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Copyright Notice
Copyright © 2004 Juniper Networks, Inc. All rights reserved.

Juniper Networks, the Juniper Networks logo, NetScreen, NetScreen Technologies, the NetScreen logo, NetScreen-Global 
Pro, ScreenOS, and GigaScreen are registered trademarks of Juniper Networks, Inc. in the United States and other 
countries. 

The following are trademarks of Juniper Networks, Inc.:  Deep Inspection, ERX, ESP, Instant Virtual Extranet, Internet 
Processor, J-Protect, JUNOS, JUNOScope, JUNOScript, JUNOSe, M5, M7i, M10, M10i, M20, M40, M40e, M160, M320, 
M-series, MMD, NetScreen-5GT, NetScreen-5XP, NetScreen-5XT, NetScreen-25, NetScreen-50, NetScreen-204, 
NetScreen-208, NetScreen-500, NetScreen-5200, NetScreen-5400, NetScreen-IDP 10, NetScreen-IDP 100, NetScreen-IDP 
500, NetScreen-IDP 1000, NetScreen-ISG 2000, NetScreen-Remote Security Client, NetScreen-Remote VPN Client, 
NetScreen-SA 1000 Series, NetScreen-SA 3000 Series, NetScreen-SA 5000 Series, NetScreen-SA Central Manager, 
NetScreen Secure Access, NetScreen-SM 3000, NetScreen-Security Manager, NMC-RX, SDX, Stateful Signature, T320, 
T640, and T-series.

Information in this document is subject to change without notice.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any 
purpose, without receiving written permission from: 

Juniper Networks, Inc.

ATTN:  General Counsel

1194 N. Mathilda Ave.

Sunnyvale, CA  94089

FCC Statement
The following information is for FCC compliance of Class A devices: This equipment has been tested and found to comply 
with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a commercial environment. The 
equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case users will be required to correct the interference at 
their own expense.

The following information is for FCC compliance of Class B devices: The equipment described in this manual generates 
and may radiate radio-frequency energy. If it is not installed in accordance with NetScreen’s installation instructions, it 
may cause interference with radio and television reception. This equipment has been tested and found to comply with the 
limits for a Class B digital device in accordance with the specifications in part 15 of the FCC rules. These specifications are 
designed to provide reasonable protection against such interference in a residential installation. However, there is no 
guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and receiver.

•  Consult the dealer or an experienced radio/TV technician for help.

•  Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Caution: Changes or modifications to this product could void the user's warranty and authority to operate this device.

Disclaimer
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH 
IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY 
THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, 
CONTACT YOUR NETSCREEN REPRESENTATIVE FOR A COPY.
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Juniper Networks NetScreen-Security Manager 2004 is a software application that helps 
you centralize control and management of your NetScreen security devices. With 
NetScreen-Security Manager, Juniper Networks delivers integrated, policy-based security 
and network management for all Juniper Networks NetScreen FW/VPN products.

NetScreen-Security Manager uses the technology developed for ScreenOS 5.0 to simplify 
management support, enabling support for previous and future versions of ScreenOS. By 
integrating management of all Juniper Networks NetScreen FW/VPN devices, NetScreen-
Security Manager enhances the overall security of the Internet gateway.

This Administrator’s Guide describes NetScreen-Security Manager features and provides 
a technical overview of the management system architecture. It also explains how to 
configure basic and advanced NetScreen-Security Manager functionality, including 
adding new devices, deploying new device configurations, updating device firmware, 
managing Security Policies and VPNs, viewing log information, and monitoring the status 
of your network. Use this guide in conjunction with the NetScreen-Security Manager 
Online Help, which provides step-by-step instructions for many of the processes described 
in this document.

This guide is intended for system administrators that are responsible for the security 
infrastructure of their organization. Specifically, this book discusses concepts of interest 
to firewall and VPN administrators, network/security operations center administrators; 
and system administrators responsible for user permissions on the network.
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This manual has 1 preface, 4 sections, 12 chapters, a glossary, 3 appendixes, and an 
index.

����������� ��!�����
Chapter 1, “Introduction” details NetScreen-Security Manager features and provides a 
technical overview of the system and its architecture. This chapter also includes a User 
Interface (UI) overview to help you get acquainted with the NetScreen-Security Manager 
UI.

Chapter 2, “Configuring Role-Based Administration (RBA)” details the process of creating 
a domain structure, designing permissions, and preparing to add devices, objects, and 
policies.

����������������������
Chapter 3, “Adding Devices” details how to add NetScreen FW/VPN devices to NetScreen-
Security Manager. This chapter also describes how to use Rapid Deployment (RD) to 
quickly deploy devices in non-technical environments.

Chapter 4, “Configuring Devices” details how to create a device configuration, including 
zones, interfaces, and routes. This chapter also describes how to use templates and groups 
to manage multiple devices more efficiently.

��������"��������#���
Chapter 5, “Updating Devices” details how to use configuration summaries, update your 
device configurations, and use Job Manager to track the update progress.

Chapter 6, “Managing Devices” details how to maintain device features, manage device 
images, and update AntiVirus and Deep Inspection files on the device.

Chapter 7, “Configuring Objects” details how to configure shared objects, such as address, 
service, schedule, attack objects, and NAT objects such as VIPs, MIPs, and DIPs.

Chapter 8, “Configuring Security Policies” details how to build firewall and multicast 
rules to create efficient Security Policies.

Chapter 9, “Configuring VPNs” details how to create VPN components such as protected 
resources and IKE proposals, and guides you through building VPNs at the system level 
and at the device level.

���������������������
Chapter 10, “Monitoring” details the firewall, VPN, and NSRP monitoring functionality of 
NetScreen-Security Manager.

Chapter 11, “Logging” details how to manage, filter, and export firewall logs in the Log 
Viewer, how to investigate suspicious activity in the Log Investigator, and how to track 
administrative changes in the Audit Log Viewer.

Chapter 12, “Reporting” details how to create reports from log information.
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The glossary defines terms and concepts used in the NetScreen-Security Manager 
environment.

�!!��&�'
Appendix A details unsupported ScreenOS CLI commands.

Appendix B details log entry categories and subcategories.

Appendix C lists the examples provided throughout this document.

��&�'
The index provides an alphabetical list of the major topics and subtopics discussed in this 
document, and their corresponding page numbers. 
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Throughout this book, a chevron ( > ) is used to indicate navigation through the UI by 
clicking menu options and links. For example, the path to the local user configuration is 
presented as Object Manager > User Objects > Local User Objects, as shown below:

1. In the main navigation tree, select Object Manager. The Object Manager tree 
expands to reveal a subset of objects.

2. In the Object Manager navigation tree, select User Objects. The main display 
area displays all defined user objects.

3. In the User Objects navigation tree, select Local User Objects. The main display 
area displays all defined local user objects.

1

2

3



Illustration Conventions

NetScreen-Security Manager 2004 FP2 xxvii


�������
�	���	��	�
�	�
The following graphics make up the basic set of images used in illustrations throughout 
this book:

Generic NetScreen 
FW/VPN Device

Security Zone

Security Zone Interfaces

White = Protected Zone Interface
(example: Trust Zone)

Black = Outside Zone Interface
(example: Untrust Zone)

Router Icon

Switch IconVPN Tunnel

Local Area Network (LAN) 
with a Single Subnet. 
(example: 10.1.1.0/24)

Internet

Desktop Computer

Server

Tunnel Interface

Laptop Computer
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To obtain technical documentation for any Juniper Networks NetScreen product, visit 
www.juniper.net/techpubs/.

To obtain the latest software version, visit: www.juniper.net/support/. After logging in, 
select the Download Software option, and then follow the displayed instructions. (You 
must be a registered user to download software.)

If you find any errors or omissions in the following content, please contact us at the email 
address below: techpubs-comments@juniper.net.

http://www.juniper.net/techpubs/
http://www.juniper.net/support/
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• About NetScreen-Security Manager 2004

• Technical Overview

• Working in the User Interface

All networks are different, but each network is built the same way: You devote time to 
design your network, spend money to buy the necessary equipment, and put in the hard 
work to build and customize your network components so they work the way you want 
them to. In an ideal world, that would be the end of the job—the perfect network has 
perfect uptime, with perfect redundancy, growth potential, etc.

The reality is that managing your network devices is a full-time job. Ensuring that all 
devices in your system are up and running, patched against vulnerabilities and exploits, 
and functioning as expected requires a team of intelligent and committed individuals who 
understand every aspect of their network. To respond quickly and appropriately to a 
network situation, IT administrators, network administrators, and security 
administrators must have complete control over network connectivity, network access, 
and network traffic flow.

As your network grows, individual device maintenance can quickly become a logistical 
nightmare. New devices, new networking technologies, software upgrades—almost every 
change to your network requires some human and monetary resource. Even in small 
networks, setting up and maintaining each device individually is time-consuming, prone 
to error, and likely to require network downtime. Many organizations are now turning 
towards integrated management solutions to help them configure and manage devices 
more efficiently.

Juniper Networks NetScreen-Security Manager is designed to give you back complete 
control over your network. The concept is simple: Using NetScreen-Security Manager, you 
can configure all your Juniper Networks NetScreen FW/VPN devices from one location, at 
one time. NetScreen-Security Manager manages the functionality of Juniper Networks 
NetScreen ScreenOS and incorporates Juniper Networks NetScreen-Global PRO 
functionality in one unified system with a single, streamlined User Interface.
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At its foundation, a management system integrates your individual FW/VPN devices into 
a single, effective security system that you control from a central location. With 
NetScreen-Security Manager, you can manage your network at the system level, using 
policy-based central management, as well as at the device level, managing all device 
parameters for devices.

NetScreen-Security Manager is designed to work with networks of all sizes and 
complexity. You can add a single device, or create device templates to help you deploy 
multiple devices; you can create new policies, or edit existing policies for NetScreen FW/
VPN devices. The management system tracks and logs each administrative change in 
realtime, providing you with a complete administrative record and helping you perform 
fault management.

NetScreen-Security Manager also simplifies control of your network with an intuitive UI. 
Making all changes to your devices from a single, easy-to-use interface can reduce 
deployment costs, simplify network complexity, speed configuration, and minimize 
troubleshooting time.

The following sections detail the key management features of NetScreen-Security 
Manager.
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True security integration occurs when you can control every security device on your 
network and see every security event in real-time from one location. In NetScreen-
Security Manager, this location is the NetScreen-Security Manager UI, a graphical user 
interface that contains a virtual representation of every NetScreen FW/VPN device on 
your network. The idea behind this virtual-physical abstraction is that you can access 
your entire network from one location—use this console to view your network, the devices 
running on it, the policies controlling access to it, and the traffic that is flowing through it.
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You can create and manage device configurations for NetScreen FW/VPN devices or 
systems. NetScreen-Security Manager provides support for ScreenOS configuration 
commands, so you can retain complete control over your devices when using system-level 
management features like VPNs.
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Divide and conquer with NetScreen-Security Manager—use domains to segment your 
network functionally or geographically to define specific network areas that multiple 
administrators can manage easily.
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A domain logically groups devices, their policies, and their access privileges. Use a single 
domain for small networks with a few security administrators, or use multiple domains 
for enterprise networks to separate large, geographically distant or functionally distinct 
systems, control administrative access to individual systems, or obfuscate systems for 
service provider deployments.

With multiple domains, you can create objects, policies, and templates in the global 
domain, then create subdomains that automatically inherit these definitions from the 
global domain.
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Control access to management with NetScreen-Security Manager—define strategic roles 
for your administrators, delegate management tasks, and enhance existing permission 
structures with new task-based functionality.

Use NetScreen-Security Manager to create a security environment that reflects your 
current offline administrator roles and responsibilities. Because management is 
centralized, it’s easy to configure multiple administrators for multiple domains. By 
specifying the exact tasks your NetScreen-Security Manager administrators can perform 
within a domain, you minimize the probability of errors and security violations, and 
enable a clear audit trail for every management event. 

Initially, when you log in to NetScreen-Security Manager as the super administrator, you 
have full access to all functionality within the global domain. From the global domain, you 
can add NetScreen-Security Manager administrators, configure their roles, and specify 
the subdomains to which they have access:

• Activities & Roles. An activity is a predefined task performed in the 
NetScreen-Security Manager system, and a role is a collection of activities that 
define an administrative function. Use activities to create custom roles for your 
NetScreen-Security Manager administrators.

• Administrators. An administrator is a user of NetScreen-Security Manager; 
each administrator has a specific level of permissions. Create multiple 
administrators with specific roles to control access to the devices in each domain.

• Default Roles. Use the predefined roles System Administrator, Read-Only 
System Administrator, Domain Administrator, and Read-Only Domain 
Administrator to quickly create permissions for your administrators.
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No network too large—because you manage your security devices from one location, you 
can use several system management mechanisms to help you quickly and efficiently 
create or modify multiple device configurations at one time:

• Templates. A template is simply a predefined device configuration that helps 
you re-use specific information. Create a device template that defines specific 
configuration values, then apply that template to devices to quickly configure 
multiple devices at one time. For more flexibility, you can combine and apply 
multiple device templates to a single device configuration. (31 maximum). 
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• Shared Objects. An object is a NetScreen-Security Manager definition that is 
valid in the global domain and all subdomains. Any object created in the global 
domain is a shared object that is shared by all subdomains; the subdomain 
automatically inherits any shared objects defined in the global domain.

The global domain is a good location for FW/VPN devices and systems that are 
used throughout your organization, address book entries for commonly used 
network components, or other frequently used objects. A subdomain, 
alternatively, enables you to separate firewalls, systems, address objects, etc. 
from the global domain and other subdomains, creating a private area to which 
you can restrict access.

• Grouping. A group is a collection of similar devices or objects. Use device 
groups and object groups to update multiple devices simultaneously, simplify 
policy creation and deployment, and enable group-specific reporting. You can 
even link groups using Group Expressions to create a custom group.
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If you have existing NetScreen FW/VPN devices deployed on your network or are using a 
previous NetScreen management system, you can use the NetScreen-Security Manager 
migration tools to quickly import your existing FW/VPN devices and their configurations, 
address books, service objects, policies, VPNs, and administrator privileges. As 
NetScreen-Security Manager imports your existing device configurations, it automatically 
creates your virtual network based on the configuration information.

You can import device configurations directly from your NetScreen FW/VPN device, or 
from your Juniper Network NetScreen Global PRO or Global PRO Express system. 
Import all your FW/VPN devices at one time, or, if your network is large, import one 
domain at a time. When importing from Global PRO or Global PRO Express, NetScreen-
Security Manager automatically transfers your existing domain structure.

For details on migrating from a previous management system, see the NetScreen-Security 
Manager 2004 FP1 Migration Guide.
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A production network is a living entity, constantly evolving to adapt to the needs of your 
organization. As your network grows, you might need to add new devices, reconfigure 
existing devices, update software versions on older devices, or integrate a new network to 
work with your existing network. NetScreen-Security Manager helps you take control of 
your network by providing a virtual environment in which to first model, verify, then 
updated your managed devices with changes.
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Using your virtual network to change, review, and test your network configuration before 
deploying it to your physical network can help you discover problems like routing issues, 
IP conflicts, and version mismatches across your entire network before they actually 
occur. NetScreen-Security Manager includes configuration validation to help you identify 
device configuration errors and missing information, then points you to the trouble spot so 
you can quickly fix the problem. When you have designed a virtual configuration that 
works, you can push this configuration to your devices with a single update.

With NetScreen-Security Manager, you can implement a new routing protocol across your 
network, design and deploy a new Security Policy with traffic shaping, or create a new 
VPN tunnel that connects a branch office to your corporate network—then deploy all 
changes with a single click.
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Rapid Deployment (RD) enables deployment of multiple NetScreen FW/VPN devices in a 
large networked environment with minimal user involvement. RD is designed to simplify 
the staging and configuration of FW/VPN devices in non-technical environments, 
enabling the secure and efficient deployment of a large number of devices.

To use RD, the NetScreen-Security Manager administrator creates a small file (called a 
configlet) in NetScreen-Security Manager, then sends that configlet to an on-site 
administrator that has local access to the NetScreen FW/VPN device. With the help of the 
Rapid Deployment wizard, the on-site administrator installs the configlet on the device, 
which automatically contacts NetScreen-Security Manager and establishes a secure 
connection for device management. 

RD is ideal for quickly bringing new NetScreen FW/VPN devices under NetScreen-
Security Manager management for initial configuration. You can model and verify your 
device configurations for undeployed devices, then install the completed device 
configuration when the device contacts NetScreen-Security Manager.
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Create simplified and efficient Security Policies for your managed devices using:

• Groups. Group your devices by platform, ScreenOS version, location, or 
function, then add them to your Security Policies.

• Zone Exceptions. To simplify your rules, define a common To Zone and From 
Zone for all devices in the rule, then specify zone exceptions to change the To 
and From zones for specific devices. Zone exceptions add flexibility to your 
firewall rules, enabling you to manage more devices in a single rule.

• Filtering. Filter on From and To Zones to see rules between zones. 
• Scheduling. Schedule a time or time period that a rule in your policy is in effect 

on the devices in a rule. Create schedule objects as one-time, recurring, or both; 
you can even select multiple schedule objects in a FW/VPN rule.
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• Attack Protection. Configure a rule to look for known attacks, viruses, or 
protocol anomalies (devices running ScreenOS 5.x only).

• Traffic Shaping. Use your firewall rules to control the amount of traffic 
permitted through your NetScreen FW/VPN devices. 
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Persistent management control is essential when managing large networks. You need to 
be sure that configuration and policies you send to your managed devices are correct 
before you install them on your devices.

Using NetScreen-Security Manager’s error prevention and recovery features, you can 
ensure that you are consistently sending stable configurations to your devices, and that 
your device remain connected to NetScreen-Security Manager. Additionally, you can track 
each change made by an NetScreen-Security Manager administrator to help you identify 
when, how, and what changes were made to your managed devices.
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NetScreen-Security Manager automatically alerts you to configuration errors while you 
work in the UI. Each field that has incorrect or incomplete data displays a  icon—
simply move your mouse cursor over the icon to get details on the missing data.
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The policy validation tool checks your Security Policies and alerts you to possible 
problems before you install that policy on your managed devices.
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On devices running ScreenOS 5.x, if the configuration deployment fails for any reason, the 
device automatically uses the last installed stable configuration. Additionally, if the 
configuration deployment succeeds, but the device loses connectivity to the management 
system, the device restores the last installed configuration. This minimizes downtime and 
ensures that NetScreen-Security Manager always maintains a stable connection to the 
managed device.
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You can update the software that runs on your devices by installing a new ScreenOS 
image on all your NetScreen FW/VPN devices:

• NetScreen-Security Manager updates. Use NetScreen-Security Manager to 
upload the new image file to multiple NetScreen FW/VPN devices with a single 
click.
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• RMA updates. To replace failed devices, simply set the device to the RMA state, 
which enables NetScreen-Security Manager to retain the device configuration 
without a serial number or connection statistics. When you install the 
replacement device, just activate the device with the serial number of the 
replacement unit. 
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Use the Audit Log Viewer to track administrative actions so you’ll always know exactly 
when and what changes were made using the management system. The Audit Log Viewer 
displays log entries in the order generated, and includes:

• Date and time the administrative action occurred
• NetScreen-Security Manager administrator who performed the action
• Action performed
• Domain (global or a subdomain) in which the action occurred
• Object type and name

The detail view of the Audit Log Viewer displays what changed from the previous version.
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NetScreen-Security Manager provides the tools and features you need to manage your 
devices as a complete system, as well as individual networks and devices:

• To manage an individual device, create a single device configuration, define a 
policy for that device, and monitor the device status. 

• To manage a network, create multiple device configurations, define and install 
policies for multiple devices, and view the status of all devices in the same UI.

• To manage at the system level, create templates and use them to quickly 
configure multiple policies and VPNs that control the flow of traffic through your 
network, view system-wide log information for network security events, and 
monitor the status of NSRP.
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Use VPN Manager to design a system level VPN and automatically set up all connections, 
tunnels, and rules for all devices in the VPN. Instead of configuring each device as a VPN 
member and then creating the VPN, start from a system perspective: Determine which 
users and networks need access to each other, then add those components to the VPN.

Using AutoKey IKE, you can create the following VPNs with VPN Manager:

• Dynamic, route-based VPNs provide resilient, always-on access across your 
network. Add firewall rules on top of a route-based VPN to control traffic flow. 

• Policy-based VPNs connect devices, remote access service (RAS) users, and 
control traffic flow (can also create with L2TP). 
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• Mixed-mode VPNs connect route-based VPNs with policy-based VPNs, giving 
you flexibility.
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You use the NetScreen FW/VPN devices on your network for multiple reasons: to control 
access to and from your network, to detect and prevent unwanted intruders, and to record 
security events so you can monitor the important activities occurring on your network. 
You can use NetScreen-Security Manager to monitor, log, and report on network activity 
in real-time to help you understand what is happening on your network:

• View traffic log entries generated by network traffic events, configuration log 
entries generated by administrative changes, or create custom views to see 
specific information in the Log Viewer.

• Create detailed reports from traffic log information in the Report Manager.
• Inspect suspicious events by correlating log information in the Log Investigator.
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NetScreen-Security Manager can keep up-to-date on the health of your security system. 

• View critical information about your device in the Device Monitor:
– Configuration and connection status of your NetScreen FW/VPN devices
– Individual device details, such as memory usage and active sessions
– Device statistics

• View the status of each individual VPN tunnel in the VPN Monitor.
• View NSRP status in the NSRP Monitor.
• View the health of the NetScreen-Security Manager system itself, including 

CPU utilization, memory usage, and swap status in the Server Monitor.
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You can view the progress of communication to and from your devices in the Job Manager. 
NetScreen-Security Manager sends commands to managed devices at your request, 
typically to import, update or reboot devices, and view configuration and delta 
configuration summaries. When you send a command to a device or group of devices, 
NetScreen-Security Manager creates a job for that command and displays information 
about that job in the Job Manager module.

Job Manager tracks the progress of the command as it travels to the device and back to 
the management system. Each job contains:

• Name of the command
• Date and time the command was sent
• Completion status for each device that received the command
• Detailed description of command progress
• Command output, such as a configuration list or CLI changes on the device
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Security from bottom up—NetScreen-Security Manager architecture is built on a secure 
foundation, with secure communication between management components and a single 
access point for inbound connections.

*��<
����	��
NetScreen-Security Manager is a three tier management system comprised of a User 
Interface, management system, and managed devices (NetScreen FW/VPN devices). 
These three tiers combine to manage your security devices, which process your network 
traffic and are the enforcement points that implement your policies. The UI and 
management system tiers are software, not hardware, so you can deploy them quickly and 
easily. Additionally, because the management system uses internal databases for storage 
and authentication, you don’t need LDAP or an external database.

Note: For details on NetScreen-Security Manager architecture and help with 
setting up the management system, see the NetScreen-Security Manager 2004 
Installer’s Guide.
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The UI is software that provides a powerful, graphical environment for centrally 
managing your network. The UI is a software application that can be installed on multiple 
Windows (XP, NT, 2000) or Red Hat linux computers on your network. You use the UI to 
remotely access the management system.

Multiple NetScreen-Security Manager admins can interact with NetScreen FW/VPN 
devices using the UI, and can even configure unique UI preferences. The NetScreen-
Security Manager GUI Server stores user preferences in the central database so that they 
remain consistent when you access them from different client machines. The UI also 
provides extensive online help to help you use NetScreen-Security Manager quickly and 
efficiently.

The UI communicates with the GUI Server using a secure, proprietary, TCP-based 
connection that encrypts and authenticates all traffic.
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The management system used in NetScreen-Security Manager provides all the 
functionality required to integrate management of all the components in your network 
security environment. It enables you to centrally gather, store, configure, manage, 
monitor and generate reports on the NetScreen FW/VPN devices you have deployed in 
your network.

The management system itself is composed of two distinct components:

• GUI Server
• Device Server

Both the GUI Server and Device Server working together are collectively referred to as 
the NetScreen-Security Manager “management system”.
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The GUI Server manages the system resources and data that drive NetScreen-Security 
Manager functionality. You can install the GUI Server software on a separate computer 
running Red Hat Linux 8/9 or Solaris 8/9, or on a Global PRO appliance. The GUI Server 
contains the NetScreen-Security Manager databases, and centralizes information for 
devices, their configurations, attack and server objects, and policies. 

Management System

GUI Server

Device Server
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Specifically, the GUI Server stores all of the following information:

• Device, policy, and VPN configuration
• NetScreen-Security Manager administrator accounts, device administrator 

accounts, and domains
• Objects
• Organizes and presents log entries from NetScreen FW/VPN devices (logs are 

stored on the Device Server)

The GUI Server receives logs from the Device Server on a single inbound port. When you 
use the UI to access NetScreen-Security Manager functionality, you connect using the 
same single port and access the databases stored on the GUI Server. The GUI Server 
communicates with the Device Server using SSP, a secure, proprietary, TCP-based 
connection that encrypts and authenticates all traffic.

When you start the GUI Server, it runs the following processes.
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The Device Server handles communication between the GUI Server and the device, 
collects data from the managed devices on your network, formats configuration 
information sent to your managed device, and consolidates log and event data.

You can install the GUI Server and the Device Server on the same physical computer, or 
separate computers. Communication between a physically separate GUI Server and the 
Device Server is an encrypted TCP connection to a default port. The Device Server 
connects to the GUI Server using the default port; you can change the default port by 
editing the configuration files for both servers.

If the GUI Server computer and the Device Server computer have a firewall between 
them, you must configure a policy on that firewall to permit NetScreen-Security Manager 
management traffic.

Process Description

guiSvrManager GUI Server Manager receives and responds to requests from the 
NetScreen-Security Manager User Interface. The GUI Server 
Manager forwards requests to the GUI Directive Handler or Device 
Directive Handler depending on the type of request for further 
processing.

guiSvrDirectiveHandler GUI Directive Handler handles all directives or instructions from the 
NetScreen-Security Manager UI which require reading, writing or 
modifying of the local data store.

guiSvrStatus Monitor GUI Server Status Monitor monitors the status of the processes that 
run on the GUI Server.

guiSvrMasterController Master Controller forwards configuration data to the NetScreen-
Security Manager UI (for viewing) or to the local data store (for later 
retrieval).
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When you start the Device Server, it runs the following processes:
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Managed devices are the NetScreen FW/VPN devices and systems that you use to enable 
access to your network components and to protect your network against malicious traffic. 
The following table details the FW/VPN devices and versions of ScreenOS supported by 
NetScreen-Security Manager:

Process Description

devSvrManager Device Server Manager enables FW/VPN devices to connect to and 
communicate with the NetScreen-Security Manager management 
system. The Device Server Manager is writes log data into the local 
data store, and routes messages and directives from the GUI Server to 
the Device Directive Handler for further processing.

deviceDirectiveHandler Device Directive Handler manages directives that are issued 
specifically to the FW/VPN device (for example, a reboot, update 
firmware, or generate Config Summary command).

devSvrStatusMonitor Device Server Status Monitor monitors the status of the processes that 
run on the Device Server.

devSvrDataCollector Device Server Data Collector collects log data and device statistics 
from each FW/VPN device managed by NetScreen-Security Manager.

devSvrLogWalker Device Server Log Walker performs user-specified actions on log 
entries (i.e., indexing, de-duplication, filtering).

FW/VPN Device ScreenOS Versions Supported

Juniper Networks NetScreen-5XP 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-5XT 4.0.0, 4.0.0-DIAL2, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-25 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-50 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-100 4.0.0, 4.0.1, 4.0.3

Juniper Networks NetScreen-204 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-208 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-500 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-500 GPRS 5.0.0 only

Juniper Networks NetScreen-5200/8 4.0.0, 4.0.1, 4.0.3, 5.0

Juniper Networks NetScreen-5200/8 GPRS 5.0 only

Juniper Networks NetScreen-5200/24 4.0.1-SBR, 4.0.1-SIBR, 5.0

Juniper Networks NetScreen-5200/24 GPRS 5.0 only

Juniper Networks NetScreen-5400 4.0.1-SBR, 4.0.1-SIBR, 5.0

Juniper Networks NetScreen-5400 GPRS 5.0 only

Juniper Networks NetScreen-5GT 4.0.0-DIAL2, 5.0
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NetScreen-Security Manager also manages vsys configurations, NSRP clusters, and 
extranet devices.
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The distributed data collection system provides NetScreen-Security Manager with a 
robust yet lightweight method for managing multiple objects. In NetScreen-Security 
Manager, each device is described by a unique Data Model (DM) that contains all the 
configuration data for that individual device. The Abstract Data Model (ADM) contains 
configuration data for all objects in a specific domain. When you use the UI to interface 
with your managed devices, the ADM and DMs work together:

• When you update a device configuration, the GUI Server translates the objects 
and object attributes in the ADM domain into device configuration information 
in a DM. The Device Server then translates the device configuration information 
in the DM into CLI commands and sends the commands to the device. 

• When you import a device configuration, the device sends CLI commands to the 
Device Server, which translates the CLI commands into a DM with device 
configuration information. The GUI Server then translates the device 
configuration in the DM into objects and object attributes in the ADM, and uses 
the ADM to display current information in the UI.

The structure of the ADM and the DMs is defined by a DM schema, which lists all the 
possible fields and attributes for that type of object or device. The DM schema reads from 
a capability file, which lists the fields and attributes that a specific ScreenOS version 
supports, to determine the supported features for the ScreenOS version that is running on 
the managed devices. NetScreen-Security Manager uses capability files to enable 
NetScreen software upgrades without changing the device configuration in NetScreen-
Security Manager.

For more details on the ADM and DMs, see “Managing Devices” on page 281.
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NetScreen-Security Manager integrates application-level encryption and authentication 
and uses high-grade encryption and public-key algorithms to eliminate the need for 
separate IPSEC tunnels between each device and the management station.

For communication between the UI, the GUI Server, and the Device Server, NetScreen-
Security Manager uses Secure Server Protocol (SSP), a modified version of TCP that is 
more reliable than ordinary TCP, requires less CPU and memory resources from servers, 
and reduces the number of acknowledgement packets on the network. SSP uses AES 
encryption and SHA1 authentication for all connections.

Juniper Networks NetScreen-5GT ADSL 5.0.0r6 only

Juniper Networks NetScreen-HSC 5.0 only

Juniper Networks NetScreen-ISG-2000 5.0 only

FW/VPN Device ScreenOS Versions Supported



Chapter 1 Introduction

16 Administrator’s Guide

��� 
���7�������+����
NetScreen-Security Manager is designed to grow with your network, so you can continue 
to manage all your NetScreen network devices with NetScreen-Security Manager. As you 
add devices or network components to your physical network, you also add them to your 
virtual NetScreen-Security Manager network, where you can manage all future 
configurations. A NetScreen-Security Manager Device Server can support up to 1000 
devices; the management system supports up to 20,000 log entries per second.
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The NetScreen-Security Manager User Interface (UI) is used to control the NetScreen-
Security Manager system. Using the UI, you can configure NetScreen-Security Manager 
administrators, add devices, edit policies, view reports—access the full functionality of the 
NetScreen-Security Manager system.
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The NetScreen-Security Manager User Interface (UI) appears after you log in, and 
displays a set of menus and toolbar icons at the top of the UI window. Depending on the 
component displayed, right-click menus are available to perform various tasks.

The UI is shown below:

Note: For step-by-step instructions on using the User Interface, click the icon in 
the menu bar of the UI to access the NetScreen-Security Manager 2004 Online Help.

Main Display Area 

Menu Bar

Toolbar

Domain Menu

Navigation Tree

Status Bar
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The navigation tree displays the 11 NetScreen-Security Manager modules in the left pane 
of the NetScreen-Security Manager window. Double-click a module to display its contents 
in a hierarchical tree format. For details on each module, see below.
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The main display area displays content for the selected module or module contents.

• Menu Bar. The menu bar contains clickable commands. You can access many 
menu bar commands using keyboard shortcuts such as add, edit, delete. For a 
complete list of keyboards shortcuts, see the Online Help.

• ToolBar. The toolbar contains buttons for common tasks. The buttons displayed 
in the toolbar are determined by the selected module.

• Status Bar. The status bar displays additional information for selected module.
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The navigation tree contains 11 top-level modules that contain specific NetScreen-
Security Manager functionality, as detailed in the following sections.
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The Log Viewer displays log entries that your NetScreen FW/VPN devices generate based 
on criteria that you defined in your Security Policies, on the GUI Server, and in the device 
configuration. Log entries appear in table format; each row contains a single log entry, 
and each column defines specific information for a log entry.

You can customize the view (which log entries and what log information is shown) using 
log filters or by changing the column settings.

Use the Log Viewer to:

• View summarized information about security events and alarms
• Drill down to view information about a specific log entry
• Show, hide, or move columns to customize the Log Viewer
• Filter log entries by column headings
• Create and save custom views that display your filters/column settings
• Set flags on Log Viewer entries to indicate a specific priority or action

For more details on using the Log Viewer, see Chapter 11, “Logging”.



Working in the User Interface

NetScreen-Security Manager 2004 FP2 19

,�"����������
The Report Manager contains summary, graphs, and charts that detail specific security 
events that occur on your network. NetScreen-Security Manager generates reports to 
visually represent the information contained in your log entries. You can use reports to 
quickly summarize security threats to your network, analyze traffic behavior, and 
determine the efficiency of NetScreen-Security Manager. To share reports or to use report 
information in other application, you can print or export report data. 
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The Log Investigator contains tools for analyzing your log entries in depth. Use the Log 
Investigator to:

• Manipulate and change constraints on log information
• Correlate log entries visually and rapidly
• Filter log entries while maintaining the broader picture
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The Device Manager contains the device objects that represent your NetScreen FW/VPN 
devices. You can create:

• NetScreen FW/VPN devices and systems. The devices you use to enable 
access to your network and to protect your network against malicious traffic.

• vsys devices. A vsys is a virtual device that exists within a physical NetScreen 
FW/VPN device.

• Clusters. A cluster is two NetScreen FW/VPN devices joined together in a high 
availability configuration to ensure continued network uptime.

• Extranet devices. Firewalls or VPN devices that are not Juniper Networks 
NetScreen FW/VPN devices.

• Templates. A template is a device configuration that you can define a single 
time then use for multiple devices.

• Device Groups. A device group is a user-defined collection of devices.
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Security Policies contains the firewall, multicast, and VPN rules that control traffic on 
your network. Using a graphical, easy-to-use rule building platform, you can quickly 
create and deploy new policies to your NetScreen FW/VPN devices.

Use Security Policies to:

• Add or modify existing Security Policies
• Add or modify existing VPN rules
• Create new policies based on existing policies
• Install policies on one or multiple NetScreen FW/VPN devices
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• Delete policies

If the device configurations that you imported from your NetScreen FW/VPN devices 
contained policies, Security Policies displays those imported policies. For details on 
editing those imported polices or creating new policies, see Chapter 8, “Configuring 
Security Policies” or Chapter 9, “Configuring VPNs”.

9���������
The VPN Manager contains the VPN abstractions that control the VPN tunnels between 
your managed devices and remote users. Using VPN objects such Protected Resources and 
IKE Proposals, you can create multiple VPNs for use in your Security Policies.

Use the VPN Manager to:

• Define the protected resources on your network. Protected Resources represent 
the network resources you want to protect in a VPN.

• Create custom IKE Phase 1 and 2 Proposals.
• Configure AutoKey IKE, L2TP, and L2TP-over-AutoKey IKE VPNs in policy-

based or route-based modes. You can also create an AutoKey IKE mixed mode 
VPN to connect policy-based VPN members with route-based VPN members.

• Configure AutoKey IKE and L2TP policy-based VPNs for remote access services 
(RAS) and include multiple users.
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The Object Manager contains the Objects used in your NetScreen-Security Manager 
system. An object is a re-usable, basic NetScreen-Security Manager building block that 
contains specific information; you use objects to create device configurations, policies, and 
VPNs. All objects are shared, meaning they can be shared by all devices and policies in 
the domain.

You can create the following objects in NetScreen-Security Manager:

• Address Objects represent components of your network (hosts, networks, 
servers, etc.)

• Schedule Objects represent specific dates and times. You can use schedule 
objects in firewall rules to specify a time or time period that the rule is in effect.

• Attack Objects represent attack signatures and protocol anomalies used in 
Deep Inspection.

• AV Objects represent the servers that contain your virus definitions and 
AntiVirus software.

• Service Objects represent services running on your network, such as FTP, 
HTTP, and Telnet. NetScreen-Security Manager contains a database of Service 
Objects for well-known services; you can also create new Service Objects to 
represent the custom services you are running on your network.

• User Objects represent the remote users that access the network protected by 
the FW/VPN device. To provide remote users with access, create a user object for 
each user, then create a VPN that includes those user objects.
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• IP Pools represent a range of IP addresses. You use IP pools when you 
configure a DHCP Server for your managed devices.

• Authentication Servers represent external authentication servers, such as 
RADIUS and SecurID servers. You can use an authentication server object to 
authenticate NetScreen-Security Manager admins (RADIUS only), XAuth users, 
IKE RAS users, and L2TP users. 

• Group Expressions are OR, AND, and NOT statements that set conditions for 
authentication requirements. 

• Remote Settings represent DNS and WINS servers. You use remote settings 
object when configuring XAuth or L2TP authentication in a VPN.

• NAT Objects represent MIPs, VIPs, and DIPs. 
• GTP Objects represent GTP client connections. 
• CA Objects represent the certificate authority’s certificate.
• CRL Objects represent the certificate authority’s certificate revocation list.

You can use the Object Manager to:

• View and/or edit the Object properties
• Create, edit, or delete Objects
• Create custom groups of Objects

For more details on objects, see Chapter 7, “Configuring Objects”.
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Server Manager contains server objects that represent your management system 
components. Use Server Manager to manage and monitor the individual server processes 
that comprise your NetScreen-Security Manager system.
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Realtime Monitor provides a graphical view of the current status of all devices managed 
by NetScreen-Security Manager:

• Device Monitor tracks the connection state and configuration state of your 
FW/VPN devices. You can also view device details to see CPU utilization and 
memory usage for each device, or check device statistics.

• VPN Monitor tracks the status of all VPN tunnels.
• NSRP Monitor tracks the status of NSRP.

You can customize Realtime Monitor to:

• Display only the information you want to see
• Update information at specified time periods
• Set alarm criteria for a device or process

For more details on Realtime Monitor, see Chapter 10, “Monitoring”.
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Job Manager contains the status of commands (also called directives) that NetScreen-
Security Manager sends to your managed devices. You can view summaries or details for 
active jobs and completed jobs. 
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The Audit Log Viewer contains a log entry for every change made by a NetScreen-Security 
Manager administrator.
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When multiple NetScreen-Security Manager admins are accessing the NetScreen-
Security Manager system at the same time, NetScreen-Security Manager synchronizes 
their edits by locking an active object. Only one admin at a time can edit existing values 
for an object, but multiple admins can still view the existing values for that object:

• When an NetScreen-Security Manager admin begins editing an object, the UI 
locks that object to prevent other admins from editing the object’s value. 

• During lockout, NetScreen-Security Manager makes “lazy” saves of all edits 
made and stores them in an in-memory database. If NetScreen-Security 
Manager crashes during a lazy save, edits made since the last lazy save are lost, 
and NetScreen-Security Manager prompts the NetScreen-Security Manager 
admin to rollback to the last lazy save.

• When the admin completes and saves the edit, that object is unlocked, enabling 
other admins to edit it. However, because the UI does not immediately refresh 
the object values, you must manually refresh the UI to view the most recent 
versions.

For example, let’s say Bob and Carol are both NetScreen-Security Manager admins with 
the same roles. If both admins view the same object, but Bob also edits and saves the 
object, NetScreen-Security Manager does not notify Carol that a newer version of the 
object exists. To see the newest version, Carol must first close, then open the object again 
or refresh the console.
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• About Role-Based Administration (RBA)

• Using Role-Based Administration Effectively

• Configuring Role-Based Administration

• Planning Your NetScreen-Security Manager Network

This chapter details how to use Juniper Networks NetScreen-Security Manager’s role-
based administration feature to configure domains, administrators, and roles to manage 
your network. Your organization probably already has an existing permission structure 
that is defined by job titles, responsibilities, and geographical access to your security 
devices. Using role-based administration, you can re-create this same permission 
structure in NetScreen-Security Manager. 

RBA is particularly useful for Enterprise and Service Provider organizations that have 
different administrative roles associated with managing a large network and security 
infrastructure. You can create custom roles with specific permissions to create the exact 
administration structure your organization requires.

After you have created a role-based administrative structure for your network, you can 
begin thinking about your central management strategy and how to prepare your network 
for NetScreen-Security Manager. NetScreen-Security Manager includes many features 
specifically designed for managing multiple Juniper Networks NetScreen FW/VPN 
devices, such as device groups, templates, etc. 
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NetScreen-Security Manager’s role-based administration feature enables you to define 
strategic roles for your administrators, delegate management tasks, and enhance existing 
permission structures with new task-based functionality.

Use NetScreen-Security Manager to create a security environment that reflects your 
current offline administrator roles and responsibilities. Because management is 
centralized, it’s easy to configure multiple administrators for multiple domains. By 
specifying the exact tasks your NetScreen-Security Manager administrators can perform 
within a domain, you minimize the probability of errors and security violations, and 
enable a clear audit trail for every management event.
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A domain is a logical grouping of devices, their Security Policies, and their access 
privileges. A domain can contain devices, templates, objects, policies, VPNs, 
administrators, activities, authentication servers, groups—a representation of all or a 
subset of the physical devices and functionality on your network.

NetScreen-Security Manager contains a default top-level domain, called the global 
domain, which can contain additional domains, called subdomain. Use subdomains to 
manage multiple domains in a single hierarchical structure. You can create all your 
devices and their configurations in the global domain, or you can configure additional 
subdomains within the global domain.

Typically, multiple domains are used for two main reasons: to define network structure 
and to control administrator access. Multiple domains help to separate large, 
geographically distant systems into smaller, more manageable sections, and also to 
control administrative access to individual systems.

For example, a small organization might only have one domain (the global domain) for 
their entire network, while a large, international organization might have dozens of 
subdomains that exist within the global domain to represent each of its regional office 
networks across the world. A Service Provider might use domains to build a virtual 
network for each client network, then assign access permissions for each client domain to 
the appropriate client administrator.

Domain selection is critical if you plan to use VPNs in your network. Because you can 
create VPNs only between devices in the same domain, be sure to add the devices you 
want to connect with a VPN to the same domain, or use the workaround detailed on 
“Using Devices in VPNs” on page 54.

Note: You can create only one level of subdomains in NetScreen-Security 
Manager 2004 FP2.
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Roles define who can perform which task and view which information. NetScreen-
Security Manager uses a powerful, role-based access control system that enables you to 
create custom roles for individual administrators. Use role-based management to control 
administrative access to NetScreen-Security Manager functionality.

All NetScreen-Security Manager users are some type of admin. During NetScreen-
Security Manager installation, you are prompted for a password for the (default) admin 
account for NetScreen-Security Manager; this admin account is the first administrator, 
and is therefore the super administrator. The super admin automatically has all 
permissions, and can create other domains, admins, and roles. As super admin, you 
specify who has what permissions for NetScreen-Security Manager functionality for the 
entire NetScreen-Security Manager system, a single domain, or specific functionality 
within a domain

You can define multiple NetScreen-Security Manager administrators and assign 
dedicated roles to each administrator:

• A role is a set of activities that specify the functions the admin can perform.
• Activities are predefined tasks within NetScreen-Security Manager; the 

NetScreen-Security Manager admin can combine multiple activities into a 
custom role.

With role-based administration, you can specify who has what permissions for NetScreen-
Security Manager functionality for the entire NetScreen-Security Manager system, a 
single domain, or even specific functionality within a domain. You can even delegate 
NetScreen-Security Manager administrator management, enabling existing NetScreen-
Security Manager administrators to create other NetScreen-Security Manager 
administrators, assign domains, and define or create roles.

Note: You cannot define a custom activity.

Note: A device administrator is the person responsible for managing a device 
directly, using ScreenOS (command line or WebUI). If a device administrator uses 
only ScreenOS to manage devices, do not create an NetScreen-Security Manager 
administrator account for the device admin; however, if a device administrator 
uses both ScreenOS and NetScreen-Security Manager to manage devices, you must 
create a NetScreen-Security Manager administrator account for the device admin.
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The structure of your NetScreen-Security Manager domains should reflect both your 
existing network structure and your desired permission structure.

• Network Structure. Use multiple domains to segregate large, geographically 
distant networks into locally-managed sections. 

• Permission Structure. Use multiple domains to segregate critical devices and 
systems from less important network areas, then restrict administrator access to 
devices in the critical domain.

Your organization probably already has an existing permission structure that is defined 
by job titles, responsibilities, and geographical access to your security devices. You can re-
create this same permission structure in NetScreen-Security Manager. 

Role-based administration is particularly useful for Enterprise and Service Provider 
organizations that have different administrative roles associated with managing a large 
network and security infrastructure. RBA is also helpful for any size organization that 
wants to provide access to other device statistics to non-administrators within the 
organization, such as creating a role for the CIO to access reports.
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Each enterprise defines administrative roles differently. With NetScreen-Security 
Manager, you have the flexibility to create the appropriate permission level.
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To manage large, geographically diverse networks, you can create domains for each 
separate geographical location. Typically, the larger the Enterprise, the deeper and more 
complex your geographical divisions. Two common geographical divisions are Corporate 
and Region:

• Corporate. The corporate domain is the global domain. In the global domain, 
the super administrator creates the devices, objects, and policies that exist in 
the corporate network, and creates subdomains for each region. 

• Region. Each region is a subdomain. Within each subdomain, the super admin 
creates a regional administrator to manage the subdomain. The super admin 
also specifies the roles the regional admin has to view and manipulate devices, 
remote users, configuration actions, and report information within that 
subdomain.
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To ensure continual network uptime and provide prompt respond to network attacks, 
each geographical division is often monitored by a dedicated Network Operations Center 
(NOC) and/or Security Operations Center (SOC). The NOC and SOC are typically the 
same location for small organizations, but might be physically separate for larger, more 
complex organizations. Whether combined or separate, NOC and SOC administrators 
perform distinct roles:

• NOC administrators focus on network connectivity and status.
• SOC administrators focus on network attacks and events associated with 

Security Policies.
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Many organizations have different types of administrators for different roles within the 
company. Each organization has a unique vision for the granularity of their permission 
structure. 
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Typically, a NOC/SOC uses a 3-tier permission structure. The administrators in each tier 
have a specific level of skill and understanding of the underlying network and technology, 
as well as access permissions to view or change configurations. An example NOC/SOC 
center might use the following role structure:

• Tier 1 administrators view events and audit configurations.
• Tier 2 administrators view events and audit configurations, but also change 

network configurations during troubleshooting.
• Tier 3 administrators have full access to all functionality on the device, and 

make configuration and policy changes. 
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Some enterprise organizations use different administrator groups to manage specific 
aspects of device configuration. Configuration responsibilities might use the following role 
structure:

• The IT group integrates new devices into the existing network infrastructure. 
This group has roles with activities for setting up Layer 2 and Layer 3 aspects of 
the device (IP addressing, Routing, Vlans, Syslog, etc.). Within the IT group, the 
network administrator might also have a role with an activity for managing the 
management system.

• The Security group creates and manages Security Policies. This group has 
roles with activities for defining custom services, address objects, and firewall 
rules on devices for which they have responsibility.

• The Remote Connectivity group creates and manages VPNs and RAS user 
configuration. This group has roles with activities for configuring VPNs and 
remote users.
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• Configuration Validation. An audit administrator approves all configuration 

changes before those changes are made on the network. Only the auditor has a 
role with activities for updating devices on the network. 

• Reporting. A reporting administrator views reports for one or more domains. A 
regional reporting administrator has a role with activities for viewing reports for 
their regional subdomain; a corporate reporting administrator has a role with 
activities for viewing reports for the global domain and all subdomains.

• Configuration Update. An update administrator updates firmware for all FW/
VPN devices. The update administrator has a role with activities for updating 
firmware on the devices in their assigned domain.

• Administrative Management. A management administrator creates new 
administrators and manages their permissions. The super administrator creates 
an management administrator to delegate administrator management. For 
example, a NOC Tier 2 administrator has a role that includes the activity to 
create new admins, but cannot assign them an activity that is not included in 
their own role. Typically, a subdomain has only one management administrator 
to control the creation of administrators.

• Device Installation. A device install admin creates new devices. The device 
install administrator has a role with activities for adding, updating, and viewing 
device configurations. 
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Service Providers can use NetScreen-Security Manager domain, subdomains, and roles to 
manage their internal infrastructure and their customers’ infrastructures.
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Internally, a Service Provider network is similar to an enterprise network; both view their 
networks as regions with dedicated NOC/SOC, and both use the same types of 
administrators.
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Telcos and Service Providers use their networks to generate revenue. Customers pay the 
MSSP to deploy devices and to manage the VPN or FW infrastructure. MSSPs use 
different role structures that best match their organizational structure:

• MSSP owns devices; customer manages infrastructure
• Customer owns devices; MSSP manages infrastructure
• Customer leases devices; MSSP manages the infrastructure
• MSSP owns devices and manages infrastructure (Customer Network 

Management (CNM))
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CNM Service Providers vary widely in how they control access to their customer 
networks. Some CNMs assign one or more customers to a network administrator that has 
control over the device and policies used by those customers. Other CNMs assign one 
network administrator to view reports for all customers. CNMs might use the following 
role structure:

• Super administrator. At the global domain, the super administrator creates
– The internal network of the CNM.
– A subdomain for each customer. The customer subdomain contains the 

devices and objects that belong to the customer network. Because the 
customer network is completely contained within a subdomain, it is 
isolated from other subdomains for other customers.

– Customer administrators to manage one or more subdomains. The super 
administrator assigns roles to the customer administrator in one or more 
customer subdomains, enabling the customer admin to handle multiple 
customer networks without access to the CNM internal network.

Additionally, the super administrator can create a role structure that maps to the specific 
tasks performed by each customer administrator, as described in “Specific Tasks” on page 
28.

MSSPs can also use Virtual Systems (available on NetScreen-500 and -5000 series) to 
share a single device between multiple customers. For each customer, the MSSP creates a 
customer subdomain and a virtual system within that subdomain.
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When you have analyzed your network and permission structure and designed your 
domain strategy, you are ready to create subdomains and new NetScreen-Security 
Manager administrators for those subdomains. When you create NetScreen-Security 
Manager administrators for your subdomains, you can set their permissions so that they 
can see only the domains to which they have access.

From the menu bar, click Tools > Manage Administrators & Domains to display the role-
based administration settings for NetScreen-Security Manager:

• Administrators. Configure administrators for NetScreen-Security Manager.
• Roles. View or edit default roles, or create your own custom roles for your 

NetScreen-Security Manager admins.
• Subdomains. Create subdomains to segregate networks.
• Current Domain Detail. View the information about the current domain, such 

as assigned administrators, authentication method, and default authentication 
servers.

The following sections detail how to configure these role-based administration settings. 
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The super administrator automatically has full permissions for all subdomains, so you 
don’t need to assign new subdomains to the super administrator. However, to assign the 
subdomain to another administrator, you must first create the administrator and specify 
their permissions within a selected subdomain.

You can create NetScreen-Security Manager administrators at the global domain level or 
at the subdomain level:

• To assign the new admin permissions in the global domain or permissions in 
multiple subdomains, create the admin in the global domain.

• To assign the new admin permissions in only one subdomain, create the admin 
in that subdomain.

����
�	�
���?����� �����
���
To create an NetScreen-Security Manager administrator, click the Add icon in the 
Administrator tab to display the New Admin dialog box. In the General tab, enter a name 
and contact information (email, phone, etc.) for the new administrator.

Note: If you are migrating from Juniper Networks NetScreen-Global PRO or Global 
PRO Express, you can migrate your existing domain structure and administrators. For 
details, see the NetScreen-Security Manager 2004 Migration Guide.
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To configure the authorization method for the new administrator, click the Authorization 
tab and select local or remote authentication: 

• For locally authenticated administrators, the NetScreen-Security Manager 
management server handles authentication. You must specify the password that 
NetScreen-Security Manager uses to authenticate the admin; the admin must 
enter this password at the NetScreen-Security Manager UI login screen.

• For remotely authenticated administrators, a RADIUS authentication server 
handles authentication. Because the admin password is stored on the RADIUS 
server, you do not need to enter the password again, however, the admin must 
enter the password at the NetScreen-Security Manager UI login screen.

To configure the RADIUS authentication server for NetScreen-Security 
Manager administrators, see the Online Help topic “Editing the Domain 
Contact.”
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To assign permissions to the new admin, click the Permissions tab and select a role for the 
new admin. A role is a collection of predefined activities that define access to NetScreen-
Security Manager functionality. When you assign a role to an NetScreen-Security 
Manager admin, the admin can perform the predefined system activities specified in that 
role. 

You can select a default or custom role for that administrator. NetScreen-Security 
Manager includes default roles for common job responsibilities:

• Domain Administrator. Can perform all activities in the domain
• Read-Only Domain Administrator. Can perform all read-only activities in 

the domain
• System Administrator. Can perform all system-wide activities and Domain 

Administrator activities
• Read-Only System Administrator. Can perform all read-only system-wide 

activities and Domain Administrator activities

Each default role contains activities that relate to the traditional responsibilities for a 
specific job title. Use a default role to quickly create NetScreen-Security Manager 
administrators, or when your organization’s existing permission structure maps closely to 
the permissions defined in the default role.

Note: The super administrator has immutable powers. You cannot change or 
delete permissions for the super administrator; you can, however, change the 
password for the super admin. Because this admin has complete control over 
NetScreen-Security Manager functionality, Juniper Networks recommends that 
you consider the security of the super administrator password appropriately. If 
you forget or lose the super administrator password, please contact Juniper 
Networks technical support.
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All roles, default and custom, are created from activities. In a default role, the activities 
are chosen for you; in a custom role, you choose the activities that make up the desired 
functionality. For details on creating custom roles, see “Creating Roles” on page 32. 

You must also select a domain. You can assign admins to the global domain, or to one or 
more subdomains (the subdomain must already exist). Administrators must log in to the 
domain they were created in. For example, the super admin has access to all domains, but 
must log in to the global domain first, then switch to a subdomain using the domain 
menu. For details on creating a subdomain, see “Creating Subdomains” on page 35.
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Click the Roles tab to display available roles. NetScreen-Security Manager includes four 
default roles, as described above, and can contain an unlimited number of custom roles.
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For more complex and diverse permissions requirements, create custom roles to specify 
the exact level of permission you want to give an admin. An activity is a predefined task 
that defines access to a function in NetScreen-Security Manager. To assign one or more 
activities to an NetScreen-Security Manager admin, create a role that includes those 
activities and assign the role to the admin.

Click the Add icon to display the New Role dialog box and all available activities. 
NetScreen-Security Manager includes 75 predefined activities, grouped by similar 
functionality.

Note: Role assignment is additive. When you assign multiple roles to a single 
admin, the permissions specified by the activities in the role are added.

Function Task Description

Admins View
Create
Edit
Delete

An admin is a user of the NetScreen-Security Manager 
management system.

Admin Roles View
Create
Edit
Delete

An admin role defines the access privileges for a NetScreen-
Security Manager administrator.

Audit Logs View An audit log records an administrative change (such as login, 
update, or policy change) to the managed devices or 
management system.

Devices, Device 
Groups, & Templates

View
Create
Edit
Delete

• A device is a NetScreen FW/VPN device.

• A device group is a collection of managed devices.

• A template is a device configuration that contains predefined, 
static configuration information, such as networking settings, 
interface settings, or DNS settings.
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Device Certificates Generate 
& Upload
Get
Edit
Delete

A device certificate authenticates packets passing through a 
device.

Device Software Keys Install A device software key provides enhances or adds functionality 
for a managed device.

Device Running Config View A device running config is a report that details the device 
configuration running on the physical device.

Device Delta Config View A device delta config is a report that details the differences 
between the device configuration running on the physical 
device and the modeled device configuration in NetScreen-
Security Manager.

Device Firmware Update The device firmware is the ScreenOS software image used on 
the managed device.

Device Configuration View
Update

A device configuration is the modeled configuration that exists 
for a managed device within NetScreen-Security Manager.

Device Reboot Reboot A device reboot is a reboot command sent to a managed device 
to power down, then power up.

Subdomains & Groups View
Create
Edit
Delete

A subdomain is a separate, unique representation of other 
networks that exist within your larger network.

System Error Logs View A system error log displays information about a system error.

Historical Log Reports View An historical log report is a report generated using historical log 
entries. 

Investigative Log 
Reports

View An investigative log report is generated using the Log 
Investigator. 

Active Jobs Cancel An active job is a task that NetScreen-Security Manager is 
currently performing, such as rebooting, updating, or firmware 
change. Active jobs display in the Job Manager.

Jobs View A job is a task that NetScreen-Security Manager can perform.

Device Logs View
Hide & 
Unhide
Purge

 A device log records a security event that occurred on a FW/
VPN device.

Device Log Comments Update A device log comment is a user-defined description of a security 
event that is recorded in a device log.

Device Log Flags Update A device log flag is visual icon that can be assigned to a device 
log. Admins can assign flags to indicate severity, status, etc. to 
a device log.

Device Status Monitor View The device status monitor tracks the status NetScreen FW/VPN 
devices, VPN tunnels, and NSRP.

Function Task Description
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Some activities are dependant on other activities. If you select a dependant activity, 
NetScreen-Security Manager automatically selects the prerequisite activities. You can 
clear prerequisite activities from a custom role, but doing so affects permissions granted 
in the dependant activity.

For example, if you create a role that includes the activity “Create VPNs”, the activities 
“Edit VPNs” and “View VPNs” are automatically selected for you.
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When you create an administrator, you can assign a custom role just as you would a 
default role. However, you cannot assign an activity or role that you do not possess to 
another admin (the activity or role is not visible in the list of available activities or roles).

Implicit N/A

Migration N/A Migration is the ability to migrate data from a Global PRO 
system to NetScreen-Security Manager 2004.

NSRP Monitor View NSRP Monitor tracks NSRP statistics. To enable NetScreen-
Security Manager to track these statistics, you must enable 
“NSRP Monitor” in the NSRP properties for each cluster device. 

Shared Objects & 
Groups

View
Create
Edit
Delete

An object contains re-usable information. Shared objects 
include address book objects, schedule objects, attack objects, 
service objects, and user objects.

Policies & Groups View
Create
Edit
Delete

A policy is a set of rules that determines how a device responds 
to incoming packets. 

Realtime Monitor View The Realtime Monitor module tracks device statistics, VPN 
tunnel statistics, and NSRP statistics in real time.

Servers View
Create
Edit
Delete

The Device Server and GUI Server comprise the NetScreen-
Security Manager system. 

VPN Monitor View VPN Monitor tracks VPN tunnel statistics. To enable 
NetScreen-Security Manager to track these statistics, you must 
enable “VPN Monitor” in the Gateway properties for each VPN. 

VPNs View
Create
Edit
Delete

A VPN is a virtual private network that exists between two or 
more NetScreen FW/VPN devices, extranet devices, or RAS 
users.

Function Task Description



Configuring Role-Based Administration

NetScreen-Security Manager 2004 FP2 35

Within a domain, you can view only the custom roles that you have created or 
that have been assigned to you. You cannot view custom roles created by other 
administrators, even if the role is in the same domain and includes the same activities 
already assigned to you.
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To create a subdomain, in the Subdomains tab, add a new subdomain and click apply. The 
new subdomain appears in the subdomain list. 

You can add unlimited subdomains in the global domain, however, you cannot create 
subdomains within a subdomain. Additionally, when you view the Manage Domains and 
Administrators dialog box from within a subdomain, the Subdomains tab does not appear.

To view a subdomain in the main display area, select it from the pull-down menu at the 
top of the navigation tree.
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The domain detail displays the subdomains, administrators, their roles, and 
authentication server for the currently selected domain (subdomains appear only when in 
the global domain). 

You can designate a default RADIUS authentication server for the global domain and for 
each subdomain. The default auth server is used:

• To authenticate administrators when they log into the NetScreen-Security 
Manager system

• To authenticate RAS users in VPNs

For step-by-step instructions on configuring a RADIUS authentication server to 
authenticate administrators and users, see the Online Help topic “Editing the Domain 
Contact.”
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Each time you update a device configuration on a NetScreen FW/VPN device using 
NetScreen-Security Manager, a new version of the device domain is automatically 
created. NetScreen-Security Manager archives the previous domain version and stores it 
on the GUI Server. You can view these previous versions to identify changes in the 
domain. 

Note: You cannot create VPNs between devices in different domains, unless you 
use the workaround detailed in “Using Devices in VPNs” on page 54.
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To view a previous version of a domain, click Tools > Select Domain Version, and select 
the domain version. Domain versions display according to their timestamp, which 
indicates the time and date a device configuration in the domain was last installed on a 
managed device. After you have selected domain, click OK; NetScreen-Security Manager 
displays the archived domain version as a read-only domain.

An archived domain version displays the modules (Device Manager, Security Policies, Log 
Investigator, etc.) that were saved during the versioning process. Because the versioning 
process saves only the modules that were changed, some modules might not appear. You 
cannot edit objects, policies, or other parameters for an archived domain version. 

To return to the current domain version, click Tools > Select Domain Version, and select 
the most recent domain version. 
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In this example, you configure a domain structure for an Internet Service Provider (ISP) 
with a co-location facility in New York that handles customers across four states. The 
company uses a two-letter state postal code combined with the customer name. Their goal 
is to manage all devices and policies from the co-location facility, but provide read-only 
permission for customers to view log entries and generate reports. No VPNs are used.

To configure this domain structure, use the following process:

• Create the subdomains
• Create the subdomain administrators
• Create the read-only customer administrator
• Login as each administrator (for verification)
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In this step, you create a subdomain for each company that uses the ISP. 

1. Log in to the global domain as the superadmin. From the Menu bar, click Tools > 
Manage Domains & Administrators. 

2. Click the Subdomains tab, then click the Add icon to create a subdomain for the 
first customer. Configure four subdomains, as shown below:

3. Click OK to save your changes. 
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In this step, you create a subdomain administrator with full permissions for the domain.

1. Using the domain menu (at the top of the navigation tree), select the first 
subdomain (MA_company1). NetScreen-Security Manager loads the subdomain. 

2. From the Menu bar, click Tools > Manage Domains & Administrators. 
3. In the Administrators tab, click the Add icon to create the primary 

administrator for this domain:
– In the General Properties tab, enter a name, color, and contact 

information for the admin.
– In the Authorization tab, leave the default authentication as Local and 

configure a password for the admin.
– In the Permissions tab, click the Add icon to select a role and domain as 

shown below:

4. Click OK to save your changes. 
5. Repeat for each subdomain.
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In this step, you create a custom role and admin account that permits the ISP customers 
to view log entries and generate reports for devices in their subdomain.

1. Using the domain menu (at the top of the navigation tree), select the first 
subdomain (MA_company1). NetScreen-Security Manager loads the subdomain. 

2. From the Menu bar, click Tools > Manage Domains & Administrators. 
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3. In the Roles tab, click the Add icon to create a role that includes viewing and 
reporting permissions for this domain, as shown below:

4. Click OK to save your changes. 
5. In the Administrators tab, click the Add icon to create the customer 

administrator for this domain:
– In the General Properties tab, enter a name, color, and contact 

information for the admin.
– In the Authorization tab, leave the default authentication as Local and 

configure a password for the admin.
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– In the Permissions tab, click the Add icon to select a role and domain as 
shown below:

6. Click OK to save your changes and return to the Administrators tab, which 
should display the following administrators:

7. Click OK to save your changes. 
8. Repeat for each subdomain.
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In this step, you login as each administrator to verify their permissions (administrators 
must log in to the domain they were created in). Start a new instance of the NetScreen-
Security Manager UI, then login as the following admins to test permissions.
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• Logging in as the Domain Administrator. To login as the domain 
administrator, in the login screen, enter the subdomain, domain admin name, 
password, and GUI Server IP address as shown below:

Click OK to login. The NetScreen-Security Manager navigation tree and main 
display area appear. Because the domain admin account has full permissions for 
the domain, the UI displays all modules and enables all functionality for the 
domain. However, the domain menu (at the top of the navigation tree) displays 
only the current domain, restricting the domain admin to that domain.

Repeat for each subdomain and domain admin.

• Logging in as the Customer Administrator. To login as the customer admin, 
in the login screen, enter the subdomain, customer admin name, password, and 
GUI Server IP address as shown below:

Click OK to login. The NetScreen-Security Manager navigation tree and main 
display area appear. Because the customer admin account has permission only 
for viewing and report, the UI displays only the modules that are use for those 
permissions (note that Server Manager, Job Manager, and the Audit Log Viewer 
do not appear). Additionally, all Add, Edit, and Delete icons appear in gray, 
indicating that the admin cannot perform these tasks.

Repeat for each subdomain and customer admin.
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After you have configured domains, roles, and administrators, the next step in using 
NetScreen-Security Manager to manage your NetScreen FW/VPN devices is to create a 
virtual network in NetScreen-Security Manager that represents your physical network. 
Using this virtual network, you can create, control, and maintain the security of your 
physical network at a system-level.

Some questions you might want to consider include:

• Where should you start and why?
• What is the best order to do things? Why?
• Are you building a new network? Are you importing an existing network?
• How do you use NetScreen-Security Manager to improve your existing network 

structure?
• How do you use management features to simplify your day-to-day 

administrative tasks?

The following sections provide information to help you decide how best to create your 
virtual network and simplify management tasks.
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You have two options for creating your virtual network:

• Model devices in NetScreen-Security Manager. If you do not have a NetScreen 
FW/VPN device deployed on your network, you can create the device 
configuration in NetScreen-Security Manager. When you physically deploy your 
device, you can install the modeled device configuration on that device to 
instantly get it up and running.

• Import devices into NetScreen-Security Manager. If you have NetScreen FW/
VPN devices deployed on your network, you should import and verify their 
device configurations.

A third option, Migration, exists for devices that are current managed by NetScreen-
Global PRO or Global PRO Express. For complete information on NetScreen-Security 
Manager migration, see the NetScreen-Security Manager 2004 Migration Guide.
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For new networks or networks that do not use a previously deployed Juniper Networks 
NetScreen security device, you should review your network topology thoroughly and 
design a security system that works for your organization.

When creating a new security network using NetScreen-Security Manager:

1. Create the domain structure that best suits your network topology and access 
requirements.

2. Create NetScreen-Security Manager administrators and set their permission 
level by creating and assigning roles.
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3. Add your security devices and create their device configurations. You’ll need to 
define zones, assign interfaces, designate virtual routers, etc. to enable the 
firewall to pass traffic on the network. 

– Use templates to configure multiple devices. Templates help you re-use 
common information to quickly create configurations for similar devices.

– For ScreenOS 5.x devices, you can use Rapid Deployment (RD) to deploy 
multiple devices in non-technical locations. Use RD to stage and configure 
devices quickly, then simultaneously update all device with policies to 
control traffic as desired in multiple locations.

4. Create the objects used in your Security Policies. These objects might include:
– NAT Objects for policy-based network address translation
– Address Objects for your network components
– Service Objects for your custom network services (NetScreen-Security 

Manager includes an object database of common transport and 
application-level services).

– AV objects for detecting viruses in your network traffic
– GTP objects for handling VoIP client connections

5. Create Security Policies
– Add a policy, then create firewall rules that specify source, destination, 

service, action, etc. You can also create multicast rules to handle multicast 
control traffic. Select the devices that should receive and implement this 
rule in the Install On column.

– Verify each policy using the Policy Validation tool.
6. Update devices

– Resolve any validation issues with the device configuration
– View a summary of the device configuration to ensure that all device 

parameters are correct.
– Check progress in Job Manager

7. Create VPN Rules
– Create Protected Resources
– Create User Objects and User Groups for RAS VPNs
– Use VPN Manager to select VPN members, then automatically generate 

the rules for each member

For details on adding devices, see Chapter 3, “Adding Devices”; for details on configuring 
devices, see Chapter 4, “Configuring Devices”.

�+"���
���5�
��
���/��
���
For networks with deployed NetScreen FW/VPN devices, if you have already designed, 
staged, and set up a working physical device already, you don’t need to do that again; you 
can simply import that device so it exists (virtually) inside the management station. This 
import includes the routing, IP configuration, access and Security Policies, access 
privileges, and other device-specific information defined on the device.
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Before you begin importing devices, however, you should review the import process 
thoroughly to understand how NetScreen-Security Manager will handle your 
configuration data, and to select the best method for importing your own individual 
security devices to NetScreen-Security Manager.

In general, the import process includes two concepts: importing information and verifying 
information. An overview of this process is provided below. 

1. Import your device configuration directly from the device. As NetScreen-
Security Manager imports your existing device configurations, it automatically 
creates your virtual network based on the configuration information.

2. Verify your imported device configuration:
– Run a Delta Config Summary and view the results
– Check Device configuration information
– Check Address, Service, Schedule, and NAT Objects
– Check Security Policies
– Check Protected Resources
– Check VPN Policies

3. Correct any validation errors, if found.
4. Check for duplicate objects (address objects, custom service objects, etc.). Be sure 

to consolidate any duplicate object before importing another NetScreen FW/VPN 
device.

You can also delete devices from NetScreen-Security Manager, and re-import them if 
necessary. Deleting a device removes all device configuration information from the 
management system, but might be the best solution if you need to perform extensive 
troubleshooting and/or reconfigure the device locally. After you have made the necessary 
changes locally, you can then re-import that device into the NetScreen-Security Manager 
system.

For details on importing devices, see Chapter 3, “Adding Devices”.
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A naming convention is a method for assigning names to your network devices (firewalls, 
servers, workstations, etc.) that enables you to quickly identify where the device is and 
what its purpose is.

If your network is small, you might choose a simple naming convention, such as planets, 
Science Fiction, cars, mountains, etc. When using this type of informal method to name 
your network components, be sure to choose a theme that is easily understood by both 
your users and administrators, and that still has room to grow. For example, you might 
use the naming convention: <city>_<name>, with a naming theme of Greek mythology 
figures; some sample device names might be la_ns5gt_Athena, sf_ns5XT_Zeus, 
oak_ns204. 
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If your network is larger, however, you need a more formal naming schema that is more 
descriptive of the network component’s location and purpose. Having a logical and 
standardized naming convention can help you quickly identify the appropriate 
administrator for the component, as well as quickly identify the component location of 
without having to tear through the subnet tables.

A typical naming convention for large, distributed networks consists of a standardized 
location identification code, followed by the department code, a description of function, 
and a numerical sequence.
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You use the naming convention: nation_state_city_platform_name for your NetScreen 
FW/VPN devices. Your devices use names similar to the following:

• us_ca_la_ns5gt_01
• us_co_dv_ns204_05
• us_tx_hs_ns5200_10
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For address objects that represent networks or hosts, you use the following naming 
convention: city_function_service_00.

• City. A two-character postal abbreviation for the city where the server resides.
• Function. Some common functional abbreviations:

• Service. Abbreviated name of the main service on that machine.
• Number. A sequential number starting with 01.

For example, the first Apache Web server installed in Los Angeles would read: 
la_ws_apache_01.

For address objects that represent client hosts, use the naming convention: 
city_flastname_(m or w)_os

• City. A two-character postal abbreviation for the office location the user is 
attached to.

• FLastname. The first initial and last name of the main user (or general account 
name if it is a multiuser machine)

SV Server

WS Workstation

IIS Web Server

MSX  Mail Server

SQL SQL Server

SMS SMS Server

APP Application Server
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• (M or W). A single letter to designate Mobile computer or Workstation
• OS. A two-character abbreviation for the operating system. 

For example, Wendy Parker, working in Houston on a Windows 2000 Pro laptop, would 
see her machine name as: hs_wparker_m_2kpro.
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When you add your FW/VPN devices to NetScreen-Security Manager, you are creating the 
network organization that you will use to manage your security system. Before you begin 
the device creation or device import process however, first review your network topology 
and decide how you want it to appear in NetScreen-Security Manager. This is particularly 
important when you are creating a new network, but is also helpful when you are 
importing networks, as you might want to edit your network design to take advantage of 
key NetScreen-Security Manager management features.

These features include:

• Using Device Groups
• Using Device Templates
• Merging Policies
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You can create groups of devices to help you manage multiple devices at one time. Group 
your device by region, device type, or even OS version, then use the groups to:

• Deploy new or updated device configurations to the entire device group
• Deploy new or updated policies to the entire device group
• Create reports using the log information from the entire device group
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A template is a predefined device configuration that helps you re-use common 
information. A domain can contain multiple templates, and you can use templates to 
quickly configure and deploy multiple devices. A device template looks much like a device 
configuration—the template page displays boxes for interfaces, zones, virtual routers, 
etc., in which you can enter values. When you add a new device that uses similar 
information as a previously added device, you can use a device template to fill in specific 
configuration values so you do not have to re-enter information. 

For example, you might create a generic NetScreen-5XT template that you can use each 
time you add a device of that type. Or, you can apply multiple templates to the same 
device. You can map a maximum of 31 templates to the same device; you set the priority of 
the template to determine the order in which they applied.

For example, you might create the following templates:

• DNS setting template
• Default PKI Settings template



Chapter 2 Configuring Role-Based Administration (RBA)

46 Administrator’s Guide

• Authentication template

Then, apply these template to a single device to instantly configure the DNS, PKI, and 
Authentication settings for the device.
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You can create new policies for all your managed devices from the central NetScreen-
Security Manager UI and deploy them with a single click. Alternatively, NetScreen-
Security Manager can import all existing policies from your FW/VPN device. You can 
import all security and access policies from your NetScreen FW/VPN devices, and import 
all VPN tunnels (route-based and policy-based) from your NetScreen FW/VPN devices.

Each time you import a policy from a managed device, that policy appears in NetScreen-
Security Manager as a separate, individual policy in the Security Policies list. To simplify 
policy management and maintenance, you can merge two policies into a single policy. For 
details on merging policies, see Chapter 8, “Configuring Security Policies”. 

Note: You cannot create VPNs between devices in different domains.
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• About Device Creation

• Before You Begin

• Importing Devices

• Modeling Devices

• Using Rapid Deployment

• Adding Other Device Types

• Adding Many Devices

Devices are the Juniper Networks NetScreen security devices (FW/VPN devices) that you 
use to enable access to your network components and to protect your network against 
malicious traffic. 

Juniper Networks NetScreen-Security Manager can manage all Juniper Networks 
NetScreen FW/VPN devices running Juniper Networks NetScreen ScreenOS 5.x and 
ScreenOS 4.0.x (except 4.0.2). NetScreen-Security Manager can also manage vsys 
configurations, NSRP clusters, and extranet devices.

Before you can manage a device with NetScreen-Security Manager, you must add the 
device to the management system. NetScreen-Security Manager supports adding 
individual devices or many devices one at a time.

Use Rapid Deployment (RD) to quickly add devices in non-technical environments with no 
staging requirements.

Note: The Juniper Networks NetScreen-5 device, Juniper Networks NetScreen-10 
device, and Juniper Networks NetScreen-1000 device are not supported.
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Before NetScreen-Security Manager can manage your devices, you must first add those 
devices to the management system using the UI. To add a device, you create an object in 
the UI that represents the physical device, then create a connection between the UI object 
and the physical device so that their information is linked. When you make a change to 
the UI device object, you can push that information to the real device so the two remain in 
sync. You can add a single device at a time, or add multiple devices all at once.

You can add the following types of devices:

• NetScreen FW/VPN devices and systems (NetScreen-5GT device, 
NetScreen-208 device, etc.). The “Importing Devices” on page 56 and “Modeling 
Devices” on page 65 sections of this chapter detail how to add an existing or new 
NetScreen FW/VPN device into NetScreen-Security Manager. For details on 
adding many devices or systems at one time, see “Adding Many Devices” on page 
83.

• vsys devices. A vsys is a virtual device that exists within a physical NetScreen 
FW/VPN device. For details on adding vsys devices, see “Adding Vsys Devices” 
on page 78.

• Clusters. A cluster is two NetScreen FW/VPN devices joined together in a high 
availability configuration to ensure continued network uptime. For details on 
adding clusters, see “Adding a Cluster” on page 81.

• Extranet devices. Firewalls or VPN devices that are not NetScreen FW/VPN 
devices. For details on adding extranet devices, see “Adding an Extranet Device” 
on page 81.

To add any device type, you must determine the device status before you add the device, 
then verify the device configuration after the device is added to NetScreen-Security 
Manager.
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How you add your devices to the management system depends on the network status of 
the device:

• Import deployed devices. Deployed devices are the devices you are currently 
using in your existing network. These devices run 5.x or earlier version of 
ScreenOS, and have already been configured with an IP address, zones, etc. For 
deployed devices, you can import the existing device configuration information 
into NetScreen-Security Manager.

• Model undeployed devices. Undeployed devices are devices that you are not 
currently using in your network, and typically do not have IP addresses, zones, 
etc. For undeployed devices, you can model a new device configuration, then 
install that configuration on the device.

Note: The connection between a managed device and the NetScreen Security Manager 
Device Server must be at least 28.8 kbps.
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To help you add a device, the UI contains an Add Device wizard that walks you through 
each step of the device creation process. The Add Device wizard prompts you for specific 
device information like device type, IP address, device admin name and password, etc., 
then uses that information to enable the physical device to connect to the Device Server. 

After the physical device connects, it is considered a managed device, meaning it is now 
under the control of the NetScreen-Security Manager.
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For managed devices that use imported device configurations, you will want to verify that 
all device information was imported correctly. To identify any discrepancies, you can 
generate a summary of the differences between the physical device configuration and the 
NetScreen-Security Manager device configuration (this summary is known as a Delta 
Configuration Summary). It’s also a good idea to check your imported Security Policies, 
objects, and VPNs to become familiar with how the NetScreen-Security Manager UI 
displays them.

For managed devices that use modeled device configurations, you will want to verify that 
all device information was pushed to the physical device correctly. To identify 
discrepancies, you can generate a summary of the device configuration that is running on 
the physical device (this summary is known as a Get Running Config Summary).
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After you have successfully added a device, you can begin managing its device 
configuration, objects, and policies in the UI. You can also begin viewing traffic log entries 
for your device in the Log Viewer, administrative log entries in the Audit Log Viewer, and 
monitoring the status of your devices in Realtime Monitor.

You can also delete devices from NetScreen-Security Manager, and re-import them if 
necessary. Deleting a device removes all device configuration information from the 
management system, but might be the best solution if you need to perform extensive 
troubleshooting and/or reconfigure the device locally. After you have made the necessary 
changes locally, you can then re-import that device into the NetScreen-Security Manager 
system. However, during re-import, NetScreen-Security Manager imports all device 
configuration data—not just the data that was changed; any changes that exist in the 
modeled configuration will be lost during re-import. Additionally, after re-importing a 
device configuration, you must reassign the imported policy to the device.

If you delete a device that was added using Rapid Deployment (described on page 72), you 
must also re-create the configlet and install it again on the device.



Chapter 3 Adding Devices

52 Administrator’s Guide

��(����#�����
	
Before you add a device to NetScreen-Security Manager, you should check the ScreenOS 
version that is running on the device, decide if you will import or model the device, and 
determine the location (global domain or subdomain) for the device.
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Ensure that the devices you are adding to NetScreen-Security Manager are running a 
supported version of ScreenOS. NetScreen-Security Manager supports devices running 
4.x or newer versions of ScreenOS; if you are not running a supported version, you must 
upgrade your devices before adding them into the management system. Contact Juniper 
Networks customer support for details.
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Decide if you want to import or model your devices in NetScreen-Security Manager. 
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If you are currently using NetScreen FW/VPN devices in your existing network, you can 
add these devices into NetScreen-Security Manager and import their configurations. 
Using the Add Device Wizard, you configure a connection between the management 
system and the physical device, then import all device parameters, policies, objects, VPNs, 
etc. 

After you have imported several devices, you can start using system-level management 
features, such as the policy merge tool (merge several device Security Policies into a 
single, efficient policy that is easy to maintain), device groups (group devices by function, 
location, or platform to make updating easier), and the VPN Manager (create VPNs across 
multiple devices quickly).
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For new or undeployed NetScreen FW/VPN devices, you can add and configure the device 
in NetScreen-Security Manager, then activate when you are ready to deploy the physical 
device on your network. 

Before connecting to the device, simply create a device (using the Add Device Wizard) that 
represents the ScreenOS platform and NetScreen FW/VPN device type of the actual, 
physical device. Then, model the device configuration in the NetScreen-Security Manager 
UI. Configure zones, interfaces, virtual routers, policies, logging features—all device 
features. Finally, activate the device (using the Activate Device Wizard) by configuring a 
connection between the management system and the physical device, then update the 
modeled configuration to the device. 
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To quickly configure multiple devices, use templates (re-usable, custom device settings 
such as DNS settings, PKI settings, etc.) and objects (re-usable, custom objects such as 
NAT objects, CA certificates, etc.). For large deployments that involve multiple devices in 
non-technical environment, use Rapid Deployment (RD) to bring new FW/VPN devices 
under NetScreen-Security Manager management for initial configuration.
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Although the Add Device Wizard and Activate Device Wizard automatically handle many 
of the tasks involved in adding a device to the management system, you might need to 
manually perform some steps after using a wizard to complete the device add process.

The amount of manual involvement when adding a device to NetScreen-Security Manager 
depends on several factors, such as if you are importing a deployed device, activating a 
modeled device, the version of ScreenOS the device is running, and the type of IP address 
(static or dynamic) the device uses to connect to the management system. The illustration 
shown below details the different device add processes and required manual steps for 
adding each type of NetScreen FW/VPN device and ScreenOS version:

5.x Static 5.x Dynamic4.0.x Static 4.0.x Dynamic

NSM Prompts 
Device to 
Establish 
Connection

Enter CLI 
Commands 
on Device

Enter CLI 
Commands 
on Device

Send Configlet to 
On-Site Admin

Use 
Configlet?

Manually 
Update 
Configuration

Device Connects 
to NSM

Device Connects 
to NSM

Done!
Manually 
Import 
Configuration

NSM 
Automatically 
Imports 
Configuration

ActivateActivate

AddAdd

You must manually 
perform these actions

After you have finished using the Add Device Wizard or 
Activate Device Wizard, NetScreen-Security Manager 
begins attempting to add the device to the management 
system. Depending on the ScreenOS version and IP 
address type, you might need to perform manual tasks.

NSM and the device automatically 
perform these actions for you.
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Determine the domain you want the device to exist in. A domain is a logical grouping of 
devices, their policies, and their access privileges. NetScreen-Security Manager includes a 
global domain by default; you can also create additional domains, called subdomains, that 
exist within the global domain. Before you add the device, you must select the domain 
that contains the device; after the device is created, it appears only in that domain, and 
must be managed from that domain.
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Domain selection is critical if you plan to use VPNs in your network. Because you can 
create VPNs only between devices in the same domain, be sure to add the devices you 
want to connect with a VPN to the same domain. If you need to add a device to a VPN in a 
different domain, add the device as an extranet device in the domain that contains the 
VPN, then add the extranet device to the VPN. An example is shown below:
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When you log in to the UI for the first time after installing the management system, 
NetScreen-Security Manager loads the global domain by default, and the Device Manager 
does not contain any devices.

To begin adding devices, ensure that you are in the domain you want to add the device to:

• Add device to the global domain. Ensure that you are in the global domain 
and begin the device creation process.

• Add device to an existing subdomain. From the domain menu at the top of 
the navigation tree, select the subdomain you want to add the device to and then 
begin the device creation process. The domain menu displays only the domains 
you have access to.

Global Domain

Domain 1

Domain 2

Domain 3

Extranet Device 
(NetScreen-500)

Extranet Device 
(NetScreen-204)Extranet Device 

(NetScreen-50)

VPN



Before You Begin

NetScreen-Security Manager 2004 FP2 55

• Add device to a new subdomain. You must first create the new subdomain in 
NetScreen-Security Manager before adding devices to that subdomain. For 
details on creating new subdomains, see “Configuring Role-Based 
Administration” on page 30. After you have created the subdomain, select it 
from the domain menu and begin the device creation process.
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Determine if you want to add devices to NetScreen-Security Manager individually, or add 
many devices all at one time (FW/VPN devices and systems only). The adding process for 
a single device is different than the process for adding multiple devices.

When adding a single FW/VPN device, you use the Add Device Wizard to create the device 
object in NetScreen-Security Manager. To activate a modeled device and/or create a 
configlet, you use the Activate Device Wizard. You can import or model device 
configurations from a device running ScreenOS 4.0.x or 5.x.

When adding many devices, you first create a .csv file that defines all required and 
optional parameters for each device, then use the Add Many Device Wizard to create a 
device object for each device in NetScreen-Security Manager. To activate modeled devices 
and create configlets for each device, you use the Activate Many Device Wizard. 

You can use the Add Many Devices wizard for the following tasks:

• Import many ScreenOS 4.0.x and 5.x devices at one time. 
• Model many ScreenOS 5.x devices at one time.
• Model, create configlets for, and activate multiple ScreenOS 5.x devices at one 

time for use with Rapid Deployment.

Additionally, you can use the Activate Many Devices wizard to create configlets for and 
activate multiple ScreenOS 5.x devices at one time for use with Rapid Deployment.

However, you cannot activate multiple ScreenOS 5.x devices without creating configlets. 
For details, see “Adding Many Devices” on page 83.

Note: After you have created subdomains, you can load a specific subdomain 
automatically when you log in to the UI. You must have access to that subdomain, and 
permissions to create, edit, and view devices in that subdomain.
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NetScreen-Security Manager can import device configurations from devices running 
ScreenOS 5.x or earlier. The process differs slightly for 5.x devices and 4.0.x devices. 

When importing ScreenOS 4.0.x devices, the management system connects to the device 
and imports the CLI command statements that detail the device configuration. The 
connection is secured using a standard encryption method; multiple, temporary 
connections between the management system and device are possible. 

When importing ScreenOS 5.x devices, the management system connects to the device 
and imports Data Model (DM) information that details the device configuration. The 
connection is secured using Secure Server Protocol (SSP), a proprietary encryption 
method; an always-on connection exists between the management system and device.

Adding a single deployed device to NetScreen-Security Manager is a three stage process:

1. Add the device.
2. Import the configuration.
3. Verify the imported configuration.

In some cases, you may need to configure NACN, or other features on the physical device 
to enable the device to connect to NetScreen-Security Manager. 

For details on adding multiple devices at one time, see “Adding Many Devices” on page 83.
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To import a single device:

• The physical device must have Telnet or SSH enabled.
• You must have the device connection information (IP address, etc.) and device 

admin name and password available.
• The device must be staged, meaning it is connected to your network and has 

network connectivity.
• The device must have at least one interface that has an IP address. Devices that 

use dynamically assigned IP address must also support NACN.
• Ensure that the device is operating in the desired mode. You cannot change the 

operational mode after importing the device into NetScreen-Security Manager.

Note: After importing a device configuration, log entries from that device begin to 
appear in the Log Viewer. However, until you update the device from NetScreen-
Security Manager, the following log fields display 0 (or unknown):

• For 5.x devices: domain, domain version, rulebase, policy, rule number.

• For 4.0.x devices: domain, domain version, rulebase, policy, rule number, from 
zone, to zone, action.

After you update the imported device configuration using NetScreen-Security 
Manager, the appropriate values are displayed for log entries from the device.
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A static IP address is an IP address that does not change.
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To import a ScreenOS 4.0.x device with a known IP address:

1. From the domain menu, select the domain in which to import the device.
2. In Device Manager, click the Add icon and select Device. The Add Device wizard 

appears. 
– Enter a name and select a color to represent the device in the UI.
– Select Device is Reachable (default).

3. Click Next to display the Specify Connection Settings dialog box. Enter the 
connection information:

– Enter the IP Address of the NetScreen FW/VPN device.
– Enter the username of the device admin.
– Enter the password for the device admin.
– Select the connection method (Telnet, SSH version 1, SSH version 2) and 

the port number for the selected service.

If you selected Telnet, click Next and goto step 4.

If you selected an SSH version, click Next to display The Verify Device 
Authenticity dialog box. The device wizard displays the RSA Key 
FingerPrint information; to prevent man-in-the-middle attacks, you 
should verify the fingerprint using an out-of-band method.

4. The wizard displays the autodetected device information. Verify that the device 
type, ScreenOS version, and the device serial number are correct, then select the 
Device Server connection:

– Use the default settings to configure the device to connect to the 
NetScreen-Security Manager Device Server IP address and port.

– Use a MIP to configure the device to connect to the NetScreen-Security 
Manager Device Server through a mapped IP address and port.

Click Next.

5. Select Enable Logging to enable NetScreen-Security Manager to collect log 
entries from the device.

6. To configure NACN, click the Add icon to display the Arbitrator dialog box. The 
Add Device Wizard automatically completes the PM Cert Subject Name, Device 
Server Address, and NACN Registering Port for you. Configure the remaining 
fields:

– For Interface Monitored, select the untrust interface. 
– For NACN Password, enter the password that authenticates NACN 

communication between the device and the management system.
– Click OK to add the NACN Arbitrator.
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– Click Show Device Commands to display a list of CLI commands. Copy 
and paste these commands into a text file.

– Send the commands to the device administrator. The device admin must 
make a telnet connection to the physical device, paste the commands, and 
execute them to enable NACN on the device.

The device cannot connect to NetScreen-Security Manager until these 
commands are executed on the physical device.

7. Click Finish to complete the Add Device wizard. The wizard automatically 
imports the device configuration. After the import is complete, double-click the 
device to view the imported configuration. 

To check the device configuration status, mouseover the device in Device Manager (you 
can also check configuration status in Device Monitor). The device status displays as 
Managed, indicating that the device has connected and the management system has 
successfully imported the device configuration.
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To import a ScreenOS 5.x device with a known IP address:

1. From the domain menu, select the domain in which to import the device.
2. In Device Manager, click the Add icon and select Device. The Add Device wizard 

appears. 
– Enter a name and select a color to represent the device in the UI.
– Select Device is Reachable (default).

3. Click Next to display the Specify Connection Settings dialog box. Enter the 
connection information:

– Enter the IP Address of the NetScreen FW/VPN device.
– Enter the username of the device admin.
– Enter the password for the device admin.
– Select the connection method (Telnet, SSH version 1, SSH version 2) and 

the port number for the selected service.

If you selected Telnet, click Next and goto step 4.

If you selected an SSH version, click Next to display The Verify Device 
Authenticity dialog box. The device wizard displays the RSA Key 
FingerPrint information; to prevent man-in-the-middle attacks, you 
should verify the fingerprint using an out-of-band method.

4. The wizard displays the autodetected device information. Verify that the device 
type, ScreenOS version, and the device serial number are correct.

Note: The device admin can also use a console connection to execute the 
commands on the physical device. However, the commands must be 
entered three at a time to ensure that the device receives all commands.
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5. Click Finish to complete the Add Device wizard. The new device appears in the 
Device Manager list.

6. To check the device configuration status, mouseover the device in Device 
Manager (you can also check configuration status in Device Monitor):

– Before the device connects, the status displays Waiting for 1st connect, 
indicating that the management system is waiting for the device to 
connect. (This event occurs very quickly and might not display.)

– After the device connects, the status displays Import Needed, indicating 
that the device has connected but the management system has not 
imported the device configuration yet.

7. Import the device configuration by right-clicking the device and selecting Import 
Device. The Job Information box appears and displays the job type and status for 
the import; when the job status displays successful completion, click Close.

After the import is complete, double-click the device in Device Manager to view the 
imported configuration.

To check the device configuration status, mouseover the device in Device Manager (you 
can also check configuration status in Device Monitor). The device status displays as 
Managed, indicating that the device has connected and the management system has 
successfully imported the device configuration.
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A dynamic IP address is an IP address that changes. To add a ScreenOS device that uses 
a dynamic IP address, the device must support NACN.
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To import a ScreenOS 4.0.x device with an unknown IP address: 

1. From the domain menu, select the domain in which you want to import the 
device. 

2. In Device Manager, click the Add icon and select Device. The Add Device wizard 
appears.

– Enter a name and select a color to represent the device in the UI. 
– Select Device is not Reachable.

3. Click Next to display the New Device dialog box:
– Enter the device type and specify the ScreenOS version that is running on 

the device.
– If desired, enable Transparent Mode.

Note: After importing a NetScreen-5GT that uses extended port mode, NetScreen-
Security Manager displays the modes as “ns5GT-Trust-Untrust-DMZ” and sets the 
license mode to extended.
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– Select the Device Server connection: Use the default settings to configure 
the device to connect to the NetScreen-Security Manager Device Server IP 
address and port. Use a MIP to configure the device to connect to the 
NetScreen-Security Manager Device Server through a mapped IP address 
and port.

4. Click Next to display the Configure NACN and Global-PRO Logging dialog box.
– Enter the Serial Number of the device.
– Enable Global-PRO logging to enable NetScreen-Security Manager to 

collect log entries from the device.
– Enter the username and password of the device admin.

5. To configure NACN, click the Add icon to display the Arbitrator dialog box. The 
Add Device Wizard automatically completes the PM Cert Subject Name, Device 
Server Address, and NACN Registering Port for you. 

– For Interface Monitored, select the untrust interface. 
– For NACN Password, enter the password that authenticates NACN 

communication between the device and the management system.
– Click OK to add the NACN Arbitrator.
– Click Show Device Commands to display a list of CLI commands. Copy 

and paste these commands into a text file.
– Send the commands to the device administrator. The device admin must 

make a telnet connection to the physical device, paste the commands, and 
execute them to enable NACN on the device.

The device cannot connect to NetScreen-Security Manager until these 
commands are executed on the physical device.

6. Click Finish to complete the Add Device wizard. The new device appears in the 
Device Manager list.

7. To check the device configuration status, mouseover the device in Device 
Manager (you can also check configuration status in Device Monitor):

– Before the device connects, the status displays Waiting for 1st connect, 
indicating that the management system is waiting for the device to 
connect. (This event occurs very quickly and might not display.)

– After the device connects, the status displays Import Needed, indicating 
that the device has connected but the management system has not 
imported the device configuration yet.

8. Import the device configuration by right-clicking the device and selecting Import 
Device. The Job Information box appears and displays the job type and status for 
the import; when the job status displays successful completion, click Close. 

After the import is complete, double-click the device to view the imported configuration.

Note: The device admin can also use a console connection to execute the 
commands on the physical device. However, the commands must be 
entered three at a time to ensure that the device receives all commands.
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To check the device configuration status, mouseover the device in Device Manager (you 
can also check configuration status in Device Monitor). The device status displays as 
Managed, indicating that the device has connected and the management system has 
successfully imported the device configuration.
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To import a ScreenOS 5.x device with an unknown IP address: 

1. From the domain menu, select the domain in which you want to import the 
device.

2. In Device Manager, click the Add icon and select Device. The Add Device wizard 
appears.

– Enter a name and select a color to represent the device in the UI. 
– Select Device is not Reachable.
– Select the Device Server connection: Use the default settings to configure 

the device to connect to the NetScreen-Security Manager Device Server IP 
address and port. Use a MIP to configure the device to connect to the 
NetScreen-Security Manager Device Server through a mapped IP address 
and port.

3. Click Next. Enter the device type and specify the ScreenOS version that is 
running on the device. If desired, enable Transparent Mode.

4. Select the license key model for the device. Available selections depend on the 
type of NetScreen FW/VPN device, and can include: baseline, advanced, 
extended, plus, 10-user.

5. Click Next. 
– The wizard automatically enters the Unique External ID for the device. 

This ID number represents the device within the management system.
– Specify the First Connection One Time Password (OTP) that 

authenticates the device.
– Click Show Device Commands to display a list of CLI commands. The 

commands enable management and set the management IP address to the 
Device Server IP address, enable the Management Agent, set the Unique 
External ID, and set the device OTP. 

– Copy and paste these commands into a text file, then send the commands 
to the device administrator. The device admin must make a telnet 
connection to the physical device, paste the commands, and execute them 
to enable NetScreen-Security Manager management on the device

6. Click Finish to complete the Add Device wizard. The new device appears in the 
Device Manager list.

7. To check the device configuration status, mouseover the device in Device 
Manager (you can also check configuration status in Device Monitor):

– Before the device connects, the status displays Waiting for 1st connect, 
indicating that the management system is waiting for the device to 
connect. (This event occurs very quickly and might not display.)
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– After the device connects, the status displays Import Needed, indicating 
that the device has connected but the management system has not 
imported the device configuration yet.

8. Import the device configuration by right-clicking the device and selecting Import 
Device. The Job Information box appears and displays the job type and status for 
the import; when the job status displays successful completion, click Close.

After the import is complete, double-click the device to view the imported configuration. 

To check the device configuration status, mouseover the device in Device Manager (you 
can also check configuration status in Device Monitor). The device status displays as 
Managed, indicating that the device has connected and the management system has 
successfully imported the device configuration.
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After importing a device, you should verify that all device information was imported as 
you expected. 

��
���/��
�����
���
The Device Monitor tracks the status of individual devices, systems, and their processes. 
After you import a device, you should check the status of that device in Device Monitor, 
located in Realtime Monitor.

The imported device should display a configured status of Managed and a Connection 
status of UP, indicating that the device has connected and the management system has 
successfully imported the device configuration.
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In the FW/VPN Device tree, ensure that the device exists, then open the device 
configuration and check the following values:

• Ensure that the device serial number matches the physical device.
• Ensure that the device IP address matches the IP address for the physical 

device.
• Ensure that device administrator name and password are correct for the 

physical device.
• Ensure that the interface on the device are correct for the physical device.
• Browse the device configuration tree and ensure that the management system 

successfully imported all device configuration information, including zones, 
virtual routers, and routes.

Note: After importing a NetScreen-5GT that uses extended port mode, NetScreen-
Security Manager displays the modes as “ns5GT-Trust-Untrust-DMZ” and sets 
the license mode to extended.
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Job Manager tracks the status of major administrative tasks, like importing or updating a 
device. After you import a device, it’s a good idea to view the report for the import task to 
ensure that the management system imported the device configuration as you expected. 
Job Manager also tracks the status of configuration summaries, described below.
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NetScreen-Security Manager provides three configuration summaries to help you manage 
device configurations and prevent accidental misconfiguration. You should use 
configuration summaries after you import a device to ensure that the management 
system imported the physical device configuration as you expected.
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A configuration summary shows you the exact CLI commands that will be sent to the 
managed device during the next device update. To get a Configuration Summary, from the 
menu bar click Devices > Configuration > Summarize Config to display a list of FW/VPN 
devices to which you have access. Select the device you just imported and click OK. 
NetScreen-Security Manager analyzes the UI device configuration and generates a 
summary report that lists the CLI commands that will be sent to the physical device 
during the next device update.

For a just-imported device, the config summary report should display the device 
configuration that matches the configuration currently running on the physical device.
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A delta configuration summary shows you the differences between the configuration you 
see in the NetScreen-Security Manager UI and the configuration on the physical device. 
To get a Delta Configuration Summary, from the menu bar, click Devices Configuration > 
Summarize Delta Config to display a list of FW/VPN devices to which you have access. 
Select the device you just imported and click OK. NetScreen-Security Manager queries 
the physical device to obtain a list of all CLI commands used in the device configuration, 
compares that list with the UI device configuration, and generates a summary report of 
all differences, or deltas discovered. 

For a just-imported device, the delta config summary should display minimal deltas, 
meaning that very few deltas differences exist between the configuration on the physical 
device and the configuration in the UI. NetScreen-Security Manager automatically 
imports your VPNs and displays the VPN policies; however, NetScreen-Security Manager 
does not create VPN abstractions for your VPN policies.

Note: Configuration summaries are helpful tools for ongoing device maintenance, too, 
particularly for devices on which a local device administrator has performed 
troubleshooting using CLI commands or the WebUI. Because the UI device 
configuration can overwrite the physical device configuration, you should always 
confirm the commands that are sent to the device.
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A running configuration summary shows you the exact CLI commands that were used to 
create the current device configuration on the physical device. To get the Running Config 
summary, from the menu bar click Device > Configuration > Get Running Config to 
display a list of FW/VPN devices to which you have access. Select the device you just 
imported and click OK. NetScreen-Security Manager queries the physical device to obtain 
a list of all CLI commands used in the device configuration and generates a summary 
report that lists those commands.

For a just-imported device, the get running config summary report should display the 
device configuration currently running on the physical device.
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For undeployed devices, you can create a device configuration in NetScreen-Security 
Manager then install that device configuration on the physical device. For ScreenOS 5.x 
devices, you can use Rapid Deployment (RD) to quickly provision multiple devices in non-
technical environments. See “Using Rapid Deployment” on page 72 for details.

Adding a single undeployed device to NetScreen-Security Manager is a four stage process:

1. Model device in the UI
2. Create device configuration
3. Activate device
4. Update device configuration

For details on modeling multiple devices at one time, see “Adding Many Devices” on page 
83.

,�D	
��+����
To model a device, you must know the device type and ScreenOS version that is running 
on the device.

To activate a device:

• You must have the device connection information and device admin name and 
password.

• The device must be staged, meaning it is connected to your network and has 
network connectivity.

• The device must have at least one interface that has an IP address. Devices that 
use dynamically assigned IP address must also support NACN.
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To add a device:

1. From the domain menu, select the domain in which you want to import the 
device.

2. In Device Manager, click the Add icon and select Device. The device wizard 
appears.

– Enter a name and select a color to represent the device in the UI. 
– Select Model Device.

3. Click Next to display the New Device platform dialog box. Enter the device 
platform and OS version.

Note: When adding a NetScreen-5GT that uses extended port mode, select 
the device type “ns5GT-Trust-Untrust-DMZ”. NetScreen-Security Manager 
automatically sets the license mode to extended.
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4. Select the license key model for the device. Available selections depend on the 
type of NetScreen FW/VPN device, and can include: baseline, advanced, 
extended, plus, 10-user.

5. Enable transparent mode, if desired. 

6. Click Finish to complete the add device wizard. The UI creates a corresponding 
device object that appears in the Device Manager list.

7. To check the device configuration status, mouseover the device in Device 
Manager (you can also check configuration status in Device Monitor). The status 
displays Modeled, indicating that the management system has modeled the 
device, but the device is not activated and has not connected.
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Because undeployed devices are devices that you are not currently using in your network, 
they might not have a pre-existing device configuration (IP addresses, zones, interfaces, 
etc.) that is available for import. You can create a configuration for the device in 
NetScreen-Security Manager, then install that configuration on the device.

Double-click the device object to display the device configuration and begin configuring 
the device as desired. For details on device configuration, see Chapter 4, “Configuring 
Devices”.
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After you have created a device configuration for the undeployed device, you are ready to 
activate the device and prompt it to connect to the management system. After that device 
has made contact with NetScreen-Security Manager, you can install the configuration you 
created on the device.
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A static IP address is an IP address that does not change.
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To activate a ScreenOS 4.0.x device with a static IP address:

1. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). The device status should display Modeled, indicating that the 
management system is waiting for the device to be activated.

2. Right-click the device and select Activate Device to display the Activate Device 
wizard. Select Device Deployed and IP is Reachable.

Note: You cannot change the operational mode after the device has been modeled.
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3. Click Next to display the Specify Connection Settings dialog box. Enter the 
connection information:

– Enter the IP Address of the NetScreen FW/VPN device.
– Enter the device admin name and password.
– Select the connection method (Telnet, SSH version 1, SSH version 2) and 

the port number for the selected service.

If you selected Telnet, click Next and goto step 4.

If you selected an SSH version, click Next to display The Verify Device 
Authenticity dialog box. The device wizard displays the RSA Key 
FingerPrint information; to prevent man-in-the-middle attacks, you 
should verify the fingerprint using an out-of-band method.

4. The wizard displays the autodetected device information. Verify that the device 
type, ScreenOS version, and the device serial number are correct, then select the 
Device Server connection:

– Use the default settings to configure the device to connect to the 
NetScreen-Security Manager Device Server IP address and port.

– Use a MIP to configure the device to connect to the NetScreen-Security 
Manager Device Server through a mapped IP address and port.

5. Click Next. Select Enable Logging to enable NetScreen-Security Manager to 
collect log entries from the device.

6. To configure NACN, click the Add icon to display the Arbitrator dialog box. The 
Add Device Wizard automatically completes the PM Cert Subject Name, Device 
Server Address, and NACN Registering Port for you. 

– For Interface Monitored, select the untrust interface. 
– For NACN Password, enter the password that authenticates NACN 

communication between the device and the management system.
– Click OK to add the NACN Arbitrator.
– Click Show Device Commands to display a list of CLI commands. Copy 

and paste these commands into a text file.
– Send the commands to the device administrator. The device admin must 

make a telnet connection to the physical device, paste the commands, and 
execute them to enable NACN on the device.

The device cannot connect to NetScreen-Security Manager until these 
commands are executed on the physical device.

7. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). When the device connects, the status displays Update Needed, 
indicating that the device has connected but the management system has not 
pushed the device configuration yet.

Note: The device admin can also use a console connection to execute the 
commands on the physical device. However, the commands must be 
entered three at a time to ensure that the device receives all commands.
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8. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type and 
status for the update; when the job status displays successful completion, click 
Close.

After update is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully pushed the device 
configuration.
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To activate a ScreenOS 5.x device with a static IP address:

1. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). The device status should display Modeled, indicating that the 
management system is waiting for the device to connect.

2. Right-click the device and select Activate Device to display the Activate Device 
wizard. Select Device Deployed and IP is Reachable.

3. Click Next to display the Specify Connection Settings dialog box. Enter the 
connection information:

– Enter the IP Address of the NetScreen FW/VPN device.
– Enter the device admin name and password.
– Select the connection method (Telnet, SSH version 1, SSH version 2) and 

the port number for the selected service.

If you selected Telnet, click Next and goto step 4.

If you selected an SSH version, click Next to display The Verify Device 
Authenticity dialog box. The device wizard displays the RSA Key 
FingerPrint information; to prevent man-in-the-middle attacks, you 
should verify the fingerprint using an out-of-band method.

4. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). When the device connects, the status displays Update Needed, 
indicating that the device has connected but the management system has not 
pushed the device configuration yet.

5. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type and 
status for the update; when the job status displays successful completion, click 
Close.

After update is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully pushed the device 
configuration.
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A dynamic IP address is an IP address that changes. To add a ScreenOS device that uses 
a dynamic IP address, the device must support NACN.

������	���6�6'���(���%
To activate a ScreenOS 4.0.x device with an unknown IP address:

1. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). The device status should display Modeled, indicating that the 
management system is waiting for the device to connect.

2. Right-click the device and select Actions > Activate Device. The Activate Device 
wizard appears. Select Device Deployed but IP is Not Reachable. 

3. Click Next to display the Configure NACN and Global-PRO Logging dialog box.
– Enter the Serial Number of the device.
– Enable Global-PRO logging to enable NetScreen-Security Manager to 

collect log entries from the device.
– Enter the username and password of the device admin.

4. To configure NACN, click the Add icon to display the Arbitrator dialog box. The 
Add Device Wizard automatically completes the PM Cert Subject Name, Device 
Server Address, and NACN Registering Port for you. 

– For Interface Monitored, select the untrust interface. 
– For NACN Password, enter the password that authenticates NACN 

communication between the device and the management system.
– Click OK to add the NACN Arbitrator.
– Click Show Device Commands to display a list of CLI commands. Copy 

and paste these commands into a text file.
– Send the commands to the device administrator. The device admin must 

make a telnet connection to the physical device, paste the commands, and 
execute them to enable NACN on the device.

The device cannot connect to NetScreen-Security Manager until these 
commands are executed on the physical device.

5. Click Finish to complete the Activate Device wizard.
6. Check the device configuration status by holding your mouse cursor over the 

device in Device Manager (you can also check configuration status in Device 
Monitor). When the device connects, the status displays Update Needed, 
indicating that the device has connected but the management system has not 
pushed the device configuration yet.

Note: The device admin can also use a console connection to execute the 
commands on the physical device. However, the commands must be 
entered three at a time to ensure that the device receives all commands.



Chapter 3 Adding Devices

70 Administrator’s Guide

7. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type and 
status for the update; when the job status displays successful completion, click 
Close.

After the update is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully updated the device 
configuration.
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To activate a ScreenOS 5.x device with an unknown IP address:

1. Check the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in Device 
Monitor). The device status should display Modeled, indicating that the 
management system is waiting for the device to connect.

2. Right-click the device and select Actions > Activate Device. The Activate Device 
wizard displays. Select Device Deployed but IP is Not Reachable.

3. Click Next. Select Initialize Device Manually. (For details on initializing with a 
configlet, see “Using Rapid Deployment” on page 72.)

4. Click Next. 
– Specify the First Connection One Time Password (OTP) that 

authenticates the device.
– Click Show Device Commands to display a list of CLI commands. The 

commands enable management and set the management IP address to the 
Device Server IP address, enable the Management Agent, set the Unique 
External ID, and set the device OTP. 

– Copy and paste these commands into a text file, then send the commands 
to the device administrator. The device admin must make a telnet 
connection to the physical device, paste the commands, and execute them 
to enable NetScreen-Security Manager management on the device.

5. Click Finish to complete the Activate Device wizard.
6. Check the device configuration status by holding your mouse cursor over the 

device in Device Manager (you can also check configuration status in Device 
Monitor). When the device connects, the status displays Update Needed, 
indicating that the device has connected but the management system has not 
pushed the device configuration yet.

7. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type and 
status for the update; when the job status displays successful completion, click 
Close. 

Note: The device admin can also use a console connection to execute 
the commands on the physical device. However, the commands 
must be entered three at a time to ensure that the device receives all 
commands.
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After the updated is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully updated the device 
configuration.
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Rapid Deployment (RD) enables deployment of multiple NetScreen appliances in a large 
networked environment with minimal user involvement. RD is designed to:

• Simplify the deployment of firewall devices in non-technical environments
• Minimal device staging or technical staff required at deployment site
• Enable secure and efficient deployment of a large number of firewalls
• Bring new security devices under NetScreen-Security Manager management for 

initial configuration

RD typically involves two people: The NetScreen-Security Manager administrator, who 
creates the necessary device configuration for the new firewall devices in the NetScreen-
Security Manager management console, and the on-site admin, who enables the firewall 
device to contact NetScreen-Security Manager for configuration.

The NetScreen-Security Manager administrator works in the NSM UI. First, add a 
device to the UI, then creates a device configuration with specific or template-driven 
values. Next, enter the basic information that defines how a NetScreen firewall can 
contact your NetScreen-Security Manager Device Server and generate a small, static 
command file called a configlet. Save the configlet to a user-defined directory; using email, 
floppy disk, CD, or other out-of-band method, send the configlet file to the on-site admin 
that will be installing the configlet on the NetScreen FW/VPN device at its physical 
location. After the on-site admin installs the configlet and the device has successfully 
connected to the management system, you can install the modeled device configuration on 
the physical device.

The On-Site administrator works locally, at the physical device. At the NetScreen FW/
VPN device, install the configlet on a locally-connected computer and run the Rapid 
Deployment Wizard. The RD wizard uses the information in the configlet to establish and 
authenticate a secure connection the NetScreen-Security Manager Device Server, 
enabling NetScreen-Security Manager to begin managing the device.

After the firewall device has connected to NetScreen-Security Manager, the NetScreen-
Security Manager administrator can manage the device exactly like any other firewall in 
NetScreen-Security Manager. 
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The NetScreen-Security Manager administrator adds a single device with RD in three 
stages:

1. Creating the Configlet
2. Installing the Configlet (performed by the on-site admin)
3. Updating the Device Configuration (on page 77)

Note: If you delete the NetScreen FW/VPN device from the NetScreen-Security 
Manager system then re-add the device, you must also re-create the configlet and 
install on the physical device.



Using Rapid Deployment

NetScreen-Security Manager 2004 FP2 73

The sections below detail each stage. For details on modeling, creating configlets for, and 
activating multiple devices at one time, see “Adding Many Devices” on page 83.
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To use rapid deployment:

• The device must be running ScreenOS 5.x
• The device must use default factory settings.
• The device must be able to reach the Internet using a static IP address, a 

PPPoE- or PPPoA-assigned IP address, or DHCP- assigned IP address.
• The device must be modeled in NetScreen-Security Manager system. For details 

on modeling a device, see “Modeling a Device” on page 65

After you have modeled the device in the management system, you can begin tracking its 
status using the Device Monitor. Check the device configuration status by holding your 
mouse cursor over the device in Device Manager (you can also check configuration status 
in Device Monitor). The status should display Modeled, indicating that the management 
system has modeled the device, but the device is not activated and has not connected.
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After you have created a device configuration for the undeployed device, you are ready to 
activate the device and create the configlet.

1. Right-click the device and select Activate Device. The Activate Device wizard 
appears.

2. Select Device Deployed but IP is Not Reachable.
3. Click Next. Select Initialize Device Using Configlet. 
4. Click Next. 

– Specify the First Connection One Time Password that authenticates the 
device.

– The wizard automatically selects the interface on the device that will 
connect to the NetScreen-Security Manager management system. This 
interface is determined by the device platform and cannot be changed.

– Select the Device Server connection: Use the default settings to configure 
the device to connect to the NetScreen-Security Manager Device Server IP 
address and port. Use a MIP to configure the device to connect to the 
NetScreen-Security Manager Device Server through a mapped IP address 
and port.

5. Click Next. 

• Specify the connection setting on the device:

– For devices with static IPs, you can pre-define the IP address, mask, and 
gateway OR ask the on-site admin to specify this information during 
device installation.
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– For devices with PPPoEs, you can pre-define the user name and password 
OR ask the on-site admin to specify the user name and password during 
device installation.

– For devices that use DHCP, the configlet automatically handles IP 
assignment during installation.

– If you don’t know the ISP environment or the environment has location-
specific networking requirements, prompt the on-site admin to configure 
the ISP environment during installation.

– For devices with PPPoA, you can pre-define the user name, password, 
multiplexing mode, and VPI/VCI pair OR ask the on-site admin to specify 
the user name and password during device installation.

• Specify the password for the configlet, or use the default device password 
(which is netscreen).

• Specify Device User Names and passwords, or use the default admin name 
and passwords for the device.

• Restrict the use of the configlet to the current device. If checked, the configlet 
can only be installed on a device with the specified serial number.

6. Click Next to display the decoded configlet. To see the encoded configlet, click 
the Raw Configlet tab. Click Save to save the configlet (configlet files 
automatically use the format .cfg).

7. Click Finish to complete the Activate Device wizard. 
8. Send the configlet to the on-site admin using email, floppy disk, CD, or other 

out-of-band method.

To help the on-site admin through the configlet installation process, you should 
also send them the Rapid Deployment Getting Started Guide available on the 
Juniper Networks NetScreen-Security Manager Documentation CD. This guide 
provides step-by-step instructions for connecting a FW/VPN device to the 
network, preparing the device to use a configlet, and installing and running the 
configlet.

The on-site admin must complete the configlet installation process and the device must 
successfully connect to the management system before you can update the device with the 
modeled configuration.

You can track the connection status of the device to determine when the device connects. 
Check the device configuration status by holding your mouse cursor over the device in 
Device Manager (you can also check configuration status in Device Monitor).

• Before the device connects, the status displays Waiting for 1st Connect, 
indicating that the management system has modeled and activated the device, 
but the device has not connected.

Note: For security reasons, you cannot edit a configlet file directly. To 
make changes to the information in a configlet file, run the Activate 
Device wizard to re-generate the configlet.
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• After the on-site admin has installed the configlet, the device automatically 
connects to the management system and the status displays Update Needed 
indicating that the device has connected but the management system has not 
installed the modeled device configuration yet.

�����  
����<������
� ��
The on-site admin performs RD in two stages:

• Preparing the FW/VPN Device
• Installing the Configlet

The sections below detail each stage. For detailed, step-by-step instructions on installing 
the configlet, please see the Rapid Deployment Getting Started Guide.

���"��
����<��/��
��
Before you install the configlet, you must prepare the FW/VPN device:

1. Connect the device to your network. For details on connecting the device, see the 
User’s Guide that came with your NetScreen FW/VPN device.

2. Connect a standalone computer, such as a laptop, to the device eth1 port.
– To connect directly to the device, use a cross-over cable.
– To connect to the device over a hub or switch, use a straight-through 

cable.

If your device has auto-sensing ports, you can use any type of Ethernet cable to 
connect to the device.

3. Change the IP address of the standalone computer to 192.168.1.2 and the 
default gateway to 192.168.1.1. To change an IP address, see your computer’s 
operating system documentation.

4. Ensure that the device is using the factory default settings. 

RD works with the factory default setting of all NetScreen FW/VPN devices 
running ScreenOS 5.x. If the device does not use the factory default settings, you 
cannot use RD (the WebUI cannot load the configlet).

To restore the factory defaults on the firewall device, see the User’s Guide that 
came with your NetScreen FW/VPN device.

5. Ensure that the Status LED on firewall device displays green.

�����  
����<������
� ��

To install the configlet:

1. Save the configlet on the standalone computer that you connected to the FW/
VPN device.

Note: During the configlet installation process, you cannot edit the device configuration.
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2. In a Web browser, enter the IP address of the trust interface on the FW/VPN 
device as 192.168.1.1. The Rapid Deployment Wizard appears.

3. Select Load configlet file and browse to the location of the saved configlet file. 
Click Next.

The RD Wizard opens the configlet, authenticates the integrity of the configlet, 
and decrypts the configlet. If the configlet is valid, the RD Wizard uses the 
configlet information to prepare the FW/VPN device for NetScreen-Security 
Manager management.

4. If prompted, enter the configlet password and click Next. The configlet password 
is given to you by the NetScreen-Security Manager administrator who sent you 
the configlet file. Click Next.

5. Confirm or enter the ISP information. 

The ISP information describes the ISP environment in which the device is 
deployed. If the NetScreen-Security Manager administrator included ISP 
information in the configlet, the RD Wizard displays that information. Ensure 
that all information is correct. 

If the NetScreen-Security Manager administrator did not include ISP 
information or included only partial information, you must complete the ISP 
environment for the device:

– If your firewall device uses DHCP to obtain an IP address from the 
network, select Using cable modem (Dynamic IP via DHCP).

– If your firewall device uses a PPPoE connection to the Internet, select 
Using DSL modem (Dynamic IP via PPPoE). Enter the username and 
password for your PPPoE account.

– If your firewall device uses a static IP address, select Using ISP-supplied 
Settings (Static IP) and enter the IP address, Netmask, and Gateway for 
the firewall device.

– If your FW/VPN device uses a PPPoA connection to the Internet (available 
on NetScreen-5GT ADSL devices), select PPPoA. Enter the username, 
password, multiplexing mode, and VCI pair for your PPPoA account.

6. Click Next to initiate the connection to NetScreen-Security Manager. 

The FW/VPN device connects to the NetScreen-Security Manager Device Server. 
During this first connection, the device and the NetScreen-Security Manager 
Device Server exchange authentication information. After NetScreen-Security 
Manager authenticates the connection and saves the device public key, it sends 
a confirmation message to the device, which displays the message in the RD 
Wizard.

7. Click close to exit the RD Wizard.

Note: For security reasons, after the first successful connection, the FW/VPN 
device erases the one-time-password (OTP) from memory.
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The NetScreen-Security Manager admin can now configure the device using NetScreen-
Security Manager.
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After the on-site admin has installed the configlet and the device has successfully 
connected to management system, you can install the modeled device configuration on the 
physical device:

1. Ensure that the device is connected by viewing the device status. Check the 
device configuration status by holding your mouse cursor over the device in 
Device Manager (you can also check configuration status in Device Monitor). 
Ensure that the configuration status for the device displays Update Needed, 
which indicates that the device has connected but the management system has 
not updated the device configuration yet.

2. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type and 
status for the update; when the job status displays successful completion, click 
Close.

After update is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully updated the device 
configuration.

Note: If the configlet installation process fails, you must reset the device to factory 
defaults. For details, see the User’s Guide that came with your NetScreen FW/VPN 
device.
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You can also add or import other device types into NetScreen-Security Manager, 
including:

• Adding Vsys Devices
• Adding an Extranet Device
• Adding a Cluster

You cannot add multiple vsys, extranet, or cluster devices at one time; you must add each 
vsys, extranet, and cluster device (and cluster member) individually.
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A Virtual System (vsys) is a virtual device that exists within a physical NetScreen FW/
VPN device. The vsys device functions as a completely separate FW/VPN device. The 
physical device, called the root device, can contain multiple vsys devices. The following 
NetScreen systems can be root devices:

• NetScreen-500
• NetScreen-5000
• NetScreen-5200
• NetScreen-5400
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Before you begin importing or modeling a root device, determine where you want to place 
the vsys devices:

• To add vsys devices in the global domain and one or more subdomains, add the 
root device to the global domain.

• To add vsys devices in a single subdomain, add the root device to that 
subdomain.
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An example is shown below:
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Importing vsys devices is a two stage process:

• Import the root device. To import the root device, use the Add Device wizard 
to add the root device to the appropriate domain. For details, see “Importing 
Devices” on page 56.

• Import the vsys devices. To import a vsys device, use the Add vsys wizard to 
add the vsys device. If you are adding multiple vsys devices to the same domain, 
you can add them all at once.

To import a vsys device:

1. From the domain menu, select the domain that contains the root device.
2. In Device Manager, click the Add icon and select vsys Device. The Add Device 

wizard appears. 
– Select the root device for the vsys.
– Select a color to represent the vsys in the UI.
– Select Import Existing Virtual System From Physical Device

3. Click Next. Select the domain in which to import the device.
4. Click Next. Select the vsys devices to import:

– Use SELECT ALL to import all vsys devices from the root device.
– Use SELECT NONE to clear all checked vsys devices.

5. Click Finish to complete the Add Device wizard. NetScreen-Security Manager 
automatically imports the select vsys configurations, and the new vsys devices 
appear in the Device Manager list.

6. To check the device configuration status, mouseover the vsys in Device Manager 
(you can also check configuration status in Device Monitor):

Domain 3

Global Domain

Domain 1

Domain 2
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– Before the vsys connects, the status displays Waiting for 1st connect, 
indicating that the management system is waiting for the vsys to connect. 
(This event occurs very quickly and might not display.)

– After the vsys connects, the status displays Import Needed, indicating 
that the vsys has connected but the management system has not imported 
the vsys configuration yet.

To view the imported configuration, double-click the vsys in Device Manager.

To check the vsys configuration status, mouseover the vsys device in Device Manager (you 
can also check configuration status in Device Monitor). The device status displays as 
Managed, indicating that the vsys has connected and the management system has 
successfully imported the vsys configuration.
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Modeling vsys devices is a two stage process:

• Import or Model the root device. To import or model the root device, use the 
Add Device wizard to add the root device to the appropriate domain. For details, 
see “Importing Devices” on page 56 or “Modeling Devices” on page 65.

• Model the vsys device. To model a vsys device, use the Add vsys wizard to add 
the vsys device. You can model a vsys on an imported or modeled root device; 
however, you cannot update the vsys device configuration until you have first 
activated the root device. You must model one vsys device at a time.

To model a vsys device:

1. From the domain menu, select the domain that contains the root device.
2. In Device Manager, click the Add icon and select vsys Device. The Add Device 

wizard appears. 
– Select the root device for the vsys.
– Select a color to represent the vsys in the UI.
– Select Model Virtual System Device

3. Click Next to specify the Virtual System information:
– NSM vsys Name. Enter a name for the vsys device. This name identifies 

the vsys device in the NetScreen-Security Manager UI. The name can 
contain letters, numbers, spaces, dashes, and underscores.

– ScreenOS vsys Name. Enter a name for the vsys device. This name is 
stored in the root device. The name can contain letters and numbers and 
can be no longer than eight characters. 

– Domain. Select the domain in which to model the device.

The wizard automatically complete the vsys ID, device type, and OS version of 
the root device.

4. Click Next to select the Virtual Router for this device:
– Default Vrouter. Use the default virtual router in the root device. 
– Shared Vrouter. Select a one of the virtual routers defined in the root 

device to be shared with vsys devices. 
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– User Vrouter. Enter the name of a user-defined virtual router in the root 
device.

5. Click Finish to complete the Add vsys wizard. The new vsys device appears in 
the Device Manager list.

6. Ensure that the vsys is connected by viewing the device status. Check the 
configuration status by holding your mouse cursor over the device in Device 
Manager (you can also check configuration status in Device Monitor). Ensure 
that the configuration status for the vsys displays Update Needed, which 
indicates that the device has connected but the management system has not 
updated the device configuration yet.

7. Update the device configuration by right-clicking the vsys and selecting Update 
Device. The Job Information box appears and displays the job type and status for 
the update; when the job status displays successful completion, click Close.

After update is complete, the device status displays as Managed, indicating that the 
device has connected and the management system has successfully updated the device 
configuration.

After you have modeled the vsys device, create the vsys configuration and update the 
device. To check the vsys configuration status, mouseover the vsys device in Device 
Manager (you can also check configuration status in Device Monitor). The device status 
displays as Managed, indicating that the vsys has connected and the management 
system has successfully updated the vsys configuration.
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An extranet device is a firewall or VPN device that is not a NetScreen FW/VPN device. If 
you use devices from multiple manufacturers, you can add extranet devices to NetScreen-
Security Manager to represent your heterogeneous network environment. After you have 
added the extranet device to the NetScreen-Security Manager UI, you can use the device 
in groups, Security Policies, and VPNs.

To add a new extranet device in Device Manager, click the add icon and select Extranet 
device. The Extranet Device dialog box appears. Enter the extranet device information:

• Name. Enter the name of the extranet device. The name can contain letters, 
numbers, spaces, dashes, and underscores. 

• Color. Select the color that represents the extranet device in the NetScreen-
Security Manager UI.

• IP Address. Enter the IP Address of the extranet device 

Click OK to add the extranet device to NetScreen-Security Manager. 
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A cluster is a two NetScreen FW/VPN devices joined together in a high availability 
configuration to ensure continued network uptime. The two device configurations are 
synced, meaning both devices share the same configuration settings, enabling either 
device to handle traffic for the other if one device fails.
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Adding a cluster is a three stage process:

1. Add the cluster device object.
2. Add the members of the cluster to the cluster device object.
3. Configure the cluster ID (after importing OR modeling)
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In Device Manager, click the Add icon and select Cluster. Enter the cluster information:

• Cluster Name. Enter a name for the cluster.
• Color. Select a color to represent the cluster.
• Physical Choice. Select the NetScreen platform for both cluster members. 
• OS Version. Select the ScreenOS version for both cluster members.
• Transparent Mode. Enable transparent mode, if desired.

The cluster device object appears in the device tree.
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Next, add the members of the cluster to the cluster device object. In Device Manager, 
right-click the Cluster device and select New > Cluster Member. The Add Device wizard 
appears; follow the instructions in the wizard to import or add a new cluster member. 

• When importing a cluster member, the Add Device Wizard automatically 
imports the device configuration from the physical device and resets the 
cluster ID to 0. After you have added both cluster members, you must 
set the cluster ID as desired.

• When modeling a cluster member, ensure that both cluster members have been 
added to the cluster device object before configuring the cluster. By default, the 
cluster ID is set to 0.

For details on creating and configuring a cluster, see “Creating an NSRP Cluster” on page 
257.

For example, to create a cluster that includes an existing device (with an existing 
configuration and Security Policy) and a new device (with no configuration or Security 
Policy), you should:

1. Create the cluster.
2. Add the existing device by importing. The Add Device Wizard automatically 

imports the device configuration.
3. Add the new device by modeling, then activating the device.
4. Set the cluster ID.
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If your network includes a large number of NetScreen FW/VPN devices, adding each 
device individually can take unwanted time and effort. To help you import or model your 
existing devices into NetScreen-Security Manager, you can now add multiple devices in a 
single workflow using the Add Many Device wizard.

With the wizard, you can add up to 1000 devices at a time to a single domain (you cannot 
add multiple devices to different domains at one time). Additionally, you can create 
configlets for and activate newly deployed NetScreen FW/VPN devices that are running 
ScreenOS 5.x.

Adding many devices is a three step process:

1. Create the CSV file. This file defines all the required and optional values for 
each device.

2. Using the Add Many Devices wizard, select the CSV file to import or model the 
devices. The wizard first validates the CSV file and notifies you of any errors, 
then adds the devices for which all defined values are valid.

– When importing devices with static IP addresses, the device configuration 
is automatically imported during the Add Many Devices workflow.

– When importing devices with dynamic IP addresses, you must manually 
import the device configuration after the Add Many Device workflow is 
complete.

– When modeling ScreenOS 5.x devices for Rapid Deployment, you can also 
create configlets during the Add Many Devices workflow, or select to skip 
configlet creation.

3. Verify the device configuration.

The following sections detail each step.
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Within a .cvs file, you define the device configuration values for each device you want to 
add. The required and optional values depend on how the device is deployed on your 
network: static IP addresses, dynamic IP addresses, or undeployed devices. 

You must create a separate CSV file for the following devices:

• Devices with known IP addresses. In this CSV file, you define the device 
parameters required to add and import the device configurations from ScreenOS 
4.0.x and 5.x devices. 

• Devices with unknown IP addresses. In this CSV file, you define the device 
parameters required to add ScreenOS 4.0.x and 5.x devices to the NetScreen-
Security Manager system. 

Note: You cannot model multiple NetScreen-5GTASDL devices using the Add 
Many Devices process.
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• Undeployed devices. In this CSV file, you define the device parameters 
required to add and model the devices in the NetScreen-Security Manager 
system. 

Juniper Networks provides CVS templates in Microsoft Excel format for each type of CVS 
file; templates are located on the Juniper Networks support Web site.

For each CVS file, the header row defines the required and optional parameters; each 
subsequent row defines a single device’s values for those parameters. Columns are 
separated by commas. 
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For devices with static IP addresses, create a .cvs file with the following parameters:
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To view the template for adding many device with static IPs: 

1. Download the Microsoft Excel file Add_Many_Devices_Reachable.xls from the 
Juniper Networks support Web site. The header row at the top defines the 
settings. 

Note: You can model many devices, but you cannot activate many devices 
except when using the Rapid Deployment process.

Field Name Type Required Acceptable Values

Name String yes

Color String yes black, gray, blue, red, green, yellow, 
cyan, magenta, orange, pink

Device IP Address String yes

Device Admin Name String yes <admin>

Device Admin Password String yes <password>

Connection Protocol String yes telnet, ssh_v1, ssh_v2

Device Admin Port Integer no 23, 22, 4444, 7777 
If null, uses 23 for telnet and 22 for SSH

SSH Fingerprint String yes (when 
connection SSH)

<SSH fingerprint>
use Any to bypass check

Global Pro Logging String yes on, off

NACN String yes on, off

NACN Interface 
Monitored

String yes (when NACN 
is enabled)

must be a valid device interface

NACN Password String yes (when NACN 
is enabled)

must be a minimum of 9 characters
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2. Using one row for each device you want to add, enter the required values for the 
device. You can also provide optional values, if desired. 

3. Save the file to a location on your local drive.
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To add two NetScreen FW/VPN devices that use static IP addresses, create a text file with 
the following text:

After you have created the file, save it as a .csv file.
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For devices with dynamic IP addresses, create a .cvs file with the following parameters:

Field Name Type Required Acceptable Values

Name String yes dev1, Chicago, NS-208

Color String yes black, gray, blue, red, green, yellow, 
cyan, magenta, orange, pink

Device Platform String yes ns5GT-Combined, ns5GT-Dual-Untrust, 
ns5GT-Trust-Untrust, ns5GT-Trust-
Untrust-DMZ,
ns5GTadsl-Home-Work, ns5GTadsl-
Trust-Untrust, ns5GTadsl-Trust-Untrust-
DMZ, ns5XP,
ns5XT, ns5XT-Combined, ns5XT-Dual-
Untrust, ns5XT-Trust-Untrust, ns25, 
ns50, ns100,
ns204, ns208, ns500, ns5200, ns5400, 
nsHSC-Home-Work, nsHSC-Trust-
Untrust, nsISG2000

ScreenOS Version String yes 5.0, 4.0

Transparent Mode String yes on, off

License Key Model String yes range of values defined in dcf file

First Conn OTP String yes (when using 
ScreenOS 4.0.x)

Device Serial Number String yes (when using 
ScreenOS 4.0.x)

NACN Interface String yes (when using 
ScreenOS 4.0.x)

must be a valid device interface

Global Pro Logging String yes on, off

Chicago,green,10.100.31.78,netscreen,netscreen,ssh_v2,,any,on,off,, , 
Memphis,orange,10.100.20.236,netscreen,netscreen,ssh_v2,,any,on,off,untrust,password,
Columbus,red,10.100.20.200,netscreen,netscreen,telnet,,any,off,off,,,
Cincinnati,blue,10.100.20.237,netscreen,netscreen,ssh_v2,,any,on,on,untrust,pw-nacn,
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To view the template for adding many device with dynamic IPs: 

1. Download the Microsoft Excel file Add_Many_Devices_Unreachable.xls from the 
Juniper Networks support Web site. The header row at the top defines the 
settings. 

2. Using one row for each device you want to add, enter the required values for the 
device. You can also provide optional values, if desired. 

3. Save the file to a location on your local drive.
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To add two NetScreen FW/VPN devices that use dynamic IP addresses, create a text file 
with the following text:

After you have created the file, save it as a .csv file.

��(�" ���(�/��
���
For undeployed devices (ScreenOS 5.x only), create a .cvs file with the following 
parameters:

Device Admin Name String yes

Device Admin Password String yes must be a minimum of 9 characters

Telnet Port Integer no if null, defaults to 23

SSH Port Integer no if null, defaults to 22

Field name Type Required Acceptable Values

Name String yes valid character

Color String yes black, gray, blue, red, green, yellow, 
cyan, magenta, orange, pink

Platform String yes must be a device platform that supports 
ScreenOS 5.x and configlets (cannot 
be a ns5GTADSL device)

ScreenOS Version String yes must be a ScreenOS 5.x device 
platform

Transparent Mode String yes on, off

License Key Model String yes range of values defined in dcf file

Field Name Type Required Acceptable Values

dev03,red,ns204,5.0,off,advanced,netscreen123,43042002000071,,,off,netscreen-super,netscreen,,
dev04,green,ns500,5.0,off,advanced,netscreen123,10062002000039,,,off,super-netscreen,netscreen,,
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To view the template for adding many modeled devices: 

1. Download the Microsoft Excel file Add_Many_Devices_Model.xls from the 
Juniper Networks support Web site. The header row at the top defines the 
settings. 

2. Using one row for each device you want to add, enter the required values for the 
device. You can also provide optional values, if desired. 

3. Save the file to a location on your local drive.
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To add and model two NetScreen FW/VPN devices, create a text file with the following 
text:

First Conn OTP String yes must be a minimum of 9 characters

Connection Type String yes static, pppoe, dhcp, prompt

Device IP Address String yes (when connection 
type is static)

Device Netmask String yes (when connection 
type is static)

Device Gateway String yes (when connection 
type is static)

PPPoE User Name String yes (when connection 
type is PPPoE)

PPPoE User Password String yes (when connection 
type is PPPoE)

must be a minimum of 9 characters

Configlet Password String no default to a random string

Device Admin Name String yes

Device Admin Password String yes must be a minimum of 9 characters

Telnet Port Integer no default to 23

SSH Port Integer no default to 22

Restrict to Serial Number String yes on, off

Note: You cannot model multiple NetScreen-5GTASDL devices using the Add 
Many Devices process.

Field name Type Required Acceptable Values

dev13,orange,ns5XP,5.0,off,advanced,netscreen123,static,10.10.30.5,255.255.255.0,10.10.30.1,,,123abc,netscreen,netscreen,,,on
dev14,green,ns50,5.0,off,advanced,netscreen123,pppoe,,,,root,netscreen,,1netscreen,netscreen1,,,off
dev15,red,ns204,5.0,off,advanced,netscreen123,dhcp,,,,,,,2netscreen,netscreen2,,,off
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After you have created the file, save it as a .csv file.
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When you add the device, NetScreen-Security Manager validates the configuration 
information in the .csv file and creates a Validation Report. The report lists any incorrect 
or duplicate configurations, and indicates the exact line that contains invalid data. 

Select Cancel to quit the Add Many Devices process, or select Add Valid Devices to begin 
adding the devices for which you have provided valid device configurations. If the 
Validation Report listed incorrect configurations, you can still select Add Valid Devices; 
however, only the devices with correct configurations are added. If the .csv file contains 
duplicate configurations, NetScreen-Security Manager ignores the duplicates.

After you have added device, you cannot rollback or undo your changes. To edit or delete a 
device, select the device in the UI and make the necessary changes.
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The import process differs slightly between devices that use static IP addresses and 
devices that use dynamic IP addresses:

• For devices with static IP addresses, the Add Many Devices wizard 
automatically imports the device configurations.

• For devices with dynamic IP addresses, you must manually import the device 
configurations.

In some cases, you might also need to configure NACN, or other features on the physical 
device to enable the device to connect to NetScreen-Security Manager.

After you have added the devices, you should take a moment to verify that the device 
configuration import matches your expectations. For details, see “Verifying the Imported 
Device Configuration” on page 62
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For devices with static IP addresses:

1. From the domain menu, select the domain in which to import the device.
2. In Device Manager, click the Add icon and select Add Many Devices. The Add 

Device wizard appears. 
– Select Device is Reachable (default).
– Specify the location of the CSV file.

3. Click Next. The Add Device wizard validates the CSV file and provides a 
Validation Report:

Note: The Validation Report displays only the first error in the line. If the line contains 
additional errors, those errors do not appear in the Validation Report. 
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– Select Cancel to quit the Add Many Devices process. 
– Select Add Valid Devices to begin adding the devices for which you have 

provided valid device configurations.

The Add Device wizard adds the valid devices and automatically imports their 
configurations. 
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For devices with dynamic IP addresses:

1. From the domain menu, select the domain in which to import the device.
2. In Device Manager, click the Add icon and select Add Many Devices. The Add 

Device wizard appears. 
– Select Device is Not Reachable.
– Specify the location of the CSV file.
– Specify the output directory for the .cli file. For each valid ScreenOS 

device configuration that uses a dynamic IP address, NetScreen-Security 
Manager creates a .cli output file. During the add process, you can specify 
the directory (Cli Server Output Subdir) that should be used to save the 
.cli file. By default, the .cli file is saved to the following GUI Server 
directory:

/usr/netscreen/GuiSvr/var/ManyDevicesOutput/
<inputFile_YYYYMMDDHHMM>/

Before the device can be managed by NetScreen-Security Manager, you 
must enter the CLI commands in the .cli file on the physical NetScreen 
FW/VPN device.

3. Click Next. The Add Device wizard validates the CSV file and provides a 
Validation Report:

– Select Cancel to quit the Add Many Devices process. 
– Select Add Valid Devices to begin adding the devices for which you have 

provided valid device configurations.
4. The Add Device wizard adds the valid devices and automatically imports their 

configurations. 
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For undeployed devices, you can create their device configurations in NetScreen-Security 
Manager in a single workflow. After you have created modeled configurations for each 
device, you must activate all devices individually. 

To model many devices:

1. From the domain menu, select the domain in which to import the device.

Note: The devices must be running ScreenOS 5.x.
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2. In Device Manager, click the Add icon select Add Many Devices. The Add Device 
wizard appears. 

– Select Model Device.
– Specify the location of the CSV file.

3. Click Next. The Add Device wizard validates the CSV file and provides a 
Validation Report:

– Select Cancel to quit the Add Many Devices process. 
– Select Add Valid Devices to begin adding the devices for which you have 

provided valid device configurations.

The Add Device wizard adds the valid devices to the NetScreen-Security 
Manager UI.

4. Model the device configuration as desired.

After you have added the device and created modeled device configurations for your 
undeployed device, you are ready to activate the device and prompt it to connect to the 
management system. After that device has made contact with NetScreen-Security 
Manager, you can install the modeled configuration you created on the physical device. 
For details on activating a device, see “Activating a Device” on page 66.
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You can model, generate configlets, and activate many ScreenOS 5.x devices at one time. 
Alternatively, you can choose to model multiple devices initially, then generate configlets 
and activate them at a later time. The devices must be running ScreenOS 5.x and support 
configlets (the NetScreen-500 and -5000 series do not support configlets).

�(� 
���7�*��
���
�������/��
����3#
�<�����
� ���4
To model, create configlets, and activate at the same time:

1. From the domain menu, select the domain in which to import the device.
2. In Device Manager, click the Add icon and select Add Many Devices. The Add 

Device wizard appears. 
– Select Model Device.
– Specify the location of the CSV file.
– Select Activate and Create Configlets now (ns208 and below). 
– Specify the output directory for the .cfg file. For each modeled ScreenOS 

5.x device configuration, NetScreen-Security Manager creates a .cfg 
output file. During the configlet creation process, you can specify the 
directory (Configlet Server Output Subdir) that should be used to save the 
.cfg file. By default, the .cfg file is saved to the following GUI Server 
directory: 

Note: You cannot model multiple NetScreen-5GTASDL devices using the Add 
Many Devices process.
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/usr/netscreen/GuiSvr/var/ManyDevicesOutput/
<inputFile_YYYYMMDDHHMM>/

3. Click Next. The Add Device wizard validates the CSV file and provides a 
Validation Report:

– Select Cancel to quit the Add Many Devices process.
– Select Add Valid Devices to begin adding the devices for which you have 

provided valid device configurations.

The Add Device wizard adds the valid devices to the NetScreen-Security 
Manager UI.

4. Send the .cfg file to the on-site administrator for the corresponding device. After 
the on-site administrator installs the configlet on the physical NetScreen FW/
VPN device, the device automatically contacts the NetScreen-Security Manager 
Device Server, which establishes an always-on management connection. For 
instructions for the on-site administrator, see “Installing the Configlet” on page 
75, or refer to the Rapid Deployment Getting Started Guide. 

5. Model the device configurations as desired. 
6. Install the modeled configuration. After the on-site administrators have 

installed the configlets and the devices have successfully connected to 
management system, you can install the modeled device configurations on the 
physical devices:

a. Ensure that the device is connected by viewing the device status. Check 
the device configuration status by holding your mouse cursor over the 
device in Device Manager (you can also check configuration status in 
Device Monitor). Ensure that the configuration status for the device 
displays Update Needed, which indicates that the device has connected 
but the management system has not updated the device configuration yet.

b. Update the device configuration by right-clicking the device and selecting 
Update Device. The Job Information box appears and displays the job type 
and status for the update; when the job status displays successful 
completion, click Close.

After update is complete, the device status displays as Managed, indicating 
that the device has connected and the management system has successfully 
updated the device configuration.

For more details on the Rapid Deployment, see “Using Rapid Deployment” on page 72. 
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Before activating devices and creating a configlet, you must configure a modeled 
configuration for the device in the NetScreen-Security Manager UI. 

To create configlets and activate many devices:

1. In Device Manager, click the Add icon and select Activate Many Devices. The 
Activate Device wizard appears.

2. Select the devices to activate.
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3. Specify the output directory for the .cfg file. For each modeled ScreenOS 5.x 
device configuration, NetScreen-Security Manager creates a .cfg output file. 
During the configlet creation process, you can specify the directory (Configlet 
Server Output Subdir) that should be used to save the .cfg file. By default, the 
.cfg file is saved to the following GUI Server directory:

/usr/netscreen/GuiSvr/var/ManyDevicesOutput/
<inputFile_YYYYMMDDHHMM>/

4. Send the .cfg file to the on-site administrator for the corresponding device. After 
the on-site administrator installs the configlet on the physical NetScreen FW/
VPN device, the device automatically contacts the NetScreen-Security Manager 
Device Server, which establishes an always-on management connection. For 
instructions for the on-site administrator, see “Installing the Configlet” on page 
75, or refer to the Rapid Deployment Getting Started Guide.

5. Click OK. A Job Manager window appears to display the progress of the 
activation. When completed, click Close.

6. Update the physical device with the modeled configuration.

Note: For security reasons, you cannot edit a configlet file directly. To 
make changes to the information in any configlet file, run the Activate 
Many Device wizard to re-generate the configlets.
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The Device Manager module in Juniper Networks NetScreen-Security Manager enables 
you to configure the managed Juniper Networks NetScreen FW/VPN devices in your 
network. You can edit configurations after you add or import a managed device, or create 
configurations when you model a device. For details about adding, importing, or modeling 
a device, see Chapter 3, “Adding Devices”.

After you edit or create a configuration for a device, you must update the configuration on 
the managed device for your changes to take effect. For details on updating devices, see 
Chapter 5, “Updating Devices”.

This chapter details the device configuration parameters, and provides configuration 
examples when possible. For step-by-step instructions on configuring specific device 
settings, see the Juniper Networks NetScreen-Security Manager Online Help. This 
chapter also details two important tools that you can use to simplify configuring multiple 
FW/VPN devices: templates and device groups. 

Use Security Policies to configure firewall and VPN rules that control traffic on your 
network, as described in Chapter 8, “Configuring Security Policies”. Use the VPN 
Manager to configure VPNs, as described in Chapter 9, “Configuring VPNs”.

• About Device Configuration • Configuring a Modem Connection (Dial)

• Using Templates • Configuring DNS

• Using Device Groups • Configuring Advanced Network Settings

• Configuring Device Information • Configuring Device Administration

• Configuring Network Overview • Configuring Authentication

• Configuring the Network Module • Configuring Reporting

• Configuring Virtual Routers • Configuring Security

• Configuring Zones • Configuring Advanced Device Settings

• Configuring Interfaces • Configuring L2TP and XAuth Local Users

• Configuring DIP Groups • Configuring vsys

• Configuring PPPoE • Configuring Certificates

• Configuring PPPoA • Configuring NSRP Clusters

• Configuring NACN
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The device configuration contains the configuration settings for a managed device, such as 
interface, routing, and authentication settings. You can edit configurations after you add 
or import a managed device, or create configurations when you model a device. When you 
are satisfied with your changes, you can then update the managed device with the 
modeled device configuration to make your changes effective.

NetScreen-Security Manager does not support all device configuration settings; you may 
need to make some changes (described below) to the device locally, using the Juniper 
Networks NetScreen WebUI or CLI. Additionally, some changes can affect the 
management connection between the NetScreen-Security Manager Device Server and the 
managed device.
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Some device configurations can be performed only by the device administrator using the 
CLI or WebUI. A NetScreen-Security Manager administrator cannot perform the 
following device configurations in the Device Manager:

• Configuring functions that are only applicable for the device administrator, such 
as setting initial IKE contact, audible alarms, MAC addresses, or console 
operations.

• Configuring functions that require device administrator intervention, such as 
Secure Command Shell (SCS) and Secure Shell (SSH) client operation.

• Executing debugging commands.
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Some configuration changes to a managed device can affect the NetScreen-Security 
Manager connection to the device when you update the device, such as:

• Changing the connection method (Telnet or SSH) used between the NetScreen-
Security Manager Device Server and the managed device.

• Disabling the ability of the managed device to communicate with the NetScreen-
Security Manager Device Server.

• Changing the IP address of the NetScreen-Security Manager Device Server on 
the managed device.

• Changing the interface on the managed device that is permitted to receive 
NetScreen-Security Manager management traffic.

• Changing the VPN that handles traffic between the managed device and the 
NetScreen-Security Manager Device Server.

• Modifying router information on the managed device.
• Changing Security Policy rules on the managed device that cause NetScreen-

Security Manager traffic to be dropped.

If you need to make any of the above changes to the managed device, use the WebUI or 
CLI to make the changes locally, then re-import the device configuration into the 
NetScreen-Security Manager UI.
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Use templates to define a common device configuration and then reuse that configuration 
information across multiple devices. In a template, you can define only those 
configuration parameters that you want to set; you do not need to specify a complete 
device configuration. Templates provide two benefits:

• You can configure parameter values for a device by referring to one or more 
templates when configuring the device.

• When you change a parameter value in a template and save the template, the 
value also changes for all device configurations that refer to that template. See 
“Modifying Template Values” on page 100.

When you apply a template to a device, NetScreen-Security Manager applies the template 
settings to the device. For example, you can create a template that specifies the IP 
address of the NTP server to which all managed FW/VPN devices synchronize their 
clocks. You can apply this template to the configuration of each device in your domain so 
that all devices use the same NTP server. You can apply the same template to different 
types of NetScreen FW/VPN devices, from NetScreen-5XT appliances to NetScreen-5200 
systems.

A template can refer to other templates, enabling you to combine multiple templates into 
a single template. When you make changes to any of the referenced templates, those 
changes are propagated through the combined template. For more information about the 
options you can configure, see the later sections in this chapter, starting with 
“Configuring Device Information” on page 108. For step-by-step instructions on creating 
and applying templates, see the Online Help topic, “Adding Device Templates” and 
“Applying Templates”.
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You can manually override any value set by a template in the individual device 
configuration. To determine if the value is set by a template or is device-specific, press the 
SHIFT key and move the mouse cursor over the field name:
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• If the value is set by a template, the message “From template: template-name” 
appears, as shown below:

• If the value is set by the individual device (a device-specific value), the “From 
object” appears:

For any value in the device configuration that was set by a template, select the value and 
use SHIFT-RIGHT-CLICK to automatically revert the device-specific value to the 
template-defined value (this also reverts non-template values back to the default value). 
An example is shown below:

A device-specific configuration value always overrides a template value.
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When configuring and using templates in NetScreen-Security Manager, be aware of the 
following limitations.
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You can apply a maximum of 31 templates to a single device. However, configuring 
certain features reduces the maximum number of templates you can apply to a device:

• Cluster or vsys member. Configuring a device as a vsys device or as a member 
of a cluster reduces the maximum number of templates by one.

• VPNs. Each VPN that the device belongs to also reduces the maximum number 
of templates by one. This includes VPNs configured in VPN Manager and VPNs 
configured at the device-level.

• Referenced templates. Each referenced template (a template referred to by 
another template) reduces the maximum number of templates by one. For 
example, a device that uses template A, which in turn refers to templates B and 
C, calculates three templates applied to the device.
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You cannot apply a template to a device group. To use the same template for multiple 
devices, you must apply the template to each device individually.

/���	 ��9� 	��
When creating a template, default values do not appear, as many default values depend 
on the Juniper Networks NetScreen ScreenOS version and device platform.
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Templates do not automatically include any of the entities that are predefined on devices, 
such as zones, interfaces, or virtual routers. To create a template that refers to a specific 
predefined entity, you must create the entity in the template.

For example, to create a template that refers to the ethernet1 interface:

1. In the template navigation tree, select Network > Interface.
2. Click the Add icon and select Predefined Interface. The Physical Interface dialog 

box appears.
3. For Name, enter ethernet1.

When adding an entity in a template, ensure that the menu option you select is 
appropriate for the predefined entity. Choose the menu option that includes the name of 
the predefined entity you are creating.

For example, to create a template that refers to the mgt zone: 

1. In the template navigation tree, select Network > Interface.
2. Click the Add icon and select Predefined Functional Zone > mgt/vlan. The Zone 

dialog box appears.
3. Enter mgt.
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Key list parameters uniquely identify a configuration object in a list of similar objects and 
are read-only. You cannot edit key list parameters that are derived from a template. For 
example, a zone name uniquely identifies a zone in a list of zones that can be configured 
on a device. If you create a zone in a template and apply the template to a device, you 
cannot change the zone name in the device configuration. You must first delete the 
template-derived zone, then create a new zone.

A configuration object can contain multiple key list parameters. For example, in the 
routing table, multiple parameters (including IP address/netmask, interface, next-hop, 
vsys, and so on) uniquely identify a particular route entry.
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In this example, you create a template that configures the IP addresses of primary and 
secondary DNS servers.

1. In the navigation tree, select Device Manager > FW/VPN Device Templates. 
Click the Add icon in the Device Template Tree or the Device Template List. 

The New Device Template dialog box appears, displaying the template 
navigation tree in the left pane and the Info screen in the right pane.

2. In the Info screen, enter DNS in the Name field, as shown below:

3. From the template navigation tree, select Network > DNS. In the DNS screen:
– Enter the IP address of the primary and secondary DNS servers.
– Configure the default DNS refresh schedule, if desired.
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Your DNS settings look similar to the ones shown below:

4. Click OK to save the template.

You can now use this template when configuring a single FW/VPN device. 
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In this example, you apply the DNS template you created in the previous example:

1. Ensure that the device you want to apply the template to has been successfully 
added to the management system.

2. In the navigation tree, select Device Manager > FW/VPN Devices, then double-
click the device to open the Device dialog box.

3. In the device navigation tree, select Info > Templates. The templates 
configuration screen appears.

4. Click the Edit icon. The Edit Templates dialog box appears.
5. Select the DNS template, as shown below:

6. Click OK in the Edit Templates dialog box, then click OK to save your changes to 
the device configuration.
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You can apply the same template to different device types that run different ScreenOS 
versions. In some cases, the fields or field values you specify in the template might not be 
appropriate for all ScreenOS versions and device types:

• If the template specifies a field that a device does not support, the field does not 
appear in the Device dialog box and is not updated to the device. No validation 
message appears.

• If the template specifies a field that the device supports, but the value is outside 
the permitted range for the device, a validation message appears in the Device 
dialog box.

As you create and edit template values and fields, NetScreen-Security Manager performs 
validation, and might display validation messages. For example, you can configure an IP 
address in one template and the netmask for that IP address in another template. 
However, a validation message might appear when you enter the IP address because the 
netmask is not specified within that same template.

You can safely ignore a validation message if the missing value is derived from another 
template that is applied to the device, or if you manually entered in the value in the 
specific device configuration.
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You can modify a template that has already been applied to one or more device 
configurations. When you change a field value in a template, the new value appears in the 
device configuration the next time you edit the configuration. To change the field value on 
the device, you must update the device (see Chapter 5, “Updating Devices”).

When you change a template, the configuration of one or more devices that use the 
template might become invalid. For example, a template change could cause a required 
field to be cleared or a field value to be outside the permitted range.

For step-by-step instructions on modifying a template, see the Online Help topic, “Editing 
Device Template”.
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When applying multiple templates to a single device, you determine the order that the 
templates are applied. The highest priority template is positioned at the end of the 
template list, and can override values set in any of the lower priority templates. If more 
than one template specifies a value for the same field, the value in the highest-priority 
template takes precedence. The lower the template appears in the template list, the 
higher priority it has when applying values to a device configuration.
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In this example, you create two templates that each configure different values for the 
same firewall SCREEN option for the untrust zone. The first template, DoS, sets several 
values in the SCREEN options, including setting the source-based IP session threshold 
limit to 128 for the untrust zone. The second template, DoS2, sets the source-based IP 
session threshold limit to 256 for the untrust zone. When you apply these templates to a 
device, the template with the highest priority overrides the values in the lower priority 
template.

1. Create a template that sets SCREEN options for the untrust zone then apply the 
template to a NetScreen-208 device running Screen 4.0:

a. In the navigation tree, select Device Manager > FW/VPN Device 
Templates and click the Add icon. The New Device Template dialog box 
appears.

b. In the Info screen, enter DoS in the Name field.
c. In the template navigation tree, select Network > Zone. The Zone 

configuration screen appears. 
d. Click the Add icon in the Zone configuration screen and select Predefined 

Security Zone. The Predefined Zone dialog box appears.

e. In the General Properties screen, enter untrust in the Name field.
f. In the zone navigation tree, select Screen > Denial of Service Defense. The 

Denial of Service Defense screen appears. Enable and set the following 
options as shown below:

g. Click OK in the Predefined Zone dialog box, then click OK in the New 
Device Template dialog box.

Note: Because the untrust security zone is predefined for the device, you 
must select the Predefined Security Zone option. You can select the 
Security Zone or Tunnel Zone option only when adding or configuring 
a user-defined zone.
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2. Apply the DoS template to a device configuration for a NetScreen-208 running 
ScreenOS 4.0:

a. Add a NetScreen-208 FW/VPN device to the management system, and 
model the configuration. Be sure to configure the device as running 
ScreenOS 4.0.

b. In the navigation tree, select Device Manager > FW/VPN Devices. Double-
click the NetScreen-208 device icon to open the Device dialog box.

c. Select Info > Templates in the device navigation tree. Click the Edit icon 
in the Templates screen. The Edit Templates dialog box appears.

d. Select the DoS template, as shown below:

e. Click OK in the Edit Templates dialog box.
3. Verify that the DoS template values have been applied to the device:

a. Select Network > Zone in the device navigation tree. Double-click the 
untrust zone. The untrust-Predefined Zone dialog box appears.
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b. Select Screen > Denial of Service Defense and review the values applied 
by the template, as shown below:

Because the NetScreen-208 is running ScreenOS 4.0, the Destination IP-Based 
Session Limit does not appear (this option is not supported by ScreenOS 4.0.x) 
and is not applied to the device.

4. Create a second template that sets a different value for a SCREEN option than 
was set in the DoS template:

a. In the navigation tree, select Device Manager > FW/VPN Device 
Templates and click the Add icon. The New Device Template dialog box 
appears.

b. In the Info screen, enter DoS2 in the Name field.
c. In the template navigation tree, select Network > Zone. The Zone 

configuration screen appears. 
d. Click the Add icon in the Zone configuration screen and select Predefined 

Security Zone. The Predefined Zone dialog box appears.
e. In the General Properties screen, enter untrust in the Name field.
f. In the zone navigation tree, select Screen > Denial of Service Defense. The 

Denial of Service Defense screen appears. Enable and set the Source IP 
Based Session Limit Threshold to 128.
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Your settings appear as shown below:

g. Click OK in the Predefined Zone dialog box, then click OK in the New 
Device Template configuration dialog box.

5. Apply the DoS2 template to the NetScreen-208 device:

a. In the navigation tree, select Device Manager > FW/VPN Devices. Double-
click the NetScreen-208 device icon to open the Device dialog box.

b. Select Info > Templates in the device navigation tree. Click the Edit icon 
in the Templates configuration screen. The Edit Templates dialog box 
appears.

c. Select the DoS2 template, as shown below.

d. Click OK in the Edit Templates dialog box.
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6. Set the template priority. 

Currently, the DoS template has the highest priority, which enables it to 
override any similar values set by the DoS2 template, as shown below:

To set the DoS2 template to the highest priority, select the DoS2 template and 
click the down arrow icon above the list of templates (or press Alt-N.) The DoS2 
template now has the highest priority, as shown below:

The DoS2 template now overrides similar values set in the DoS template.

7. Verify that the configuration values from the DoS and DoS2 templates have 
been applied in the device configuration:

a. Select Network > Zone in the device navigation tree. Double-click the 
untrust zone. The untrust-Predefined Zone dialog box appears.

b. Select Screen > Denial of Service Defense and review the values applied 
by the template, as shown below:
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Although both the DoS and DoS2 templates configured threshold values 
for the Source IP Based Session Limit field, the higher threshold value 
from DoS2 appears in the device configuration because you assigned the 
DoS2 template a higher priority than the DoS template.

c. Verify the origin of each value by pressing the Shift key and moving the 
mouse cursor over the field name.

For the Source IP Based Session Limit, the message “From template: 
DoS2” appears, as shown below:

For the SYN-ACK-ACK Proxy Protection, the message “From template: 
DoS” appears, as shown below:

8. Manually override the SYN-ACK-ACK Proxy Protection value that is set by the 
template DoS:

a. Clear the SYN-ACK-ACK Proxy Protection checkbox.
b. Enable and set the SYN-ACK-ACK Proxy Protection threshold to be 1000.
c. Verify that the setting is derived from the device configuration itself and 

not a template by pressing the Shift key and moving the cursor over the 
field name. The message “From object” appears, as shown below:
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Use device groups to organize your managed devices, making it easier for you to configure 
and manage devices within a domain. You can group devices by type (such as all the 
NetScreen-5GTs in a domain), by physical location (such as all the NetScreen FW/VPN 
devices in the San Jose office), or logically, (such as all the NetScreen FW/VPN devices in 
sales offices throughout western Europe.)

Groups enable you to execute certain NetScreen-Security Manager operations on multiple 
FW/VPN devices at the same time. For example, if you have a group of the same type of 
devices running similar ScreenOS versions, you can upload the firmware on all devices in 
the group at the same time. You can also add devices to the NetScreen-Security Manager 
UI, place the devices in a group, and then import the device configurations for all devices 
in the group at one time.

The devices that you add to a group must exist; that is, you must have previously added or 
modeled the devices in the domain. You can group devices before configuring them. You 
can add a device to more than one group. You can also add a group to another group.
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In this example, you create a device group that includes FW/VPN devices used to protect 
the Sales & Marketing department of your organization. 

1. Add and model the following devices to the management system:
– Outside Sales
– Marcom
– Direct Marketing
– Sales
– Marketing

2. In the navigation tree, select Device Manager > FW/VPN Devices. 
3. Click the Add icon. The New Group dialog box appears, displaying all existing 

devices for the current domain in the Non-members list.
4. For Name, enter Sales.
5. In the non-members list, select the devices that you want to be part of the Sales 

device group.
6. Click Add==> to move the selected devices to the Member list.
7. Click OK.

Note: You cannot apply a template to a group. You must apply templates to 
individual devices in a group. If you need to apply the same set of templates to 
multiple devices, you can create a single template that includes all the templates that 
are to be applied to a device, and then apply the combined template to each device.
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To configure a device that has been added, imported, or modeled in NetScreen-Security 
Manager:

1. In the navigation tree, select Device Manager > FW/VPN Devices. 
2. Open the device configuration using one of the following methods:

– Double-click the device object in the FW/VPN Device Tree or the FW/VPN 
Device List.

– Select the device object and then click the Edit icon.
– Right-click the device object and select Edit.

The device navigation tree appears on the left, listing the device configuration 
parameters by function.

3. In the device navigation tree, select a function heading to see device parameters, 
then select the configuration parameter you want to configure.

4. Make your changes to the device configuration, then choose one of the following:
– Click OK to save your changes and close the device configuration.
– Click Apply to save your changes and continue making changes. 
– Click Cancel to discard all changes and close the device configuration.

This section describes the Info options in the Device dialog box. Subsequent sections 
describe other options in the Device dialog box.

When you add or model a device in the NetScreen-Security Manager UI, you provide 
information about the device name, color, type, and OS version. If you imported the device 
configuration, the Info options display additional information about the device.
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Rapid Deployment (RD) simplifies the staging and configuration of multiple FW/VPN 
appliances under NetScreen-Security Manager. With RD, the NetScreen-Security 
Manager administrator creates a configlet in the NetScreen-Security Manager, then 
sends the configlet to the user that has local access to the FW/VPN device.

For details about RD and using configlets, see Chapter 3, “Adding Devices”.
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You can set most device configurations, except policies and VPNs, in a template. You can 
also manually override any value set by a template.

The order in which the templates are listed determines how template values are applied 
to the device. When a value is set in more than one template applied to a device, the value 
in the highest-priority template takes precedence. To reorder templates, click the up or 
down arrow icon above the list of templates to move the priority up (lower priority) or 
down (higher priority). (Or, press Alt-U or Alt-N to move the priority of the template up or 
down.)
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For more information about templates, see “Using Templates” on page 95.

9
�#
���/��
�����"�%
 
�
��
The Capabilities screen lists features and resources available on the device. This screen is 
read-only; you cannot change any of the values on the screen.

The configuration screens that you see for a particular NetScreen FW/VPN device depend 
upon the following:

• Device platform
• ScreenOS version running on the device
• License key(s) installed on the device

Therefore, some of the configurations described in this chapter only apply to specific 
NetScreen FW/VPN platforms, ScreenOS versions, or license key installations.
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The Network screens contain the options that enable the device to connect to and operate 
in the network. In the Device navigation tree, open the Network heading in the navigation 
tree to see the network settings options.

The following section detail configuring the following network settings:

• Configuring the Network Module (Slot). This option is only available for 
Netscreen FW/VPN systems, such as the NetScreen-5000 series, that contain 
physical slots in which you can install optional modules. You can view or edit the 
type of network module installed in each available slot in the physical device. 

• Configuring Virtual Routers. A virtual router (VR) supports static routes, 
dynamic routing protocols, and multicast protocols. The virtual router 
configuration includes the configuration for dynamic routing protocols and 
multicast protocols.

• Configuring Zones. A security zone is a specific network segment for which you 
can control inbound and outbound traffic. You can configure predefined zones or 
create user-defined security zones. You can also create a tunnel zone, which is a 
logical segment to which a VPN tunnel interface is bound.

• Configuring Interfaces. You bind interfaces to predefined or user-defined 
security zones or to tunnel zones to permit traffic to pass into or out of the zone. 
For an interface in Route or NAT mode, you assign an IP address to the 
interface.

• Configuring DIP Groups. You can configure a range of IP addresses from which 
FW/VPN device can take addresses when performing network address 
translation (NAT) on the source IP address of outgoing or incoming IP packets.

• Configuring PPPoE. This option is only available for NetScreen FW/VPN 
appliances. You can configure PPPoE to enable the FW/VPN device to connect to 
remote sites.

• Configuring PPPoA. On the ADSL interface (available on the NetScreen-
5GTADSL FW/VPN device), you can configure a PPPoA client instance with a 
user name, password, and other parameters, then bind the instance to the ADSL 
interface (or subinterface) to enable Internet access for an internal network.

• Configuring NACN. This option is only available for FW/VPN devices running 
ScreenOS 4.0.x. You configure NetScreen Address Change Notification to enable 
the FW/VPN device to alert NetScreen-Security Manager of any change in the IP 
address assigned by a DHCP or PPPoE server.

• Configuring Interface Failover. This option is only available for some NetScreen 
FW/VPN appliances. When there are both primary and backup interfaces to the 
Untrust zone, you can configure traffic failover traffic from the primary to the 
backup interface, and from the backup to the primary interface.

• Configuring a Modem Connection (Dial). This option is only available for some 
NetScreen FW/VPN appliances. You can connect and configure an external 
modem to the RS-232 serial port as a backup dialup interface for traffic to the 
Untrust zone.
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• Configuring DNS. Before the NetScreen FW/VPN device can use DNS for 
domain name and address resolution, you must configure the addresses for the 
primary and secondary DNS servers.

• Configuring Advanced Network Settings. This option contains additional 
network settings you can configure.
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(This option is only available for Netscreen FW/VPN systems, such as the NetScreen-5000 
series, that contain physical slots in which you can install optional modules.) In the slot 
screens, you can set, view, or edit the type of network module installed in each available 
slot in the physical device.

Network modules include copper and fiber interface modules, which provide additional 
ethernet ports. The NetScreen-5000 series network modules are known as Security Port 
Modules (SPMs); SPMs handle general packet processing at Gigabit speeds, enabled by 
ASIC support.
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A single NetScreen FW/VPN device can support a 10/100 Base-T and GBIC card 
simultaneously; however, the cards are not hot-swappable.
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The 10/100Mbps interface module is typically used to support a 10 Base-T or 100 Base-T 
LAN. The card can support 2, 4, or 8 copper interfaces, and uses RJ45 connectors with 
twisted pair.
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The tri-mode card, available for NetScreen-ISG2000 FW/VPN devices, is a 2 ethernet port 
10/100/1000Mbps IO card. The card supports 2 copper interfaces, uses RJ45 connectors 
and twisted pair, and contains the following IO port configurations:

• 10Mbps Full/Half Duplex
• 100Mbps Full/Half Duplex
• 1000Mbps Full Duplex
• Auto (auto-negotiate link speed/duplex)
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Fiber interface module provide connectivity for fiber-based, gigabit ethernet LANs. 

• GB
– 1 interface (mini-GBIC). This card supports 1 fiber interface and uses an 

optical cable with SX or LX connectors.

Note: The NetScreen-ISG 2000 supports a maximum port count of 28. When using 
8-port 10/100 modules in each I/O slot, ports five through eight in slot 4 are 
automatically disabled. You cannot configure these ports for firewall or HA 
functionality.
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– 2 interfaces (GBIC). This card supports 2 fiber interfaces and uses an 
optical cable with SX or LX connectors.

• GB LX/SX (2 interfaces). This card supports 2 fiber interfaces and uses an 
optical cable with SX and LX connectors.
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Secure Port Modules (SPMs) provides general packet processing and device connection 
tasks for the NetScreen-5000 series. These modules are based on the GigaScreen-II ASIC.

SPMs handle packets as they enter and exit the system, providing packet parsing, 
classification, and flow-level processing. SPMs also provide encryption, decryption, 
Network Address Translation (NAT), and session lookup features. When packets require 
additional processing, the device forwards the packets to the management module.

NetScreen-Security Manager supports the following SPMs for the NetScreen-5000 series 
FW/VPN devices:

• 5000-8G SPM. This SPM provides eight Gigabit Ethernet mini-Gigabit 
Interface Converter (GBIC) ports using hot-swappable transceivers. The 5000-
8G delivers up to 4 Gigabits-per-second (Gbps) of firewall and up to 2 Gbps of 
Virtual Private Network (VPN) capacity. This module is also capable of 
supporting a total of four aggregate interfaces. The 5000-8G provides port Link 
and Activity LEDs in addition to Power and Status LEDs.

• 5000-2G24FE SPM. This SPM provides two 1-Gigabit Ethernet ports and 24 FE 
ports with up to 2 Gbps of firewall and up to 1 Gbps of VPN process capacity. 
This module is capable of supporting a total of six aggregate interfaces. This 
total consists of one aggregate interface for the two 1-Gigabit ports, and five 
aggregate interfaces for the 24 10/100 Ethernet ports. Only similar ports can be 
aggregated together. You cannot aggregate a Gigabit port to a 10/100 FE port. 
The 5000-2G24FE provides port Link and Activity LEDs, in addition to Power 
and Status LEDs. Mini-GBIC transceivers are hot-swappable.
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Use the Virtual Router screens to configure routing on NetScreen FW/VPN devices. 
Routing is the process of forwarding packets from one network to another toward a final 
destination, and a router is a point where one network meets another network. NetScreen 
FW/VPN devices contain integrated routing functionality that enables them to effectively 
forward protected traffic to its destination.
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You can configure three types of routing on a NetScreen FW/VPN device:

• Static. Static routes are mappings of IP network addresses to next-hop 
destinations that you define on a layer 3 forwarding device, such as a router. 
These mappings do not change unless you alter them. For networks that have 
few connections to other networks or where inter-network connections are 
relatively unchanging, it is usually more efficient to define static routes than to 
set up dynamic routing. The device retains static routes until you explicitly 
remove them. However, you can override static routes with dynamic routing 
information if necessary. 

• Dynamic. Dynamic routing involves routers exchanging information about the 
reachability of networks and subnetworks and adjusting routing tables by 
analyzing incoming routing update messages. These messages populate the 
network, directing routers to recalculate routes and change their routing tables 
accordingly.

• Multicast. Multicast protocols enable routers to forward traffic from one source 
to multiple receivers simultaneously.

All routes are contained within a virtual router, as detailed below.
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A NetScreen FW/VPN device can divide its routing component into two or more virtual 
routers. A virtual router supports static routing, dynamic routing protocols, and multicast 
protocols, which you can enable simultaneously in one virtual router. A NetScreen FW/
VPN device can contain the following types of Virtual Routers (VRs):

• Predefined Virtual Routers. Each NetScreen FW/VPN device contains two 
predefined virtual routers:

– trust-vr. By default, contains all predefined security zones and any user-
defined zones.

– untrust-vr. By default, does not contain any security zones.

You cannot delete the trust-vr or untrust-vr predefined virtual routers. 

• User-Defined Virtual Routers. On some NetScreen FW/VPN devices, you can 
create and configure additional custom virtual routers.
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By default, all predefined and user-defined security zones (and all interfaces bound to 
those security zones) are bound to the trust-vr virtual router. To bind a security zone to 
the untrust-vr or to a custom VR, you must first unbind all interfaces from the zone.

For a vsys, you can select a virtual router to be the default router for the vsys.

To configure a virtual router, double-click the virtual router in the Virtual Router 
configuration screen (or, either select the virtual router and then click the Edit icon, or 
right-click the virtual router and select Edit). You can configure the following parameters 
for a virtual router:

• Configuring Virtual Router General Properties
• Configuring Access Lists
• Configuring Route Maps
• Configuring Export and Import Rules
• Configuring Routing Table Entries

• Configuring Multicast Route Table Entries
• Configuring Route Preferences
• Configuring Dynamic Routing Protocols

For more detailed explanations about virtual routers and dynamic routing protocols on 
NetScreen FW/VPN devices, see the “Dynamic Routing” volume in the NetScreen Concepts 
& Examples ScreenOS Reference Guide.
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You can configure the following general properties for a virtual router:

• Virtual router ID. A unique identifier used to communicate with other routing 
device. The identifier can be in the form of a dotted decimal notation, like an IP 
address, or an integer value. If you do not configure a specific virtual router ID 
before enabling a dynamic routing protocol, ScreenOS automatically selects the 
highest IP address of the active interfaces in the VR for the router identifier.

• Maximum number of routing table entries that can be allocated for a 
specific virtual router. The maximum number of route entries available 
depends upon the NetScreen FW/VPN device and the number of virtual routers 
configured on the device. Setting the maximum number of route entries in a VR 
helps prevent one virtual router from using up all the entries in the system.

• Shared VR. You can make the VR accessible from any virtual system (vsys) on 
the device. By default, only the untrust-vr is a shared VR that is accessible by 
any vsys. You can configure other root-level VRs to be sharable.

• Route Exporting. (For the trust-vr only) You can enable or disable automatic 
route exporting to the untrust-vr for interfaces configured in Route mode.

Note: In the routing table, you must configure a default route for the 
NetScreen FW/VPN device. You should also configure a route from the device 
to the IP address of the NetScreen-Security Manager Device Server.
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• Consider Active Routes.You can direct the virtual router to consider active 
routes on inactive interfaces for redistribution or export. By default, only active 
routes defined on active interfaces can be redistributed to other protocols or 
exported to other virtual routers.

• SNMP Private Traps. You can specify the use of SNMP private traps for 
managing virtual router objects, including objects in the dynamic routing MIB. 
This option is only available for the default root-level virtual router.

• Ignore Overlapping Subnets. You can direct the virtual router to ignore 
overlapping subnet addresses for interfaces in the virtual router. By default, you 
cannot configure overlapping subnet IP addresses on interfaces in the same 
virtual router.

• Next Hop. (For the trust-vr only) You can direct the virtual router to use the 
untrust-vr as the next hop for the default route.
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An access list is a sequential list of statements against which a route is compared. Each 
entry in the list specifies the IP address/netmask of a network prefix and the forwarding 
status (whether to permit or deny the route). For example, an entry in an access list can 
permit routes for the 1.1.1.0/24 subnetwork, while another entry in the same access list 
can deny routes for the 2.2.2.0/24 subnetwork. If a route matches an entry in the access 
list, the specified forwarding status is applied. If the two entries are in an access list, a 
route to the host at 1.1.1.10 is permitted, while the route to the host at 2.2.2.10 is denied.

You can also use access lists to control the flow of multicast control traffic. You can create 
an access list to restrict the multicast groups that hosts can join or the sources from which 
multicast traffic is received. After you create an access list, you can include it in a 
multicast rule.

The sequence of entries in an access list is important. A route is first compared to the 
entry in the access list with the lowest sequence number and then to other entries in 
ascending sequence number until there is a match. If there is a match, all subsequent 
entries in the access list are ignored. Therefore, you should sequence the more specific 
entries before less specific entries. For example, place the entry that denies routes for the 
1.1.1.1/30 subnetwork before the entry that permits routes for the 1.1.1.0/24 subnetwork.
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In this example, you create an access list on the trust-vr:

1. In Device Manager, doubleclick a device icon to open the device configuration. In 
the device navigation tree, select Network > Virtual Routers. 

2. Doubleclick the trust-vr virtual router. The General Properties screen appears.
3. In the virtual router navigation tree, select Access List, then click the Add icon 

in the main display area. The Access List Entries/New dialog box appears.
4. For Access List Number, enter 2. This number uniquely identifies the access list.
5. In the Access List Entries area, click the Add icon. The New Access List Entry 

dialog box appears. Configure the following:
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a. For Sequence Number, enter 10. This number positions this statement 
relative to other statements in the access list.

b. For Action, select Permit.
c. For Prefix, select Prefix to Filter and enter the IP address/netmask 

1.1.1.1/24.
d. Click OK to save the new access list.

6. Click OK to save your changes to the virtual router, then click OK again to save 
your changes to the device configuration.
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A route map is a set of statements that the device applies in sequential order to a route. 
Each statement in the route map defines a condition that is compared to the route. A 
route is compared to each statement in a specified route map in order of increasing 
sequence number until there is a match, then the action specified by the statement is 
applied. If the route matches the condition in the route map statement, the route is either 
permitted or rejected. 

A route map statement can also modify certain attributes of a matching route. There is an 
implicit deny at the end of every route map; that is, if a route does not match any entry in 
the route map, the route is rejected.

When creating a route map, for each match condition you specify whether a route that 
matches the condition is accepted (permitted) or rejected (denied). If a route matches a 
condition and is permitted, you can optionally set attribute values for the route. You can 
also configure the Set Properties to define the type of action that occurs when an incoming 
or outgoing route matches the conditions specified in the Match Properties.

You can configure additional entries for the same route map, specifying a different 
sequence number for each entry.
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When the NetScreen FW/VPN device has multiple virtual routers, you can enable one VR 
to learn specified routes in the another VR. 

• Use an export rule on the source VR to export specific routes to the destination 
VR. When exporting routes, a virtual router permits other VRs to learn about its 
network. 

• Use an import rule on the destination VR to import specific routes from the 
source VR. Import rules control which routes can be imported; if the destination 
VR does not contain any import rules, the destination VR accepts all exported 
routes, however, if you create an import rule, the destination VR accepts only 
the routes specified in the import rule. 

Configuring an export or import rule is similar to configuring a redistribution rule. You 
configure a route map to specify which routes are to be exported/imported and the 
attributes of the routes.
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You can also configure the trust-vr to automatically export all its route table entries to the 
untrust-vr, or configure a user-defined virtual router to automatically export routes to 
other virtual routers. However, this does not necessarily mean that the untrust-vr 
imports all the routes exported by the trust-vr. If you define import rules for the untrust-
vr, only routes that match the import rules are imported.
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In this example, you export OSPF routes for the 1.1.1.1/24 network in the trust-vr virtual 
router to the untrust-vr routing domain. You first create an access list for the network 
prefix 1.1.1.1/24, which is then used in the route map “rtmap1”to filter for matches of 
routes for the 1.1.1.1/24 network. You then create a route export rule to export matching 
OSPF routes from the trust-vr to the untrust-vr virtual router.

1. In Device Manager, doubleclick a device icon to open the device configuration. In 
the device navigation tree, select Network > Virtual Routers. 

2. Doubleclick the trust-vr virtual router. The General Properties screen appears.
3. Configure the Access List:

a. In the virtual router navigation tree, select Access List, then click the Add 
icon in the main display area. The Access List Entries/New dialog box 
appears.

b. For Access List Number, enter 2. 
c. In the Access List Entries area, click the Add icon. The New Access List 

Entry dialog box appears. 
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d. Configure as shown below:

– For Sequence Number, enter 10.
– For Action, select Permit.
– For Prefix, select Prefix to Filter and enter the IP address/netmask 

1.1.1.1/24.
e. Click OK to save the new access list.

4. Configure the Route Map:

a. In the virtual router navigation tree, select Route Map, then click the Add 
icon in the main display area. The New Route Map dialog box appears.

b. For Name, enter rtmap1. 
c. In the Route Map Entry area, click the Add icon. The New Route-Map 

Entry dialog box appears. 
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d. Configure as shown below:

– For Sequence Number, enter 10.
– For Action, select permit.
– In the Match Properties area, in the Access List table, select 2.

e. Leave all other defaults and click OK to save the new route map entry.
5. Configure the Export Rule:

a. In the virtual router navigation tree, select Export Rules, then click the 
Add icon in the main display area. The New Export Rule dialog box 
appears.
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b. Configure as shown below:

– For Export to Virtual Router, select untrust-vr.
– For Route Map, select rtmap1.
– For Protocol, select OSPF.

c. Click OK to save the new export rule. 
6. Click OK to save your changes to the virtual router, then click OK again to save 

your changes to the device configuration.
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In this example, you configure the trust-vr to automatically export all routes to the 
untrust-vr. You also configure a route map on the untrust-vr to permit only internal 
OSPF routes.

1. In Device Manager, doubleclick a device icon to open the device configuration. In 
the device navigation tree, select Network > Virtual Routers. 

2. Configure the export rule for the trust-vr:

a. Doubleclick the trust-vr virtual router. The General Properties screen 
appears.

b. In the main display area, select Auto-export route to untrust-vr, as shown 
below:

c. Click OK to save your changes to the trust-vr. 
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3. Configure the route map for the untrust-vr. 

a. Doubleclick the trust-vr virtual router. The General Properties screen 
appears.

b. In the virtual router navigation tree, select Route Map, then click the Add 
icon in the main display area. 

c. For Name, enter from-ospf-trust. 
d. In the Route Map Entry area, click the Add icon. The New Route-Map 

Entry dialog box appears. Configure as shown below:

– For Sequence Number, enter 10.
– For Action, select permit.
– In the Match Properties area, in the Route Type table, select Internal 

OSPF.
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e. Click OK to save the new route map entry, then click OK again to save the 
route map.

4. Click OK to save your changes to the virtual router, then click OK again to save 
your changes to the device configuration.
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Typically, routers are attached to multiple networks and are responsible for directing 
traffic across these networks. Each router maintains a routing table, which is a list of 
known networks and directions on how to reach them. While processing an incoming 
packet on a NetScreen FW/VPN device, ScreenOS performs a routing table lookup to find 
the appropriate interface that leads to the destination address.

Each entry in a routing table—called a route entry or simply a route—is identified by the 
destination network to which traffic can be forwarded. The destination network, in the 
form of an IP address and netmask, can be an IP network, subnetwork, supernet, or a 
host. ScreenOS routing table entries can originate from the following sources:

• Directly-connected networks (the destination network is the IP address that you 
assign to an interface in Route mode)

• Dynamic routing protocols, such as OSPF, BGP, or RIP
• Routes that are imported from other routers or virtual routers
• Statically-configured routes

For each destination network, the destination routing table contains the following 
information:

• The interface on the NetScreen FW/VPN device on which traffic for the 
destination network is forwarded.

• The next-hop, which can be either another virtual router on the NetScreen FW/
VPN device or a gateway IP address (usually a router address).

• The protocol from which the route is derived.
• The preference is used to select the route to use when there are multiple routes 

to the same destination network. This value is determined by the protocol or the 
origin of the route. The lower the preference value of a route, the more likely the 
route is to be selected as the active route. You can modify the preference value 
for each protocol or route origin on a per-virtual router basis.

• The metric can also be used to select the route to use when there are multiple 
routes for the same destination network with the same preference value. The 
metric value for connected routes is always 0. The default metric value for static 
routes is 1, but you can specify a different value when defining a static route. 

• The virtual system (vsys) to which this route belongs.

Note: In the routing table, you must configure a default route (network address 
0.0.0.0/0) for the NetScreen FW/VPN device. You should also configure a route 
from the device to the IP address of the NetScreen-Security Manager Device Server.
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When a NetScreen FW/VPN device contains multiple virtual routers, the device does not 
automatically forward traffic between zones that reside in different VRs, even if the 
Security Policy permits that traffic. To enable traffic to pass from one virtual router to 
another, you can configure a static route in one virtual router that defines another VR as 
the next hop for the route. This route can even be the default route for the virtual router. 
For example, you can configure a default route for the trust-vr with the untrust-vr as the 
next hop. If the destination in an outbound packet does not match any other entries in the 
trust-vr routing table, it is forwarded to the untrust-vr.

To create a static route for a network destination:

1. Click the Add icon in the Destination-based Routing Table configuration screen. 
The Routing Table dialog box appears.

2. Enter the IP address and netmask for the destination network.
3. Select either Virtual Router or Gateway in the Next Hop list.

– If you selected Virtual Router, select the VR that is to be the next hop for 
this route.

– If you selected Gateway, enter the interface through which the next hop 
router is accessed, the IP address of the next hop router, and the metric 
and tag for this route.

4. Click OK.
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Some NetScreen FW/VPN devices also enable you to configure a route entry based on the 
source IP address of the data packet. To create a static route based on a network source:

1. Select the Enable Source-based Routing check box.
2. Click the Add icon in the Source-based Routing Table configuration screen. The 

Source Routing Table dialog box appears.
3. Enter the IP address and netmask for the source network.
4. Select the interface through which the next hop router is accessed in the 

Interface list.
5. Enter the IP address of the next hop router.
6. Enter the metric for the route
7. Click OK.
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In the following example, you want to forward traffic from the 10.1.1.0/24 subnetwork to 
ISP 1, and forward traffic from the 10.1.2.0/24 subnetwork to ISP 2. You must configure 
two entries in the default trust-vr virtual router routing table and enable source-based 
routing. The subnetwork 10.1.1.0/24, with ethernet1 as the forwarding interface, uses the 
ISP 1 router (1.1.1.1) as the next-hop; subnetwork 10.1.2.0/24, with ethernet2 as the 
forwarding interface, uses the ISP 2 router (2.2.2.2) as the next-hop.

1. Doubleclick the device icon to open the device configuration. In the device 
navigation tree, select Network > Virtual Routers. Doubleclick the trust-vr 
virtual router. The General Properties screen appears. 

2. In the router navigation tree, select Routing Table. 
3. Select Enable Source-Based Routing. 
4. Add the first routing entry:

a. In the Source-Based Routing Table area, click the Add icon. The New 
Source Routing Table dialog box appears. 

b. Configure as shown below:

– For IP Address, enter 10.1.1.0. 
– For Network Mask, enter 24.
– For Interface, select ethernet1

10.1.1.0/24

10.1.2.0/24

ISP 1
1.1.1.1

ISP 2
2.2.2.2

ethernet1

ethernet2



Chapter 4 Configuring Devices

126 Administrator’s Guide

– For Gateway, enter the IP address 1.1.1.1
c. Click OK to save the new routing entry.

5. Add the second routing entry:

a. In the Source-Based Routing Table area, click the Add icon. The New 
Source Routing Table dialog box appears. 

b. Configure as shown below:

– For IP Address, enter 10.1.2.0. 
– For Network Mask, enter 24.
– For Interface, select ethernet2
– For Gateway, enter the IP address 2.2.2.2

c. Click OK to save the new routing entry.
6. Confirm that your routing table is similar to the one shown below:

7. Click OK to save your changes to the device.
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Some NetScreen FW/VPN devices also enable you to configure a route entry based on the 
source interface (the interface on which a data packet arrives). You can use source-based-
interface routing (SIBR) to enable traffic from users on a specific subnet to be forwarded 
on one path while traffic from users on a different subnet is forwarded on another path.

Note: Source-interface-based routing is only supported in ScreenOS 4.0.1-SIBR. For 
more information, see the Release Notes for ScreenOS 4.0.1-SIBR.
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SIBR can be used in conjunction with the source-based routing feature, which enables 
traffic to be forwarded based on the source IP address of a data packet. When a NetScreen 
FW/VPN device performs route lookup, the source-interface-based routing table is 
checked first. If the route is not found in the source-interface-based routing table and if 
source-based routing is enabled, the source-based routing table is checked. If the route is 
not found in the source-based routing table, the destination-based routing table is 
checked.

You define source-interface-based routes as static routes on a specific virtual router and 
source interface. Source-interface-based routes only apply to the virtual router in which 
you configure them. For example, you cannot specify another virtual router as the next-
hop for a source-interface-based route. You also cannot redistribute source-interface-
based routes into another virtual router or into a routing protocol.

When configuring SIBR, you must specify the name of the interface in the virtual router 
on which the packet arrives, then se the interface on which the packet is to be forwarded. 
This interface can belong to a zone in another virtual router, if that virtual router is 
sharable. (Sharable virtual routers are VRs that are accessible by any vsys on the device. 
The untrust-vr is, by default, a sharable virtual router, but you can configure other root-
level VRs to be sharable). Next, enter the IP address of the next hop router in Gateway. If 
you have already specified a default gateway for the interface, you do not need to specify 
this parameter; the interface’s default gateway is used for the source-interface-based 
route.

You can also configure a metric for the route, if desired. By default, the metric for all SIBR 
entries is 1. If there are multiple source-interface-based routes with the same prefix, only 
the route with the best (lowest) metric is used for route lookup and other routes with the 
same prefix are marked as “inactive”.
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In the following example, you want to forward traffic from the 10.1.1.0/24 subnetwork to 
ISP 1, and forward traffic from the 10.1.2.0/24 subnetwork to ISP 2. You must configure 
two entries in the default trust-vr virtual router routing table and enable source-based 
routing. The subnetwork 10.1.1.0/24, with ethernet2/1 as the source interface and 
ethernet2/3 as the forwarding interface, uses the ISP 1 router (1.1.1.1) as the next-hop; 
subnetwork 10.1.2.0/24, with ethernet2/2 as the source interface and ethernet2/4 as the 
forwarding interface, uses the ISP 2 router (2.2.2.2) as the next-hop. 

10.1.1.0/24

10.1.2.0/24

ISP 1
1.1.1.1

ISP 2
2.2.2.2

ethernet2/3

ethernet2/4

ethernet2/1

ethernet2/2
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1. Add a NetScreen-5400 device running ScreenOS 4.0.1SIBR, then configure the 
network module:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Slot. 

b. Double-click slot 2 to display the slot configuration dialog box. For Card 
Type, select 5000-8G SPM, as shown below:

c. Click OK to save the slot configuration, then click Apply to apply the new 
interfaces to the device.

2. Configure the ethernet 2/1 and ethernet 2/3 interfaces:

a. In the device navigation tree, select Network > Interface. 
b. Doubleclick the ethernet2/1 interface. The General Properties screen 

appears. Configure as follows:
– For Zone, select Trust.
– For IP address and Netmask, enter 10.1.1.0/24.

c. Click OK to save your changes to the interface.
d. Doubleclick the ethernet2/3 interface. The General Properties screen 

appears. Configure as follows:
– For Zone, select Trust.
– For IP address and Netmask, enter 10.1.2.0/24.

e. Click OK to save your changes to the interface.
3. In the device navigation tree, select Network > Virtual Routers. Doubleclick the 

trust-vr virtual router. The General Properties screen appears. In the router 
navigation tree, select Routing Table. 

4. Select Enable Source-Based Routing. 
5. Configure the first entry:
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a. In the Source-Interface-Based Routing Table area, click the Add icon. 
Configure as shown below:

– For Incoming Interface, select ethernet2/1. 
– For IP Address and Netmask, enter 10.1.1.0/24
– For Interface, enter ethernet2/3.
– For Gateway IP Address, enter 1.1.1.1

b. Click OK to save the SIBR entry.
6. Configure the second entry:

a. In the Source-Interface-Based Routing Table area, click the Add icon. 
Configure as shown below:

– For Incoming Interface, select ethernet2/2. 
– For IP Address and Netmask, enter 10.1.2.0/24
– For Interface, enter ethernet2/4.
– For Gateway IP Address, enter 2.2.2.2

b. Click OK to save the SIBR entry.
7. Click OK to save your changes to the virtual router, then click OK to save your 

changes to the device.
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Static multicast routes are typically used to support multicast data forwarding from the 
hosts on interfaces in IGMP router proxy mode to the routers upstream on the interfaces 
in IGMP host mode. (For information on IGMP proxy, see “Configuring IGMP Proxy” on 
page 135.)

Each entry in the multicast routing table contains the following information:

• The multicast group that receives the multicast traffic 
• The IP address of the source of the multicast traffic
• The interface on which the multicast traffic is received 
• The outgoing interface(s) 

In addition, NetScreen FW/VPN devices can translate the original multicast group 
address to a different multicast group address on the outgoing interface. When you create 
a static route, you can specify both the original and translated multicast group address.

To configure a static multicast route:

1. In the Multicast Routing Table configuration screen, select the Multiple IIF 
Enable check box to permit multiple routes with different incoming interfaces 
for the same source and multicast group.

2. Click the Add icon in the Multicast Static Routes area. The Multicast Routing 
Table dialog box appears. Configure the new routing entry:

a. Enter the multicast group IP address.
b. Enter the source IP address.
c. Enter the IP address of the multicast group on the outgoing interface, if 

the NetScreen FW/VPN device translates the multicast group IP address.
d. In the Incoming Interface box, select the interface on which the device 

receives the multicast traffic.
e. Click the Add icon to add an outgoing interface. The Outgoing Interface 

dialog box appears. Select the outgoing interface and click OK. Repeat to 
add more outgoing interfaces.

3. Repeat step 2 to add more multicast route entries.
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A route preference is a weight added to the route that influences the determination of the 
best path for traffic to reach its destination. When importing or adding a route to the 
routing table, the virtual router adds a preference value — determined by the protocol by 
which the route is learned — to the route. A low preference value (a number closer to 0) is 
preferable to a high preference value (a number further from 0). In a virtual router, you 
can set the preference value for routes according to protocol.

To change the preference value for a protocol, enter a new value for the protocol in the 
Route Preferences configuration screen.
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This section describes the basic steps in configuring the following dynamic routing 
protocols:

• Open Shortest Path First (OSPF)
• Routing Information Protocol (RIP)
• Border Gateway Protocol (BGP)
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The following are the basic tasks in configuring OSPF in a VR on a NetScreen FW/VPN 
device:

1. Create and enable the OSPF routing instance in a VR. This step also 
automatically creates an OSPF backbone area, with an area ID of 0.0.0.0, which 
cannot be deleted.

2. (Optional) Unless all OSPF interfaces will be connected to the backbone area, 
you need to define a new OSPF area with its own area ID. For example, if the 
NetScreen FW/VPN device is to act as an ABR, you need to create a new OSPF 
area in addition to the backbone area. You can configure the new area as a 
normal, stub, or not-so-stubby area.

3. Assign one or more interfaces to each OSPF area. You must explicitly add 
interfaces to an OSPF area, including the backbone area.

4. Enable OSPF on each interface.

You can optionally configure other OSPF parameters, such as Global parameters and 
Interface parameters.

Global parameters, such as virtual links, are set at the VR level for the OSPF protocol. 
When you configure an OSPF parameter at the VR level, the parameter setting affects 
operations on all OSPF-enabled interfaces.

Interface parameters, such as authentication, are set on a per-interface basis for the 
OSPF protocol. When you configure an OSPF parameter at the interface level, the 
parameter setting affects the OSPF operation only on the specific interface.

To configure OSPF:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Double-click 
the device object to open the device configuration.

2. In the device navigation tree, select Network >Virtual Router to display the list 
of configured virtual routers. Double-click the virtual router in which you are 
configuring an OSPF routing instance. The Virtual Router configuration screen 
appears.

3. In the virtual router navigation tree, select Dynamic Routing Protocol and 
enable Configured OSPF Instance. OSPF configuration options now appear in 
the virtual router navigation tree under Dynamic Routing Protocol.

4. In the virtual router navigation tree, select OSPF > Parameters to display the 
Parameters screen. Enable OSPF, then click OK to close the Parameters screen.
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(OPTIONAL) To define a new non-backbone OSPF area, select OSPF > Area. 
The Area configuration screen appears. In this screen, do the following:

a. Click the Add icon.
b. Enter the Area ID.
c. Select the interfaces that are to be included in this OSPF area.
d. Select the Type.
e. Click OK to close the Area configuration screen.

5. In the device navigation tree, select Interface to display the list of interfaces. 
Double-click the interface that is connected to OSPF peers to open the interface 
screen.

6. In the interface navigation tree, select Protocol to display the Protocol screen, 
then click the OSPF tab and configure the following:

a. Select the ID of the OSPF area to which the interface is bound.
b. Enable OSPF.

7. Click OK.
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To configure RIP, you must create and enable the RIP routing instance in a virtual outer, 
then enable RIP on interfaces that connect to other RIP routers. Optionally, you can 
configure other RIP parameters such as Global parameters and Interface parameters.

Global parameters, such as timers and trusted RIP neighbors, are set at the VR level for 
the RIP protocol. When you configure a RIP parameter at the VR level, the parameter 
setting affects operations on all RIP-enabled interfaces. 

Interface parameters, such as neighbor authentication, are set on a per-interface basis for 
the RIP protocol. When you configure a RIP parameter at the interface level, the 
parameter setting affects the RIP operation only on the specific interface.

To configure RIP:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Double-click 
the device icon to open the device configuration.

2. In the device navigation tree, select Network >Virtual Router to display the list 
of configured virtual routers. Double-click the virtual router in which you are 
configuring a RIP routing instance. The Virtual Router configuration screen 
appears.

3. In the virtual router navigation tree, select Dynamic Routing Protocol and 
enable Configured RIP Instance. RIP configuration options now appear in the 
virtual router navigation tree under Dynamic Routing Protocol.

4. In the virtual router navigation tree, select RIP > Parameters to display the 
Parameters screen. Enable RIP, then click OK to close the Parameters screen.

5. In the device navigation tree, select Interface to display the list of interfaces. 
Double-click the interface that is connected to the RIP peer to open the interface 
screen.
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6. In the interface navigation tree, select Protocol to display the Protocol screen, 
then click the RIP tab and enable the following settings:

– Bind Interface to RIP
– Enable RIP

7. Click OK.
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To configure BGP, you must create and enable the BGP routing instance in a virtual 
router by assigning an autonomous system number to the BGP instance, then enabling 
the instance. After you enable and configure the BGP peer, you can then enable BGP on 
the interface that is connected to the peer.

Before two BGP devices can communicate and exchange routes, they need to identify each 
other so they can start a BGP session. You need to specify the IP addresses of the BGP 
peers and, optionally, configure parameters for establishing and maintaining the session. 
Peers can be either internal (IBGP) or external (EBGP) peers. For an EBGP peer, you 
need to specify the autonomous system in which the peer resides.

All BGP sessions are authenticated by checking the BGP peer identifier and the AS 
number advertised by the peers. A successful connection with a peer is logged. If anything 
goes wrong with the peer connection, a BGP notification message will either be sent to or 
received from the peer, which causes the connection to fail or close.

You can configure parameters for individual peer addresses. You can also assign peers to 
a peer-group, which then enables you configure parameters for the peer-group as a whole. 
Note that you cannot assign IBGP and EBGP peers to the same peer-group.

To configure BGP:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Double-click 
the device object to open the device configuration.

2. In the device navigation tree, select Network >Virtual Router to display the list 
of configured virtual routers. Double-click the virtual router in which you are 
configuring a BGP routing instance. The Virtual Router configuration screen 
appears.

3. In the virtual router navigation tree, select Dynamic Routing Protocol and 
enable Configured BGP Instance. BGP configuration options now appear in the 
virtual router navigation tree under Dynamic Routing Protocol.

4. In the virtual router navigation tree, select BGP > Parameters to display the 
Parameters screen. Configure the following:

– Enable BGP.
– Enter an AS Number.

5. In the virtual router navigation tree, select BGP > Neighbors to display the 
Neighbors screen. Click the Add icon to display the New Neighbor screen. 
Configure the following:

c. Select Peer Enabled.
d. Enter the BGP peer information.
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e. Click OK to save the new neighbor.
f. Click OK to save your changes to the virtual router.

6. In the device navigation tree, select Interface to display the list of interfaces. 
Double-click the interface that is connected to the BGP peer to open the interface 
screen.

7. In the interface navigation tree, select Protocol to display the Protocol screen, 
then click the BGP tab and enable BGP.

8. Click OK.
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Multicast routing environments require the following to forward multicast information:

• A mechanism between hosts and routers to communicate group membership 
information. NetScreen FW/VPN devices support the Internet Group 
Management Protocol (IGMP) versions 1 and 2. 

• A multicast routing protocol to populate the multicast route table and forward 
multicast traffic to hosts throughout the network. NetScreen FW/VPN devices 
support the Protocol Independent Multicast - Sparse-Mode (PIM-SM) protocol. 
Alternatively, you can use IGMP Proxy to transmit multicast information 
between routers without the CPU overhead of a multicast routing protocol

This section describes the basic steps in configuring the following multicast protocols:

• Configuring IGMP
• Configuring IGMP Proxy
• Configuring PIM-SM
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On NetScreen FW/VPN devices, you must explicitly enable IGMP in router mode on the 
interfaces that are connected to hosts. To enable IGMP in router mode:

1. In the device navigation tree, select Network > Interface.
2. Double-click the interface on which you are enabling IGMP. The General 

Properties screen appears.
3. In the interface navigation tree, select Protocol.

Note: Multicast routing is only supported in ScreenOS 4.0.1-Multicast. For more 
information, see the ScreenOS 4.0.1-Multicast New Features Guide.

Note: The NetScreen-Security Manager UI displays the multicast parameters and 
multicast static routes that you configure. It does not display dynamic information 
about multicast protocols at the device level. (For example, whether or not an interface 
is a Querier in IGMP.) For this information, you must issue the appropriate CLI “get” 
commands from the device.
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4. Select the IGMP tab and configure the following:

a. In the Type box, select Router.
b. Select Enable.

5. Click OK to save your changes to the interface. 
6. Click OK to save your changes to the device.

You can optionally change the default parameters for each interface on which IGMP is 
enabled. You can also use access lists to control traffic to and from an IGMP interface. 
First, create access lists that identify the following:

• The multicast groups that the hosts on a specified interface can join
• The hosts from which an IGMP router interface can receive IGMP messages 
• The routers that are eligible for Querier selection 

Then, enter the access list IDs in the IGMP configuration screen of the IGMP interface(s). 
The NetScreen FW/VPN device then filters IGMP traffic based on the access lists. 
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IGMP proxy enables a NetScreen FW/VPN device to extend the scope of a multicast 
domain by one hop without running a multicast routing protocol. When you enable IGMP 
proxy on a device, the interface connected to the hosts (downstream interface) functions as 
a multicast router, and the interface connected to the upstream router functions as an 
IGMP host. You must first enable IGMP in host mode on upstream interfaces, then enable 
IGMP in router mode on downstream interfaces, and finally enable IGMP proxy on router 
interfaces.

To configure an IGMP proxy in the NetScreen-Security Manager UI:

1. In the device navigation tree, select Network > Interface.
2. Double-click the interface on which you are enabling IGMP. The General 

Properties screen appears.
3. In the interface navigation tree, select Protocol.
4. Select the IGMP.

– If you are enabling IGMP on an upstream interface:
– In the Type box, select Host.
– Select Enable.

– If you are enabling IGMP on a downstream interface:
– In the Type box, select Router.
– Select Enable.
– Select Proxy.

5. Click OK to save your changes to the routing entry.
6. Click OK to save your changes to the device.

After you configure the interfaces, configure a multicast rule to permit IGMP messages to 
pass between zones. For information on multicast rules, see “About the Multicast 
Rulebase” on page 354.
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To configure PIM-SM in a virtual router on a NetScreen FW/VPN device:

1. Configure either a static route or a dynamic routing protocol such as RIP, BGP 
or OSPF. (For details on configuring static routes, see “Configuring Routing 
Table Entries” on page 123. For details on the dynamic routing protocols, see 
“Configuring Dynamic Routing Protocols” on page 131.)

2. Create a Security Policy to pass unicast and multicast data traffic between 
zones. (For details on Security Policies, see “About Security Policies” on page 
352.)

3. Create and enable the PIM-SM routing instance in a virtual router. 
4. Enable PIM-SM on interfaces that transmit multicast traffic.
5. Configure a multicast rule to permit PIM-SM messages between zones. (For 

details on multicast rules, see “About the Multicast Rulebase” on page 354.)

After you enable the PIM-SM routing instance in the virtual router and enable it on all 
applicable interfaces, you can optionally configure PIM-SM features such as the following:

• Use access lists to restrict the rendezvous points (RPs) and sources from which a 
multicast group can receive traffic. You can also use access lists to restrict the 
multicast groups for which the virtual router forwards PIM join-prune 
messages. First, create the access lists, then enter the access list IDs in the PIM-
SM configuration screen of the virtual router. The NetScreen FW/VPN device 
then uses the access lists to filter the PIM-SM traffic.

• Change the default parameters for each interface on which PIM-SM is enabled. 
When you set parameters at this level, the parameters affect the specific 
interface only.

• Configure a static RP for a particular zone, or use dynamic RP mappings and 
configure a virtual router as a candidate rendezvous point (C-RP).

• You can configure a virtual router to function as a proxy RP.

The following are the basic steps to configure PIM-SM in the NetScreen-Security 
Manager UI:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Doubleclick 
the device icon to open the device configuration. 

2. Configure the virtual router for PIM-SM:

a. In the device navigation tree, select Network > Virtual Router.
b. Doubleclick the virtual router in which you are configuring a PIM-SM 

instance. The General Properties screen appears.
c. In the virtual router navigation tree, select Dynamic Routing Protocol.
d. In the main display area, select Configure PIM-SM. PIM-SM 

configuration options now appear in the virtual router navigation tree 
under Dynamic Routing Protocol.

e. In the virtual router navigation tree, select Dynamic Routing Protocol > 
PIM-SM > Parameters. The Parameters configuration screen appears.

f. Select Enable in the main display area,
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g. Click OK to save your changes to the virtual router.
3. Configure the interface for PIM-SM:

a. In the device navigation tree, select Network > Interface. 
b. Doubleclick the interface that transmits multicast traffic. The General 

Properties screen appears.
c. In the interface navigation tree, select Protocol, then select the PIM-SM 

tab in the main display area.
d. Select Configure PIM-SM on Interface.
e. Select Enable PIM-SM.
f. Click OK to save your changes to the interface. Repeat step 3 to enable 

PIM-SM on additional interfaces.
4. Click OK to save your changes to the device configuration.
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You can configure a static rendezvous point (RP) for a particular zone and/or configure a 
virtual router as a C-RP. Before you configure a static RP and a C-RP, you must first 
create access lists that identify the multicast groups mapped to each one.

Following are the basic steps for configuring a Rendezvous Point:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Doubleclick 
the device icon to open the device configuration. 

2. Configure the virtual router for PIM-SM:

a. In the device navigation tree, select Network > Virtual Router.
b. Doubleclick the virtual router in which you are configuring a PIM-SM 

instance. The General Properties screen appears.
c. In the virtual router navigation tree, select Dynamic Routing Protocol.
d. In the main display area, select Configure PIM-SM. PIM-SM 

configuration options now appear in the virtual router navigation tree 
under Dynamic Routing Protocol.

3. In the virtual router navigation tree, select Dynamic Routing Protocol > PIM-SM 
> Rendezvous Points. 

4. In the main display area, click the Add icon. The new Zone dialog box appears. 
For Zone, select the zone that contains the RP.

5. To configure an Rendezvous Point Candidate:

a. Select the interface that is advertised as the C-RP.
b. Specify the access list that identifies the multicast group(s) for which the 

interface is the RP candidate.
c. Select the advertised C-RP priority.
d. Select the holdtime advertised to the bootstrap router.

6. To configure a Static Rendezvous Point, click the Add icon in the Static RP 
Addresses area. The Static RP Addresses dialog box appears. Configure as 
follows:
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a. Enter the IP address of the RP.
b. Specify the access list that identifies the multicast group(s) mapped to the 

RP.
c. If you want to always use the same RP for the specified multicast group(s) 

select the Always used as RP check box. Use this option to override 
dynamic group-RP mappings.

7. Click OK to save your changes to the virtual router, then click OK to save your 
changes to the device configuration.
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You can create access lists to identify the acceptable sources, multicast groups and RPs, 
then configure the virtual router to accept PIM messages only from those specified in the 
access lists. To configure acceptable groups on the virtual router:

1. In the navigation tree, select Device Manager > FW/VPN Devices. Doubleclick 
the device icon to open the device configuration. 

2. Configure the virtual router for PIM-SM:

a. In the device navigation tree, select Network > Virtual Router.
b. Doubleclick the virtual router in which you are configuring a PIM-SM 

instance. The General Properties screen appears.
c. In the virtual router navigation tree, select Dynamic Routing Protocol.
d. In the main display area, select Configure PIM-SM. PIM-SM 

configuration options now appear in the virtual router navigation tree 
under Dynamic Routing Protocol.

3. In the virtual router navigation tree, select Dynamic Routing Protocol > PIM-SM 
> Acceptable Groups.

4. In the main display area, select the access list that identifies the permitted 
multicast group(s). 

5. In the Group Specific Access Policies area, click the Add icon to map a multicast 
group to access lists. The Multicast Group IP dialog box appears.

a. Enter the IP address of the multicast group for which you created access 
lists for permitted RPs and permitted sources.

b. Select the ID of the access list that identifies the permitted RP(s). The 
device drops traffic for the multicast group if the traffic is from an RP that 
is not on the access list.

c. Select the ID of the access list that identifies the permitted source(s). This 
prevents unauthorized sources from sending data into your network. 
When you use this feature, the device drops multicast data from sources 
not in the list.

d. Click OK to save the new Multicast Group IP.
6. Click OK to save your changes to the virtual router, then click OK again to save 

your changes to the device configuration.
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You can configure a virtual router to function as a proxy RP. A proxy RP acts as the RP for 
groups learned from other zones. To configure a virtual router as a proxy RP, select Proxy 
when configuring the Rendezvous Point for PIM-SM.
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In this example, the hosts in the Trust zone are to receive the multicast stream for the 
multicast group 224.4.4.1/32. You configure RIP as the unicast routing protocol and create 
a firewall rule to pass data traffic between the Trust and Untrust zones. You create a PIM 
instance on the trust-vr and enable PIM on ethernet1 in the Trust zone, and on ethernet2 
in the Untrust zone. ethernet1 is connected to the potential receivers; therefore, you also 
configure IGMP in router mode on this interface. You then create a multicast rule that 
permits PIM-SM BSR and join-prune messages between the zones.

1. Configure zones and interfaces.

a. Configure ethernet1 and bind it to the Trust zone.
b. Enable IGMP in router mode on ethernet1, as shown below.

c. Configure ethernet2 and bind it to the Untrust zone.
2. Configure the following address objects:

– Multicast group IP address, as shown below:

– Source IP address 
3. Configure the access list that permits traffic from multicast group 224.4.4.1 

(shown below).
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4. Configure RIP.

a. Create a RIP instance on the trust-vr, as shown below.

b. Enable RIP on ethernet1 and on ethernet3.
5. Configure PIM-SM.

a. Create a PIM-SM instance on the trust-vr.
b. Select Enable in the Parameters screen.
c. Enable PIM-SM on ethernet1 and on ethernet3, as shown below.

6. Configure a firewall rule that permits unicast and multicast data traffic to pass 
between zones, as shown below.
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7. Configure a multicast rule permitting PIM-SM messages to pass between zones, 
as shown below.
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Use the Zone screen to configure predefined zones or create user-defined security zones. 
You can also create a tunnel zone, a logical segment to which a VPN tunnel interface is 
bound.

For more detailed information about zones on NetScreen FW/VPN devices, see the 
“Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide.
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To create a security or tunnel zone:

1. Determine the zone type:
– A layer 3 zone is a zone to which you bind NAT or Route mode interfaces
– A layer 2 zone is a zone to which you bind Transparent mode interfaces

– A tunnel zone is a zone to which you bind a carrier zone
2. Click the Add icon in the Zone screen and select Security Zone or Tunnel Zone.
3. Define the name of the zone and the virtual router in which you want to place 

the zone.

For tunnel zones, you must also specify the carrier zone, which is the security 
zone with which the tunnel zone is logically associated. A carrier zone provides 
firewall protection to the encapsulated traffic.

4. Click OK.
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To configure a zone, double-click the zone in the Zone screen to open the zone 
configuration. For security zones, you can configure the following general properties:

• Enable reassembly of fragmented IP packets and TCP segments for application 
layer gateway (ALG) filtering.

• Block traffic between hosts within the security zone
• Direct the NetScreen FW/VPN device to send back a TCP segment with the 

RESET flag set to 1 when a TCP segment with a flag other than SYN is received.

Note: When you add a device and configure it to operate in 
Transparent mode, the L2 zone names appear in the NetScreen-
Security Manager UI without the “V1-” prefix. When you update the 
configuration on the device from the UI, the correct L2 zone names are 
configured.
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Typically, a network forwarding device such as a router or switch does not reassemble 
fragmented packets that it receives. It is the responsibility of the destination host to 
reconstruct the fragmented packets when they all arrive. Because the purpose of 
forwarding devices is the efficient delivery of traffic, queuing fragmented packets, 
reassembling them, then refragmenting them, and forwarding them is unnecessary and 
inefficient. However, passing fragmented packets through a firewall is insecure. An 
attacker can intentionally break up packets to conceal traffic strings that the firewall 
otherwise would detect and block.

You can enable predefined screen options that detect and block various kinds of traffic 
that the FW/VPN device determines to be potentially harmful. To secure all connection 
attempts, NetScreen FW/VPN devices use a dynamic packet filtering method known as 
stateful inspection. Using this method, the device notes various components in a packet 
header, such as source and destination IP addresses, source and destination port 
numbers, and packet sequence numbers. The device uses this information to maintain the 
state of each session traversing the firewall.

A NetScreen FW/VPN device uses stateful inspection to secure a zone by inspecting, and 
then permitting or denying, all connection attempts that require crossing an interface 
from and to that zone. To protect against attacks from other zones, you can enable defense 
mechanisms known as screen attack protections, which detect and deflect TCP, UDP, IP, 
and ICMP packet attacks. Common Screen attacks are SYN floods, packet fragments, and 
SYN and FIN bits set. When Screen attack protections are enabled, the device generates a 
screen alarm log entry for each violation. 

To configure Screen attack protections, open a device configuration and select Network > 
Zones to display the Zone configuration. Double-click a zone to display the Predefined 
Zone dialog box and select Screen. The Screen dialog box contains the following five tabs:

Tab Description

Flood Defense Manage attacks that overwhelm the device with large numbers or 
floods of certain packet types. Examples include SYN packets 
that overwhelm the network resulting in a denial of service (DoS).

TCP/IP Anomalies Manage SYN and SYN-ACK-ACK attacks. Examples include:

• A TCP packet has a FIN flag set, but not the ACK bit. TCP packets 
with the FIN flag normally also have the ACK bit set. 

• Both the SYN and FIN flags are set in the same packet. An 
attacker might send a packet with both flags set to see what kind of 
system reply is returned. The attacker can then use any known 
system vulnerabilities for further attacks.

• A TCP packet without flags.
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For step-by-step instructions on configuring the SCREEN options, see the Online Help 
topic “Configuring SCREEN Options”. For details on the SCREEN alarm log entries that 
enabling these options can generate, see “Screen Alarm Log Entries” on page 612.

����
�	�
���� ��,;��������
��
You can also enable malicious URL protection. When configured, the FW/VPN device can 
drop incoming HTTP packets that reference URLs with specific user-defined patterns. 
You can define up to 48 malicious URL string patterns per zone, each of which can be up 
to 64 characters long, for malicious URL protection at the zone level. When the Malicious 
URL blocking feature is enabled, the NetScreen FW/VPN device examines the data 
payload of all HTTP packets. If it locates a URL and detects that the beginning of its 
string—up to a specified number of characters—matches the pattern you defined, the 
device blocks that packet from passing the firewall. 

A resourceful attacker, realizing that the string is known and might be guarded against, 
can deliberately fragment the IP packets or TCP segments to make the pattern 
unrecognizable during a packet-by-packet inspection. However, the NetScreen FW/VPN 
device uses Fragment Reassembly to buffer fragments in a queue, reassemble them into a 
complete packet, and then inspect that packet for a malicious URL. Depending on the 
results of this reassembly process and subsequent inspection, the device performs one of 
the following steps:

• If the device discovers a malicious URL, it drops the packet and enters the event 
in the log.

• If the device cannot complete the reassembly process, a time limit is imposed to 
age out and discard fragments.

• If the device determines that the URL is not malicious but the reassembled 
packet is too big to forward, the device fragments that packet into multiple 
packets and forwards them.

• If the device determines that the URL is not malicious and does not need to 
fragment it, it then forwards the packet.

To configure a malicious URL string, you must specify the following properties:

• Malicious URL ID. Enter the ID that you want use to identify the URL string.

IP Option Anomalies Set options that provide IP-related protections. Examples include 
fragments, which are reduced portions of an attack packet that in 
complete form would be recognized by the Security Policy. By 
disassembling into smaller, non-defined packet portions, the 
fragments go unrecognized by the policy and reassemble into 
the whole attack packet after they have entered the device where 
they can degrade data and cause port and device interruption.

Block HTTP Components Detect and block component-level attacks. 

MS Windows Defense Detect and block Windows attacks.

Denial of Service Defense Detect and block Denial of Service (DoS) attacks.

Scan/Spoof/Sweep Defense Detect and block systems scans and identity spoofing attacks.



Configuring Zones

NetScreen-Security Manager 2004 FP2 145

• HTTP Header Pattern. Enter the malicious URL string (also called a pattern) 
that you want the NetScreen FW/VPN device to match.

• Minimum Length Before CRLF. Enter the number of characters in the URL 
string (pattern) that must be present in a URL—starting from the first 
character—for a positive match (not every character is required for a match). 
CRLF represents “carriage return/line feed”; HTTP uses a CR or LF character to 
mark the end of a code segment.

For more detailed information about Mal-URL on NetScreen FW/VPN devices, see the 
“Attack Detections and Defense Mechanisms”, volume 4 in the NetScreen Concepts & 
Examples ScreenOS Reference Guide.
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In this example, you define three malicious URL strings and enable the malicious URL 
blocking option. Then, enable fragment reassembly for the detection of the URLs in 
fragmented HTTP traffic arriving at an Untrust zone interface.

1. Add a NetScreen-5GT FW/VPN device. Choose Model when adding the device 
and configure the device as running ScreenOS 5.x.

2. In the device navigation tree, select Network > Zone. Double-click the Untrust 
zone. The General Properties screen appears.

3. Enable TCP/IP Reassembly for ALG.
4. In the Zone navigation tree, select Mal-URL. Configure the three malicious URL 

strings:

a. Click the Add icon to display the new Malicious URL ID dialog box. 
Configure as shown below:

For Malicious URL ID, enter Perl. 

For HTTP Header Pattern, enter scripts/perl.exe.

For Minimum Length Before CRLF, enter 14. 

Click OK to save the URL.
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b. Click the Add icon to display the new Malicious URL ID dialog box. 
Configure as shown below:

For Malicious URL ID, enter CMF. 

For HTTP Header Pattern, enter cgi-bin/phf.

For Minimum Length Before CRLF, enter 11.

Click OK to save the URL.

c. Click the Add icon to display the new Malicious URL ID dialog box. 
Configure as shown below:

For Malicious URL ID, enter DLL. 

For HTTP Header Pattern, enter 210.1.1.5/msadcs.dll.

For Minimum Length Before CRLF, enter 18.

Click OK to save the URL.

5. Click OK to save your changes to the zone, then click OK again to save the 
device configuration.



Configuring Interfaces

NetScreen-Security Manager 2004 FP2 147

��	(
��
	��
	���(����
The Interface screen shows the physical interfaces available on the NetScreen FW/VPN 
device. Some NetScreen systems support function zone interfaces, which are either a 
separate physical MGT interface for management traffic or a high availability (HA) 
interface used to link two devices together to form a redundant group or cluster.

Interfaces and subinterfaces enable traffic to enter and exit a security zone. To enable 
network traffic to flow in and out of a security zone, you must bind an interface to that 
zone and, if it is a Layer 3 zone, assign it an IP address. You can assign multiple 
interfaces to a zone, but you cannot assign a single interface to multiple zones.

You can add the following interfaces on a NetScreen FW/VPN device:

• An aggregate interface is the accumulation of two or more physical interface 
which share the traffic load to a single IP address. This type of interface is only 
supported on certain NetScreen FW/VPN systems.

• A loopback interface is a logical interface that emulates a physical interface 
and is always is the up state.

• Virtual security interfaces (VSIs) are the virtual interfaces that two 
NetScreen FW/VPN devices share when forming a virtual security device (VSD) 
in a high availability cluster.

• A redundant interface consists of two physical interfaces bound to the same 
security zone. One of the two physical interfaces acts as the primary interface 
and handles all the traffic directed to the redundant interface; the other physical 
interface acts as a backup.

• A subinterface is a logical division of a physical interface. A subinterface 
borrows the bandwidth it needs from the physical interface.

• A tunnel interface acts as a doorway to a VPN tunnel. Traffic enters and exits 
a VPN tunnel via a tunnel interface. When you configure a tunnel interface, you 
can also encapsulate IP multicast packets in GREv1 unicast packets.

• An ADSL interface on the NetScreen-5GT ADSL FW/VPN device uses ATM as 
its transport layer. The interface can support multiple permanent virtual 
circuits (PVCs) on a single physical line. Before you can configure the adsl1 
interface, however, you must obtain the DSLAM configuration details for the 
ADSL connection from the service provider. 

For details and examples on configuring specific interface types, see “Interface 
Configuration Examples” on page 166. 

In the Interface screens, you can configure the physical interfaces and, if available, the 
function zone interfaces. Double-click the interface in the Interface screen (or, either 
select the interface and then click the Edit icon, or right-click the interface and select 
Edit). For physical and function zone interfaces, you can configure the following:

• Configuring General Properties
• Configuring Advanced Properties
• Configuring Service Options
• Configuring DHCP
• Configuring Protocol
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• Configuring Secondary IP
• Configuring Track IP
• Configuring GRE
• Configuring NAT

For more detailed explanations about interfaces on NetScreen FW/VPN devices, see the 
“Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide.
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Set the following:

• Name of the interface
• Zone to which the interface is bound
• Loopback interface group to which the interface belongs
• Redundant interface group to which the interface belongs
• IP address, netmask, and gateway of the interface
• Mode of the interface (NAT or route)

On NetScreen FW/VPN ADSL interfaces, you can also configure ADSL options (VPI, VCI, 
Multiplexing mode) as part of the General Properties for the ADSL interface. For details 
on configuring ADSL, see “Configuring an ADSL Interface” on page 179.

On some NetScreen FW/VPN device interfaces, such as the VLAN1 or Serial interface, 
you also configure the service options as part of the General Properties for the interface. 
For details on service options, see “Configuring Service Options” on page 148.
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Set attributes of the physical link for the interface:

• Physical Settings
• Link & MTU Size
• WebAuth
• Deny Routing
• Port Settings
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Enable management service options for the interface:

• Web:  Selecting this option enable the interface to receive HTTP traffic for 
management from the Web user interface (WebUI).

• Telnet:  A terminal emulation program for TCP/IP networks such as the 
Internet, Telnet is a common way to remotely control network devices. Selecting 
this option enables Telnet manageability.
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• SSH:  You can administer the NetScreen FW/VPN device from an Ethernet 
connection or a dial-in modem using Secure Command Shell (SSH). You must 
have an SSH client that is compatible with Version 1.5 of the SSH protocol. 
These clients are available for Windows 95 and later, Windows NT, Linux, and 
UNIX. The NetScreen FW/VPN device communicates with the SSH client 
through its built-in SSH server, which provides device configuration and 
management services. Selecting this option enables SSH manageability.

• SNMP: The NetScreen FW/VPN device supports both SNMPv1 and SNMPv2c, 
and all relevant Management Information Base II (MIB II) groups, as defined in 
RFC-1213. Selecting this option enables SNMP manageability.

• SSL:  Selecting this option enables the interface to receive HTTPS traffic for 
secure management of the NetScreen FW/VPN device using the WebUI.

• Global Pro (Security Manager): Selecting this option enables the interface to 
receive NetScreen-Security Manager traffic.

• Ping: Selecting this option enables the interface to respond to an ICMP echo 
request, or ping, which determines whether a specific IP address is accessible 
over the network.

• Ident-Reset:  Services like Mail and FTP send identification requests. If they 
receive no acknowledgement, they send the request again. While the request is 
processing, there is no user access. By enabling the Ident-reset option, the 
interface sends a TCP reset announcement in response to an IDENT request to 
port 113 and restores access that has been blocked by an unacknowledged 
identification request.
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The Dynamic Host Configuration Protocol (DHCP) automatically assigns TCP/IP settings 
for the hosts on the network. Different NetScreen FW/VPN devices support different 
DHCP roles:

• DHCP clients receive a dynamically assigned IP address.
• DHCP servers allocate dynamic IP addresses to clients.
• DHCP relay agents receive information from a DHCP server and relay that 

information to clients.

Some devices can simultaneously act as a DHCP client, server, and relay agent.

����
�	�
���������� 
You can enable and configure dynamic routing protocol and multicast protocol operations 
on the interface.
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This option is not available for interfaces in the Untrust zone. Each interface has a single, 
unique primary IP address. You can also set one or more secondary IP addresses for the 
interface.
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You can enable the NetScreen FW/VPN device to monitor the reachability of certain IP 
addresses through the interface to determine interface failure. For each IP address to be 
tracked, specify the following:

• Interval at which pings are sent to the tracked address
• Number of consecutive unsuccessful ping attempts before the connection to the 

address is considered failed
• Weight of the failed IP connection

The Failover Threshold is compared to the sum of the weights of failed IP connections. 
Instead of tracking specific IP addresses, you can alternatively set the device to track the 
interface’s default gateway.
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You can configure a tunnel interface to support GREv1 encapsulation. You can use GRE 
to forward multicast packets through non-multicast aware routers and devices.
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You can configure the following address translation methods on the NetScreen FW/VPN 
device:

• Mapped IP (MIP) settings. For details on configuring a MIP, see “Configuring 
MIPs” on page 150.

• Dynamic IP (DIP) settings. For details on configuring a DIP, see “Configuring 
DIPs” on page 157. For details on DIP groups for NetScreen FW/VPN devices in 
an active/active NSRP configuration, see “Configuring DIP Groups” on page 195.

• Virtual IP (VIP) settings. For details on configuring a VIP, see “Configuring 
VIPs” on page 153.
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A mapped IP (MIP) is a direct one-to-one mapping of one IP address to another. The 
NetScreen FW/VPN device forwards incoming traffic destined for a MIP to the host with 
the address to which the MIP points. A MIP is static destination address translation that 
maps the destination IP address in an IP packet header to another static IP address, 
enabling inbound traffic to reach private addresses in a zone whose interface is in NAT 
mode. When a MIP host initiates outbound traffic, the NetScreen FW/VPN device 
translates the source IP address of the host to that of the MIP address. You can map an 
address-to-address or subnet-to-subnet relationship (the netmask applies to both the 
mapped IP subnet and the original IP subnet).

You can also use a MIP to handle overlapping address spaces at two sites connected by a 
VPN tunnel (an overlapping address space is when the IP address range in two networks 
are partially or completely the same).
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The zone you configure the MIP in determines the subnet of IP address that you can 
assign the MIP:

• When defining a MIP in a tunnel zone or security zone other than untrust, you 
must use the same subnet as a tunnel interface with an IP address and netmask, 
or in the same subnet as the IP address and netmask of an interface bound to a 
Layer 3 (L3) security zone.

• When defining a MIP an interface in the Untrust zone, you can use a different 
subnet than the Untrust zone interface IP address. However, you must add a 
route on the external router pointing to an Untrust zone interface so that 
incoming traffic can reach the MIP. You must also define a static route that 
associates the MIP with the interface that hosts it.

• On some NetScreen FW/VPN devices, you can assign a MIP the same address as 
an interface, but you cannot use that MIP address in a DIP pool.

You can use a MIP as the destination addresses in rules between any two zones or in a 
Global rule. For the destination zone, use either the Global zone or the zone with the 
address to which the MIP points.
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In this example, you create a MIP to handle inbound traffic to your Web server. After 
configuring the MIP, you create a Global MIP to represent the MIP you created for the 
device, then use the Global MIP object in a Security Policy rule that permits HTTP traffic 
from any address in the Untrust zone to the MIP—and to the host with the address to 
which the MIP points—in the Trust zone. All security zones are in the trust-vr routing 
domain.

1. Add a NetScreen-50 FW/VPN device. Choose Model when adding the device and 
configure the device as running ScreenOS 5.x.

2. Configure the Trust interface for ethernet1.

Untrust Zone

Trust Zone

Global Zone

Untrust Zone Interface
ethernet2, 1.1.1.1/24

Trust Zone Interface
ethernet1, 10.1.1.1/24

MIP 1.1.1.5 -> 10.1.1.5 (Configured on ethernet2)

Web Server
10.1.1.5

Internet

Traffic destined for 1.1.1.5 arrives at 
ethernet2.
The NetScreen FW/VPN device looks 
up the route for a MIP on ethernet2 
and resolves 1.1.1.5 to 10.1.1.5.
The NetScreen FW/VPN device looks 
up the route to 10.1.1.5 and forwards 
traffic out ethernet1.

1

2

3

1

2

3
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a. In the device navigation tree, select Network > Interface. 
b. Double-click ethernet1 (trust interface). The General Properties screen 

appears.
c. Configure the IP address as 10.1.1.1 and the Netmask as 24. Leave all 

other settings as default.
d. Click OK to save your changes.

3. Configure the Untrust interface for ethernet2.

a. In the device navigation tree, select Network > Interface. 
b. Double-click ethernet2 (untrust interface). The General Properties screen 

appears.
c. Configure the IP address as 1.1.1.1 and the Netmask as 24. Leave all 

other settings as default.
d. Click OK to save your changes.

4. Configure the MIP for ethernet2:

a. Double-click ethernet2. The General Properties screen appears.
b. In the interface navigation tree, select NAT > MIP to displays the MIP 

screen.
c. Click the Add icon and configure the MIP as shown below:

For Mapped IP, enter 1.1.1.5

For Netmask, enter 32. 

For Host IP, enter 10.1.1.5

For virtual router, select trust-vr

d. Click OK to save the MIP.
5. Click OK to save your changes to the interface, then click OK to save your 

changes to the device.
6. Create a Global MIP to reference the MIP you created for the device. You use a 

Global MIP when configuring NAT in a Security Policy rule; the Global MIP 
references the MIP for an individual device, enabling you to use one object (the 
Global MIP object) to represent multiple MIPs in a single rule.
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a. In the navigation tree, select Object Manager > NAT Objects > MIP. 
b. Click the Add icon to display the new Global MIP dialog box.
c. Configure the Global MIP as shown below:

7. Configure a firewall rule to route inbound HTTP traffic to the MIP address, as 
shown below:
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A virtual IP (VIP) address maps traffic received at one IP address to another address 
based on the destination port number in the TCP or UDP segment header. The 
destination IP addresses are the same, and the destination port numbers determine the 
host to that receives the traffic. The NetScreen FW/VPN device forwards incoming traffic 
destined for a VIP to the host with the address to which the VIP points. When a VIP host 
initiates outbound traffic, the NetScreen FW/VPN device translates the source IP address 
of the host to that of the VIP address.
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You can set a VIP only on an interface in the Untrust zone, and you must assign the VIP 
an IP address that is in the same subnet as an interface in the Untrust zone. Some 
NetScreen FW/VPN devices also support:

• Assigning the VIP the exact same address as the interface.
• Assigning the VIP to a dynamic IP address. When using a VIP with an interface 

in the Untrust zone that receives its IP address dynamically via DHCP or 
PPPoE, select the Same as the untrusted interface IP address option when 
setting up the VIP.

Additionally, the host to which the NetScreen FW/VPN device maps VIP traffic must be 
reachable from the trust-vr. If the host is in a routing domain other than that of the trust-
vr, you must define a route to reach it.

You can use a VIP as the destination addresses in rules between any two zones or in a 
Global rule. For the destination zone, use either the Global zone or the zone with the 
address to which the VIP points.
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You can use virtual port numbers for well-known services when running multiple server 
processes on a single machine. For example, you can run two FTP servers on the same 
machine, one server on port 21 and the other on port 2121. Only users who know the 
virtual port number can append it to the IP address in the packet header to gain access to 
the second FTP server.

You can map predefined and custom services in a VIP. A single VIP can support custom 
services with:

• The same source and destination port numbers but different transports. 
• Single port entries (by default).
• Multiple port entries, when you creating multiple service entries under a VIP 

(one service entry in the VIP for each port entry in the service). 
• Any destination port number or number range from 1 to 65,535, not just from 

1024 to 65,535.
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In this example, you create a VIP to handle inbound traffic to your Web server. After 
configuring the VIP, you create a Global VIP to represent the VIP you created for the 
device, then use the Global VIP object in a Security Policy rule that permits HTTP traffic 
on port 80 from any address in the Untrust zone to the MIP—and to the host with the 
address and port to which the MIP points—in the Trust zone. All security zones are in the 
trust-vr routing domain.
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Because the VIP is in the same subnet as the Untrust zone interface, you do not need to 
define a route for traffic from the Untrust zone to reach it. (To route HTTP traffic from a 
security zone other than the Untrust zone to the VIP, you must set a route for 1.1.1.10 on 
the router in the other zone to point to an interface bound to that zone.)

1. Add a NetScreen-204 FW/VPN device. Choose Model when adding the device 
and configure the device as running ScreenOS 5.x.

2. Configure the Trust interface for ethernet1.

a. In the device navigation tree, select Network > Interface. 
b. Double-click ethernet1 (trust interface). The General Properties screen 

appears.
c. Configure the IP address as 10.1.1.1 and the Netmask as 24. Leave all 

other settings as default.
d. Click OK to save your changes.

3. Configure the Untrust interface for ethernet3.

a. In the device navigation tree, select Network > Interface. 
b. Double-click ethernet3 (untrust interface). The General Properties screen 

appears.
c. Configure the IP address as 1.1.1.1 and the Netmask as 24. Leave all 

other settings as default.
d. Click OK to save your changes.

4. Configure the VIP for ethernet3:

a. Double-click ethernet3. The General Properties screen appears.
b. In the interface navigation tree, select NAT > VIP to display the VIP 

screen.
c. Click the Add icon to display the Virtual IP dialog box. Enter the Virtual 

IP as 1.1.1.10.

Trust ZoneGlobal Zone

HTTP (80)

VIP 1.1.1.10 Web server
10.1.1.10

Trust Zone Interface eth1, 10.1.1.1/24Untrust Zone Interface eth3, 1.1.1.1/24

Untrust Zone
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d. Click the Add icon to display the VIP mapping dialog box. Configure the 
VIP as shown below:

For Virtual Port, enter 80.

For Mapped IP, 10.1.1.10.

For Mapped Service, enter HTTP.

e. Click OK to save the VIP mapping, then click OK to save the VIP. 
5. Click OK to save your changes to the interface, then click OK to save your 

changes to the device.
6. Create a Global VIP to reference the VIP you created for the device. You use a 

Global VIP when configuring NAT in a firewall rule; the Global VIP references 
the VIP for the individual device, enabling you to use one object (the Global VIP 
object) to represent multiple VIPs in a single rule.

a. In the navigation tree, select Object Manager > NAT Objects > VIP. 
b. Click the Add icon to display the new Global VIP dialog box.
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c. Configure the Global VIP as shown below:

7. Configure a firewall rule to route inbound HTTP traffic on port 80 to the VIP 
address, as shown below:
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A dynamic IP (DIP) pool is a range of IP addresses. The NetScreen FW/VPPN device can 
dynamically or deterministically use these IP addresses when performing network 
address translation on the source IP address (NAT-src) in IP packet headers.

• If the range of addresses in a DIP pool is in the same subnet as the interface IP 
address, the pool must exclude the interface IP address, router IP addresses, 
and any mapped IP (MIP) or virtual IP (VIP) addresses that might also be in 
that subnet.

• If the range of addresses is in the subnet of an extended interface, the pool must 
exclude the extended interface IP address.

You can assign DIP pools to physical interfaces and subinterfaces for network and VPN 
traffic, and tunnel interfaces for VPN tunnels only.
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Use Port Address Translation (PAT) to enable multiple hosts (up to 64,500) to share the 
same IP address. The NetScreen FW/VPN device maintains a list of assigned port 
numbers to distinguish which session belongs to which host. Use PAT in conjunction with 
a MIP and a DIP pool to resolve the problem of overlapping address spaces.

Some applications, such as NetBIOS Extended User Interface (NetBEUI) and Windows 
Internet Naming Service (WINS), require specific port numbers and do not work with 
PAT. For these applications, you cannot use PAT; you must configure the DIP pool to use 
a fixed port (numbered IP). For fixed-port DIP, the NetScreen FW/VPN device hashes and 
saves the original host IP address in its host hash table, enabling the device to associate 
the right session with each host.
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In this example, you want to create a VPN tunnel for users at one site to reach an FTP 
server at another site. However, the internal networks at both sites use the same private 
address space of 10.1.1.0/24.

On the first device, an NetScreen-HSC, you create a tunnel interface in the Untrust zone 
with IP address 10.10.1.1/24, and associate it with a DIP pool containing the IP address 
range 10.10.1.2–10.10.1.2 (addresses in the neutral address space of 10.10.1.0/24). You 
enable port address translation for the DIP pool. On the second device, an NetScreen-208, 
you create a tunnel interface with an IP address in a neutral address space and set up a 
Mapped IP (MIP) address to its FTP server. This example provides details on configuring 
the NetScreen-HSC to use a DIP pool with PAT; details on configuring the second device 
in the VPN are not provided.

1. Add a NetScreen-HSC FW/VPN device. Choose Model when adding the device 
and configure the device as running ScreenOS 5.x.

2. Configure the tunnel interface:

a. In the device navigation tree, select Network > Interface. 
b. Click the Add icon and select New > Tunnel Interface. The General 

Properties screen appears.
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c. Configure the tunnel interface as shown below:

3. Configure the DIP pool:

a. In the interface navigation tree, select NAT > DIP to display the DIP 
screen.

b. Click the Add icon to display the DIP pool dialog box and configure the 
DIP as shown below:

c. Click OK to save the DIP pool.
4. Click OK to save your changes to the interface, then click OK to save your 

changes to the device.
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If circumstances require that the source IP address in outbound firewall traffic be 
translated to an address in a different subnet from that of the egress interface, you can 
use the extended interface option. This option enables you to graft a second IP address 
and an accompanying DIP pool onto an interface that is in a different subnet. You can 
then enable NAT on a per-policy basis and specify the DIP pool built on the extended 
interface for the translation.
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In this example, two branch offices have leased lines to a central office. The central office 
requires them to use only the authorized IP addresses it has assigned them. However, the 
offices receive different IP addresses from their ISPs for Internet traffic. For 
communication with the central office, you use the extended interface option to configure 
the NetScreen FW/VPN device in each branch office to translate the source IP address in 
packets it sends to the central office to the authorized address. The authorized and 
assigned IP addresses for branch offices A and B are as follows:

The NetScreen FW/VPN devices at both sites have a Trust zone and an Untrust zone. All 
security zones are in the trust-vr routing domain. You bind ethernet1 to the Trust zone 
and assign it IP address 10.1.1.1/24. You bind ethernet3 to the Untrust zone and give it 
the IP address assigned by the ISPs: 195.1.1.1/24 for Office A and 201.1.1.1/24 for Office 
B. You then create an extended interface with a DIP pool containing the authorized IP 
address on ethernet3:

• Office A: extended interface IP 211.10.1.10/24; DIP pool 211.10.1.1 – 211.10.1.1; 
PAT enabled

• Office B: extended interface IP 211.20.1.10/24; DIP pool 211.20.1.1 – 211.20.1.1; 
PAT enabled

You set the Trust zone interface in NAT mode. It uses the Untrust zone interface IP 
address as its source address in all outbound traffic except for traffic sent to the central 
office. You configure a policy to the central office that translates the source address to an 
address in the DIP pool in the extended interface. (The DIP pool ID number is 5. It 
contains one IP address, which, with port address translation, can handle sessions for 
~64,500 hosts.) The MIP address that the central office uses for inbound traffic is 
200.1.1.1, which you enter as “HQ” in the Untrust zone address book on each NetScreen 
FW/VPN device.

Assigned IP Address (from 
ISP) Used for Untrust Zone 
Physical Interface

Authorized IP Address (from 
Central Office) Used for Untrust 
Zone Extended Interface DIP

Office A 195.1.1.1/24 211.10.1.1/24

Office B 201.1.1.1/24 211.20.1.1/24
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1. Add the devices: 

a. For Office A, add a NetScreen-208 FW/VPN device.
b. For Office B, add a NetScreen-204 FWVPN device.

Choose Model when adding each device and configure as running ScreenOS 5.x. 

2. Configure ethernet1 (Trust Zone) for Office A:

a. Doubleclick Office A device to open the device configuration. In the device 
navigation tree, select Network > Interface. 

b. Double-click ethernet1. The General Properties screen appears.
c. Configure IP address/netmask as 10.1.1.1/24 and the Interface Mode as 

NAT.
d. Click OK to save your changes.

3. Configure ethernet3 (Untrust Zone) for Office A:

a. In the device navigation tree, select Network > Interface.
b. Double-click ethernet3. The General Properties screen appears.
c. Configure IP address/netmask as 195.1.1.1/24 and the Interface Mode as 

Route.
d. In the interface navigation tree, select NAT > DIP. 

Office BTrust Zone, 
ethernet1
10.1.1.1/24

Trust Zone, 
ethernet1
10.1.1.1/24Trust ZoneTrust Zone

Untrust ZoneUntrust Zone

I n t e r n e t

Central Office (HQ)

Untrust Zone, ethernet3

• ISP assigns 
201.1.1.1/24 
(physical interface)

• HQ authorizes 
211.20.1.1/24 
(extended interface)

• Default Gateway 
201.1.1.254

Untrust Zone, ethernet3
• ISP assigns 

195.1.1.1/24 
(physical interface)

• HQ authorizes 
211.10.1.1/24 
(extended interface)

• Default Gateway 
195.1.1.254

Leased lines connect branch 
offices A and B directly to 
the central office.

ISP ISP

ISP

Leased 
Line

Leased 
Line

200.1.1.1

Office A

Each ISP must set up a route for traffic destined to a site at the end of 
a leased line to use that leased line. The ISPs route any other traffic 
they receive from a local NetScreen FW/VPN device to the Internet.
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e. Click the Add icon to display the DIP pool dialog box and configure the 
DIP as shown below:

f. Click OK to save your changes.
4. Add the route to the Corporate Office on the trust-vr of Office A:

a. In the device navigation tree, select Network > Routing. Doubleclick the 
trust-vr router. The General Properties screen appears.

b. In the trust-vr navigation tree, select Routing Table. Click the Add icon 
and configure the new route as shown below:

Set the IP address/netmask to 0.0.0.0/0. 

For Next Hop, select Gateway; the gateway options appear.
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For Interface, select ethernet3.

For Gateway IP Address, enter 195.1.1.254.

Leave all other defaults, then click OK to save the route.

c. Click OK to save your changes to the trust-vr.
d. Click OK to save your changes and close the Office A device configuration.

5. Configure ethernet1 (Trust Zone) for Office B:

a. Doubleclick Office B device to open the device configuration. In the device 
navigation tree, select Network > Interface. 

b. Double-click ethernet1. The General Properties screen appears.
c. Configure IP address/netmask as 10.1.1.1/24 and the Interface Mode as 

NAT.
d. Click OK to save your changes.

6. Configure ethernet3 (Untrust Zone) for Office B:

a. In the device navigation tree, select Network > Interface. 
b. Double-click ethernet3. The General Properties screen appears.
c. Configure IP address/netmask as 201.1.1.1/24 and the Interface Mode as 

Route.
d. In the interface navigation tree, select NAT > DIP. 
e. Click the Add icon to display the DIP pool dialog box and configure the 

DIP as shown below:

f. Click OK to save your changes.
7. Add the route to the Corporate Office on the trust-vr of Office B:

a. In the device navigation tree, select Network > Routing. Doubleclick the 
trust-vr router. The General Properties screen appears.
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b. In the trust-vr navigation tree, select Routing Table. Click the Add icon 
and configure the new route as shown below:

Set the IP address/netmask to 0.0.0.0/0.

For Next Hop, select Gateway; the gateway options appear.

For Interface, select ethernet3.

For Gateway IP Address, enter 201.1.1.254.

Leave all other defaults, then click OK to save the route.

c. Click OK to save your changes to the trust-vr, then click OK to save your 
changes and close the Office A device configuration.

8. Add the Address Object that represents HQ:

a. In the main navigation tree, select Object Manager > Address Objects. 
Click the Add icon and select Host. The New Host dialog box appears.

b. Configure the Host as shown below:
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c. Click OK to save the new Host object.
9. Create a Global DIP to reference the DIP pool on each device. You use a Global 

DIP when configuring NAT in a firewall rule; the Global DIP references the DIP 
pool for an individual device, enabling you to use one object (the Global DIP 
object) to represent multiple DIP pools in a single rule.

a. In the navigation tree, select Object Manager > NAT Objects > DIP. 
b. Click the Add icon to display the new Global DIP dialog box.
c. Configure the Global DIP as shown below:

d. Click OK to save your changes.
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10. Configure two firewall rules, one which uses the Global DIP object for NAT 
translation, as shown below:
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You can configure the following interface types:

• Configuring an Aggregate Interface
• Configuring a Loopback Interface
• Configuring Virtual Security Interfaces (VSIs)
• Configuring a Redundant Interface
• Configuring a Subinterface
• Configuring a Tunnel Interface
• Configuring an ADSL Interface

The following sections detail each interface type and provide configuration examples.
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An aggregate interface combines two or more physical interfaces, enabling each member 
to share equally the traffic load on the aggregate interface IP address. Use an aggregate 
interface to increase the amount of bandwidth available to a single IP address. You can 
also provide redundancy: If one member of an aggregate interface fails, the other 
members can continue processing traffic—although with less bandwidth than previously 
available.

The NetScreen-5000 series supports aggregate interfaces with Secure Port Modules 
(SPMs):
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• The 5000-8G SPM supports up to four aggregate interfaces.
• The 5000-24FE SPM supports up to five aggregate interfaces.

You must assign one of the following names to the aggregate interface: aggregate1, 
aggregate2, aggregate3, aggregate4, or aggregate5.
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In this example, you combine two Gigabit Ethernet mini-GBIC ports, each running at 1 
Gbps, into an aggregate interface (aggregate1) running at 2-Gbps. The aggregate 
interface combines Ethernet ports 1 and 2 on a 5000-8G SPM (residing in Slot 2) and is 
bound to the Trust zone.

1. Add a NetScreen-5200 device running ScreenOS 5.x, then configure the network 
module:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Slot. 

b. Double-click slot 2 to display the slot configuration dialog box. For Card 
Type, select 5000-8G SPM, as shown below:

c. Click OK to save the slot configuration.
2. Configure the aggregate interface:

a. In the device navigation tree, select Network > Interface. 
b. Click the Add icon and select Aggregate Interface. The General Properties 

screen appears. 
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c. Configure as shown below:

– For Zone, select Trust. 
– For IP address/netmask, enter 10.1.1.0/24.
– For Interface Mode, ensure that the mode is set to NAT.

d. Click OK to save your changes.
3. Add the ethernet 2/1 interface as a member of the aggregate1 interface.

a. In the device navigation tree, select Network > Interface. Double-click 
ethernet2/1. The General Properties screen appears. 

b. Configure as shown below:

For Parent Aggregate Interface, select aggregate1.

c. Click OK to save your changes.
4. Add the ethernet 2/2 interface as a member of the aggregate1 interface.

a. In the device navigation tree, select Network > Interface. Double-click 
ethernet2/2. The General Properties screen appears. 
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b. Configure as shown below:

For Parent Aggregate Interface, select aggregate1.

c. Click OK to save your changes.
5. Click OK to save your changes to the device.

����
�	�
�����;��"%��$����������
A loopback interface emulates a physical interface on a NetScreen FW/VPN device. 
However, unlike a physical interface, a loopback interface is always in the up state as long 
as the device on which it resides is up. You might want to use a loopback interface as:

• The management interface. You can manage the device using either the IP 
address of a loopback interface or the manage IP address that you assign to a 
loopback interface.

• A Virtual Security Interface (VSIs) for NSRP. The physical state of the VSI 
on the loopback interface is always up. The interface can be active or not, 
depending upon the state of the VSD group to which the interface belongs.

• A source interface for specific traffic (such as syslog packets) that 
originates from the device. When you define a source interface for an 
application, the specified source interface address is used instead of the 
outbound interface address to communicate with an external device.

Loopback interfaces are named loopback.id_num, where id_num is a number greater than 
or equal to 1 (the maximum id_num value you can specify is platform-specific) and 
denotes a unique loopback interface on the device. Like a physical interface, you must 
assign an IP address to a loopback interface and bind it to a security zone.

After defining a loopback interface, you can then define other interfaces as members of its 
group. Traffic can reach a loopback interface if it arrives through one of the interfaces in 
its group. Any interface type can be a member of a loopback interface group—physical 
interface, subinterface, tunnel interface, redundant interface, or VSI.

Note: You cannot bind a loopback interface to a HA zone, nor can you configure a 
loopback interface for layer 2 operation or as a redundant/aggregate interface. You 
cannot configure the following features on loopback interfaces: NTP, DNS, VIP, 
secondary IP, track IP, or Webauth.
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In this example, you create the loopback interface loopback.1, bind it to the Untrust zone, 
and assign the IP address 1.1.1.27/24 to it.

1. Add a device.
2. Configure the loopback interface:

a. In the device navigation tree, select Network > Interface. 
b. Click the Add icon and select Loopback Interface. The General Properties 

screen appears.
c. Configure as shown below:

– For zone, select Untrust. 
– For IP Address/Netmask, enter 1.1.1.27/24

d. Click OK to save the new interface.
3. Click OK to save your changes to the device.
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Virtual security interfaces (VSIs) are the virtual interfaces that two NetScreen FW/VPN 
devices forming a virtual security device (VSD) share when operating in high availability 
(HA) mode. Network and VPN traffic use the IP address and virtual MAC address of a 
VSI. The VSD then maps the traffic to the physical interface, subinterface, or redundant 
interface to which you have previously bound the VSI. When two NetScreen FW/VPN 
devices are operating in HA mode, you must bind security zone interfaces that you want 
to provide uninterrupted service in the event of a device failover to one or more virtual 
security devices (VSDs). When you bind an interface to a VSD, the result is a virtual 
security interface (VSI). 

For more details and an example on configuring VSIs, see “Configuring NSRP Clusters” 
on page 256.
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A redundant interface combines two physical interfaces to create one redundant interface, 
which you can then bind to a security zone. One of the two physical interfaces acts is the 
primary interface and handles all the traffic directed to the redundant interface; the other 
physical interface is the secondary interface and stands by. If the primary interface fails, 
traffic to the redundant interface fails over to the secondary interface, which becomes the 
new primary interface. 

Because redundant interfaces enable failover at the interface level, before a failure 
escalates to the device failover level, they are often used when deploying two NetScreen 
FW/VPN devices in a High Availability configuration. You can use the dedicated physical 
redundant HA interfaces or bind two generic interfaces to the HA zone (you can also 
create redundant security zone interfaces). Then, if the link from the primary interface to 
the switch becomes disconnected, the link fails over to the secondary interface, preventing 
a device failover from the VSD master to backup.
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In this example, devices A and B are members of two VSD groups—VSD group 0 and VSD 
group 1—in an active/active configuration. Device A is the master of VSD group 0 and the 
backup in VSD group 1. Device B is the master of VSD group 1 and the backup in VSD 
group 0. The devices are linked to two pairs of redundant switches—switches A and B in 
the Untrust zone, and switches C and D in the Trust zone. 

Because devices A and B are members of the same NSRP cluster, device A propagates all 
interface configurations to device B except the manage IP address, which you enter on the 
redundant2 interface on both devices. You put ethernet1/1 and ethernet1/2 in 
redundant1, and ethernet2/1 and ethernet2/2 in redundant2. On the redundant2 
interface, you define a manage IP of 10.1.1.21 for device A and a manage IP of 10.1.1.22 
for device B on this interface.

The physical interfaces that are bound to the same redundant interface connect to 
different switches:

• Physical interfaces bound to a redundant interface in the Untrust zone: 
ethernet1/1 to switch A, ethernet1/2 to switch B

• Physical interfaces bound to a redundant interface in the Trust zone: ethernet2/
1 to switch C, ethernet2/2 to switch D.

By putting ethernet1/1 and ethernet2/1 in their respective redundant interfaces first, you 
designate them as primary interfaces. If the link to a primary interface becomes 
disconnected, the device reroutes traffic through the secondary interface to the other 
switch without requiring the VSD master device to fail over.

Note: You cannot combine subinterfaces in a redundant interface. However, you 
can define a VLAN on a redundant interface in the same way that you can define a 
VLAN on a subinterface.
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The physical interfaces do not have to be in the same security zone as the redundant 
interface to which you bind them. IP addresses for multiple VSIs can be in the same 
subnet or in different subnets if the VSIs are on the same redundant interface, physical 
interface, or subinterface. If the VSIs are on different interfaces, they must be in different 
subnets. The IP addresses for the VSIs:

In this example, if the cable from ethernet1/1 becomes disconnected, the port fails over to 
ethernet1/2. Consequently, all the traffic to and from devices A and B passes through 
switch B. Reconnecting the cable from ethernet1/1 on device A to switch A automatically 
causes that interface to regain its former priority.

1. Add the cluster and member devices: 

a. For the cluster, specify NetScreen-500 FW/VPN devices running 
ScreenOS 5.x.

b. Add member Device A.
c. Add member Device B.

2. Create a new VSD definition for the cluster:

a. Doubleclick the Office 1 Cluster to open the cluster configuration. 

VSIs for VSD Group 0 VSIs for VSD Group 1

redundant1 210.1.1.1/24 redundant1:1 210.1.1.2/24

redundant2 10.1.1.1/24 redundant2:1 10.1.1.2/24

VSD Group 0 VSD Group 1

redundant1
210.1.1.1/24

redundant1:1
210.1.1.2/24

redundant2
10.1.1.1/24

redundant2:1
10.1.1.2/24

Redundant
Interfaces

Redundant
Interfaces

Physical
Interfaces

Trust Zone
VSIs

Untrust 
Zone VSIs

redundant1
210.1.1.1/24

redundant1:1
210.1.1.2/24

redundant2
10.1.1.1/24

redundant2:1
10.1.1.2/24

redundant2

redundant1

e1/1 e1/2 e3/1 e3/2

e2/1 e2/2 e4/1 e4/2

Switch A

Trust Zone

Untrust Zone

Switch B

Switch C Switch D

Cabling from physical interfaces 
to switches in a redundant group

solid line = primary link
dashed line = secondary link

redundant2 manage IPs
Device A: 10.1.1.21/24
Device B: 10.1.1.22/24
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b. In the cluster navigation tree, select Members. 
c. In the VSD Definitions area, click the Add icon. 
d. Enter 2, then click OK to save the new VSD definition.

3. Configure the cluster network module (slot1):

a. In the cluster navigation tree, select Network > Slot.
b. Double-click slot 1 to display the slot configuration dialog box. For Card 

Type, select 2 Interfaces (10/100), as shown below:

c. Click OK to save the slot configuration.
d. Repeat step c to add a new network module for slot 2.

4. Configure the redundant1 interface:

a. In the cluster navigation tree, select Network > Interface.
b. Click the Add icon and select Redundant Interface. The General 

Properties screen appears.
c. Configure as shown below:

– For Zone, select Untrust.
– For IP address/netmask, enter 210.1.1.1/24.

d. Click OK to save your changes.
5. Add ethernet1/1 as a member of the redundant1 interface:
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a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet1/1. The General Properties screen appears. 

b. Configure as shown below:

For Redundant Interface Group, select redundant1.

c. Click OK to save your changes.
6. Add ethernet1/2 as a member of the redundant1 interface:

a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet1/1. The General Properties screen appears. 

b. Configure as shown below:

For Redundant Interface Group, select redundant1.

c. Click OK to save your changes.
7. Configure the redundant2 interface:

a. In the cluster navigation tree, select Network > Interface.
b. Click the Add icon and select Redundant Interface. The General 

Properties screen appears.
c. For Zone, select Trust.
d. For IP address/netmask, enter 10.1.1.1/24.
e. Click OK to save your changes.

8. Add ethernet2/1 as a member of the redundant2 interface:

a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet1/1. The General Properties screen appears. 

b. For Redundant Interface Group, select redundant2.
c. Click OK to save your changes.

9. Add ethernet2/2 as a member of the redundant2 interface:
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a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet1/1. The General Properties screen appears. 

b. For Redundant Interface Group, select redundant2.
c. Click OK to save your changes.

10. Add the VSI interface for redundant1:

a. In the cluster navigation tree, select Network > Interfaces. Click the Add 
icon and select VSI. The General Properties screen appears.

b. Configure as shown below:

– For Name, select redundant 1, then select 1 (for VSD Group 1).
– For IP address/Netmask, enter 210.1.1.2/24.
– Click OK to save your changes.

11. Add the VSI interface for redundant2:

a. In the cluster navigation tree, select Network > Interfaces. Click the Add 
icon and select VSI. The General Properties screen appears.

b. Configure as shown below:

– For Name, select redundant 2, then select 1 (for VSD Group 1).
– For IP address/Netmask, enter 10.1.1.2/24.
– Click OK to save your changes.

12. Click Apply to apply your changes to the cluster and propagate the 
settings to each member device.

13. Configure the Manage IP address for each member device:

a. In the cluster navigation tree, select Members, then doubleclick Device A.
b. In the device navigation tree, select Network > Interfaces, then 

doubleclick redundant2. The General Properties screen appears. 
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c. For Management IP, enter 10.1.1.21, then click OK to save your changes.
d. In the cluster navigation tree, select Members, then doubleclick Device B.
e. In the device navigation tree, select Network > Interfaces, then 

doubleclick redundant2. The General Properties screen appears. 
f. For Management IP, enter 10.1.1.22, then click OK to save your changes.

14. Click OK to save your changes to the cluster.
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A subinterface, like a physical interface, is a doorway through which traffic enters and 
exits a security zone. You can logically divide a physical interface into several virtual 
subinterfaces, each of which borrows the bandwidth it needs from the physical interface. 
Subinterfaces use names that indicate their physical interface, such as ethernet3/2.1 or 
ethernet2.1. Using VLAN tagging, the subinterface distinguishes between traffic bound 
for it from traffic bound for other interfaces.

You can create a subinterface on any physical interface in the root system or virtual 
system, and you can bind a subinterface to the same zone as its physical interface or to a 
different zone. However, the IP address of a subinterface must be in a different subnet 
from the IP addresses of all other physical interfaces and subinterfaces.
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In this example, you create a subinterface for the Trust zone in the root system. You 
configure the subinterface on ethernet1, which is bound to the Trust zone. You bind the 
subinterface to a user-defined zone named “accounting”, which is in the trust-vr. You 
assign it subinterface ID 3, IP address 10.2.1.1/24, and VLAN tag ID 3. The interface 
mode is NAT.

1. Add a device.
2. Configure a new zone:

a. Doubleclick the device icon to open the device configuration. In the device 
navigation tree, select Network > Zone. 

b. Click the Add icon and select Security Zone. The General Properties 
Screen appears. 

c. Configure as shown below:

– For Name, enter accounting.
– For Virtual Router, select trust-vr.

d. Click OK to save the new security zone.
3. Configure the Subinterface:
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a. In the device navigation tree, select Network > Interface. 
b. Click the Add icon and select Sub Interface. The General Properties 

screen appears.
c. Configure as shown below:

– For Name, select ethernet1, then select 3.
– For VLAN tag, enter 3.
– For Zone, select accounting.
– For IP Address/Netmask, enter 10.2.1.1/24
– For Interface Mode, select NAT.

d. Click OK to save the new interface.
4. Click OK to save your changes to the device.
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A tunnel interface is a doorway to a VPN tunnel, and VPN traffic enters and exits a VPN 
tunnel via a tunnel interface. When you bind a tunnel interface to a VPN tunnel, you can 
use that tunnel interface to route VPN traffic to a specific destination. 

Note: VPN Manager automatically creates the necessary tunnel interfaces for route-
based VPNs. For device-level VPNs, you can create the tunnel interfaces before or after 
creating the VPN.
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When creating a route-based VPN, you must create a tunnel interface to enable the 
NetScreen FW/VPN device to route traffic VPN traffic. You can bind a route-based VPN 
tunnel to a tunnel interface that is either numbered (with IP address/netmask) or 
unnumbered (without IP address/netmask):

• Numbered. When the tunnel interface is numbered, you must give the interface 
an IP address and bind the tunnel interface to a tunnel zone. Using numbered 
tunnel interfaces enables you to use NAT services for policy-based VPN tunnels. 
Assign an IP address to a tunnel interface if you want the interface to support 
one or more dynamic IP (DIP) pools for source address translation (NAT-src) and 
mapped IP (MIP) addresses for destination address translation (NAT-dst). You 
can create a numbered tunnel interface in a security zone or a tunnel zone.

• Unnumbered. When the tunnel interface is unnumbered, you must specify the 
interface from which the tunnel interface borrows an IP address. The NetScreen 
FW/VPN device uses the borrowed IP address as a source address when the 
device itself initiates traffic—such as OSPF messages—through the tunnel. Use 
unnumbered tunnel interfaces when the tunnel interface does not need to 
support NAT services, and your configuration does not require the tunnel 
interface to be bound to a tunnel zone. You can created an unnumbered tunnel 
interface that borrows the IP address from an interface in the same security 
zone or from an interface in a different zone, as long as both zones are in the 
same routing domain. However, you cannot bind the tunnel interface to a tunnel 
zone.

When a tunnel interface is bound to a tunnel zone, 
the tunnel interface must have an IP address and 
netmask, which enables you to define DIP pools and 
MIP addresses on that interface. If you bind a VPN 
tunnel to a tunnel zone, you cannot also bind the 
VPN tunnel to a tunnel interface—you must create a 
policy-based VPN configuration.

When a tunnel interface is in a security zone, you 
must bind a VPN tunnel to the tunnel interface to 
create a route-based VPN. The tunnel interface can 
be numbered or unnumbered. When unnumbered, 
the tunnel interface borrows the IP address from the 
default interface of the security zone in which you 
created it. When numbered, the tunnel interface can 
support policy-based NAT.

When a numbered tunnel interface is in a security 
zone and is the only interface in that zone, you do 
not need to create a security zone interface. The 
security zone supports VPN traffic via the tunnel 
interface, but no other kind of traffic.

Security 
Zone

Tunnel 
Zone

Tunnel Interfaces Security Zone Interfaces

VPN Tunnel

VPN Tunnel

VPN Tunnel

Numbered or 
Unnumbered

Security 
Zone

Numbered

Numbered
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Asymmetric Digital Subscriber Line (ADSL) is a Digital Subscriber Line (DSL) technology 
that enables existing telephone lines to carry both voice telephone service and high-speed 
digital transmission. To use ADSL with a NetScreen FW/VPN device, you must configure 
the adsl1 interface on the NetScreen-5GT ADSL FW/VPN device (which supports ADSL).
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Traditional telephone lines use analog signals to carry voice service through twisted-pair 
copper wires. However, when using analog transmission, the service provider can use only 
a small portion of the available bandwidth. To work around this limitation, the service 
provider can use digital transmission to access a wider bandwidth on the same media, at 
the same time. Because the service provider separates analog and digital transmissions, 
you can use your telephone and connect the Internet with your computer at the same time 
on the same line.

At the service provider’s central office, the Digital Subscriber Line Access Multiplexer 
(DSLAM) connects many DSL lines to a high-speed network such as an Asynchronous 
Transfer Mode (ATM) network. ADSL transmission is asymmetric because the rate at 
which you can send data (the upstream rate) is considerably less than the rate at which 
you can receive data (the downstream rate). ADSL is ideal for Internet access because 
most messages sent to the Internet are small and do not require much upstream 
bandwidth, while most data received from the Internet require greater downstream 
bandwidth.

You can use the ADSL port on the NetScreen-5GT ADSL FW/VPN device to enable 
Internet access for a network—without adding additional phone lines, and without using 
an additional ADSL modem. For details on connecting and cabling the NetScreen-5GT 
ADSL, see the NetScreen-5GT ADSL User’s Guide.
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The ADSL interface on the NetScreen-5GT ADSL FW/VPN device uses ATM as its 
transport layer. The interface supports multiple permanent virtual circuits (PVCs), which 
are continuously-available logical connections to the network, on a single physical line 
(the adsl1 interface). You can configure additional virtual circuits on the device by 
creating subinterfaces (adsl1.1, adsl1.2, etc.).

Before you can configure the adsl1 interface, however, you must obtain the DSLAM 
configuration details for the ADSL connection from the service provider, as detailed 
below. 
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The service provider for ADSL Internet access must provide you with some details about 
the ADSL connection so you can configure the NetScreen FW/VPN device to connect to 
their servers. Not all service providers use the same implementation of ADSL; you might 
be given any combination of the following ADSL parameters:
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• Virtual Path Identifier and Virtual Channel Identifier (VPI/VCI), which identify 
the virtual circuit on the DSLAM. 

• ATM encapsulation method. The ADSL interface on the NetScreen FW/VPN 
device supports the following ATM Adaptation Layer 5 (AAL5) encapsulations:

– Virtual Circuit (VC)-based multiplexing, in which each protocol is carried 
over a separate ATM virtual circuit.

– Logical Link Control (LLC), which enables several protocols to be carried 
on the same ATM virtual circuit (default encapsulation method).

The service provider must tell you the type of multiplexing used on the ADSL 
line.

• Point-to-Point Protocol (PPP) is a standard protocol for transmitting IP packets 
over serial point-to-point links, such as an ATM PVC. The NetScreen FW/VPN 
device supports the following methods of transporting PPP packets:

– PPP over Ethernet (PPPoE). RFC 2516 describes the encapsulation of PPP 
packets over Ethernet. For more information about PPPoE, see 
“Configuring PPPoE” on page 202.

– PPP over AAL5 (PPPoA). RFC 1483 describes the encapsulation of 
network traffic over AAL5. For more information about PPPoA, see 
“Configuring PPPoA” on page 203.

If the service provider’s network uses PPPoE or PPPoA, the service provider 
must give you the user name and password for the connection, the 
authentication method used, and any other protocol-specific parameters.

• IP addresses. The service provider might give the network a static IP address or 
a range of IP addresses. The service provider should also give you the address of 
the DNS server to use for DNS name and address resolution.

• Discrete multitone (DMT) is a method for encoding digital data in an analog 
signal. By default, the ADSL interface automatically negotiates the DMT 
operating mode with the service provider’s DSLAM. You can change the mode on 
the adsl1 interface to force the interface to use only one of the following DMT 
standards:

– American National Standards Institute (ANSI) TI.413 Issue 2, which 
supports rates up to 8 Mbps downstream and 1 Mbps upstream.

– International Telecommunications Union (ITU) G.992.1 (also known as 
G.dmt), which supports minimum data rates of 6.144 Mbps downstream 
and 640 kbps upstream.

– ITU 992.2 (also known as G.lite), which supports up to data rates of 1.536 
Mbps downstream and 512 kbps upstream. This standard is also called 
“splitterless DSL” because you do not have to install a signal splitter on 
your ADSL line (the service provider’s equipment splits the signal 
remotely).
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The port mode of a NetScreen-5GT ADSL device determines the binding of physical ports, 
logical interfaces, and zones.
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• Trust-Untrust port mode (default). This port mode uses the following default 
settings:

– Binds the ADSL port to the adsl1 interface, which is bound to the Untrust 
zone.

– Binds ethernet ports 1-4 to the ethernet1 interface, which is bound to the 
Trust zone.

• The Home-Work port mode creates special Home and Work zones to segregate 
business and home users, while allowing users in both zones to access the 
Internet (the Untrust zone) through the ADSL interface. This port mode uses 
the following default settings:

– Binds ethernet ports 1 and 2 to the ethernet1 interface, which is bound to 
the Work security zone.

– Binds ethernet ports 3 and 4 to the ethernet2 interface, which is bound to 
the Home security zone.

– Permits all traffic from the Work zone to the Untrust zone.
– Permits all traffic from the Home zone to the Untrust zone.
– Permits all traffic from the Work zone to the Home zone.
– Denies all traffic from the Home zone to the Work zone (you cannot 

remove this policy)

In the Home-Work port mode, you must manage the device from the Work zone. 
You cannot configure the device from the Home zone, nor can you use any 
management services on the Home zone interface. The default IP address of 
ethernet1, the Work zone interface, is 192.168.1.1/24.

• Trust-Untrust-DMZ port mode. This port mode uses the following default 
settings:

– Binds ethernet ports 1 and 2 to the ethernet1 interface, which is bound to 
the Trust security zone.

– Binds ethernet ports 3 and 4 to the ethernet2 interface, which is bound to 
the DMZ security zone.

– Binds the ADSL port to the adsl1 interface, which is bound to the Untrust 
security zone.

For all supported port modes, the adsl1 interface is the only interface bound to the 
Untrust zone by default. 

You can change the port mode to use different port, interface, and zone bindings on the 
device. For more information about port modes, see the “Zones” chapter in the 
“Fundamentals” volume of the NetScreen Concepts & Examples ScreenOS Reference 
Guide.

Note: The Trust/Untrust/DMZ port mode is supported only on the 
Extended version of the NetScreen-5GT ADSL device.
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When using ADSL, the adsl1 interface serves as the primary connection to the Internet. 
However, you can configure a backup connection to the Internet using the Untrusted 
ethernet port or the Modem port on the NetScreen FW/VPN device. 

To configure the backup interface, bind both the adsl1 and backup interface to the 
Untrust zone to automatically configure the interface failover. If the ADSL interface 
becomes unavailable, the NetScreen FW/VPN device automatically sends outgoing traffic 
to the backup interface, which connects to the ISP account. When the ADSL interface is 
again available, the device automatically sends outgoing traffic to the adsl1 interface.

To configure the serial interface for the Modem, you must have the following information:

• Login and password for the account to the dialup service provider
• Primary phone connection for dialing into the account
• Modem initialization string

For more information about configuring the serial interface on a NetScreen FW/VPN 
device, see the “Interface Redundancy” chapter in the “High Availability” volume of the 
NetScreen Concepts & Examples ScreenOS Reference Guide.

For details on configuring the Modem and ISP settings for the serial interface in 
NetScreen-Security Manager, see “Configuring a Modem Connection (Dial)” on page 206.

For an example on configuring a backup link in an ADSL configuration, see “PPPoE on 
ADSL Interface with Backup (Modem Port)” on page 191. 

Note: You can configure only one backup interface. 



Configuring Interfaces

NetScreen-Security Manager 2004 FP2 183

�'�#!$������,$������%%����8���$����(��%
In this example, you configure a NetScreen-5GT ADSL FW/VPN device to permit internal 
hosts to access the Internet through the ADSL interface and permit Internet users to 
access a local Web server while protecting other internal hosts. To segregate traffic flow to 
the Web server from the rest of the internal network, configure the Web server in the 
DMZ, then create a firewall rule that permits HTTP traffic only to the DMZ zone. 

1. Add the NetScreen-5GT ADSL FW/VPN device as ADSL 1 (device name).To 
enable the DMZ zone, select the Trust/Untrust/DMZ port mode.

2. Configure the ADSL interface (adsl1 interface in the Untrust zone):

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Interface. 

Internet

MIP 1.1.1.5 -> 10.1.1.5
(Configured on adsl1)adsl1: 1.1.1.1/24

ethernet2: 10.1.1.1/24

Web Server
10.1.1.5

DSLAM

Untrust Zone

Trust ZoneDMZ Zone

ethernet1: 192.168.1.1/24

NetScreen-5GT ADSL FW/VPN device in 
Trust/Untrust/DMZ (Extended) port mode
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b. Right click the adsl1 interface and select Edit. The General Properties 
screen appears. Using the information you previously obtained from the 
service provider, configure as shown below:

– For VPI, enter 0; for VCI, enter 35.
– For Multiplexing Mode, select VC Multiplexing.
– For IP address/netmask, enter 1.1.1.1/24

c. Configure the Interface Mode as NAT.
d. In the interface navigation tree, select NAT > MIP. Configure a new MIP 

as shown below:

– For Mapped IP, enter 1.1.1.5. 
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– For Netmask, enter 32.
– For Host IP, enter 10.1.1.5.
– Ensure that the Host Virtual Router is set to trust-vr.

e. Click OK to add the MIP, then click OK again to save your changes to the 
ADSL interface.

3. Configure the Trust interface (ethernet1 in the Trust zone).

a. Right-click ethernet1 and select Edit. The General Properties screen 
appears. Configure the interface to use an IP address and netmask of 
192.168.1.1/24. For Interface Mode, select NAT.

b. In the interface navigation tree, select DHCP. For DHCP Mode, select 
DHCP Server.

c. Select the DHCP Server IP Pools tab, then configure a new DHCP IP Pool 
as shown below:

– For starting IP, enter 192.168.1.3.
– For Value, select End IP.
– For ending IP, enter 192.168.1.33.

d. Click OK to add the new IP pool, then click OK again to save your changes 
to the Trust interface.

4. Configure the DMZ interface (ethernet2 in the DMZ zone).

a. Double-click ethernet2. The General Properties screen appears. Configure 
the interface to use an IP address and netmask of 10.1.1.1/24. For 
Interface Mode, select NAT.

b. Click OK to save your changes to the DMZ interface, then click OK to save 
and apply your changes to the device configuration.

5. Create a Global MIP to reference the MIP you created for the adsl1 interface. 
You use a Global MIP when configuring NAT in a Security Policy rule; the 
Global MIP references the MIP for an individual device, enabling you to use one 
object (the Global MIP object) to represent multiple MIPs in a single rule.

a. In the navigation tree, select Object Manager > NAT Objects > MIP. 
b. Click the Add icon to display the new Global MIP dialog box.
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c. Configure the Global MIP as shown below:

6. Create a firewall rule that routes inbound HTTP traffic from any address in the 
Untrust zone to the MIP host (the Web server) in the DMZ zone. Configure the 
rule as shown below:
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In this example, you configure a NetScreen-5GT ADSL FW/VPN device to connect to the 
Internet using PPPoA and the ADSL interface. The device acts as both a PPPoA client 
and a DHCP server:

• As a PPPoA client, the device receives the IP address for the ADSL interface. 
However, the device also receives one or more IP addresses for DNS servers. 
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• As DHCP server, the device provides hosts in the Trust zone with their IP 
addresses and the IP addresses of the DNS servers. 

1. Add the NetScreen-5GT ADSL FW/VPN device. 

a. For device name, enter ADSL PPPoA
b. Select Model Device.
c. For device platform, select ns5GTadsl-Trust-Untrust

2. Configure the ADSL Interface:

Internet

DSLAM
DNS Servers

Trust Zone

Untrust Zone

DHCP Range:
192.168.1.3 - 192.168.1.33

Untrust Interface (adsl1): PPPoA

Trust Interface: 192.168.1.1/24

NetScreen-5GT ADSL FW/VPN device 
in Trust-Untrust (default) port mode



Chapter 4 Configuring Devices

188 Administrator’s Guide

a. In the device navigation tree, select Network > Interface. Right-click the 
ADSL1 interface and select Edit. Configure the General Properties tab as 
shown below:

– For VPI, enter 0; for VCI, enter 35.
– For Multiplexing Mode, select LLC/SNAP Encapsulation.
– Ensure that the zone is Untrust and the Mode is Route.

b. Leave all other defaults and click OK to save your changes to the 
interface.

3. Configure the Trust interface:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Interfaces.

b. Right-click ethernet1 and select Edit. The General Properties screen 
appears. Configure the interface to use an IP address and netmask of 
192.168.1.1/24. For Interface Mode, select NAT.

c. In the interface navigation tree, select DHCP. For DHCP Mode, select 
DHCP Server.
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d. Select the DHCP Server IP Pools tab, then configure a new DHCP IP Pool 
as shown below:

– For starting IP, enter 192.168.1.3.
– For Value, select End IP.
– For ending IP, enter 192.168.1.33.

e. Click OK to add the new IP pool, then click OK again to save your changes 
to the Trust interface.

4. Configuring the PPPoA instance:

a. In the device navigation tree, select Network > PPPoA. Right-click the 
Trust interface and select Edit. 
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b. Click the Add icon to create a new PPPoA instance, then configure as 
shown below:

– For PPPoA Instance, enter poa1
– For Interface, select the adsl1 interface.
– For Username, enter Alex
– For Password, enter tSOCbme4NW5iYPshGxCy67Ww48ngtHC0Bw==
– Enable Update DHCP Server.

c. Leave all other defaults and click OK to save the PPPoA instance, then 
OK to save the device configuration. 

After you have updated the device with the modeled configuration, the device 
administrator can activate PPPoA on local network.

• First, the device administrator powers down the NetScreen-5GTADSL FW/VPN 
device and all workstations in the Trust zone, then powers on just the device. 
The device makes a PPPoA connection to the DSLAM, and obtains the IP 
address for the ADSL interface and the IP addresses for the DNS servers.

• Finally, the device administrator powers on the workstations to activate DHCP; 
the workstations automatically receive the IP address for the DNS server and 
obtain an IP address for themselves when they attempt a TCP/IP connection.
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In this example, you configure the NetScreen-5GTADSL FW/VPN device as a firewall 
with the primary Internet connection through the ADSL interface using PPPoE, and a 
backup Internet connection through the serial modem port and dialup connection.

1. Add the NetScreen-5GT ADSL FW/VPN device. 

a. For device name, enter ADSL PPPoE.
b. Select Model Device.
c. For device platform, select ns5GTadsl-Home-Work.

2. Configure the ADSL Interface:

a. In the device navigation tree, select Network > Interface. Right-click the 
ADSL1 interface and select Edit. Configure the General Properties tab:
– For VPI, enter 0; for VCI, enter 35.
– For Multiplexing Mode, select LLC/SNAP Encapsulation.
– Ensure that the zone is Untrust and the Mode is Route.

b. Leave all other defaults and click OK to save your changes to the ADSL 
interface.

3. Configure the Work interface:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Interfaces.

ISDN
Network

Internet

DSLAM

Home Zone

Untrust Zone

Work Zone

adsl1: PPPoE mode

ethernet1: 192.168.1.1/24ethernet2: 192.168.2.1/24

DHCP Range:
192.168.2.2-192.168.2.5

DHCP Range:
192.168.1.3-192.168.1.33

NetScreen-5GTADSL FW/VPN 
device in Home-Work port mode

ISDN Terminal Adapter
serial: ISP
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b. Right-click ethernet1 and select Edit. The General Properties screen 
appears. Configure the interface to use an IP address and netmask of 
192.168.1.1/24. For Interface Mode, select NAT.

c. In the interface navigation tree, select DHCP. For DHCP Mode, select 
DHCP Server.

d. Select the DHCP Server IP Pools tab, then configure a new DHCP IP Pool 
as shown below:

– For starting IP, enter 192.168.1.3.
– For Value, select End IP.
– For ending IP, enter 192.168.1.33.

e. Click OK to add the new IP pool, then click OK again to save your changes 
to the Work interface.

4. Configure the Home interface:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Interfaces.

b. Right-click ethernet2 and select Edit. The General Properties screen 
appears. Configure the interface to use an IP address and netmask of 
192.168.2.1/24. For Interface Mode, select NAT.

c. In the interface navigation tree, select DHCP. For DHCP Mode, select 
DHCP Server.

d. Select the DHCP Server IP Pools tab, then configure a new DHCP IP Pool:
– For starting IP, enter 192.168.2.2.
– For Value, select End IP.
– For ending IP, enter 192.168.2.5.

e. Click OK to add the new IP pool, then click OK again to save your changes 
to the Home interface.

5. Configuring the PPPoE instance:

a. In the device navigation tree, select Network > PPPoE. Right-click the 
Trust interface and select Edit. 

b. Click the Add icon to create a new PPPoE instance:
– For PPPoE Instance, enter poe1
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– For Interface, select the adsl1 interface.
– For Username, enter Alex
– For Password, enter tSOCbme4NW5iYPshGxCy67Ww48ngtHC0Bw==
– Enable Update DHCP Server.

c. Leave all other defaults and click OK to save the PPPoE instance. 
6. Configure the backup interface (the serial interface on the modem port):

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Interfaces.

b. Right-click serial interface and select Edit. The General Properties screen 
appears.

c. For Zone, select Untrust.
7. Configure the ISP settings for the serial interface:

a. In the device navigation tree, select Network > Dial > ISP.
b. Create a new ISP and configure as shown below:

– For ISP Name, enter isp1. 
– For Login Name, enter kgreen. 
– For Password, enter 98765432
– For Primary Number, enter 4085551111
– For Alternative Number, enter 408555222

c. Click OK to save the new ISP.
8. Configure the Modem settings for the serial interface:

a. In the device navigation tree, select Network > Dial > Modem.
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b. Select the Modem tab and configure as shown below:

– For Modem Name, enter mod1.
– For Init String, enter AT&FS7=255S32=6
– Enable Is Active.

c. Click OK to save the new modem settings, then click OK again to save 
your changes to the device configuration.

Note: The ISP and Modem settings automatically apply to the serial 
interface; you do not need to manually assign them to the Modem port.
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Use a DIP group to combine two DIP pools for two NetScreen FW/VPN devices that are in 
an active/active NRSP configuration. When specifying the NAT settings in the rule 
options for a Security Policy rule, you can select a DIP group instead of a single DIP pool. 

Selecting a DIP group in the policy enables NAT using the DIP pool that exists on either 
device in the HA configuration. Typically, two NetScreen FW/VPN devices in an active/
active configuration share the same configuration, and both devices process traffic 
simultaneously. When you define a policy to perform NAT using a DIP pool located on one 
VSI, because that VSI is active only on the device acting as the master of the VSD group 
to which the VSI is bound, any traffic sent to the other device—the one acting as the 
backup of that VSD group—cannot use that DIP pool and is dropped. To solve this 
problem, you can create two DIP pools—one on the Untrust zone VSI for each VSD 
group—and combine the two DIP pools into one DIP group, which you reference in the 
policy. Each VSI uses its own VSD pool even though the policy specifies the DIP group.

If you do not use a DIP group, the NetScreen FW/VPN device that acts as the backup of a 
VSD group cannot use a DIP pool located on the VSI of the master of the VSD group. For 
more details about DIP groups on NetScreen FW/VPN devices, see the “Fundamentals” 
volume in the NetScreen Concepts & Examples ScreenOS Reference Guide.
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In this example, you configure a DIP group that includes the DIP pools of two NetScreen 
FW/VPN devices in an active/active NRSP configuration. By combining the DIP pools 
located on both Untrust zone VSIs (for VSD groups 0 and 1) into one DIP group, Devices A 
and B can both process traffic matching policy “out-nat”, which references not an 
interface-specific DIP pool but the shared DIP group.

1. Create the Cluster:

VSD Group: 0 VSD Group: 1

Untrust Zone

Trust Zone

Untrust Zone VSIs

Trust Zone VSIs
ethernet1 10.1.1.1/24 ethernet1:1 10.1.1.2/24

ethernet3 1.1.1.1/24 ethernet3:1 1.1.1.2/24

Device B

Device A

Master VSD 1

Backup VSD 1Master VSD 0

Backup VSD 0

DIP Pool ID 6
1.1.1.30 – 1.1.1.39

DIP Pool ID 5
1.1.1.20 – 1.1.1.29

DIP Group 7

NSRP Cluster



Configuring DIP Groups

NetScreen-Security Manager 2004 FP2 197

a. In the navigation tree, select Device Manager > FW/VPN Devices. Click 
the Add icon and select Cluster. Configure the Cluster as shown below:

b. Add the following two cluster members to the cluster: NS-208 A, NS-208 
B. Choose Model when adding each device.

2. Configure the untrust interface for VSD group 0.

a. In the cluster navigation tree, select Network > Interface. 
b. Double-click ethernet3 (untrust interface on the NS-208 A). The General 

Properties screen appears.
c. Configure the IP address as 1.1.1.1 and the Netmask as 24. Leave all 

other settings as default.
d. Select NAT > DIP to display the Dynamic IP dialog box. Configure the ID 

as 5 and the IP address range, enter 1.1.1.20 - 1.1.1.29, as shown below:

e. Click OK to close the Dynamic IP dialog box.
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f. Click OK to save your changes.
3. Configure the trust interface for VSD group 0.

a. In the cluster navigation tree, select Network > Interface. 
b. Double-click ethernet1 (trust interface on the NS-208 A). The General 

Properties screen appears.
c. Configure the IP address as 10.1.1.1, the Netmask as 24. Leave all other 

settings as default.
d. Click OK to save your changes.

4. Configure the untrust interface for VSD group 1:

a. In the cluster navigation tree, select Network > Interface. 
b. Right-click on ethernet3 and select New > VSI. 
c. Configure the IP address as 1.1.1.2, the Netmask as 24. Leave all other 

settings as default, as shown below:

d. Select NAT > DIP to display the Dynamic IP dialog box. Configure the ID 
as 6 and the IP address range as 1.1.1.30 - 1.1.1.39, as shown below:
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e. Click OK to close the Dynamic IP dialog box.
f. Click OK to save your changes.

5. Configure the trust interface for VSD group 1.

a. In the cluster navigation tree, select Network > Interface. 
b. Right-click ethernet1 and select New > VSI. 
c. Configure the IP address as 10.1.1.2, the Netmask as 24. Leave all other 

settings as default.
d. Click OK to save your changes.

6. Create the DIP group:

a. In the cluster navigation tree, select Network > DIP Group.
b. Click the Add icon in the DIP Group configuration screen. The Dynamic IP 

dialog box appears.
c. Configure the DIP Group Name as 7, and select DIP members 5 and 6, as 

shown below:

d. Click OK to close the Dynamic IP dialog box.
e. Click OK to close save your changes.

7. Enable DIP Translation Stickiness to ensure that the device assigns the same IP 
address from a DIP pool to a host for multiple concurrent sessions.

a. In the cluster navigation tree, select Network > Advanced > DIP. 
b. Enable DIP Translation Stickiness.
c. Click OK to save your changes.

For details on DIP Translation Stickiness, see “Configuring DIP Options” on 
page 210.
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8. Create a Global DIP to reference the DIP group for the cluster. You use a Global 
DIP when configuring NAT in a firewall rule; the Global DIP references the DIP 
pool or DIP group for an individual device or cluster, enabling you to use one 
object (the Global DIP object) to represent multiple DIP pools or DIP groups in a 
single rule.

a. In the navigation tree, select Object Manager > NAT Objects > DIP. 
b. Click the Add icon to display the new Global DIP dialog box.
c. Configure the Global DIP as shown below:

d. Click OK to save your changes.
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9. Configure a firewall rule to use the Global DIP object for NAT translation, as 
shown below:
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Use the PPPoE option to configure PPPoE operations. Some NetScreen FW/VPN devices 
support PPPoE, which enables them to operate compatibly on DSL, Ethernet Direct, and 
cable networks run by ISPs that use PPPoE for their clients’ Internet access. 

You can configure a specific instance of PPPoE and assign a username and password and 
other parameters for that instance. For NetScreen FW/VPN devices running ScreenOS 
4.0.0, you can only enable PPPoE on a single interface bound to the Untrust zone. For 
NetScreen FW/VPN devices running ScreenOS 5.x, you can enable PPPoE on multiple 
interfaces in any zone at the same time.

To add a PPPoE instance:

1. Click the Add icon in the PPPoE configuration screen. The PPPoE Instance 
dialog box appears.

2. Enter the name for the PPPoE instance.
3. Select the interface to which this PPPoE instance applies (can select an adsl1 

interface, if available).
4. Enter the username and password for the instance.
5. Configure any other PPPoE parameters.
6. Click OK to close the PPPoE Instance dialog box.

For more detailed explanation about PPPoE or DHCP on NetScreen FW/VPN devices, see 
the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide.

Note: Some ISPs use DHCP for their clients’ Internet access. To configure DHCP 
on an interface, see “Configuring DHCP” on page 149.



Configuring PPPoA

NetScreen-Security Manager 2004 FP2 203

��	(
��
	�������
PPPoA is typically used for PPP sessions that terminate on a NetScreen FW/VPN device 
with an ADSL interface (the NetScreen-5GT ADSL FW/VPN device). On the ADSL 
interface (or its subinterfaces), you can configure a PPPoA client instance with a user 
name, password, and other parameters, then bind the instance to the ADSL interface (or 
subinterface). 

When the NetScreen-5GT ADSL FW/VPN device initiates a PPPoA connection to the 
PPPoA server (controlled by the service provider), the server automatically provides the 
IP addresses for the Untrust zone interface and for the Domain Name Service (DNS) 
servers. Using this information, the NetScreen FW/VPN device automatically updates the 
DNS server addresses in its DHCP server (you can disable this automatic update if 
desired).

For details and an example of configuring an ADSL interface with PPPoA, see 
“Configuring an ADSL Interface” on page 179.
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Use the NACN option to configure NetScreen Address Change Notification (NACN). 
NACN is available only on FW/VPN devices running ScreenOS 4.0.x. Before NetScreen-
Security Manager can contact a NetScreen FW/VPN device, it must have the current IP 
address of the device interface. This is relatively easy when the NetScreen FW/VPN 
device has a static IP address on its interface. However, an interface on a NetScreen FW/
VPN device can have a dynamically assigned IP address, using either PPPoE or DHCP. In 
these cases, the NetScreen FW/VPN device uses NACN to monitor a specific interface and 
then register with NetScreen-Security Manager the IP address of the interface whenever 
it changes. This prevents interruption of communication between NetScreen-Security 
Manager and the NetScreen FW/VPN device.

For more detailed explanation about NACN on NetScreen FW/VPN devices, see the 
“Administration” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide for ScreenOS 4.0.0.
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(This option is only available for some NetScreen FW/VPN appliances.) Use the Failover 
option to configure the FW/VPN device to switch over traffic from the primary interface to 
the backup interface, and from the backup to the primary when there are both primary 
and backup interfaces bound to the Untrust zone. An interface failover can occur when 
ScreenOS detects a physical link problem on the primary interface connection, such as an 
unplugged cable. You can also define the following types of interface failover:

• When certain IP addresses become unreachable through a given interface using 
IP tracking

• When certain VPN tunnels on the primary untrust interface become 
unreachable using VPN tunnel monitoring

You can also configure the NetScreen FW/VPN device to automatically switch to the 
backup interface if ScreenOS detects a failure on the primary interface connection. When 
the connection through the primary interface is restored, ScreenOS automatically 
switches traffic from the backup interface to the primary.

By default, there is a 30-second interval before the failover occurs (the hold-down time). 
You can change this interval.

For more detailed explanation about interface failover on NetScreen FW/VPN devices, see 
the “High Availability” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide for ScreenOS 5.x or the New Features Guide for ScreenOS 4.0.0-DIAL2.
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(This option is only available for some NetScreen FW/VPN appliances.) Use the Modem 
option to configure the NetScreen FW/VPN device for operation with an external modem. 
You can connect an external modem to the RS-232 serial port on certain NetScreen FW/
VPN devices to enable the device to establish a PPP connection to an ISP. This provides a 
backup serial interface for traffic to the Untrust zone if there is a failure on the connection 
through the primary interface. 

You can configure the following parameters for the serial link:

• Speed (BPS). The maximum baud rate for the serial link (the default rate is 
115200 bps).

• Timeout. The maximum amount of time that the serial link can be idle before 
ScreenOS automatically disconnects the modem (the default is 10 minutes).

• Retry Number. The number of times ScreenOS retries the dial-up connection if 
the line is busy or there is no response (the default is 3 times).

• Retry Interval. The interval, in seconds, between dial-up retries (the default is 
10 seconds).
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The modem you use for the dial-up connection must support the following features:

• Hardware flow control
• Provide clear to send (CTS) signals
• Able to respond to request to send (RTS) signals
• Asynchronous only
• Support AT command set

To create the settings for a modem:

1. Click the Add icon in the Modem Settings portion of the Modem configuration 
screen.

2. Specify the name for the modem setting.
3. Specify the modem initialization string. The modem initialization string must 

meet the following requirements:
– Hardware flow control is recommended, but not required (you can specify 

no flow control)
– Software flow control is not used
– Result code must be displayed in verbal mode

4. Specify whether this modem setting is active. You can activate only one of the 
configured modem settings at a time. 

5. Click OK.
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You configure the NetScreen FW/VPN device to dial to an ISP account if a failover to the 
serial interface occurs and there is traffic to be sent. You can configure up to four ISP 
connections, assigning each a different priority number (1 is the highest priority). The 
priority number determines the order that the device uses in attempting the dial-up 
connection; the ISP with the highest priority is dialed first. If the device is unable to log in 
to the ISP account with the highest priority, it will dial the ISP with the next highest 
priority number, and so on, until there are no more ISP configurations.

To create the settings for a ISP connection:

1. Click the Add icon in the ISP Settings portion of the Modem configuration 
screen.

2. Specify the name for the ISP setting.
3. Specify the login name and password for the ISP account.
4. Specify the primary phone number and optionally, an alternate phone number. 

If the modem uses pulse dial by default but you want to use tone dial, precede 
the phone number with a T. If the modem uses tone dial by default but you want 
to use pulse dial, precede the phone number with a P.

5. Specify the priority for this setting, relative to other configured ISP settings. The 
highest priority is 1.

6. Click OK.

For more detailed explanation about interface failover on NetScreen FW/VPN devices, see 
the “High Availability” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide for ScreenOS 5.x or the New Features Guide for ScreenOS 4.0.0-DIAL2.



Chapter 4 Configuring Devices

208 Administrator’s Guide

��	(
��
	��2	�
Use the DNS option to configure DNS server information. Before the FW/VPN device can 
use DNS for domain name/address resolution, you must configure the address for the 
primary DNS server the device should use.

The NetScreen FW/VPN device refreshes all the entries in its DNS table by checking 
them with a specified DNS server at the following times:

• After an HA failover occurs
• At a regularly scheduled time of day and at regularly scheduled intervals

For more detailed explanation about configuring DNS on NetScreen FW/VPN devices, see 
the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide.
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In the Advanced Network screens, you can configure the following network settings:

• Configuring ARP Cache Entries
• Configuring VIP Options
• Configuring DIP Options
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Use the ARP option to manually add entries to the Address Resolution Protocol (ARP) 
cache. The ARP cache contains associations of IP addresses to physical machine addresses 
known as Media Access Control (MAC) addresses. The ARP normally resolves unknown 
IP addresses and updates its cache automatically. You can manually add ARP cache 
entries, if necessary, for testing or troubleshooting purposes.

To add an ARP cache entry:

1. Click the Add icon in the ARP configuration screen.
2. Specify the IP address, interface, and MAC address for the ARP entry.
3. Click OK.

For more detailed explanation about configuring ARP entries on NetScreen FW/VPN 
devices, see the arp commands in the NetScreen CLI Reference Guide.
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A virtual IP (VIP) address maps traffic received at one IP address to another address 
based on the destination port number in the TCP or UDP segment header. You can only 
set a VIP on an interface in the Untrust zone. The IP address for the VIP must be in the 
same subnet as an interface in the Untrust zone. (On some NetScreen FW/VPN devices, 
the IP address for the VIP can be the same address as the Untrust zone interface.) In 
addition, you need the following information to define a VIP:

• The IP addresses for the servers that process the requests
• The type of service you want the NetScreen FW/VPN device to forward from the 

VIP to the IP address of the host.

Use the VIP Options configuration screen to set multiple port entries for VIPs. A single 
VIP can support custom services with multiple port entries by creating multiple service 
entries under that VIP. To be able to use multiple-port services in a VIP, you need to 
enable multiple port services, then reset the NetScreen FW/VPN device.

For more detailed explanation about configuring VIPs on NetScreen FW/VPN devices, see 
the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS Reference 
Guide.
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Use DIP Options to set DIP translation operation. 

When DIP is configured on an interface, the NetScreen FW/VPN device normally assigns 
a different source IP address for each session, even when a single host initiates several 
sessions that require network address translation using the DIP pool. This random 
address assignment can be problematic for services that create multiple sessions that 
require the same source IP address for each session. 

For example, it is important to have the same IP address for multiple sessions when using 
the AOL Instant Messaging (AIM) client. You create one session when you log in, and 
another for each chat. For the AIM server to verify that a new chat belongs to an 
authenticated user, it must match the source IP address of the login session with that of 
the chat session. If they are different—possibly because they were randomly assigned 
from a DIP pool during the NAT process—the AIM server rejects the chat session.

To ensure that the device assigns the same IP address from a DIP pool to a host for 
multiple concurrent sessions, enable DIP Translation Stickiness.

For more detailed explanation about configuring DIP options on NetScreen FW/VPN 
devices, see the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide.

For details about creating a DIP group, see “Configuring DIP Groups” on page 195.
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Use the Device Administration screens to configure administrative options for the 
managed device. In the device navigation tree, select Device Admin to view configuration 
options.

This section describes configuring the following device administration options for 
NetScreen FW/VPN devices:

• Configuring Device Administrators
• Configuring Permitted IPs
• Configuring CLI Management
• Configuring Web Management
• Configuring Date and Time Settings

For more detailed explanation about configuring device administration on NetScreen FW/
VPN devices, see the “Fundamentals” and “Administration” volumes in the NetScreen 
Concepts & Examples ScreenOS Reference Guide.
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A device administrator is the person responsible for managing a device locally using 
ScreenOS (command line or WebUI). A NetScreen FW/VPN device includes one default 
device administrator account, the root device administrator, which has complete access to 
all functionality on the device. Using NetScreen-Security Manager, you can create 20 
additional device administrators with different privilege levels.

When you import a device configuration into NetScreen-Security Manager, device 
administrator accounts are not automatically imported—you must manually import the 
accounts from the device using a separate directive. You cannot manage device 
administrator functionality in NetScreen-Security Manager until you have imported the 
device administrator information from the physical device (the device admin screens do 
not appear).

To notify you when device admin information needs to be imported, NetScreen-Security 
Manager displays the message “Need to Migrate Admin Info From Device”. To view this 
message, in the device navigation tree, select Device Administration; the message appears 
in the main display area. When present, this message indicates that you have not yet 
imported device administrators for that device. This message automatically appear after 
you perform the following operations:

• Adjust the ScreenOS version (changing the device firmware from ScreenOS 
4.x to ScreenOS 5.x). For details, see “Managing Device Firmware Version” on 
page 282. 

Note: To enable a device administrator to use NetScreen-Security Manager to 
manage devices, you must create a NetScreen-Security Manager administrator 
account for the device admin. For details, see “Creating Administrators” on page 30. 
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• Upgrade to NetScreen-Security Manager FP2. For details, refer to the 
NetScreen-Security Manager FP2 Installer Guide.

To import device administrator information, from the file menu, select Devices > 
Configuration > Import Admins. 
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To authenticate device administrators when they attempt to connect to the NetScreen 
FW/VPN device, you can use the default authentication server (on the device), or an 
external authentication server.

The root device administrator is always stored and authenticated using the local 
database; however, for non-root read/write and read-only device admins (including vsys 
device admins), you can specify an external auth server (RADIUS, SecurID, or LDAP 
server) that stores device administrator accounts. To select an external server from the 
auth server list, you must have already created and configured an Authentication Server 
object in the NetScreen-Security Manager UI (for details, see “Configuring Authentication 
Servers” on page 323). 

After the device administrator is authenticated, the auth server checks the privilege level 
of the device admin. A privilege level defines the privileges that are accessible to the 
device admin after successful logging in to the device:

• For device administrators stored in the local database, the NetScreen FW/VPN 
device uses the privilege level specified in the local device administrator account.

• For device administrators stored on an external auth server, select one of the 
following privilege settings:

– Get privilege from RADIUS server. Select this option to query a 
RADIUS server for all external device administrator privileges. The 
RADIUS server must contain the device administrator accounts and the 
netscreen.dct (NetScreen dictionary file).

– Read-Write, Read-Only. Select a privilege level that applies to all 
external device administrators. Although the device administrator 
accounts are stored on the external server, the NetScreen FW/VPN device 
provides the device administrator privilege level. Use this option when 
storing accounts on a SecurID or LDAP server, or when using a RADIUS 
server that does not contain the NetScreen dictionary file. By default, the 
external device administrator privilege level is set to Read-Only.
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You must create an account for each device administrator on the managed device. The 
device administrator account contains a device admin privilege level, user name, 
password, and optional PKA keys for the admin. 

Additionally, for NetScreen FW/VPN devices that run ScreenOS 5.0 dial, you can 
configure privileges for the Trustee, such as granting the permission to configure the 
untrust Ethernet interface and the permission to configure the untrust modem interface.
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A NetScreen FW/VPN device supports multiple device administrators. NetScreen-
Security Manager connects to the device as the root device administrator, and has 
complete administrative privileges for the device. A NetScreen FW/VPN device can have 
only one root device administrator, which cannot be deleted.

When you create other device administrators, you must assign a privilege level; these 
privileges are accessible to the device admin after successful login to the device:

• Read/Write Device Administrator. The read/write administrator has the 
same privileges as the root device administrator, but cannot create, modify, or 
remove other device administrators. Privileges include:

– Creates virtual systems and assigns virtual system administrators
– Monitors any virtual system
– Tracks statistics (this privilege cannot be delegated to a virtual system 

administrator)
• Read-Only Device Administrator. The read-only device administrator has 

only viewing privileges using the WebUI, and can only issue the get and ping  
CLI commands. Privileges include:

– Read-only privileges in the root system, using the following four 
commands: enter , exit , get, and ping

– Read-only privileges in virtual systems
• Virtual System Device Administrator (available on NetScreen FW/VPN 

devices that support virtual systems). Each virtual system (vsys) is a unique 
security domain, which can be managed by virtual system device administrators 
with privileges that apply only to that vsys. Virtual system administrators 
independently manage virtual systems through the CLI or WebUI. Privileges 
include:

– Creates and edits auth, IKE, L2TP, XAuth, and Manual Key users
– Creates and edits services
– Creates and edits policies
– Creates and edits addresses
– Creates and edits VPNs
– Modifies the virtual system administrator login password
– Creates and manages security zones
– Adds and removes virtual system read-only administrators

Note: For ScreenOS 4.x devices, you can set or change the root device admin password 
using the directive “Set Root Admin”. To execute this directive, right-click the device in 
the Device Manager device list and select Device > Set Root Admin.
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• Virtual System Read-Only Device Administrator (available on NetScreen 
FW/VPN devices that support virtual systems). A virtual system read-only 
administrator has the same set of privileges as a read-only administrator, but 
only within a specific virtual system. A virtual system read-only administrator 
has viewing privileges for a particular vsys through the WebUI, and can only 
issue the enter, exit, get, and ping CLI commands within that vsys.

For any configuration change made by a device administrator, the managed device 
generates a log entry with the name of the device administrator making the change, the 
IP address from which the change was made, and the time of the change. These log 
entries appear as configuration logs in the NetScreen-Security Manager Log Viewer.
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A device administrator can authenticate a connection to a NetScreen FW/VPN device 
using one of two authentication methods: Password or Public Key (ScreenOS 5.x devices 
only). However, regardless of the authentication method you want the device 
administrator to use, you must initially define a password for the admin account. If you 
bind a public key to the admin, the password becomes irrelevant. 

Use password authentication for device administrators who need to configure or monitor 
the managed device. You can use this authentication method for device administrators on 
ScreenOS 4.x and 5.x devices.

• To configure, enter a user name, password, and privilege level for the device 
administrator account, then select SSH Password Authentication.

• To connect using an SSH-aware application, the device administrator (the SSH 
client) initiates an SSH connection to the managed device (the SSH server). 
When SSH is enabled on the interface receiving the connection request, the 
managed device prompts the admin for user name and password, then compares 
that information to the information in the device admin account. If the user 
name and passwords match, the device authenticates the connection; if they do 
not match, the device rejects the connection request.

Use Public Key Authentication (PKA) for greater security, or to run automated scripts. 
You can use this authentication method for device administrators on a ScreenOS 5.x 
device.

• To configure, generate the PKA public/private key pair using the key generate 
program in an SSH client application (see the SSH client application 
documentation for more information). The key pair is RSA for SSHv1 and DSA 
for SSHv2. Assign the private key to the device administrator account, and use 
use a TFTP server to load the public key on the managed device.

• To connect using an SSH-aware application, the device administrator (the SSH 
client) initiates an SSH connection to the managed device (the SSH server). 
When SSH is enabled on the interface receiving the connection request, the 
managed device prompts the admin for user name and public key (of a public/
private key pair), then compares that information with up to four public keys for 
that device admin account. If one of the keys matches, the device authenticates 
the connection; if no keys match, the device rejects the connection request.
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When the managed device receives the connection request, it first checks the device 
administrator account for a public key bound to that administrator. If a matching key is 
found, the managed device authenticates the administrator using PKA; if no matching 
key is found, the managed device prompts for a user name and password. You can store 
up to four PKA keys for each device administrator.

You must enable SSH on the interface through which the device administrator connects to 
the managed device using an SSH connection.
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Use permitted IPs to restrict management connections (a connection in which a device 
administrator attempts to log in) to specific IP addresses. By default, any host on the trust 
interface of the managed device can connect to the NetScreen FW/VPN device and 
attempt to log in. You can configure the device to permit management connections from 
one or more user-defined IP addresses only.

After you create Permitted IPs (and update the device with the modeled configuration), 
the device immediately begins rejecting management connections from non-permitted IP 
addresses. If a device administrator is managing the device using a remote network 
connection and the workstation is not included as a permitted IP, the NetScreen FW/VPN 
device immediately terminates the device administrator’s session.

To create a Permitted IP, click the Add icon in the Permitted IP area, then configure an IP 
address and netmask.
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Corporation A has a small network, in which a single device administrator at 
172.16.40.42 is allowed to manage the NetScreen FW/VPN device. For this device, you 
create a permitted IP as shown below:

Note: Configuring a permitted IP for a device administrator does not affect the 
NetScreen-Security Manager –managed device connection.
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Corporation B has a large network with multiple devices. Several device administrators 
on the 172.16.40.0 subnet require access to all devices. For each device, you create a 
permitted IP as shown below:
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Use the CLI management options to configure local access using a console connection, or 
remote access using Telnet or SSH. A device administrator can connect directly to most 
NetScreen FW/VPN devices using the console port. CLI management settings apply to all 
device administrators for the NetScreen FW/VPN device.

Additionally, to manage a device remotely using Telnet or SSH, the device administrator 
must use a permitted IP address to initiate a Telnet or SSH connection to the device, and 
the correct service option must be enabled for the interface that the device administrator 
connects to on the device. For details on configuring permitted IP addresses, see 
“Configuring Permitted IPs” on page 215; for details on configuring service options for a 
device interface, see “Configuring Service Options” on page 148. 
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The file format determines the format (dos or unix) of a device configuration files. The 
CLI commands that configure the NetScreen FW/VPN device are automatically stored in 
a text-based configuration file. Occasionally, for troubleshooting purposes, a device 
administrator might need to view this configuration file outside of the NetScreen FW/
VPN device. 

To configure the file format of the configuration file, select the format that matches the 
computer system on which the configuration files will be viewed:

• In a UNIX text file, a line of text is terminated by a line feed character. When 
viewing a UNIX text file on a UNIX or DOS-based system, this line feed 
character does not appear. If you typically view configuration files on a UNIX 
system, select UNIX as the file format.

• In a DOS text file, a line of text is terminated by a line feed and a carriage return 
(^M). When viewing a DOS text file on a UNIX system, the carriage return 
character appears onscreen. If you typically view configuration files on a DOS-
based system, select DOS as the file format.
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You can configure the port numbers to use for SSH and Telnet connections:

• The default port for SSH client connections is 22; to change this default, enter a 
port number between 1024 and 32767.

• The default port for Telnet client connections is 23; to change this default, enter 
a port number between 1024 and 32767.

In a vsys system, the root and vsys share the same SSH port number. For example, if you 
change the SSH port from the default port 22, the port is also changed for all vsys.
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To minimize unauthorized access, you can limit the number of unsuccessful login 
attempts allowed before the NetScreen FW/VPN device terminates a Telnet session. This 
restriction also protects against certain types of attacks, such as automated dictionary 
attacks. 

By default, a NetScreen FW/VPN device allows up to three unsuccessful login attempts 
before it closes the Telnet session. 
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To prevent a root device administrator from using short passwords (which are easier to 
decode and discover), you can set the minimum length requirement for the root device 
administrator password to any number from 1 to 31.

However, to set this restriction, the current root device administrator password must 
meet the minimum length requirement you are attempting to set. If the current password 
is too short, NetScreen-Security Manager displays an error message. 
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If the root device administrator password is lost, the device administrator can restore 
access in one of two ways:

• Using Asset Recovery. Using a console connection, the device administrator 
uses the unset all command to clear all existing configuration settings and 
return the device to factory defaults (for details, see the “Administration” 
volume in the NetScreen Concepts & Examples ScreenOS Reference Guide). 
Device recovery is enabled by default. To disable it, clear the checkbox next to 
Enable Asset Recovery in the CLI Management configuration screen.

Note: For ScreenOS 4.x devices, you can set or change the device port numbers that accept 
Telnet and/or SSH connections. “Set Admin Ports”. To execute this directive, right-click 
the device in the Device Manager device list and select Device > Set Admin Ports.

Note: A NetScreen-FW/VPN device in FIPS mode automatically disables 
asset recovery.



Chapter 4 Configuring Devices

218 Administrator’s Guide

• Reset Hardware. The device administrator performs a manual operation on 
the physical device hardware to return the device to factory defaults (for details, 
see the “Administration” volume in the NetScreen Concepts & Examples 
ScreenOS Reference Guide). Reset Hardware is enabled by default. To disable it, 
clear the checkbox next to Enable Reset Hardware in the CLI Management 
configuration screen. 

All configuration settings stored on the managed device are lost during an asset recovery 
or hardware reset. After restoring access to the device, the device administrator should 
perform the following tasks to enable the device to reconnect to NetScreen-Security 
Manager:

1. Configure the interface that connects to the management system
2. Send the new root device administrator user name and password to the 

NetScreen-Security Manager administrator, who should update the existing root 
user name and password for the device in the modeled configuration.

3. Enable the NetScreen-Security Manager agent on the managed device. 

After the device has re-connected to the management system, you (the NetScreen-
Security Manager administrator) can update the device with the modeled configuration.
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You can require the root device administrator to log in to the NetScreen FW/VPN device 
through the console port only. This restriction requires the root device admin to have 
physical access to the device to log in, preventing unauthorized persons from logging in 
remotely.

By default, this restriction is not enabled (the root device administrator can log in 
remotely). To restrict access to console only, select the checkbox next to Root Access 
Console Only in the CLI Management screen. When enabled, the managed device denies 
access to all WebUI, Telnet, or SSH connections for the root device administrator. This 
setting overrides the management options enabled on the ingress interface.

Enabling the console-only setting does not affect the NetScreen-Security Manager–
managed device connection.
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Each NetScreen FW/VPN device includes a built-in Secure Shell (SSH) server. Device 
administrators can use an SSH-aware application to open a remote command shell on the 
device and execute commands. When using SSH, the connection is protected against IP or 
DNS spoofing attacks, and password or data interception.

Note: You cannot perform a hardware reset on a NetScreen-500 system.

Note: This option does not appear for the Juniper Networks NetScreen-Hardware 
Security Client, which does not contain a console port.
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The maximum number of SSH sessions is a device-wide limit and is between 2 and 24, 
depending upon the device. If the maximum number of SSH clients are already logged 
into the device, no other SSH client can log in to the SSH server.

To enable SSH connections to the managed device, select SSH Enable and configure an 
SSH Version. Because SSHv1 and SSHv2 are incompatible, you must use the same SSH 
version for both the client and server. For example, you cannot use an SSHv1 client to 
connect to an SSHv2 server on the managed device, or vice versa. 

For the SSH server (the NetScreen FW/VPN device), you can also enable Secure Copy 
(SCP). A device administrator can use SCP to transfer files to or from the managed device 
using SSH (SSH authenticates, encrypts, and ensure data integrity for the SCP 
connection). When using SCP, the NetScreen FW/VPN device acts as an SCP server that 
accepts connections from SCP clients on remote hosts. Additionally, you must enable SSH 
for the managed device before you can enable SCP (disabled by default).
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SSHv1 is widely deployed and is commonly used. You can use a password or Public Key 
Authentication (PKA) to authenticate an SSHv1 connection.

When using PKA authentication for the SSHv1 server (the NetScreen FW/VPN device) 
you can also set the key generation interval for the host PKA key. When you enable SSH 
on a managed device, the device generates a unique host key that is permanently bound to 
the device (each vsys has its own host key). If SSH is disabled, then enabled again, the 
device uses the same host key. The NetScreen FW/VPN device uses the host key to 
identify itself to an SSH client (device administrator).

After the key is generated, it can be distributed to the SSH client in one of two ways:

• Manually. Send the host key to the client admin user via e-mail, phone, etc. The 
device administrator stores the host key in the appropriate SSH file on the SSH 
client system (the SSH client application determines the file location and 
format).

• Automatically. When the SSH client connects to the managed device, the SSH 
server sends the unencrypted public component of the host key to the client. The 
SSH client searches its local host key database to see if the received host key is 
mapped to the address of the NetScreen FW/VPN device. If the host key is 
unknown (there is no mapping to the device address in the client’s host key 
database), the device admin user can accept the host key and authenticate the 
connection, or reject the host key and terminate the connection request.

Note: For ScreenOS 4.x devices, you can enable or disable SSH for device admin 
connections using the directive “Set Admin SSH”. To execute this directive, right-click 
the device in the Device Manager device list and select Device > Set Admin SSH.
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To configure the SSH client, you must also bind the RSA PKA keys to the device 
administrator before that admin can make an SSH connection. For details on assigning 
PKA keys to a device admin, see “Configuring Device Administrator Accounts” on page 
212.
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SSHv2 is considered more secure than SSHv1 and is currently being developed as the 
IETF standard. 

To configure the SSH client, you must also bind the DSA PKA keys to the device 
administrator before that admin can make an SSH connection. For details on assigning 
PKA keys to a device admin, see “Configuring Device Administrator Accounts” on page 
212.
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You can customize the message that appears when a device administrator logs on to the 
NetScreen FW/VPN device using a console connection, Telnet, or SSH. This message, 
called a banner, provides confirmation to device administrators to let them know that 
they have successfully logged in. Banners are optional; you are not required to configure 
CLI banners for the NetScreen FW/VPN device.

A default banner already exists for Telnet and SSH, but you can write a new message to 
suit your needs. You can use one banner for console connection and a different banner for 
both Telnet and SSH connections.

To configure CLI banners:

• For console connections, enter a message in Console Login Banner text field. By 
default, the console banner is blank (no confirmation is provided to the device 
administrator upon successful login).

• For Telnet or SSH connections, enter a new message or edit the existing default 
message in the Telnet/SSH Login Banner text field. By default, the message 
“Remote Management Console” is provided to device administrators upon 
successful login.

The maximum number of characters permitted in each banner is 127.
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Use the Web management options to configure remote access using Hypertext Transfer 
Protocol (HTTP). A device administrator can use a standard Web browser and HTTP to 
remotely access the WebUI on the NetScreen FW/VPN device. Web management settings 
apply to all device administrators for the NetScreen FW/VPN device.

Note: NetScreen-Security Manager supports PKA keys for device administrator 
authentication only for devices running ScreenOS 5.x.
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Additionally, to manage a device using the WebUI, the device administrator must use a 
permitted IP address to initiate an HTTP connection to the device, and the correct service 
option must be enabled for the interface that the device administrator connects to on the 
device. For details on configuring permitted IP addresses, see “Configuring Permitted 
IPs” on page 215; for details on configuring service options for a device interface, see 
“Configuring Service Options” on page 148.
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You can configure the following options for administrative connections that use HTTP:

• Idle time for WebUI management. The number of seconds that the HTTP 
connection remains idle (no traffic is flowing) before the device drops the 
connection.

• Port number. The default HTTP port number is 80. If you are running HTTP 
services on a different device port, enter that port number here.

Additionally, the device administrator must use a permitted IP address to initiate an 
HTTP connection to the device, and the Web service option must be enabled for the 
interface that the device administrator connects to on the device.

To secure HTTP administrative traffic, you can use the Secure Sockets Layer (SSL) 
protocol.
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Secure Sockets Layer (SSL) is a set of protocols that can provide a secure connection 
between a Web client and a Web server communicating over a TCP/IP network. SSL 
consists of the SSL Handshake Protocol (SSLHP), which enables a client and server to 
authenticate each other and negotiate an encryption method, and the SSL Record Protocol 
(SSLRP), which provides basic security services to higher-level protocols such as HTTP. 
Using certificates, SSL authenticates the server (the NetScreen FW/VPN device), then 
encrypts the traffic sent during the session. Juniper Networks supports authentication 
only of the server (the NetScreen FW/VPN device), not the client (the device 
administrator); the device authenticates itself to the device administrator, but the device 
administrator does not use SSL to authenticate to the device. However, the device 
administrator must connect using a Web browser with SSL version 3 compatibility (not 
version 2). Netscape Communicator 4.7x and later and Internet Explorer 5.x later are SSL 
version 3 compatible.

During the SSL handshake, the NetScreen FW/VPN device sends the device 
administrator its self-signed certificate. The device admin encrypts a random number 
with the public key contained in the certificate and sends the number back to the device, 
which uses its private key to decrypt the number. Both participants then use the shared 
random number and a negotiated secret key cipher (3DES, DES, RC4, or RC4-40) to 
create a shared secret key, which they use to encrypt traffic between themselves. They 
also use an agreed-upon compression method (PKZip or gzip) to compress data and an 
agreed-upon hash algorithm (SHA-1 or MD-5) to generate a hash of the data to provide 
message integrity.
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Additionally, the device administrator must use a permitted IP address to initiate an 
HTTP connection to the device, and the SSL service option must be enabled for the 
interface that the device administrator connects to on the device.

By default, SSL is enabled, so all HTTP connections to the WebUI are secure. The device 
automatically redirects administrative traffic using HTTP (default port 80) to SSL 
(default port 443) and authenticates using an auto-generated self-signed certificate. You 
can change the SSL configuration by editing the following SSL settings:

• Certificate. Initially, the NetScreen FW/VPN device uses an auto-generated 
self-signed certificate for SSL. To change the certificate used for SSL, select a 
certificate from the list of available certificates.

• Port. The default port for SSL connections is 443; to change this default, enter a 
different port number.

• Cipher. Select an encryption algorithm for SSL:
– RC4-40 with 40-bit keys
– RC4 with 128-bit keys
– DES: Data Encryption Standard with 56-bit keys
– 3DES: Triple DES with 168-bit keys

The RC4 algorithms are paired with MD5; DES and 3DES with SHA-1.

• Authentication. Select an authentication method for SSL:
– Message Digest version 5 (MD5)—128-bit keys
– Secure Hash Algorithm version 1 (SHA-1)—160-bit keys

While SSL is enabled, any device administrator can connect to the NetScreen FW/VPN 
device using the SSL port. When administrative connections use SSL, in the Web browser 
URL field, the device admin must enter the https (instead of http) before the IP address 
used to manage the device. If you changed the default SSL port from 443, the device 
administrator must also append a colon and the SSL port number to the IP address. For 
example, to connect to the 5.5.5.5 interface and SSL port 1443, the device administrator 
must enter https://5.5.5.5:1443.

To use HTTP without SSL, simply disable SSL by clearing the Enable SSL checkbox. The 
device no longer redirects HTTP connections to SSL, and no authentication occurs for the 
connection.
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Use the Date/Time option to configure date and time synchronization on NetScreen FW/
VPN devices. The date and time setting on the device affects VPN tunnel setup and 
schedule objects used in active Security Policies.

You configure the device time in relation to GMT.
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To ensure that the NetScreen FW/VPN device always maintains the right time, the device 
can use NTP (Network Time Protocol) to synchronize its system clock with that of an NTP 
server on the Internet.

To use NTP, first enable Network Time Protocol, then configure the following settings:

• Synchronization. You can configure the NetScreen FW/VPN device to perform 
this synchronization automatically at time intervals that you specify. By default, 
the synchronization interface is set to 10 minutes, with a 3 second maximum 
adjustment threshold. For details on how to immediately synchronize the device 
system clock with an NTP server, see Chapter 6, “Managing Devices”.

• Authentication. To secure NTP traffic, enable authentication. When using 
authentication, for each NTP server you configure on the NetScreen FW/VPN 
device, you must assign a unique Server Key ID and Preshare Key; the key id 
and preshare key serve to create an MD5checksum, with which the device and 
the NTP server can authenticate NTP data. Select the authentication mode that 
the device uses when connecting to an NTP server:

– Required. The device must include the authentication information—
Server Key ID and MD5checksum—in every packet it sends to a NTP 
server and must authenticate all NTP packets it receives from a NTP 
server. If authentication fails, the device denies NTP traffic from the NTP 
server.

– Preferred. The device attempts to authenticate NTP traffic using the same 
methods as the Required options, but continues to send and receive NTP 
traffic if authentication fails.

– None (default mode). Select this mode if you do not want to authenticate 
NTP packets. 

• NTP Servers. You can configure up to three NTP servers (one primary and two 
backups) from which the NetScreen FW/VPN device can regularly update its 
system clock. If you enabled authentication by selecting the Required or 
Preferred authentication options, you must also provide a unique Server Key ID 
and Preshare Key for each NTP server that you configure.
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The authentication screens contain the following device-wide authentication options you 
can configure on a NetScreen FW/VPN device:

• Configuring Banners
• Configuring Default Servers

The following sections detail each authentication option.

����
�	�
���-������
You can customize the message that appears when a device administrator logs on to the 
NetScreen FW/VPN device Telnet, FTP, HTTP, or via WebAuth. This message, called a 
banner, provides confirmation to device administrators to let them know the status of the 
connection. Default banners already exist, but you can write a new message to suit your 
needs. You can use different banners for each protocol.

To configure a protocol banner, select the protocol tab and edit the default Telnet, FTP, 
and HTTP messages:

• Attempted Logins. Enter a new message or edit the existing default message 
in the Login text field. This message is provided to device administrators when 
they are prompted for their authentication credentials.

• Successful Logins. Enter a new message or edit the existing default message 
in the Success text field. This message is provided to device administrators after 
their credentials have been authenticated and a connection has been 
established.

• Failed Logins. Enter a new message or edit the existing default message in the 
Fail text field. This message is provided to device administrators when their 
credentials are not authenticated (authentication fails) or when the 
administrator is not authorized to access the device.

To configure the WebAuth banner, select the WebAuth tab and enter a new message (or 
edit the existing default message in the Success text field. This message is provided to 
auth user when their WebAuth credentials have been authenticated and a connection has 
been established. The message appears at the top of a Web browser screen, after an auth 
user has successfully logged on to a WebAuth address. Typically, the message simply 
informs the user that the authentication was successful, but you can enter any message 
you want, up to a maximum of 220 characters.

Banners are optional; you are not required to configure banners for the NetScreen FW/
VPN device.

Note: To configure the Telnet, SSH, or console connection banner, see 
“Configuring CLI Banners” on page 220. 
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The default servers for the NetScreen FW/VPN device define the authentication servers 
used to provide local, external, and WebAuth user authentication. 

The Local server is the NetScreen FW/VPN device itself. All NetScreen FW/VPN devices 
support a built-in database for authentication; this database is the default server 
(authentication server) for all types of authentication that occur on the device. The user 
names and authentication credentials of all local users are stored in this local database.

Alternatively, you can select an external authentication server as the default server. To 
select an external server, you must have already created and configured an 
Authentication Server object in the NetScreen-Security Manager UI. You must also have 
defined the user accounts for all external users on the external server. For details, see 
“Configuring Authentication Servers” on page 323 and “Configuring User Objects” on 
page 328. 

For the Local server only, you can set the authentication timeout, which is the number of 
minutes the connection remains active after an authentication request has been 
submitted and a successful authentication is received. By default, the authentication 
timeout on the Local authentication server is 10 minutes. To change this timeout, enter a 
new value.
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The default Auth Server for a device handles all types of authentication that occur on the 
device, including user authentication. Select the Local authentication server to provide 
authentication for local users defined in the local database.
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When using WebAuth, an auth user first initiates an HTTP session to the IP address on 
the NetScreen FW/VPN device that hosts WebAuth. After successfully authenticating, the 
auth user can send traffic to the destination (as permitted by the Security Policy). To 
authenticate WebAuth users, you can use the Local authentication server (on the 
NetScreen FW/VPN device), or select a previously-defined external auth server.
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The Report Settings screens contain reporting options that you can set for the device. In 
the Device dialog box, open the Report Settings heading to see configuration options.

This section provides an overview of the following reporting options for NetScreen FW/
VPN devices. For details on configuring reporting settings, “Configuring the Device for 
Logging” on page 529. 

For more detailed explanation about reporting concepts for the NetScreen FW/VPN 
devices, see the “Administration” volume in the NetScreen Concepts & Examples 
ScreenOS Reference Guide.
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Use the General reporting settings to configure the severity levels of the messages you 
want to log and where you want those messages sent. Each system event on a NetScreen 
FW/VPN device is assigned a level of severity. You can configure your NetScreen FW/VPN 
device to send messages to specific destinations to communicate events of a certain level 
of severity. By default, packets that are dropped on the NetScreen FW/VPN device are 
logged to the self log. In the Firewall Options, you can disable or enable logging of dropped 
packets for specific traffic types, including ICMP, IKE, SNMP, and multicast packets.

For details on configuring General reporting options, see “Configuring the Device for 
Logging” on page 529.

����
�	�
���5+�
 ����
�
���
�������
���
Use the Email option to configure a NetScreen FW/VPN device to send messages using 
email whenever a system event of Emergency, Alert, Critical, or Notification severity level 
occurs. To configure email notification, you must specify the SMTP mail server and at 
least one email address; if desired, you can enter a secondary email address as well.

For details on configuring Email reporting options, see “Configuring Email Server 
Settings” on page 532.
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Use the NSM reporting settings to configure the NetScreen FW/VPN device to report 
specified events to NetScreen-Security Manager. You configure the primary IP address of 
the NetScreen-Security Manager Device Server and select the categories of events that 
are tracked on the FW/VPN device and reported to NetScreen-Security Manager. You can 
also set the interval at which the NetScreen-Security Manager Device Server polls for 
policy statistics and protocol distribution events.

For details on configuring NSM reporting options, see “Configuring NSM Reporting 
Settings” on page 532.
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Use the SNMP reporting options to configure the Simple Network Management Protocol 
(SNMP) agent for the NetScreen FW/VPN device. The SNMP agent provides a view of 
statistical data about the network and the devices on it, and notification of system events 
of interest.

You also must enable SNMP manageability on the interface through which the SNMP 
manager applicable communicates with the SNMP agent in the FW/VPN device.

For details on configuring SNMP reporting options, see “Configuring SNMP Reporting 
Settings” on page 537.

����
�	�
������ ���,�"���
��
Use the Syslog option to configure syslog reporting. A NetScreen FW/VPN device can 
generate syslog messages for system events at predefined severity levels and optionally 
for traffic that policies permit across a firewall. It sends these messages via UDP (port 
514) to up to four designated syslog hosts running on UNIX/Linux systems. When you 
enable syslog reporting, you also specify which interface the NetScreen FW/VPN devices 
uses to send syslog packets.
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To configure a syslog host:

1. Click the Add icon in the Syslog configuration screen. The host configuration 
dialog box appears.

2. Specify the hostname and the port to which the NetScreen FW/VPN device sends 
syslog messages.

3. For each syslog host, you specify the following:
– Whether the NetScreen FW/VPN device includes traffic log entries, event 

log entries or both traffic and event log entries
– The security facility, which classifies and sends messages to the Syslog 

host for security-related actions; and the regular facility, which classifies 
and sends messages for events unrelated to security

– Which transport protocol (UDP or TCP) is used for sending syslog 
messages

4. Click OK.

For details on configuring syslog reporting options, see “Directing Logs to a Syslog Server” 
on page 538.
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Use the Webtrends option to configure the NetScreen FW/VPN device to send syslog 
reports to a Webtrends Syslog host. Webtrends offers a product called the Webtrends 
Firewall Suite that enables you to customize syslog reports to display the information you 
want in a graphical format.

To configure the NetScreen FW/VPN device to send syslog reports to a Webtrends Syslog 
host, you first enable Webtrends reporting, then specify the name of the Webtrends host 
and the port on which the syslog message are sent. If you are sending reports through a 
VPN tunnel, click the Use Trust Zone Interface as Source IP for VPN check box.

For details on configuring Webtrends reporting options, see “Directing Data to a 
WebTrends Server” on page 539.
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The Security screens contain security options that you can set for the device. In the Device 
dialog box, open the Security heading to see configuration options.

This section describes configuring the following security options for NetScreen FW/VPN 
devices:

• Configuring AntiVirus (AV) Settings
• Configuring URL Filtering
• Configuring Deep Inspection
• Configuring the Attack Database
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(This option is only available on some NetScreen FW/VPN devices.) Use the antivirus 
(AV) option to configure AV scanning. NetScreen FW/VPN devices provide embedded AV 
scanning or external AV scanning in conjunction with Trend Micro. With embedded AV 
scanning, the AV scanner is inside the device; embedded AV scanning is only supported 
on some NetScreen FW/VPN devices. With external AV scanning, the AV scanner is a 
separate device to which the NetScreen FW/VPN device forwards traffic that requires 
scanning.

To configure AV settings:

1. Click the tab for the type of settings you want to configure in the AntiVirus 
configuration screen:

– AV Scanner Settings configures parameters for external AV scanners
– AV Scan Manager Settings configures parameters for the internal AV 

scanner
– AV HTTP Webmail Settings configures the device for WebMail scanning

For descriptions of these settings, see the following sections.

2. Specify the options you want.
3. Click OK.
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Use the AV Scanner Settings tab to configure the following:

• Fail Mode Traffic Permit. You can direct the device to pass traffic if the device 
loses connectivity with the AV scanner.

• Maximum AV resources allowed per AV client. You can set the maximum 
percentage of AV resources permitted per AV client.

• HTTP Settings. You can direct the device to use the HTTP keep-alive 
connection option.
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• Trickling. You can direct the device to forward specific amounts of unscanned 
traffic to the HTTP client to prevent the client from timing out while the scanner 
is busy examining downloaded HTTP files. If you select Custom, you can specify 
the amounts that are forwarded. Selecting Default resets the amounts to their 
default values.

����
�	�
����<��������� �*9��������
Use the AV Scan Manager Settings tab to configure the following:

• Pattern Server URL. You specify the URL address of the server from which 
the device retrieves pattern file updates.

• Update Interval. You can specify the interval at which the device starts an 
automatic pattern update.

• Maximum Decompression Level. You can specify the maximum number of 
layers of nested compressed files that the scanner decompresses before 
executing a virus scan.

• Content drop parameters. You can specify that the device drop messages if 
the size of the content or the number of concurrent messages exceed configurable 
limits.

• Content Protocol. You can select the type of protocols (HTTP, SMTP, or POP3) 
that are to be examined for virus patterns and the number of seconds permitted 
for a scan.
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Use the AV HTTP Webmail Settings tab to enable virus scanning for webmail.

To specify a URL pattern:

1. Click the Add icon in the AV HTTP Webmail Settings tab in the AntiVirus (AV) 
configuration screen. The URL Pattern dialog box appears.

2. Enter the following information:
– User-defined name for the pattern
– The download URL path for the webmail
– URL arguments, which begin with “?”
– The host name included in the URL

3. Click OK to close the URL Pattern dialog box.

Note: You can direct a NetScreen FW/VPN device to immediately contact the 
pattern server and update its pattern file. To do this, right-click the device 
object in the FW/VPN Device Tree or FW/VPN Device List tab in the Device 
Manager, and select AV Scan Manager > Update Pattern. (You can modify 
the pattern server URL and update interface if necessary.) Click OK.
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For more detailed explanations of AV settings, see the “Attack Detection and Defense 
Mechanisms” volume in the NetScreen Concepts & Examples ScreenOS Reference Guide 
for ScreenOS 5.x.
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Use the URL Filtering option to configure URL filtering using the Websense Enterprise 
Engine, which enables you to block or permit access to different sites based on their 
URLs, domain names, and IP addresses. With the Websense API built directly into the 
NetScreen FW/VPN device, the device creates a direct link to a Websense URL-blocking 
server.

To configure URL filtering with a Websense URL-blocking server, you enable URL 
filtering and define the following:

• Interface from which the NetScreen FW/VPN device initiates URL filter 
requests to the Websense server sent through a VPN tunnel

• Name and port for the Websense server
• Whether you want the device to block or permit all HTTP requests if 

connectivity to the Websense server is lost

You can also configure the timeout for receiving responses from the server and the 
message that is returned to the user when the user tries to access a blocked site.

For more detailed explanations of URL filtering, see the “Fundamentals” volume in the 
NetScreen Concepts & Examples ScreenOS Reference Guide for ScreenOS 4.0.0 or the 
“Attack Detection and Defense Mechanisms” volume in the NetScreen Concepts & 
Examples ScreenOS Reference Guide for ScreenOS 5.x.
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(This option is only available on some NetScreen FW/VPN devices.) Deep Inspection (DI) 
is a mechanism for filtering the traffic permitted by the NetScreen firewall. You can 
enable Deep Inspection in policies to examine permitted traffic and take action if the DI 
module in ScreenOS finds attack signatures or protocol anomalies.

Protocol anomaly detection is particularly useful for catching new attacks or those attacks 
that cannot be defined by a textual pattern. Attack objects that search for protocol 
anomalies detect traffic that deviates from the standards defined in RFCs and common 
RFC extensions. Juniper Networks supports protocol anomaly attack objects for the 
following protocols:

• DNS
• POP3
• SMTP
• IMAP
• FTP
• HTTP
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Use the Deep Inspection configuration screens to modify the default settings defined in 
RFCs and RFC extensions for these protocols.

You can also enable the validation of all TCP packets for TCP checksum by clicking the 
Enable TCP Checksum check box.

For more detailed explanation of Deep Inspection, see the “Attack Detection and Defense 
Mechanisms” volume in the NetScreen Concepts & Examples ScreenOS Reference Guide 
for ScreenOS 5.x.
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(This option is only available on some NetScreen FW/VPN devices.) Use the Attack 
Database option to configure a database that contains all the predefined attack objects, 
organized into attack object groups by protocol and severity level. Juniper Networks 
stores the attack object database on a server at https://services.netscreen.com/restricted/
sigupdates. To use the predefined attack objects, you must download the database from 
this server, load it on your NetScreen FW/VPN device, and then reference specific attack 
object groups in policies.

To gain access to the attack object database server, you must first obtain an attack object 
update subscription for your NetScreen FW/VPN device. To obtain a subscription for a 
device using the NetScreen-Security Manager UI, see Chapter 6, “Managing Devices”.

To configure the attack object database, specify the following:

• URL of the attack object database server
• The mode for checking and updating the database:

– Notification checks the server at user-defined times and notifies you if the 
database on the server is more recent than the database on the NetScreen 
FW/VPN device

– Update checks the server at user-defined times and automatically updates 
the database on the device if the database on the server is more recent

• Schedule (daily, weekly, or monthly) on which the NetScreen FW/VPN device 
checks the attack object database server

From the NetScreen-Security Manager UI, you can direct the NetScreen FW/VPN device 
to update its attack object database immediately. See Chapter 6, “Managing Devices”.

For more detailed explanations of the attack object database, see the “Attack Detection 
and Defense Mechanisms” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide for ScreenOS 5.x.
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Use the advanced screens to configure advanced options for the NetScreen FW/VPN 
device. In the device navigation tree, select Advanced to view configuration options.

The following sections detail the advanced options for NetScreen FW/VPN devices:

• Configuring Timeouts for Predefined Services
• Configuring SIP Settings
• Configuring Traffic Shaping
• Configuring Packet Flow
• Configuring TFTP/FTP Server Operation
• Configuring Host and Domain Name
• Configuring NSGP
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Use the Predefined Service Timeout option to configure timeouts for predefined services. 
Services are types of IP traffic for which protocol standards exist. Each service has a port 
number associated with it, where the access policy accepts a request for that service. 
When you create an access policy, you must define a service for it. You can select one of 
the predefined services or select a custom service that you have created. For predefined 
services, you can use the default timeout specified by the protocol or you can configure a 
different timeout value.

To configure a timeout for a predefined service:

1. Click the Add icon in the Predefined Service Timeout configuration screen. The 
Predefined Service Timeout dialog box appears.

2. Select the service from the Name scrolling list.
3. Select User-defined Value from the Timeout scrolling list.
4. Enter the timeout value.
5. Click OK.

For more detailed explanation about configuring timeouts for predefined services on 
NetScreen FW/VPN devices, see the “Fundamentals” volume in the NetScreen Concepts & 
Examples ScreenOS Reference Guide.

����
�	�
�����������
���
Use the SIP Settings option to configure Session Initiation Protocol (SIP) as a service on 
the NetScreen FW/VPN device. The device can then screen SIP traffic, permitting or 
denying it based on a Security Policy that you configure. SIP is a predefined service in 
ScreenOS and uses port 5060 as the destination port. NetScreen FW/VPN devices 
currently do not support NAT (network address translation) with SIP.

SIP is used to distribute the session description and, during the session, to negotiate and 
modify the parameters of the session. SIP is also used to terminate the session.
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SIP messages consist of requests from a client to a server and responses to the requests 
from a server to a client with the purpose of establishing a session (or a call). A UA (User 
Agent) is an application that runs at the endpoints of the call and consists of two parts: 
the UAC (User Agent Client) that sends SIP requests on behalf of the user, and a UAS 
(User Agent Server) who listens to the responses and notifies the user when they arrive. 
Examples of User Agents are SIP proxy servers and SIP phones.

A call can have one or more voice channels. Each voice channel has two sessions (or two 
media streams), one for RTP and one for RTCP. When managing the sessions, the 
NetScreen FW/VPN device considers the sessions in each voice channel as one group. 
Settings such as the inactivity timeout apply to a group as opposed to each session.

You can configure two types of inactivity timeouts that determine the lifetime of a group:

• Signaling Inactivity Timeout. This parameter indicates the maximum length 
of time (in seconds) a call can remain active without any SIP signaling traffic. 
Each time a SIP signaling message occurs within a call, this timeout resets. The 
default setting is 43200 seconds (12 hours).

• Media Inactivity Timeout. This parameter indicates the maximum length of 
time (in seconds) a call can remain active without any media (RTP or RTCP) 
traffic within a group. Each time a RTP or RTCP packet occurs within a call, this 
timeout resets. The default setting is 120 seconds.

If either of these timeouts expire, the NetScreen FW/VPN device removes all sessions for 
this call from its table, thus terminating the call. For more detailed explanation about 
configuring SIP on NetScreen FW/VPN devices, see the “Fundamentals” volume in the 
NetScreen Concepts & Examples ScreenOS Reference Guide.
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Use the Traffic Shaping option to configure traffic shaping parameters. Traffic shaping is 
the allocation of network bandwidth at a guaranteed Quality of Service (QoS) to every 
user and application on an interface. You can use a NetScreen FW/VPN device to shape 
traffic by creating policies and by applying traffic shaping to each class of traffic going 
through the device.

You can configure the following traffic shaping parameters:

• The mapping of eight priority levels to the first three bits in the DiffServ field, or 
to the IP precedence field in the ToS byte in the IP packet header. By default, 
the highest priority (priority 0) on the NetScreen FW/VPN device maps to 111 in 
the IP precedence field. The lowest priority (priority 7) maps to 000 in the IP 
precedence field.

• The traffic shaping mode is automatically determined by the device, but you can 
set it to on or off.

You can only apply traffic shaping to policies whose destination zone has a single 
interface bound to it. Security zones that contain subinterfaces or that contain more than 
one physical interface do not support traffic shaping. For information about using traffic 
shaping with a policy, see Chapter 8, “Configuring Security Policies”.
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For more detailed explanation about configuring traffic shaping on NetScreen FW/VPN 
devices, see the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide.
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The Packet Flow option enables you to configure the NetScreen FW/VPN device to 
regulate packet flow. You can set the following:

• Enable or disable DNS replies when there is no matching DNS request
• Pass or block packets containing destination MAC addresses that are not in the 

MAC learning table
• Set or display the initial session timeout values
• Control or prevent packet fragmentation
• Age or time out sessions in the session table

For more detailed explanation about configuring packet flow on NetScreen FW/VPN 
devices, see the flow commands in the NetScreen CLI Reference Guide.
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Use the TFTP/FTP option to configure a NetScreen FW/VPN device to enable TFTP or 
FTP servers to save or import external files. These files can contain configuration 
settings, software versions, public keys, error messages, certificates, and other items.

For TFTP servers, you can specify the following:

• Source interface
• Number of times that the server can retry a TFTP communication before the 

NetScreen FW/VPN device ends the attempt
• Timeout (in seconds) before the device terminates an inactive TFTP connection. 

You can also enable FTP servers to dynamically negotiate a data port other than port 20.

For more detailed explanation about configuring TFTP or FTP servers for NetScreen FW/
VPN devices, see the ip commands in the NetScreen CLI Reference Guide.
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The Host/Domain Name option enables you to configure a host and domain name for the 
NetScreen FW/VPN device. The host name is a character string that identifies the device. 
The host name, combined with a domain name, enables other devices to access the 
NetScreen FW/VPN device through a DNS server. If you define a fully-qualified domain 
name (FQDN) for the device, you can use the FQDN as a gateway for a VPN tunnel.

For more detailed explanation about configuring the hostname or domain name for 
NetScreen FW/VPN devices, see the hostname and domain commands in the NetScreen 
CLI Reference Guide.
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NetScreen Gatekeeper Protocol (NSGP) is a Juniper Networks proprietary peer-to-peer 
protocol that enables a NetScreen FW/VPN device to act as a server for Voice-over-IP 
(VoIP) traffic. 

You can use NSGP to prevent overbilling attacks that can occur when using GTP for VoIP. 
By configuring one NetScreen FW/VPN device as a NSGP server and another NetScreen 
FW/VPN device as an GTP client, you can keep both server and client aware of the 
connection status. When a user initiates a call, the NSGP server and GTP client establish 
a session; when the user completes the call, the client notifies the server, prompting the 
server to close the session.

NetScreen-500 FW/VPN devices running ScreenOS 5.x can be both the NSGP server and 
client; a NetScreen-5000 FW/VPN device can only be an NSGP server. 

Configuring NSGP on a device does not automatically enable the device to handle GTP 
traffic—it simply enables the GTP client and NSGP server to close a session at the same 
time. To enable the GTP client to manage GPRS traffic, you must create a GTP object, 
then add that object to the Security Policy installed on the device. For details on creating 
a GTP object, see “Configuring GTP Objects” on page 311. For details on adding a GTP 
Object to a Security Policy, see “Enabling GTP” on page 360. 
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Because mobile stations get their IP addresses from an IP pool, an overbilling attack can 
occur when a legitimate subscriber returns an IP address to the IP pool, but the session is 
still open. Attackers can hijack the IP address without being detected and reported, then 
download data at the expense of the legitimate subscriber, or send data to other 
subscribers. Overbilling can also occur when a newly-returned IP address is reassigned to 
another MS; traffic initiated by the previous MS might be forwarded to the new MS, 
causing the new MS to be billed for unsolicited traffic. To protect subscribers of a PLMN 
from Overbilling attacks, you can use the NetScreen Gatekeeper Protocol (NSGP) module 
and two NetScreen FW/VPN devices.

The NSGP module includes two components: the client and the server. The client connects 
to the server and sends requests, which the server processes. Both client and server 
support multiple connections to each other and to others simultaneously. Using TCP, 
NSGP monitors the connectivity between client and server by sending Hello messages at 
set intervals. 

Note: To use NSGP on a NetScreen 500 or 5000 device, you must first enable 
NSGP using a license key. For details on activating NSGP using a license key, see 
“Installing License Keys” on page 284.
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NSGP uses a session context to ensure that the server and client know that status of the 
connection. The session context stores is identified by a unique number (context ID); when 
configuring NSGP on the client and server devices, you must use the same context ID on 
each devices. When the client sends a “clear session” request to the server, the request 
includes the context ID and IP address of the server. When the server receives the “clear 
session” message, it matches the context ID and then clears the session from its table.

The NetScreen FW/VPN device acting as the NSGP server must run the ScreenOS 5.0.0 
NSGP firmware, and the other device acting as the GTP client must run the ScreenOS 
5.0.0 GPRS firmware. After you have deployed the two devices, you must:

• Configure NSGP on the GTP server to recognize when a GTP tunnel is deleted 
and to notify the GTP client.

• Configure NSGP on the GTP client to automatically clear sessions whenever the 
NSGP server gets a notification from the GTP client that a GTP tunnel was 
deleted.

By clearing the sessions, the NSGP server stops the unsolicited traffic, and prevents 
overbilling.
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In this example, you configure NSGP on both the GTP firewall (client) and the Gi firewall 
(server). First, you must create the GTP Object for the client connection. Then, to enable 
NSGP on the NetScreen FW/VPN device, you must configure both the server and client 
side connection parameters:

• For the NSGP server connection, you enable NSGP on an interface.
• For the GTP client connection, you select a source interface, then copy the NSGP 

server settings (from the NSGP server device) to configure the destination 
interface.

Finally, you create a firewall rule that includes the GTP object, the GTP firewall, and the 
Gi firewall.

GTP Firewall 
1.1.2.5/24

Gi Firewall 
2.2.1.4/24

Internet

Server
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1. Create a GTP object named GPRS1. For details and an example for creating a 
GTP object, see “Configuring GTP Objects” on page 311.

2. Add the Gi Firewall (server) as a NetScreen-500 running NSGP, then configure 
the network module:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Slot. 

b. Double-click slot 1 to display the slot configuration dialog box. For Card 
Type, select 2 Interfaces (10/100), as shown below:

c. Click OK to save the slot configuration.
3. Add the GTP firewall (client) as a NetScreen-500 running GPRS, then configure 

the network module:

a. Double-click the device icon to open the device configuration. In the device 
navigation tree, select Network > Slot. 

b. Double-click slot 1 to display the slot configuration dialog box. For Card 
Type, select 2 Interfaces (10/100). 

c. Click OK to save the slot configuration.
4. Configure the Gi firewall (server):

a. In the device navigation tree, select Advanced > NSGP > Server Side 
Settings. 

b. Leave the default port number and enter an MD5 password.
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c. In the NSGP Context IDs area, click the Add icon to display the New 
Context Entry dialog box. Configure as shown below:

– For Context Entry, enter 2.
– For Zone, select untrust.
– Click OK to save the Context ID.

d. In the Interface NSGP Settings area, right-click the ethernet 1/2 interface 
and select Edit. The General Properties screen appears. Configure as 
shown below:
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– For IP Address, enter 2.2.1.4. 
– For Netmask, enter 24.
– Leave all other defaults.

e. In the interface navigation tree, select Service Options. Configure as 
shown below:

– Select Telnet. 
– Select NSGP Enabled, then select Enforce IPSec to encrypt the GTP 

connection.
f. Click OK to save your changes to the interface, then click OK to save your 

changes to the device.
5. Configure the GTP firewall (client):

a. In the device navigation tree, select Advanced > NSGP > NSGP 
Connections. Click the Add icon to display the New NSGP Connection 
dialog box.

b. For Source Interface, select ethernet 1/2.
c. For Destination, click Copy Existing NSGP Server Setting. The Copy 

Existing NSGP Server Info dialog box appears. Configure as shown below:

– For NSGP Server Info, select Gi firewall (server).
– For Destination Interface, select ethernet 1/2.
– Click OK to copy the NSGP server settings to the GTP client. NetScreen 

Security Manager automatically completes the destination server 
settings for the GTP client.
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d. In GTP Objects, select the GPRS1 object. When complete, your NSGP 
connection settings for the GTP client should appear as shown below:

e. Click OK to save the NSGP Connection.
6. Configure a firewall rule to handle GTP traffic, as shown below:
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Use the L2TP/XAuth/Local User option to enable the NetScreen FW/VPN device to 
authenticate local users and/or assign specific IP pools and remote settings. Because user 
objects are shared objects, you can configure the same user on multiple devices, but assign 
different remote settings and IP pool for each device.

You must configure a L2TP or XAuth local user on a NetScreen FW/VPN device when:

• You want the device to authenticate the user. Typically, you want to 
authenticate a user who is connecting to the device using a VPN tunnel.

• You want the device to assign specific IP, DNS server, and WINS server 
addresses to a user who is connecting to the device using a VPN tunnel. The 
remote settings and IP pool you assign at the device level override the remote 
settings and IP pool assigned to the VPN.
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The Layer 2 Tunneling Protocol (L2TP) enables a NetScreen FW/VPN device to 
authenticate users using the local database or an external auth server, and assign specific 
remote settings and IP pools.

L2TP simply enables the NetScreen FW/VPN device to authenticate users; to encrypt an 
L2TP VPN tunnel, you must apply an encryption scheme, such as IPSec, to the L2TP 
tunnel. When configuring an L2TP-over-IPSec VPN, you are actually setting up an L2TP 
tunnel and an IPSec tunnel with the same endpoints, then linking the two tunnels 
together in a Security Policy rule. VPN Manager automatically generates the required 
rules; if you are creating the L2TP-over-IPSec VPN at the device-level, you must configure 
the rules manually. For more details on L2TP VPNs, see “L2TP” on page 389. 

You can also use the device to assign specific IP, DNS server, and WINS server addresses 
from the local database or a RADIUS server. When you assign the L2TP user or user 
group a remote setting and IP pool at the device level, the settings override the remote 
settings and IP pool assigned to the VPN.
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You can even use different auth servers, one for each aspect of L2TP. For example, you 
might use a SecurID server to authenticate an L2TP user but make the address 
assignments from the local database.
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1. Configure the L2TP user object named L2TP Adam, configured as shown below:

– For Name, enter Adam.
– Select Enable, then select L2TP.
– Select Password, then enter and confirm the password: AJbioJ15.

Click OK to save the new user object. For details on creating user objects, see 
“Configuring User Objects” on page 328.
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2. Configure the Remote Settings object named RM_L2TP, configured as shown 
below:

– For Dns1, enter 1.1.1.2.
– For Dns2, enter 1.1.1.3.
– For Wins1, enter 0.0.0.0.
– For Wins2, enter 0.0.0.0.

Click OK to save the new Remote Settings object. For details on creating Remote 
Settings objects, see “Configuring Remote Settings” on page 337.

3. Configure the IP Pool object named Global, configured as shown below:

– For IP Pool Name, enter Global.
– For Start IP, enter 10.10.2.100.
– For End IP, enter 10.10.2.180.

Click OK to save the new IP Pool object. For details on creating IP Pool objects, 
see “Configuring IP Pools” on page 333.



Chapter 4 Configuring Devices

246 Administrator’s Guide

4. Configure the L2TP local user: 

a. In Device Manager, double-click the device icon for the device on which 
you want to configure the L2TP local user.

b. In the device navigation tree, select L2TP/XAuth/Local User.
c. In the main display area, click the Add icon. The new L2TP/XAuth User 

Settings dialog box appears.
d. Configure as shown below:

– In the User menu, select Adam.
– In the Remote Settings menu, select RM_L2TP.
– In the IP Pool list, select Global.

e. Click OK to save the new local user.
5. Click OK to save your changes to the device configuration.
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The XAuth protocol enables the device to authenticate XAuth users and/or assign IP pools 
and remote settings. 

An XAuth user (or user group) is a RAS user who authenticates when connecting to the 
NetScreen FW/VPN device using an AutoKey IKE VPN tunnel. Although both IKE and 
XAuth users can authenticate through an AutoKey IKE VPN tunnel, the authentication 
of IKE users is actually the authentication of VPN gateways or clients, while the 
authentication of XAuth users is the authentication of the individuals themselves. XAuth 
users must enter information that only they are supposed to know—their user name and 
password.

You can also assign an XAuth user IP, WINS, and DNS addresses from the device. When 
you assign the XAuth user or user group a remote setting and IP pool at the device level, 
the settings override the remote settings and IP pool assigned to the VPN.

For more details about configuring authentication users on NetScreen FW/VPN devices, 
see the “Fundamentals” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide.



Configuring vsys

NetScreen-Security Manager 2004 FP2 247

��	(
��
	����#�
After you create a vsys, you need to perform other configurations to make it a functional 
vsys. You need to configure interfaces or subinterfaces for the vsys, and possibly shared 
virtual routers and shared security zones. After completing these configurations, you can 
then exit the virtual system and enable the domain administrator to log into the virtual 
system and begin configuring addresses, users, services, VPNs, and policies.

For more detailed explanations of vsys, see the “Virtual Systems” volume in the NetScreen 
Concepts & Examples ScreenOS Reference Guide.

To configure a vsys:

1. In the Device Manager, double-click the vsys in either the FW/VPN Device Tree 
or the FW/VPN Device List. (Or, either select the vsys and click the Edit icon, or 
right-click on the vsys and select Edit.)

The Virtual System dialog box appears. The Virtual System dialog box is similar 
to the Device dialog box, but with fewer options.

2. Select the option you want to configure in the Virtual System dialog box 
navigation tree.
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When you create a vsys object, the vsys automatically has the following virtual routers 
available for its use:

• All shared root-level virtual routers
• Its own non-sharable virtual router named vsys_name-vr

You can configure any shared root-level virtual router or the vsys-level virtual router as 
the default virtual router for the vsys. You can define any root-level VR as sharable. If you 
configure a root-level virtual router to be shared, you cannot unshare it without removing 
all vsys first.
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Each virtual system (vsys) is a unique security domain and can share security zones with 
the root system and have its own security zones. When a root-level admin creates a vsys 
object, the following zones are automatically inherited or created:

• All shared zones (inherited from the root system). A shared zone must in a 
shared virtual router, although a zone in a shared VR can be either shared or 
unshared.

• Shared Null zone (inherited from the root system)
• Trust-vsys_name zone
• Untrust-Tun-vsys_name zone
• Global-vsys_name zone
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Each vsys can also support extra user-defined security zones. You can bind these zones to 
any shared virtual routers defined at the root level or to the virtual router dedicated to 
that vsys.

IP-based traffic classification enables you to use virtual systems without VLANs. The 
NetScreen FW/VPN device uses IP addresses to sort traffic, associating a subnet or range 
of IP addresses with either the root or a specific vsys. To designate a subnet or range of IP 
addresses to the root system or to a previously-created vsys, you must enable IP 
classification at the root level on the shared zone. 
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You can configure any of the following types of interfaces for a vsys:

• Dedicated physical interface
• Subinterface, with VLAN tagging to determine the vsys that inbound or 

outbound traffic belongs
• Shared interface with the root system. A shared interface must be configured at 

the root level and bound to a shared zone in a shared virtual router.

A shared interface is an interface that can be shared with the root system or another vsys. 
Any interface you bind to a shared zone is shared. By default, the predefined untrust-vr is 
a shared VR, and the predefined Untrust zone is a shared zone. Therefore, a vsys can 
share any root-level physical interface, subinterface, redundant interface, or aggregate 
interface bound to the Untrust zone.

A physical, subinterface, redundant interface, or aggregate interface in the root system 
that is bound to a non-sharable zone is dedicated to the root system. If you import a 
physical or aggregate interface into a vsys and bind it to either a shared zone or the Trust-
vsys_name zone, the interface becomes a dedicated interface for the vsys. When you 
configure a subinterface in a vsys, it belongs to that vsys.
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Selecting the VSYS option on the Device dialog box navigation tree for the root device 
permits you to view the vsys that are currently created on the device.
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To authenticate external devices, use a Group IKE ID to authenticate multiple RAS users, 
or provide additional authentication for the FW/VPN devices in your VPN, you must 
obtain and install a digital certificate on each FW/VPN device that is a member.

A digital certificate is an electronic means for verifying identity through the word of a 
trusted third party, known as a Certificate Authority (CA). The CA is a trusted partner of 
the VPN member using the digital certificate as well as the member receiving it.

The CA also issues certificates, often with a set time limit. If you do not renew the 
certificate before the time limit is reached, the CA considers the certificate inactive. A 
VPN member attempting to use an expired certificate is immediately detected (and 
rejected) by the CA.

To use certificates in your VPN, you must configure:

• A local certificate for each FW/VPN device that is a VPN member.
• Certificate Authority (CA) Object. Use a CA object to obtain a local and CA 

certificate.
• Certificate Revocation List (CRL) Object. Use a CRL object to ensure that 

expired certificates are not accepted; a CRL is optional.

If you have imported a NetScreen FW/VPN device that already has a local certificate, CA, 
and CRL, these objects are automatically imported when you add that device to the 
NetScreen-Security Manager system. However, to reuse the CA and CRL objects in other 
NetScreen FW/VPN devices, you must load the CA and CRL file directly into the 
management system. For details, see “Using Imported Certificates” on page 253. 
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A local certificate validates the identity of the FW/VPN device in a VPN tunnel 
connection. To get a local certificate for a device, you must prompt the device to generate a 
certificate request (includes public/private key pair request) using the Generate 
Certificate Request directive. In response, the device provides certificate request that 
includes the encrypted public key for the device. Using this encrypted public key, you can 
contact a independent CA (or use your own internal CA, if available) to obtain a local 
device certificate file (a .cer file).

You must install this local certificate file on the managed device using NetScreen-Security 
Manager before you can use certificates to validate that device in your VPN. Because the 
local certificate is device-specific, you must use a unique local certificate for each device.

You can also use SCEP to configure the device to automatically obtain local certificate 
(and a CA certificate) from the CA directly.
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To send a certificate request prompt to the managed device, right-click the device and 
select Certificates > Generate Certificate Request. Enter the following information:

• Name. Enter the name of the certificate requestor; typically, this is the person 
who administrators the NetScreen FW/VPN device.

• Phone. Enter the telephone number of the certificate requestor.
• Unit/Department. Enter the unit or department of the certificate requestor.
• Organization. Enter the organization of the certificate requestor.
• County/Locality. Enter the county or locality of the certificate requestor.
• State. Enter the state of the certificate requestor.
• Country. Enter the country of the certificate requestor.
• E-mail. Enter the email address of the certificate requestor.
• IP Address. Enter the IP address of the certificate requestor.
• FQDN. Enter the fully-qualified domain name of the NetScreen FW/VPN 

device.
• Key Pair Type. Select RSA or DSA encryption.
• Key Pair Length. Select the key length: 512, 786, 1024, or 2048. Ensure that 

your Certificate Authority can support the key length you select. Key lengths 
greater than 1024 might require generation times longer than 10 minutes.

• Automatically Enroll. Enable this option to use SCEP. The device 
automatically requests, receives, and installs the local certificate and the CA 
certificate locally. To use SCEP, configure the following defaults:

– Certificate Authority. Select a preconfigured CA or use the default CA 
settings for the device.

– E-mail request to. Provide the email address that receives the PKCS#10 
file, which defines the syntax for certification requests.

Click OK to send the request prompt to the device. A Job Manager window appears to 
display job information and job progress. When the job is complete, the device public key 
appears in the Job window:

• If you are using SCEP, the device automatically sends its public key to the CA 
directly. Close the job window.

• If you are obtaining the local certificate manually, you need this information to 
give to the CA. Copy and paste the information from the job window to a text file, 
or simply leave the job window open.
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After you prompt the device to generate the certificate request, the device creates the 
public/private key pair that is used to create the local certificate and returns the public 
key to the management system (the private key never leaves the device). During this 
time, the certificate status is key pair, meaning that a key pair exists but no certificate 
has been loaded. 
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After you obtain the local certificate, load the certificate into the management system 
using the NetScreen-Security Manager UI, and install the certificate on the device, the 
certificate is known as active. To view the current status of your certificate requests, open 
the device configuration and select VPN Settings > Local Certificates.

• Before the certificate is fulfilled, the certificate status appears as key pair, 
indicating a public/private key pair exists but the certificate file does not yet 
exist on both the physical device and the management system.

• After the certificate is fulfilled, the certificate status appears as active, 
indicating that the certificate file has been successfully installed on both the 
physical device and the management system.
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If you used SCEP for automatic enrollment, the device contacts the specified CA and 
obtains a local and CA certificate. After the device has installed the certificate, refresh the 
NetScreen-Security Manager device configuration for that device to view the new 
certificate information:

1. Right-click the device and select Certificates > Refresh Local Certificates. This 
directive uses the information on the physical device to refresh the information 
on the management system.

2. Open the device configuration to view the local certificates in VPN Settings > 
Local Certificates. The certificate status appears as active, indicating that the 
certificate file has been successfully installed on both the physical device and the 
management system.
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If you did not use SCEP, you must manually contact your CA and use the device public 
key to create a local device certificate. After you have obtained the local certificate (.cer) 
file from your CA, install that certificate on the device: 

1. Right-click the device and select Certificates > Update Fulfilled Certificate. This 
directive uses the information in the management system to update the 
information on the physical system.

2. Load the certificate file and click OK to install the local certificate on the device.

A Job Manager window appears to display job information and job progress. 
When the job is complete, close the Job Manager window.

3. To view local certificate, open the device configuration and select VPN Settings > 
Local Certificates. The certificate status appears as active, indicating that the 
certificate file has been successfully installed on both the physical device and the 
management system.

Note: Any time you need to move information from the physical device to the management 
system, you are using a Refresh directive; when you need to move information from the 
management system to the physical device, you are using an Update directive.
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A CA certificate validates the identity of the CA that issued the local device certificate. 
You can obtain a CA certificate file (.cer) from the CA that issued the local certificate, then 
use this file to create a Certificate Authority object.

You must install this CA certificate on the managed device using NetScreen-Security 
Manager before you can use certificate to validate that device in your VPN. Because the 
CA certificate is an object, however, you can use the same CA for multiple devices, as long 
as those devices use local certificates that were issued by that CA.

You can also use SCEP to configure the device to automatically obtain a CA certificate at 
the same time it receives the local certificate. For details on configuring a certificate 
authority object, see Chapter 7, “Configuring Objects”.

The following sections detail how to add a CA certificate to a device using SCEP or 
manually.
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If you used SCEP to obtain a local certificate for the device, the CA certificate was 
automatically downloaded and installed on the device at the same time as the local 
certificate. However, because the management system does not know about the CA 
certificate, you must refresh the CA information:

1. Right-click the device and select Certificates > Refresh CA Certificates. This 
directive uses the information on the physical device to refresh the information 
on the management system.

2. Open the device configuration to view the CA certificates in VPN Settings > CA 
Certificates.
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If you did not use SCEP, you must manually contact your CA, obtain a CA certificate, and 
create a Certificate Authority Object. Then, add the CA certificate to the device and 
install it on the device: 

1. Open the device configuration and select VPN Settings > CA Certificates. Click 
the Add icon and add the Certificate Authority object. Close the device 
configuration.

2. Right-click the device and select Certificates > Update CA Certificate. This 
directive uses the information in the management system to update the 
information on the physical system. A Job Manager window appears to display 
job information and job progress.

3. When the job is complete, close the Job Manager window.

To view CA certificate, open the device configuration and select VPN Settings > CA 
Certificates.
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A Certificate Revocation List (CRL) identifies invalid certificates. You can obtain a CRL 
file (.crl) from the CA that issued the local certification and CA certificate for the device, 
then use this file to create a Certificate Revocation List object.

You must install the CRL on the managed device using NetScreen-Security Manager 
before you can use a CRL to check for revoked certificates in your VPN. Because the CRL 
is an object, however, you can use the same CRL for multiple devices, as long as those 
devices use local and CA certificates that were issued by that CA. After you have received 
a CRL, you can use the CRL object in your VPN. For details on configuring a certificate 
revocation list object, see Chapter 7, “Configuring Objects”.

You must manually contact your CA, obtain a CRL, and create a Certificate Revocation 
List Object. Then, add the CRL to the device and install it on the device: 

1. Open the device configuration and select VPN Settings > CRLs. Click the Add 
icon and add the Certificate Revocation List object. Close the device 
configuration.

2. Right-click the device and select Certificates > Update CRL. This directive uses 
the information in the management system to update the information on the 
physical system. A Job Manager window appears to display job information and 
job progress.

3. When the job is complete, close the Job Manager window.

To view CRL, open the device configuration and select VPN Settings > CRL.
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If you have imported a NetScreen FW/VPN device that already has a local certificate, CA, 
and CRL, these objects are automatically imported when you add that device to the 
NetScreen-Security Manager system. Imported objects use the default name of 
<CN>_<timestamp.

However, to reuse the CA and CRL objects in other NetScreen FW/VPN devices, you must 
load the CA and CRL file directly into the management system: 

• To load a CA file (.cer) into the management system, open the imported CA 
object in Object Manager and use the Load Certificate option. After loading the 
CA, verify the status of the certificate appears as Loaded.

• To load a CRL file (.crl) into the management system, open the imported CRL 
object in Object Manager and use the Load CRL option. After loading the CRL, 
verify the status of the CRL appears as Loaded.

After the CA certificate and CRL files have been loaded, you can use those CA and CRL 
objects in other devices.
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You can configure default PKI settings for each FW/VPN device that define how that 
device handles certificates. When configuring a VPN that includes the device, you can use 
these default settings.

In device configuration tree, select VPN Settings > Defaults > PKI Settings to display the 
default PKI settings. First, configure the source interface for PKI Traffic. The source 
interface is the interface on the device that sends the certificate request to the CA. 
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Configure the following X509 certificate settings:

• Email Destination for the PKCS#10 File. Provide the email address that 
receives the PKCS#10, which defines the syntax for certification requests.

• Enable raw common name. 
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Revocation settings define how and when certificates are revoked. You might want to 
revoke a certificate that you suspect has been compromised or when a certificate holder 
leaves a company. You can revoke the certificate manually, or use CRL or OCSP to 
automatically check for revoked certificates.

• X.509 Certificate Path Validation Level. X509 contains a specification for a 
certificate which binds an entity’s distinguished name to its public key through 
the use of a digital signature.

– Full. Use full validation to validate the certificate path back to the root.
– Partial. Use partial validation to validate the certificate path only part of 

the way to the root.
• Revocation Check. 

– Check for revocation. Select this option to enable revocation checking.
– Do not check for revocation. Select this option to disable revocation 

checking.
• Revocation Checking Method. If you enabled revocation checking, you can 

select the checking method to use. If you did not enable revocation checking, 
these fields are unavailable.

– CRL. Use a Certificate Revocation List when you want to keep a local copy 
of the revoked certificates on the managed device. This method enables 
you to check for revoked certificates quickly.

– OSCP. Use the Online Certificate Status Protocol when you want the 
managed device to access a remote OCSP server to check for revoked 
certificates. Because the OCSP server dynamically updated their list of 
revoked certificates, this method provides the most up-to-date 
information.
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• Best Effort. Enable this option to check for revocation accept the certificate if 
no revocation information is found.

• CRL Settings. Configure the default setting for the Certificate Revocation List.
– URL address. Provide the URL address of your internal LDAP server that 

provides the CRL.
– LDAP server. Provide the IP address of the external LDAP server that 

manages the CRL.
– Refresh Frequency. Select the frequency that the device contacts the CA to 

obtain a new CRL list: Daily, Weekly, or Monthly.
• OCSP. Configure the Online Certificate Status Protocol to dynamically check 

for revoked certificates. 
– Certificate Verification. 
– No revoke status check for CA delegated signing cert. 
– URL of OCSP Responder. Provide the URL address of the OCSP server.
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Alternatively, you can use Simple Certificate Enrollment Protocol (SCEP) to get a local 
certificate automatically. To enable SCEP for a managed device, configure the default PKI 
settings for SCEP:

• CA CGI. Enter the URL address of the Certificate Authority Certificate 
Generation Information.

• RA CGI. Enter the URL address of the Registration Authority Certificate 
Generation Information that the NetScreen FW/VPN device contacts to request 
a CA certificate.

• CA IDENT. Enter the name of the certificate authority to confirm certificate 
ownership.

• Challenge. Enter the challenge word(s) sent to you by the CA that confirm the 
FW/VPN device identity to the CA.

• CA Certificate Authentication. 
– Auto. 
– Manual. 

• Polling Interval. 
– Poll. When enabled, you can configure the number of minutes between 

polls.
– Do not poll. Use this option to disable automatic polling.

• Certificate Renewal. Define the number of times a certificate can be renewed.
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An NSRP cluster consists of a two NetScreen FW/VPN devices that enforce the same 
Security Policy and share the same configuration settings. When you assign a FW/VPN 
device to an NSRP cluster, any changes you make to the configuration on one member of 
the cluster propagate to the other. Members of the same NSRP cluster maintain identical 
settings for policies and policy objects (such as addresses, services, VPNs, users, and 
schedules) and system parameters (such as settings for authentication servers, DNS, 
SNMP, syslog, etc.).

Before two NetScreen FW/VPN devices can provide redundant network connectivity, you 
must group them in the same NSRP cluster by assigning a cluster ID between 1 and 7. 
When you add a NetScreen FW/VPN device into an NSRP cluster, the device 
automatically becomes a member of Virtual Security Device (VSD) group 0 and all its 
interfaces become Virtual Security Interfaces (VSIs) for VSD group 0.

In an NSRP cluster, one device acts as a master and the other as its backup:

• In active/passive configurations, the master handles all firewall and VPN 
activities while the backup waits to take over when the master steps down. You 
can configure the cluster in active/passive operation when the interfaces are in 
transparent, NAT, or route mode:

– Transparent Mode. When interfaces are in Transparent mode, the device 
operates at Layer 2. The security zone interfaces do not have IP addresses, 
and the NetScreen FW/VPN device forwards traffic like a Layer 2 switch. 
To manage a backup device, you use the manage IP address that you set 
on the VLAN1 interface.

– NAT or Route Mode. When interfaces are in NAT or Route mode, the 
NetScreen FW/VPN device operates at Layer 3 in the OSI model. The 
security zone interfaces have IP addresses, and the device forwards traffic 
like a Layer 3 router. To manage a backup device, you must use the 
manage IP address that you set per security zone interface; you cannot set 
a manage IP address on a VSI for any VSD group except VSD group 0.

• In active/active configurations, you create two virtual security devices (VSD) 
groups for the cluster: One device acts as the master of one VSD group, while the 
other device acts as the backup for the same group. In the other VSD group, the 
device roles are reversed: Each device is the master of one VSD group and the 
backup in the other VSD group. You can configure the cluster in active/active 
operation when the interfaces are in NAT or route mode. The NetScreen FW/
VPN device operates at Layer 3 in the OSI model. The security zone interfaces 
have IP addresses, and the device forwards traffic like a Layer 3 router. To 
manage a backup device, you must use the manage IP address that you set per 
security zone interface; you cannot set a manage IP address on a VSI for any 
VSD group except VSD group 0.
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Because of the sensitive nature of NSRP communications, you can secure all NSRP traffic 
through encryption and authentication. For encryption and authentication, NSRP 
supports the DES and MD5 algorithms respectively. However, if the HA cables run 
directly from one NetScreen FW/VPN device to another (that is, not through a switch 
forwarding other kinds of network traffic), it is unnecessary to use encryption and 
authentication.

In addition to NSRP clusters, which propagate configurations among group members and 
advertise each members’ current VSD group states, you can configure the devices as 
members in an RTO mirror group, which maintains the synchronicity of run-time objects 
(RTOs) between a pair of devices. When the master steps down, the backup can 
immediately assume mastership with minimal service downtime by maintaining all 
current sessions.

For more detailed explanations of NSRP, see the “NSRP” volume in the NetScreen 
Concepts & Examples ScreenOS Reference Guide for ScreenOS 4.0.0 or the “High 
Availability” volume in the NetScreen Concepts & Examples ScreenOS Reference Guide for 
ScreenOS 5.x.
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To create an NSRP cluster, either by importing or modeling, first add the cluster to 
NetScreen-Security Manager. In the Device Manager, click the Add icon and select 
Cluster. Follow the directions in the Add Device wizard to add the cluster. When you 
select the device model and ScreenOS version, remember that all devices in a cluster must 
be the same device model and run the same ScreenOS version.

Next, add devices to the cluster: Right-click the cluster and select New > Cluster Member. 
Follow the directions in the Add Device wizard to import or model the cluster member.

Finally, configure the cluster and the cluster members (you must configure cluster 
members from within the cluster itself). To configure a cluster member, open the Cluster 
device configuration and select Members in the Cluster navigation tree. Double-click the 
cluster member you want to configure to open its device configuration, then make your 
changes.

Although you can leave many of the default NSRP configuration values, you must set 
the cluster ID, which is automatically set to 0 for both imported and modeled 
clusters:

1. In the cluster navigation tree, select NSRP to display the NSRP General tab.
2. Set the cluster ID as desired. By default, when you add a modeled cluster 

member or import an existing cluster member, the cluster ID is set to 0. To 
change the cluster ID, enter a new number. You can also configure other NSRP 
link settings in this screen.

3. Use the RTO Mirror and VSD Group Info tabs to configure other settings, as 
desired.

4. Click OK to save your changes to the cluster.
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Most settings entered on one device in a cluster propagate to the other device, however, 
some configurations, such as setting NSRP authentication and encryption passwords, do 
not propagate. If you are using NSRP authentication and encryption passwords in the 
cluster, you need to configure the same information on all devices in the cluster. 

For step-by-step instructions on adding member devices to a cluster, see the Online Help 
topic “Configuring NSRP Clusters”.

For more information about configurations that do not propagate, see the “NSRP” volume 
in the NetScreen Concepts & Examples ScreenOS Reference Guide for ScreenOS 4.0.0 or 
the “High Availability” volume in the NetScreen Concepts & Examples ScreenOS 
Reference Guide for ScreenOS 5.x.
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To ensure continuous traffic flow, you can enable and configure two NetScreen FW/VPN 
devices in a redundant cluster, with one device acting as a master and the other as its 
backup. The master propagates all its network and configuration settings and the current 
session information to the backup. Should the master fail, the backup is promoted to 
master and takes over the traffic processing.

By default, the two cluster members are configured as active/passive after you add them 
to the cluster object. NetScreen-Security Manager automatically creates VSD group 0 and 
transforms physical interfaces into Virtual Security Interfaces (VSIs) for VSD group 0.

To configure an active/passive cluster, you must:

1. Cable two NetScreen FW/VPN devices together.
2. Set the cluster ID.
3. Enable automatic RTO synchronization
4. Select the ports that you want the devices to monitor, so that if they detect a loss 

of network connectivity on one of the monitored ports, the device fails over.
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In this example, you want to configure two NetScreen-208 FW/VPN devices, Corporate A 
and Corporate B, in an NSRP cluster. Both device are running ScreenOS 5.x. Using a 
cable, connect the ethernet7 interfaces of both devices, then use another cable to connect 
the ethernet8 interfaces. Next, add the cluster and cluster member to NetScreen-Security 
Manager. When the devices become members of the NSRP cluster, the IP addresses of 
their physical interfaces automatically become the IP addresses of the Virtual Security 
Interfaces (VSIs) for VSD group ID 0. Each VSD member has a default priority of 100, the 
device with the higher unit ID becomes the VSD group master.

Finally, configure the cluster:

• Bind ethernet7 and ethernet8 to the HA zone. By default, ethernet8 is bound to 
the HA zone, so you only need to bind it to the HA zone if you have previously 
bound it to a different zone. 

• Set manage IP addresses for the Trust zone interfaces on both devices.
• Assign the Cluster ID.
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• Configure monitoring on ethernet1 and ethernet3, so that loss of network 
connectivity on either of those ports triggers a device failover.

• Enable automatic synchronization of RTOs.

1. Create the Cluster:

a. In the navigation tree, select Device Manager > FW/VPN Devices. Click 
the Add icon and select Cluster. Configure the Cluster as shown below:

b. Add the following two cluster members to the cluster: Corporate A, 
Corporate B. Choose Model when adding each device.

2. Configure the HA interfaces for the cluster.

a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet7. The General Properties screen appears.

b. For Zone, select HA, then click OK to save your changes.
c. Double-click ethernet8. The General Properties screen appears.

Cluster ID 1

Untrust Zone

Trust Zone
VSD Group 0
Untrust Zone VSI: 210.1.1.1
Trust Zone VSI: 10.1.1.1

BA

Master (A)
(Unit ID: 1684080)

Untrust Interface: ethernet1

Physical IP: 210.1.1.1/24

Trust Interface: ethernet3

Physical IP: 10.1.1.1/24

Manage IP: 10.1.1.20

HA Interfaces: ethernet7 
and ethernet8 (No IP 
Addresses Required)

Backup (B) 
(Unit ID: 1032544)

Untrust Interface: ethernet1

Physical IP: 210.1.1.1/24

Trust Interface: ethernet3

Physical IP: 10.1.1.1/24

Manage IP: 10.1.1.21

HA Interface: ethernet7 and 
ethernet8 (No IP Addresses 
Required)
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d. Ensure that the zone name HA, then click OK to save your changes.
3. Configure the Untrust interface for the cluster:

a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet1. The General Properties screen appears.

b. For Zone, select Untrust.
c. For IP address and netmask, enter 210.1.1.1/24.
d. Click OK to save your changes.

4. Configure the Trust interface for the cluster:

a. In the cluster navigation tree, select Network > Interface. Double-click 
ethernet3. The General Properties screen appears.

b. For Zone, select Trust.
c. For IP address and netmask, enter 10.1.1.1/24.
d. Ensure that the interface mode is NAT, then click OK to save your 

changes.
e. Click Apply to apply all previous changes to the cluster members.

5. Configure the Manage IP and Monitoring for Corporate A:

a. In the cluster navigation tree, select Members. Double-click Corporate A 
to open its device configuration. 

b. In the device navigation tree, select Network > Interface and double-click 
ethernet 3. The General Properties screen appears.

c. For Manage IP, enter 10.1.1.20, then click OK to save your changes.
d. In the device navigation tree, select Monitoring > Whole Box Monitoring, 

then select the Monitor Interface tab.
e. Click the Add icon to display the new monitor interface dialog box. Select 

ethernet1, leave the default weight of 255, and click OK to save your 
changes.

f. Click the Add icon to display the new monitor interface dialog box. Select 
ethernet3, leave the default weight of 255, and click OK to save your 
changes.

g. Click OK to close the device configuration for Corporate A.
6. Configure the Manage IP for Corporate B:

a. In the cluster navigation tree, select Members. Double-click Corporate B 
to open its device configuration.

b. In the device navigation tree, select Network > Interface and double-click 
ethernet 3. The General Properties screen appears.

c. For Manage IP, enter 10.1.1.21, then click OK to save your changes.
d. In the device navigation tree, select Monitoring > Whole Box Monitoring, 

then select the Monitor Interface tab.
e. Click the Add icon to display the new monitor interface dialog box. Select 

ethernet1, leave the default weight of 255, and click OK to save your 
changes.
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f. Click the Add icon to display the new monitor interface dialog box. Select 
ethernet3, leave the default weight of 255, and click OK to save your 
changes.

g. Click OK to close the device configuration for Corporate B.
7. Configure the NSRP settings:

a. In the cluster navigation tree, select NSRP. 
b. For NSRP Cluster ID, select 1.
c. Enable RTO Sync.

8. Click OK to save your changes to the cluster and cluster members.
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On a NetScreen FW/VPN device in Route or NAT mode, you can configure both devices in 
a redundant cluster to be active, sharing the traffic distributed between them by routers 
with load-balancing capabilities running a protocol such as the Virtual Router 
Redundancy Protocol (VRRP). 

Using NSRP, you create two virtual security devices (VSD) groups, each with its own 
virtual security interfaces (VSIs). For example, Device A acts as the master of VSD group 
1 and as the backup of VSD group 2. Device B acts as the master of VSD group 2 and as 
the backup of VSD group 1. Devices A and B each receive 50% of the network and VPN 
traffic. Should device A fail, device B becomes the master of VSD group 1, as well as 
continuing to be the master of VSD group 2, and handles 100% of the traffic. 

Although the total number of sessions divided between the two devices in an active/active 
configuration cannot exceed the capacity of a single NetScreen FW/VPN device 
(otherwise, in the case of a failover, the excess sessions might be lost), the addition of a 
second device doubles the available bandwidth potential. A second active device also 
guarantees that both devices have functioning network connections.

To configure an active/active cluster, you must configure a second VSD group:

1. Double-click the cluster to open the cluster configuration. In the cluster 
navigation tree, select Members.

2. In the VSD definitions area, click the Add icon to display the Add VSD dialog 
box.

3. Select a value other than 0, then click OK to save the new VSD. The VSD you 
added appears in the VSD Definitions list.

4. Click Ok to save your changes to the cluster.
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After you add new members to an NSRP cluster, you must synchronize the configuration 
and files from one device to another.

To synchronize configurations:

1. In the Device Manager, double-click the cluster to open the cluster 
configuration.
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2. In the cluster navigation tree, select NSRP Directives > Flash Sync.
3. Select the device that will be used to synchronize the other device and click 

Perform Sync. The device that has been synchronized is automatically rebooted 
to activate the new configuration.

4. Click OK to save your changes to the cluster.

After synchronizing the configurations and files, you can then synchronize the run-time 
objects (RTOs). RTOs are code objects created dynamically in memory during normal 
operation. Some examples of RTOs are session table entries, ARP cache entries, DHCP 
leases, and IPSec security associations (SAs). In the event of a failover, the new master 
must maintain the current RTOs to avoid service interruption.

To ensure session backup, the members of an NSRP cluster backup the RTOs using an 
RTP mirror group. An RTO mirror group is two NetScreen FW/VPN devices that pass 
RTOs unidirectionally from a sender to a receiver. You can also create a second mirror 
group (with a different group ID from the first group) for the same devices but reverse the 
roles of sender and receiver. Working together, each member backs up the RTOs from the 
other, which permits RTOs to be maintained should the master of either VSD group in an 
active/active HA scheme step down.

After you add the cluster members, you can configure the RTO synchronization to enable 
each member to send and receive RTOs. However, by default, NSRP cluster members do 
not synchronize their configurations before synchronizing RTOs; before enabling RTO 
synchronization, you must first synchronize the configurations between the cluster 
members. Unless the configurations on both members in the cluster are identical, RTO 
synchronization might fail.
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If necessary, for troubleshooting or maintenance, you can force a device to assume a new 
mode (backup or primary) in a specified VSD group. To do this:

1. In the Device Manager, double-click the cluster to open the cluster 
configuration.

2. In the cluster navigation tree, select NSRP Directives > Exec Mode.
3. Select the device that will assume a new role, then click Exec Mode. The Mode 

Selection dialog box appears.
4. Select the mode (backup or primary) that the device is to assume. 
5. Click OK to save your changes.



NetScreen-Security Manager 2004 FP2 263

.
���������

5�-�!�*�2,3! ,.

���0<
���<�"���'

• About Updating

• Knowing When to Update

• Using Preview Tools

• Performing an Update

• Tracking Device Updates

This chapter details how to update the running configuration (the configuration on the 
FW/VPN device) with the modeled configuration (the configuration in the Juniper 
Networks NetScreen-Security Manager UI). In addition to covering the basic update 
process, this chapter also details the events that can require you to update your device, as 
well as NetScreen-Security Manager tools that help you to track, verify, and preview the 
update process.

After you model or make changes to a device configuration in the NetScreen-Security 
Manager UI, you must install that device configuration on the physical Juniper Networks 
NetScreen FW/VPN device before those changes can take effect. For devices running 
ScreenOS 5.x, NetScreen-Security Manager supports atomic configuration, a fail-safe 
feature that ensures successful updates occur without errors or the update is not 
performed. Atomic configuration is always enabled and occurs automatically when a 
device update causes the device to lose its connection to the management server.
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When you updated a managed device, you are modifying the running device configuration 
(the configuration currently installed on the physical device) with the modeled device 
configuration (the configuration currently modeled in NetScreen-Security Manager).

You can update a single device, multiple devices, vsys devices, clusters, and/or device 
groups simultaneously. For example, if you have created a device group that includes only 
NetScreen-5GT devices, you can update the entire device group in a single update 
procedure. During the update, NetScreen-Security Manager displays the progress of the 
update on each individual device so you can see exactly what is happening. Simultaneous 
updating also reduces downtime to unaffected devices and areas of your network.

Updating a device is a simple three-step process: 

1. Ensure that you have configured the device correctly, created and assigned a 
policy to the device, and have established a connection between the device and 
the management server. 

2. From the menu bar, select Devices > Configuration > Update Config. NetScreen-
Security Manager displays the Update Devices dialog box. 

3. Select the devices or device groups you want to update and click OK. NetScreen-
Security Manager updates the selected devices or device groups with the 
modeled configuration.

NetScreen-Security Manager uses centralized control and tracking to indicate when you 
need to update a device, and to follow the progress of the device configuration you are 
updating. Some useful tools for tracking. Before updating your managed devices, you can 
use other NetScreen-Security Manager modules and tools to identify devices that need to 
be updated, validate their modeled configurations, and preview how those devices accept 
the new configuration. After updating, you can use those same tools to verify a successful 
update. These tools include:

• Audit Log Viewer. This NetScreen-Security Manager module records changes 
made to a device configuration. The audit log entry also details the 
administrator performed the change, when the change was updated on the 
device, and a history of change details. 

• Report Manager. This NetScreen-Security Manager module collects data from 
traffic logs on various events that occur over your network and provides a visual 
representation of them. You can customize reports to display and filter 
parameters.

• Configuration Summaries. These tools provide a preview of the modeled 
configuration, enabling you to compare it with the configuration that is running 
on the device. Use configuration summaries to ensure the modeled configuration 
is consistent with what you want to update on the device. 

Note: Although atomic configuration provides fail-safe methods of protecting 
your ScreenOS 5.x devices from invalid configurations, you should be 
confident about the modeled configuration before updating the device.
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• Job Manager. This NetScreen-Security Manager module tracks the status of 
running and completed update processes. The Job Manager displays details of 
the update process in a dedicated information window and includes the update’s 
success or failure and errors involved in a failed update.
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The lifecycle of the update process:

1. The managed device is functioning normally. You have successfully added the 
device to NetScreen-Security Manager, reviewed the device configuration, and 
updated the device. Suddenly, an event occurs on the managed device that 
requires a change to the device configuration. For example, malicious traffic 
might have entered your network, causing you to update the Security Policy for 
the device to detect and prevent that attack.

2. You locate the cause of the event. Using NetScreen-Security Manager modules 
such as the Realtime Monitor and Log Viewer, you determine the exact attack 
that penetrated the device. From the Report Manager, you also determine what 
rule in the Security Policy was ineffective in blocking the attack. You then 
update the modeled device configuration, editing the Security Policy to detect 
and prevent the attack from entering your network again.

3. Before updating the running configuration, you review the modeled device 
configuration. Using a delta configuration summary, compare the modeled 
configuration with the running configuration on the device to confirm the 
differences. Fine-tune the modeled configuration, if needed.

4. When you are confident that the modeled configuration is valid, update the 
device. NetScreen-Security Manager updates the running configuration with 
only the new changes (delta). during the update, you track the update progress 
using Job Manager. In the job information window, you can track the progress of 
the update real-time and observe the transfer of the configuration from 
NetScreen-Security Manager to the device. 

If the update is unsuccessful, use the information in the Job information window 
to correct the problems in the modeled configuration.

5. After updating, run a second Delta Configuration Summary to identify any 
remaining differences between the modeled configuration and the running 
configuration on the device. When the Delta Configuration Summary reveals no 
differences between the new configuration and the old configuration on the 
device, you have successfully updated the running configuration.
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NetScreen-Security Manager uses atomic configuration, a fail-safe feature for NetScreen 
FW/VPN devices running ScreenOS 5.x. Atomic configuration ensures a current valid 
configuration is not overwritten by a flawed configuration in flash memory. The update 
must complete without errors, or the update is aborted to prevent an invalid, error-prone, 
or flawed configuration to install on the device. 
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Atomic configuration is always on. During an update:

1. NetScreen-Security Manager saves and locks the active configuration on the 
device, then starts a timer for the update process. While the active configuration 
is locked, it cannot be saved.

2. NetScreen-Security Manager sends the modeled configuration to the device. 
3. The device receives the modeled configuration and attempts to update its 

existing active configuration with the new commands:
– If the entire modeled configuration (all commands) is accepted by the 

device, NetScreen-Security Manager unlocks the active configuration, 
updates it with the new commands in the modeled configuration, and 
saves the new active configuration. 

– If an error occurs during the update process, NetScreen-Security Manager 
resets the device, unlocks the active configuration, and restores the saved 
active configuration to the device.

4. If an invalid command in the modeled configuration causes the device to lose 
communication with NetScreen-Security Manager, the timer expires and the 
device automatically resets (NetScreen-Security Manager unlocks the active 
configuration, and restores the saved active configuration to the device.

Note: When updating vsys devices, atomic configuration occurs only for the root vsys.
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You might need to update a device configuration for one or more reasons. Typically, you 
update a device after changing the device configuration or after modifying the policy that 
is assigned to the device.

• To overwrite changes made to the device, update the physical device with the 
modeled configuration in NetScreen-Security Manager.

• To keep the changes made to the device, update NetScreen-Security Manager 
with the active configuration on the physical device. Currently, NetScreen-
Security Manager does not support updates from the device; to import the 
running configuration (configuration installed on the physical device), you must 
delete the device from the management system and re-import it. For details on 
re-importing a device, see “Managing the Device” on page 51.

Using NetScreen-Security Manager, you can identify the changes made to the device or to 
the modeled configuration, then update the device. For significant changes to the network 
that the FW/VPN device is deployed in, you might also need to change the assigned policy. 

Check the following areas to detect configuration or policy changes:

• Verifying Device Status
• Reviewing Logs
• Identifying Administrative Changes
• Reviewing Reports
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Within the management system, a managed device has an associated connection state and 
configuration state.

The connection state indicates the status of managed device–Device Server connection. 
Using heartbeat packets to continually test the connection between the Device Server and 
the physical device, NetScreen-Security Manager displays the connection state for each 
managed device in RealTime Monitor > Device Monitor. The connection status column 
displays the current status of the device:

• Up status indicates the device is connected to the Device Server and is running 
properly. Before you can update a device, it must be in the Up state. 

• Down status indicates that an event has occurred, either manually by an 
administrator or automatically by the flow of a type of traffic, that has stopped 
the device from running.

• Never Connected status indicates that the device has not made an initial 
connection to Device Server. Typically, this state appears for modeled devices 
that have not been activated, or for devices waiting to be activated using Rapid 
Deployment.

The configuration state indicates the status of the device configuration on the physical 
device. Some common configuration states include:
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• Managed indicates that the running configuration is the same as the modeled 
configuration (the device is using a “managed” configuration).

• Modeled indicates that the running configuration is not the same as the 
modeled configuration, and that the device has not yet connected to NetScreen-
Security Manager.

• Import Needed indicates that the running configuration is not the same as the 
modeled configuration, but the device has connected to NetScreen-Security 
Manager and is awaiting manual import (this configuration status occurs only 
when adding devices running ScreenOS 5.x to the management system).

• Update Needed indicates that the running configuration is not the same as the 
modeled configuration, and that the device is connected to NetScreen-Security 
Manager. You must update the managed device before the changes you made in 
the modeled configuration can take effect. 

For details on the all connection and configuration states, see “Viewing Device Status” on 
page 489. An example of connection and configuration status in the Realtime Monitor is 
shown below: 

For more details on using the Device Monitor, see Chapter 10, “Monitoring”.
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The Log Viewer can help you identify event patterns on your network. To clarify the 
pattern in the Log Viewer, create a custom view using filters that display log entries 
based on specific criteria. To set a column or cell filter, right-click the column or cell that 
you want to use as the matching criteria and specify the value.

For example: 

• To track all events for a specific time period, create a filter on the timestamp 
column; when applied, the filter displays only the log entries that meet the 
specified time period.

Configuration Status Connection Status
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• To track all events from a specific source IP address, create a filter on source 
address column; when applied the filter displays only the log entries that use the 
specified source address.

• To track all events for a specific category or subcategory of log entries, such as 
Configuration or Attack log entries, create a filter on the category or subcategory 
column; when applied the filter displays only the log entries with the specified 
category or subcategory designation.

For more details on using the Log Viewer, see Chapter 11, “Logging”. For step-by-step 
instructions on creating a filter, see the Online Help topic “Setting Filters”.

�(���
��
���*(+
�
�����
����<�����
Use the Audit Log Viewer to identify administrative changes made to your managed 
devices. Audit log entries also detail the administrator who made the change, the action 
performed, and the date and time of the change. You can track changes by time of logging, 
administrator name, action, targets, and devices. If an administrator made a change to a 
device or an object, you might want to update the affected devices. 

For details on using the Audit Log Viewer, see Chapter 11, “Logging”.
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Use Report Manager to determine when you are receiving too many attacks of a certain 
type and order them by an IP address. For example, if you determine that the current 
device configuration and Security Policy cannot block scans, you might want to create a 
new rule in the Security Policy that guards against those attacks, then update the device.

Report Manager provides three reports based on three different criteria: time-based 
reports, event-based reports, and severity-based reports. 

• To identify common events, select an event-based report to see the frequency of 
events in bar graph or pie chart. To see details for a specific event, right-click the 
event and select View in Log Viewer to display a custom view in a new window. 
You can save a detailed view as a custom report. For example, when viewing the 
Top Alarms, expand a location to view the data that makes up this location.

• To examine how specific rules in your Security Policy are performing, select the 
Administrative > Top Rules report. You might need to fine-tune an inefficient 
rule to better handle events in your network traffic.

For details on using Report Manager, see Chapter 12, “Reporting”.
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When you update a managed device, you are overwriting the existing configuration that is 
running on the physical device. Although you can use domain rollback to recover from 
invalid configurations, ideally, you should verify a configuration before sending it to the 
device. 

Using preview tools, you can preview how the modeled configuration looks in CLI 
command form to predict the success of the update and anticipate errors. NetScreen-
Security Manager supports three types of preview tools:

• Configuration Summary displays the modeled configuration using ScreenOS 
CLI commands.

• Delta Configuration Summary displays the modeled configuration and 
running configuration using ScreenOS CLI commands, and lists the differences 
between the two configurations.

• Running Config displays the configuration installed on the physical device.

The configuration and delta configuration summaries help you ensure that the modeled 
configuration is correct before you update your managed devices, while the running config 
helps you identify settings already on the managed device.
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When you update a managed device using NetScreen-Security Manager, the management 
system generates ScreenOS CLI commands that map to the settings in the NetScreen-
Security Manager UI. To verify the configuration you are installing on the device 
generates the correct CLI commands, run a configuration summary.

1. From the file menu, select Devices > Configuration > Summarize Config. 
NetScreen-Security Manager displays the Get Configuration Summary dialog 
box.

2. Select the devices or device groups for which you want to run a Configuration 
Summary and click OK. A Job Information window appears to help you track the 
progress of the summary.

3. When the job completes, review the CLI commands in the Job Information 
window. When you update the device, these are the commands that NetScreen-
Security Manager uses to overwrite the running configuration.

For some settings, the CLI commands for a UI settings do not map one-to-one. For 
example, a single vsys configuration in the NetScreen-Security Manager UI generates 
multiple ScreenOS commands.

Because the management system generates all information (UI settings and CLI 
commands) for a configuration summary, you can run a configuration summary on a 
modeled device (the device does not need to physically exist).
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A Delta Configuration Summary compares the active configuration on the device with the 
modeled configuration in NetScreen-Security Manager and displays the differences 
between the two configurations. The Delta Configuration Summary produces four sets of 
data.

You should run a Delta Configuration Summary two times: 

• Before updating. Because you are overwriting the running configuration with 
the modeled configuration, you might want to identify and verify the 
configuration you are installing on the device.

• After updating. Ensure that the device received the configuration as you 
expected, and that no differences exist between the running configuration and 
the modeled configuration.

Delta configuration summaries are helpful tools for ongoing device maintenance too, 
particularly for devices that are managed locally by a device administrator using CLI 
commands or the WebUI and remotely by a NetScreen-Security Manager administrator 
using the NetScreen-Security Manager UI. Because the modeled configuration can 
overwrite the running configuration, you should always confirm the commands that are 
sent to the device.

To run a Delta Configuration Summary:

1. From the file menu, select Devices > Configuration > Summarize Delta Config. 
NetScreen-Security Manager displays the Get Delta Config Summary dialog 
box.

2. Select the devices or device groups for which you want to run a Delta Config 
Summary and click OK. A Job Information window appears to help you track the 
progress of the summary.

Delta Config Data Description

Config on Device but not 
on NSM

Displays the CLI commands detected on the device that do not 
map to NetScreen-Security Manager settings. Use this 
information to identify any out-of-band updates (made by the 
local device admin) to the running configuration; you might not 
want to overwrite these settings. 

Config on NSM but not on 
Device

Displays the CLI commands (as mapped to NetScreen-Security 
Manager settings in the modeled configuration) detected in 
NetScreen-Security Manager but not on the device. Use this 
information to identify the changes you have made to the 
modeled configuration since the last update.

Config on both NSM and 
Device but reordered

Displays the CLI commands for configuration settings present on 
both the device and NetScreen-Security Manager, but the CLI 
command sequence has been reordered.

Config to be sent to device 
on next Update Device

Displays the CLI commands that NetScreen-Security Manager 
will send to the device on the next update.
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3. When the job completes, review the CLI commands in the Job Information 
window. Specifically, review the commands in the section “Config to be sent to 
device on next Update Device”; when you update the device, these are the 
commands that NetScreen-Security Manager uses to overwrite the running 
configuration.
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An example Delta Configuration Summary is shown below:

Commands for 
objects already 
configured on 
the device

Commands for 
Objects configured in 
NetScreen-Security 
Manager.

Commands on the 
device and 
NetScreen-Security 
Manager that have 
been reordered.

Commands to 
send during the 
next update. 
These commands 
overwrite the 
active 
configuration
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You can update a single device, multiple devices, or device groups using the same process:

1. Before updating:
– Ensure that you have configured the device correctly, created and 

assigned a policy to the device, and have established a connection between 
the device and the management server.

– Run a Configuration Summary on the device to view the CLI commands 
for the modeled configuration. Review these commands to ensure that you 
have configured the device as desired.

– Run a Delta Configuration Summary to view the differences between the 
modeled configuration and the running configuration in CLI command 
format.

2. Update the device:

a. From the menu bar, select Devices > Configuration > Update Config. 
NetScreen-Security Manager displays the Update Devices dialog box.

b. Select the devices or device groups you want to update and click OK. 
NetScreen-Security Manager begins updating the selected devices or 
device groups with the modeled configuration.

3. After updating:
– Review the information in the Job Information window to determine if the 

update was successful.
– NetScreen-Security Manager automatically runs a Delta Configuration 

Summary after a successful update. Review the summary to ensure that 
no conflict exist between the running configuration and the modeled 
configuration.

For details on tracking update status, see the next section, “Tracking Device Updates” on 
page 275. For details on troubleshooting failed updates, see “Understanding Updating 
Errors” on page 277.
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Use Job Manager to track device updates in real-time. You can view the status of a 
running update and the status of completed updates.
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When you send a command to a device or group of devices using NetScreen-Security 
Manager, the management system creates a job for that command and displays 
information about that job in the Job Information window. The command you send the 
device is called a directive; Job Manager tracks the progress of the directive as it travels to 
the device and back to the management system. Each job contains:

• Name of the command
• Date and time the command was sent
• Completion status for each device that received the command
• Detailed description of command progress
• Command output, such as a configuration list or CLI changes on the device

You can initiate directives from multiple locations in the NetScreen-Security Manager UI, 
including the Devices and Tools menus in the NetScreen-Security Manager toolbar (to 
access the Update directive, from the file menu, select Devices > Configuration > Update 
Device Configuration). 

The Job Manager module is shown below:

Job Manager includes the following utilities and information:

• View Controls. Use View controls to set the information level you want 
displayed in Job Manager: 

– Expand All displays all devices undergoing tasks associated with a 
directive type.

– Collapse All displays the directive type.

Job Management

Job Type List
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• Job Type (Directive) List. Displays the job type (directives) and associated 
time stamp completion status information. All current and completed jobs 
appear, including device updates. However, if you have not yet performed an 
update using NetScreen-Security Manager, the Job List does not display an 
Update Configuration directive.

• Notification Controls. Enables you to manually view job completion status.
• Job Information. Enables you to view various types of job information 

including errors, job completion status, job state, automatic job completion 
notification setting, and start time of job.
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The Job Information dialog box displays the changing device states as the directive is 
executed. Device state changes, error messages, and warning messages are displayed in 
real-time. An example Job Information dialog box is shown below:

Job Manager tracks the overall progress of one or more jobs executed on a single device. 
For multiple device updates, Job Manager tracks the progress of each job on each device 
in addition to the overall progress for all devices. To view the Job status for an individual 
device (including error messages and percent complete), select the device in the Percent 
Complete pane; the status appears in the Output pane.

The Job Information includes:

• Job Type. The type of task being tracked. Job Types include Update Device, 
Reboot Device, Config Summary, etc. Job Type is also known as a directive.

• Time Stamp. The time that NetScreen-Security Manager began executing the 
directive.

• Job Status. The current state of the job. 

Number of Jobs 
Completed

Percent Complete

Device Name

State Description

Output Display
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• Number of Jobs Completed. The number of jobs completed out of the total 
number of jobs.

• Percent Complete. The percentage of total jobs successfully executed. When 
performing multiple jobs on multiple devices, this number displays the 
percentage complete for each device. When the job has completed, successfully or 
unsuccessfully, the percent complete displays 100 percent.

• Device Name. The name of the device on which the job is executed.
• State Description. The current state of the job. 
• Completion Level. The percentage of the total job that has executed 

successfully.
• Output. Displays content of the update, including commands that have been 

interpreted from the NetScreen-Security Manager data model into ScreenOS 
commands, error messages, and existing commands deleted from the device. The 
Output Display Region displays all errors, warnings, device verification output, 
and device state information associated with the job. 
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During an update, the managed device changes device state. You can view the current 
device state in real-time in the State Description field of the Job Information dialog box. A 
device can have the following states:

The update process for devices running ScreenOS 4.0.x or ScreenOS 5.x is identical.
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When an update fails for any reason, Job Manager displays error codes and error 
messages that can help you identify and locate the problem. Typical errors include:

Device State Description

None No update activity has occurred on the device.

Loading in Progress NetScreen-Security Manager is sending the update image into 
the Flash memory of the device.

Pending Device is accepting the parameters from the update configuration 
that has been sent to the device Flash memory.

Converting Data Model 
to Device Data Model

The parameters that have been set in the NetScreen-Security 
Manager configuration are being changed to corresponding 
ScreenOS CLI commands that execute on the device.

Completion Device has successfully been updated with the modeled 
configuration.

Failed Device has not been successfully updated with the modeled 
configuration. The Output pane of the Job Manager dialog box 
displays error messages and error codes.
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• The modeled configuration contained invalid values that the device could not 
process.

• During the update process, the connection between the managed device and the 
Device Server was lost. 

• The modeled configuration caused the managed device to lose its connection to 
NetScreen-Security Manager. For these update errors, the Job Information 
dialog box displays the Job Status as “Failed.”

You can also check the Connection Status and Configuration Status columns for the 
device in the Realtime Monitor to determine if the device is running. 

After a device is updated, NetScreen-Security Manager automatically runs a Delta 
Configuration Summary to determine any remaining differences between the modeled 
configuration and the running configuration; the output of this summary appears in the 
Job Manager information window. For successful updates, no discrepancies are found or 
displayed. For failed updates, the output area lists remaining discrepancies.

For example, a failed update job is shown below:

In the Output area of this job, the update:

• Successfully removed existing commands on the device (Generating 
Removing CLI Commands)

• Unsuccessfully added new commands that were not present in the running 
configuration. (Generated 5 Delta Config CLI Commands). 
Specifically, the update could not set the command: pppoe name untrust 
clear-on-disconnect

The Delta Config Summary correctly detected a difference between settings on the 
managed device and settings in NetScreen-Security Manager. This error might be the 
result of a disabled command, possibly disabled by another NetScreen-Security Manager 
administrator or a local device administrator. 

Error Code

Error Message

Inactivated 
Command

Failure Indicator

New Commands 
updated on the Device

Operation Type

Commands Deleted 
from Device
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• Managing Device Firmware Version

• Managing License Keys

• Activating Subscription Services

• Updating the Attack Database

• Updating AV Pattern Files

• Miscellaneous Device Operations

• Managing Device Capabilities

• Archiving and Restoring

This chapter describes device management tasks you might need to perform in specific 
situations, such as upgrading the ScreenOS version on your devices, obtaining and 
activating a Deep Inspection subscription, and handling an RMA device in the NetScreen-
Security Manager UI. 

This chapter also provides details on how the components of the NetScreen-Security 
Manager management system handle device capabilities, and how device configuration 
settings are imported and updated. This material is provided for reference only, and does 
not contain specific configuration tasks. 
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You can use Juniper Networks NetScreen-Security Manager to upgrade the firmware on a 
device running ScreenOS 4.0.x. or 5.0.x. However, NetScreen-Security Manager does not 
support firmware downgrades; you cannot use NetScreen-Security Manager to install an 
earlier version of Juniper Networks NetScreen ScreenOS firmware than is currently 
running on the device. You must use the WebUI or ScreenOS CLI commands to 
downgrade a managed device, then re-add the device to NetScreen-Security Manager.
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To upgrade the firmware, first download the new firmware image file to your computer. 
Next, use the Firmware Manager in NetScreen-Security Manager to copy the image file to 
the GUI Server, where it is permanently stored, then select the devices and the firmware 
image files you want to use to upgrade the device. During the upgrade, the GUI Server 
copies the image file to the Device Server, where the image file is stored temporarily until 
the upgrade is complete. After the firmware has been successfully installed, the device 
automatically reboots.

When upgrading multiple device types, ensure that you have loaded the same ScreenOS 
version of the image file for each type of device on the Device Server. For example, you can 
upgrade the firmware on a NetScreen-208, a NetScreen-50, and a NetScreen-5XP at the 
same time, but the image files for each device type must exist on the Device Server and 
must be the same ScreenOS version.

To upgrade firmware on FW/VPN devices that are currently running ScreenOS 4.0.x, you 
must install a TFTP server on the NetScreen-Security Manager Device Server. The 
Device Server uses TFTP to upload the firmware onto ScreenOS 4.0.x devices. For more 
information, see the NetScreen-Security Manager 2004 Installer’s Guide.

The Automate ADM Transformation option allows the Abstract Data Model (ADM) for the 
device to automatically update when the firmware is uploaded. If you deselect this option, 
the firmware is uploaded onto the device, but you will not be able to manage the device 
from the UI until the ADM for the device is updated. For example, you can deselect this 
option to first verify that the device is properly operating with the uploaded firmware 
before allowing it to be managed from the NetScreen-Security Manager UI. You will later 
need to reconcile the firmware that you uploaded on the device with the ADM, as 
described in “Adjusting Device Firmware Version” on page 283. For more information 
about the ADM and NetScreen-Security Manager components, see “Managing Device 
Capabilities” on page 292.

For step-by-step instructions on upgrading a device, see the Online Help topic, 
“Upgrading Firmware on Devices.”

Note: Do not change the name of the image file. The name of the image file must be 
exactly the same as the filename that you download from Juniper Networks, for 
example, ns5xp.4.0.3r2.0.
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When importing or updating devices, NetScreen-Security Manager alerts you if it detects 
a mismatch between the firmware running on the managed device and the firmware that 
NetScreen-Security Manager has recorded for the device. 

Firmware mismatches can occur when:

• A device administrator changes the firmware on the device using the WebUI or 
CLI commands (through a console, Telnet, or SSH session).

• The Automate ADM Transformation option in the Firmware Update Availability 
dialog box was deselected during a firmware upgrade by NetScreen-Security 
Manager. (See “Upgrading Device Firmware Version” on page 282.)

To reconcile the firmware versions, right-click a device and select Adjust OS Version to 
display the Adjust OS Version Wizard. Follow the directions in the wizard. For step-by-
step instructions on upgrade a device, see the Online Help topic, “Adjusting the Firmware 
Version on Devices.” 
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Some NetScreen FW/VPN devices support the activation of optional features or the 
increased capacity of existing features through the installation of license keys.
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The procedure for obtaining a license key is as follows:

1. Contact the value-added reseller (VAR) who sold you the NetScreen FW/VPN 
device, or contact Juniper Networks directly.

2. Provide the serial number of your device and state the feature option you want. 
The license key is generated and then sent to you via email.

To install the license key on a device:

1. Right-click a device from the FW/VPN Device Tree or the FW/VPN Device List 
tab in the Device Manager and select Admin > Install License Key. The Install 
License Key dialog box appears.

2. Either copy and paste the license key into the dialog box, or click the Browse 
button to locate the license key file on your computer.

3. Click OK.
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To see which license keys are installed on a device, and the features and capacities 
available on the device:

1. Right-click a device from the FW/VPN Device Tree or the FW/VPN Device List 
tab in the Device Manager and select Admin > Get License Key Info.

2. Click Yes at the confirmation dialog box. The Job Information window displays 
the license key information.
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To use some Juniper Networks services, such as internal AV or Deep Inspection Signature 
Service, you must activate on the device by first registering the device, then obtaining the 
subscription for the service. Even though devices with bundled AV services come with a 
temporary, pre-installed subscription, you must register your product and retrieve the 
subscription to receive your full paid subscription.

To register your product, go to www.juniper.net/support. After you have registered your 
product, you can retrieve the service subscription as described in the following section.

To obtain the subscription for a service:

1. From the menu bar, select Devices > Entitlement > Get Entitlement. The Get 
Entitlement dialog box appears.

2. Select the device(s) or group of devices for which you want to retrieve a 
subscription.

3. Click OK. The Job Information window displays the status of the subscription 
retrieval.
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Deep Inspection is an attack detection mechanism that checks traffic permitted by the 
NetScreen FW/VPN device for known and unknown attacks. The attack object database 
stored on the device contains predefined attack objects, organized into attack object 
groups by protocol and severity level; these attack objects are used to detect known attack 
patterns and protocol anomalies within network traffic.

�"(��
����<��*����$��%@����/���%���
You can update the attack object database on the NetScreen FW/VPN device by 
downloading new attack objects from the attack object database server. To perform the 
update however, you must first:

• Obtain a DI subscription. To access this server, you must first obtain a Deep 
Inspection (DI) subscription for your NetScreen FW/VPN device. For more 
information, see “Activating Subscription Services” on page 285.

• Configure the device. After you have obtained a DI subscription, configure the 
device to contact the attack object database server at https://
services.netscreen.com/restricted/sigupdates (see Chapter 4, “Configuring 
Devices”).

Finally, to update the attack object database on a device:

1. From the menu bar, select Devices > Deep Inspection > Update Attack 
Database. The Update Attack Database dialog box appears.

2. Select the device(s) or group of devices to be updated.
3. Click OK. The Job Information window displays the status of the update.
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You can check if the attack object database on the server is more recent than the one on 
the NetScreen FW/VPN device. This can help you determine if you need to update the 
database.

To check the attack object database version:

1. From the menu bar, select Devices > Deep Inspection > Check Attack Database 
Server Version. The Check Attack Database Server Version dialog box appears.

2. Select the device(s) or group of devices to be checked.
3. Click OK. The Job Information window displays the status of the version check.
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Some NetScreen FW/VPN devices provide antivirus (AV) scanning for specific application-
layer transactions using an internal AV scanner developed by Trend Micro. The internal 
AV scanner references a virus pattern file to identify virus signatures. As new viruses 
emerge, the pattern file on the device needs to be updated.

To update the AV pattern file for a device:

1. From the menu bar, select Devices > AV Scan Manager > Update Pattern. The 
Update Pattern dialog box appears.

2. Select the device(s) or group of devices to be updated.
3. Click OK. The Job Information window displays the status of the update.
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This section describes other device management tasks that you can perform using the 
NetScreen-Security Manager UI.
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You can restart one or more selected devices, or a group of devices. To restart one or more 
devices:

1. From the menu bar, select Devices > Reboot Device. The Reboot Device(s) dialog 
box appears.

2. Select the device(s) or the group of devices to be restarted.
3. Click OK. The Job Information window displays the status of the restart.
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To enable a NetScreen FW/VPN device to use Domain Name System (DNS) to resolve 
domain names to IP addresses, you configure the IP addresses of the primary and 
secondary DNS servers on the device. The device can automatically refresh entries in its 
DNS table by checking them with the specified DNS server at regularly scheduled times 
or intervals, or after an HA failover (see Chapter 4, “Configuring Devices”).

You can also manually direct the device to refresh its DNS table entries. When you direct 
the device to refresh its DNS entries, it connects to the previously-configured DNS server 
to perform a lookup of each entry in its table.

To direct one or more devices to refresh their DNS table entries:

1. Select DNS > Refresh DNS Entries from the Devices menu. The Refresh DNS 
Entries dialog box appears.

2. Select the device(s) or the group of devices on which DNS tables should be 
refreshed.

3. Click OK. The Job Information window displays the status of the refresh.
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The NetScreen FW/VPN device can use the Network Time Protocol (NTP) to synchronize 
its system clock with a configured NTP server over the Internet. You can configure the 
device to perform this synchronization automatically at specific time intervals (see 
Chapter 4, “Configuring Devices”), or you can direct the device to synchronize its clock 
immediately to a previously-configured NTP server, as described in the following steps.

To direct one or more devices to synchronize their clocks:

1. From the menu bar, select Devices > NTP > Perform NTP Time Update. The 
Perform NTP Time Update dialog box appears.

2. Select the device(s) or group of devices that should be synchronized with NTP 
servers.
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3. Click OK. The Job Information window displays the status of the 
synchronization.
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All NetScreen FW/VPN devices ship with the same default login and password for the root 
administrator. Because these default settings known, you should change the login and 
password for the root administrator as soon as possible and as often as necessary.

Each NetScreen FW/VPN device can have only one root administrator, who has the 
following privileges:

• Manages the root system of the NetScreen FW/VPN device
• Adds, removes, and manages all other administrators
• Establishes and manages virtual systems, and assigns physical or logical 

interfaces to them
• Creates, removes, and manages virtual routers
• Adds, removes, and manages security zones
• Assigns interfaces to security zones
• Performs asset recovery
• Sets the device to FIPS mode
• Resets the device to its default settings
• Updates the firmware
• Loads configuration files

After you change the root administrator login and password, only persons who know the 
new login and password can log into the device and perform the tasks listed above. 

To configure the login and password for the root administrator for a FW/VPN device:

1. In Device Manager, right-click a device icon select Admin > Set Root Admin. The 
Set Root Admin dialog box appears for the device.

2. Enter the new name in the Administrator Name field.
3. Enter the new password in the Password field and then re-enter the same 

password in the Confirm Password field.
4. Click OK.

For more details on managing device administrators, including the root administrator, 
see “Configuring Device Administrators” on page 211.
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Some NetScreen FW/VPN devices support port modes that bind a second backup interface 
to the Untrust zone. For these port modes, the backup interface is used only when there is 
a failure on the connection through the primary interface or when you manually force 
traffic from the primary interface to the backup.

To force a FW/VPN device to fail over to the backup interface:
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1. Right-click a device from the FW/VPN Device Tree or the FW/VPN Device List 
tab in the Device Manager and select Admin > Failover. The Failover Action 
dialog box appears.

2. Click Force to Failover.
3. Click OK.

To force a FW/VPN device to revert back to the primary interface:

1. Right-click a device from the FW/VPN Device Tree or the FW/VPN Device List 
tab in the Device Manager and select Admin > Failover. The Failover Action 
dialog box appears.

2. Click Force to Revert.
3. Click OK.
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If you need to send a device back to the factory and replace it with a new device, you can 
set the device to the RMA state. This state allows NetScreen-Security Manager to retain 
the device configuration without a serial number or connection statistics. When you 
install the replacement device, all you need to do is activate the device with the serial 
number of the replacement unit.

In the RMA state, the device object is functionally identical to a modeled device, but its 
status is “RMA” in the Device Monitor.

To set a device to the RMA state:

1. Right-click a device from the FW/VPN Device Tree or FW/VPN Device List tab in 
the Device Manager and select RMA Device. The Confirm RMA Device dialog 
box appears.

2. Click OK. In the Device Monitor window, the device status is RMA.

When the replacement device is installed, activate the device with the serial number of 
the replacement. For information about activating a device, see Chapter 3, “Adding 
Devices”.
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To troubleshoot BGP peer configurations, you can connect and disconnect BGP 
connections to a specific neighbor. You can also test the TCP connection to a specific 
neighbor. To perform these tests, you need to have configured a virtual router and the 
BGP dynamic routing protocol on the device, and enabled BGP on the virtual router and 
on the interface to the BGP neighbor.

Note: The replacement device must be the same platform and ScreenOS version as the 
unit that is being replaced. Setting the RMA state cannot be undone.
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To connect or disconnect to a BGP peer:

1. Right-click a device from the FW/VPN Device Tree or FW/VPN Device List tab in 
the Device Manager and select Admin > Modify BGP Peer Session. The Modify 
BGP Peer Session dialog box appears.

2. Select the virtual router in which the BGP configuration resides.
3. Select the peer to which you want to connect or disconnect from the list of 

configured BGP neighbors.
4. Select Connect to establish a BGP connection to the selected peer, Disconnect to 

terminate the BGP connection to the selected peer, or TCP Connect to test the 
TCP connection to the selected peer.

5. Click OK.
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To display the CLI configuration commands for a device, right-click a device from the FW/
VPN Device Tree or FW/VPN Device List tab in the Device Manager and select Admin > 
Show Device Commands.
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To locate groups, vsys, policies, and VPNs in which a specific device is referenced, right-
click a device from the FW/VPN Device Tree or FW/VPN Device List tab in the Device 
Manager and select Find Usages. The Find References box appears.

Note: This task is only applicable to added NetScreen FW/VPN devices running 
ScreenOS 4.x with dynamic IP addresses.
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This section presents a detailed description of how NetScreen-Security Manager 
components enable you to add, configure, update, and manage NetScreen FW/VPN 
devices. The illustration below is an overview of the components and how they interact 
with each other. A description of each component follows.

*%�������/�����(� 
The Abstract Data Model (ADM) is an XML file that contains configuration data for all 
objects in a specific domain. The ADM is stored in the GUI Server, but you do not access 
the ADM directly. When you create, update, or import a device, the GUI Server edits the 
ADM to reflect the changes. The Management console uses the ADM to determine the 
current options, fields, screens, and data range to display in the UI for each object.
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A Data Model (DM) is an XML file that contains configuration data for an individual 
device. The DM is stored in the Device Server. When you create, update, or import a 
device, the GUI Server edits the ADM to reflect the changes, then translates that 
information to the DM.
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The structure of the ADM and DM is determined by the Data Model (DM) schema. The 
DM schema reads from a device capability file to determine the supported features for the 
ScreenOS version that is running on the managed devices. A device capability file lists the 
fields and attributes that a specific ScreenOS version supports.

Your network may contain similar NetScreen FW/VPN devices that are running different 
ScreenOS versions. For example, a NetScreen-5XT may run ScreenOS 5.x, which supports 
the Routing Information Protocol (RIP), while another NetScreen-5XT runs ScreenOS 
4.0.0r2, which does not support RIP. The DM schema links to the appropriate device 
capability file for each device.

Device capability files make it easier to integrate devices into NetScreen-Security 
Manager and also make upgrading the software on your NetScreen FW/VPN devices 
easier. Each software release includes device capability files that describe the new and 
changed fields, attributes, and allowable ranges of values.
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Data Model update is the process of translating the objects and object attributes in the 
ADM domain into individual DMs with device-specific configuration information.

In the ADM, objects are arranged similarly to objects in the management console: each 
item (VPN, policy, device, device group, etc.) is represented by an object. In the DM, each 
item is a property of a single device. During the data model update process, the GUI 
Server identifies the objects that contain properties for a device, and translates those 
object properties into properties of that device.

When you update a device configuration using the management console, the GUI Server 
translates the objects and object attributes in the ADM domain into device configuration 
information in a DM. The Device Server then translates the device configuration 
information in the DM into CLI commands and sends the commands to the device.
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For example: The ADM contains a VPN with tunnel interfaces, a routing table, and users. 
When you update a selected device, the DM update identifies the devices that are involved 
in the VPN and creates interfaces, routing tables, users, VPN policies, etc. in the DM for 
each device. The DM contains only the VPN information that relates to the specific device, 
not the entire VPN.

During the device model update process:

• The GUI Server translates the object and object attributes in the ADM domain 
into device configuration information in a DM.

• The Device Server translates the device configuration information in the DM 
into CLI commands.

• The Device Server sends the CLI commands to the device.
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Data Model Import (DM import) is the process of translating the device-specific 
configuration information in individual DMs into the objects and object attributes in the 
ADM domain.

When you import a device configuration using the management console, the device sends 
CLI commands to the Device Server, which translates the CLI commands into a DM with 
device configuration information. The GUI Server then translates the device 
configuration in the DM into objects and object attributes in the ADM, and uses the ADM 
to display current information in the management console.
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During the device model import process:

• The device sends CLI commands to the Device Server, which translates the CLI 
commands into a DM with device configuration information.

• The GUI Server translates the device configuration in the DM into objects and 
object attributes in the ADM.

The GUI Server then reads the ADM and displays the current information.
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You can archive and restore log and configuration data in NetScreen-Security Manager 
using standard Unix commands. Logs reside on the Device Server; all other configuration 
information, including device configuration data, administrators, policies, audit logs, and 
job information resides on the GUI Server.

Before archiving, you must stop the processes running on both servers, then use the “ls -
al” command to identify the actual paths of the GUI Server and Device Server data 
directories:

• For all information on the GUI Server: /usr/netscreen/GuiSvr/var
• For all information on the Device Server: /usr/netscreen/DevSvr/var

These directories are links representing the paths that were entered at the time the 
servers where installed.

After archiving, restart the processes on both servers. For details on stopping, starting, 
and restarting processes on the management system, refer to the NetScreen-Security 
Manager 2004 Installer’s Guide.

*��<
�
���;������(�����
�	���
���/���
To archive log and configuration data:

1. Stop the Device Server and the GUI Server.
2. Use the "ls -al" command to discover the actual paths of the GUI Server and 

Device Server data directories. These are the directories you need to back up. 

For example:

ls -al /usr/netscreen/GuiSvr/var
lrwxrwxrwx 1 root root 21 Feb 25 16:04 /usr/netscreen/
GuiSvr var -> /var/netscreen/GuiSvr

The output in the example indicates that the actual location of the GUI Server 
data is in /var/netscreen/GuiSvr. On your own system, verify where your data is 
stored and which directories should be backed up. Follow the same procedure to 
determine the location of your data on the Device Server.

3. Run the appropriate backup command on your Solaris or Linux platform to 
backup the GUI Server data. For example: 

tar -cvf /netscreen_backup/db-date.tar /var/netscreen/
GuiSvr

4. Run the appropriate backup command on your Solaris or Linux platform to 
backup the Device Server data. 

For a large amount of log data, using tar may not be appropriate. Juniper 
Networks recommends using Secure Copy (scp) or File Transfer Protocol (FTP) 
to backup the Device Server data. 

Example using scp:
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scp -r <local directory> usr@host:<remote-directory>

Example using FTP:

ftp <host name>
bi
hash
lcd <local directory>
prompt
mput

5. Start GUI Server and Device Server processes.
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These instructions apply only to systems where the var directory links point to a true 
location outside the prescribed locations (e.g., /usr/netscreen/GuiSvr or /usr/netscreen/
DevSvr). Juniper Networks recommends that you do not set these links to point to 
locations that are inside /usr/netscreen/GuiSvr or /usr/netscreen/DevSvr; doing so can 
complicate upgrades to NetScreen-Security Manager and requires special precautions 
during backup and restore procedures.

To restore log and configuration data:

1. Stop Device Server and GUI Server processes.
2. Use the mv command to transfer data from the var directories to a safe location. 

This precaution clears the var directory for restoration of the backups. 
3. Untar your backups into both of the locations described above.
4. Start GUI Server and the Device Server processes.
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• About Objects

• Configuring Address Objects

• Configuring Schedule Objects

• Configuring Attack Objects

• Configuring AntiVirus Objects

• Configuring GTP Objects

• Configuring Service Objects

• Configuring Authentication Servers

• Configuring User Objects

• Configuring IP Pools

• Configuring Group Expressions

• Configuring Remote Settings

• Configuring NAT Objects

• Configuring Certificate Authorities

• Configuring Certificate Revocation Lists

• Configuring Protected Resources

• Configuring IKE Proposals

Objects represent reusable information, such as network addresses, individual users and 
user groups, and commonly used configuration data. In Juniper Networks NetScreen-
Security Manager, objects are shared objects, meaning they are shared between the global 
domain and all subdomains. 

Objects are the building blocks of the NetScreen-Security Manager management system. 
You can use an object multiple times in the same domain. For example, you can create an 
address object to represent a host such as an individual workstation, then use the address 
object in a VPN protected resource and as the source or destination in a firewall or 
multicast rule.
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Objects created in the global domain are available in all subdomains, but objects created 
in a subdomain are only available in that subdomain. 

When creating a VPN:

• You can use a global domain user object in a subdomain VPN.
• You can use a subdomain user object in a subdomain VPN.
• You cannot use a subdomain user object in a global domain VPN. 

When creating a subdomain protected resource, you can include a subdomain address 
object and a global domain service object, but you can only select the protected resource 
when you are logged in to that specific subdomain.
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The Juniper Networks NetScreen-Security Manager UI groups most objects under Object 
Manager, and the VPN-related objects under VPN Manager. 

Use Object Manager to view, add, edit, and delete the following objects:

• Network and Address Translation:
– Address Objects represent individual hosts or subnetworks in your 

network.
– NAT Objects (DIP, MIP, VIP) represent references to device-specific NAT 

configurations (dynamic IPs, mapped IPs, and virtual IPs), enabling 
multiple devices to share a single object.

– IP Pools define ranges of IP addresses used to assign an IP address to a 
RAS user.

– Remote Settings represents DNS and WINS servers.
• Services and Schedules:

– Schedule Objects represent time periods and determine when a rule is in 
effect.

– Service Objects represent predefined and custom network services, such as 
HTTP/80.

• Application Layer Protection:
– Attack Objects represent signature patterns and service contexts for 

known attacks.
– AV Objects define the server that contains your virus definitions and 

AntiVirus software.
• Users and Authentication:

– User Objects represent RAS users on your network.
– Authentication Servers represent the servers in your network used to 

authenticate NetScreen-Security Manager admins, RAS users, and 
network traffic.
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– Group Expressions define logical expressions used to include or exclude 
RAS users.

• Certificates:
– Certificate Authority Objects represent the certificate authority’s 

certificate.
– CRL Objects represent the certificate authority’s certificate revocation 

list.
• VoIP Protection:

– GTP Objects represent client GTP configurations.

Use VPN Manager to view, add, edit, and delete the following objects:

• Protected Resources represent the network component, a network service, 
and the NetScreen FW/VPN device that protects that component and service. 

• IKE Phase1 Proposals represent the phase1 proposals used to establish a 
secure and authenticated communication channel between two VPN members.

• IKE Phase2 Proposals represent the Security Associations for services (such 
as IPsec) that require key material and/or parameters, as exchanged by two 
VPN members.
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If you already have objects defined in your existing Juniper Networks NetScreen-Global 
PRO management system or on the device itself, you can import those objects into 
NetScreen-Security Manager. When importing device configurations and their domains 
from Global PRO, NetScreen-Security Manager also imports all objects that are defined 
for those domains. During this import process, NetScreen-Security Manager determines if 
the object is accessible by a single domain or accessible by all domains.
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An address object is a representation of a component of your network, such as a 
workstation, router, switch, subnetwork, or any other object that is connected to your 
network. You use address book objects in NetScreen-Security Manager to specify the 
network components you want to protect:

• Firewall Rules. Use address objects or groups to specify the source and/or 
destination of network traffic.

• Multicast Rules. Use multicast group address objects to specify the destination 
of multicast traffic.

• VPNs. Use address objects or groups to create Protected Resources for your 
Policy-Based and Mixed-Mode VPNs.

9
�#
���*((������%@����
In the navigation tree, click Object Manager > Address Objects to view all address objects 
for the current domain. You can display Address objects in a tree or table format:

• The Address Tree tab displays address objects in a tree format. To view the 
members of an Address Object group, click the group to display a member list.

• The Address Table tab displays address objects in a table format with the 
following columns:

– Name. Name of the address object
– Type. Type of the address object (Host, Network, Group)
– IP/Domain Name. The IP address or host name (such as 

www.netscreen.com) of the address object
– Netmask. Netmask of the address object
– Comment. A description of the address object

When you initially deploy the NetScreen-Security Manager system and open the UI for 
the first time, the Address Object tree and table tabs are empty. Using the Object 
Manager, you can create Address Objects that represent network components that are 
unique to your network. As you add the address objects, they appear in the both the tree 
and table tabs.
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You can create the following address objects: 

• Host. Represents components, such as workstations, connected to your network.
• Network. Represents divisions or subnetworks in your network.
• Address Object Group. Represents multiple address objects.
• Multicast Group. Represents the destination of multicast packets. 

The following sections detail each Address Object type.
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To add a host address object:

1. In the navigation tree, open the Object Manager and select Address Objects. The 
address object tree appears.

2. In the main display area, click the add icon and select Host.
3. Enter a name for the address object.
4. Select a color to represent the address object.
5. Enter a Comment about the host.
6. Enter the address that identifies the host on your network:

– To identify the host with an IP address, select IP and enter the IP address 
of the host. Click Resolve to automatically resolve the domain name for 
that IP address.

– To identify the host with a domain name, select Domain Name and enter 
the domain name of the host. Click Resolve to automatically resolve the IP 
address for that domain name.

7. Click OK to add the address object.

The new host address object immediately appears in the Address Tree and Address Table.
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To add a network address object:

1. In the navigation tree, open the Object Manager and select Address Objects. The 
address object tree appears.

2. In the main display area, click the add icon and select Network.
3. Enter a name for the address object.
4. Enter the IP address and netmask of the network.
5. Select a color to represent the address object.
6. Enter a Comment about the network.
7. Click OK to add the address object.

The new network address object immediately appears in the Address Tree and Address 
Table.
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To simplify your Security Policies, you can combine multiple address objects in an address 
object group. An address object group can contain address objects (and other address 
object groups) from current subdomain and the global domain.

To add an Address Object Group:

1. In the navigation tree, open the Object Manager and select Address Objects. The 
address object tree appears.

2. In the main display area, click the add icon and select Group.
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3. Enter a name for the group. 

4. Select a color to represent the group.
5. Enter a Comment about the group.
6. In the Non-members list, select the address objects you want to include in the 

group (hold down Ctrl to select multiple address objects):
– If you are in the global domain, only the global address objects appear in 

the non-members list.
– If you are in a subdomain, both global and subdomain address objects 

appear in the non-members list.
7. Click Add. The selected address objects now appear in the member list.
8. Click OK to add the group.

You can create address object groups with existing users or create empty address object 
groups and fill them with users later.
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To add a multicast group address object:

1. In the navigation tree, open the Object Manager and select Address Objects. The 
address object tree appears.

2. In the main display area, click the add icon and select Multicast Group. The New 
Multicast Group dialog box appears.

3. Enter a name for the multicast group address. 

4. Select a color to represent the multicast group address.
5. Enter a Comment about the multicast group address.
6. Enter the IP address of the multicast group.
7. Click OK to add the multicast group address.

Note: Address Object group names must be unique; you cannot name an 
address object group the same name as an existing address object.

Note: Multicast Group Address Object names must be unique; you cannot 
name a multicast group address object the same name as an existing 
multicast group address object.
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A schedule object defines a time interval that a firewall rule is in effect. You use a 
schedule object in your firewall rule to determine when a device enforces that rule: 

• Use a one-time schedule to control access to a destination for a specific time 
interval. The schedule object defines a start time, end time, and date during 
which a rule is enforced. Some examples: 

– Contractor Access Schedule (8:30 AM December 1 to 6:00 PM December 5)
– Christmas Break Schedule (6:00 PM December 24 to 8:00 AM January 2)

• Use a recurring schedule to control access to a destination for a repeating time 
interval. The schedule object defines a start time, end time, and days during 
which a rule is enforced. Some examples:

– Business Hours Schedule (8:00 AM to 6:00 PM on Monday, Tuesday, 
Wednesday, Thursday, Friday)

– After Hours Schedule (6:01 PM to 7:59 AM on Monday, Tuesday, 
Wednesday, Thursday, Friday, Saturday, Sunday)

– Weekend Schedule (8:00 AM to 6:00 PM on Saturday, Sunday)
• Combine a one-time and recurrent schedule to define a repeated time interval. 
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To add a schedule object:

1. In the navigation tree, open the Object Manager and select Schedule Objects. 
The schedule object tree appears.

2. In the main display area, click the add icon.
3. Enter a name and comment for the schedule object.
4. Select the frequency of the schedule:

– To configure a one-time schedule, select Once, and enter the Start Date, 
Start Time, Stop Date, and Stop Time.

– To configure a recurrent schedule, select Recurrent, and click the Add 
icon. In the Recurrent Schedule dialog box, select the day of the week and 
specify the hour and minutes for Start 1 and Stop 1. 

To specify a second recurring time interval on the same day, specify the 
hour and minutes for Start 2 and Stop 2. Ex. Business Hours Schedule 
(8:00 to 12:00 and 13:00 to 17:00 every weekday).
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Attack objects contain attack patterns for known attacks that attackers can use to 
compromise your network. Attack objects don’t work on their own—they need to be part of 
a rule before they can start detecting known attacks and preventing malicious traffic from 
entering your network.

To use attack objects in your firewall rules, enable Deep Inspection in the Rule Option 
column of a firewall rule. Deep Inspection is supported by NetScreen-5GT devices, the 
NetScreen-HSC, and all devices running ScreenOS 5.x.

You can view, edit, and create attack objects. You might want to view an attack object to 
find out more about the attack it detects and the signature it uses. Or, you might want to 
edit the context of an attack object that is producing too many false positives on your 
network. Maybe you heard about some new virus or Trojan that is sweeping the Internet 
and you want to create a custom signature to detect it as it enters your network.
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NetScreen-Security Manager supports two types of attack objects:

• Signature Attack Objects
• Protocol Anomaly Attack Objects

In a Security Policy, you can select the attack objects that a device uses to detect attacks 
against your network. If an attack is detected, the device generates an attack log entry 
that appears in the Log Viewer. For more details on configuring Deep Inspection in a 
firewall rule, see “Configuring Attack Protection” on page 365; for details on attack log 
entries, see “Deep Inspection Alarm Log Entries” on page 534.

The following sections detail each attack object type.
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Attack objects detect known attacks using attack signatures. An attack signature is a 
pattern that always exists within an attack; if the attack is present, so is the attack 
signature. NetScreen-Security Manager uses stateful signatures to detect attacks. A 
stateful signature is a signature that not only knows the pattern it is attempting to find, 
but also knows where to look for that pattern. Stateful signatures produce very few false 
positives because they understand the context of the attack and can eliminate huge 
sections of network traffic they know the attack won’t be in.

Stateful signatures are much smarter than regular signatures: they know the protocol or 
service used to perpetrate the attack, they know the direction and flow of the attack, and 
they know the context in which the attack occurs. Obviously, though, a signature can’t 
contain all this information within the attack signature pattern—the data must be 
associated with the signature, but not actually part of the pattern itself. NetScreen does 
this by combining the attack pattern with service, context, and other information into a 
neat little package called an attack object.
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Signature attack objects can only detect known attacks, because a pattern needs to be 
created before it can be matched. Thus, signature attack objects do not detect new attacks 
or attacks that resist characterization. However, NetScreen-Security Manager features 
Protocol Anomaly Detection using protocol anomaly attack objects to find unknown or 
sophisticated attacks that violate protocol specifications. Protocol Anomaly Detection 
works by comparing traffic to what is not considered harmful from a protocol perspective. 
Security Policy rules with protocol anomaly attack objects match on traffic that does not 
conform with RFCs and common RFC extensions.
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NetScreen-Security Manager includes predefined attack object groups that you can use in 
Security Policies to match traffic against known attacks. You can also create custom 
attack objects and attack object groups to detect attacks specific to your network.
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In Object Manager, click Predefined Attack Objects to display the list of predefined attack 
objects that represent known and unknown attack patterns. The Attack Object Tree tab 
(default view) is useful for viewing the membership of attack groups. To display all 
members of an attack group, double-click the group.

The Attack Object Table tab is useful for viewing details about an attack object. The 
Attack Table tab displays all attacks in a table format and includes the following 
information: 

• Name of the attack object
• Type of attack object: signature, anomaly, or group
• Attack severity (Major, Minor).
• Miscellaneous comment about the attack object

You cannot create, edit, or delete predefined attack objects, but you can update the list of 
attack objects using the Attack Update Client, detailed below.
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To keep your Attack Object database up-to-date, download new Attack Objects weekly 
from NetScreen using the Attack Update Client. Updates can include:

• New descriptions or severities for existing attack objects
• New attack objects
• Deletion of obsolete Attack Objects

From the menu bar, click Tools > Update Attacks to display the Attack Update Client, 
then follow the wizard to update your list of predefined attack objects. For step-by-step 
instructions on using the wizard, see the Online Help topic “Updating Attack Objects”.
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You can create custom attack objects to detect new attack or customize an existing attack 
to meet the unique needs of your network.

To add an attack object:

1. In the navigation tree, double-click Object Manager and select Attack Object > 
Custom Attack Objects. In the main display area, click the Signatures tab. Click 
the Add icon. The New Attack dialog box appears. 

2. Enter a name for the attack (the name must begin with CS:). You might want to 
include the protocol the attack uses in the attack name.

3. Select a severity for this attack: info; warning, minor, major, critical.
4. Select a color and enter a comment for the attack, if desired.
5. In the Pattern table, click the Add icon to configure a pattern for the attack 

object. In the Pattern Name dialog box, enter:
– In the Pattern Name box, enter a name for the pattern you want this 

attack to match. 
– In the Pattern box, enter the regular expression you want to match. 

NetScreen-Security Manager supports the following expressions:

– Select a context for the attack. The context defines the exact location in 
the packet you want the NetScreen FW/VPN to search for the attack 
pattern. Selecting a context enables you to make precise matches, 
reducing false positives and improving performance.

Note: You cannot create new protocol anomaly attack objects.

Regular Expression Description

\0<octal-number> For a direct binary match

\X<hexadecimal-number>\X For a direct binary match

\[<character-set>\] For case insensitive matches

. To match any symbol

* To match 0 or more symbols

+ To match 1 or more symbols

? To match 0 or 1 symbols

( ) Grouping of expressions

| Alternation. Typically used with ( )

[<start>-<end>] Character range

[^<start>-<end>] Negation of range
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NetScreen-Security Manager supports the following contexts:

6. Click OK to save the pattern, then click OK again to save the attack object.
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You can create attack groups of custom attack objects to use in your firewall rules. To add 
an Attack Object group:

1. In the navigation tree, double-click Object Manager and select Custom Attack 
Objects. In the Attack Object Group tab, click the Add icon to display the new 
Attack Group dialog box.

2. Enter a name, color, and comment for the attack group.

3. Select the custom attack objects or attack groups you want to add to the group 
by clicking them in the Non-members area (Hold CTRL to select multiple 
objects); then click Add. To add all objects to the group, click Add All.

4. Click OK to save the group.

Context Description

FTP Command Matches the attack pattern against an FTP command.

FTP Username Matches the attack pattern against the FTP user name (RFC 
959, #4.1.1).

HTTP URL Parsed Matches the attack pattern against the URL after it has been 
normalized and parsed. All parameters of the URI are skipped 
(anything after the ’?’ is skipped). The NetScreen FW/VPN 
device performs the following normalizations on the URL:

• % (hexadecimal) decoding

• %u decoding

• unicode normalization

• normalize directory traversals ('..' and './')

• remove double slashes - '//'

• convert tabs to space

• convert DOS '\' to '/'

• remove NULL characters '%00'

SMTP From Matches the attack pattern against the SMTP ’MAIL FROM’ 
command line.

SMTP Header From: Matches the attack pattern against the SMTP ’From:’ header.

SMTP RCPT Matches the attack pattern against the SMTP ’RCPT TO’ 
command line.

SMTP Header To: Matches the attack pattern against the SMTP ’To:’ header.

Stream Matches the attack pattern against the entire stream of data.

Note: Attack group names cannot be the same as attack object names.
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AV objects define the server that contains your virus definitions and AntiVirus software. 
To create an AV object, select AV Objects and click the Add icon. Enter a name for the 
object, then configure the AV server parameters:

• Server Name. Enter the name of the AV server.
• Server Port. Enter the port number on the AV server. 
• Color. Select a color to represent the object in the NetScreen-Security Manager 

UI.
• Comment. Enter a comment, if desired.
• Contents. Configure the protocol that the AV server scans for viruses:

– HTTP. To scan HTTP traffic for viruses, enable HTTP and configure the 
number of seconds. 

– SMTP. To scan SMTP traffic for viruses, enable SMTP and configure the 
number of seconds. 



Configuring GTP Objects

NetScreen-Security Manager 2004 FP2 311

��	(
��
	�������������
To enable a NetScreen FW/VPN device to manage GTP traffic, you must create a GTP 
Object and then apply it to a Security Policy rule. The rule with the GTP object defines 
how the device handles GTP packets: If a GTP packet matches the rule, the device 
attempts to further match the packet data with the parameters set in the GTP object. 

Using GTP objects, you can configure multiple rules that enforce different GTP 
configurations in the same Security Policy. For example, you can configure a Security 
Policy that enables a device to control GTP traffic differently based on source and 
destination zones and addresses, action, etc.

You configure GTP Objects in the Object Manager. From the main navigation tree, select 
Object Manager > GTP Objects, then click the Add icon to display the New GTP Object 
configuration screens. For each object, you can configure the following settings:

• Configuring Info
• Configuring Traffic Logging & Counting
• Configuring IMSI Prefix & APN Filtering
• Configuring GTP Message Filtering
• Configuring Subscriber Tracing (Lawful Interception)

The following sections detail each GTP setting. For an example on creating a GTP object, 
see “Creating a GTP Object” on page 316.
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The Info settings define the basic properties of the GTP object, and specify how the 
NetScreen FW/VPN device should handle GTP messages and tunnels.
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To limit the length of a GTP message, you can specify the minimum and maximum 
number of bytes permitted in a message length field. In the GTP header, the message 
length field indicates the length of the GTP payload. It does not include the length of the 
GTP header itself, the UDP header, or the IP header.

The default minimum and maximum GTP message lengths are 0 and 65535, respectively. 

;
+
�
���?0���������,���
To limit the rate of network traffic from a NetScreen FW/VPN device to a GPRS Support 
Node (GSN), you can specify the number of packets per second permitted for GTP-Control 
(GTP-C) messages.

Because GTP-C messages require processing and replying, they can overwhelm a GSN. 
Setting a rate limit on GTP-C messages can protect your GSNs from Denial-of-Service 
(DoS) attacks such as:
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• Border Gateway bandwidth saturation. A malicious operator connected to 
the same GRX as your PLMN can generate enough network traffic directed at 
your Border Gateway, so that legitimate traffic is starved for bandwidth in or 
out of your PLMN, thus denying roaming access to or from your network.

• GTP flood. GTP traffic can flood a GSN, forcing it to spend its CPU cycles 
processing illegitimate data. This can prevent subscribers from roaming, 
forwarding data to external networks, or prevent a GPRS attach to the network.

To limit the GTP message rate, enable Limit (packets/second) and enter the maximum 
number of packets per second that a NetScreen FW/VPN device can send to a GSN (the 
default is unlimited). 
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GSNs use GTP tunnels to transmit GTP traffic using the GPRS Tunneling Protocol (GTP). 
Because GSNs have a limited capacity for GTP tunnels, you might want to configure the 
NetScreen FW/VPN device to limit the number of GTP tunnels created. 

To limit GTP tunnels, enable Limit (tunnels/GSN) and enter the maximum number of 
tunnels permitted for each GSN (the default is unlimited).
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To configure a NetScreen FW/VPN device to detect and remove inactive GTP tunnels 
automatically, configure the GTP Tunnel Inactivity Timeout (hours). A GTP tunnel might 
hang (become inactive) when a “delete pdp context response” message gets lost on a 
network, or a GSN does not properly shut down.

The NetScreen FW/VPN device automatically removes a GTP tunnel that is idle for the 
specified timeout value. The default timeout value is 24 hours.
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When using a NetScreen FW/VPN device between the GGSNs, you can configure the 
device to validate sequence numbers for the GGSN and drop out-of-sequence packets. This 
helps conserve GGSN resources by preventing the unnecessary processing of invalid 
packets.

The header of a GTP packet contains a Sequence Number field, which indicates the order 
of the packets arriving at the GGSN. During the PDP context activation stage:

• The sending GGSN uses zero (0) as the Sequence Number value for the first G-
PDU it sends through a tunnel to another GGSN. The sending GGSN then 
increments the Sequence Number value for each following G-PDU it sends. The 
value resets to zero when it reaches 65535.

• The receiving GGSN sets its counter to zero. When it receives a valid G-PDU, it 
increments its counter by one. The counter resets to zero when it reaches 65535. 
The receiving GGSN compares the Sequence Number in the arriving packet 
with the sequence number in its counter: If the numbers correspond, the GGSN 
forwards the packet; if they differ, the GGSN drops the packet.



Configuring GTP Objects

NetScreen-Security Manager 2004 FP2 313

To enable the device to validate sequence numbers for the GGSN, enable Sequence 
Number Validation. By default, validation is disabled.
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To enable a NetScreen FW/VPN device to detect and drop a GTP packet that contains 
another GTP packet in its message body, enable GTP in GTP Denied.

����
�	�
���0����
��;���
���7���	��
��
When you enable traffic logging and counting for a GTP object, the NetScreen FW/VPN 
device generates log entries for deleted GTP tunnels and GTP traffic events. 
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A NetScreen FW/VPN device can count the number of user data and control messages (or 
bytes of data), received from and forwarded to the GGSNs and SGSNs that the device 
protects. The device counts traffic for each GTP tunnel separately, and differentiates 
GTP-User and GTP-Control messages. 

To enable counting, select Count By Message or Count By Byte. When counting is enabled 
and tunnel is deleted, the device counts and logs the total number of messages or bytes of 
data that it received from and forwarded to the SGSN or GGSN. 

To view log entries for deleted GTP tunnels, use the Log Viewer. For details on the 
information provided in the GTP log entry, see “GTP Log Entries” on page 650.
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A NetScreen FW/VPN device creates log entries for GTP events based on the status of the 
GTP packet. For each event type, you can also specify how much information (basic or 
extended) you want about each packet (for details, see “GTP Log Entries” on page 650). 

To configure GTP logging, select basic or extended for each GTP packet status:

• Log Forwarded Packets. When enabled, the device creates a log entry for 
each GTP packet that was transmitted because it was permitted by the Security 
Policy.

• Log Dropped Packet Due to Type/Length/Version. When enabled, the 
device creates a log entry for each GTP packet that was dropped because it was 
denied by the Security Policy.

• Log Dropped Packet Due to Invalid State. When enabled, the device creates 
a log entry for each GTP packet that was dropped because it failed stateful 
inspection.

• Log Dropped Packet Due to GSN Tunnel Limit. When enabled, the device 
creates a log entry for each GTP packet that was dropped because the maximum 
limit of GTP tunnels for the destination GSN was reached.
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• Log Dropped Packet Due to GSN Rate Limit. When enabled, the device 
creates a log entry for each GTP packet that was dropped because the maximum 
rate limit of the destination GSN was reached. 

You can also specify the frequency that a NetScreen FW/VPN device creates log 
entries for rate-limited messages. Setting a logging frequency conserves 
resources on the syslog server and NetScreen FW/VPN device, and can avoid a 
logging overflow of messages. By default, the frequency is 2, meaning the 
NetScreen FW/VPN device creates a log entry for every two messages above the 
set rate limit.

To view GTP traffic log entries, use the Log Viewer.
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You can use the IMSI Prefix and APN to restrict access to a specific set of mobile 
subscribers.
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An Access Point Name (APN) is included in the header of a GTP packet, and provides 
information on how to reach a network. By default, a NetScreen FW/VPN device permits 
all APNs. However, you can configure the device to filter APNs, enabling access only for 
those APNs you specify, and restricting roaming subscribers’ access to external networks. 

You can specify up to 2000 permitted APNs. When APN filtering is enabled, it applies 
only to “create pdp request” messages. For these messages to pass an APN filter, the GTP 
packet must match both the APN name filter and the Selection Mode filter:

• APN Domain Name filter. The device attempts to match the APN in a GTP 
packet to the APNs set in the GTP object. If the two APNs match, the device 
passes the packet to the selection mode filter.

• Selection Mode Filter. The device attempts to match the Selection Mode for 
the GTP packet and the GTP object. If the two modes match, the device forwards 
the GTP packet; if the modes do not match, the device drops the GTP packet.

Additionally, you can filter GTP packets based on the combination of an IMSI prefix and 
an APN. For details, see “Creating an IMSI Prefix Filter” on page 315.
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To set an APN filter, you need to know the network ID, which identifies the name of an 
external network. 

Note: Because the APN domain name (network ID) can potentially be very long and 
contain many characters, you can use the wildcard “*” as the first character of the APN 
to indicate that the APN also includes all preceding characters. However, because APN 
filtering is based on perfect matches, using the wildcard “*” can prevent the 
inadvertent exclusion of APNs that you would otherwise authorize.
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You must also set a Selection Mode, which indicates the origin of the APN and if the user 
subscription has been verified by the Home Location Register (HLR). You can set one of 
the following Selection Modes:

• Mobile Station. MS-provided APN, subscription not verified. This Selection 
Mode indicates that the mobile station (MS) provided the APN and that the HLR 
did not verify the user’s subscription to the network.

• Network. Network-provided APN, subscription not verified. This Selection 
Mode indicates that the network provided a default APN because the MS did not 
specify one, and that the HLR did not verify the user’s subscription to the 
network.

• Verified. MS or Network-provided APN, subscription verified. This Selection 
Mode indicates that the MS or the network provided the APN and that the HLR 
verified the user’s subscription to the network.
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A GSN (GPRS Support Node) identifies a mobile station by its IMSI (International Mobile 
Station Identity). An IMSI is composed of three elements:

• The MCC (Mobile Country Code)
• The MNC (Mobile Network Code)
• The MSIN (Mobile Subscriber Identification Number)

The MCC and MNC combine to create the IMSI prefix, which identifies the mobile 
subscriber’s home network (PLMN). By default, a NetScreen FW/VPN device does not 
perform IMSI prefix filtering on GTP packets. You can use the IMSI prefix to configure a 
NetScreen FW/VPN device to deny GTP traffic sent from non-roaming partners.

When you set an IMSI prefix in the GTP object, the NetScreen FW/VPN device filters 
“create pdp request” messages and permits only GTP packets with a matching IMSI 
prefix. If the prefix does not match, the NetScreen FW/VPN device drops the GTP packet. 
You can set up to 1000 IMSI prefixes for each device (one per each filter).

To disable IMSI prefix filtering, remove all MCC-MNC pairs from the GTP object.
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By default, the NetScreen FW/VPN device permits all GTP message types. You can 
configure a NetScreen FW/VPN device to filter GTP packets and drop them based on their 
message type.

A GTP message type includes one or many messages. When you drop a message type, you 
automatically drop all messages of the specified type. For example, if you select to drop 
the sgsn-context message type, you also drop “sgsn context request”, “sgsn context 
response”, and “sgsn context acknowledge” messages.

You drop message types based on the GTP version number, enabling you to drop message 
types for one version and permit them for another version.
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You can configure a NetScreen FW/VPN device to identify subscribers based on IMSI 
prefixes or Mobile Station-Integrated Services Data Network (MS-ISDN) identification, 
then log the contents of their GTP-User Data (GTP-U) or GTP-Control (GTP-C) messages.

To enable subscriber tracing, you must configure the following:

• Set Subscribers. Set the number of number of subscribers that the NetScreen 
FW/VPN device actively traces concurrently. The default number of 
simultaneous active traces is three (3). 

• Specify Log Bytes. Specify the number of bytes of data to log for a GTP-U 
packet. The default value is zero, meaning that the device does not log any 
content from a GTP-U packet. When you enter a number other than zero, the 
NetScreen FW/VPN device sends the logged packets to an external server (such 
as Syslog) dedicated to Lawful Interception operations.

• Set ID. For each subscriber you want to trace, enter their ID number and select 
Based on IMSI or Based on MSISDN.
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1. In Object Manager, select GTP Objects, then click the Add icon in the main 

display area. The New GTP Object dialog box appears. 
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2. In the Info tab, configure the object as shown below:

– For Name, enter GPRS1, then enter a color, and comment for the object. 
– Select Sequence Number Validation and GTP in GTP Denied.
– Leave all other defaults.

3. In the GTP navigation tree, select Traffic Logging/Counting. Configure as shown 
below:
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– For Traffic Counters, select Count by Message. 
– Select Basic for the following message types: Log Forwarded Packets, Log 

Dropped Packet Due to Type/Length/Version, and Log Dropped Packet 
Due to Invalid State.

– Leave all other defaults.
4. In the GTP navigation tree, select IMSI Prefix and APN Filtering. Click the Add 

icon to display a new IMSI Prefix and APN Filter Entry dialog box. Configure as 
shown below:

– For APN, enter mobiphone.com.mnc123.mcc456.gprs.
– Select MCC-MNC and enter the code 24656.
– For Selection Mode, select Mobile Station, Network, and Verified.

Click OK to save the new filter.

5. In the GTP navigation tree, select Subscriber Tracing.
– For Maximum Number of Simultaneous Active Traces, enter 2.
– For Number of Bytes to Be Saved to Log, enter 1020.

6. Click the Add icon to display a New Subscriber ID dialog box. Configure as 
shown below:

– For ID, enter 345678.
– For ID Type, select Based on IMSI.

7. Click OK to save the new Subscriber ID, then click OK to save the GPRS1 object.
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Service objects represent the IP traffic types for existing protocol standards. NetScreen 
FW/VPN devices monitor and manage network traffic using these protocols. NetScreen-
Security Manager includes predefined service objects for most standard services. You can 
also create custom service objects to represent services that are not included in the list of 
predefined service objects, or to represent a custom service running on your network.

You use service objects to create protected resources and specify the type of service within 
a Security Policy:

• In a protected resource, select a service or group of services to define the types of 
traffic you are permitting to and from the resource.

• In individual rules within a firewall rulebase, select one or more services or 
groups of services to define the types of IP traffic to which the rule applies. The 
action of the rule applies when the NetScreen FW/VPN detects packets that use 
the specified service type.
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A predefined service object represents a standard communication protocol, such as FTP or 
HTTP. To view predefined service objects, double-click Service Objects in the navigation 
tree and select predefined Services. The available services appear in the main display 
area within the Service tree tab, which displays the service objects in a tree format. Select 
a service group to display the members of that group.

To view service objects in a tabular format, select the Service Table tab. The available 
services appear in a table that uses the following format: 

You can view details for a predefined service object, but you cannot edit that service 
object. To view in read-only mode, double-click the service object to open it. 

Name Name of the service object

Type Type of the service object: service or group

Timeout Service timeout—inactivity timeout after a which a session on a NetScreen FW/
VPN device is removed

Category Classification broadly based on the purpose the service is designed for: 

email—used for sending and receiving email (POP3, for example)

info seeking—used to retrieve specific information from a server (DNS, for 
example)

remote—used for accessing remote servers (telnet, for example)

security—enable the access of a remote server securely using well known 
security mechanisms (HTTPS for example)

other— all other services

Predefined If selected, an NetScreen-Security Manager predefined service.
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You can create custom service objects to represent protocols that are not included in the 
predefined services or to meet the unique needs of your network. 

To add a service object, in the Object Manager, select Service Objects > Custom Service 
Objects. In the main display area, click the Add icon to display the New Service dialog 
box. Select Service, enter a name for the service, then configure the following parameters:

• Category. Select a category for the service:
– Other. All other services
– Remote. Services used for accessing remote servers (telnet, etc.)
– Info seeking. Services used to retrieve specific information from a server 

(DNS, etc.)
– Security. Services that enable access to a remote server securely using 

well known security mechanisms (HTTPS, etc.).
– Email. Services used for sending and receiving email (POP3, etc.)

• Timeout. Select the session timeout after which an inactive session is removed.
– Never. The session does not timeout.
– Default. Use the default timeout for the selected protocol. The default 

timeout for TCP connections is 30 minutes. The default timeout for UDP 
connections is 1 minute.

– User-defined. Enter a session timeout value. The maximum timeout value 
for TCP and UDP connections is 40 minutes.

• Color. Select a color to represent this service object in the NetScreen-Security 
Manager UI.

• Comment. Add a comment, if desired.
• Add the service:

– For ICMP services, select the ICMP type and code. For details on ICMP 
type, see the NetScreen-Security Manager Online Help.

– For other services, select the protocol type and configure the source and 
destination ports. For multiple ports, add two service entries with 
different ports.
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You can group services together as a service object group, then use that group in Security 
Policies and VPNs to simplify administration. Each service object can be referenced by 
multiple service object groups. Service object groups can contain both predefined and 
custom service objects, as well as other service object groups.

To add a service object group:

1. In the navigation tree, double-click Object Manager and select Service Objects.
2. In the main display area, click the Add icon and select New > Group. The new 

Service Group dialog box appears.
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3. Enter a name, color, and comment for the service object group.

4. Select the service objects or service object groups you want to add to the group by 
clicking them in the Non-members area (Hold CTRL to select multiple objects); 
then click Add. 

5. Click OK.

The new service object group appears in the Service Tree and Service Table tabs.
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In this example, you’ll create a custom service object to represent the Ident service and a 
custom service group that includes this service.

To create the custom Ident service:

1. In Service Objects, select Custom Service Objects. In the main display area, click 
the Add icon and select Service. 

2. Configure the object as shown below:

3. Click OK to save the object and return to Custom Service Objects. 

Next, create a Remote Mail service group:

1. In Service Objects, select Custom Service Objects. In the main display area, click 
the Add icon and select Group. 

Note: Service object group names cannot be the same as service object names.

Click the Add icon to 
configure the Ident 
protocol and ports.
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2. Configure the group as shown below:

3. Click OK to save the group and return to Custom Service Objects.
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An authentication server provides authentication for NetScreen-Security Manager 
administrators and remote access services (RAS) users on your network. When the 
NetScreen FW/VPN device receives a connection request that requires authentication 
verification, the device requests an authentication check from the external auth server 
specified in the policy, L2TP tunnel configuration, or IKE gateway configuration. The 
device then acts as a relay between the user requesting authentication and the auth 
server granting authentication.

In NetScreen-Security Manager, an auth server is an object used in Security Policies, IKE 
gateways, and L2TP tunnels. Each NetScreen FW/VPN device includes a default 
authentication server; however, to enable an external RADIUS, SecureID, or LDAP server 
to provide authentication, you must configure an external authentication server object. 
You can also configure a RADIUS authentication server object to provide authentication 
for the global domain and each subdomain. For details on configuring a RADIUS server, 
see “Configuring a RADIUS Authentication Server” on page 324.

To configure general authentication server object properties, in the main navigation tree, 
select Object Manager > Authentication Servers and click the Add icon. Enter a name, 
color, and comment for the authentication server, then configure the following 
parameters:

• Main Server. Enter the IP address of the main authentication server.
• Primary Backup Server. Enter the IP address of the primary backup server.
• Secondary Backup Server. For RADIUS servers only, you can enter the IP 

address of the secondary backup server (this option is not supported for 
SecureID servers).

• Authentication Timeout. Enter the number of minutes before the 
authentication check times out.

– Auth user. The timeout countdown begins after the first authenticated 
session completes. If users initiate a new session before the countdown 
reaches the timeout threshold, they do not need to reauthenticate and the 
timeout countdown resets. The default timeout value is 10 minutes, and 
the maximum is 255 minutes. You can also set the timeout value at 0 so 
that the authentication period never times out.

Note: You must also define routes that direct authentication requests to the RADIUS, 
SecurID, and LDAP servers.
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– Admin user. If the length of idle time reaches the timeout threshold, the 
NetScreen FW/VPN device terminates the admin session. To continue 
managing the device, the admin must reconnect to the device and re 
authenticate. The default timeout value is 10 minutes, and the maximum 
is 1000 minutes. You can also set the timeout value at 0 so that an admin 
session never times out. 

• Users. Enable the server to provide authentication for:
– Admin Users
– Firewall Auth Users
– XAuth Users
– L2TP Users

• Server Type. Select the authentication server type and configure the necessary 
parameters:

For RADIUS, configure the following (see “Configuring a RADIUS 
Authentication Server” on page 324):

– RADIUS Server IP Address. The IP address of the RADIUS server 
– Shared Secret. The secret (password) shared between a NetScreen FW/

VPN device and the RADIUS server. The RADIUS server uses the shared 
secret to generate a key to encrypt traffic between the NetScreen FW/VPN 
device and the RADIUS server. The NetScreen FW/VPN device uses the 
shared secret to encrypt the user’s password that it sends to the RADIUS 
server.

– RADIUS Port. The port number on the RADIUS server to which a 
NetScreen FW/VPN device sends authentication requests. The default 
port number is 1645.

– RADIUS Retry Timeout. The interval (in seconds) that a NetScreen 
FW/VPN device waits before sending another authentication request to 
the RADIUS server if the previous request does not elicit a response. The 
default is three seconds.
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The Remote Authentication Dial-In User Service (RADIUS) is a protocol for an 
authentication server that can support up to tens of thousands of users.

Note: User authentication timeout is not the same as session idle 
timeout. If no activity occurs in a session for a predefined length of 
time, the NetScreen FW/VPN device automatically removes the 
session from its session table.
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The NetScreen FW/VPN device acts as a RADIUS client that authenticates users. When 
users log in, the RADIUS client (the NetScreen FW/VPN device) prompts them for their 
user name and password, then compares these values with the values stored in the 
RADIUS database. If the values match, the RADIUS client authenticates the user and 
permits access to the appropriate network services.

A RADIUS server supports the following user types:

• Auth users
• L2TP users (authentication and remote settings)
• XAuth users (authentication and remote settings)
• Admin users (authentication and privilege assignments)
• User groups

A RADIUS server does not support IKE users.
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A dictionary file defines vendor-specific attributes (VSIs) that you load onto a RADIUS 
server. After you define the VSA values, the NetScreen FW/VPN device can query those 
values when a user logs on to the device.

You must load a NetScreen dictionary file to enable the RADIUS server to support 
NetScreen-specific attributes as admin privileges, user groups, and remote L2TP and 
XAuth IP address, and DNS and WINS server address assignments. You do not need to 
load NetScreen dictionary file to enable RADIUS to make IP address assignments 
(NetScreen uses the standard RADIUS attribute for IP address assignments).

NetScreen provides two dictionary files: one for Cisco RADIUS servers and one for Funk 
Software RADIUS servers. To download a dictionary file, go to www.netscreen.com/
services/tackiness/index.jsp, select a NetScreen product, and then select a RADIUS 
dictionary file. If using a Microsoft RADIUS server, there is no dictionary file. You must 
configure it as outlined in Using a Windows NT Domain / Active Directory for User 
Authentication NetScreen Devices , which you can download from www.netscreen.com/
resources/application_notes/technical.jsp.

Each NetScreen dictionary file contains the following specific information:

A VPN RAS user requests 
a connection to the 
protected network.

The NetScreen FW/VPN device uses an 
external RADIUS server to authenticate the 
RAS VPN user before approving the 
connection request.Internet

RADIUS Server

http://www.netscreen.com/services/tac_online/index.jsp
http://www.netscreen.com/services/tac_online/index.jsp
http://www.netscreen.com/resources/application_notes/technical.jsp
http://www.netscreen.com/resources/application_notes/technical.jsp
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• Vendor ID: The NetScreen vendor ID (VID; also called an “IETF number”) is 
3224. The VID identifies a specific vendor for a particular attribute. Some types 
of RADIUS server require you to enter the VID for each attribute entry, while 
other types only require you to enter it once and then apply it globally. Refer to 
your RADIUS server documentation for further information.

• Attribute Name: The attribute names describe individual NetScreen-specific 
attributes, such as NS-Admin-Privilege, NS-User-Group, and NS-Primary-DNS-
Server.

• Attribute Number: The attribute number identifies an individual vendor-
specific attribute. 

• Attribute Type: The attribute type identifies the form in which attribute data 
(or “value”) appears—a string, an IP address, or an integer.

The RADIUS server automatically receives the above information when you load the 
NetScreen dictionary file onto it. To make new data entries, you must manually enter a 
value in the form indicated by the attribute type.
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When a user attempts to log in using telnet, a NetScreen FW/VPN devices can process 
access-challenge packets from an external RADIUS server.

Access-challenge is an additional authentication level. After a username and password 
has been authentication. the RADIUS server sends an access-challenge to the NetScreen 
FW/FPN device, which forwards the challenge to the user. When the user replies, the 
device sends a new access-request with the user's response to the RADIUS server; if the 
user's response is correct, the authentication process concludes successfully.
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In the following example, you define an auth server object for a RADIUS server. You 
specify its user account types as auth, L2TP, and XAuth. You name the RADIUS server 
“radius1” and accept the ID number that the NetScreen FW/VPN device automatically 
assigns it. You enter its IP address, which is 10.20.1.100; and change its port number 
from the default (1645) to 4500. You define its shared secret as “A56htYY97kl”. You 
change the authentication timeout value from the default (10 minutes) to 30 minutes and 
the RADIUS retry timeout from 3 seconds to 4 seconds. You also assign its two backup 
servers the IP addresses 10.20.1.110 and 10.20.1.120.

In addition, you load the NetScreen dictionary file on the RADIUS server so that it can 
support queries for the following vendor-specific attributes (VSAs): user groups, admin 
privileges, remote L2TP and XAuth settings.

Note: NetScreen does not support access-challenge with L2TP.
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1. In the main navigation tree, select Object Manager > Authentication Servers 
and click the Add icon. Enter a name, color, and comment for the authentication 
server.

2. Configure the RADIUS servers:
– For Main Server, enter the IP 10.20.1.100
– For Primary Backup Server, enter IP 10.20.1.110
– For Secondary Backup Server, enter IP 10.20.1.120

3. For timeout, enter 30.
4. Select the following:

– For Firewall Auth Users
– For XAuth Users
– For L2TP Users

5. For Server Type, select RADIUS. 
6. Configure the RADIUS server properties:

– For server port, select 4500
– For secret, enter A56hYY97kl
– For retry timeout, select 4.

7. Click OK to save the RADIUS authentication server object.
8. Load the NetScreen dictionary file on the RADIUS server.

RADIUS Server
Name: radius1
IP 10.20.1.100, Port 4500
Timeout: 30 minutes
shared secret: A56htYY97kl
Account Types: Auth, L2TP, XAuth

Backup2 IP: 10.20.1.120

Note: Only cabling to the 
RADIUS servers is shown.

The NetScreen FW/VPN device sends auth, L2TP, and 
XAuth authentication requests to the primary RADIUS 
server, “radius1”, at 10.20.1.100.

If the NetScreen FW/VPN device loses network connectivity 
with the primary RADIUS server, the device redirects 
authentication requests to backup1 at 10.20.1.110.

If the NetScreen FW/VPN device cannot reach backup1, it 
redirects authentication requests to backup2 at 10.20.1.120.

Backup1 IP: 10.20.1.110
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User objects represent the users of your managed devices. You can include user objects or 
groups in Security Policies or VPNs to permit or deny access to individuals or groups. 
NetScreen-Security Manager support two types of user objects: 

• Local Users are users with accounts that are managed by your NetScreen FW/
VPN devices. You can create local user groups that include multiple users 
simplify user administration and make policies and VPNs easier to create.

• External Users and External User Groups are users with accounts that are 
managed by external devices, such as RADIUS servers. You can use external 
users and groups to create group expressions (for details, see “Configuring 
Group Expressions” on page 334).
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Local User Objects represent the user account on your NetScreen FW/VPN devices. To 
add a local user object:

1. In the navigation tree, double-click the Object Manager, select User Objects, 
then select Local Users. In the main display area, click the Add icon and select 
New > User to display the New Local User dialog box.

2. Enter a name, color, and comment for the local group.
3. Select the Enable checkbox to enable authentication for this user, then configure 

the authentication methods for the user.
– XAuth. Enables XAuth authentication for this user. If you select this 

option, you must also enter an XAuth password for the user.
– IKE. Enables IKE authentication using one of the IKE proposals defined 

in the IKE Proposal Objects. If you select this option, you must also 
configure the IKE Share limit and authentication token. 

– Auth. Enables local authentication against a username and password 
stored in a NetScreen FW/VPN device's local database. If you select this 
option, you must also enter an Auth password for the user.

– L2TP: Enables authentication in the L2TP tunnel that the user uses to 
connect to the device. If you select this option, you must also enter an 
L2TP password for the user.

4. Click OK to save the user object. 
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Organize local users in groups to add multiple users at one time to a Security Policy, and 
to manage the members without changing the policy. To add a local user group object:

1. In the navigation tree, double-click the Object Manager, select User Objects, 
then select Local Users. In the main display area, click the Add icon and select 
New > Group to display the New Local User Group dialog box.

2. Enter a name, color, and comment for the local user group.
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3. Configure the members of the group:
– To add members, select users from the Non-members list and click Add. 

Use Ctrl-click to select multiple users, or click Add All to add all users in 
Non-members list to the group.

– To remove members, select users in the Members list and click Remove. 
Use Ctrl-click to select multiple users, or click Remove All to remove all 
users in Members list from the group.

4. Click OK to save the local user group. 
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External User Objects represent users whose accounts are maintained and authenticated 
on devices that are not managed by NetScreen-Security Manager, such as an external 
RADIUS or SecureID server. When an external user is included in a Security Policy 
(under Authentication rule options), the NetScreen FW/VPN device uses the external 
server to authenticate that user.

To configure an external user:

1. In the navigation tree, double-click the Object Manager, select User Objects, 
then select External Users. In the main display area, click the Add icon and 
select New to display the New External User dialog box.

2. Enter a name, color, and comment for the external user.
3. Click OK to save the external user object.
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External User Group objects represent user groups that are managed on non-NetScreen 
FW/VPN devices, such as an external RADIUS or SecureID server. When an external user 
group is included in a Security Policy (under Authentication rule options), the NetScreen 
FW/VPN device uses the external server to authenticate those users. 

To use an external user group in a VPN, however, you must also create local user objects 
with IKE authentication for each external user. In phase 1 of IKE negotiations, the 
NetScreen FW/VPN device authenticates the external user group using the RADIUS 
server. In phase 2 of IKE negotiations, the device uses the local user object or local user 
group for authentication. Typically, you configure the local user object with IKE 
authentication and a U-FQDN (email address); during phase 2, the device prompts the 
user for their U-FQDN for authentication.

To add an external user group object:

1. In the navigation tree, double-click the Object Manager, select User Objects, 
then select External User Groups. In the main display area, click the Add icon 
and select New to display the New External Group dialog box.

2. Enter a name for the external user group. The name must match the name of the 
user group as configured on the external server.

3. Enter a color and comment for the external user group. 
4. Configure the authentication methods for the user group:
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– XAuth. Enables XAuth authentication for the user group.
– Auth. Enables local authentication against a username and password 

stored in a NetScreen FW/VPN device's local database.
– L2TP: Enables authentication in the L2TP tunnel that users in the group 

use to connect to the device.
5. Click OK.
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In this example, you configure an external RADIUS auth server named radius1 and 
define an external auth user group named auth_grp2. You define the external auth user 
group auth_grp2 in two places: External RADIUS auth server “radius1”, and in 
NetScreen-Security Manager. 

You populate the auth user group “auth_grp2” with auth users on the RADIUS server 
only, leaving the group unpopulated in NetScreen-Security Manager. The members in 
this group are accountants who require exclusive access to a server at IP address 
10.1.1.80. You create an address book entry for the server and name the address “midas.” 
You then configure a Security Policy that permits only authenticated traffic from 
auth_grp2 to midas, both of which are in the Trust zone.

1. On the RADIUS server, load the NetScreen dictionary file and define auth user 
accounts. Use the NetScreen user group VSA to create the user group auth_grp2 
and apply it to the auth user accounts that you want to add to that group.

2. In NetScreen-Security Manager, in the main navigation tree, select Object 
Manager > Authentication Servers and click the Add icon. Configure the server:

a. For name, enter radius1. Select a color and add a comment, if desired.
b. For Main Server, enter the IP 10.20.1.100; for Primary Backup Server, 

enter IP 10.20.1.110; for Secondary Backup Server, enter IP 10.20.1.120.
c. For timeout, enter 30.
d. Select For Firewall Auth Users.
e. For Server Type, select RADIUS, then configure the RADIUS server:

For server port, select 4500

For secret, enter A56hYY97kl

For retry timeout, select 4.

f. Click OK to save the RADIUS authentication server object.
3. Configure the External User Group in NetScreen-Security Manager:

a. In the Object Manager, select User Objects > External User Groups.

Note: For instructions on loading the dictionary file onto a RADIUS server, 
refer to the RADIUS server documentation. If you are using a Microsoft IAS 
RADIUS server, there is no dictionary file to load. Instead, define the correct 
vendor-specific attributes (VSAs) on the server.
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b. Click the Add icon to display the New External User Group dialog box. 
Configure as shown below:

c. Click OK to save the new group.
4. Add the Address Object that represents the Accounting Server:

a. In the Object Manager, select Address Objects. Click the Add icon and 
select Host. The New Host dialog box appears.

b. Configure the Host as shown below:

c. Click OK to save the new Host object.
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5. Configure a firewall rule to use the RADIUS authentication server object to 
authenticate traffic between the external user group and the Midas server, as 
shown below:
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An IP pool is a range of IP addresses within the same subnet. You use IP Pool objects to 
assign IP addresses to L2TP users in L2TP VPNs or local users on a specific device. The 
IP pool you select for the VPN or the local user determines the range of IP addresses the 
device can assign to the L2TP RAS user when the user connects to the L2TP VPN.

An IP Pool object has the following fields:

• IP Pool Name: The name of the IP Pool. 
• Start IP: The beginning of the range of IP addresses included in this pool, 

inclusive. The Start IP must always be lower than the End IP.
• End IP: The end of the range of IP addresses included in this pool, inclusive. 

The End IP must always be higher than the Start IP.

To add an IP pool: 

1. In the navigation tree, select Object Manager > IP Pools. 
2. In the main display area, click the Add icon.
3. Enter a name, color, and comment about the IP Pool.
4. Enter the Start IP and End IP. Enter a range wide enough to accommodate the 

number of RAS users in your VPN.
5. Click OK to save the IP Pool object and return to Object Manager.

Note: For details on configuring XAuth and L2TP local users on a device, see 
“Configuring L2TP and XAuth Local Users” on page 242. 
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Group expressions are statements that set conditions for authentication requirements, 
enabling you to combine multiple external user objects. You can create group expressions 
using the operator OR, AND, or NOT to combine user objects, user group objects, or other 
group expressions to define:

• Alternatives for authentication (“a” OR “b”)
• Requirements for authentication “a” AND “b”)
• Exclusions of a user, user group, or another group expression (NOT “c”).

The operators have different meanings depending on the type of user object you are using 
in the Security Policy, as detailed below:

Note: The user and user groups you reference in the group expressions must be external 
users that are stored on an external RADIUS server. (A RADIUS server enables a user to 
belong to more than one user group).

User Objects

OR If the Security Policy defines authentication for “a” or “b” user objects, the 
NetScreen FW/VPN device authenticates the user if it is either “a” or “b”.

AND Requires one of the two objects in the expression to be either a user group or a 
group expression (a single user cannot be both user “a” and user “b”). If the 
Security Policy defines authentication for “a” AND a member of group “b”, the 
NetScreen FW/VPN device authenticates the user only if those two conditions 
are met.

NOT If the Security Policy defines authentication for any user object that is not the “c” 
user (NOT “c”), the NetScreen FW/VPN device authenticates all users except 
the “c” user.

User groups

OR If the Security Policy defines authentication for user group “a” or user group “b”, 
the NetScreen FW/VPN device authenticates the user if it belongs to either “a” 
or “b” user group.

AND If the Security Policy defines authentication for user group “a” AND user group 
“b”, the NetScreen FW/VPN device authenticates the user only if it belongs to 
both user groups.

NOT If the Security Policy defines authentication for any user group that is not group 
“c” (NOT “c”), the NetScreen FW/VPN device authenticates all users except 
those that belong to the “c” user group.

Group expressions

OR If the Security Policy defines authentication for user objects that match the 
description of group expression “a” OR group expression “b”, the NetScreen 
FW/VPN device authenticates the user if either group expression references 
that user.
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Because a group expression references external user objects and/or external user groups, 
you must first create those user object and groups before you can use them in a group 
expression. You cannot reference local user object or local user object groups in a group 
expression.

To add a group expression:

1. In the navigation tree, double-click Object Manager and select Group 
Expressions.

2. In the main display area, click the Add icon and select New. The New Group 
Expression dialog box appears.

3. Enter a name, color, and comment for the group expression. 
4. Select the operator you want to use in the expression (OR, AND, NOT) and then 

configure the Operands:
– For NOT expressions, use Operand 1 to select the user object, group, or 

expression that cannot be present for a successful match. Because the 
operation is exclusion, you do not need to configure Operand 2.

– For AND expressions, use Operand 1 and Operand 2 to select the two user 
object, group, or expression that must be present for a successful match.

– For OR expressions, use Operand 1 and Operand 2 to select the two user 
object, group, or expression, one of which must be present for a successful 
match.

5. Click OK. The group expression object appears in the Object Manager.

After you have created a group expression object, you can use that object in the 
Authentication rule options. For details, see Chapter 8, “Configuring Security Policies”.
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In this example, you configure a group expression to authenticate all users that belong to 
your Sales group and your Marketing group, then add the expression to a Security Policy 
that provides access to your protected networks.

AND If the Security Policy defines authentication for user objects that match the 
description of group expression “a” AND group expression “b,” the NetScreen 
FW/VPN device authenticates the user only if both group expressions reference 
that user.

NOT If the Security Policy defines authentication for user objects that do not match 
the description of group expression “c” (NOT “c”), the NetScreen FW/VPN 
device authenticates all users except those that match the group expression.



Chapter 7 Configuring Objects

336 Administrator’s Guide

1. First, create two external user group objects: one to represent the Sales users 
and the other to represent the Marketing users, as shown below:

2. Next, create a group expression object that reference both the Sales and 
Marketing group, as shown below:

3. Finally, add the group expression object to your firewall rule in the 
Authentication rule option, as shown below:

Select Authentication as the 
Authentication option

Select the authentication server 
object that represents the RADIUS
server used to authenticate your 
external user groups.
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A remote settings object defines the DNS and WINS servers that are assigned to L2TP 
RAS users after they have connected to the L2TP tunnel. You can use remote settings 
objects in an L2TP VPN, and when configuring a local user on a specific device. 

NetScreen FW/VPN devices incorporate DNS (domain name server) and WINS support to 
permit the use of domain names as well as IP addresses for identifying locations. A DNS 
or WINS server keeps a table of the IP addresses associated with domain names. Using 
DNS or WINS, you can reference locations by their domain name (www.juniper.net) in 
addition to using a routable IP address (such as 209.125.148.136). 

Before you can use DNS or WINS for domain name/address resolution in a VPN, you must 
create remote settings for the DNS or WINS servers (primary and secondary).

To configure a remote setting, select Remote Settings and click the Add icon. Enter a 
name, color, and comment for the object, then configure the following parameters:

• DNS1. Enter the IP address of the primary DNS server. 
• DNS2. Enter the IP address of the secondary DNS server. 
• WINS1. Enter the IP address of the primary WINS server. 
• WINS2. Enter the IP address of the secondary WINS server. 

Note: For details on configuring XAuth and L2TP local users on a device, see 
“Configuring L2TP and XAuth Local Users” on page 242. 
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A global NAT object contains references to device-specific NAT configurations, enabling 
multiple devices to share a single object.

Use the Device Manager to configure NAT for each device, then create a global NAT object 
that includes the device-specific NAT configuration. The single global NAT object 
represents multiple device-specific NAT objects (a global DIP represents multiple device-
specific DIPs, etc.). However, a global NAT object can contain only one device-specific 
NAT object from the same device.

Use global NAT objects in VPNs; when you install the VPN on a device, that device 
automatically replaces the global NAT object with its device-specific NAT configuration. 
Before you configure a shared NAT object, ensure that you have configured the MIP, VIP, 
or DIP on the device itself. 
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In Object Manager, select NAT Objects > DIP and click the Add icon. Enter a name, color, 
and comment for the object, then click the Add icon to specify the device-specific DIP:

• Device. Select the NetScreen FW/VPN device that includes the DIP.
• Interface or DIP Group. Select the interface or DIP group for the device. 

– For interface, select the interface on the device and the dynamic IP 
address configuration for that interface.

– For DIP group, select the dynamic IP group configuration for that device.

If no values appear in the pull-down menu for interface, DIP, or DIP group, 
ensure that you have configured DIP correctly in the Device Manager.

You can add multiple device DIPs to a single global DIP object.

For details on configuring a DIP object and an example, see “Configuring DIPs” on page 
157. For details on configuring a DIP group and an example, see “Configuring DIP 
Groups” on page 195.
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In Object Manager, select NAT Objects > MIP and click the Add icon. Enter a name, color, 
and comment for the object, then click the Add icon to specify the device-specific MIP:

• Device. Select the NetScreen FW/VPN device that includes the MIP.
• Interface. Select the interface on the device that uses the mapped IP address. 
• MIP. Select the mapped IP address configuration for that interface.

If no values appear in the pull-down menu for interface or MIP, ensure that you have 
configured MIP correctly in the Device Manager. You can add multiple device MIPs to a 
single global MIP object. 

For details on configuring a MIP object and an example, see “Configuring MIPs” on page 
150.
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In Object Manager, select NAT Objects > VIP and click the Add icon. Enter a name, color, 
and comment for the object, then click the Add icon to specify the device-specific VIP 
configuration:

• Device. Select the NetScreen FW/VPN device that includes the VIP.
• Interface. Select the interface on the device that uses the virtual IP address. 
• VIP. Select the virtual IP address configuration for that interface.

If no values appear in the pull-down menu for interface or VIP, ensure that you have 
configured VIP correctly in the Device Manager. You can add multiple device VIPs to a 
single global VIP object. 

For details on configuring a VIP object and an example, see “Configuring VIPs” on page 
153.
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A digital certificate is an electronic means for verifying your identity through the word of 
a trusted third party, known as a Certificate Authority (CA). NetScreen-Security 
Manager simplifies creating and managing certificates:

• Use the same CA server for multiple devices. Create a single CA object for each 
CA server you use, then use that object for those devices.

• Generate a local and CA certificate in one click using SCEP.
• Use OCSP to automatically check for revoked certificates (ScreenOS 5.x devices 

only) 
• Use a certificate chain that includes a root CA and subordinate CA (CA group)

A CA object represents the CA server you want to use to authenticate the identity of your 
VPN member. You can use an independent or internal CA server:

• An independent CA server is owned and operated by an independent CA. The 
independent CA provides the IP addresses of their CA and CRL servers. You 
submit a local certificate request to the independent CA and provide your local 
certificate information.

• An internal CA server is owned and operated by your company. You provide 
the IP addresses of the CA and CRL servers and local certificate information.

You can obtain a CA certificate file (.cer) from the CA that issued the local certification, 
then use this file to create a Certificate Authority object. Then, install this CA certificate 
on the managed device using NetScreen-Security Manager. Because the CA certificate is 
an object, however, you can use the same CA for multiple devices, as long as those devices 
use local certificates that were issued by that CA.

Alternatively, you can use SCEP to configure the device to automatically obtain a CA 
certificate at the same time it receives the local certificate. For details, see Chapter 4, 
“Configuring Devices”.
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You must use obtain and install a CA certificate on each VPN member to authenticate the 
local device certificates on your managed devices. 
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After you have obtained a CA Certificate file (.cer) from your CA, use this file to create a 
Certificate Authority Object. In Object Manager, select Certificate Authorities, then click 
the Add icon to display the New CA Certificate dialog box. Enter a name for the CA 
Certificate, then click Load CA certificate and load the appropriate .cer file. NetScreen-
Security Manager uses the information in the .cer file to automatically complete the 
Subject Name, Issued By, and Expired On fields.
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Complete the remaining settings:

• X.509 Certificate Path Validation Level. X509 contains a specification for a 
certificate which binds an entity’s distinguished name to its public key through 
the use of a digital signature.

– Full. Use full validation to validate the certificate path back to the root.
– Partial. Use partial validation to validate the certificate path only part of 

the way to the root.
• Revocation Check. 

– Check for revocation. Select this option to enable revocation checking.
– Do not check for revocation. Select this option to disable revocation 

checking.
• Revocation Checking Method. If you enabled revocation checking, you can 

select the checking method to use. If you did not enable revocation checking, 
these fields are unavailable.

– CRL. Use a Certificate Revocation List when you want to keep a local copy 
of the revoked certificates on the managed device. This method enables 
the device to check for revoked certificates quickly; to accept the certificate 
if no revocation information is found, also enable Best Effort. 

– OSCP. Use the Online Certificate Status Protocol when you want the 
managed device to access a remote OCSP server to check for revoked 
certificates. Because the OCSP server dynamically updates its list of 
revoked certificates, this method provides the most up-to-date 
information; to accept the certificate if no revocation information is found, 
also enable Best Effort. 

– Best Effort. Enable this option to check for revocation accept the certificate 
if no revocation information is found.

• CRL Settings. Configure the default setting for the Certificate Revocation List.
– Refresh Frequency. Select the frequency that the device contacts the CA to 

obtain a new CRL list: Daily, Weekly, or Monthly.
– LDAP server. Provide the IP address of the external LDAP server that 

manages the CRL.
– URL address. Provide the URL address of your internal LDAP server that 

provides the CRL.
• OCSP. Configure the Online Certificate Status Protocol to dynamically check 

for revoked certificates. 
– Certificate Verification. 
– No revoke status check for CA delegated signing cert. 
– URL of OCSP Responder. Provide the URL address of the OCSP server.

• SCEP. Configure Simple Certificate Enrollment Protocol to get a local 
certificate automatically.

– CA CGI. Enter the URL address of the Certificate Authority Certificate 
Generation Information.
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– RA CGI. Enter the URL address of the Registration Authority Certificate 
Generation Information that the NetScreen FW/VPN device contacts to 
request a CA certificate.

– CA IDENT. Enter the name of the certificate authority to confirm 
certificate ownership.

– Challenge. Enter the challenge word(s) sent to you by the CA that confirm 
the FW/VPN device identity to the CA.

– CA Certificate Authentication. (Auto or Manual)
– Polling Interval. (Poll or Do not poll). 
– Certificate Renewal. Define the number of times a certificate can be 

renewed.

Click OK to complete the CA Object.
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A Certificate Revocation List (CRL) identifies invalid certificates. You can obtain a CRL 
file (.crl) from the CA that issued the local certification and CA certificate for the device, 
then use this file to create a Certificate Revocation List object.

You must install the CRL on the managed device using NetScreen-Security Manager. 
Because the CRL is an object, however, you can use the same CRL for multiple devices, as 
long as those devices use local and CA certificates that were issued by that CA.
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You can use a CRL object in a VPN to check for VPN members using revoked certificates. 
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After you have obtained a CRL file (.crl) from your CA, use this file to create a Certificate 
Revocation Object. 

In Object Manager, select CRLs, then click the Add icon to display the New CRL dialog 
box. Enter a name for the CRL, then click Load CRL and load the appropriate .crl file. 
NetScreen-Security Manager uses the information in the .crl file to automatically 
complete the Issued By and Expire On fields. Click OK to complete the CRL object.
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A protected resource combines a network component, a network service, a traffic 
direction, and the NetScreen FW/VPN device that protects that component and service. 
Protected resources are the source and destination addresses of a policy-based VPN. 

Protected resources consist of three elements:

• IP Address. The address represents the computer, network, or range of 
addresses to be considered part of this protected resource. The Address can be an 
individual host, a network, or an address group.

• Network Service. Services are the protocols that can communicate over a 
network, such as FTP and HTTP. The service can be an individual service or a 
service group.

• Traffic Direction. Traffic direction is determined by the IP address that 
initiates the connection. 

– Client connections are typically outgoing, or outbound from the protected 
network.

– Server connection are typically incoming, or inbound to the protected 
network.

– To protect incoming and outgoing traffic, select Both.

Corporate LAN

Computer Group, Protected 
Resources Range 10.100.20.0

European LAN Asian LAN

Trust 10.100.20.1

Untrust 1.1.1.20

Trust 10.100.30.1

Untrust 1.1.1.30

Trust 10.100.10.1

Untrust 1.1.1.10

Computer Group, Protected 
Resources Range 10.100.30.0

Computer Group, 
Protected Resources 
Range 10.100.10.0

Single Computer, 
Protected Resource 
10.100.10.211
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• NetScreen FW/VPN device. The device is the FW/VPN device through which 
the VPN must connect to reach the protected resource. If the resource can be 
reached through more than one device, you can add multiple devices to the 
resource. When you add a protected resource to a VPN, the devices listed in the 
protected resource are included in the VPN.

Each protected resource represents an address or a range of addresses on your network. 
Each resource also can specify a service (such as FTP or NSF). Therefore, the protected 
resource is the destination for all traffic using the selected service to the selected address.

You can have more than one protected resource for a single address or range of addresses. 
That way you can individually manage different services traffic to the same destination 
separately. 
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To add a protected resource object:

1. In the navigation tree, open VPN Manager and click Protected Resources.
2. In the main display area, click the Add icon to display the Protected Resource 

dialog box.
3. Enter a name for the protected resource.
4. Select the services you want to permit to this resource, such as FTP, HTTP, 

NFS, etc. Select Any to permit all services.
5. Select the initiator of the permitted service: Server, a Client, or Both. 
6. Select the address object or address group for the resource.
7. Add the FW/VPN device through which traffic can reach the protected resource.

a. In the Security Gateway area, click the Add icon to display the Security 
Gateway dialog box.

b. Select FW/VPN device or device group
c. Select the security zone on the FW/VPN device that contains the address 

objects.
d. Click OK to add the security gateway to the protected resource.

You can add multiple security gateways to provide redundant access for the 
protected resource.
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You can edit protected resources to accommodate changes in your network:

• If you make changes to a protected resource object that is used in a VPN, 
NetScreen-Security Manager automatically generates new configuration and 
propagates your changes to all affected FW/VPN devices. 
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• If you change the FW/VPN device that protects a resource, NetScreen-Security 
Manager removes the previous FW/VPN device from all affected VPNs and adds 
the new FW/VPN device. However, NetScreen-Security Manager does not 
configure the VPN topology for the new FW/VPN—you must reconfigure the 
topology to include the new device manually.
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In an AutoKey IKE VPN, you can use the Internet Key Exchange (IKE) protocol to 
generate and distribute encryption keys and authentication algorithms to all VPN nodes. 
IKE automatically generates new encryption keys for the traffic on the network, and 
automatically replaces those keys when they expire. Because IKE generates keys 
automatically, you can give each key a short life span, making it expire before it can be 
broken. By also exchanging authentication algorithms, IKE can confirm that the 
communication in the VPN tunnel is secure.

Because all security parameters are dynamically assigned, VPN nodes must negotiate the 
exact set of security parameters that will be used to send and receive data to other VPN 
nodes. To enable negotiations, each VPN node contains a list of proposals; each proposal is 
a set of encryption keys and authentication algorithms. When a VPN node attempts to 
send data through the VPN tunnel, IKE compares the proposals from each VPN node and 
selects a proposal that is common to both nodes. If IKE cannot find a proposal that exists 
on both nodes, the connection is not established.

IKE negotiations include two phases:

• In Phase 1, two members establish a secure and authenticated communication 
channel. 

• In Phase 2, two members negotiate Security Associations for services (such as 
IPsec) that require key material and/or parameters.

By default, NetScreen-Security Manager includes several common IKE phase1 and phase 
2 proposals. To view these proposals, open VPN Manager and select IKE Phase1 
Proposals or IKE Phase2 Proposals. 
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Create a custom proposals for a specific combination of authentication and encryption 
that is not available in the predefined proposals, or to match the name of proposals on a 
non-NetScreen FW/VPN device. 

To create a custom IKE Phase1 proposal, select Custom IKE Phase1 and click the Add 
icon. Enter a name and choose a color for the object, then configure the following settings:

• Authentication Method. Select the authentication method.
– Preshared Key. Use this option to generate an ephemeral secret and 

authenticate data using MD5 or SHA hash algorithms against the secret.
– RSA Certificate. 
– DSA Certificate. 
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• Diffie-Hellman Group. The Diffie-Hellman group provides asymmetric 
encryption to encrypt the keys needed to decrypt the data. The larger the 
modulus of the group, the more secure the generated key is—and the more time 
it takes to generate the key. Select the group that meets your security 
requirements and user needs:

– Group 1. Uses a 768-bit modulus. 
– Group 2. Uses a 1024-bit modulus.
– Group 5. Uses a 1536-bit modulus.

• Encryption Algorithm. Select the algorithm that meets your security 
requirements: 

– DES-CBC
– 3DES-CBC
– AES-CBC (128 Bits)
– AES-CBC (192 Bits)
– AES-CBC (256 Bits)

• Hash Algorithm. Select the algorithm that meets your security requirements.
– MD5. Authenticate data using Message Digest version 5. 
– SHA-1. Authenticate data with Secure Hash Algorithm-1.

• Lifetime. Enter the number of seconds before the key is regenerated. The 
default value is 28800 seconds (8 hours).

Click OK to add the custom IKE object to the management system.
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Create a custom proposals for a specific combination of authentication and encryption 
that is not available in the predefined proposals, or to match the name of proposals on a 
non-NetScreen FW/VPN device. 

To create a custom IKE Phase2 proposal, select Custom IKE Phase2 and click the Add 
icon. Enter a name and choose a color for the object, then configure the following settings:

• Perfect Forward Secrecy. PFS ensures that a single key permits access to 
data protected by that single key. The key used to protect transmission of data 
and the material used to create that key are used only once and are not used to 
derive additional keys. Select the DH group to encrypt the key:

– No Perfect Forward Secrecy. 
– Diffie-Hellman Group 1. 
– Diffie-Hellman Group 2. 
– Diffie-Hellman Group 3. 

• Lifetime (Seconds). Enter the number of seconds before the key is 
regenerated. The default value is 3600 seconds (8 hours).

Note: NetScreen FW/VPN devices use hardware encryption for DES and 
3DES and use software encryption for AES.
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• Lifesize (KB). Enter the number of bytes permitted through the connection 
before the key is regenerated. A value of 0 (the default) means no limit. 

• Encryption (ESP) or Authentication (AH) Algorithm. 
– Select ESP to configure encryption and authentication, then select the 

desired algorithms. 
– Select AH to configure authentication only, then select the desired 

algorithm.

Click OK to add the custom IKE object to the management system.
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• About Security Policies

• Configuring Firewall Rules

• Configuring Multicast Rules

• Installing Security Policies

• Managing Rules & Policies

Because all incoming and outgoing network traffic passes through your firewall, it is the 
ideal location to control the traffic flowing on your network. Creating Security Policies 
enables you to define what type of traffic should be permitted on your network, as well as 
how that traffic is treated while inside. Each Security Policy contains firewall rules (Zone 
rulebase rules and Global rulebase rules) and multicast rules.

Firewall rules define access to your network, including permitted services, users, and 
time periods. You can also use firewall rules to control the shape of your network traffic as 
it passes through the firewall, or to log specific network events.

Multicast rules permit multicast control traffic, such as IGMP or PIM-SM messages, to 
cross Juniper Networks NetScreen FW/VPN devices. Multicast rules permit multicast 
control traffic only; to permit data traffic (both unicast and multicast) to pass between 
zones, you must configure firewall rules.

Using Juniper Networks NetScreen-Security Manager features like device groups, zone 
exceptions, and application-level detection, you can create a single, efficient Security 
Policy that manages multiple devices.
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A Security Policy defines how your managed devices handle your network traffic. 
NetScreen-Security Manager enables you to configure three Security Policy rulebases: 
Zone, Global, and Multicast, as detailed in the following sections.

After you create a Security Policy by building rules in one or more rulebases, you can 
assign that policy to specific NetScreen FW/VPN devices. For details on assigning a policy 
to a device, see “Assigning a Policy to a Device” on page 370.
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A rulebase is a set of rules. NetScreen-Security Manager supports three rulebases:

• The Zone rulebase contains rules that apply to traffic from one specific zone to 
another. Create a firewall rule in the zone-specific rulebase when you need to 
control traffic between specific zones. The zone-specific rulebase can contain 
firewall rules, VPN rules, and VPN links.

• The Global rulebase contains rules that are valid for across all zones. Create a 
firewall rule in the global rulebase when you need to control specific traffic 
across the entire firewall. The global rulebase can contain only firewall rules.

• The Multicast rulebase contains rules that enable IGMP proxy or PIM-SM 
multicast control traffic between zones.

The rules in all three rulebases combine to create a Security Policy. NetScreen FW/VPN 
devices process and execute rules in the Zone rulebase first, then rules in the Global 
rulebase, and finally rules in the Multicast rulebase.
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By default, all NetScreen FW/VPN devices deny all traffic. A rule is a statement that 
defines a specific type of network traffic; traffic must meet the rule requirements before it 
is permitted to pass through the NetScreen FW/VPN device. When traffic passes through 
the FW/VPN device, the device attempts to match that traffic against its list of rules. 
Network traffic that matches this list of requirements is considered to “match” the rule, 
and the device performs the action specified in the rule. If any requirement is not met, the 
network traffic does not match, and is denied.

You can create intrazone firewall rules, global firewall rule, multicast rules, VPN rules, 
and VPN links. You create all rules using the Security Policies in the NetScreen-Security 
Manager UI. Each Security Policy (all rulebases combined) can contain a maximum of 
40,000 rules.

Note: In the ScreenOS WebUI and CLI, a Security Policy is a single statement that 
defines a source, destination, zone, direction, and service. In NetScreen-Security 
Manager, those same statements are known as rules, and a Security Policy is a 
collection of rules.
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You create rule in the firewall rulebases to enable access across your networks by 
permitting or denying specific network traffic flowing from one zone to another zone. After 
you have added your NetScreen FW/VPN a device in NetScreen-Security Manager, you 
can create rules in the firewall rulebases of your Security Policy.

You can build multiple firewall rules in both firewall rulebases for a single device; these 
rules combine to create a Security Policy that determines how your NetScreen FW/VPN 
device handles traffic. To simplify your Security Policy, use device groups to build access 
rules that apply to all your perimeter NetScreen FW/VPN devices, then apply the entire 
policy to the perimeter device group.
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Within a firewall rule, you specify where the traffic is coming from, where it is going, and 
what service it is using. You can also use firewall rules to authenticate users, monitor 
network traffic flowing between zones, or set a schedule on a firewall rule that controls 
the time period that the rule is applied to network traffic.

When creating firewall rules, consider the type, location, and functionality of each 
NetScreen FW/VPN device in your network. Typically, a single Security Policy for 
multiple devices works well for devices that perform similar functions, such as perimeter 
firewalls. However, you might want to create a separate Security Policy per device when 
the management system contains separate administrators with regional responsibilities, 
or when you need to troubleshoot a device issue (use one Security Policy per device to 
enable an admin to troubleshoot on one device without making policy changes on other 
devices).

A firewall rule must contain the following elements:

• Direction. The direction that the traffic flows between two zones; all traffic 
flows from a source zone to a destination zone. You can select any zone for source 
or destination; however, the zones must be valid for the NetScreen FW/VPN 
devices you select in the Install On column of the rule. You can also use zone 
exceptions to specify unique to and from zones for each device. 

• Source address. The address that initiates the traffic.
• Destination address. The address that receives the traffic. 
• Service. The application-level protocol that the traffic uses to transmit data.
• Action. The action the NetScreen FW/VPN device performs when it receives 

traffic that matches the direction, source, destination, and service.
• Install On. The NetScreen FW/VPN device on which the firewall rule is 

installed. You can install the same rule on multiple devices.

To begin configuring firewall rules for your managed devices, see “Configuring Firewall 
Rules” on page 356.

Note: On NetScreen vsys devices, rules defined in the root system do not affect rules 
defined in virtual systems.
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The rules for your rule-based VPNs appear in the Zone rulebase. 

• Use VPN Links for VPNs created in VPN Manager. By default, VPN Manager 
autogenerated rules are implicitly executed as the first rule in the Zone 
rulebase, even though they do not appear. Because VPN Manager autogenerates 
the access rules for the VPN, you do not need to manually create them in the 
rulebase itself. However, to specify the exact location of the autogenerated rules 
in your rulebase, you can add a VPN link anywhere in the Zone rulebase.

• Use VPN Rules for VPNs created manually. If you did not use VPN Manager to 
create a rule-based VPN, you must manually add the VPN rules to create the 
VPN tunnel. You can place VPN rules anywhere in the Zone rulebase.

Because routing-based VPNs are on always-on connection between two or more 
termination points, you do not need VPN rules to create the routing-based VPN tunnel. 
However, you might want to create access rules to control the flow of traffic in a routing-
based VPN tunnel. For details on adding VPN links or VPN rules, see Chapter 9, 
“Configuring VPNs”.

*%�	��,	 ��?��	"�
A rule group is a user-defined grouping of rules within the Zone rulebase. Combining 
rules into a rule group can help you better manage rules. For example, you might want to 
combine your VPN rules in a single rule group, or combine all rules that manage traffic 
from a specific interface on the FW/VPN device.

You can add, edit, and delete rule groups; however, deleting a rule group also deletes all 
rules within that group. You can create multiple rule groups (40,000 rules max in a 
Security Policy). NetScreen-Security Manager supports one level of rule groups; you 
cannot create a rule group within a rule group.

For details on using rule groups, “Using Rule Groups” on page 376.
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By default, NetScreen FW/VPN devices do not permit multicast control traffic such as 
IGMP or PIM-SM messages. If you run IGMP proxy or PIM-SM on your network, you 
must configure rules in the Multicast rulebase to explicitly permit multicast control traffic 
between zones. 

You can also configure multicast rules to translate multicast addresses. For example, to 
translate a multicast group address in an internal zone to a different address on the 
outgoing interface, specify both the original multicast address and the translated 
multicast group address in a multicast rule.

When you create a multicast rule, you must specify the following:

• Source zone. The zone from which traffic initiates.

Note: You cannot create rule groups in the Global or Multicast rulebases.
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• Destination zone. The zone to which traffic is sent.
• Multicast group. The multicast group or access list that specifies the multicast 

groups for which you want the NetScreen FW/VPN device to permit multicast 
traffic.

Multicast rules control the flow of multicast control traffic only. To permit data traffic 
(both unicast and multicast) to pass between zones, you must configure rules in a firewall 
rulebase.

To begin configuring multicast rules for your managed devices, see “Configuring Multicast 
Rules” on page 367.
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Within Security Policies, you can manage individual rules in each rulebase, including:

• Determining the order that rules are applied to network traffic by placing the 
rules in the desired sequential order.

• Disabling a rule.
• Negating source or destination addresses (ScreenOS 5.x devices only).
• Verifying Security Policy

For details on managing your Security Policy, see “Managing Rules & Policies” on page 
375.

Note: You cannot create rule groups within the Global or Multicast rulebases.
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A firewall rulebase controls traffic flow on your network, from one network component to 
another network component. To do this, the firewall must know the path that the traffic 
takes to reach its destination and the service the traffic uses to get there.

When creating your firewall rules, you must specify the areas in your network that the 
traffic passes through. These areas include the network components that originate and 
receive the traffic, and the firewall zones the traffic passes through.

The Match columns of a firewall rule are required:

• The Destination Address, Source Address, Service, and Action are required for 
all rules in the Zone and Global rulebases.

• The To Zone, From Zone, and service are required for rules in the Zone rulebase.

The remaining columns are optional.

/��
�
������<
The following sections detail the Match columns of a firewall rule.
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In the Zone rulebase, you create firewall rules to enable traffic to flow between zones 
(interzone) or between two interfaces bound to the same zone (intrazone). You must create 
zones on your NetScreen FW/VPN device before you can create a rule for that device. In a 
single rule:

• You must select a single zone for the source zone and a single zone for the 
destination zone. These zones must be available on the FW/VPN devices you will 
install the policy on.

• You can also select multiple zone exceptions for both source and destination 
zones. A zone exception includes a specific zone and the device that contains that 
zone. 

The Global rulebase does not contain source and destination zone columns. Because global 
rules permit or deny traffic flow between all zones on the FW/VPN device, both the source 
and destination zones are global and so are not displayed.
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You create firewall rules to enable traffic to flow between two network components. In the 
NetScreen-Security Manager system, address objects are used to represent the 
components on your network: hosts, networks, servers, etc. When you add the address 
object to the rule, you are assigning it to a security zone on your NetScreen FW/VPN 
device.

You must create Address Objects for the network components that originate and receive 
the traffic before you can create a firewall rule to control traffic between those 
components.
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To control incoming Internet traffic to your trusted network, set the From Zone to Untrust 
and the To Zone to Trust. Set the source address as any and the destination to the address 
object that represents your trusted network. Your rule is similar to the example below:

To create a broader rule that controls traffic between multiple network components, 
create Address Object groups and use them in your firewall rules as you would other 
address objects. However, because FW/VPN devices running ScreenOS 4.0.x apply 
firewall rules to each address object separately, using address object groups can quickly 
decrease the number of available internal logical rules. If you must use address groups for 
both the source and destination, ensure that these groups are as small and as specific as 
possible.
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To control traffic from your Marketing servers to your Engineering Servers, set the To 
Zone to Engineering and the From Zone to Marketing. Set the source address as the 
address group object that represents your Marketing servers, and the destination address 
to the address group object that represents your Engineering servers. Your rule is similar 
to the example below:

The more specific you are in defining the source and destination address in a firewall rule, 
the better your firewall performance.
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Services are application layer protocols that define how data is structured as it travels 
across the network. In NetScreen-Security Manager, Service Objects represent the 
services running on your network. In a firewall rule, you specify which services are 
supported by the destination address object.

Note: All services rely on a transport layer protocol to transmit data. NetScreen-
Security Manager includes services that use TCP, UDP, RPC, and ICMP transport 
layer protocols.



Chapter 8 Configuring Security Policies

358 Administrator’s Guide

NetScreen-Security Manager comes with several service objects based on industry-
standard services already created for you. You use these predefined service objects in 
firewall rules to specify the services that traffic can use to traverse your network.
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To control FTP traffic from the Engineering Server in the trust zone to the corporate Web 
Server in the DMZ zone, select the FTP, HTTP, IMCP ANY, and TELNET service objects. 
Your rule is similar to the example below:

You can create your own Service Objects to use in rules using the Object Editor, such as 
Service Objects for protocols that use non-standard ports.
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If you use a non-standard port (8080) for your HTTP services, create an HTTP Service 
Object on port 8080. Add this Service Object to your firewall rule. NetScreen-Security 
Manager uses the specified service object, HTTP on port 8080, and considers all 
connections to TCP/8080 to be HTTP connections. Your rule is similar to the example 
below:

If the service of the network traffic matches a service selected in the rule, the firewall 
performs the action. 
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You can specify the action that your NetScreen FW/VPN device performs against traffic 
that matches the zones, address objects, and services specified in the firewall rule. You 
can set different actions for each rule:

Note: For firewall rules installed on a ScreenOS 5.x device, if you use a custom 
service to relocate an application to a non-standard port, you must also enable the 
Application option in the Rule Options > Miscellaneous > ScreenOS 5.x devices. 
For details, see “ScreenOS 5.x Options” on page 363.
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• Permit. Your NetScreen FW/VPN device permits the traffic to pass through 
firewall to its destination address.

• Deny. You NetScreen FW/VPN device does not permit the traffic to pass 
through the firewall, and drops all associated packets.

When you permit traffic, you can also:

• Use logging to monitor suspicious or abnormal uses of permitted traffic (such as 
excessive Web surfing).

• Use AntiVirus to detect viruses in permitted traffic.
• Use Attack Protection to detect and prevent attacks in permitted traffic.
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In the install on column, select the device/s that receive and use this rule. You can select 
multiple NetScreen FW/VPN devices on which to install the firewall rule. 

After you have created the Security Policy and assigned it to a device, NetScreen-Security 
Manager only installs the rule on the devices specified in the Install Column of the rule, 
enabling you to use a single Security Policy for multiple NetScreen FW/VPN devices.

To see the exact rules that are applied to a specific device, in Device Manager, right-click 
a device and select Policy > View Pending Device Policy. 
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Rule options enable you to configure additional protection mechanisms (such as AntiVirus 
or Deep Inspection) as well as logging, traffic shaping, NAT, and other miscellaneous 
features. 

To quickly configure all rule options, right-click the Rule Options column and select 
Configure All Options. The Configure Options dialog box appears; select the option tab 
you want to configure for the rule. 
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You can configure policy-based network address translation (NAT) for a firewall rule. 
NAT enables the FW/VPN device to translate the IP address of incoming or outgoing 
traffic so that the packets are routable on the network.
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You can configure the NetScreen FW/VPN device to translate the source IP address:

Note: For firewall rules, the VPN action to “tunnel” is not available.
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• To translate the source IP address using a predefined range of IP addresses, 
select NAT and choose a Dynamic IP pool (DIP) object. For each matching 
packet, the device translates the original source address into a IP address 
selected from the DIP pool.

• To translate the source IP address using the IP address of the outgoing interface 
on the NetScreen FW/VPN device, select Use Interface.
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You can configure NetScreen FW/VPN devices running ScreenOS 5.x to translate the 
destination IP address. Enable Destination NAT and enter the destination IP address you 
want to translate to. 

Other destination NAT options include:

• Destination Port. Your NetScreen FWVPN devices can perform one-to-one 
destination NAT without changing the destination port numbers. However, you 
can configure the device to map the original destination port number in the 
segment header to another port number. 

– To enable destination port translation, select Destination Port and enter 
the port number you want to translate to.

– To use the original destination port number, leave the default of None.
• Upper IP Address. Your device can also translate the destination IP address to 

a range of IP addresses. Select the Upper IP Address and enter the upper IP 
address. The device uses an address shifting mechanism to maintain the 
relationships among the original range of destination addresses after 
translating them to the new range of addresses.

Using Device Manager, you can also implement NAT on any device interface in any zone 
except Untrust. For details, see Chapter 4, “Configuring Devices”. For details on 
configuring NAT objects, see Chapter 7, “Configuring Objects”.
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You can use a GTP object in a firewall rule to control how your NetScreen FW/VPN 
devices handle GPRS traffic. To add a GTP object, you must have already configured the 
object in Object Manager. For details, see “Configuring GTP Objects” on page 311.
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You can control the amount of bandwidth that is available to the matching network traffic 
in a rule. You can also define a priority that defines how the NetScreen FW/VPN device 
handles the matching network traffic that exceeds the defined maximum bandwidth.

To set the minimum, or guaranteed bandwidth that is available to matching network 
traffic, enter the number of kilobits per second (kbps). This setting determines the 
minimum amount of throughput for the rule. The NetScreen FW/VPN device 
automatically passes matching traffic that has less than this throughput.
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To set the maximum bandwidth available to the matching traffic, enter the number of 
kilobits per second (kbps). This setting determines the maximum amount of throughput 
for the rule. The NetScreen FW/VPN device throttles and drops matching traffic that has 
more than this throughput.

For matching traffic that falls between the guaranteed and maximum settings, your 
NetScreen FW/VPN device passes traffic based on the priority setting.
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You can set a priority for each firewall rule in your Security Policy. Your NetScreen FW/
VPN device passes permitted traffic according to the priority level specified in the 
matching rule. The higher the priority level of the rule, the faster the matching traffic for 
that rule passes.

NetScreen-Security Manager uses the Differentiated Services Code Point (DSCP) 
mechanism to set priority levels. Using DSCP, you can mark traffic at a position within a 
hierarchy of priority. You can map the eight NetScreen priority levels to the DiffServ 
system: Priority 0 is the highest priority, and priority 7 is the lowest priority. Each 
priority level maps to a specific set of bits in the DiffServ field or the IP precedence field in 
the ToS byte of the IP packet header.

For details on changing the default mappings between priority levels and the DiffServ 
system, see “Configuring Traffic Shaping” on page 234. For more details on Traffic 
Shaping, see the ScreenOS Concepts & Examples Guide 5.0.
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A good Security Policy generates enough log entries to fully document only the important 
security events on your network. However, if you need to keep a record of all log entries 
for archiving and accountability, you can design your rule to log every security event. For 
critical events, you might even want to be notified immediately by email or set an alert to 
appear in the log entry.

Log entries appear in real-time in the Log Viewer, and are also used in the Log 
Investigator for cross-tabulation of security events. Your goal is to fine-tune the 
notifications in your Security Policy to your individual security needs.
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To log an event for a rule, enable logging. Each time your NetScreen FW/VPN device 
matches network traffic to the rule, the device creates a traffic log entry that describes 
that event and NetScreen-Security Manager displays the traffic log entry in the Log 
Viewer. For a list of possible traffic log entries, see “Traffic Log Entries” on page 649.

Note: Juniper Networks recommends that you do not set the maximum bandwidth 
to less than 10 kbps. Your NetScreen FW/VPN device might drop packets or the 
source address might attempt to resend the traffic repeatedly.
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Depending on your security needs, you might want NetScreen-Security Manager to 
provide additional notification when a rule is matched, such as an alert in the log entry. 
An alert is a notification icon ( ) that appears in a log entry in the Log Viewer. When 
you enable alerts in your firewall rule and traffic matches that rule, the device generates 
a traffic log entry that includes an alert. Alerts can help you quickly identify specific 
network traffic, such as critical severity attacks.

You must enable logging before you can enable alerts.
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Counting and alarms work together to help you track the amount of traffic that is 
matching your firewall rule. Counting enables the device to count the number of bytes in 
network traffic that matches the firewall rule. Using this data, the device can them 
generate alarms that notify you when the matching network traffic falls outside your 
predefined byte range.

To set an alarm, enable counting and specify the minimum and maximum byte thresholds 
for matching network traffic. You can specify a predefined number of bytes per second, 
number of Kilobytes per minute, or both (a value of 0 indicates that the alarm is disabled). 
Each time your NetScreen FW/VPN device detects network traffic that exceeds the alarm 
threshold in the rule, the device generates an alarm log entry for that describes that event 
and displays it in the Log Viewer. For a list of possible alarm log entries, see “Alarm Log 
Entries” on page 614.

You must enable counting before you can enable alarms. Although you can enable 
counting without also enabling alarms, NetScreen-Security Manager does not use the 
counting data except to trigger alarms. If you do not intend to use alarms, you should 
leave counting disabled. Additionally, because counting can impact performance during 
heavy traffic periods, you should enable counting and alarms only for firewall rules that 
detect important activity.
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The following sections detail the Miscellaneous rule options.
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To control the time period that your NetScreen FW/VPN device applies the rule to your 
network traffic, you can define a schedule for the rule. If you define a schedule, the 
NetScreen FW/VPN device applies the rule to your network traffic only during the time 
period specified in the schedule; if you do not specify a schedule, the rule is always applied 
to your network traffic.

In NetScreen-Security Manager, schedules are represented by Schedule Objects. Before 
you can define a schedule for rule, you must create a Schedule Object that describes a 
time period. The Schedule Object details the start time and date, end time and date, and 
frequency (recurring or one-time) of the time period. For more details on creating 
Schedule Objects, see Chapter 7, “Configuring Objects”.
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You can use schedules to control the flow of network traffic at a time-sensitive level, and 
also enhance your network security. 
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To prevent employees from downloading large files during business hours, set the Service 
Object to FTP, the Action to deny, and configure traffic shaping to limit bandwidth. Using 
the Object Manager, create a Schedule Object called Business Day that describes the time 
period of 9:00am to 7:00pm, M-F, recurring weekly. Right-click the schedule column in the 
rule and select the Business Day schedule object.
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NetScreen-5XT and NetScreen-5GT FW/VPN devices can disable active firewall rules 
that permit traffic if the session switches over to the modem link. This feature is ON by 
default.
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For FW/VPN devices running ScreenOS 5.x, you can configure additional rule options.

• Application. You can configure the FW/VPN device to handle the service for 
the firewall rule as a known Layer 4 protocol service. If you are using application 
relocation (using a nonstandard port to handle an application service), enable 
this option to ensure that the NetScreen FW/VPN device correctly checks traffic. 

• URL Filtering. If you are using an integrated WebSense system with a 
ScreenOS 5.x device, you can enable URL filtering.
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You can authenticate the identity of the user who is generating the network traffic. When 
you enable authentication in the rule, the user must authenticate future network traffic 
by supplying a user name and password in an initial, separate HTTP, FTP, or Telnet 
connection. If the user fails to authenticate using one of these services or provides 
incorrect credentials, the authentication requirement for the rule is not met and the 
network traffic is denied. (Typically, when you enable authentication, you also use the 
permit action.)
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Authentication enables you to control which RAS users can connect to the protected 
network and how they can connect. When you select an authentication server, you must 
also configure the users that authentication server authenticates.

Select the authentication mechanism:

Note: You cannot enable authentication for a rule that includes the DNS/53 
Service Object.
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• No Authentication. Use this option to enable the specified RAS users to 
connect without authentication. 

• Authentication. Use for RAS users that use HTTP, FTP, or Telnet services to 
connect to the protected network.

• Web Authentication. Use for RAS users using HTTP to connect to the 
protected network.
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RAS users are represented by User Objects. Before you can authenticate a user in a 
firewall rule, you must create a User Object that defines the user name, user password, 
and the authentication location (local or external). For Authentication and Web 
Authentication, configure the users:

• User. Select the User object that represents the user you want to authenticate.
• User Group. Select the User Group object that represents the users you want to 

authenticate.
• Group Expression. Select the Group Expression object.
• Allow Any. Use this option to authenticate any user or user group.

To authenticate RAS users with Authentication, you must include HTTP, FTP, or Telnet 
service objects in the Service column of the rule. You can include other services as well, or 
select any to specify all services. To make a connection to the destination IP address in the 
rule, the RAS user first initiates an HTTP, FTP, or Telnet connection to the destination 
address; the FW/VPN device intercepts the request packet and responds with a login 
prompt for user credentials.

• If the destination address is a subnet, the remote user must authenticate for 
each IP address in that subnet.

• If the source address supports multiple remote user accounts (e.g., a Unix host 
running Telnet) OR is located behind a NAT device that uses a single IP address 
for all NAT assignments, only the first remote user from that source address 
must initiate and authenticate an HTTP, FTP, or Telnet connection. All 
subsequent remote users from that source address do not need to authenticate, 
and can pass matching network traffic to the destination address.

To authentication RAS users with Web Authentication, you must include HTTP service 
object in the Service column of the rule. To make a connection to the destination address 
in the rule, the RAS user first initiates an HTTP connection to the Web Authentication 
server. The FW/VPN device responds with a login prompt for user credentials.

For more details on User Objects, see Chapter 7, “Configuring Objects”.
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To configure AntiVirus protection for a firewall rule:

• None. No AntiVirus protection enabled.
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• Use AV Objects. AntiVirus objects represent specific viruses. You can use a 
maximum of three antivirus objects in a firewall rule to detect viruses in traffic. 

• Use Scan Manager. Scan Manager is an embedded scanning engine. To use 
Scan Manager, the NetScreen FW/VPN device you install the policy on must an 
NetScreen-5GT or NetScreen-Hardware Security Client device running 
ScreenOS 5.x. If you install a policy that uses Scan Manager on a different 
device, the device executes and processes traffic according to the rule, but does 
not detect viruses using the embedded scanning engine.
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The following sections detail the Attack Protection rule options. NetScreen FW/VPN 
devices running ScreenOS 5.x include Deep Inspection attack protection that can detect 
malicious network traffic at the application level.
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Attack objects represent specific patterns of malicious activity within a connection, and 
are a method for detecting attacks. Each attack object detects a known or unknown attack 
against your network. Use attack objects in your firewall rule to detect intrusion attempts 
within permitted traffic. When the device detects a match between the permitted network 
traffic and an attack object in the rule, the device generates an attack log entry. 

To use attack objects:

• The firewall action must be permit. You cannot detect attacks in traffic that the 
firewall denies.

• The NetScreen FW/VPN device you install the policy on must be running 
ScreenOS 5.x. If you install a policy that contains attack objects on a ScreenOS 
4.0.x device, the device executes and processes traffic according to the rule, but 
does not detect application-level attacks.

For a list of possible attack log entries, see “Deep Inspection Alarm Log Entries” on page 
616.
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Network security is an ongoing process of understanding what is normal traffic for your 
network. Eliminating malicious traffic is important, but identifying ambiguous traffic can 
be equally important. You do not always want to drop traffic that appears abnormal; you 
might want to reset the connection, block the attacker, simply log the event, or use all 
three methods.

Note: If you select the option Use AV Objects, you must select at least one 
object from the AntiVirus object list. Selecting this option without selecting 
AV objects results in a policy validation error.
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You can tell the firewall which actions to perform against attacks that match firewall 
rules in your Security Policy. For each attack that matches a rule, actions respond to 
matching traffic using one of the following actions: 
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Each attack object has a default severity level of info, warning, minor, major, critical. To 
override the default severity level for an attack object in your rule, select a different 
severity level.
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This option sets an alert on an event log entry for matching traffic. If your FW/VPN device 
matches network traffic to an attack object in the rule, NetScreen-Security Manager 
creates an event log entry that describes that attack (direction, service, and Attack object) 
and displays an alert in the Log Viewer.

This option is ON by default.
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Enter comments, if desired.

Action Description

none The firewall takes no action against the connection.

ignore The firewall ignores the remainder of a connection after an Attack group is 
matched.

drop packet The firewall drops a matching packet before it can reach its destination but does 
not close the connection. Use this action to drop packets for attacks in traffic that 
is prone to spoofing, such as UDP traffic. Dropping a connection for such traffic 
could result in a denial of service that prevents you from receiving traffic from a 
legitimate source IP address.

drop 
connection

The firewall drops the connection without sending a RST packet to the sender, 
preventing the traffic from reaching its destination. Use this action to drop 
connections for traffic that is not prone to spoofing.

close client 
and server

The firewall closes the connection and sends a RST packet to both the client and 
the server.

close client The firewall closes the connection to the client, but not to the server.

close server The firewall closes the connection to the server, but not to the client.
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A multicast rule is a statement that defines a specific type of multicast control traffic. 
When multicast control traffic passes through a NetScreen FW/VPN device, the device 
attempts to match that traffic against its list of rules. If a rule is matched, the device 
permits the traffic to pass through.

On NetScreen FW/VPN devices, you secure multicast control traffic using access lists. 
First, you create an access list, which defines one of the following:

• the multicast groups a host can join
• the sources from which traffic can be received

After creating an access list, you reference these access lists in a multicast rule in the 
Security Policy for the device.
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In the Multicast rulebase, you create rules to enable multicast control traffic to flow 
between zones. You must create zones on your NetScreen FW/VPN device before you can 
create a rule for that device. In a single rule:

• You must select a single zone for the source zone and a single zone for the 
destination zone. These zones must be available on the FW/VPN devices on 
which you install the policy.

• You can also select multiple zone exceptions for both source and destination 
zones. A zone exception includes a specific zone and the device that contains that 
zone. 
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When you create a multicast rule, specify the multicast groups for which you want to 
permit multicast traffic using one of the following methods:

• Specify a multicast group IP address, and optionally, the multicast group 
address on the outgoing interface

• Specify the access list that identifies the permitted multicast groups 
• Select “any” to accept traffic for all multicast groups

����
�	�
���,	 ���"�
���
Rule options enable you to specify the type of multicast control traffic to which this rule 
applies and whether the rule is bidirectional. 

A rule can apply to either IGMP messages or PIM-SM messages:

• When running IGMP proxy on the NetScreen FW/VPN device, configure a rule 
that permits IGMP messages to flow between zones.

• When running PIM-SIM on the NetScreen FW/VPN device, configure a rule that 
permits PIM-SM messages.
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In this example, you define a multicast rule that permits IGMP messages from the Trust 
zone to the Untrust zone. You specify the original multicast group address object and a 
different destination multicast group object.

1. Create the multicast group address objects:

a. In the main navigation tree, select Object Manager > Address Objects.
b. In the main display area, click the Add icon and select Multicast Group. 

The New Multicast Group dialog box appears. 
c. Configure the object as shown below:

d. In the main display area, click the Add icon and select Multicast Group. 
The New Multicast Group dialog box appears. 

e. Configure the object as shown below:

2. In the main navigation tree, select Security Policies, then create a new multicast 
rule in the Multicast rulebase of a new or existing Security Policy.
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3. Right-click in the Source Group column and select Configure Source/
Destination. Configure as shown below:
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After you have successfully verified your Security Policy, you must: 

1. Assign the policy to your managed devices
2. Validate the policy
3. Install the policy on your managed devices

The following sections detail each step.
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New devices do not have existing or default Security Policy. However, when you import a 
device configuration, NetScreen-Security Manager automatically imports all existing 
policies for the device. To simplify policy management, you can merge these multiple 
device policies into a single Security Policy that you install on several devices at one time. 
For details, see “Merging Policies” on page 377.

After you have created a Security Policy, you must assign that policy to a device. 
Assigning a policy to a device links the device to that policy, enabling NetScreen-Security 
Manager to install the policy on that device. To assign an existing policy to a device, use 
one of the following methods:

• Right-click a device and select Policy > Assign Policy. Select the policy you want 
to assign to the device.

• Double-click a device to open the device configuration. In the Info tab, under 
Policy for device, select the policy you want to assign to the device.

You can use a single Security Policy to control multiple NetScreen FW/VPN devices. Each 
rule in a Security Policy contains an Install On column that specifies the devices the rule 
is applied to. This means that you can assign a Security Policy to a device, but only some 
of the rules in that policy are actually installed on that device during a device update.

You can also create multiple policies for a single device, but only one Security Policy can 
be active on the device. When you update a device configuration, NetScreen-Security 
Manager installs the active policy on the NetScreen FW/VPN device. By default, 
NetScreen-Security Manager considers the active policy as the policy that was most 
recently edited.
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You should validate a Security Policy to identify potential problems before you install it. 
Common problems include:

• Rule Duplication. Occurs when one or more rules in the Security Policy are 
identical.

• Zone Mismatch. Occurs when the source or destination zone you have chosen 
in a rule is not available on the device you selected in the Install On column.

Note: If you delete and then re-import a device, you must reassign a policy to the device.
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NetScreen-Security Manager contains a Policy Validation tool to help you locate 
additional problems, such as rule shadowing and unsupported options.

To validate a policy, from the menu bar click Devices > Policy > Validate Policy. A Job 
Manager window appears to display job information and progress. Policy validation 
analyzes the source and destination addresses, the to and from zones, and the service 
when validating. If NetScreen-Security Manager identifies any problems in the policy 
during policy validation, it displays information about the problem at the bottom of the 
selected rulebase.
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Policy validation can identify rule shadowing, a problem that occurs when two rules are 
designed to detect the same attack. Eliminating rule shadowing in your policy improves 
the performance of your NetScreen FW/VPN device. To correct, return to the rule that is 
shadowing and modify or delete it. NetScreen-Security Manager validates rules according 
to the ScreenOS version that is running on the device in the Install On column:

• For ScreenOS 4.0.x devices, each item the rule is treated as a separate rule. For 
example, a rule with two service objects (AOL and DNS) is sent to the device as 
two rules, one rule with AOL and another with DNS.

• For ScreenOS 5.x devices, a rule can contain multiple items. For example, a rule 
with two or more service objects is sent to the device as one rule.

For example, the following policy contains rule shadowing:

If you install this policy on a ScreenOS 4.x device, rule validation fails because rule 2 
shadows rule 1 (the device receives two rules from the same source/destination that use 
HTTP). However, a ScreenOS 5.x device passes.

Note: Juniper Networks highly recommends that you validate a policy before 
installing. A policy that has internal problems can leave your network vulnerable.

Note: To use the Policy Validation tool to validate a policy, you must first assign 
the policy to a device.
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Policy Validation can also identify unsupported options in your Security Policy. Because 
different NetScreen FW/VPN devices and system support different features and options, 
policy validation checks the rules in the policy to ensure that the devices specified in the 
Install On column of the rule can support the Rule Options configured for the rule. 

Some examples of unsupported option messages are included below:

• ’Permit/Tunnel’ Rules from home zone to work zone is not allowed on a Dial 2 
Device (except when NSRP Lite enabled). Will be trimmed before an Update 
Device.

• Destination NAT Options not available on 4.0.x devices.Will be trimmed before 
an Update Device.

• Antivirus Option not available on 4.0.x devices.Will be trimmed before an 
Update Device.

• Deep Inspection Option not available on 4.0.x devices.Will be trimmed before an 
Update Device.

• Schedule option is not supported on a Vsys Device.

For example, if you configure a firewall rule option (such as AntiVirus protection or Deep 
Inspection) that is not supported by the NetScreen FW/VPN device in the Install On 
column of the rule, policy validation displays an information message that describes the 
unsupported feature. 
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Before you install a Security Policy, ensure that you have:

• Assigned the policy to your devices. After you have created a Security 
Policy, you must assign that policy to the devices you want to use that policy. 
Assigning a policy to a device links the device to that policy, enabling NetScreen-
Security Manager to install the policy on that device.

• Selected the correct devices for the Install On column of each rule. A 
NetScreen FW/VPN device can only use one Security Policy at a time; when you 
install a new policy, it overwrites all existing policies on the NetScreen FW/VPN 
device.

• Configured each device in the Install On column of each rule correctly. 
When you push a policy to a device, you also push the device configuration to the 
device. Any changes made (by you or another admin) to the device configuration 
are pushed to the device along with the policy.

• Configured rules in the Zone, Global, and Multicast rulebases correctly. 
The management system installs rules from all rulebases on the specified 
device—Global rules first, then Zone rules, then Multicast rules.
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• Configured the VPN rules or VPN links in the policy correctly. The 
management system installs all VPN rules in the policy. 

To help you identify possible problems in your policy, you might want to run a Delta 
Config Summary before pushing the policy.
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When you install a policy, NetScreen-Security Manager installs the rules in the policy on 
the NetScreen FW/VPN devices you selected in the Install On column of each rule. The 
install process occurs between the management system and your managed devices. 

First, the GUI Server creates the ADM file that contains all policies for all devices 
selected for update (although the ADM file collects information from all policies, it does 
not merge the policies) The GUI Server sends the ADM to the Device Server. Next, the 
NetScreen-Security Manager Device Server receives the ADM and uses it to create a 
separate, individual DM for each device that you selected for update:

• For 5.x devices, the Device Server sends the DM to the managed device, which 
translates the information in the DM into commands and runs those commands 
on the devices.

• For 4.0.x devices and earlier, the Device Server translates the DM into 
commands and send those commands to the managed device, which runs those 
commands.

For details on the device ADM and DM, see the Chapter 6, “Managing Devices”. 

�"(��
����� 
�
��
To install a policy, from the toolbar, select Devices > Configuration > Update Device 
Config. If you changed the device configuration or assigned policy for a device, that device 
is automatically selected. Unselect any devices you do not want to update, and click OK.
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The Job Manager task window appears and displays the progress of the policy 
installation. After the task has completed, close the Job Manager window. The rules in 
the policy become active on the devices you selected in the Install On column of the rule.

To see the exact rules that were applied to a specific device, in Device Manager, right-click 
a device and select Policy > View Pending Device Policy. 
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Managing rules and policies for multiple FW/VPN devices can seem daunting at first. 
Take some time to carefully design your policies to make them efficient. Because a device 
can have only one Security Policy installed at a time, you must include all rules for that 
device in one policy.

Some helpful tips about managing your rule and policies:

• The Security Policies navigation tree lists Security Policies alphabetically. You 
can create (or import) an unlimited number of Security Policies.

• Each Security Policy contains a default firewall rulebase (Zone); you can add a 
second and third rulebase (Global and Multicast) to create global firewall rules 
and multicast rules.

• Each rulebase can contain one or more rules, up to 40,000 max for the Security 
Policy. The top rule in the rulebase is rule 1, and second rule is rule 2, and so on. 
To combine rules for easier management, you can create rule groups.

• Each rule group can contain one or more rules, up to 40,000 max for the Security 
Policy. Rules within a rule group follow the rulebase numbering sequence.
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A zone exception is a powerful tool that can help reduce the number of rules in your 
Security Policy while maintaining the same functionality. Zone exceptions add flexibility 
to your rules, enabling you to include more devices in a single rule.
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To view rules that handle traffic between zones, use the Filter on From and To Zones 
menus in the Zone rulebase.
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To select a single rule, click anywhere in the rule; to select multiple rules, press CTL and 
select the desired rules. 
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To change the order of rules in a policy, right the No. Column (the first column) of a rule 
and select Move Rule Up or Move Rule Down.

��
����	�6���"�6�7������
To quickly create multiple rules that use the same basic information, copy and paste the 
rule, then change the parameters in each copied rule to make the rule unique (this is 
especially useful for rules that contain detailed rule options such as attack protection). 
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To cut and paste a rule, right-click inside the No. column (the first column) of the rule and 
select Edit > Cut. Next, select a rule that is above or below the position you want to paste 
the cut rule into, then select Edit > Paste > <above> <below>. 
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To delete a rule, right-click inside the No. column (the first column) of the rule and select 
Delete. You can also delete a rule group; however, deleting the rule group also deletes all 
rules within the rule group.
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To disable a rule, right-click inside the No. column (the first column) of the rule and select 
Disable. The rule remains in the rulebase, but displays a gray diagonal stripe to indicate 
that it has been disabled. While the rule is disabled, NetScreen-Security Manager does 
not install the rule on any devices.

To enable a rule, right-click inside the No. column (the first column) of the rule and select 
Disable again to clear the checkbox. You can disable rule groups using the same method.
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To create a rule group, press Ctrl and select the rules you want to include in the group, 
then right-click and select create rule group. Enter a name and description for the rule 
group, then click OK.

Combining rules into a rule group can help you better manage rules. For example, you 
might want to create rule group for:

• VPN rules or VPN links
• Rules that manage traffic from a specific zone or interface on the FW/VPN 

device
• Rules for a specific device or device group
• Rules that provide attack or AV protection
• Rules that manage VoIP traffic with GTP objects

You can add, edit, and delete rule groups; however, deleting a rule group also deletes all 
rules within that group. 

You can create multiple rule groups (40,000 rules max in a Security Policy). NetScreen-
Security Manager supports one level of rule groups; you cannot create a rule group within 
a rule group.

Note: The cut rule remains visible in its original position until you paste it into its 
new position.
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When you import policies from a single managed device, those policies appear in 
NetScreen-Security Manager as rules in a new policy. Each device policy is imported as a 
single rule, and the rules make up the policy that exists on the device.

To simplify policy management and maintenance, you can merge two policies into a single 
Security Policy. To merge two policies, select a source policy and a target policy:

• The source policy contains the rules that you want to merge into another policy 
(in the UI, this is the From Policy).

• The target policy receives the rules from the source policy (in the UI, this is the 
To Policy).

NetScreen-Security Manager copies the rules from the source policy and pastes them 
above, below, or inline with the rules in the target policy. When placing rules inline, be 
aware of the intra-policy dependence of both policies. Because rule order is important 
(rules are executed top-down), rules can be dependant on other rules. If you rearrange the 
order of dependant rules by inserting merged rules, the NetScreen FW/VPN device 
changes the way it handles the packets. If you are unsure if you have intra-policy 
dependence in your rules, it’s best to merge rules above or below the existing rules.

After creating a single Security Policy that contains both source and target rules, 
NetScreen-Security Manager also identifies rules that contain similar values in the 
source, destination, service, and install on columns, then collapses those rules into a 
single rule. NetScreen-Security Manager does not collapse rules that contain different 
zones, or rules that refer to unique VPNs.

Occasionally, you might need to delete and then re-add a NetScreen FW/VPN device to 
NetScreen-Security Manager. After you re-import the device configuration for a device 
that was previously managed by NetScreen-Security Manager, the management system 
automatically merges the imported device policy to the assigned policy (the Security 
Policy that was previously installed on the device before it was deleted).

You can merge any two Security Policies. To access the Policy Merge tool, select the 
Security Policies, then use the menu bar to select Tools > Policy Merge. See the Online 
Help for details.

Note: In the ScreenOS WebUI and CLI, a Security Policy is a single statement that 
defines a source, destination, zone, direction, and service. In NetScreen-Security 
Manager, those same statements are known as rules, and a Security Policy is a 
collection of rules.
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Policy A contains the following rules:

Policy B contains the following rules:
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To merge Policy A (from policy) with Policy B (to policy), from the file menu, select Tools > 
Policy Merge Tool and configure the merge as shown below:

NetScreen-Security Manager copies all rules from Policy A and pastes them above the 
rules in Policy B. Next, NetScreen-Security Manager merges the matching values in the 
columns to create a single, simplified policy (Policy C):
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• About VPNs

• Planning for Your VPN

• Preparing VPN Components

• Creating VPNs with VPN Manager

• VPN Manager Examples

• Creating Device-Level VPNs

• Device-Level VPN Examples

This chapter discusses the concepts involved in creating secure tunnels between devices, 
details the differences between VPN types, helps you determine the best VPN for your 
network, and guides you through creating and configuring your chosen VPN.

VPNs route private data through a public Internet. Like normal Internet traffic, data in a 
VPN is routed from source to destination using public Internet networking equipment. 
Unlike normal traffic, however, the source and destination use a Security Association 
(SA) pair to create a secure, private tunnel through which the data traverses the Internet. 
A tunnel has a defined start point and end point, (usually an IP address), and is a private 
connection through which the data can move freely. By encrypting and authenticating the 
data while in the tunnel, you can ensure the security and integrity of the data. 

VPNs can also connect widely distributed networks to make separate networks appear as 
a single Wide Area Network (WAN). VPNs replace costly point-to-point protocol (PPP) 
and frame relay connections that require dedicated lines (and sometimes even satellites!) 
between your private networks.

Note: For step-by-step instructions on creating VPNs, see the Online Help Topic “VPNs”.
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With Juniper Networks NetScreen-Security Manager, you can use basic networking 
principles and your Juniper Networks NetScreen FW/VPN devices to create VPNs that 
connect your headquarters with your branch offices and your remote users with your 
protected networks.

NetScreen-Security Manager supports tunnel and transport modes for AutoKey IKE, 
Manual Key, L2TP, and L2TP-over-AutoKey IKE VPNS in policy or route-based 
configurations. You can create the VPN at the system-level or device-level:

• System-Level VPN (VPN Manager). Design a system level VPN and 
automatically set up connections, tunnels, and rules for all devices in the VPN.

• Device-Level VPN (Device Manager). Manually configure VPN information 
for each NetScreen FW/VPN device, then add VPN rules to a Security Policy to 
create a policy-based VPN or configure routes on each FW/VPN device to create 
a route-based VPN.
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For AutoKey IKE and L2TP VPNs, create the VPN at the system-level using VPN 
Manager. VPN Manager supports:

• AutoKey IKE VPNs in policy-based or route-based modes. You can also create 
a Mixed-Mode VPN to connect policy-based VPN members to route-based VPN 
members in a single VPN.

• L2TP-over-AutoKey IKE RAS VPNs and L2TP RAS VPNs that can connect 
and authenticate multiple L2TP remote access services (RAS) users and 
protected resources with or without encryption.

• Re-usable VPN Components. Create objects to represent your protected 
resources, CA certificates and CRLs, custom IKE proposals, and NAT 
configurations, then use these objects in multiple VPNs.

• Compact and Expanded Views. Choose the Compact (default) or Expanded 
view to create your VPN. Both views offer the same configuration options.

• Autogenerated Tunnels. Create tunnel interfaces on each route-based VPN 
member automatically. Use the device tunnel summary to review all 
autogenerated tunnels in the VPN.

• Autogenerated VPN Rules. Create all VPN rules with a single click. 
NetScreen-Security Manager automatically generates the rules between each 
policy-based VPN member. You can review these rules, configure additional rule 
options (such as traffic shaping, attack protection, and logging), then insert the 
rules into a Security Policy. 

Note: Each VPN that a device belongs to reduces the maximum number of templates by 
one. This includes VPNs configured in VPN Manager and VPNs configured at the 
device-level. You can apply a maximum of 31 templates to a single device.
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To view all VPNs created with VPN Manager, select VPN Manager in the navigation tree. 
A list of saved VPNs appears in the main display area in table format. You can add and 
delete VPNs from this view. 

VPN Manager does not support Manual Key VPNs; to create a Manual Key VPN in 
NetScreen-Security Manager, you must create the VPN at the device-level in Device 
Manager.
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For Manual Key VPNs, create the VPN at the device-level by manually configuring VPN 
information for each FW/VPN device. 

After you have configured the VPN on each FW/VPN device in the VPN, add VPN rules to 
a Security Policy to create the VPN tunnel (for policy-based VPNs) or to control traffic 
through the tunnel (for route-based VPNs). 

You can also create AutoKey IKE, L2TP, and L2TP-over-AutoKey IKE VPNs at the 
device-level. 
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NetScreen-Security Manager supports all possible VPN configurations that are supported 
by the CLI and Juniper Networks NetScreen ScreenOS WebUI, including: 

• NAT-Traversal. Because NAT obscures the IP address in some IPSec packet 
headers, VPN nodes cannot receive VPN traffic that passes through an external 
NAT device. To enable VPN traffic to traverse a NAT device, you can use NAT 
Traversal (NAT-T) to encapsulate the VPN packets in UDP. If a VPN node with 
NAT-T enabled detects an external NAT device, it checks every VPN packet to 
determine if NAT-T is necessary. 

• XAuth. To authenticate remote access services (RAS) users, use XAuth to assign 
users an authentication token (such as SecureID) and to make TCP/IP settings 
(IP address, DNS server, and WINS server) for the peer gateway.
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NetScreen-Security Manager offers you maximum flexibility for creating a VPN. You can 
choose your topology, authentication level, and creation method. Because you have so 
many choices, it’s a good idea to determine what your needs are before you create the VPN 
so you can make the right decisions for your network.

These decisions include: 

• VPN Topology. What do you want to connect? How many devices? How do you 
want these devices to communicate? Will you have users as VPN members?

• Data Protection. How much security do you need? Do you need encryption, 
authentication, or both? Is security more or less important than performance?

• Tunnel Type. Do you want an always-on connection or traffic-based 
connection?

• VPN Manager or Device-Level. How do you want to create the VPN? 
Maintain the VPN?

The following sections provide information to help you make these decisions. 
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You can use a VPN to connect:

• FW/VPN devices. Create a VPN between two or more FW/VPN devices to 
establish secure communication between separate networks.

• Network components. Create a VPN between a two or more network 
components to establish secure communication between specific machines.

• Remote users. Create a VPN between a user and a FW/VPN device to enable 
secure access to protected networks.

Each device, component, and RAS user in a VPN is considered a VPN node. The VPN 
connects each node to other nodes using a VPN tunnel. VPN tunnel termination points 
are the end points of the tunnel; traffic enters and departs the VPN tunnel through these 
end points. Each tunnel has two termination points: a source and destination, which are 
the source and destination zones on FW/VPN device.
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Network Address Translation (NAT) maps private IP addresses to public, Internet-
routable IP addresses. Because your FW/VPN device is also a NAT server, you can use 
private, unregistered IP addresses for your internal network, minimizing the number of 
registered IP addresses you must buy and use.

Note: In NetScreen-Security Manager, remote users are known as remote access service 
(RAS) users. 
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If you enable NAT, when an internal system connects to the Internet, the FW/VPN device 
translates the unregistered IP address in the outbound data packets to the registered 
address of the FW/VPN device. The FW/VPN device also relays responses back to the 
original system. Additionally, because your internal systems do not have a valid Internet 
IP address, your systems are invisible to the outside Internet, meaning that attackers 
cannot discover the IP addresses in use on your network.
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Site-to-site VPNs are the most common type of VPN. Typically, each remote site is an 
individual FW/VPN device or RAS user that connects to a central FW/VPN device. 

• Advantages: Simple, easy to configure.
• Disadvantages: The central FW/VPN is a single point of failure.

Use a site-to-site VPN to connect remote networks to a single, central network 
inexpensively. An example is shown below:
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In a hub and spoke VPN, multiple FW/VPN devices (spokes) communicate through a 
central device (the hub). 

• Advantages: Can connect several devices and users. Hub and spoke VPNs are 
easy to maintain because you only need to reconfigure the spoke and the hub 
device, which save you administration and resource costs. If you have smaller 
NetScreen FW/VPN devices with limited tunnel capacity, you can use hub and 
spoke VPNs to increase the number of available tunnels.

• Disadvantages: The hub is a single point of failure; however, you can use NSRP 
for redundancy.

Remote Office Corporate Office

Untrust 1.1.1.250

Trust 10.0.0.1

Untrust 4.4.4.250

Trust 20.0.0.1
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A hub acts as a concentrator for the other VPN members, but does not necessarily have 
resources that are available to other members. In fact, you can specify a FW/VPN device 
that is not a VPN member to act as the hub: If you include the hub in the VPN, the hub 
device can send and receive traffic from all spokes; if you do not include the hub, the hub 
device simply routes traffic between spokes.

Use a hub and spoke topology when you want to route VPN traffic through a VPN member 
that does not contain protected resources. An example is shown below:
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In a full mesh VPN, all VPN member can communicate with all other VPN members.

• Advantages: Because a full mesh configuration uses redundant IPSec tunnels, 
traffic continues to flow even if a node fails. 

• Disadvantages: When you add a member to the VPN, you must reconfigure all 
devices.

Corporate HQ (Hub)

Store 1 (Spoke) Store 2 (Spoke) Store 3(Spoke)

NetScreen-Security Manager

Corporate LAN
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Use a full mesh VPN when you need to ensure that every VPN member can communicate 
with every other VPN member. An example is shown below:
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To ensure stable, continuous VPN connection, use redundant gateways to create multiple 
tunnels between resources. If a tunnel fails, the management system automatically 
reroutes traffic. Redundant gateways use NSRP to determine the tunnel status.

When planning your VPN topology, consider the importance each tunnel has in the 
overall network. Critical data tunnels should be redundant to ensure that VPN traffic 
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To protect traffic as it passes over the Internet, you can create a secure tunnel between 
devices using a tunneling protocol. Each device in the VPN uses the tunneling protocol to 
establish a secure data path, enabling traffic between the devices to flow securely from 
source to destination. NetScreen-Security Manager provides two tunneling protocols, 
IPSec and L2TP, as detailed in the following sections.
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IPSec is a suite of related protocols that tunnel data between devices and 
cryptographically secure communications at the network layer. Each device in the VPN 
has the same IPSec configuration, enabling traffic between the devices to flow securely 
from source to destination. 

Corporate HQ (Main)

Store 1 (Main) Store 2 (Main) Store 3 (Main)

NetScreen-Security Manager

Corporate LAN
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Because IPSec functions at the network layer, it protects all data generated by any 
application or protocol that uses IP. Network layer encryption protects data generated by 
all protocols at the upper layers of the protocol stack. It also protects all data throughout 
the entire journey of the packet. Data is encrypted at the source and remains encrypted 
until reaching its destination. Intermediate systems that transmit the packet (like routers 
and switches on the Internet) do not need to decrypt the packet to route it, and do not 
need to support IPSec.

When you create your VPN in NetScreen-Security Manager, you can use one or more 
IPSec services to establish the tunnel and protect your data. Typically, VPNs use 
encryption and authentication services to enable basic security between devices; however, 
for critical data paths, using certificates can greatly enhance the security of the VPN. 
NetScreen-Security Manager supports the following IPSec data protection services for 
VPNs.
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To authenticate the data in the VPN tunnel, you can use the AH protocol, pre-shared 
secrets, or certificates:

• Authentication Header (AH). AH authenticates the integrity and 
authenticity of data in the VPN. You can authenticate packets using Message 
Digest version 5 (MD5), Secure Hash Algorithm-1 (SHA-1), or Hash-based 
Message Authentication Code (HMAC).

• Preshared Secret. NetScreen-Security Manager generates an ephemeral 
secret, distributes the secret to each VPN node, then authenticates the VPN 
data using MD5 or SHA hash algorithms against the secret.

• Certificates. IKE uses a trusted authority on the client as the certificate server. 
For details on using certificates, see Chapter 4, “Configuring Devices”.

Authentication only authenticates the data; it does not encrypt the data in the VPN. To 
ensure privacy, you must encrypt the data using ESP.
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ESP encrypts the data in the VPN with DES, Triple DES, or AES symmetric encryption. 
When the encrypted data arrives at the destination, the receiving device uses a key to 
decrypt the data. For additional security, you can encrypt the keys that decrypt the data 
using Diffie-Hellman asymmetric encryption. ESP can also authenticate data in the VPN 
using MD5 and SHA-1 algorithms. You can use ESP to encrypt, authenticate, or encrypt 
and authenticate data depending on your security requirements. Because ESP uses keys 
to encrypt and decrypt data, each VPN node must have the correct key to send and receive 
VPN data through the VPN tunnel. 

You can manually configure a key for each VPN node, or use a key exchange protocol to 
automate key generation and distribution:

• Manual Key IKE. In a manual key VPN, you specify the encryption algorithm, 
authentication algorithm, and the Security Parameter Index (SPI) for each VPN 
node. Because all security parameters are static and consistent, VPN nodes can 
send and receive data automatically, without negotiation.
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• Autokey IKE. In an AutoKey IKE VPN, you can use the Internet Key Exchange 
(IKE) protocol to generate and distribute encryption keys and authentication 
algorithms to all VPN nodes. IKE automatically generates new encryption keys 
for the traffic on the network, and automatically replaces those keys when they 
expire. Because IKE generates keys automatically, you can give each key a short 
life span, making it expire before it can be broken. By also exchanging 
authentication algorithms, IKE can confirm that the communication in the VPN 
tunnel is secure.

Because all security parameters are dynamically assigned, VPN nodes must 
negotiate the exact set of security parameters that will be used to send and 
receive data to other VPN nodes. To enable negotiations, each VPN node 
contains a list of proposals; each proposal is a set of encryption keys and 
authentication algorithms. When a VPN node attempts to send data through the 
VPN tunnel, IKE compares the proposals from each VPN node and selects a 
proposal that is common to both nodes. If IKE cannot find a proposal that exists 
on both nodes, the connection is not established.

IKE negotiations include two phases:

– In Phase 1, two members establish a secure and authenticated 
communication channel. 

– In Phase 2, two members negotiate Security Associations for services 
(such as IPsec) that require key material and/or parameters.

VPN nodes must use the same authentication and encryption algorithms to 
establish communication.

• Replay protection. In a replay attack, an attacker intercepts a series of 
legitimate packets and uses them to create a denial-of-service (DoS) against the 
packet destination or to gain entry to trusted networks. Replay protection 
enables your NetScreen FW/VPN devices to inspect every IPSec packet to see if 
the packet has been received before—if packets arrive outside a specified 
sequence range, the NetScreen FW/VPN device rejects them.
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Layer 2 Tunneling Protocol (L2TP) is another tunneling protocol used to transmit data 
securely across the Internet. Because L2TP can transport Point to Point Protocol (PPP) 
frames over IP, it is often used to:

• Establish PPP connections (Ex. authenticate ADSL services using PPP for users 
with an ISP at the opposite side of a Telco IP/ATM network

• Transmit non-IP protocols (Ex. bridge Novell and other network protocols)

PPP can send IP datagrams over a serial link, and is often used to enable dial-up users to 
connect to their ISP and to the Internet. PPP authenticates username and password, and 
assigns parameters such as IP address, IP gateway, and DNS. PPP can also tunnel non-IP 
traffic across a serial link, such as Novell IPX or Appletalk. 
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PPP is also useful because it can carry non-IP traffic and authenticate connections to 
RADIUS servers. However, because PPP is not an IP protocol, Internet routers and 
switches cannot route PPP packets. To route PPP packets, you use L2TP, which 
encapsulates PPP packet inside an Internet routable, UDP packet. L2TP VPNs supports 
remote access service users using Password Authentication Protocol (PAP) and Challenge 
Handshake Authentication Protocol (CHAP) authentication. 
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L2TP only transmits packets; for encryption, authentication, or other data protection 
services, you must further encapsulate the L2TP packet using AutoKey IKE.
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You can configure three types of VPN tunnels with NetScreen-Security Manager: 

• Policy-based VPNs. The VPN tunnel is created and maintained only during 
the transfer of network traffic that matches a VPN rule, and is torn down when 
the connection ends. Use policy-based VPNs when you want to encrypt and 
authenticate certain types of traffic between two VPN members.

• Routing-based VPNs. The VPN tunnel is created when the route is defined 
and is maintained continuously. Use route-based VPNs when you want to 
encrypt and authenticate all traffic between two VPN members. You cannot add 
RAS users in a routing-mode VPN.

• Mixed-mode VPNs. Connects policy-based VPNs to route-based VPNs in a 
mixed-mode VPN. You cannot add RAS users in a mixed-mode VPN.

The following sections detail each VPN type.
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A policy-based VPN tunnels traffic between two FW/VPN devices, or between one FW/
VPN device and a remote user. Each time a NetScreen FW/VPN device detects traffic that 
matches the from zone, source, to zone, destination, and service in the VPN rule, 
NetScreen-Security Manager creates a VPN tunnel to encrypt, authenticate, and send the 
data to the specified destination. When no traffic matches the VPN rule, NetScreen-
Security Manager tears down the VPN tunnel.

To create a policy-based VPN, you determine the network components you want to 
protect, and create protected resources to represent those components in the NetScreen-
Security Manager UI. A protected resource is a combination of a network component and 
a service; protected resources in a VPN can communicate with other protected resources 
using the specified services. In a VPN rule, you add protected resources as the source and 
destination IP addresses.

Policy-based VPNs can use any of the supported data protection methods. Use policy-
based VPNs when you want to enable Remote Access Services (RAS). You can add users to 
the VPN just as you add devices, enabling user access to all resources within the VPN.
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Like a policy-based VPN, a route-based VPN tunnels traffic between two FW/VPN 
devices, or between one FW/VPN device and a remote user. However, a route-based VPN 
automatically tunnels all traffic between two termination points, without regard for the 
type of traffic. Because the tunnel is an always-on connection between two network 
points, the FW/VPN device views the tunnel as a static network resource through which 
to route traffic. 

To create the termination points of the tunnel, you designate an interface on the FW/VPN 
device as a tunnel interface, then define a static route or use a dynamic routing protocol 
(BGP, OSPF) between all tunnel interfaces in the VPN. The tunnel interface, just like a 
physical interface, maintains state to enable dynamic routing protocols to make route 
decisions. When using VPN Manager to create your route-based VPN, the tunnel 
interfaces are automatically created for you. 
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After you have carefully considered your VPN requirements, create a VPN checklist to 
help you determine the VPN components you need to create. You might also want to 
create a network diagram of your topology that includes protected resources, VPN 
members, their IP addresses and gateways, and the type of tunnel between them. 
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What do you want to connect?

• Devices
• Network Components/Protected Resources
• Remote Access Service (RAS) Users
• Extranet Devices

How do you want to connect the VPN members?

• Site to Site
• Hub & Spoke
• Full Mesh

You might want to create a network diagram to map out your VPN visually, with IP 
addresses, to help you configure your topology.

�� 
���-���(6�,�	���-���(6����
��(��(�
What type of traffic do you want to protect?

• Use a policy-based VPN to encrypt and authenticate certain types of traffic 
between two network nodes.

• Use a route-based VPN to encrypt and authenticate all traffic between two 
network nodes.
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• Use a mixed-mode VPN to encrypt and authenticate traffic between policy-based 
and route-based VPN nodes.
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How do you want to protect the VPN traffic?

• Autokey IKE
• L2TP
• L2TP over AutoKey IKE
• Manual Key (you cannot use VPN Manager to create a Manual Key VPN)

You must also decide if you want to use certificates to authenticate communication 
between the VPN members.
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How do want to create the tunnel? Using VPN Manager or configuring each device?

0 ���������
When adding a VPN using the VPN Manager, you enter the VPN members, gateways, 
IKE properties, and VPN topology, then autogenerate the VPN rules that create the VPN. 
You can inspect the VPN rules and override any VPN property before sending the VPN 
configuration to your devices. 

Choose the VPN type that best matches your VPN requirements:

• Use an Autokey IKE VPN to authenticate and encrypt traffic between devices 
and/or protected resources. An Autokey IKE VPN supports:

– Mixed-mode VPNs (policy-based members and route-based members)
– Policy-based VPNs
– Route-based VPNs
– ESP and AH Authentication
– ESP AutoKey IKE Encryption
– IP traffic
– Tunnels between devices (routing-based) and protected resources (policy-

based)
• Use an Autokey IKE RAS VPN to authenticate and encrypt traffic between 

remote users and protected resources. An Autokey IKE RAS VPN supports:
– Policy-based VPNs
– ESP and AH Authentication
– ESP AutoKey IKE Encryption
– IP traffic
– Remote access users
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• Use an L2TP RAS VPN to authenticate (but not encrypt) PPP or other non-IP 
traffic between RAS users and protected resources. An L2TP RAS VPN 
supports:

– Policy-based VPNs
– AH Authentication
– PPP or other non-IP traffic
– Remote access users

• Use an L2TP over Autokey IKE RAS VPN to authenticate and encrypt PPP 
traffic between remote users and protected resources. An L2TP over Autokey 
IKE RAS VPN supports:

– Policy-based VPNs
– ESP and AH Authentication
– ESP AutoKey IKE Encryption
– PPP or other non-IP traffic
– Remote access users
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You can create the following VPN types:

• AutoKey IKE VPN
• Manual Key IKE VPN
• L2TP VPN
• Redundant Site-Site VPN
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After you have determine how you want to configure your VPN, you can being preparing 
the VPN components necessary to create the VPN. A VPN combines device-level 
components (such as devices, zones, and routes) with network-level components 
(authentication, users, and NAT) to create a secure system of communication. Before you 
can create a VPN, you must first configure the components that comprise the VPN.

Each VPN type has basic, required, and optional components:

• Basic VPN Components
• Required Policy-Based VPN Components
• Required Routing-Based VPN Components
• Optional VPN Components

For mixed-mode VPNs, you must configure all basic and required policy- and route-based 
components.
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To create any type of VPN, ensure that all FW/VPN devices you want to use in the VPN 
are managed by NetScreen-Security Manager and configured correctly.

• Devices. Add the FW/VPN devices you want to include in the VPN to 
NetScreen-Security Manager, ensuring that all devices are in the same domain. 
If you need to add a device to a VPN in a different domain, you must add the 
device as an extranet device in the domain that contains the VPN, then add the 
extranet device to the VPN. For details on adding devices, importing devices, or 
using extranet devices in VPNs, see Chapter 3, “Adding Devices”. 

• Zones. Configure each FW/VPN device with at least two zones (trust and 
untrust); each zone must contain at least one interface (physical or virtual). For 
details on creating and configuring zones and interfaces, see Chapter 4, 
“Configuring Devices”.
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A policy-based VPN requires several components:

• Address Objects
• Protected Resources
• NAT Objects
• User Objects

The following sections detail how to configure each component; after you have created a 
component, you can use it to create your VPN.

Note: For step-by-step instructions on creating VPNs, see the Online Help topic “VPNs”.
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You must create address objects to represent your network components in the UI. For 
details on creating and configuring address objects, see Chapter 7, “Configuring Objects”.
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You should determine your protected resources first to help you identify the devices you 
need to include in the VPN. After you know what you want to protect, you can use VPN 
Manager or manually configure your FW/VPN devices to create the VPN. A protected 
resource object represents the network components (address objects) and services (service 
objects) you want to protect and the FW/VPN device that protects them.

An example is show below:

The address specifies secured destination, the service specifies the type of traffic to be 
tunneled, and the device specifies where the VPN terminates (typically an outgoing 
interface in untrust zone). In a VPN rule, protected resources are the source and 
destination IP addresses, as shown below:

When creating protected resources:

• To protect multiple network components that are accessible by the same FW/
VPN device, add the address objects that represent those network components to 
the protected resource object.

• To protect a single network component that is accessible by multiple FW/VPN 
devices, add multiple devices to the protected resource object. You must 
configure each device to be a part of the VPN.
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ServiceService specifies type specifies type 
of traffic to be tunneledof traffic to be tunneled

AddressAddress specifies specifies 
secured destinationsecured destination

DeviceDevice specifies specifies 
where VPN terminateswhere VPN terminates
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ServiceService specifies type specifies type 
of traffic to be tunneledof traffic to be tunneled

AddressAddress specifies specifies 
secured destinationsecured destination

DeviceDevice specifies specifies 
where VPN terminateswhere VPN terminates

�����������

A

���	
��
��

�����������

�����������

�����������

�����������

AA

���	
��
��

�����������

�����������

�����������



Chapter 9 Configuring VPNs

396 Administrator’s Guide

• To manage different services for the same network component, create multiple 
protected resource objects that use the same address object and FW/VPN device 
but specify a different service object.

• If you change the FW/VPN device that protects a resource, NetScreen-Security 
Manager removes the previous FW/VPN device from all affected VPNs and adds 
the new FW/VPN device. However, NetScreen-Security Manager does not 
configure the VPN topology for the new FW/VPN—you must reconfigure the 
topology to include the new device manually.

For more details on creating protected resources, see Chapter 7, “Configuring Objects”.
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For VPNs that support policy-based NAT, you must create one or more shared NAT 
objects. A shared NAT object contains references to device-specific NAT objects, enabling 
multiple devices to share a single object.

First, create a device-specific NAT object by editing the device configuration of each FW/
VPN member. Then, create a global NAT object that includes the device-specific NAT 
objects. In the Object Manager, create a single shared NAT object to represent similar 
device-specific NAT objects (a global DIP represents multiple device-specific DIPs, etc.) 
Use the global NAT object in your VPN; when you install the VPN on a device, that device 
automatically replaces the shared NAT object with its device-specific NAT object.

For details on shared NAT objects, see Chapter 7, “Configuring Objects”.
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For VPNs that support RAS users, you must create a User Object to represent each user. 
NetScreen-Security Manager supports two types of users:

• Local Users. A local user has an account on the FW/VPN device that guards the 
protected resources in the VPN. When a local user attempts to connect to a 
protected resource, the FW/VPN device authenticates the user.

• External Users. An external user has an account on RADIUS or SecureID 
Authentication Server. When an external attempts to connect to a protected 
resource, the FW/VPN device forwards the request to the authentication server 
for authentication.



Preparing VPN Components

NetScreen-Security Manager 2004 FP2 397

���/���������������%��%
You can authenticate/encrypt a RAS user using one or more of the following protocols:

• XAuth. Uses IPSec ESP and a username and password for authentication. 
XAuth RAS users must authenticate with a username and password when they 
connect to the VPN tunnel.

• AutoKey IKE. Uses IPSec ESP and AH for encryption and authentication. 
AutoKey IKE users have a unique IKE ID that NetScreen-Security Manager 
uses to identify and authenticate the user during IKE Phase I negotiations. To 
simplify RAS management for large numbers of AutoKey IKE users, you can 
also create AutoKey IKE groups that use a shared Group IKE ID.

• L2TP. Uses Password Authentication Protocol (PAP) and Challenge Handshake 
Authentication Protocol (CHAP) for authentication (password sent in the clear).

• Manual Key IKE. Uses IPSec ESP and AH for encryption and authentication. 
Because manual key users are device-specific, you create them in the FW/VPN 
device configuration, not in the Object Manager. For details on creating manual 
key users, see “Adding XAuth Users” on page 457.
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If your VPN includes multiple remote users, it can be impractical to create an IKE ID and 
VPN rule for each. Instead, you can use a Group IKE ID to authenticate multiple users in 
a single VPN rule. In the FW/VPN device configuration VPN settings, create a VPN 
Group and specify the maximum number of concurrent connections that the group 
supports (cannot exceed the maximum number of allowed Phase 1 SAs or the maximum 
number of VPN tunnels allowed on the Juniper Networks NetScreen platform).

For details on group IKE IDs, see the ScreenOS 5.x Concepts & Examples Guide.
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A route-based VPN requires two components:

• Tunnel Interface or Zone
• Route (Static or Dynamic)

The following sections detail how to configure each required component. 

For VPNs created with VPN Manager, you create the VPN first to autogenerate the 
tunnel interfaces, then create the routes on the device itself using those tunnel interfaces. 
For VPNs created at the device level, you can create the tunnel interfaces and routes 
before or after configuring the VPN.
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A VPN requires a physical or virtual interface on the FW/VPN device, and each NetScreen 
FW/VPN device supports a specific number of physical and virtual interfaces. To support 
multiple VPNs on a device, you might want to create tunnel interfaces and tunnel zones to 
increase the number of available interfaces on the device. 

If you do not need to do address translation (NAT), use unnumbered.

• Tunnel Interfaces. A tunnel interface handles VPN traffic between the VPN 
tunnel and the protected resources. You can create numbered tunnel interfaces 
that use unique IP addresses and netmasks, or unnumbered tunnel interfaces 
that do not have their own IP address and netmask (unnumbered tunnel 
interface borrows the IP address of the default interface of the security zone). 

• Tunnel Zones. A tunnel zone is a logical construction that includes one or more 
numbered tunnel interfaces. You must bind the VPN tunnel to the tunnel zone 
(not the numbered tunnel interfaces); the VPN tunnel uses the default interface 
for the tunnel zone. In a policy-based VPN, you can link:

– A single VPN tunnel to multiple tunnel interfaces
– Multiple VPN tunnels to a single tunnel interface

For details on tunnel interfaces and tunnel zones, see “Configuring a Tunnel Interface” on 
page 177.
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A FW/VPN device must know the path, or route, between each protected resource or FW/
VPN device in the VPN before it can forward packets from the source network to the 
destination network on the other side of the tunnel. To specify the route, you can use 
static routes, which define a specific, unchanging path between two VPN nodes, or 
dynamic routes, which define an algorithm that dynamically determines the best path 
between two VPN nodes. 

To create a static route, you must manually create a route for each tunnel on each device. 
For VPNs with more than just a few devices, NetScreen highly recommends using a 
dynamic routing protocol to automatically determine the best route for VPN traffic:

To route between different networks over the Internet, use Border Gateway Protocol 
(BGP); to route within the same network, use Open Shortest Patch First (OSPF). For 
details on creating routes, see Chapter 4, “Configuring Devices”.

Note: VPN Manager automatically creates the necessary tunnel interfaces for 
route-based VPNs. For device-level VPNs, you can create the tunnel interfaces 
before or after creating the VPN.

Note: If you are using VPN Manager to create the route-based VPNs, you create the 
routes after autogenerating the VPN. If you are creating a device-level VPN, you can 
create the routes after configuring the tunnel interfaces.
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In any type of VPN, you can also use three optional components:

• Authentication Server
• Certificate & Certificate Revocation List Objects
• PKI Defaults

The following sections detail how to configure each optional component; after you have 
created the component, you can use it to create your VPN.

�����
���*	�<���
���
����������
To externally authenticate VPN traffic for XAuth and L2TP, you must create an 
authentication server object to use in your VPN. For details on authentication servers, see 
Chapter 7, “Configuring Objects”.
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To authenticate external devices, use a Group IKE ID to authenticate multiple RAS users, 
or provide additional authentication for the FW/VPN devices in your VPN, you must 
obtain and install a digital certificate on each VPN member. A digital certificate is an 
electronic means for verifying identity through the word of a trusted third party, known 
as a Certificate Authority (CA). The CA is a trusted partner of the VPN member using the 
digital certificate as well as the member receiving it.

The CA also issues certificates, often with a set time limit. If you do not renew the 
certificate before the time limit is reached, the CA considers the certificate inactive. A 
VPN member attempting to use an expired certificate is immediately detected (and 
rejected) by the CA.

To use certificates in your VPN, you must configure:

• A local certificate for each FW/VPN device that is a VPN member.
• Certificate Authority (CA) Object. Use a CA object to obtain a local and CA 

certificate.
• Certificate Revocation List (CRL) Object. Use a CRL object to ensure that 

expired certificates are not accepted; a CRL is optional.
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A local certificate validates the identity of the FW/VPN device in a VPN tunnel 
connection. To get a local certificate for a device, you must prompt the device to generate a 
certificate request (includes public/private key pair request) using the Generate 
Certificate Request directive. In response, the device provides certificate request that 
includes the encrypted public key for the device. Using this encrypted public key, you can 
contact a independent CA (or use your own internal CA, if available) to obtain a local 
device certificate file (a .cer file).
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You must install this local certificate file on the managed device using NetScreen-Security 
Manager before you can use certificates to validate that device in your VPN. Because the 
local certificate is device-specific, you must use a unique local certificate for each device.

You can also use SCEP to configure the device to automatically obtain local certificate 
(and a CA certificate) from the CA directly. For details on local certificates, see Chapter 4, 
“Configuring Devices”.
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A CA certificate validates the identity of the CA that issued the local device certificate. 
You can obtain a CA certificate file (.cer) from the CA that issued the local certification, 
then use this file to create a Certificate Authority object. 

You must install this CA certificate on the managed device using NetScreen-Security 
Manager before you can use certificate to validate that device in your VPN. Because the 
CA certificate is an object, however, you can use the same CA for multiple devices, as long 
as those devices use local certificates that were issued by that CA.

You can also use SCEP to configure the device to automatically obtain a CA certificate at 
the same time it receives the local certificate. For details on configuring a certificate 
authority object, see Chapter 7, “Configuring Objects”.
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A Certificate Revocation List (CRL) identifies invalid certificates. You can obtain a CRL 
file (.crl) from the CA that issued the local certification and CA certificate for the device, 
then use this file to create a Certificate Revocation object. 

You must install the CRL on the managed device using NetScreen-Security Manager 
before you can use a CRL to check for revoked certificates in your VPN. Because the CRL 
is an object, however, you can use the same CRL for multiple devices, as long as those 
devices use local and CA certificates that were issued by that CA.

After you have received a CRL list, you can use the CRL object in your VPN. For details 
on configuring a certificate revocation list object, see Chapter 7, “Configuring Objects”.
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You can configure default PKI settings for each FW/VPN device that define how that 
device handles certificates. When configuring a VPN that includes the device, you can use 
these default settings. For details on PKI defaults, see Chapter 4, “Configuring Devices”.
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Configuring a VPN using VPN Manager is an eight stage process:

1. Adding the VPN
2. Configuring Members (policy-based, RAS users, routing-based)
3. Configuring Topology (AutoKey IKE only)
4. Configuring Gateways
5. Configuring IKE
6. Autogenerating the VPN
7. Configuring Overrides
8. Adding the VPN Link

The following sections detail each step. 
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From the menu bar, click VPN Manager > New and select the VPN type: 

• Use an AutoKey IKE VPN to connect devices and/or protected resources. An 
AutoKey IKE VPN supports mixed-mode, policy-based, and routing-based VPNs, 
but does not support RAS users.

• Use an AutoKey IKE RAS VPN to connect IKE RAS users and protected 
resources. An Autokey IKE RAS VPN supports policy-based VPNs and IKE RAS 
users, but does not support routing-based VPNs, mixed-mode VPNs, or L2TP 
RAS users.

• Use an L2TP RAS VPN to connect L2TP RAS users and protected resources 
without encryption. 

• Use an L2TP over AutoKey IKE RAS VPN to connect L2TP RAS users and 
protected resources. An L2TP over AutoKey IKE RAS VPN supports policy-
based VPNs and L2TP RAS users, but does not support routing-based or mixed-
mode VPNs.

Enter a name for the VPN, then specify the general properties for the VPN:

• Enable. Use this option to enable/disable the VPN. If you disable the VPN, the 
autogenerated VPN rules, VPN member gateways, and other device 
configuration settings are not installed on your managed devices.

• Termination Point. Select the Default Zone for the VPN Termination Point. 
Typically, the default zone is untrust. When you configure the topology for the 
VPN, you can select a unique termination point for each VPN member.

Click OK to save the VPN and return to VPN Manager. 

Note: For an L2TP RAS VPN, you do not need to configure gateways or IKE. 

Note: For step-by-step instructions on creating VPNs, see the Online Help topic “VPNs”.
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The second step in configuring your VPN is to add members to the VPN. Depending on the 
type of VPN you are creating, you can add protected resources, FW/VPN devices, and/or 
RAS users as VPN members. 
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In policy-based configuration area, you can add protected resources to the VPN. Click 
Protected Resources link and select the predefined Protected Resources you want to 
include in the VPN. For details on creating Protected Resources, see Chapter 7, 
“Configuring Objects”.

After you have added the protected resources, you can configure NAT and/or L2TP 
settings on the FW/VPN device that protects each resource:

• For L2TP RAS VPNs and L2TP over AutoKey IKE VPN protected resources, you 
must configure L2TP settings.

• For all protected resources, you can configure policy-based NAT. Use policy-
based NAT to translate private source IP addresses to Internet-routable IP 
addresses. Configuring NAT is optional; if you do not use NAT on your network, 
you do not need to configure NAT for the VPN.

The following sections detail how to configure NAT and L2TP.
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Below the Protected Resources window, select NAT to display the protecting FW/VPN 
devices for each protected resource. Select the device for which you want to configure 
NAT. Enable NAT and specify the following values (you cannot edit the name of the device 
or the zone that contains the protected resource).

• Configure Incoming DIP. You can enable the FW/VPN device to use a 
Dynamic IP pool for incoming VPN traffic. For each incoming VPN packet, the 
device translates the destination address into a IP address that is selected from 
the DIP pool. 

– Interface for Incoming DIP. Select the interface that receives traffic 
addressed to Dynamic IP addresses.

– Incoming Global DIP. Select the Global DIP object that represents range 
of IP addresses available to the FW/VPN device. (This DIP pool must 
include IP addresses that are routable on your internal network.)

For details on configuring DIP objects, see Chapter 7, “Configuring Objects”.

• Configure Tunnel Interface & Zone. You can bind the VPN tunnel to a 
tunnel interface or tunnel zone to increase the number of available interfaces in 
the FW/VPN device. 

Note: If the FW/VPN device is running ScreenOS 5.x and configured in 
transparent mode, you can only configure the zone (the interface does not 
appear) ScreenOS 4.0.x devices display both zone and interface.
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To use a tunnel interface and/or tunnel zone in your VPN, you must first create 
the tunnel interface or zone on the device; for details, see “Configuring Tunnel 
Interfaces & Tunnel Zones” on page 398 and Chapter 4, “Configuring Devices”. 

– Tunnel Zone. Select a pre-configured tunnel zone on the FW/VPN devices 
to bind the VPN tunnel directly to the tunnel zone. The tunnel zone must 
include one or more numbered tunnel interfaces; when the FW/VPN 
devices route VPN traffic to the tunnel zone, the traffic uses one or more of 
the tunnel interfaces to reach the protected resources.

– Tunnel Interface. Select a pre-configured tunnel interface on the FW/VPN 
devices to bind the VPN tunnel to the tunnel interface. The FW/VPN 
devices route all VPN traffic through the tunnel interface to the protected 
resources.

• Configure MIP, VIP, & Outgoing DIP. 
– Enable MIP. Enable MIP to use a mapped IP address for the interface.
– Global MIP. Select the global MIP object that represents the mapped IP 

address you want to use for the interface.
– Global VIP. Select the global VIP object that represents the virtual IP 

address you want to use for the interface.
– Global DIP (Outgoing). You can enable the FW/VPN device to use a 

Dynamic IP pool for outgoing VPN traffic. For each outgoing VPN packet, 
the device translates the source address into a IP address selected from 
the DIP pool. Select the Global DIP object that represents range of IP 
addresses available to the FW/VPN device. (This DIP pool must include IP 
address that are routable on the Internet.)
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For L2TP RAS VPNs and L2TP over AutoKey IKE VPN protected resources, you must 
configure L2TP settings. 

To connect to an L2TP VPN tunnel, the L2TP RAS user uses the IP address and WINS/
DNS information assigned by the user’s ISP. However, when the L2TP RAS user sends 
VPN traffic through the tunnel, the FW/VPN device assigns a new IP address and WINS/
DNS information that enables the traffic to reach the destination network.

Below the Protected Resources pane, select L2TP/NAT to display the protecting FW/VPN 
devices for each protected resource. (If you are configuring an AutoKey IKE VPN or 
AutoKey IKE RAS VPN, this option does not appear.) Select the device for which you 
want to configure L2TP. In the L2TP tab, specify the following values (you cannot edit the 
name of the device).

• Host Name. Enter the name of the L2TP host.
• Keep Alive. The number of seconds a VPN member waits between sending hello 

packets to an L2TP RAS user.
• Peer IP. Enter the IP address of the L2TP peer.
• Secret. Enter the shared secret that authenticates communication in the L2TP 

tunnel.
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• Remote Settings. Select the remote settings object that represents the DNS 
and WINS servers assigned to L2TP RAS users after they have connected to the 
tunnel.

• IP Pool Name. Select the IP pool object that represents the available IP 
addresses that can be assigned to L2TP RAS users after they have connected to 
the tunnel.

• Auth Server. Because the L2TP must authenticate L2TP users, use custom 
settings to associate those users with a specific Authentication Server. You can 
also configure the device to query the remote settings object for DNS and WINS 
information for those users. 

To use the default authentication server for L2TP users, add the users to the 
device first.

*((
���,*�������
In the Remote User area, you can add RAS users to the VPN. (When configuring an 
AutoKey IKE VPN, this area does not appear.) Click the Users link to display the user 
selection dialog box, then click the Edit icon to select the predefined RAS users or user 
groups you want to include in the VPN. For details on creating RAS users and groups, see 
Chapter 7, Configuring Objects.
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You can include a single RAS user in multiple VPNs. To specify this VPN as the default 
entry point for all RAS users listed in the VPN, enable Use as Default Gateway.
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In the routing-based configuration area, you can add routing-based members to the VPN. 
(When configuring an AutoKey IKE RAS VPN, an L2TP RAS VPN, or an L2TP over 
AutoKey IKE RAS VPN, this area does not appear.) A routing-based VPN member is a 
FW/VPN device that will route traffic (statically or dynamically) through a tunnel 
interface to one or more VPN members. 

VPN Manager automatically creates the necessary tunnel interfaces for each route-based 
VPN member. However, after VPN Manager autogenerates the VPN tunnels, you must 
configure static or dynamic routes on the NetScreen FW/VPN devices to route traffic 
through these tunnel interfaces. For details on creating routes, see Chapter 4, 
“Configuring Devices”.

Click the FW/VPN devices link to display the route-based member selection dialog box.

Note: When configuring a VPN that includes RAS users, if you added the user as a 
L2TP local user and assigned an IP pool and remote settings object on a specific device 
in the VPN, those settings override the settings defined in the VPN.
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• Configure Tunnel Interface Settings. Select a Primary Zone, Secondary 
Zone, and physical source interface for each FW/VPN device. The selected zone 
passes VPN traffic through the selected interface on the FW/VPN device.

– The Zone settings apply to all route-based members selected in the 
members window.

– If the Primary Zone is not defined or available on the FW/VPN device, 
VPN traffic automatically uses the Secondary Zone.

– The Physical Source Interface is the default physical interface on the 
device that transmits VPN traffic.

• Configure Tunnel Options. ScreenOS 5.x devices support additional 
functionality for handling VPN tunnels:

– To use a single tunnel interface on each device for VPN traffic, enable 
Generate Single Tunnel Interface for 5.x devices. When enabled, the 
NetScreen FW/VPN device uses the route table and the next-hop tunnel 
binding table to link a specific destination to one of a number of VPN 
tunnels bound to the same tunnel interface. By mapping the next-hop 
gateway IP address specified in the route table entry to a specific VPN 
tunnel in the NHTB table, the device can use one tunnel interface for all 
VPN traffic through the device. This option is enabled by default.

– To create entries in the Next Hop Tunnel Binding (NHTB) table, enable 
Generate NHTB entries for 5.x devices. When this option is selected, VPN 
Manager autogenerates NHTB entries for each VPN tunnel. If you are 
using a single interface for all VPN traffic on the device but you 
do not select this option, you must manually add the NHTB routes 
in the NHTB table, or configure BGP to automatically create the 
entries for you. This option is disabled by default.

For details on working with the NHTB routing table, see the NetScreen 
ScreenOS 5.x Concepts & Examples Guide, Volume 7, “Advanced VPN 
Features”. 

• Configure Members. Click the Add icon to select the predefined FW/VPN 
devices you want to include in the VPN. After you have added the device to the 
VPN, you can double-click the device and configure overrides for the default 
tunnel interface zone, the physical source interface. For ScreenOS 5.x devices, 
you can also enable/disable single tunnel interface and NHTB entries.

After VPN Manager generates the tunnel interfaces, you must configure static 
or dynamic routes on each VPN member to route traffic to other VPN members.
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In the general configuration area, you can define the topology and/or termination points of 
the VPN:

• The topology of the VPN determines how VPN members logically connect to each 
other. The topology is the communication path that VPN traffic must take to 
reach a VPN member.
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• The termination points of the VPN determine how VPN members physically 
connect to each other. A termination point is the interface on each VPN member 
that sends and receives VPN traffic to and from the VPN tunnel.

For AutoKey IKE VPNs, you must define the topology for the VPN. Each VPN member is 
a node that has specific connection capabilities, and the topology describes the logical 
connections between those nodes. 

A node can be:

• Hub. A hub can connect to a branch or main.
• Main. A main can connect to a hub, branch, or another main. When configuring 

a VPN that uses multiple mains, you can select to mesh all mains (all mains can 
communicate with each other) or disable all main meshing.

• Branch. A branch can connect to a hub or a main. Branches can send and 
receive VPN traffic to and from a hub or a main device, but cannot communicate 
directly with other branches.

Additionally, you can use a supernet to reduce the number of rules required for the hub 
device in a policy-based VPN. A supernet is a Address Object Group containing the 
network Address Objects that represent the source and destination points of the VPN. 
Use a supernet when the hub device supports a small number of rules.
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You can use VPN Manager to configure the following common VPN topologies:

• Hub & Spoke. Select a device to act as the hub; this device connects VPN 
members and enables them to communicate. Next, select the VPN members to 
be the spokes. You are not required to use a VPN member as a hub:

– If do not select a VPN member as the VPN hub, the hub simply routes 
VPN traffic from one branch to another.

– If you do select a VPN member as the VPN hub, the hub routes VPN 
traffic from itself and all connected branches.

Each spoke can send and receive VPN traffic to and from the hub, but cannot 
communicate directly with other spokes.

• Main & Branch. Main and branch topologies combine the flexibility of hub and 
spoke with the redundancy of full mesh. Because you can select multiple mains, 
each branch has an alternate tunnel to use if one main fails. To create a main 
and branch:

Note: If you change the FW/VPN device that protects a resource, NetScreen-Security 
Manager removes the previous FW/VPN device from all affected VPNs and adds the 
new FW/VPN device. However, NetScreen-Security Manager does not configure the 
VPN topology for the new FW/VPN—you must reconfigure the topology to include the 
new device manually.

Note: You can select only one hub per VPN.
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– Select the devices to act at mains; these devices can communicate with all 
other VPN members.

– Select remaining devices as branches; these devices communicate with all 
mains.

• Full Mesh. Select all VPN members to act as mains. All members can 
communicate with any other VPN member. Do not select a hub.

• Site to Site. Select both VPN members as mains. Each member can 
communicate with the other VPN member. Do not select a hub.
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You must define the termination interface for each FW/VPN device in the VPN. The 
Termination Points tab displays the default termination points for the VPN. A 
termination point is the interface on a FW/VPN device that sends and receives VPN 
traffic to and from the VPN tunnel, and is typically in the Untrust zone. Each VPN 
member (the FW/VPN devices included as routing-based members and/or as protected 
resources for policy-based members) has a default termination interface.

To override the default termination interface, right-click the VPN member, select Edit, 
and select a new termination interface for the device.
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To configure the gateways for VPN, click the Gateway Parameters link.
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In the Properties tab, specify the following gateway values.
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The mode determines how Phase 1 negotiations occur. Select the mode that meets your 
VPN requirements:

• In Main mode, the IKE identity of each node is protected. Each node sends three 
two-way messages (six messages total); the first two messages negotiate 
encryption and authentication algorithms that protect subsequent messages, 
including the IKE identity exchange between the nodes. Depending on the speed 
of your network connection and the encryption and authentication algorithms 
you use, main mode negotiations can take a long time to complete. Use Main 
mode when security is more important.

• In Aggressive mode, the IKE identity of each node is not protected. The 
initiating node sends two messages and the receiving node sends one (three 
messages total); all messages are sent in the clear, including the IKE identity 
exchange between the nodes. Because Aggressive mode is typically faster but 
less secure than Main mode, use Aggressive mode when speed is more important 
than security.
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For RAS VPNs, you must use Aggressive mode; for VPNs that do not include RAS users, 
select the mode that meets your requirements.
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Use heartbeats to enable redundant gateways.

• Hello. Enter the number of seconds the FW/VPN devices wait between sending 
hello pulses.

• Reconnect. Enter the maximum number of seconds the FW/VPN devices wait 
for a reply to the hello pulse.

• Threshold. Enter the number of seconds that the FW/VPN devices wait before 
attempting to reconnect.
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Because NAT obscures the IP address in some IPSec packet headers, VPN nodes cannot 
receive VPN traffic that passes through an external NAT device. To enable VPN traffic to 
traverse a NAT device, you can use NAT Traversal (NAT-T) to encapsulate the VPN 
packets in UDP. If a VPN node with NAT-T enabled detects an external NAT device, it 
checks every VPN packet to determine if NAT-T is necessary. 

Because checking every packet impacts VPN performance, you should only use NAT 
Traversal for remote users that must connect to the VPN over an external NAT device. 
You do not need to enable NAT-T for your internal FW/VPN nodes that use NAT; each 
VPN node knows the correct address translations for VPN traffic and does not need to 
encapsulate the traffic. 

To use NAT-T, enable NAT-Traversal and specify:

• UDP Checksum. A 2-byte value (calculated from the UDP header, footer, and 
other UDP message fields) that verifies packet integrity. You must enable this 
option for NAT devices that require UDP checksum verification; however, most 
NAT devices (including NetScreen FW/VPN devices) do not require it.

• Keep alive Frequency. The number of seconds a VPN node waits between 
sending empty UDP packets through the NAT device. A NAT device keeps 
translated IP addresses active only during traffic flow, and invalidates unused 
IP addresses. To ensure that the VPN tunnel remains open, you can configure 
the VPN node to send empty “keep alive” packets through the NAT device.

)��+��������=���/
Use the XAuth protocol to authenticate RAS users with an authentication token (such as 
SecureID) and to make TCP/IP settings (IP address, DNS server, and WINS server) for 
the peer gateway.

• Use the Default Server to use the default XAuthentication server for the 
device. To change or assign a default XAuthentication server, edit the VPN 
settings in the FW/VPN device configuration.

• Use XAuth Server when the remote gateway is a FW/VPN device that you 
want to assign TCP/IP settings.
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– Auth Server Name. Select a pre-configured authentication server object. 
For details on creating an authentication server object, see Chapter 7, 
“Configuring Objects”.

– Allowed Authentication Type. Select Generic or Challenge Handshake 
Authentication Protocol (CHAP) (password is sent in the clear) to 
authenticate the remote gateway.

– Query Remote Setting. Enable this option to query the remote settings 
object for DNS and WINS information.

• Use XAuth Client when the remote gateway is a RAS user that you want to 
authenticate.

– Allowed Authentication Type. Select Any or CHAP.
– User Name and Password. Enter the user name and password that the 

RAS user must provide for authentication.
• Bypass Authentication to permit VPN traffic from VPN members to pass 

unauthenticated by the XAuth server. 
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Determine the authentication mechanisms you want the VPN nodes to use for IKE Phase 
I negotiations. You can use a preshared key or certificates for authentication.
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For Phase 1, select a Preshared Key Information or PKI Information:

• Use Preshared Key if your VPN includes NetScreen FW/VPN devices and/or 
RAS users. VPN nodes use the preshared key during Phase 1 negotiations to 
authenticate each other; because each node knows the key in advance, 
negotiations use fewer messages and are quicker.

– To generate a random key, click Generate Key.
– To use a predefined value for the key, enter a value for the Preshared Key

Note: When configuring a VPN that includes RAS users, if you 
added the user as a L2TP or XAuth local user and assigned a 
remote settings object on a specific device in the VPN, those settings 
override the settings defined in the VPN.

Note: Using a random key can generate CLI commands in excess of 
255 characters, which exceeds ScreenOS limits and might not be 
accepted by the NetScreen FW/VPN device during update. To 
reduce the key size, shorten the autogenerated key value by deleting 
characters.
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• Use PKI if your VPN includes extranet devices or you require the additional 
security provided by certificates (PKI uses certificates for VPN member 
authentication). For details on creating and managing certificates, see Chapter 
7, “Configuring Objects”. 

For Phase 1, select a proposal or proposal set. You can select from predefined or user-
defined proposals:

• To use a predefined proposal set, select one of the following:
– Basic (nopfs-esp-des-sha, nopfs-esp-des-md5)
– Compatible (nopfs-esp-3des-sha, nopfs-esp-3des-md5, nopfs-esp-des-sha, 

nopfs-esp-des-md5)
– Standard (gs-esp-3des-sha, gs-esp-aes128-sha)

• To use a user-defined proposal, select a single proposal from the list of 
predefined and custom IKE Phase 1 Proposals. For details on custom IKE 
proposals, see Chapter 7, “Configuring Objects”. 

If your VPN includes only NetScreen FW/VPN devices, you can specify one 
predefined or custom proposal that NetScreen-Security Manager propagates to 
all nodes in the VPN. If your VPN includes extranet devices, you should use 
multiple proposals to increase security and ensure compatibility. 
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You can use the same preshared secret for all nodes in the VPN, or create a unique 
preshared secret for communication from a specific node to another node.
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Every VPN node has a unique identification number, known as an IKE ID. During Phase 
1 negotiations, the IKE protocol uses the IKE ID to authenticate the VPN member.

VPN Manager automatically creates the default IKE ID for you, based on the policy- or 
route-based members and RAS users, so you do not need to configure this option. 
However, if you do not want to use the default IKE ID, you can select a different IKE ID 
type and configure an IKE ID for each VPN gateway. 

The IKE ID tab displays all FW/VPN devices included as routing-based members and/or 
as protected resources for policy-based members. For each device, select the IKE ID type 
and enter the ID value:

• ASN1-DN. Abstract Syntax Notation, version 1 is a data representation format 
that is non-platform specific; Distinguished Name is the name of the computer. 
Use ASN1-DN to create a Group IKE ID that enables multiple, concurrent 
connections to the same VPN tunnel; use a Group IKE ID to make configuring 
and maintaining your VPN quicker and easier.

Note: You cannot use a predefined proposal set with certificates—
you must select a user-defined proposal or change the 
authentication method to Preshared Key.
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For details on how Group IKE IDs work, see “Configuring Group IKE IDS” on 
page 397. For details on determining the ASN1-DN container and wildcard 
values for Group IKE IDs, see the NetScreen ScreenOS 5.x Concepts & 
Examples Guide.

• FQDN. Use a Fully Qualified Domain Name when the gateway is a dynamic IP 
address. FQDN is a name that identifies (qualifies) a computer to the DNS 
protocol using the computer name and the domain name; ex. 
server1.colorado.mycompany.com.

• IP Address. Use an IP address when the gateway has a static IP address.
• U-FQDN. Use a User Fully Qualified Domain Name when the gateway is a 

dynamic IP address, such as a RAS user. A U-FQDN is a simply an email 
address; ex. user1@mycompany.com.

����
�	�
����E5
To configure the IKE properties and Phase 2 Proposals for the VPN, click the IKE 
Parameters link. Because L2TP RAS VPNs do not support encryption, you do not need to 
configure IKE properties for L2TP RAS VPNs.
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Configure the IKE properties:

• Idle Time to Disable SA. Configure the number of minutes before a session 
that has no traffic automatically disables the SA.

• Replay Protection. In a replay attack, an attacker intercepts a series of 
legitimate packets and uses them to create a denial-of-service (DoS) against the 
packet destination or to gain entry to trusted networks. If replay protection is 
enabled, your NetScreen FW/VPN devices inspect every IPSec packet to see if 
the packet has been received before—if packets arrive outside a specified 
sequence range, the NetScreen FW/VPN device rejects them.

• IPSec Mode. Configure the mode:
– Use tunnel mode for IPSec. Before an IP packet enters the VPN tunnel, 

NetScreen-Security Manager encapsulates the packet in the payload of 
another IP packet and attaches a new IP header. This new IP packet can 
be authenticated, encrypted, or both.

– Use transport mode for L2TP-over-AutoKey IKE VPNs. NetScreen-
Security Manager does not encapsulate the IP packet, meaning that the 
original IP header must remain in plaintext. However, the original IP 
packet can be authenticated, and the payload can be encrypted.

• Do not set Fragment Bit in the Outer Header. The Fragment Bit controls 
how the IP packet is fragmented when traveling across networks.

– Clear. Use this option to enable IP packets to be fragmented.
– Set. Use this option to ensure that IP packets are not fragmented.
– Copy. Select to use the same option as specified in the internal IP header 

of the original packet.
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You can enable VPN Monitor and configure the monitoring parameters for the device. 
Monitoring is off by default. To enable the VPN Monitor in Realtime Monitor to display 
statistics for the VPN tunnel, configure the following:

• VPN Monitor. When enabled, the NetScreen FW/VPN devices in the VPN send 
ICMP echo requests (pings) through the tunnel at specified intervals 
(configurable in seconds) to monitor network connectivity (each device uses the 
IP address of the local outgoing interface as the source address and the IP 
address of the remote gateway as the destination address). If the ping activity 
indicates that the VPN monitoring status has changed, the device triggers an 
SNMP trap; the VPN Monitor (in RealTime Monitor) tracks these SNMP 
statistics for VPN traffic in the tunnel and displays the tunnel status.

• Rekey. When enabled, the NetScreen FW/VPN devices in the VPN regenerate 
the IKE key after a failed VPN tunnel attempts to re-establish itself. When 
disabled, each device monitors the tunnel only when the VPN passes user-
generated traffic (instead of using device-generated ICMP echo requests). Use 
the rekey option to:

– Enable dynamic routing protocols to learn routes and transmit messages 
through the tunnel.

– Automatically populate the next-hop tunnel binding table (NHTB table) 
and the route table when multiple VPN tunnels are bound to a single 
tunnel interface.

For details on VPN monitoring at the device level, see the NetScreen ScreenOS 5.x 
Concepts & Examples Guide. For details on VPN Monitor (in Realtime Monitor) in 
NetScreen-Security Manager, see Chapter 10, “Monitoring”. 
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For Phase 2 negotiations, select a proposal or proposal set. You can select from predefined 
or user-defined proposals:

• To use a predefined proposal set, select one of the following:
– Basic (nopfs-esp-des-sha, nopfs-esp-des-md5)
– Compatible (nopfs-esp-3des-sha, nopfs-esp-3des-md5, nopfs-esp-des-sha, 

nopfs-esp-des-md5)
– Standard (gs-esp-3des-sha, gs-esp-aes128-sha)

• To use a user-defined proposal, select a single proposal from the list of 
predefined and custom IKE Phase 2 Proposals. For details on custom IKE 
proposals, see Chapter 7, “Configuring Objects”. 

If your VPN includes only NetScreen FW/VPN devices, you can specify one predefined or 
custom proposal that NetScreen-Security Manager propagates to all nodes in the VPN. If 
your VPN includes extranet devices, you should use multiple proposals to increase 
security and ensure compatibility. 
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When you have completed configuring the policy- and route-based VPN members, the 
topology (if necessary) and termination points, and the IKE (if necessary) and gateway 
parameters for the VPN, you are ready to autogenerate the VPN. 

During autogeneration, NetScreen-Security Manager generates the VPN rules that 
control traffic between policy-based VPN members, and edits the device configuration 
(gateways, security parameters, etc.) of each VPN member to support the VPN. 

Autogeneration does not:

• Insert the VPN rules into a Security Policy. After you have reviewed the VPN 
rules and made any necessary overrides, you must manual insert the VPN rules 
(known as a VPN link) into a Security Policy. For details, see “Adding the VPN 
Link” on page 415.

• Install the new VPN rules or edited device configurations on the managed 
devices in the VPN. After you have inserted the VPN link into a Security Policy, 
you can install that policy on your devices using the Updated directive.

• Create static or dynamic routes for route-based VPNs. 

To autogenerate the VPN, click Save. 
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The override area enables you configure individual settings for each VPN rules (for policy-
based and mixed-mode VPNs) and each VPN member. Each change you make to the 
autogenerated rules or VPN member configuration is known as an override to the VPN 
settings. 

You might need to override the VPN settings to:

• Configure additional security for specific tunnels.
• Configure additional authentication between specific VPN members.
• Configure unique monitoring or reporting options for specific VPN members or 

VPN tunnels.
• Configure unique IKE IDs for each VPN member.
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For policy-based and mixed-mode VPNs, NetScreen-Security Manager automatically 
generates the VPN rules to control traffic between VPN members. To view these 
autogenerated rules, click the Policy Rules link in the Overrides area; the rules appear in 
a separate NetScreen-Security Manager window, using the same row and column format 
as in the Security Policies.

Note: Policy rules do not appear for route-based VPNs.
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The position of the rules indicates the order that they apply to traffic. To change the 
position of a rule, you can:

• Right-click the rule and select Move Rule Up or Move Rule Down, or
• Right-click the rule and select Change Rule Position. In the New Position dialog 

box, enter a new rule number for this rule. (The rule number is the first column 
in the policy table.)
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You can also filter the VPN rules by zones using the Zone Filter in the upper right-hand 
corner of the VPN rule window. Select a zone in From Zone and/or the To Zone to order 
the rules as desired. 

To save this rule order, click Apply. 
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You can configure rule options for each rule, including traffic shaping, logging, AntiVirus 
and Attack Objects, and protection actions. For details on configuring these options, see 
Chapter 8, “Configuring Security Policies”.
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For all VPNs, you can edit the device configuration for each VPN member. The device 
configuration displays the interfaces, gateways, etc. for each individual device.
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For route-based and mixed-mode VPNs, this displays the tunnel interfaces and virtual 
routers configured on the VPN member. To override the general properties and dynamic 
routing protocols for each tunnel interface, right-click the tunnel interface and configure 
the settings.

For policy-based VPNs, no tunnel interfaces appear.

Note: The changes you make to a Virtual Router in the Overrides area apply to the 
device configuration, not just the VPN configuration. When you change a VR setting in 
VPN manager, that change is saved and applied to the device when you save and apply 
the VPN. Similarly, when you change a VR setting for the device configuration in 
Device Manager, that change is reflected in the VPN configurations that includes the 
device.
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For VPNs that use AutoKey IKE, this displays the VPN name, remote gateway, and IPSec 
Mode for each tunnel in the VPN. To override the general properties, security, binding/
proxyID, and monitoring option for each VPN tunnel, right-click the VPN name and 
configure the settings as desired.
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For all VPNs, this displays the gateway name, gateway mode, IP address, and IKE phase 
I proposals for each VPN gateway. To override the general properties, security, and IKE 
ID/XAuth options for each gateway, right-click the gateway name and configure the 
settings as desired.
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For all VPNs, this displays VPN groups.
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For L2TP VPNs, this displays L2TP information for each VPN member. To edit this 
information, right-click and configure the settings as desired.
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For route-based and mixed-mode VPNs, you can view the VPN tunnels between each 
route-based member, including the source and peer devices, the tunnel interface, zone, 
and physical interface. 

You cannot edit the device tunnels from this view; to make overrides to the VPN tunnels, 
edit the interface configuration for each device.
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After you have reviewed the autogenerated information and made any desired overrides 
to the VPN, you must update your managed devices to activate the VPN. By default, the 
VPN you created in VPN manager is installed as the first rule in the Security Policy for 
each managed device. However, the Security Policy does not display the VPN.

You can manually add a VPN link to your Security Policy; a VPN link creates a link 
between the Security Policy and VPN (the link points to the VPN rules that exist in the 
VPN in VPN Manager). You might want to add a VPN link so you can reposition it 
elsewhere in the policy, or simply to make the VPN viewable in your policy.

Note: The device tunnel summary does not appear for policy-based VPNs.
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To create a VPN link, in Security Policies, select an existing Security Policy (or create a 
new Security Policy), then right-click and select Add VPN link. Select the VPN name and 
click OK to add the link to the policy. By default, the link appears at the top of the policy, 
but you can move the VPN link anywhere in the policy, just as you would a firewall rule. 

If you make changes to the VPN or create overrides, the VPN link automatically updates 
to reflect those edits.
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To edit a VPN created with VPN Manager: 

1. In the navigation tree, select VPNs. A table listing all configured VPNs appears 
in the main display area. 

2. Right-click the VPN you want to edit and select Edit. The expanded VPN view 
dialog box appears.

3. Make the necessary changes, then click OK to apply your changes.

To revert any changes you have made to the VPN, right-click the VPN name in the 
navigation tree and select Revert Changes.
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To edit a protected resource in the VPN, right-click the protected resource and select Edit 
Protected Resource. Make your changes, then click OK to save your changes. 

If you make changes to a protected resource object that is used in a VPN, NetScreen-
Security Manager automatically generates new configuration and propagates your 
changes to all affected FW/VPN devices. If you change the FW/VPN device that protects a 
resource, NetScreen-Security Manager removes the previous FW/VPN device from all 
affected VPNs and adds the new FW/VPN device.

However, NetScreen-Security Manager does not configure the VPN topology for the new 
FW/VPN—you must reconfigure the topology to include the new device manually.

5(
�
��������
To edit a user object in the VPN, right-click the user and select Edit Remote User. Make 
your changes, then click OK to save your changes.
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To add or delete a member, edit any VPN parameter, or reconfigure the VPN topology, 
select the VPN and click OK. Make your changes, then click Save to re-generate the VPN. 

Note: After you click Save, you cannot revert your changes to a VPN.
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If you add, edit, or delete an override, the VPN link automatically updates the 
autogenerated rules to reflect those edits.
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This section provides examples of common VPN types:

• AutoKey IKE, Policy-Based Site-to-Site VPN
• AutoKey IKE RAS, Policy-Based VPN
• AutoKey IKE, Route-Based Site-to-Site VPN
• XAuth Authentication with External User Group

The following sections provide step-by-step instructions on creating each type of VPN.
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An AutoKey IKE VPN connects protected resources using AutoKey IKE. Use this VPN 
type to connect and control traffic between two NetScreen FW/VPN devices.

In this example, an AutoKey IKE tunnel using a pair of certificates (one at each end of the 
tunnel) provides the secure connection between the Tokyo and Paris offices. For the Phase 
1 and 2 security levels, you specify the Phase 1 proposal as rsa-g2-3des-sha and select the 
predefined “Compatible” set of proposals for Phase 2. It is assumed that both participants 
already have RSA certificates and are using Entrust as the certificate authority (CA). All 
zones are in the trust-vr.
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To create an AutoKey IKE, Site-to-Site VPN, create the following VPN components:

• NetScreen FW/VPN Devices
• Address Objects

Note: For examples on creating a Manual Key VPN, see “Device-Level VPN Examples” 
on page 463.

Tokyo Trust Zone 
eth1 10.1.1.1/24

Outgoing Interface 
Untrust Zone
eth3, 1.1.1.1/24 
Gateway 1.1.1.250

VPN Tunnel

Internet

Paris Trust Zone
eth1 10.2.2.1/24

Outgoing Interface 
Untrust Zone
eth3, 2.2.2.2/24 
Gateway 2.2.2.250

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Tokyo.

Trust Zone Untrust Zone Trust ZoneUntrust Zone

TokyoParisTokyo Paris

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Paris.

Untrust-Tun Zone Untrust-Tun Zone
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• Protected Resources

The following sections detail how to create each component.
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Add the Tokyo and Paris NetScreen FW/VPN devices (for details on adding devices, see 
Chapter 3, “Adding Devices”): 

• Configure the Tokyo device with the following interfaces:
– Ethernet1 is the Trust IP (10.1.1.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (1.1.1.1/24) in the Untrust zone.

• Configure the Paris device with the following interfaces:
– Ethernet1 is the Trust IP (10.2.2.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (2.2.2.2/24) in the Untrust zone.
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Create the Address Objects that you will use to create Protected Resources (for details on 
creating or editing Address Objects, see Chapter 7, “Configuring Objects”). If you 
imported a NetScreen FW/VPN device, the address book objects configured on that device 
are automatically imported as Address Objects into the NetScreen-Security Manager UI.

To add the Tokyo Trust LAN (10.1.1.0/24) as an network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.
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To add the Paris Trust LAN (10.2.2.0/24) as a network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.
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Create the Protected Resources to represent the source and destination points of the VPN. 
(for details on creating or editing Protected Resources, see Chapter 7, “Configuring 
Objects”). 

To create the Tokyo Protected Resources object:

1. In Protected Resources (under VPN Manager), click the Add icon.
2. Configure the object as shown below:

3. Click OK to save the object and return to VPN Manager.
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To create the Paris Protected Resources object:

1. In Protected Resources (under VPN Manager), click the Add icon.
2. Configure the object as shown below:

3. Click OK to save the object and return to VPN Manager.
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1. In the navigation tree, double-click VPN Manager. right-click VPNs and select 

AutoKey IKE VPN. The New AutoKey IKE VPN dialog box appears.
2. In Name, enter Tokyo-Paris Policy-Based VPN. 
3. Select Enable.
4. In Termination Point, select Untrust. 
5. Click OK to save the VPN and return to VPN Manager.
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1. In VPN Manager, select the Tokyo-Paris Policy-Based VPN. The VPN 

appears in the main display area
2. Configure the policy-based members:

a. Select the Protected Resources link to display the Protected Resources 
list.

b. Select the Paris Protected Resources and the Tokyo Protected Resources. 
c. Click OK to return to the main display area.

3. Configure the VPN topology:

a. Select the Topology link to display the Topology dialog box.
b. Click the Add icon to display the Topology configuration dialog box.
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c. In the Mains window, select the following NetScreen FW/VPN devices, as 
shown below:

d. Click OK to return to the Topology dialog box, then click OK to return to 
the main display area.

4. Configure the termination points of the VPN:

a. Click the Termination Points link. The Termination Points dialog box 
appears. 

b. Confirm that both Paris and Tokyo devices use a Termination Interface of 
ethernet3, as shown below:

c. Click OK to return to the main display area.
5. Configure the VPN gateway:

a. Click the Gateway Parameters link. The Properties tab appears. Leave 
all defaults and click the Security tab.
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b. In the Security tab, configure the PKI Information and Phase 1 Proposals 
as shown below:

c. Click Save to save your configuration changes to the VPN.

To view the autogenerated rules, click the Policy Rules link in the Overrides section. VPN 
Manager generates the rules as shown below:
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You must create a VPN link between the Zone rulebase in a Security Policy and the VPN 
Manager autogenerated rules. You create this link by inserting a VPN link in the zone 
rulebase; this links points to the VPN rules that exist in the VPN Manager. 
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To create a VPN link:

1. In Security Policies, select an existing Security Policy (or create a new Security 
Policy). The Zone rulebase appears. Right-click and select Add VPN link.

2. Select the Tokyo-Paris Policy-Based VPN. 
3. Click OK to add the link to the policy. 

By default, the link appears at the top of the policy, but you can move the VPN link 
anywhere in the policy, just as you would a firewall rule.
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An AutoKey IKE RAS VPN connects RAS users and protected resources. In this example, 
Local Auth user Wendy (login name: reporter, password: Nd4syst4) wants to access 
resources on the UNIX server at the corporate site.

To accommodate Wendy, create an AutoKey IKE tunnel using a preshared key to provide 
the secure communication channel between IKE user Wendy and the UNIX server, which 
is protected by the Chicago Corporate FW/VPN device.

The tunnel uses ESP with 3DES encryption and SHA-1 authentication. For the Phase 1 
and 2 security levels, specify the Phase 1 proposal as pre-g2-3des-sha and select the 
predefined “Compatible” set of proposals for Phase 2.
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To create an AutoKey RAS IKE, Site-to-Site VPN, create the following VPN components:

• NetScreen FW/VPN Devices
• Address Objects
• Protected Resources
• User Objects

The following sections detail how to create each component.
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Add the Chicago Corporate device (for details on adding devices, see Chapter 3, “Adding 
Devices”) and configure the following interfaces:

Internet

VPN Tunnel

Trust ZoneUntrust Zone

Remote User Wendy
Corporate Office 
Trust Zone
ethernet1 10.1.1.1/24

Outgoing Interface 
Untrust Zone
ethernet3, 1.1.1.1/24
Gateway 1.1.1.250

UNIX Server
10.1.1.5

LAN
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• Ethernet1 is the Trust IP (10.1.1.1/24) in the Trust zone.
• Ethernet3 is the Untrust IP (1.1.1.1/24) in the Untrust zone.
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Create the Address Objects that you will use to create Protected Resources (for details on 
creating or editing Address Objects, see Chapter 7, “Configuring Objects”).

To add the Chicago Corporate Trusted LAN (10.1.1.0/24) as an network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Address Objects.

To add the UNIX Server (10.1.1.5) as a host Address Object:

1. In Address Objects, click the Add icon and select Host. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Address Objects.
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Create a Protected Resource to represent the destination point of the VPN (for details on 
creating Protected Resources, see Chapter 7, “Configuring Objects”). 

To create the Chicago Corporate Trusted LAN Protected Resources object:

1. In Protected Resources (under VPN Manager), click the Add icon.
2. Configure the object as shown below:

3. Click OK to save the object and return to VPN Manager.
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Create a Local User Object to represent Wendy, the remote user (for details on creating or 
editing User Objects, see Chapter 7, “Configuring Objects”). Local User objects are 
authenticated with the local NetScreen-Security Manager database.
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To add Wendy as a User Object:

1. In User Objects, select Local User Objects. In the main display area, click the 
Add icon and select Local. 

2. Configure the object as shown below:

3. Click OK to save the object and return to Local User Objects.
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1. In the navigation tree, double-click VPN Manager. right-click VPNs and select 

AutoKey IKE RAS VPN. The New AutoKey IKE RAS VPN dialog box appears.
2. In Name, enter UNIX Remote Access VPN.
3. Select Enable.
4. In Termination Point, select Untrust.
5. Click OK to save the VPN and return to VPN Manager.
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1. In VPN Manager, select the UNIX Remote Access VPN. 
2. Configure the policy-based members:

a. In the main display area, select the Protected Resources link.
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b. In the Protected Resources list, select the following Protected Resources, 
as shown below:

c. Click OK to return to the main display area.
3. Configure the termination points of the VPN: 

a. Click the Termination Points link. The Termination Points dialog box 
appears. 

b. Configure Chicago Corporate to use ethernet3 as the termination point 
(this is the Untrust zone interface) as shown below:

c. Click OK to return to the main display area.
4. Configure the remote users for the VPN:

a. In the Remote Users section, click the Users link. The Remote User dialog 
box appears. 

b. Select the user “wparker” as shown below:

c. Click Save to save your configuration changes to the VPN.
5. Configure the VPN gateway:
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a. Click the Gateway Parameters link. The Properties tab appears. Leave 
all defaults and click the Security tab. 

b. In the Security tab, enter the preshared key value (h1p8A24nG5), then 
click Generate Key.

c. For Phase 1 Proposals, select User-Defined, then click the Add/Edit icon to 
add the pre-g2-3des-sha proposal, as shown below:

d. Click Save to save your configuration changes to the VPN.

To view the autogenerated rules, click the Policy Rules link in the Overrides section. VPN 
Manager generates the rules as shown below:
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You must create a VPN link between the Security Policy and the VPN Manager 
autogenerated rules. You create this link by inserting a VPN link in the Security Policy; 
this links points to the VPN rules that exist in the VPN Manager. 

To create a VPN link:

1. In Security Policies, select an existing Security Policy (or create a new Security 
Policy). Right-click and select Add VPN link.

2. Select the UNIX Remote Access VPN. 
3. Click OK to add the link to the policy. 

By default, the link appears at the top of the policy, but you can move the VPN link 
anywhere in the policy, just as you would a firewall rule.
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In this example, an AutoKey IKE VPN tunnel using a preshared key provides a secure 
connection between NetScreen FW/VPN devices protecting the Tokyo and Paris offices. 
The Untrust zone interface for both NetScreen FW/VPN devices use a static IP address. 
All security and tunnel zones are in the trust-vr.

The preshared key is h1p8A24nG5. For the Phase 1 and 2 security levels, specify the 
Phase 1 proposal as pre-g2-3des-sha and the Phase 2 proposals as predefined compatible.
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To create an AutoKey IKE, Route-based, Site-to-Site VPN, create the following VPN 
components:

Internet

VPN Tunnel

Tokyo Trust Zone 
eth1 10.1.1.1/24

Outgoing Interface 
Untrust Zone
eth3 1.1.1.1/24
gateway 1.1.1.250

Outgoing Interface 
Untrust Zone
eth3, 2.2.2.2/24
Gateway 2.2.2.250

Tunnel Interface Tunnel.1 Tunnel Interface Tunnel.1

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Tokyo.

Trust Zone Untrust Zone Trust ZoneUntrust Zone

TokyoParisTokyo Paris

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Paris.

Paris Trust Zone 
eth1 10.2.2.1/24
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• NetScreen FW/VPN Devices
• Address Objects

The following sections detail how to create each component.
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Add the Tokyo and Paris FW/VPN devices (for details on adding devices, see Chapter 3, 
“Adding Devices”):

• Configure the Tokyo device with the following interfaces:
– Ethernet1 is the Trust IP (10.1.1.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (1.1.1.1/24).

• Configure the Paris device with the following interfaces:
– Ethernet1 is the Trust IP (10.2.2.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (2.2.2.2/24) in the Untrust zone.
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Create the Address Objects that you will use to create the VPN rule in your Security 
Policy (for details on creating VPN rules, see “Adding VPN Rules” on page 461). If you 
imported a NetScreen FW/VPN device, the address book objects configured on that device 
are automatically imported as Address Objects into the NetScreen-Security Manager UI.

To add the Tokyo Trust LAN (10.1.1.0/24) as an network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.
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To add the Paris Trust LAN (10.2.2.0/24) as a network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.
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1. In the navigation tree, double-click VPN Manager. right-click VPNs and select 

AutoKey IKE VPN. The New AutoKey IKE VPN dialog box appears.
2. In Name, enter Tokyo-Paris Route-Based VPN. 
3. Select Enable.
4. In Termination Point, select Untrust. 
5. Click OK to save the VPN and return to VPN Manager.
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1. In VPN Manager, select the Tokyo-Paris Route-Based VPN. 
2. Configure the route-based members:

a. In the main display area, select the FW/VPN Device link (under Route-
Based Configuration) to display the zone and tunnel options. Configure 
the default zone and tunnel options as shown below:
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b. Click the Add icon to display available FW/VPN devices. Select the Paris 
and Tokyo devices as shown below:

c. Click OK to add the members to the VPN.
d. Ensure that the route-based members are configured as shown below:

e. Click OK to save your settings and return to the main display area.
3. Configure the VPN topology:

a. Select the Topology link. The Topology dialog box appears.
b. Click the Add icon to display the Topology configuration dialog box.
c. In the Mains window, select the following NetScreen FW/VPN devices, as 

shown below:

d. Click OK to return to the Topology dialog box, then click OK to return to 
the main display area.
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4. Configure the termination points of the VPN:

a. Click the Termination Points link. The Termination Points dialog box 
appears.

b. Confirm that both Paris and Tokyo devices use a Termination Interface of 
ethernet3, as shown below:

c. Click OK to return to the main display area.
5. Configure the VPN gateway:

a. Click the Gateway Parameters link. The Properties tab appears. Leave 
all defaults and click the Security tab. 

b. In the Security tab, enter the preshared key value (h1p8A24nG5), then 
click Generate Key.

c. For Phase 1 Proposals, select User-Defined, then click the Add/Edit icon to 
add the pre-g2-3des-sha proposal, as shown below:
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6. Click Save to save your configuration changes to the VPN.

Because this VPN is route-based, no rules are autogenerated. However, you can view the 
device tunnel summary to see all autogenerated tunnels between each FW/VPN device in 
the VPN, as shown below:

A tunnel interface acts as a doorway to a VPN tunnel; traffic enters and exits a VPN 
tunnel via a tunnel interface. These tunnels are an “always-on” connection—the devices 
will route any traffic with an appropriate source and destination IP address through the 
VPN tunnel.

To control traffic through the tunnel, you must add firewall rules to the Security Policy 
that is installed on each VPN node. For details on creating firewall rules, see Chapter 8, 
“Configuring Security Policies”.
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Create the routes (in the route table of each device) that will connect the autogenerated 
tunnel interfaces and form the VPN tunnel (for details on creating routes, see Chapter 4, 
“Configuring Devices”). You can use static or dynamic routes, however, this example 
details only the static route creation.

For each device, you will create two routes using the trust virtual router (trust-vr):

• A route from 0.0.0.0/0 to eth3 in the untrust zone. This routes traffic from the 
the trust zone through eth3 in the untrust zone, then to the next hop (default) 
gateway.

• A route from the tunnel.1 interface (autogenerated by VPN Manager) to the 
untrust zone of the remote VPN node. This routes traffic destined for the remote 
VPN node through the tunnel.1 interface (where the packets are encapsulated), 
with a default next hop gateway of 0.0.0.0/0.

To configure the route on the Tokyo FW/VPN device:

1. In Device Manager, double-click the device to open the device configuration 
dialog box. Select Network > Virtual Router to display the list of virtual routers 
on the device.
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2. Double-click the trust-vr route to open the vr for editing. In the virtual router 
dialog box, click Routing Table, then click the add icon under destination-based 
Routing Table to add a new static route.

3. Configure a route from the untrust interface to the gateway, as shown below:

4. Configure route from the trust zone to the tunnel interface, as shown below:

Note: ScreenOS 4.0.x devices display only the destination-based Routing 
Table; ScreenOS 5.x devices display both destination-based and source-
based routing tables
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Your routing table should appear as shown below:

5. Click OK to save your changes to the virtual router, then click OK to save your 
changes to the Tokyo device.

To configure the route on the Paris FW/VPN device:

1. In Device Manager, double-click the device to open the device configuration 
dialog box. Select Network > Virtual Router to display the list of virtual routers 
on the device.

2. Double-click the trust-vr route to open the vr for editing. In the virtual router 
dialog box, click Routing Table, then click the add icon under destination-based 
Routing Table to add a new static route.

Note: ScreenOS 4.0.x devices display only the destination-based Routing 
Table; ScreenOS 5.x devices display both destination-based and source-
based routing tables
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3. Configure a route from the untrust interface to the gateway, as shown below:

4. Configure route from the trust zone to the tunnel interface, as shown below:
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Your routing table should appear as shown below:

5. Click OK to save your changes to the virtual router, then click OK to save your 
changes to the Paris device.
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In this example, you use a VPN to enable access for a group of resellers who require access 
to FTP servers in the corporate LAN. First, you must configure the RADIUS server, then 
add an authentication server object in NetScreen-Security Manager to represent that 
server. 

Next, to manage the users in this example, you define an external user group in two 
places: on the external RADIUS auth server and in NetScreen-Security Manager.

• On the RADIUS server, you populate the external user group with XAuth users, 
leaving the group unpopulated NetScreen-Security Manager. The RADIUS 
server authenticates the users during Phase 1 IKE negotiations.

• In NetScreen-Security Manager, you leave the external user group unpopulated, 
but you must define each user as a local user with an IKE ID, then create a 
group that includes those local users as members. This IKE ID is used to 
authenticate the users during the Phase 2 IKE negotiations.

Additionally, you must add the NetScreen FW/VPN device and create an Address object to 
represent the FTP server, as well as a protected resource. After you have assembled all 
the VPN components, you are ready to create the VPN. 
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1. On the RADIUS server, load the NetScreen dictionary file and define Xauth user 

accounts. Use the NetScreen user group VSA to create the user group xa_grp2 
and apply it to the auth user accounts that you want to add to that group.

2. In NetScreen-Security Manager, in the main navigation tree, select Object 
Manager > Authentication Servers and click the Add icon. Configure as shown 
below:

For name, enter radius1. Select a color and add a comment, if desired.

For Main Server, enter the IP 10.20.1.100; for Primary Backup Server, enter IP 
10.20.1.110; for Secondary Backup Server, enter IP 10.20.1.120.

Note: For instructions on loading the dictionary file onto a RADIUS server, 
refer to the RADIUS server documentation. If you are using a Microsoft IAS 
RADIUS server, there is no dictionary file to load. Instead, define the correct 
vendor-specific attributes (VSAs) on the server.
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For timeout, enter 30.

Select For XAuth Users.

For Server Type, select RADIUS, then configure the RADIUS server:

– For server port, select 4500
– For secret, enter A56hYY97kl
– For retry timeout, select 4.

3. Click OK to save the RADIUS authentication server object.

���!����)��+�������/���'�����$�%�������!�9����������������������
�������:

1. In the Object Manager, select User Objects > External User Groups.
2. Click the Add icon to display the New External User Group dialog box. 

Configure as shown below:

– For Name, enter xa-grp2. 
– Enable XAuth.

3. Click OK to save the new group.
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1. In the Object Manager, select User Objects > Local Users.
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2. Click the Add icon and select User. The New Local User dialog box appears. 
Configure as shown below:

– Enter a name, color, and comment for the user.
– Select Enable, then select IKE. 
– Configure the User IKE ID as a User FQDN (their email address).

3. Click OK to save the new user. Repeat for each user in the group. 
4. In the Object Manager, select User Objects > Local User Groups.
5. Click the Add icon to display the New Local User Group dialog box. Add all user 

objects that represent a reseller, as shown below:

6. Click OK to save the new user group.
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1. Add the Address Object that represents the network used by Reseller group:

a. In the Object Manager, select Address Objects. Click the Add icon and 
select Network. The New Network dialog box appears.

b. Configure the Network as shown below:

c. Click OK to save the new Network object.
2. Add the Address Object that represents the FTP Server:

a. In the Object Manager, select Address Objects. Click the Add icon and 
select Host. The New Host dialog box appears.

b. Configure the Host as shown below:

c. Click OK to save the new Host object.
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Add a NetScreen-208 FW/VPN device named “Bozeman”. This is the device protects the 
FTP server (for details on adding devices, see Chapter 3, “Adding Devices”):

Configure the Bozeman device with the following interfaces:

• Ethernet1 is the Trust IP (10.1.1.1/24) in the Trust zone.
• Ethernet3 is the Untrust IP (2.2.2.2/24) in the Untrust zone.
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Create a Protected Resource to represent the destination point of the VPN (for details on 
creating Protected Resources, see Chapter 7, “Configuring Objects”). In this example, the 
destination point is the FTP server in the trust zone of Bozeman.

To create the FTP Protected Resources object:

1. In Protected Resources (under VPN Manager), click the Add icon.
2. Configure the object as shown below:

3. Click OK to save the object and return to VPN Manager.
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1. In the main navigation tree, select VPN Manager > VPNs. Click the Add icon 

and select AutoKey IKE RAS VPN. The New AutoKey IKE RAS VPN dialog 
box appears.

2. In Name, enter Reseller Remote Access VPN.
3. Select Enable.
4. In Termination Point, select Untrust.
5. Click OK to save the VPN and return to VPN Manager.
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1. In VPN Manager, select the Reseller Remote Access VPN. 
2. Configure the policy-based members:

a. In the main display area, select the Protected Resources link.
b. In the Protected Resources list, select the rsl-svr1 protected resource, as 

shown below:

c. Click OK to return to the main display area.
3. Configure the termination points of the VPN: 

a. Click the Termination Points link. The Termination Points dialog box 
appears. 

b. Configure the Bozeman device to use ethernet3 as the termination point 
(this is the Untrust zone interface).

c. Click OK to return to the main display area.
4. Configure the remote users for the VPN:

a. In the Remote Users section, click the Users link. The Remote User dialog 
box appears. 
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b. Select the Reseller local user group as shown below:

c. Click Save to save your configuration changes to the VPN.
5. Configure the VPN gateway:

a. Click the Gateway Parameters link. The Properties tab appears.
b. For Mode, select Main.
c. In the XAuth section, select XAuth Server and then select the radius1 

authentication server for Auth Server Name. Later, after you have 
autogenerated the VPN rules and gateway, you can override this 
setting to include only the Reseller external user group. For 
details, see “Step 9: Configure Overrides” on page 447.

d. In the Security tab, enter the preshared key value (netscreen4), then click 
Generate Key.

e. For Phase 1 Proposals, select User-Defined, then click the Add/Edit icon to 
add the pre-g2-3des-sha proposal, as shown below:

f. Click Ok to save your changes to the gateway.
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6. Click Save to save your configuration changes to the VPN and autogenerate the 
policy rules. 

To view the autogenerated rules, click the Policy Rules link in the Overrides 
section. VPN Manager generates the rules as shown below:
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By default, the gateway attempts to authenticate all users using the specified 
authentication server (radius1). You must override the gateway security settings to 
enable the VPN to authenticate only the Reseller external user group.

1. In the overrides area, click the Device Configuration link. 
2. In the navigation tree, double-click Bozeman and select Gateway. The 

autogenerated gateway for the Bozeman appears in the main display area.
3. Right-click the autogenerated gateway and select Edit. The Properties tab 

appears.
4. In the IKE IDs/XAuth tab, configure the XAuth area to authenticate only the 

Reseller external group, as shown below:

– For user, select User Group. 
– For User Group, select xa-grp2.

5. Click OK to save your overrides. 
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You can create a VPN link between the Security Policy and the VPN Manager 
autogenerated rules. You create this link by inserting a VPN link in the Security Policy; 
this links points to the VPN rules that exist in the VPN Manager. 

To create a VPN link:

1. In Security Policies, select an existing Security Policy (or create a new Security 
Policy). Right-click and select Add VPN link.

2. Select the Reseller Remote Access VPN. 
3. Click OK to add the link to the policy. 

By default, the link appears at the top of the policy, but you can move the VPN link 
anywhere in the policy, just as you would a firewall rule.
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You can create four types of device-level VPNs:

• Use an AutoKey IKE VPN to connect devices and/or protected resources. An 
AutoKey IKE VPN supports mixed-mode, policy-based, and routing-based VPNs, 
but does not support RAS users. For details on each step, see “Creating AutoKey 
IKE VPNs” on page 449. 

• Use a Manual Key IKE VPNs to authenticate devices, protected resources, and 
RAS users in the VPN with manual keys. For details on each step, see “Creating 
Manual Key VPNs” on page 457.

• Use an L2TP RAS VPN to connect L2TP RAS users and protected resources 
with authentication but without encryption. For details on each step, see 
“Creating L2TP VPNs” on page 460.

• Use an L2TP-over-AutoKey IKE RAS VPN to connect L2TP RAS users and 
protected resources. An L2TP-over-AutoKey IKE RAS VPN supports policy-
based VPNs and L2TP RAS users, but does not support routing-based VPNs. For 
details on each step, see “Creating L2TP Over Autokey IKE VPNs” on page 461.
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IKE VPNs support tunnel mode, and can be policy-based or route-based; however, route-
based VPNs do not support RAS users.

L2TP VPNs support transport mode, and can be policy-based.
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Creating device-level AutoKey IKE VPNs is a four stage process:

1. Configure Gateway
2. Configure Routes (Route-based only)
3. Configure VPN on the Device
4. Add VPN rules to Security Policy
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A gateway is an interface on your FW/VPN device that sends and receives traffic; a 
remote gateway is an interface on another device that handles traffic for that device. Each 
FW/VPN member has a remote gateway that it sends and receives VPN traffic to and 
from. To configure a gateway for a VPN member, you need to define the local gateway (the 
interface on the VPN member that handles VPN traffic) and the remote gateway (the 
interface on the other VPN member that handles VPN traffic). The interface can be 
physical or virtual. 

• For remote gateways that use static IP addresses, specify the IP address or host 
name of the remote device.



Chapter 9 Configuring VPNs

450 Administrator’s Guide

• For remote gateways that use dynamic IP addresses, configure an IKE ID for the 
remote device.

• For remote gateways that are RAS users, specify a Local User object as a remote 
gateway to enable RAS user access.

To add a gateway to a FW/VPN device, open the device configuration, select VPN 
Settings, and click the Add icon to display the New Gateway Dialog box. Configure the 
gateway as detailed in the following sections. 
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Enter a name for the new gateway, then specify the following gateway values:

• Mode. The mode determines how Phase 1 negotiations occur. 
– In Main mode, the IKE identity of each node is protected. Each node sends 

three two-way messages (six messages total); the first two messages 
negotiate encryption and authentication algorithms that protect 
subsequent messages, including the IKE identity exchange between the 
nodes. Depending on the speed of your network connection and the 
encryption and authentication algorithms you use, main mode 
negotiations can take a long time to complete. Use Main mode when 
security is more important.

– In Aggressive mode, the IKE identity of each node is not protected. The 
initiating node sends two messages and the receiving node sends one 
(three messages total); all messages are sent in the clear, including the 
IKE identity exchange between the nodes. Because Aggressive mode is 
typically faster but less secure than Main mode, use Aggressive mode 
when speed is more important than security. However, you must use 
Aggressive mode for VPNs that include RAS users.

• Remote Gateway. The remote gateway is the VPN gateway on the receiving 
VPN node, and can be an interface with a static or dynamic IP address, or local 
or external user object.

– Static IP Address. For remote gateways that use a static IP address, enter 
the IP address and mask. 

– RAS User/Group. For remote gateways that are users, select the User 
object or User Group object that represents the RAS user.

– Dynamic IP Address. For remote gateways that use a dynamic IP address, 
select dynamic IP address.

• Outgoing Interface. The outgoing interface (also known as the termination 
interface) is the interface on the FW/VPN device that sends and receives VPN 
traffic. Typically, the outgoing interface is in the untrust zone.
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• Heartbeats. Use heartbeats to enable redundant gateways. You can use the 
default or set your own thresholds:

– Hello. Enter the number of seconds the FW/VPN device waits between 
sending hello pulses.

– Reconnect. Enter the maximum number of seconds the FW/VPN waits for 
a reply to the hello pulse.

– Threshold. Enter the number of seconds that the FW/VPN device waits 
before attempting to reconnect.

• NAT Traversal. Because NAT obscures the IP address in some IPSec packet 
headers, a VPN node cannot receive VPN traffic that passes through an external 
NAT device. To enable VPN traffic to traverse a NAT device, you can use NAT 
Traversal (NAT-T) to encapsulate the VPN packets in UDP. If a VPN node with 
NAT-T enabled detects an external NAT device, it checks every VPN packet to 
determine if NAT-T is necessary. Because checking every packet impacts VPN 
performance, you should only use NAT Traversal for remote users that must 
connect to the VPN over an external NAT device. 

You do not need to enable NAT-T for your internal FW/VPN nodes that use NAT; 
each VPN node knows the correct address translations for VPN traffic and does 
not need to encapsulate the traffic. 

To use NAT-T, enable NAT-Traversal and specify:

– UDP Checksum. A 2-byte value (calculated from the UDP header, footer, 
and other UDP message fields) that verifies packet integrity. You must 
enable this option for NAT devices that require UDP checksum 
verification; however, most NAT devices (including NetScreen FW/VPN 
devices) do not require it.

– Keep alive Frequency. The number of seconds a VPN node waits between 
sending empty UDP packets through the NAT device. A NAT device keeps 
translated IP addresses active only during traffic flow, and invalidates 
unused IP addresses. To ensure that the VPN tunnel remains open, you 
can configure the VPN node to send empty “keep alive” packets through 
the NAT device.
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Every VPN member has a unique identification number, known as an IKE ID. During 
Phase 1 negotiations, the IKE protocol uses the ID to authenticate the VPN member. You 
must select and configure an ID type for the VPN members at each end of the tunnel. 
However, the ID type can be different for each member: 

• ASN1-DN. Abstract Syntax Notation, version 1 is a data representation format 
that is non-platform specific; Distinguished Name is the name of the computer. 
Use ASN1-DN to create a Group ID that enables multiple RAS users to connect 
to the VPN tunnel concurrently.

– At the peer ID, specify values for the Container Match and Wildcard 
Match.

– At the local ID, specify the value.
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Using a Group ID can make configuring and maintaining your VPN quicker and 
easier. For details on how Group IKE IDs work, see “Configuring Group IKE 
IDS” on page 397. For details on determining the ASN1-DN container and 
wildcard values for Group IKE IDs, see NetScreen ScreenOS 5.x Concepts & 
Examples Guide.

• FQDN. Use a Fully Qualified Domain Name when the VPN member uses a 
dynamic IP address. FQDN is a name that identifies (qualifies) a computer to 
the DNS protocol using the computer name and the domain name; ex. 
server1.colorado.mycompany.com.

• IP Address. Use an IP address when the VPN member uses a static IP address.
• U-FQDN. Use a User Fully Qualified Domain Name when the VPN member 

uses a dynamic IP address (such as a RAS user). A U-FQDN is a simply an email 
address; ex. user1@mycompany.com.

Use the XAuth protocol to authenticate RAS users with an authentication token (such as 
SecureID) and to make TCP/IP settings (IP address, DNS server, and WINS server) for 
the peer gateway.

• Use the Default Server to use the default XAuthentication server for the 
device. To change or assign a default XAuthentication server, edit the VPN 
settings > Defaults > Xauth settings.

• Use XAuth Server to specify the authentication server that assigns TCP/IP 
settings to the remote gateway.

– XAuth Server Name. Select a pre-configured authentication server object. 
For details on creating authentication server objects, see Chapter 7, 
“Configuring Objects”.

– Allowed Authentication Type. Select generic or Challenge Handshake 
Authentication Protocol (CHAP) (password is sent in the clear) to 
authenticate the remote gateway.

– Query Remote Setting. Enable this option to query the remote settings 
object for DNS and WINS information. 

– Users & Groups. To authenticate XAuth RAS users using the 
authentication server, enable User or User Group and select a 
preconfigured user object.

• Use XAuth Client when the remote gateway is a RAS user that you want to 
authenticate.

– Allowed Authentication Type. Select Any or Challenge Handshake 
Authentication Protocol (CHAP) for authentication (password is sent in 
the clear.

– User Name and Password. Enter the user name and password that the 
RAS user must provide for authentication.

• Use Bypass Authentication to permit VPN traffic from this VPN member to 
pass unauthenticated by the Auth server.
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Select the authentication method you want to use in the VPN:

• Use Preshared Key if your VPN includes NetScreen FW/VPN devices and/or 
RAS users. VPN nodes use the preshared key during Phase 1 negotiations to 
authenticate each other; because each node knows the key in advance, 
negotiations use fewer messages and are quicker.

– To generate a random key, click Generate Key.
– To use a predefined value for the key, enter a value for the Preshared Key.

• Use PKI if your VPN includes extranet devices or you require the additional 
security provided by certificates (PKI uses certificates for VPN member 
authentication). For details on creating and managing certificates, see Chapter 
7, “Configuring Objects”. 

For Phase 1 negotiations, select a proposal or proposal set. You can select from predefined 
or user-defined proposals:

• To use a predefined proposal set, select one of the following:
– Basic (nopfs-esp-des-sha, nopfs-esp-des-md5)
– Compatible (nopfs-esp-3des-sha, nopfs-esp-3des-md5, nopfs-esp-des-sha, 

nopfs-esp-des-md5)
– Standard (gs-esp-3des-sha, gs-esp-aes128-sha)

• To use a user-defined proposal, select a single proposal from the list of 
predefined and custom IKE Phase 1 Proposals. For details on custom IKE 
proposals, see Chapter 7, “Configuring Objects”. 

If your VPN includes only NetScreen FW/VPN devices, you can specify one 
predefined or custom proposal that NetScreen-Security Manager propagates to 
all nodes in the VPN. If your VPN includes extranet devices, you should use 
multiple proposals to increase security and ensure compatibility.
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For a routing-based VPN member, you must configure:

• Tunnel zone or tunnel interfaces on the member.
• Static or dynamic routes from the member to other VPN members. 

Note: Using a random key can generate CLI commands in excess of 255 
characters, which exceeds ScreenOS limits and might not be accepted 
by the NetScreen FW/VPN device during update. To reduce the key 
size, shorten the autogenerated key value by deleting characters.

Note: You cannot use a predefined proposal set with certificates—you 
must select a user-defined proposal or change the authentication 
method to Preshared Key.
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VPN traffic flows through the tunnel zones or tunnel interfaces on the FW/VPN device, 
and uses static or dynamic routes to reach other VPN members. You must create the 
tunnel zones and interfaces before configuring routes. 

For details on configuring tunnel zones, tunnel interfaces, static routes, or dynamic 
routes, see Chapter 4, “Configuring Devices”.

After you have configured the tunnel zone or interface on the FW/VPN device, you must 
bind the VPN to that zone or interface to make the VPN functional, as described in the 
following section.
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When you configure the VPN, you are defining the gateway the FW/VPN device uses to 
connect to the VPN, the IKE Phase 2 proposals used by that gateway, and how you want 
NetScreen-Security Manager to monitor the VPN tunnel. 

For route-based VPNs, you are also binding the VPN to the tunnel interface or zone that 
sends and receives VPN traffic to and from the device.
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Enter the following values:

• VPN name. Enter a name for the VPN.
• Remote Gateway. Select the gateway for the VPN. 
• Idle Time to Disable SA. Configure the number of minutes before a session 

that has no traffic automatically disables the SA.
• Replay Protection. In a replay attack, an attacker intercepts a series of 

legitimate packets and uses them to create a denial-of-service (DoS) against the 
packet destination or to gain entry to trusted networks. If replay protection is 
enabled, your NetScreen FW/VPN devices inspect every IPSec packet to see if 
the packet has been received before—if packets arrive outside a specified 
sequence range, the NetScreen FW/VPN device rejects them.

• IPSec Mode. Configure the mode:
– Use tunnel mode for IPSec. Before an IP packet enters the VPN tunnel, 

NetScreen-Security Manager encapsulates the packet in the payload of 
another IP packet and attaches a new IP header. This new IP packet can 
be authenticated, encrypted, or both.

– Use transport mode for L2TP-over-IPSec. NetScreen-Security Manager 
does not encapsulate the IP packet, meaning that the original IP header 
must remain in plaintext. However, the original IP packet can be 
authenticated, and the payload can be encrypted.
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• Do not set Fragment Bit in the Outer Header. The Fragment Bit controls 
how the IP packet is fragmented when traveling across networks.

– Clear. Use this option to enable IP packets to be fragmented.
– Set. Use this option to ensure that IP packets are not fragmented.
– Copy. Select to use the same option as specified in the internal IP header 

of the original packet.
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For Phase 2 negotiations, select a proposal or proposal set. You can select from predefined 
or user-defined proposals:

• To use a predefined proposal set, select one of the following:
– Basic (nopfs-esp-des-sha, nopfs-esp-des-md5)
– Compatible (nopfs-esp-3des-sha, nopfs-esp-3des-md5, nopfs-esp-des-sha, 

nopfs-esp-des-md5)
– Standard (gs-esp-3des-sha, gs-esp-aes128-sha)

• To use a user-defined proposal, select a single proposal from the list of 
predefined and custom IKE Phase 2 Proposals. For details on custom IKE 
proposals, see Chapter 7, “Configuring Objects”. 

If your VPN includes only NetScreen FW/VPN devices, you can specify one predefined or 
custom proposal that NetScreen-Security Manager propagates to all nodes in the VPN. If 
your VPN includes extranet devices, you should use multiple proposals to increase 
security and ensure compatibility. 
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You can bind the VPN tunnel to a tunnel interface or tunnel zone to increase the number 
of available interfaces in the FW/VPN device. To use a tunnel interface and/or tunnel zone 
in your VPN, you must first create the tunnel interface or zone on the device; for details, 
see “Configuring Tunnel Interfaces & Tunnel Zones” on page 398 and Chapter 4, 
“Configuring Devices”. 

• None. Select none when you do not want to bind the VPN tunnel to a tunnel 
interface or zone.

• Tunnel Interface. Select a pre-configured tunnel interface on the FW/VPN 
device to bind the VPN tunnel to the tunnel interface. The FW/VPN device 
routes all VPN traffic through the tunnel interface to the protected resources.

• Tunnel Zone. Select a pre-configured tunnel zone on the FW/VPN device to 
bind the VPN tunnel directly to the tunnel zone. The tunnel zone must include 
one or more numbered tunnel interfaces; when the FW/VPN device routes VPN 
traffic to the tunnel zone, the traffic uses one or more of the tunnel interfaces to 
reach the protected resources.

You can also enable proxy and configure the proxy parameters. 
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You can enable VPN Monitor and configure the monitoring parameters for the device. 
Monitoring is off by default. To enable the VPN Monitor in Realtime Monitor to display 
statistics for the VPN tunnel, configure the following:

• VPN Monitor. When enabled, the device sends ICMP echo requests (pings) 
through the tunnel at specified intervals (configurable in seconds) to monitor 
network connectivity (the device uses the IP address of the local outgoing 
interface as the source address and the IP address of the remote gateway as the 
destination address). If the ping activity indicates that the VPN monitoring 
status has changed, the device triggers an SNMP trap; VPN Monitor (in 
RealTime Monitor) tracks these SNMP statistics for VPN traffic in the tunnel 
and displays the tunnel status.

• Rekey. When enabled, the device regenerates the IKE key after a failed VPN 
tunnel attempts to re-establish itself. When disabled, the device monitors the 
tunnel only when the VPN passes user-generated traffic (instead of using device-
generated ICMP echo requests). Use the rekey option to:

– Monitor devices at the remote site.
– Enable dynamic routing protocols to learn routes at a remote site and 

transmit messages through the tunnel.
– Automatically populate the next-hop tunnel binding table (NHTB table) 

and the route table when multiple VPN tunnels are bound to a single 
tunnel interface.

• Optimized. (This option appears only for devices running ScreenOS 5.x.) When 
enabled, the device optimizes its VPN monitoring behavior as follows:

– Considers incoming traffic in the VPN tunnel as ICMP echo replies. This 
reduces false alarms that might occur when traffic through the tunnel is 
heavy and the echo replies cannot get through.

– Suppresses VPN monitoring pings when the tunnel passes both incoming 
and outgoing traffic. This can help reduce network traffic.

• Source Interface & Destination IP. Configure these options to use VPN 
Monitoring when the other end of the VPN tunnel is not a NetScreen FW/VPN 
device. Specify the source and destination IP addresses. 

*((
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After you have configured the VPN on each device you want to include in the VPN, you 
can add a VPN rule to a Security Policy:

• For policy-based VPNs, you must add a VPN rule to create the VPN tunnel.
• For route-based VPNs, the VPN tunnel is already in place. However, you might 

want to add a VPN rule to control traffic through the tunnel.

For details on adding and configuring a VPN rule in a Security Policy, see “Adding VPN 
Rules” on page 461.
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Creating a device-level Manual Key VPN is a four stage process:

1. Configure XAuth Users
2. Configure Routes (Route-based only)
3. Configure VPN on Device
4. Add VPN rules to Security Policy

*((
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For VPNs that use IPSec manual key to provide remote access services, you must add an 
XAuth User to the FW/VPN device. An XAuth User has an account on the FW/VPN device 
that guards the protected resources in the VPN; when the user attempts to connect to a 
protected resource, the FW/VPN device authenticates the user.

To add a XAuth User for a FW/VPN device, in the FW/VPN device configuration L2TP/
XAuth/Local User, click the Add icon. Enter a name for the user, then specify:

• User. Select a preconfigured Local User object that is configured for XAuth.
• Remote Setting. Select a preconfigured Remote Settings object.
• IP Pool. Select a preconfigured IP Pool object.
• Static IP. Enter the static IP address of the Local User.
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For a routing-based VPN member, you must configure:

• Tunnel zone or tunnel interfaces on the member.
• Static or dynamic routes from the member to other VPN members. 

VPN traffic flows through the tunnel zones or tunnel interfaces on the FW/VPN device, 
and uses static or dynamic routes to reach other VPN members. You must create the 
tunnel zones and interfaces before configuring routes. For details on configuring tunnel 
zones, tunnel interfaces, and static or dynamic routes, see Chapter 4, “Configuring 
Devices”.

After you have configured the tunnel zone or interface on the FW/VPN device, you must 
bind the VPN to that zone or interface to make the VPN functional, as described in the 
following section.
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The following sections detail how to configure the VPN.
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Enter the following values:

• VPN name. Enter a name for the VPN.
• Gateway. Enter a gateway for the VPN.
• Local SPI. The local Security Parameter Index.
• Remote SPI. The remote Security Parameter Index.
• Outgoing Interface. The outgoing interface is the interface on the FW/VPN 

device that sends and receives VPN traffic. Typically, the outgoing interface is in 
the untrust zone.

• Do not set Fragment Bit in the Outer Header. The Fragment Bit controls 
how the IP packet is fragmented when traveling across networks.

– Clear. Use this option to enable IP packets to be fragmented.
– Set. Use this option to ensure that IP packets are not fragmented.
– Copy. Select to use the same option as specified in the internal IP header 

of the original packet.
• IPSec Protocol. Specify the IPSec protocol and algorithm you want to use for 

data authentication and/or encryption. Because this information is static for 
each VPN member, they do not need to negotiate for communication.

– AH. Use Authentication Header to authenticate the VPN traffic, but not 
encrypt the traffic. If you select AH, you must also specify the key or 
password that AH uses in the authentication algorithm.

– ESP. Use Encapsulating Security Payload to authenticate and encrypt the 
VPN traffic. If you select ESP, because ESP uses keys to encrypt and 
decrypt data, you must also specify the key or password that the VPN 
node uses to send and receive VPN data through the VPN tunnel.

.��&���
You can bind the VPN tunnel to a tunnel interface or tunnel zone to increase the number 
of available interfaces in the FW/VPN device. To use a tunnel interface and/or tunnel zone 
in your VPN, you must first create the tunnel interface or zone on the device; for details, 
see “Configuring Tunnel Interfaces & Tunnel Zones” on page 398 and Chapter 4, 
“Configuring Devices”. 

• None. Select none when you do not want to bind the VPN tunnel to a tunnel 
interface or zone.

• Tunnel Interface. Select a pre-configured tunnel interface on the FW/VPN 
device to bind the VPN tunnel to the tunnel interface. The FW/VPN device 
routes all VPN traffic through the tunnel interface to the protected resources.

• Tunnel Zone. Select a pre-configured tunnel zone on the FW/VPN device to 
bind the VPN tunnel directly to the tunnel zone. The tunnel zone must include 
one or more numbered tunnel interfaces; when the FW/VPN device routes VPN 
traffic to the tunnel zone, the traffic uses one or more of the tunnel interfaces to 
reach the protected resources.
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You can enable VPN Monitor and configure the monitoring parameters for the device. 
Monitoring is off by default. To enable the VPN Monitor in Realtime Monitor to display 
statistics for the VPN tunnel, configure the following:

• VPN Monitor. When enabled, the device sends ICMP echo requests (pings) 
through the tunnel at specified intervals (configurable in seconds) to monitor 
network connectivity (the device uses the IP address of the local outgoing 
interface as the source address and the IP address of the remote gateway as the 
destination address). If the ping activity indicates that the VPN monitoring 
status has changed, the device triggers an SNMP trap; VPN Monitor (in 
RealTime Monitor) tracks these SNMP statistics for VPN traffic in the tunnel 
and displays the tunnel status.

• Rekey. When enabled, the device regenerates the IKE key after a failed VPN 
tunnel attempts to re-establish itself. When disabled, the device monitors the 
tunnel only when the VPN passes user-generated traffic (instead of using device-
generated ICMP echo requests). Use the rekey option to:

– Monitor devices at the remote site.
– Enable dynamic routing protocols to learn routes at a remote site and 

transmit messages through the tunnel.
– Automatically populate the next-hop tunnel binding table (NHTB table) 

and the route table when multiple VPN tunnels are bound to a single 
tunnel interface.

• Optimized. (This option appears only for devices running ScreenOS 5.x.) When 
enabled, the device optimizes its VPN monitoring behavior as follows:

– Considers incoming traffic in the VPN tunnel as ICMP echo replies. This 
reduces false alarms that might occur when traffic through the tunnel is 
heavy and the echo replies cannot get through.

– Suppresses VPN monitoring pings when the tunnel passes both incoming 
and outgoing traffic. This can help reduce network traffic.

• Source Interface & Destination IP. Configure these options to use VPN 
Monitoring when the other end of the VPN tunnel is not a NetScreen FW/VPN 
device. Specify the source and destination IP addresses.

*((
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After you have configured the VPN on each device you want to include in the VPN, you 
can add a VPN rule to a Security Policy:

• For policy-based VPNs, you must add a VPN rule to create the VPN tunnel.
• For route-based VPNs, the VPN tunnel is already in place. However, you might 

want to add a VPN rule to control traffic through the tunnel.

For details on adding and configuring a VPN rule in a Security Policy, see “Adding VPN 
Rules” on page 461.
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Creating device-level L2TP VPN is a three stage process:

1. Add L2TP Users
2. Configure L2TP Settings
3. Add VPN rules to Security Policy
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For VPNs that use L2TP to provide remote access services, you must add an L2TP User to 
the FW/VPN device. An L2TP User has an account on the FW/VPN device that guards the 
protected resources in the VPN; when the user attempts to connect to a protected 
resource, the FW/VPN device authenticates the user.

To add a L2TP User for a FW/VPN device, in the FW/VPN device configuration L2TP/
XAuth/Local User, click the Add icon. Enter a name for the user, then specify:

• User. Select a preconfigured Local User object that is configured for L2TP.
• Remote Setting. Select a preconfigured Remote Settings object.
• IP Pool. Select a preconfigured IP Pool object.
• Static IP. Enter the static IP address of the Local User.
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To connect to an L2TP VPN tunnel, the L2TP RAS user uses the IP address and WINS/
DNS information assigned by the user’s ISP. However, when the L2TP RAS user sends 
VPN traffic through the tunnel, the FW/VPN device assigns a new IP address and WINS/
DNS information that enables the traffic to reach the destination network.

Enter a name for the L2TP VPN, then specify the following information:

• Host Name. Enter the name of the L2TP host.
• Outgoing Interface. The outgoing interface is the interface on the FW/VPN 

device that sends and receives VPN traffic. Typically, the outgoing interface is in 
the untrust zone.

• Keep Alive. The number of seconds a VPN member waits between sending hello 
packets to an L2TP RAS user.

• Peer IP. Enter the IP address of the L2TP peer.
• Secret. Enter the shared secret that authenticates communication in the L2TP 

tunnel.
• Remote Settings. Select the preconfigured remote settings object that 

represents the DNS and WINS servers assigned to L2TP RAS users after they 
have connected to the tunnel.

• IP Pool Name. Select the preconfigured IP pool object that represents the 
available IP addresses that can be assigned to L2TP RAS users after they have 
connected to the tunnel.
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• Auth Server. 
– Use the default settings to use the default authentication server for the 

domain. To change or assign a domain authentication server, edit the 
domain settings; for details, see Chapter 2, “Configuring Role-Based 
Administration (RBA)”.

– Use custom settings to specify a preconfigured authentication server 
object to assign TCP/IP settings to the gateway and authenticate specific 
L2TP User or User Groups.
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After you have configured the VPN on each device you want to include in the VPN, you 
can add a VPN rule to a Security Policy:

• For policy-based VPNs, you must add a VPN rule to create the VPN tunnel.
• For route-based VPNs, the VPN tunnel is already in place. However, you might 

want to add a VPN rule to control traffic through the tunnel.

For details on adding VPN rules to a Security Policy, see “Adding VPN Rules” on page 
461.
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Creating a device-level L2TP-over-Autokey IKE VPN is a six stage process:

1. Add L2TP Users (see “Adding L2TP Users” on page 460)
2. Configure L2TP Settings (see “Configuring L2TP” on page 460)
3. Configure Peer Gateway (see “Configuring Gateways” on page 449)
4. Configure Routes (Route-based only) (see “Configuring Routes (Route-based 

only)” on page 453)
5. Add VPN to Device (see “Configuring the VPN” on page 454)
6. Add VPN rules to Security Policy (see “Adding a VPN Rule” on page 461)
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To create a policy-based VPN or to add access policies to a route-based VPN, you must add 
a VPN rule to a FW/VPN policy for each device in the VPN. 

Adding a VPN Rule is a three stage process:

1. Configuring the VPN rule
2. Configure Security Policy 
3. Installing the Security Policy
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In Security Policies, select a predefined Security Policy (or create a new policy), and add a 
VPN rule. right-click in the Source Address, Destination Address, Action, or Install On 
column and select Configure VPN to display the Configure VPN dialog box.

• Select the source FW/VPN device that contains the termination interface for the 
VPN tunnel.

• Select a VPN Type:
– For IKE VPNs, select the VPN that you configured on the device.
– For L2TP VPNs, you must also select the L2TP tunnel that you configured 

on the device.
• Select the Protected Resources for the VPN:

– If both VPN termination points are FW/VPN devices, choose the protected 
resources that represent the network components you want to protect. 
You can also select a predefined Global MIP or VIP for the device.

– If the source VPN termination point is a RAS user, select Source is Dialup 
and choose the Protected Resources behind the destination VPN 
termination point that represent the network components you want to 
protect on the remote network.

– If the destination VPN termination point is a RAS user, select Destination 
is Dialup and choose the Protected Resources behind the source VPN 
termination point that represent the network components you want to 
protect on the local network.
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To configure the remaining columns for the VPN rule:

• From Zone. Select the zone on the source VPN member that contains the 
termination interface for the VPN tunnel.

• To Zone. Select the zone on the destination VPN member that contains the 
termination interface for the VPN tunnel.

• In the Service column, select the services you want to permit in the VPN tunnel

You do not need to configure the action—NetScreen-Security Manager automatically 
defines the action as tunnel. You can also configure traffic shaping, options, 
authentication, antivirus, or attack protection for the VPN Rule. For details on 
configuring these rule options, see Chapter 8, “Configuring Security Policies”.

To deny a host, use a deny rule before the VPN rule.

*��
���7������  ��<�����	�
����� 
��
You must assign the Security Policy to the each VPN member and install the Security 
Policy on those devices before the VPN is active.
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This section provides examples of the two device-level VPN types:

• Route-Based Site-to-Site VPN, Manual Key
• Policy-Based Site-to-Site VPN, Manual Key
• Policy-Based RAS VPN, L2TP

The following sections provide step-by-step instructions on creating each type of device-
level VPN.
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In this example, a Manual Key tunnel provides a secure communication channel between 
offices in Tokyo and Paris. The Trust zones at each site are in NAT mode. The Trust and 
Untrust security zones are in the trust-vr routing domain, and the Untrust zone interface 
(ethernet3) serves as the outgoing interface for the VPN tunnel.

To set up the tunnel, you must configure the NetScreen FW/VPN devices at both ends of 
the tunnel. First, you create the VPN components that you use to build the VPN, such as 
the NetScreen FW/VPN devices and the shared Address Objects. Next, you create the 
tunnel interfaces for each device and configure the VPN tunnel. You must also add the 
necessary static routes on each device to create the VPN tunnel. Finally, you create 
firewall rules in a Security Policy to control VPN traffic between the two sites.

Note: For examples on creating other VPN types using VPN Manager, see “VPN 
Manager Examples” on page 418.

Internet

VPN Tunnel

Tokyo Trust Zone 
eth1 10.1.1.1/24

Outgoing Interface 
Untrust Zone
eth3 1.1.1.1/24
gateway 1.1.1.250

Outgoing Interface 
Untrust Zone
eth3, 2.2.2.2/24
Gateway 2.2.2.250

Tunnel Interface Tunnel.1 Tunnel Interface Tunnel.1

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Tokyo.

Trust Zone Untrust Zone Trust ZoneUntrust Zone

TokyoParisTokyo Paris

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Paris.

Paris Trust Zone 
eth1 10.2.2.1/24
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To create a Manual Key, Route-based, Site-to-Site VPN, create the following VPN 
components:

• NetScreen FW/VPN Devices
• Address Objects

The following sections detail how to create each component.

�&&��/������������34*0 ����(���%

Add the Tokyo and Paris FW/VPN devices (for details on adding devices, see Chapter 3, 
“Adding Devices”):

• Configure the Tokyo device with the following interfaces:
– Ethernet1 is the Trust IP (10.1.1.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (1.1.1.1/24) in the Untrust zone.

• Configure the Paris device with the following interfaces:
– Ethernet1 is the Trust IP (10.2.2.1/24) in the Trust zone.
– Ethernet3 is the Untrust IP (2.2.2.2/24) in the Untrust zone.

)�������/���&&��%%�	,5���%

Create the Address Objects that you will use to create the VPN rule in your Security 
Policy (for details on creating VPN rules, see “Adding VPN Rules” on page 461). If you 
imported a NetScreen FW/VPN device, the address book objects configured on that device 
are automatically imported as Address Objects into the NetScreen-Security Manager UI.

To add the Tokyo Trust LAN (10.1.1.0/24) as an network Address Object:

1. In Address Objects, click the Add icon and select Network. 
2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.

To add the Paris Trust LAN (10.2.2.0/24) as a network Address Object:

1. In Address Objects, click the Add icon and select Network. 



Device-Level VPN Examples

NetScreen-Security Manager 2004 FP2 465

2. Configure the object as shown below:

3. Click OK to save the object and return to Object Manager.
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To enable the Tokyo device to participate in the Manual VPN, you must configure the 
following areas:

• Create the Tunnel Interface
• Create the VPN
• Create Routes

The following sections detail how to configure each area of the Tokyo device.

)�������/�������$������+����9��-��:
1. In Device Manager, doubleclick the device icon for Tokyo to open the device 

configuration.
2. In the device navigation tree, select Network > Interface. Click the Add icon and 

select Tunnel Interface. The General Properties screen appears.
3. Configure as shown below:

– For Zone, select untrust. 
– For IP Options, select Unnumbered.
– For Source Interface, select ethernet3.
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4. Click OK to save the new tunnel interface. 

)�������/��0 ��9��-��:
1. In the device navigation tree, select VPN Settings > AutoKey IKE/Manual VPN. 
2. Select the Manual tab, then click the Add icon. The Properties screen appears. 

Configure the Properties tab as shown below:

– For Name, enter Tokyo_Paris.
– For Gateway, enter 2.2.2.2. 
– For Local SP, enter 3020. 
– For Remote SPI, enter 3030. 
– For Outgoing Interface, select ethernet3.
– For ESP/AH, select ESP CBC.
– For Encryption Algorithm, select 3DES-CBC.
– Select Generate Key by Password, then enter the password asdlk24234. 
– For Authentication Algorithm, select SHA-1.
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– Select Generate Key by Password, then enter the password PNas134a.
3. Select the Binding tab. Configure as shown below:

4. Click OK to save the new VPN.

)�����������%�9��-��:
1. In the device navigation tree, select Network > Virtual Router to display the list 

of virtual routers on the device.
2. Double-click the trust-vr route to open the vr for editing.
3. In the virtual router dialog box, click Routing Table, then click the add icon 

under destination-based Routing Table to add a new static route.

4. Configure a route from the untrust interface to the gateway, as shown below:

Note: ScreenOS 4.0.x devices display only the destination-based Routing 
Table; ScreenOS 5.x devices display both destination-based and source-based 
routing tables
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5. Configure route from the trust zone to the tunnel interface, as shown below:

Your routing table should appear as shown below:

6. Click OK to save your changes to the virtual router, then click OK to save your 
changes to the Tokyo device.
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To enable the Paris device to participate in the Manual VPN, you must configure the 
following areas:

• Create the Tunnel Interface
• Create the VPN
• Create Routes

The following sections detail how to configure each area of the Paris device.

)�������/�������$������+����9 ���%:
1. In Device Manager, doubleclick the device icon for Paris to open the device 

configuration.
2. In the device navigation tree, select Network > Interface. Click the Add icon and 

select Tunnel Interface. The General Properties screen appears.
3. Configure as shown below:

– For Zone, select untrust. 
– For IP Options, select Unnumbered.
– For Source Interface, select ethernet3.

4. Click OK to save the new tunnel interface. 

)�������/��0 ��9 ���%:
1. In the device navigation tree, select VPN Settings > AutoKey IKE/Manual VPN. 

1. Select the Manual tab, then click the Add icon. The Properties screen appears. 
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2. Configure the Properties tab as shown below:

– For Name, enter Paris_Tokyo.
– For Gateway, enter 2.2.2.2. 
– For Local SP, enter 3020. 
– For Remote SPI, enter 3030. 
– For Outgoing Interface, select ethernet3.
– For ESP/AH, select ESP CBC.
– For Encryption Algorithm, select 3DES-CBC, then select Generate Key by 

Password and enter the password asdlk24234. 
– For Authentication Algorithm, select SHA-1, then select Generate Key by 

Password and enter the password PNas134a.
3. Select the Binding tab. Configure as shown below:
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4. Click OK to save the new VPN.

)�����������%�9 ���%:
1. In the device navigation tree, select Network > Virtual Router to display the list 

of virtual routers on the device.
2. Double-click the trust-vr route to open the vr for editing.
3. In the virtual router dialog box, click Routing Table, then click the add icon 

under destination-based Routing Table to add a new static route.

4. Configure a route from the untrust interface to the gateway, as shown below:

Note: ScreenOS 4.0.x devices display only the destination-based Routing 
Table; ScreenOS 5.x devices display both destination-based and source-
based routing tables
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5. Configure route from the trust zone to the tunnel interface, as shown below:

Your routing table should appear as shown below:

6. Click OK to save your changes to the virtual router, then click OK to save your 
changes to the Paris device.
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1. In the main navigation tree, select Security Policies. Click the Add icon and 

configure the Security Policy as shown below:

– For Security Policy Name, enter Corporate Route-Based VPN. 
– Add comments, if desired.
– Click OK to create the new policy.

2. In the main navigation tree, select Security Policies > Corporate Route-Based 
VPN. The security policy appears in the main display area.

3. Configure the rules as shown below:
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In this example, a Manual Key tunnel provides a secure communication channel between 
offices in Tokyo and Paris, using ESP with 3DES encryption and SHA-1 authentication. 
The Trust zones at each site are in NAT mode. The Trust and Untrust security zones and 
the Untrust-Tun tunnel zones are in the trust-vr routing domain. The Untrust zone 
interface (ethernet3) serves as the outgoing interface for the VPN tunnel.
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To set up the tunnel, you must configure the NetScreen FW/VPN devices at both ends of 
the tunnel. First, you create the VPN components that you use to build the VPN, such as 
the NetScreen FW/VPN devices and the shared Address Objects. Next, you configure the 
VPN tunnel and add the necessary static routes on each device. Finally, you create VPN 
rules in a Security Policy to create the VPN tunnel between the two sites. 

���!����)������0 ��)�#!�����%
To create a Manual Key, Route-based, Site-to-Site VPN, create the following VPN 
components:

• NetScreen FW/VPN Devices. See “Add the NetScreen FW/VPN Devices” on page 
464.

• Address Objects. See “Create the Address Objects” on page 464.
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To enable the Tokyo device to participate in the Manual VPN, you must configure the 
following areas:

• Create the VPN
• Create Routes. See “Create Routes (Tokyo)” on page 467.

The following sections detail how to configure the VPN on the Tokyo device.
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1. In the device navigation tree, select VPN Settings > AutoKey IKE/Manual VPN. 

Tokyo Trust Zone 
eth1 10.1.1.1/24

Outgoing Interface 
Untrust Zone
eth3, 1.1.1.1/24 
Gateway 1.1.1.250

VPN Tunnel

Internet

Paris Trust Zone
eth1 10.2.2.1/24

Outgoing Interface 
Untrust Zone
eth3, 2.2.2.2/24 
Gateway 2.2.2.250

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Tokyo.

Trust Zone Untrust Zone Trust ZoneUntrust Zone

TokyoParisTokyo Paris

Topology of the zones 
configured on the NetScreen 
FW/VPN device in Paris.

Untrust-Tun Zone Untrust-Tun Zone
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2. Select the Manual tab, then click the Add icon. The Properties screen appears. 
Configure the Properties tab as shown below:

– For Name, enter Tokyo_Paris.
– For Gateway, enter 2.2.2.2. 
– For Local SP, enter 3020. 
– For Remote SPI, enter 3030. 
– For Outgoing Interface, select ethernet3.
– For ESP/AH, select ESP CBC.
– For Encryption Algorithm, select 3DES-CBC.
– Select Generate Key by Password, then enter the password asdlk24234. 
– For Authentication Algorithm, select SHA-1.
– Select Generate Key by Password, then enter the password PNas134a.
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3. Select the Binding tab. Configure as shown below:

– For Binding, select Tunnel Zone.
– For Tunnel Zone, select untrust-tun.

4. Click OK to save the new VPN.
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To enable the Paris device to participate in the Manual VPN, you must configure the 
following areas:

• Create the VPN
• Create Routes. See “Create Routes (Paris)” on page 471.

The following sections detail how to configure the VPN on the Paris device.
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1. In the device navigation tree, select VPN Settings > AutoKey IKE/Manual VPN. 
2. Select the Manual tab, then click the Add icon. The Properties screen appears.
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3. Configure the Properties tab as shown below:

– For Name, enter Paris_Tokyo.
– For Gateway, enter 2.2.2.2. 
– For Local SP, enter 3020. 
– For Remote SPI, enter 3030. 
– For Outgoing Interface, select ethernet3.
– For ESP/AH, select ESP CBC.
– For Encryption Algorithm, select 3DES-CBC, then select Generate Key by 

Password and enter the password asdlk24234. 
– For Authentication Algorithm, select SHA-1, then select Generate Key by 

Password and enter the password PNas134a.
4. Select the Binding tab. Configure as shown below:
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5. Click OK to save the new VPN.
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1. In the main navigation tree, select Security Policies. Click the Add icon and 

configure the Security Policy as shown below:

– For Security Policy Name, enter Corporate Policy-Based VPN.
– Enter comments, if desired.
– Click OK to create the new policy.

2. In the main navigation tree, select Security Policies > Corporate Policy-Based 
VPN. The security policy appears in the main display area.



Device-Level VPN Examples

NetScreen-Security Manager 2004 FP2 479

3. Configure two VPN rules as shown below:

– Rule 1 creates the VPN tunnel from the Tokyo device to the Paris device.
– Rule 2 creates the VPN tunnel from the Paris device to the Tokyo device.

4. Save the Security Policy.
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In this example, you create a RAS user group called Field Sales and configure an L2TP 
tunnel called Sales_Corp, using ethernet3 (Untrust zone) as the outgoing interface for the 
L2TP tunnel. The NetScreen FW/VPN device applies the default L2TP tunnel settings to 
the RAS user group.

The remote L2TP clients are on Windows 2000 operating systems. For information on how 
to configure L2TP on the remote clients, refer to Windows 2000 documentation. Only the 
configuration for the NetScreen FW/VPN device end of the L2TP tunnel is provided below. 

1. Configure the L2TP user objects:

a. Configure an L2TP user object for Adam, as shown below:

– For Name, enter Adam.
– Select Enable, then select L2TP.
– Select Password, then enter and confirm the password: AJbioJ15.

Click OK to save the new user object. 

Note: An L2TP-only configuration is insecure and is recommended only for debugging.

Local User Group: Field Sales

Adam

Betty

Carol

DNS 1: 1.1.1.2
DNS 1.1.1.3

Corporate Network

IP Pool: Global
10.10.2.100 – 10.10.2.180

Internet

L2TP Tunnel: Sales_Corp
ethernet3, 1.1.1.1/24
(Outgoing Interface)

Untrust Zone

ethernet1, 10.1.1.1/24

Trust Zone
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b. Configure an L2TP user object for Betty:
– For Name, enter Betty.
– Select Enable, then select L2TP.
– Select Password, then enter and confirm the password: BviPsoJ1.

Click OK to save the new user object. 

c. Configure an L2TP user object for Carol:
– For Name, enter Carol.
– Select Enable, then select L2TP.
– Select Password, then enter and confirm the password: Cs10kdD3.

Click OK to save the new user object. 

2. Create a local user group called Field Sales that includes the Adam, Betty, and 
Carol local user objects. For details on creating a local user group, see 
“Configuring Local User Groups” on page 328.

3. Configure the Remote Settings object named RM_L2TP, as shown below:

– For Dns1, enter 1.1.1.2.
– For Dns2, enter 1.1.1.3.
– For Wins1, enter 0.0.0.0.
– For Wins2, enter 0.0.0.0.

Click OK to save the new Remote Settings object. For details on creating Remote 
Settings objects, see “Configuring Remote Settings” on page 337.
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4. Configure the IP Pool object named Global, configured as shown below:

– For IP Pool Name, enter Global.
– For Start IP, enter 10.10.2.100.
– For End IP, enter 10.10.2.180.

Click OK to save the new IP Pool object. For details on creating IP Pool objects, 
see “Configuring IP Pools” on page 333.

5. Configure the L2TP tunnel:

a. In Device Manager, double-click the device icon for the device on which 
you want to configure the L2TP tunnel.

a. In the device navigation tree, select VPN Settings > L2TP. In the main 
display area, click the Add icon. The null-L2TP tunnel dialog box appears.
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b. Configure as shown below:

– For Name, enter Sales_Corp.
– For Outgoing Interface, select ethernet3.
– For Keep Alive, enter 60.
– For Peer IP, enter 0.0.0.0 (because the peer’s ISP dynamically assigns it 

an IP address, enter 0.0.0.0 here).
– Select Use Custom Settings, and leave the default authentication server 

as Local.
– For User/Group, select Dialup Group, then select Field Sales. 

c. Click OK to save the new L2TP tunnel, then click OK to save your changes 
to the device.
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6. Configure a rule in the Zone-Based Rulebase of a Security Policy:
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• About Realtime Monitor

• Monitoring FW/VPN Devices

• Monitoring VPNs

• Monitoring NSRP Statistics

• Using The Realtime Monitor

The Realtime Monitor module in Juniper Networks NetScreen-Security Manager enables 
you to monitor status and traffic statistics for all the managed Juniper Networks 
NetScreen FW/VPN devices in your network in real time. You can use the Realtime 
Monitor to monitor and track the day-to-day health and performance of your network FW/
VPN devices, VPN tunnels, and NSRP clusters.
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The Realtime Monitor module in NetScreen-Security Manager enables you to monitor real 
time status and statistics about all the managed FW/VPN devices, VPN tunnels, and 
NSRP clusters in your network at a glance. You can use the Realtime Monitor to identify 
problems, track security events, and discover trends across multiple geographic regions 
and functional areas from a central management location

The Realtime Monitor can also help you quickly identify potential device, network, or 
even system-level problems, such as:

• Configuration status. At the device level, you can monitor the changing status 
of one or more FW/VPN devices in real time.

• Connection Status. At the network level, you can monitor problems that could 
lead to failed devices.

• Performance. At the system level, you can monitor the activity between VPN 
members or NSRP cluster. 

The Realtime Monitor tracks the integrity of your security perimeter by continually 
monitoring your FW/VPN devices for security events (failed FW/VPN devices, abnormal 
utilization, general errors). The Realtime monitor does the work of a management expert 
by first gathering information about specific processes and network activity, then color-
coding each event to organize problems.
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Realtime Monitor includes three views:

• Device Monitor displays status information on the managed FW/VPN devices 
in your network. This includes the name and type of each FW/VPN device 
managed in NetScreen-Security Manager, connection status, and current 
configuration status. From the Device Monitor, you can also access more 
detailed information and statistics on each FW/VPN device including ScreenOS 
version, mode, CPU utilization, memory, sessions, and network traffic.

• VPN Monitor displays status information on all VPN tunnel sessions that have 
been implemented within the domain you are working in. From the VPN 
Monitor, you can determine if a VPN tunnel is up, down, or not monitored.

• NSRP Monitor displays status information about NSRP (NetScreen 
Redundancy Protocol) clusters in your network. If you implement NSRP for the 
purpose of deploying clusters in your NetScreen security system, you can use the 
NSRP Monitor to view and troubleshoot the status of FW/VPN devices in 
clusters within the domain you are working in.

Note: If you previously implemented historical reporting in Juniper Networks 
NetScreen Global PRO, you can continue to use these reports to track Service Level 
Agreement, traffic, and resource statistics on NetScreen FW/VPN devices running 
NetScreen ScreenOS 4.0.x. 
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Use the Device Monitor to get an at-a-glance view of the current status of all the managed 
FW/VPN devices in your network. Information provided by the Device Monitor includes:

• up/down connection status of managed FW/VPN devices
• configuration status of the FW/VPN devices in NetScreen-Security Manager
• name, type and firmware version running on the FW/VPN devices managed in 

NetScreen-Security Manager
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The following table lists and describes all the FW/VPN device information that you can 
view through the Device Monitor:

Column Description

Name Unique name assigned to the FW/VPN device in NetScreen-Security 
Manager

Type Model number of the FW/VPN device.

OS Version ScreenOS firmware version running on the FW/VPN device.



Chapter 10 Monitoring

490 Administrator’s Guide

Config Status Displays the current configuration status of the FW/VPN device in 
NetScreen-Security Manager:

• None. No state has been set (does not show in Device Monitor).

• Modeled. The FW/VPN device exists in NetScreen-Security 
Manager, but a connection to the device has not yet been 
established.

• RMA. Equivalent to bringing the device into the Modeled state. RMA 
results from an admin selection in the User Interface when a FW/
VPN device goes down.

• Waiting for 1st connect. NetScreen-Security Manager is waiting for 
the FW/VPN device to connect. You must enter a command on the 
FW/VPN device to make it connect to NetScreen-Security Manager.

• Import Needed. You must import the configuration of the FW/VPN 
device into NetScreen-Security Manager. When you add a FW/VPN 
device running ScreenOS 5.x, for the first time, verify that your 
status indicates “Import Needed” before you attempt to import the 
device. During migration, this state indicates that import of the FW/
VPN device configuration is still required.

• OS Version Adjustment Needed. The firmware version detected 
running on the device is different than what was previously detected 
in NetScreen-Security Manager. This could happen in the event that 
the automatic adjustment option was cleared during a change 
device firmware directive.

• Update Needed. An update to this FW/VPN device is required. 

• Managed. The FW/VPN device is currently being managed by 
NetScreen-Security Manager.

Connection Status Displays the connection status of the FW/VPN device in NetScreen-
Security Manager as either:

• Up. FW/VPN device is currently connected to NetScreen-Security 
Manager.

• Down. FW/VPN Device is not currently connected to NetScreen-
Security Manager, but has connected in the past.

• Never Connected. FW/VPN device has never connected to 
NetScreen-Security Manager.

The Device Server checks the connection status of each device every 
120 seconds by default. You can change this behavior by editing the 
value for the devDaemon.deviceHeartbeatTimeout 
parameter in the Device Server configuration file. Refer to the 
NetScreen-Security Manager 2004 Installer’s Guide for more 
information on editing configuration files.

First Connect The first time the FW/VPN device connected to the NetScreen-
Security Manager Device Server.

Latest Connect The last time the FW/VPN device connected to the NetScreen-
Security Manager Device Server. 

Latest Disconnect The last time the FW/VPN device disconnected from the NetScreen-
Security Manager Device Server.
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NetScreen-Security Manager retrieves device statistics from the physical FW/VPN device. 
The device polling interval determines the number of seconds the Device Server waits 
before polling for new statistics. 

To configure or view the device polling intervals, double-click the Device Server, then 
select the Device Polling tab. Edit the intervals to meet your monitoring requirements:
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If a FW/VPN device is up and running, you can also access additional information on the 
device that may help you to diagnose and troubleshoot a problem from the Device 
Monitor. To view additional status, you can view Device Details. For traffic-related 
statistics and other information, you can View Statistics.

Statistic Description Poll Interval Save Interval

Device Details traffic, interface, zone, and system-
related statistics on a specific device. 
Information appears in the Device Monitor.

120 120

VPN Details VPN tunnels between your managed 
devices, including VPN tunnel status (Up, 
Down, Not Monitored), VPN name, VPN Type, 
VPN source, VPN destination, security 
parameter index (SPI), IP address, and 
protocol. Information appears in the VPN 
Monitor.

120 120

NSRP Details high availability events and statistics, 
including VSD group ID, number of units in the 
cluster, state change counter, init counter, 
number of Master devices, number of Backup 
devices, and heartbeat information. Information 
appears in the NSRP Monitor.

120 120

Interface Details the interface number, IP address, and 
zone to which the interface is mapped. 
Information appears in the Device Monitor, in 
the Device Summary.

120 30

Note: If a FW/VPN device is never connected, the Device Detail Status and Statistics 
views for the device are not available.
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You can also access more specific status information related to resource usage about a 
FW/VPN device that is up and running by viewing the Device Detail Status. To view the 
Device Detail Status on a particular FW/VPN device, right-click on the FW/VPN device 
and select View Details or simply double-click the FW/VPN device.

The following table lists and describes all the information that you can view through the 
Device Detail Status:

Item Description

OS Version Indicates the ScreenOS firmware version running on the FW/VPN device.

Mode Current operation mode of the FW/VPN device: Network Address Translation 
(NAT), Transparent, or Route.

Latest Reboot Indicates the most recent date and time that the FW/VPN device was powered 
off and on. You can use this information to determine how long the FW/VPN 
device was down.

CPU Utilization The percent of the CPU being used at the moment of the status snapshot.

One Min. Load The percent CPU utilization average on the FW/VPN device for the last 1 min.

5 Min. Load The percent CPU utilization average on the FW/VPN device for the last 5 mins.
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If a FW/VPN device is up and running, you can also access the Statistics view to access 
traffic, interface, zone, and other system-related information on the device. To view 
statistics on a particular FW/VPN device, right-click on the FW/VPN device in either the 
Device Monitor or the Device Manager and select View Statistics. The Device Statistics 
Summary appears in a new window.
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The Device Statistics Summary displays the following details:

• Details describing the FW/VPN device or virtual system, for example, serial 
number and IP address, type, and firmware version.

• Interface information
• Device status
• Time-related statistics (i.e., last connect, reboot, etc.) 

15 Min. Load The percent CPU utilization average on the FW/VPN device for the last 15 mins.

Mem Allocated The original amount of memory allocated to the FW/VPN device.

Mem Left The amount of allocated memory that remains after being used by the FW/VPN 
device.

Mem Fragmented The amount of fragmented memory.

Active Sessions The number of active sessions on the FW/VPN device.

Allocated 
Sessions

The number of sessions originally allocated to the FW/VPN device.

Max Sessions The maximum number of sessions on the FW/VPN device.

Failed Sessions The number of sessions that have failed on the FW/VPN device.
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The following table details all the information you can view about a particular FW/VPN 
device from the Device Statistics Summary.
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From the Device Statistics Summary, you can access additional information enabling you 
to view and monitor key traffic, interface, zone, and other system-related information on a 
specific FW/VPN device. You can also use Troubleshooting to access the send “get 
commands” window in order to further diagnose and troubleshoot potential issues.

Item Displays

Device Device: Displays the name, serial number, and IP address of the FW/
VPN device.
Vsys: Displays the serial number of the FW/VPN device.

Vsys The name of the virtual system (if applicable)

Version The FW/VPN device’s build, model, and operation mode (this is not 
displayed in the Vsys view).

DC IP The IP Address of the Date Collector the FW/VPN device is contacting 
(this is not displayed in the Vsys view).

Interface Information The employed interfaces. For example, Trust, Untrust, and Self.

Vsys Information The virtual systems associated with this FW/VPN device (this is not 
displayed in the Vsys view).

Last Known Connect 
Time

The last time the FW/VPN device connected to the Data Collector (this 
is not displayed in the Vsys view).

Device Status Whether the FW/VPN device is currently up or down (this is not 
displayed in the Vsys view)

Last Reboot Time The last time the system was restarted (this is not displayed in the Vsys 
view).

Last Known Uptime If the FW/VPN device is down, the entry lists the last time it was up. 
Used to determine how long a FW/VPN device was down (this is not 
displayed in the Vsys view).

GMT Time Offset 
(Hours)

The hour the FW/VPN device is set from Greenwich Mean Time (this is 
not displayed in the Vsys view).

DayLight-Saving If you have enabled the FW/VPN device to adjust time for daylight 
savings.
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The following table describes each device-specific view.

View Type View Enables you to...

Traffic Policy Distribution View traffic on the FW/VPN device distributed by policy. 
Enables you to view a chart of the traffic distribution by 
policy.

Protocol 
Distribution

View traffic on the FW/VPN device distributed by 
protocol. Enables you to view a chart of the traffic 
distribution by protocol.

VPN Distribution View the up/down status and active statistics of VPNs on 
the FW/VPN device (if applicable). Also Enables you to 
view a chart of the VPN distribution by VPN tunnel.

Interface Ethernet Statistics View FW/VPN device traffic over specific interfaces. 
Enables you to view a chart of the utilization distributed 
by interface.

Flow Statistics View FW/VPN device traffic on flow counters over 
specific interfaces. Enables you to view a chart of flow 
statistics distributed by interface.

Attack Statistics View all of the attacks that have occurred on a FW/VPN 
device over specific interfaces. Enables you to view a 
chart of attacks distributed by interface.

Zone Ethernet Statistics View FW/VPN device traffic from specific zones. 
Enables you to view a chart of the traffic distributed by 
zone.

Flow Statistics View FW/VPN device traffic on flow related statistics for 
specific interfaces. Enables you to view a chart of flow 
statistics distributed by zone.

Attack Statistics View all counters related to attacks that have occurred 
on a FW/VPN device from specific zones. Enables you 
to view a chart of the attacks distributed by zone.

System Resource Statistics View CPU utilization and memory allocation statistics on 
the FW/VPN device. Enables you to view CPU, Memory 
and Session Utilization trends.

Active Statistics View administrator and user activities; active VPNs; and 
authenticated users on a FW/VPN device. Also enable s 
you to view a snapshot of the ongoing active sessions 
on the FW/VPN device.

Troubleshooting Send troubleshooting commands over Telnet or SCS to 
a specific FW/VPN device.

HA NSRP Statistics View NSRP statistics related to clusters created on the 
FW/VPN device (if applicable).



Chapter 10 Monitoring

496 Administrator’s Guide

0��1������(�������++�����%���,�����
You can view statistics describing the traffic on a specific FW/VPN device including how 
the traffic is distributed (i.e., either by policy, protocol, or VPNs (if applicable)). You can 
use this information to help you identify those policies, protocols and VPN tunnels that 
are most and least frequently being used on a FW/VPN device.
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Click on the Policy Distribution node to view FW/VPN device traffic that matches the 
access policies configured for a FW/VPN device. A bar graph appears (under the Chart 
tab) depicting the distribution of data by policy. The graph displays a percentage of the 
absolute number of bytes for the top 10 policies by default.

The following table describes all of the information that is available from the Policy 
Distribution view..

Item Displays...

Policy ID the unique identifier of the policy.

Source IP the IP address of the host generating the session.

Source IP Mask the IP address mask for the host or network generating the session.

Destination IP the IP address of the host receiving the session.

Destination IP Mask the IP address mask for the host or network receiving the session.
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You can adjust all elements depicted in the graph including the policies, data values (i.e., 
absolute or delta), and type of data (bytes in or out, packets in or out, utilization).

To adjust policies depicted graphically:

1. Right-click within the chart and select Configure Policies. A dialog enabling 
you to select which policies to view appears.

2. Clear the Default checkbox.
3. Click to select the policies that you wish to view on the graph from the list of 

Available Policies. Click Add to add the policies that you want to the list of 
Selected Policies.

4. Click to select the policies that you no longer wish to view on the graph from the 
list of Selected Policies. Click Remove to remove the policies from the list of 
Selected Policies.

5. Click OK to apply your changes; or click Cancel to cancel your changes.

To adjust data and data types depicted graphically:

1. Right-click the Chart view.
2. From the Data option, select either Delta or Absolute.
3. From the Data Type option, select either Connections, Bytes, or Packets.
4. Click OK to apply your changes; or click Cancel to cancel your changes.

Source Zone Zone of the host generating the session.

Destination Zone Zone of the host receiving the session.

VPN Name Name of the Virtual Private Network.

Service the application or service associated with the policy. Examples include 
Mail, FTP, SNMP, AOL, Telnet, and LDAP.

Action the activity to be performed, such as Permit, Deny, Tunnel, etc.

Total Connections the total number of data connections.

Connection Rel% the relative percentage of connections.

Delta Connection the total numerical difference between the current connection value 
and the previous connection value.

Total Bytes the total number of data bytes.

Bytes Rel% the relative percentage of bytes.

Delta Bytes the total numerical difference between the current bytes value and the 
previous bytes value.

Total Packets the total number of data packets.

Packets Rel% the relative percentage of packets.

Delta Packets the total numerical difference between the current bytes value and the 
previous packets value.

Policy Name name of the policy.

Item Displays...
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Click on the Protocol Distribution node to view the distribution of traffic according to 
the protocols flowing through the device. Protocols are predefined services (such as, 
HTTP, SNMP, or Telnet) that are enabled for each FW/VPN device. You can view up to 
ten protocols. A bar graph appears similar to the one presented for viewing traffic 
according to policy distribution. The graph displays a percentage of the absolute number 
of bytes for the top 10 protocols by default.

The following table describes all of the information that is available from the Protocol 
Distribution view:

Item Displays...

Protocol the name of the predefined service (like HTTP, SNMP, or Telnet) operating 
on the selected interface.

Interface the type of interface through which the protocol is flowing.

Bytes In the number of incoming bytes for the protocol through the FW/VPN device.

Bytes In Rel% Relative percentage of all incoming bytes.

Delta Bytes In the total numerical difference between the current bytes in value and the 
previous bytes in value.

Bytes Out the number of outgoing bytes for the protocol through the FW/VPN device.

Bytes Out Rel% Relative percentage of all outgoing bytes.
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You can adjust the interfaces (i.e., Trust, Untrust, Management, NSRP, and Self) and 
data depicted graphically in the same way that you adjust the Policy Distribution graphs.

Delta Bytes Out the total numerical difference between the current bytes out value and the 
previous bytes out value.

Packets In the number of incoming packets handled by the protocol through the FW/
VPN device.

Packets In Rel% Relative percentage of all incoming packets.

Delta Packets In the total numerical difference between the current packets in value and the 
previous packets in value.

Packets Out the number of outgoing packets handled by the protocol through the FW/
VPN device.

Packets Out 
Rel%

Relative percentage of all outgoing packets.

Delta Packets 
Out

the total numerical difference between the current packets out value and 
the previous packets out value.

Util. (Absolute) the total number of the utilization of the current FW/VPN device.

Util. (Delta) the total numerical difference between the current utilization value and the 
previous utilization value.

Zone the name of the zone associated with the protocol.

Note: Additional options enable you to adjust the data types in the Protocol 
Distribution graph by Bytes In, Bytes Out, Packets In, Packets Out, or Utilization, and 
by Interface.

Item Displays...



Chapter 10 Monitoring

500 Administrator’s Guide

0��1�������++�����%���,������,��0 ��9�+��!!$���,$�:
If you are using your FW/VPN devices to implement VPNs, you can view how traffic is 
being distributed across each different VPN tunnel on the FW/VPN device. A bar graph 
appears (under the Chart tab) depicting the distribution of data traveling to and from 
each VPN tunnel. The graph uses a percentage of the absolute number of bytes traveling 
in to the top 10 VPN tunnels by default.

You can adjust all elements depicted in the graph including the VPN tunnels, data values 
(i.e., absolute or delta), and type of data (bytes in or out, packets in or out, utilization).

�&5�%�����0 �������$%���!����&����!/���$$�
1. Right-click on the Chart view and select Configure VPNs. A pop-up enabling 

you to select VPNs appears.
2. Clear the Default checkbox.
3. Click to select the VPN tunnel that you wish to view on the graph from the list of 

Available VPN tunnels. Click Add to add the VPN tunnel to the list of Selected 
VPN tunnels.

4. Click to select the VPN tunnel that you no longer wish to view on the graph from 
the list of Selected VPN tunnels. Click Remove to remove the VPN tunnel from 
the list of Selected VPN tunnels.

5. Click OK to apply your changes; or click Cancel to cancel your changes.
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1. Right-click on the Chart view and select Data, and either Delta or Absolute.
2. Right-click on the Chart view and select Data Type, and either Bytes In, Bytes 

Out, Packets In Packets Out, Utilization, Last Session Duration, Avg Latency, 
Availability.

3. Click OK to apply your changes; or click Cancel to cancel your changes.
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Click on the VPN Monitor Table tab to view specific information about your VPN. From 
the VPN Monitor Table, you can view the following details about a specific VPN:

• key details describing the VPN (i.e., name, Policy ID, group and user 
associations, VPN type)

• Security Association (SA) information
• total number of data over the tunnel (i.e., bytes in/out, packets in/out, 

utilization)

The following table describes all of the information that is available from the VPN 
Monitor Table:

Item Displays...

Name the name of the VPN.

VPN Type Type of tunnel: Site-to-site or dial-up.

SA Id the Security Association (SA) identification for the VPN at both 
ends of the tunnel.

Policy Id--In/Out A unique identifier specified when the policy was configured. 

Status up/down status of the VPN tunnel.

SA Status whether or not the current SA has been established.

Time-SA Status Change time that the SA status last changed

Last SA Session Duration duration of last SA session

Group Group associated with the VPN.

User User associated with the VPN.

DN Name Distinguished Name (DN) of the VPN.

Avg. Latency A rolling average of latency, presented in milliseconds.

Availability Percentage of the time a tunnel is up over the last thirty samples.

Bytes In the number of incoming bytes handled by the protocol through 
the FW/VPN device.

Delta Bytes In Total numerical difference between the current bytes in value 
and the previous bytes in value.

Bytes Out the number of outgoing bytes handled by the protocol through 
the FW/VPN device.
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Click on the Active VPN tab to view specific information about your active VPNs. From 
the Active VPN, you can view the following details about your active VPNs:

• key details describing the VPN (i.e., name, Policy IP, local and peer gateway IDs 
and IP addresses)

• security established on the active VPN
• time-related statistics (i.e., lifetime, latency)

The following table describes all of the information that is available from the active VPN:

Delta Bytes Out Total numerical difference between the current bytes out value 
and the previous bytes out value.

Packets In the number of incoming packets handled by the protocol through 
the FW/VPN device.

Delta Packets In Total numerical difference between the current packets in value 
and the previous packets in value.

Packets Out the number of outgoing packets handled by the protocol through 
the FW/VPN device.

Delta Packets Out Total numerical difference between the current packets out value 
and the previous packets out value.

Util. (Absolute) Total number of the utilization of the current FW/VPN device.

Util. (Delta) Total numerical difference between the current utilization value 
and the previous utilization value.

Item Displays...

Name the name of the active VPN.

VPN Type Type of tunnel: Site-to-site or dial-up.

Policy Id--In/Out A unique identifier specified when the policy was configured. 

Status whether the tunnel for the active VPN is UP or Down.

Ave Latency A rolling average of latency, presented in milliseconds.

Last Latency latency for the last ping response.

Availability Percentage of the time a tunnel is available over the last thirty samples.

Local GW Id the local gateway Id for the active VPN.

Peer GW Id the peer gateway Id address for the active VPN.

Local GW IP the local gateway IP address for the active VPN.

Peer GW IP the peer gateway IP address for the active VPN.

Local Address the local IP address for the FW/VPN device associated to the active VPN.

Peer Address the peer IP address for the FW/VPN device connected to the active VPN.

Item Displays...
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You can also view traffic information as it is processed by a device on a specific interface:

• Viewing Ethernet Statistics
• Viewing Flow Statistics
• Viewing Attack Statistics

0��1������/�����������%���%
Click the Ethernet Statistics node to view traffic information as it is processed by a 
specific physical interface on a FW/VPN device. Depending upon the specific FW/VPN 
device, the following interfaces apply:

• Trust and Untrust interfaces available on all FW/VPN devices.
• DMZ interface available on NetScreen-25, NetScreen-50, NetScreen-100 and 

NetScreen-500 devices; the NetScreen-5XP device has no DMZ interface.
• HA interface and management interface available on NetScreen-100 and 

NetScreen-500 devices.

Ethernet Statistics apply only to FW/VPN devices, and not to virtual systems. 

Monitor whether a monitoring capability for the VPN is ON or OFF.

IPSec the IPSec (IP security) protocol for the active VPN; for example, AH 
(Authentication Header) or ESP (Encapsulating Security Payload).

SPI In the SPI (Security Parameter Index) key into the active VPN. This is an 
encryption method.

SPI Out the SPI (Security Parameter Index) key out of the active VPN. This is an 
encryption method.

Encryption Algorithm used when a user encrypts communication between the FW/VPN 
device and the server. Listed as either SDI or DES.

Authentication A second algorithm used when a user encrypted communication between the 
FW/VPN device and the server.

Key Type of key associated with the VPN: Auto IKE (Internet Key Exchange) or 
manual key.

Lifetime P1 Time listed in seconds before re-keying.

Lifetime P2 Time reported in remaining bytes before re-keying. Independent from Lifetime 
P1.

Life Size the predefined duration of the tunnel (in bytes).

P1 Status whether the P1 (phase 1) status for tunnel negotiation is enabled/disabled.

P2 Status whether the P2 (phase 2) status for tunnel negotiation is enabled/disabled.

P1 Auth Associated with Auto IKE. This column displays the P1 (phase 1) 
authentication for the active VPN.

Item Displays...
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A graph appears displaying FW/VPN device % utilization traffic on the interface. Right-
click within the chart to select a desired Interface (i.e., Ethernet or HA). The active 
interface is listed below the graph. The graph will also provide the total errors in a 
graphical form. You can view up to 12 samples in the chart.

The following table describes the information available from the Ethernet Statistics view:

Item Displays...

Interface the data for each interface.

Bytes In the number of bytes of incoming traffic processed through the FW/VPN 
device over the selected interface.

Delta Bytes In the total numerical difference between the current bytes in value and the 
previous bytes in value.

Bytes Out the number of outgoing bytes handled by the interface through the FW/VPN 
device.

Delta Bytes Out the total numerical difference between the current bytes out value and the 
previous bytes out value.

Packets In the number of incoming packets handled by the interface through the FW/
VPN device.

Delta Packets In the total numerical difference between the current packets in value and the 
previous packets in value.
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Click on the Flow Statistics node to view data for various flow counters on a specific FW/
VPN device or virtual interface. For each FW/VPN device, the data and statistics are 
separated by all available interfaces.

You can change the interface setting by right-clicking in the chart and selecting the 
interface that you want.

Packets Out the number of outgoing packets handled by the interface through the FW/
VPN device.

Delta Packets Out the total numerical difference between the current packets out value and the 
previous packets out value.

Broadcast the number of broadcast-type packets processed through the FW/VPN 
device over the selected interface.

CRC Errors the number of packets generating a cyclic redundancy code error processed 
through the FW/VPN device over the selected interface.

Alignment Errors the number of Frame Checksum (FCS) errors.

ShortFrame the number of frames that are not of the correct length.

RXCollision the number of times that two packets collide, resulting in damage to both. 
This indicates that the network is overloaded.

Speed (Mbps) This is useful in calculating the speed of the interface.

Status whether the FW/VPN device is currently Up or Down.

Direction whether the FW/VPN device is in half or full duplex mode.

Zone the name of the zone associated with the interface.

Item Displays...



Chapter 10 Monitoring

506 Administrator’s Guide

The following table describes all of the information that is available from the Flow 
Statistics view:

Item Displays...

Interface the name of the virtual interface.

Bytes In the number of bytes of incoming traffic processed through the FW/VPN 
device over the selected interface.

Bytes Out the number of bytes of outgoing traffic processed through the FW/VPN 
device over the selected interface.

Packets In the number of incoming packets processed through the FW/VPN device over 
the selected interface.

Packets Out the number of outgoing packets processed through the FW/VPN device over 
the selected interface.

VLAN In the number of VLAN packets received through the NetScreen FW/VPN 
device; applies to virtual systems.

VLAN Out the number of VLAN packets sent through the NetScreen FW/VPN device; 
applies to virtual systems.

Connections the number of connections that occurred for a given interface.

Packets Dropped the number of incoming packets dropped by a given interface.
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Click on the Attack Statistics node to view distribution of the attacks that have occurred 
on a specific FW/VPN device. 

The report separates the data and statistics for all available interfaces.

The following table describes each of the attack counters available from the Attack 
Statistics view:

Packets Denied the number of incoming packets denied on the virtual interface by the policy.

Authentication 
Failed

the number of packets dropped because of an authentication failure.

URL Blocking 
Dropped 

the number of packets dropped because of URL blocking.

IPSec Dropped the number of IPSec packets dropped.

Zone the name of the zone associated with the interface.

Item Displays...

Interface Name of the interface.

Item Displays...
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SYN Attack SYN packets overwhelm a network by initiating so many connection attempts 
or information requests that the network can no longer process legitimate 
connection requests, resulting in a Denial of Service.

Tear Drop When the first and second parts of a fragmented packet overlap, the server 
attempting to reassemble the packet can crash. If the FW/VPN device sees this 
discrepancy in a fragmented packet, it drops the packet.

Source Route This option applies in an IP header and allows an attacker to enter a network 
with a false IP address and have data sent back to the attacker’s real address.

Ping of Death Intentionally oversized or irregular ICMP packets can trigger a Denial of 
Service condition, freezing, or other adverse system reactions. You can 
configure a FW/VPN device to detect and reject oversized or irregular packet 
sizes.

Address 
Spoofing

You can enable a FW/VPN device to guard against spoofing attacks by 
checking its own route table. If the IP address is not in the route table, traffic 
through the FW/VPN device is not allowed.

Land Attack Combining a SYN attack with IP spoofing, a Land attack occurs when an 
attacker sends spoofed SYN packets containing the IP address of the victim as 
both the destination and source IP address. This creates an empty connection. 
Flooding a system with such empty connections can overwhelm the system, 
causing a Denial of Service. FW/VPN devices automatically block any attempt 
of this nature and records such attempts as a Land attack.

ICMP Flood ICMP pings can be so numerous that they overload a system with so many 
echo requests that the system expends all its resources responding until it can 
no longer process valid network traffic. If you set a threshold to invoke ICMP 
flood attack protection when exceeded, ICMP flood attacks are recorded as 
statistics.

UDP Flood Similar to the ICMP flood, UDP flooding occurs when UDP packets are sent 
with the purpose of slowing down the system to the point that it can no longer 
handle valid connections. After enabling the UDP flood protection feature, you 
can set a threshold that once exceeded invokes the UDP flood attack 
protection feature. (The default threshold value is 1000 packets per second.) If 
the threshold is exceeded, the FW/VPN device ignores further UDP packets for 
the remainder of that second.

WinNuke WinNuke can cause any computer on the Internet running Windows to crash. 
WinNuke introduces a NetBIOS anomaly that forces Windows to restart. FW/
VPN devices can scan any incoming Microsoft NetBIOS Session Service 
packets, modify them, and record the event as a WinNuke attack.

Port Scan Port scan attacks occur when packets are sent with different port numbers with 
the purpose of scanning the available services in hopes that one port will 
respond. The FW/VPN device internally logs the number of different ports 
scanned from one remote source. If a remote host scans 10 ports in 0.3 
seconds, NetScreen flags this as a port scan attack, and rejects further packets 
from the remote source.

Item Displays...
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IP Sweep This is the same as an address sweep attack, and similar to a port scan attack. 
It occurs when an attacker sends ICMP echo requests (or pings) to different 
destination addresses hoping that one will reply, thus uncovering an address to 
a target. If a remote host pings 10 addresses in 0.3 seconds, the FW/VPN 
device flags this as an address sweep attack and drops the connection.

Block Java/ActX Malicious Java or ActiveX components can be hidden in Web pages. When 
downloaded, these applets install a Trojan horse on your computer. Similarly, 
Trojan horses can be hidden in compressed files such as .zip, .gzip, and .tar, 
and executable (.exe) files.

SYN Frag A SYN fragment attack floods the target host with SYN packet fragments. The 
host catches the fragments, waiting for the remaining packets to arrive so it can 
reassemble them. By flooding a server or host with connections that cannot be 
completed, the host’s memory buffer eventually fills. No further connections are 
possible, and damage to the host’s operating system can occur. The FW/VPN 
device drops ICMP packets when the protocol field indicates ICMP packets, 
and the fragment flag is set to 1 or an offset is indicated.

TCP no Flag TCP packet that does not have any bits set in the flags.

Unknown Prot The FW/VPN device drops packets where the protocol field is set to 101 or 
greater. These protocol types are reserved and undefined at this time.

Bad IP Opt Triggered when the list of IP options in the IP datagram header is incomplete or 
malformed.

IP Rec Route The FW/VPN device blocks packets where the IP option is 7 (Record Route). 
This option is used to record the route of a packet. A recorded route is 
composed of a series of internet addresses, which an outsider can analyze to 
learn details about your network’s addressing scheme and topology.

IP Timestamp The FW/VPN device blocks packets where the IP option list includes option 4 
(Internet Timestamp).

IP Security This option provides a way for hosts to send security, compartmentation, TCC 
(closed user group) parameters, and Handling Restriction Codes compatible 
with DOD requirements.

IP Loose Src The FW/VPN device blocks packets where the IP option is 3 (Loose Source 
Routing). This option provides a means for the source of a packet to supply 
routing information to be used by the gateways in forwarding the packet to the 
destination. This option is a loose source route because the gateway or host IP 
is allowed to use any route of any number of other intermediate gateways to 
reach the next address in the route.

IP Strict Src The FW/VPN device blocks packets where the IP option is 9 (Strict Source 
Routing). This option provides a means for the source of a packet to supply 
routing information to be used by the gateways in forwarding the packet to the 
destination. This option is a strict source route because the gateway or host IP 
must send the datagram directly to the next address in the source route, and 
only through the directly connected network indicated in the next address to 
reach the next gateway or host specified in the route.

Item Displays...
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IP Stream The FW/VPN device blocks packets where the IP option is 8 (Stream ID). This 
option provides a way for the 16-bit SATNET stream identifier to be carried 
through networks that do not support the stream concept.

ICMP Frag When the protocol field indicates ICMP packets, and the fragment flag is set to 
1 or an offset is indicated.

Large ICMP An ICMP packet with a length greater than 1024.

SYN n FIN Both the SYN and FIN flags are not normally set in the same packet. However, 
an attacker can send a packet with both flags set to see what kind of system 
reply is returned and thereby determine what kind of system is on the receiving 
end. The attacker can then use any known system vulnerabilities for further 
attacks. Enable this option to have the FW/VPN device drop packets that have 
both the SYN and FIN bits set in the flags field.

FIN no ACK TCP packet with a FIN set but no ACK set in the flags field.

Mal URL When you enable Malicious URL Detection, the FW/VPN device monitors each 
HTTP packet and detects any URL that matches any of several user-defined 
patterns. The FW/VPN device automatically drops any such packet.

Limit Session FW/VPN devices can limit the number of sessions that can be established by a 
single IP address. For example, session resources on a Web server can be 
exhausted if there are many requests from the same client. This option defines 
the maximum number of sessions the FW/VPN device can establish per 
second for a single IP address. (The default threshold is 128 sessions per 
second per IP address.)

Block Frag As packets traverse different networks, it is sometimes necessary to break a 
packet into smaller pieces (fragments) based upon the network’s maximum 
transmission unit (MTU). IP fragments may carry an attacker’s attempt to 
exploit the vulnerabilities in the packet reassembly code of specific IP stack 
implementations. When the target system receives these packets, the results 
range from not processing the packets correctly to crashing the entire system. 
When you enable the FW/VPN device to deny IP fragments on a security zone, 
the FW/VPN device blocks all IP packet fragments that it receives at interfaces 
bound to that zone.

Zone the name of the zone associated with the attack.

Item Displays...
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You can also view traffic information as it is processed by a FW/VPN device over specific 
zones. You can view ethernet statistics, flow statistics and attack statistics in the same 
manner that you viewed them in the Interface reports according to zone.

0��1������%��#������%���%
You can also view system-related information for a FW/VPN device.

0��1������%�����������%���%
Click on the Resource Statistics node to view the resources for a FW/VPN device. The 
following table describes all of the information that is available from the Resource 
Statistics view:

Item Displays...

Avg. CPU Utilization the average CPU usage of the FW/VPN device.

Memory Allocated the current memory allocation to FW/VPN device.

Memory Left the remaining usable memory.

No. of Fragment Blocks a percentage of blocks that are fragmented.

Active Sessions the number of currently active sessions.
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Click on the Active Statistics node to view administrator and user activities for a FW/
VPN device. The Administrators tab displays information about the administrators 
including, when, where and how they logged in to the system.

The following table describes all of the information that is available from the 
Administrators view:

Allocated Sessions the number of allocated sessions.

Max. Sessions Allowed the maximum sessions allowed.

Failed Sessions the number of sessions that failed to allocate (after maximum 
reached).

Item Displays...

Administrator ID the administrator’s logon ID.

IP Address the administrator’s IP address.

Service Used the type of service, for example, Console, Web, or Telnet to login.

Time the time that the administrator logged on.

Item Displays...
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The following table describes all of information that is available from the Authenticated 
Users view:

You can also access VPN information from the Active VPN view, and Active Session 
information from the Active Sessions view.

0��1��������(����%%���%
You can view a snapshot of ongoing active sessions on the FW/VPN device. You can view 
active sessions from the Active Statistics view.

When you click on the Active Sessions tab, a short form view of the active sessions 
appears enabling you to monitor basic information (i.e., source IP, destination IP, 
translated IP (if applicable), source port, destination port, translated port (if applicable), 
policy ID, time the session starts, and protocol type) about the active sessions on the FW/
VPN device by default. You can also view extended information about the session (i.e., 
session id, icmp type (if applicable), total incoming bytes, total outgoing bytes, total 
packets count, how long the session has been active).

Item Displays...

User ID User log in ID.

Source IP Address Source IP address.

Time Time that the user logged on.
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The following table describes all of the information that is available from the Active 
Sessions view:

%�����/����%%����3�$���
You can control the information that is provided in the Active Sessions view by 
configuring a session filter. Using the Session Filter, you can to fetch specific sessions on a 
FW/VPN device that match specific criteria that you set. Like the Monitor Filter for the 
Event Summary View, there is only one Session Filter and it defines the overall data set 
that you can view from the Active Sessions view. After you have configured and applied 
the Session Filter, you can then configure additional session display filters to view more 
specific session information.

)��+���������/����%%����3�$���
To configure the session filter:

1. Use the Options menu, and select Session Filter. The Session Filter Dialog 
will appear.

2. Click in the Long Form checkbox to display additional information about the 
Active Session.

3. Click in the Maximum number of sessions to retrieve checkbox and enter 
the total number of sessions you want the Session Filter to retrieve.

Item Displays...

Session ID A unique identifier specified with the active session.

Source IP IP address of the sending node of the connection.

Source Port Port number of the sending node of the connection.

Destination IP IP address of the receiving node of the connection.

Destination Port Port number of the receiving node of the connection.

Translated IP Translated IP address.

Translated Port Translated port number.

Duration (sec) Length in seconds of the connection session.

Policy ID A unique identifier specified when the policy was configured. None means no 
name was specified during policy configuration.

Protocol ID A unique identifier specified when the protocol was configured. 

ICMP Type the type of ICMP protocol.

Bytes In the total number of bytes sent in.

Bytes Out the total number of bytes sent out.

Total Packets the total number of packets sent.

Duration the length in seconds of the connection session.

Start Time the time that the session started.
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4. Specify criteria for the sessions that you would like to view. You can specify an 
active session according to the following:

– Source, Destination, and Translated IP (IP Address, Net Mask, and Port 
Range)

– Session Duration
– Session Start Date and Time
– Policy ID
– Session Type
– Protocol ID
– Policy with Logging

5. Click More to view additional criteria.
6. Click Reset to Default to reset all criteria back to their default settings.
7. Click OK when you are done.
8. Click Refresh to apply the criteria to the active session table view.
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You can apply a session display filter to view only specific active sessions.

1. Use the Options menu, and select Session Display Filter. The Session Filter 
Dialog will appear.

2. From the Source tab, you can specify the sessions that you want to view 
according to the Source IP Address and Port number, or Port Range.

3. Click in the Destination tab to specify the sessions that you want to view 
according to Destination IP Address and Port number, or Port Range.

4. Click in the Translated tab to specify the sessions that you want to view 
according to Translated IP Address and Port number, or Port Range.

5. Click in the Protocol tab specify the sessions that you want to view according to 
protocol.

6. Click in the Other tab specify the sessions that you want to view according to 
Session Duration, Session Start Time or Policy ID.

7. Click OK when you are done.
8. Click Refresh to apply the Session Display criteria to the active session table 

view.
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You can also communicate using Telnet or a Secure Command Shell to query on the 
status of a FW/VPN device. You can use this capability to issue a “get” Telnet command to 
a FW/VPN device or a NetScreen CLI command to the SCS (Secure Command Shell) on 
the FW/VPN device to troubleshoot problems.

Note: Commands from NetScreen-Security Manager originate from the UI client to the 
FW/VPN device. If you intend to issue get commands from NetScreen-Security Manager, 
you must plan and implement Security Policy rules in your network accordingly
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If you have configured FW/VPN devices to be highly available, you can view NSRP-related 
statistics on the device by accessing the HA Statistics view. The following table describes 
all of the information that is available from the HA Statistics view:

Item Displays...

VSD Group ID the group ID that is associated with the VSD (or RTO).

Number of Units the number of units associated with the VSD (or RTO).

State Change Counter the number of times a FW/VPN device changes operational states.

Init Counter the transient state of a VSD (or RTO) group member while it was in the 
process of joining the VSD (or RTO) group.

Master the number of Master FW/VPN devices.

Primary BackUp the number of primary backup FW/VPN devices.

BackUp the total number of backup FW/VPN devices.

Ineligible Notes that an administrator purposefully assigned a FW/VPN device so 
that it cannot participate in the selecting a new master FW/VPN device.

InOperable Notes that a VSD (or RTO) group FW/VPN device has an internal 
problem.

Master Conflict the number of conflicts that occurred on the master FW/VPN device.

Primary Backup Conflict the number of conflicts that occurred on the primary backups FW/VPN 
device.

Tx Heartbeat the number of transmitted heartbeats on the FW/VPN devices.

Rx Heartbeat the number of received heartbeats on the FW/VPN devices.
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If you have implemented a virtual private network or VPN, you can use the VPN Monitor 
to get an at-a-glance status of the up/down status of every VPN tunnel as well as other 
statistics relevant to your VPN.
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The VPN Monitor lists a summary of all the VPN tunnels that have been implemented in 
your system. It includes visual indicators that depict whether an existing VPN tunnel is 
either Up, Down, or Not Monitored. The Summary also includes information describing 
the VPN name, VPN type, Source, Destination, Security Parameter Index., IP Address, 
and Protocol.

Note: You must enable the “VPN Monitor” option on the tunnel when configuring the 
tunnel for the device.

Column Description

VPN Name of the active VPN.

VPN Type Type of tunnel: Dialup or Site to Site.

From Hostname (IP)(Vsys) Source FW/VPN devices used in the VPN. For example, a root 
FW/VPN device named NS5000 with an IP address of 1.1.1.1 
appears as NS5000(1.1.1.1). For a Vsys 1, 
“NS5000(1.1.1.1)(1)” appears.

To Hostname(IP)(Vsys) Destination FW/VPN devices used in the VPN. For example, a 
root FW/VPN device named NS5000 with an IP address of 
1.1.1.1 appears as NS5000(1.1.1.1). For a Vsys 1, 
“NS5000(1.1.1.1)(1)” appears.

Status VPN Status: Up or Down
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You can control the information that is provided in the VPN Monitor by configuring a 
VPN display filter. Use the Options menu and select Display Filter to configure a VPN 
display filter. The VPN Display filter provides several options enabling you to view VPN 
information related to the type, status, or the specific FW/VPN device or virtual system 
associated with the VPN tunnel that you want to view. Click on the Refresh button to 
apply the Session Display criteria to the active session table view.
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To view the details on the active VPN, click to select the VPN, use the View menu and 
select Active VPN Details (alternatively, you can also right-click on the VPN tunnel and 
select Active VPN Details).

Refer to “Viewing Active VPN Information” on page 502 for more information on the 
Active VPN Details table.
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Right-click on the VPN tunnel and select Monitor Data, and then the FW/VPN device to 
view FW/VPN device-specific information about your VPN. A Monitor info window 
appears where you can access the VPN Monitor table, Active VPN table, and a chart 
enabling you to view the distribution of VPN tunnels on the FW/VPN device.

SPI (in/out) Security Parameter Index (SPI) key into and out of the active 
VPN. This is the encryption method.

IP (Local-Peer) Peer gateway IP address for the active VPN.

Protocol Protocol used for the active VPN

Peer GW id Peer gateway ID for the active VPN.
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If you have implemented NetScreen Redundancy Protocol (NSRP) for the purpose of 
deploying clusters for redundancy, you can use the NSRP Monitor to get an at-a-glance 
status of your NetScreen systems that are in “clusters.” These systems include both the 
NetScreen-500 and the NetScreen-1000. To launch the NSRP Monitor, click the NSRP 
Monitor node.
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Double-click on an NSRP device to view a summary of the top-level information on the 
selected cluster. From the NSRP Summary, you can view the following details about a 
specific cluster:

• key details describing the cluster (i.e., name, # of VSDs, # of RTOs)
• security details
• the total number and type of events

The following table describes all of the information that is available from the NSRP 
summary:

Item Displays...

Cluster name of this cluster.

No of VSD’s the total number of Virtual Security Devices (VSD) that are attached 
to this cluster.
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Double-click on the cluster FW/VPN device icon or click on the + icon that corresponds to 
the cluster FW/VPN device icon to view the virtual security devices (VSD) and run-time 
objects (RTO) that have been attached to this cluster.

Click on the VSD or RTO icon and summary information describing the object appears. 
The following table describes the information available from the VSD/RTO summary:

No of RTO’s the total number of Run Time Objects (RTO) that are attached to this 
cluster.

Encryption whether or not encryption has been enabled/disabled.

Authentication whether or not authentication has been enabled/disabled.

No. of Gratuitous arps the number of gratuitous arps.

Critical Events the total number of Critical events that occurred.

Major Events the total number of Major events that occurred.

Minor Events the total number of Minor events that occurred.

Warning Events the total number of Warning events that occurred.

Intermediate Events the total number of Intermediate events that occurred.

Clear Events the total number of Clear events that occurred.

Item Displays...

Cluster the name of the cluster associated with this VSD.

VSD(RTO) the name of this VSD (or RTO).

No of Devices the total number of FW/VPN devices that are associated with 
this VSD.

Init Hold Time (sec) the initial hold time state (in seconds) of the VSD.

Heartbeat Interval (ms) the time interval (in milliseconds) between each heartbeat.

Heartbeat Lost Threshold (ms) threshold level required to change over to the backup FW/
VPN device.

Master the Master NetScreen System.

Primary Backup the primary NetScreen System.

Item Displays...
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Click the Counters tab to view specific information about your VSD counters. The 
following table describes the information that is available from the VSD counters view:
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Click the Counters tab to view specific information about your RTO counters. The 
following table describes the information that is available from the RTO counters view:

Item Displays...

Device the device(s) that are associated with the VSD (or RTO).

Number of Units the number of units associated with the VSD (or RTO).

State Change Counter the number of times a device changes operational states.

Init Counter the transient state of a VSD (or RTO) group member while it was 
in the process of joining the VSD (or RTO) group.

Master the number of Master devices.

Primary BackUp the number of primary backup devices.

BackUp the total number of backup devices.

Ineligible Notes that an administrator purposefully assigned a device so that 
it cannot participate in the selecting a new master device.

InOperable Notes that a VSD (or RTO) group device has an internal problem.

Master Conflict the number of conflicts that occurred on the master device.

Primary Backup Conflict the number of conflicts that occurred on the primary backups 
device.

Tx Heartbeat the number of transmitted heartbeats on the devices.

Rx Heartbeat the number of received heartbeats on the devices.

Item Displays...

Device the device(s) that are associated with the RTO.

Member ID the member identification associated with this RTO

Status the current status of the RTO: Active or Down.

Direction the direction of the RTO: In or Out.

Lost Heartbeat the number of heartbeats not received from the RTOs peers.

Counter to Active the number of times that the RTO was placed to “active”

Counter to Set the number of times that the RTO was placed to “set”

Counter to Lost Peer the number of times that the RTO was placed to Lost Peer.

Counter to Group Detach the number of times that the RTO was placed to Group Detach.
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The following examples describe typical use cases for monitoring your FW/VPN devices, 
VPNs, and NSRP clusters in NetScreen-Security Manager.
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In this example, you are a network administrator responsible for monitoring the day-to-
day operation of all the FW/VPN devices managed in your network. You are using 
NetScreen-Security Manager to manage your network, and Realtime Monitor to monitor 
the up/down connection status of all your FW/VPN devices.

One day, you notice that the Connection Status on a mission-critical FW/VPN device 
indicates that the FW/VPN device is DOWN. You wait several minutes to verify that the 
connection status doesn’t resolve itself as intermittent network problems may cause a 
FW/VPN device to temporarily indicate as DOWN. The Device Monitor still indicates that 
the FW/VPN device is DOWN.

You next try to ping the FW/VPN device. If you are successful in reaching the device, you 
can send a get status command to check the status of the FW/VPN device.

If you cannot ping the FW/VPN device, you will want to investigate further what may be a 
potential problem with the FW/VPN device or your network. You next scan the Log 
Viewer for the log entry indicating that the FW/VPN device has disconnected. You can 
filter the log entries in the Log Viewer to display only the log entries generated for the 
FW/VPN device during the immediate time period that it went down. Viewing these log 
entries will also provide you with a context around the events leading to the FW/VPN 
device disconnecting. This will help you to determine the cause of the problem.

You notice several very suspicious log entries that indicate that this FW/VPN device may 
have been the target of an attack. You flag the log entries using the pre-defined flag types 
in the Log Viewer, and assign them to your security experts for further investigation.
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• About Logging

• Configuring Logging

• Using the Log Viewer

• Using the Log Investigator

• Using the Audit Log Viewer

• Managing Log Volume

Juniper Networks NetScreen-Security Manager integrates log information from multiple 
devices into a seamless environment to help you easily access and distill data about the 
traffic on your network.

The Log Viewer presents log data as a log entry in a table; a log entry contains the details 
of the traffic that triggered the log, such as IP address, port number, etc. This log data is 
also automatically used to generate predefined Reports, helping you interpret event 
information in a specific context. Or, to perform your own investigation, use the Log 
Investigator to view cross-tabulations between sources, destinations, subcategories, and 
destination ports.

The Audit Log Viewer presents log entries triggered by administrative changes (changes 
made to the NetScreen-Security Manager system). An audit log entry includes details 
about the administrative event, such as the administrator name, timestamp of the 
change, and job details.
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Logging is the act of recording information about an event. In NetScreen-Security 
Manager, each event that occurs on your network or in your management system can be 
recorded and stored as a log entry. To view log entries from the Juniper Networks 
NetScreen-Security Manager UI, you can use one or more of the logging-related UI 
components, such as the Log Viewer, the Log Investigator, etc.

It may be helpful to visualize log entries being sent or pushed from the device to the 
Juniper Networks NetScreen-Security Manager Device Server, which then pushes the log 
entries to the logging database. A UI module (the Log Viewer, Report Manager, etc.) 
requests or pulls the log entries in the logging database and displays the entries in the UI.
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A managed device generates a log entry when an event matches the configured logging 
conditions. The log entry, which contains details of the event, is sent to the NetScreen-
Security Manager Device Server and stored in the logging database. You can view log 
entries in the NetScreen-Security Manager UI. 

In a single log entry, you can view detailed information about where traffic comes from 
(the source address), where traffic goes (the destination address) and a description of the 
event that triggered the log entry. You can also view summarized information about 
events and alarms for multiple log entries. This data can help you analyze log entries and 
determine the effectiveness of your current Security Policies and device configurations.
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Managed devices generate log entries based on events. Typically, devices generate log 
entries when:

• An event matches a rule in which logging is enabled. When you configure a rule 
for logging, the device creates a log entries for each event that matches that rule.

• An event matches a predefined set of conditions configured on a managed device 
or the management system.

Some events generate log entries that appear in the Log Viewer, while others appear in 
RealTime Monitor. The following table details event-generated log entries:

Events Description Destination

Attack, Alarm, 
Other

Generates log entries for events related to network 
activity on the device that violates a set threshold. 

Log Viewer

VPN Events Generates log entries for events related to VPN 
tunnels. These log entries are used to produce 
statistical information for monitoring purposes.

Realtime Monitor > 
VPN Monitor

Configuration, 
Information, Self, 
Policy, Traffic

Generates log entries for events related to device 
configuration, NetScreen-Security Manager 
configuration, Security Policy rules, and traffic activity 
on the managed device.

Log Viewer
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A log entry has an associated log category that is based on the type of information 
contained in the log entry. NetScreen-Security Manager uses the following log entry 
categories:
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The log severity level defines the urgency of the information contained in the log entry. 
The severity level of a log entry depends on the log category, such as information, traffic, 
or configuration log entries.

Flow, Ethernet, 
Attack, Policy

Generates log entries for events related to packet flow, 
ethernet objects, network attacks, and Security Policy 
rules. These log entries are used to produce statistical 
information for monitoring purposes. 

Realtime Monitor > 
Device Monitor

Protocol 
Distribution

Generates log entries for events related to protocols 
used in network activity. These log entries are used to 
produce statistical information for monitoring purposes.

Realtime Monitor > 
Device Monitor

Log Type Generated When Configured In

Alarm Traffic matches a rule with an 
alarm threshold.

Device Configuration > Report Settings > NSM
Security Policies > Rule Options > Log/Count

Anomaly Traffic matches a protocol 
anomaly attack group.

Security Policies > Rule Options > Attack Protection

Config A configuration or operational 
state changed in NetScreen-
Security Manager.

Device Configuration > Report Settings > NSM

Custom Traffic matches a Custom 
Signature Attack Object.

Security Policies > Rule Options > Attack Protection

Info Details general system 
information.

Device Configuration > Report Settings > NSM

Self A non traffic-related event 
occurs.

Device Configuration > Report Settings > General

Signature Traffic matches a Signature 
Attack Object pattern. 

Device Configuration > Report Settings > NSM
Security Policies > Rule Options > Attack Protection

Traffic A traffic-based event occurs. Device Configuration > Report Settings > NSM
Security Policies > Rule Options > Log/Count

Screen Traffic matches a Screen-level 
attack.

Device Configuration > Network > Zone



Chapter 11 Logging

526 Administrator’s Guide

You can configure a managed device to generate log entries only for those events that 
meet a specific severity level criteria. Additionally, you can configure the device to 
forward log entries that contain a specific severity to a specific destination, such as a 
console location or syslog server. Multiple log entries with different severity levels can be 
forwarded to the same log destination.

Juniper Networks assigns a predefined severity level in the firmware of each Juniper 
Networks NetScreen FW/VPN device. However, these severity levels are not the same as 
the severity levels that appear in the log entries viewed in a NetScreen-Security Manager 
UI module. The following table details how NetScreen-Security Manager handles Juniper 
Networks NetScreen ScreenOS severity levels:.
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NetScreen-Security Manager can process the following log capacities:

Each NetScreen FW/VPN device has an associated Expected Log Rates (ELRs). However, 
because the Security Policy installed on a managed device determines the amount of log 
entries generated by that device, devices with different Security Policies produce different 
log entry amounts. The most reliable figure is the Receivable Rate Per Second figure, as 
detailed below:

NSM Severity ScreenOS Severity Description

Critical Emergency The most urgent level of severity.

Alert The second most urgent level of severity.

Major Critical A noteworthy level of severity.

Minor Error A severity level that indicates an error occurred.

Warning Warning A severity level that indicates no error or violation, 
but is a cautioning that questionable activity may 
have occurred.

Info Notification The least urgent severity level.

Information A non-severity text message describing an event.

Not Set Other No severity is set.

Metric Maximum Value for Any Device

Overall Memory Capacity Per Day 256 GB of log entries per day (appr.)

Overall Log Entry Capacity Per Day 2 billion log entries per day (appr.)

Receivable Rate Per Second (Device Server) 20,000 log entries per second

Receivable Rate Per Day 1.7 billion log entries per day 

Device Max. Number of Logs

NetScreen-5XP 1024

NetScreen-5XT 1024
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NetScreen-Security Manager logging tools provide a high-level view of the activity on 
your network, enabling you to view summaries as well as detailed information. You can 
choose to view log entries for event that occur across domains (you must have the 
requisite permissions), as well as for specific device groups, clusters, firewalls, etc.

Because you collect log entries from multiple devices, log analyzing, log volume, and log 
management are important concerns. To control the amount of log data displayed 
onscreen, use tools such as filters, flags, and custom views to help identify patterns, even 
isolate log entries from devices that appear to be the source of problems. For further 
investigation, use the Log Investigator tools to cross-tabulate source, destination, attacks, 
etc. Based on your analysis, you can then edit the rules in your Security Policies to modify 
how NetScreen-Security Manager handles your log entries.

NetScreen-Security Manager includes three primary logging modules, as detailed below:

• Log Viewer presents complete, summarized, or detailed log entry information 
in a table format. You can view an individual log entry to analyze the raw log 
data, or use filters to view subset of log entries. You can also use column settings 
and flags to control how the UI presents log information. The Log Viewer 
displays each log entry as it enters the database in real-time, displaying its 
fields in the Log Viewer. For details, see “Using the Log Viewer” on page 542. 

NetScreen-5GT 1024

NetScreen-5GT ADSL 1024

NetScreen-HSC 1024

NetScreen-25 1024

NetScreen-50 1024

NetScreen-100 14,336

NetScreen-204 14,336

NetScreen-208 14,336

NetScreen-500 14,336

NetScreen-ISG 14,336

NetScreen-5200 24,576

NetScreen-5400 24,576

Note: The Receivable Rate Per Second capacity estimates indicate the maximum 
number of log entries that can be stored on a device per second. Actual throughput 
depends on available bandwidth and other run-time parameters, and is not 
guaranteed to meet the maximum estimate.
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• Log Investigator enables you to correlate log data. The Log Investigator is an 
exploratory data analysis tool that cross tabulates on two dimensions. Log 
entries are linked to the Log Viewer, helping you perform an interactive 
analysis. For details, see “Using the Log Investigator” on page 562. 

• Audit Log Viewer tracks administrative changes made to a managed device by 
a NetScreen-Security Manager administrator. Log entries details include the 
admin that performed the change, what time the change occurred, and the job 
results. For details, see “Using the Audit Log Viewer” on page 574. 
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Before your managed device can generate log entries or log data, you must configure your 
devices and the NetScreen-Security Manager system for logging. You can configure the 
following types of logging:

• Configuring the Device for Logging. Configure an individual device to generate 
attack, alarm, configuration, information, and self log entries for specific 
destinations. 

• Configuring the GUI Server for Logging. Set criteria and configure the 
management system to forward logs to specific destinations and/or formats 
(syslog, csv, xml, email) for all managed devices in the GUI Server settings.

To view log entries and log data in the NetScreen-Security Manager UI, you must 
configure the individual device to generate log information for NSM and enable one or 
more severity settings for NSM. However, you are not required to configure the settings 
for other destinations if you do not use those destinations for log management.

If you do choose to export log information to another destination, you can configure the 
settings at the device level or at the management system level using the GUI Server, as 
show in the table below:

When both the device and GUI Server support exporting to a common 
destination, such as SNMP, you do not need to configure both the device and the 
GUI Server. Because exporting from the GUI server requires only one connection to the 
destination (instead of each device making a connection), using the GUI Server to handle 
log export can increase the performance. If desired, you can also configure different 
settings for the device and GUI Server when exporting to a common destination.
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At the device level, you can configure how and where the device sends its log entries. For 
each destination, you can define: 

• The category of log entries you want the device to generate and forward to a 
specific destination, and

• The severity of log entries you want the device to forward to a specific 
destination

Log Entry Destination/Format Export from Device Export from GUI Server

NSM Yes (required) No

Syslog server Yes Yes

SNMP server Yes Yes

SMTP server (email) Yes Yes

WebTrends Yes No

XML file Yes

CSV file Yes
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The severity setting applies to all log types for that destination. For example, if traffic log 
entries are enabled for NSM, but the severity setting for NSM specifies critical and major 
severities, NSM receives only critical and major traffic logs; all other severity traffic log 
entries are generated, but never sent to NSM. Unsent traffic log entries are stored on the 
device and discarded when the device log storage capacity is exceeded.
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Use the General settings to select the severity levels of the log entries you want to forward 
to a specific location. Juniper Networks assigns a predefined severity level for each event 
that generates a log entry on a NetScreen FW/VPN device; using NetScreen-Security 
Manager, you can configure a device to send log entries with specific severity levels to 
specific destinations.

For each destination (except Firewall Options), you can specify one or more of the 
following severity levels:

Not all destinations support all log entry severities. The following table details the log 
entry severities accepted by each destination (except Firewall Options, described on page 
531): 

NSM Severity ScreenOS Severity Description

Critical Emergency The most urgent level of severity.

Alert

Major Critical A noteworthy level of severity.

Minor Error A severity level that indicates an error occurred.

Warning Warning A severity level that indicates no error or violation, 
but is a cautioning that questionable activity may 
have occurred.

Info Notification A non-severity text message describing an event.

Information

Not Set Other The severity is not set.

Note: Debug messages are sent only to syslog, and do not appear in any NetScreen-
Security Manager UI module.

Destination Description Severities

Console The PC you use to view log entries in NetScreen-
Security Manager.

All severities

Email An Email server to which you want log information 
forwarded.

Emergency
Alert
Critical
Notification
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To select log entry severities for a destination, open a device configuration and select 
Report Settings > General, then select the destination. 
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Self log entries display information on traffic that was dropped by the NetScreen FW/VPN 
device or on traffic that terminates on the device. Any packet that terminates at the 
device generates a self log entry; Telnet, Ping, BGP, and OSPF connections all terminate 
at the device, and can trigger a self log entry. 

A self log includes the date and time a packet was dropped, the source address of the 
packet, the destination address of the packet, the duration for which the packet was 
active, and the service associated with the packet. You can disable or enable logging of 
dropped packets for specific traffic types, including ICMP, IKE, SNMP, and multicast 
packets.

To configure self log entries, open a device configuration and select Report Settings > 
General. Click the Firewall Options tab and configure the following settings:

SNMP A Simple Network Management Protocol destination. Emergency
Alert
Critical

Syslog The syslog facility on the Device Server. All severities

WebTrends A WebTrends server to which you want log entries 
forwarded.

All severities

NSM The NetScreen-Security Manager server. All severities

PCMCIA A PCMCIA device to which you want log entries 
forwarded.

All severities

Internal An destination within the current device to which you 
want log entries forwarded.

All severities

Setting Description

Log ICMP Packets to Self Creates a log entry for an ICMP (ping) packet that was dropped or 
terminated at the device.

Log IKE Packets to Self Creates a log entry for an IKE packet that was dropped or 
terminated at the device. When negotiating an IKE key, the VPN 
client communicates with the NetScreen FW/VPN device.

Log SNMP Packets to Self Creates a log entry for an SNMP packet that was dropped or 
terminated at the device.

Log Multicast Packets to Self Creates a log entry for a multicast packet that was dropped or 
terminated at the device.
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Use the Email option to configure a NetScreen FW/VPN device to send messages using 
email whenever a system event of Emergency, Alert, Critical, or Notification severity level 
occurs. You can configure the email and SMTP settings at the device level, or skip this 
section and configure the GUI server to handle emails; see “Exporting to Email” on page 
540. 

To configure email server settings and enable the device to send email messages, open a 
device configuration and select Report Settings > Email. Configure the following settings:
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Use the NSM reporting settings to configure the NetScreen FW/VPN device to report 
specific events to NetScreen-Security Manager.

Select the appropriate NetScreen-Security Manager Device Server, then select the events 
that are logged on the FW/VPN device and reported to NetScreen-Security Manager. The 
following sections detail each event.
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The device generates screen alarm log entries when a NetScreen FW/VPN device detects 
network traffic that matches the screen settings enabled on the device. 

To receive screen alarm log entries, you must:

• Enable the device to generate screen alarm log entries for NSM in Report 
Settings > NSM.

Setting Description

Enable Notification for Alarms When alarm is enabled for a rule in the installed Security 
Policy and traffic matches the rule, the device sends an email 
notification to the specified SMTP server.

Include Traffic Log When logging is enabled for a rule in the installed Security 
Policy and traffic matches the rule, the device sends the 
traffic log entry to the specified SMTP server.

SMTP Server Name The name of the Simple Mail Transfer Protocol server that 
receives email notification messages. You must specify the 
SMTP server name and at least one email address to receive 
email notification.

Email Address 1 The primary email address that receives email notification 
messages from the device.

Email Address 2 The secondary email address that also receives email 
notification from the device.

Note: For NetScreen FW/VPN devices running ScreenOS 4.0.x, you must also select 
Enable Logging.



Configuring Logging

NetScreen-Security Manager 2004 FP2 533

• Enable the device to send log entries with the desired severity settings to NSM 
in Report Settings > General > NSM.

• Enable screen attack protection on the device. For details, see “Configuring 
Screen Attack Protection” on page 143.

Screen alarm log entries appear in the Log Viewer and display the following columns of 
information in the Log Viewer:

• Source Address
• Destination Address
• Service
• Action
• Category (Screen)
• Subcategory (for details on Screen subcategories, see “Screen Alarm Log 

Entries” on page 612)
• Severity
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The device generates event alarms for any security event that has a predefined severity 
level of emergency, critical, or alert. Event alarms generate log entries that appear in the 
Alarm category.

To receive event alarm log entries, you must:

• Enable the device to generate event alarm log entries for NSM in Report 
Settings > NSM.

• Enable the device to send log entries with emergency, alert, and critical severity 
settings to NSM.

Event alarms appear in the Log Viewer under the Alarm category. For details on Attack 
subcategories, see “Alarm Log Entries” on page 614.
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The device generates traffic alarm log entries when your NetScreen FW/VPN device 
detects network traffic that exceeds the specified alarm threshold in a Security Policy 
rule. The traffic alarm log entry, which displays in the Log Viewer, describes the security 
event that triggered the alarm. Traffic alarms generate log entries that appear in the 
Alarm category.

To receive traffic alarm log entries, you must:

• Enable the device to generate traffic alarm log entries for NSM in Report 
Settings > NSM.

• Enable the device to send log entries with the desired severity settings to NSM.
• Enable counting and alarms in the Security Policy installed on the device. For 

details on configuring traffic alarm logging in your Security Policy rules, see 
“Configuring Counting & Alarms” on page 362.
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Traffic alarms appear in the Log Viewer under the Alarm category. For details on alarm 
subcategories, see “Alarm Log Entries” on page 614.

Alarm log entries contain information in the following Log Viewer columns:

• To Zone
• From Zone
• Source IP
• Destination IP
• Threshold (displayed in the Misc. column of the Log Viewer)
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The device generates Deep Inspection alarm log entries when a NetScreen FW/VPN 
device with Deep Inspection (DI) detects network traffic that matches an attack object 
specified in a Security Policy rule. When matched in a rule, protocol anomaly attack 
objects, signature attack objects, and custom attack objects all generate Deep Inspection 
alarm log entries that appear in the Log Viewer.

To receive Deep Inspection alarm log entries, you must:

• Enable the device to generate Deep Inspection alarm log entries for NSM in 
Report Settings > NSM.

• Enable the device to send log entries with the desired severity settings to NSM 
in Report Settings > General > NSM.

• Enable Deep Inspection detection in the Security Policy installed on the device. 
For details on configuring Deep Inspection logging in your Security Policy rules, 
see “Configuring Attack Protection” on page 365.

Deep Inspection alarm log entries appear in the Log Viewer and display the following 
columns of information in the Log Viewer:

• Source Address
• Destination Address
• Service
• Action
• Category (Anomaly, Custom, or Signature)
• Subcategory (for details on Deep Inspection alarm subcategories, see “Deep 

Inspection Alarm Log Entries” on page 616)
• Severity
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The device generates configuration log entries for events that change the configuration on 
the device. Specifically, any command issued that the ScreenOS get config command 
statement captures and displays in ScreenOS generates a configuration log. For each 
configuration change, the device generates a configuration log entry that contains 
information about the change in the Log Viewer Detail column. 

To receive configuration log entries, you must:
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• Enable the device to generate configuration log entries for NSM in Report 
Settings > NSM.

• Enable the device to send log entries with a notification severity setting to NSM 
in Report Settings > General > NSM.

Configuration log entries appear in the Log Viewer under the category Configuration. For 
details on configuration subcategories, see “Configuration Log Entries” on page 644.
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The device generates information logs when it detects that an administrator has made a 
change to the basic settings of the device, such as logging in/log out, setting a new 
password for the device, issuing a key value for the device, or entering an MD5 
authentication password to enter a device. For each administrative change, the device 
generates an information log entry that contains information about the change in the Log 
Viewer Detail column.

To receive information log entries, you must:

• Enable the device to generate information log entries for NSM in Report 
Settings > NSM.

• Enable the device to send log entries with the info, warning, and error severity 
settings to NSM in Report Settings > General > NSM.

Information log entries appear in the Log Viewer under the category Information. For 
details on information subcategories, see “Information Log Entries” on page 646.

��$+�8���������%
The device generates self log entries for any packet that terminates at the device. Self log 
entries display information on traffic that was dropped by the NetScreen FW/VPN device 
or on traffic that terminates on the device. 

To receive self log entries, you must:

• Enable the device to generate self log entries for NSM in Report Settings > NSM. 
• Enable the device to send specific self log entries to NSM in Report Settings > 

General > Firewall Options. For details, see “Forwarding Self Log Entries 
(Firewall Options)” on page 531.

Self log entries appear in the Log Viewer under the category Self, which contains 
information in the following Log Viewer columns:

• Source
• Destination
• Services

Self log entries have the category “Self” and the subcategory “Self Log”. 
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The device generates traffic log entries when your NetScreen FW/VPN device detects 
network traffic that matches the source, destination, and service specified in a Security 
Policy rule. 

To receive traffic log entries, you must:

• Enable the device to generate traffic log entries for NSM in Report Settings > 
NSM.

• Enable the device to send log entries with the desired severity settings to NSM.
• Enable logging in the Security Policy installed on the device. For details on 

configuring traffic logging in your Security Policy rules, see “Configuring 
Logging & Alerts” on page 361.

Traffic log entries appear in the Log Viewer under the Traffic category. For details on 
traffic subcategories, see “Traffic Log Entries” on page 649.
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The device forwards statistics on the policy distribution of the traffic that entered the 
device. Policy distribution statistics do not generate log entries; the information is used by 
the Realtime Monitor module. For details on how policy distribution appears in Realtime 
Monitor, see “Viewing Traffic Distribution by Policy” on page 496.
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The device forwards statistics for attacks detected in the traffic that entered the device. 
Attack statistics do not generate log entries; the statistics are used by the Realtime 
Monitor module. For details on how attack statistics appear in Realtime Monitor, see 
“Viewing Attack Statistics” on page 507.
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The device forwards statistics for ethernet activity on the device. Ethernet statistics do 
not generate log entries; the statistics are used by the Realtime Monitor module. For 
details on how ethernet statistics appear in Realtime Monitor, see “Viewing Ethernet 
Statistics” on page 503.

3$�1������%���%
The device forwards statistics for flows that entered the device. Flow statistics do not 
generate log entries; the statistics are used by the Realtime Monitor module. For details 
on how flow statistics appear in Realtime Monitor, see “Viewing Flow Statistics” on page 
505.
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The device forwards information on the protocol distribution of the traffic that entered the 
device. Protocol distribution information does not generate log entries; the information is 
used by the Realtime Monitor module. For details on how protocol distribution appears in 
Realtime Monitor, see “Viewing Traffic Distribution by Protocol” on page 498.

The device reports statistics generated by the following services:

• AH (Authentication Header)
• ESP (Encapsulating Security Payload)
• GRE (Generic Routing Encapsulation)
• ICMP (Internet Control Message Protocol)
• OSPF (Open Shortest Path First)
• TCP (Transmission Control Protocol)
• UDP (User Datagram Protocol)

You can also set the interval at which the NetScreen-Security Manager Device Server 
polls for policy statistics and protocol distribution events.
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Use SNMP settings to configure the Simple Network Management Protocol (SNMP) agent 
for the NetScreen FW/VPN device. The SNMP agent provides a view of statistical data 
about the network and the devices on it, and notification of system events of interest. You 
can configure the SNMP settings at the device level, or skip this section and configure the 
GUI server to handle SNMP reporting; see “Exporting to SNMP” on page 540.

In addition to configuring the SNMP reporting settings, you also must enable SNMP 
management service options on the interface through which the SNMP manager 
application communicates with the SNMP agent in the NetScreen FW/VPN device. For 
details on enabling management service options, “Configuring Service Options” on page 
148.

To configure SNMP settings and enable the device to send SNMP traps, open a device 
configuration and select Report Settings > SNMP. Configure the following settings:

• System Name. The name of the device for which you are generating SNMP 
status. 

• Contact Person. The name of the network administrator who manages the 
device. This contact information is useful when the SNMP community member 
needs to contact someone about the device.

• Location. The physical location of the device.
• Listen Port. The number of the port assigned to monitor SNMP traffic (listen 

and transmit SNMP traps).
• Trap Port. The number of the port assigned to transmit traps that have been 

generated by an SNMP alarm, threshold violation, or error.
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• Enable Authentication Fail Trap. Specifies whether you want to generate a 
trap if a packet fails to be authenticated when attempting to enter the device. 
Select this options if the device sends SNMP messages through a VPN tunnel.

Next, configure SNMP communities. To send traps, the SNMP agent on the NetScreen 
FW/VPN device requires that you define communities, their associated hosts, and assign 
permissions (read/write or read-only). You can create up to three (3) SNMP communities, 
with up to eight (8) hosts in each community.

To create an SNMP community, click the Add icon under Community Settings and 
configure the following settings:

• Community name. The device uses the community name to authorize users 
attempting to enter the device.

• Access Mode. Defines read-write or read-only privileges for the community. 
• Trap Mode. When enabled (On), enables the device to send an SNMP trap for 

illegal SNMP connections attempts to the device. 
• Traffic. When enabled, the device can accept traffic from the source interface.
• Version. Defines the versions supported by the community (SNMPv1, 

SNMPv2c, or both SNMP versions, as required by the SNMP management 
stations). For backward compatibility with earlier ScreenOS releases that only 
support SNMPv1, NetScreen FW/VPN devices support SNMPv1 by default.

• Hosts. Define the host(s) associated with the community. Click the Add icon, 
then specify the host IP address and netmask, the trap version for the host (if an 
SNMP community supports both SNMPv1 and SNMPv2c, you must specify a 
trap version for each community member), and the source interface.
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A NetScreen FW/VPN device can generate syslog messages for system events at 
predefined severity levels and optionally for traffic that policies permit across a firewall. 
It sends these messages via UDP (port 514) to up to four designated syslog hosts running 
on UNIX/Linux systems. When you enable syslog reporting, you also specify which 
interface the NetScreen FW/VPN devices is to use to send syslog packets.

You can configure the syslog server settings at the device level, or skip this section and 
configure the GUI server to handle syslog messages; see “Exporting to Syslog” on page 
540.

To send log entries to a Syslog server, click the Syslog option. NetScreen-Security 
Manager displays the Syslog dialog box. Enter appropriate data into the following fields.

Field Description

Enable Syslog Messages Initiates the logging of system event messages to the Syslog.

Port Number Indicates the port number from where the messages are sent to the 
Syslog.

Use Trust Zone Interface 
as Source IF for VPN

Specifies using the interface mapped to the Trust zone as the source 
of traffic for a VPN.
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The NetScreen FW/VPN device can send syslog reports to a Webtrends Syslog host. 
Webtrends offers a product called the Webtrends Firewall Suite that enables you to 
customize syslog reports to display the information you want in a graphical format.

To send log entries to a WebTrends server, click the WebTrends option. NetScreen-
Security Manager displays the WebTrends dialog box. Enter appropriate data into the 
following fields.

You can set severity levels for WebTrends destinations by clicking the Log Settings option 
under the Report Settings option in the navigation tree. Then click the WebTrends Tab 
and click on the desired severity checkbox.
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The GUI Server organizes log data for all managed devices. You can configure the GUI 
Server to perform actions (syslog, export, alarm, etc.) on that log data based on the 
criteria you specify. To activate log actions on the GUI Server, you must configure:

• Log criteria. The criteria determines the category, subcategory, and severity 
for a matching log entry. If a log entry meets the specified criteria, it is 
considered qualified, and NetScreen-Security Manager takes the specified log 
action.

• Log action settings. These settings determine how the GUI Server handles 
qualified log entries. 
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To export to XML, CSV, SNMP, SMTP, Syslog, or script, configure the GUI Server Log 
Actions to export log entries to the specified format. 

You can configure the following log actions:

Include Traffic Log Specifies that all traffic log events are included as part of the 
messages sent to the syslog.

Config Host Indicates the name of the host device.

Field Description

Enable WebTrends Message Directs NetScreen-Security Manager to forward a log to 
the WebTrends server.

WebTrends Host Name The name of the WebTrends server.

Port Specifies the port number through which the device sends 
the log to the WebTrends server.

Use Trust Zone Interface as 
Source IP for VPN

Directs the device to use the interface mapped to the trust 
zone as the location for the Virtual Private Network over 
which the packets are forwarded to the WebTrends server.
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• Send log entries to your syslog server
• Send log entries to your SNMP server
• Export log entries to .CSV or .XML file
• Email alarms using your SMTP server

The following sections detail log action settings.
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To enable the GUI Server to send qualified log entries to your syslog server, specify the IP 
address or host name for the syslog server.

�'!������������� 
To enable the GUI Server to send log entries to an SNMP server, configure the following 
SNMP settings:

• SNMP Manager. Specify The IP address or host name of the SNMP server that 
the GUI Server sends SNMP traps.

• SNMP Community. Specify an SNMP community name that provides a 
desired combination of both read and write access from the SNMP server.

NetScreen-Security Manager exports all qualified log entries to the specified SNMP 
server.
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To enable the GUI Server to export log entries in CSV format, configure the CSV settings:

• File Path. The directory and filename that you want log entries exported to in 
.CSV format. 

• Print Header. Export column headers to .CSV format.

NetScreen-Security Manager exports all qualified log entries to CSV; each log becomes a 
CSV record.
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To enable the GUI Server to export log entries in XML format, enter the directory and 
filename you want log entries exported to in XML format. 

NetScreen-Security Manager exports all qualified log entries to XML; each log becomes an 
XML record, which you can open in most Web browsers.
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To enable the GUI Server to send email alarms to a Simple Mail Transfer Protocol 
(SMTP) email file on an SMTP server, specify the SMTP settings:

• SMTP Server. The mail server (IP address or host name) that receives email 
alarms.
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• From Email Address. The server (IP address or host name) that the SMTP 
server uses to send email. Some SMTP servers require a valid “from” email 
address” to relay mail.

• To Email Addresses. The email address that receives email alarms.

NetScreen-Security Manager sends email alarms generated by qualified log entries to the 
specified SMTP server. 
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Click the Log Criteria tab to specify the type of log entries that trigger the actions you set 
in the Log Actions tab. To add a new criteria, right-click and select Add Criteria, then 
configure the following settings.
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Select a category of log entry for the criteria. Some categories contain subcategories; 
however, to set an action based on a subcategory, you must first select a category. Next, 
select a severity of log entry.

For details on each category and subcategory, see “Log Entries” on page 611.
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The Log Viewer displays log entries generated by a NetScreen FW/VPN device when 
traffic matches a firewall or VPN rule, or when an event occurs that matches a predefined 
set of conditions. The main display of the Log Viewer displays summarized information 
about security events and alarms, while the detail panes provide more detailed 
information about a specific log entry. 

This section provides details on the following Log Viewer functionality:

• About the Log Viewer UI. This section describes the Log Viewer main display 
area, which includes a log entry list, three detail panes, a log timeline (used for 
log entry navigation), and a status bar that summarizes active filters.

• Searching Log Entries. For networks that generate large numbers of log entries, 
it can be difficult to locate the exact log entries that detail the events you want to 
investigate. This section describes how to use the log timeline to find logs 
generated around a specific time, how to use the find utility to locate log entries 
with a specific value, and how to search by LogID to jump directly to a specific 
log entry.

• Filtering Log Entries by Event & Time. This section describes how to create 
custom filters based on event data or time. You can apply these filters to a Log 
Viewer column or cell to reduce the number of log entries that appear in the 
main display area, helping you to focus your investigations on a specific group of 
log entries.

• Filtering Log Entries by Range. This section describes how to create custom 
filters based on a user-defined range. You can apply these filters to a Log Viewer 
column or cell to reduce the number of log entries that appear in the main 
display area, helping you to focus your investigations on a specific group of log 
entries.

• Customizing Columns. The Log Viewer includes 40 columns of log entry 
information; however, each predefined view includes only a small subset (16) of 
available columns. This section describes how to set viewable columns, change 
column display order, resize columns, and hide/unhide a specific column.

• Using Log Views. The Log Viewer includes several predefined views for critical 
severity attacks, configuration log entries, scans, etc. This section describes how 
to use filters to create your own unique, customized log entry view, then save the 
custom view (with all its filters) for future use.

• Using Log Viewer Integration. This section describes how to use the Log Viewer 
integration to jump from a log entry directly to the responsible Security Policy or 
managed device configuration.

• Identifying Irrelevant Attacks. Irrelevant attacks are events that do not affect 
your network or that you do not consider important. For example, if you do not 
run an Apache Web server on your network, you do not need to worry about 
attacks against Apache Web servers. This section describes how to use your log 
entries to identify irrelevant attacks, then eliminate the attack object group that 
generated that attack from your Security Policy.
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The Log Viewer contains the following components, as shown below.
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The Log Viewer contains the following columns:

Column Default What it means

Flag -- Indicates a severity level or information type associated with the 
log entry. An icon used to identify a log entry. Flags are helpful for 
locating log entries when the Log Viewer receives large amounts 
of log entries. Viewer tags entries by level of severity or 
information type using available flag types.

Alarm -- Indicates if an alarm has been generated with the log entry. 
When you configure a policy and you specify a notification for 
logging, you can configure an alarm to be generated when the 
policy performs an action.

Column headers

Log entries

Status bar

Detail Panes

Timeline

Scroll bar and slider



Chapter 11 Logging

544 Administrator’s Guide

Time Received Default Indicates the date and the time that the Log Viewer received the 
log entry.

Source Zone Source zone associated with a traffic log entry. Note: Log entry 
data for this column only appears after you update the FW/VPN 
device. The source zone is the zone that is attempting to send 
the traffic through the NetScreen FW/VPN device.

Source Address -- Indicates the address of the source device that generated the 
packet that generated the log. 

Src Port Default Indicates the TCP/UDP port number of the source device that 
generated the packet that generated the log.

Destination 
Address

Destination zone associated with a traffic log entry. Log entry 
data for this column only appears after you update the FW/VPN 
device."

Destination 
Address

Default Indicates the destination device to which the packet associated 
with the log entry was targeted.

Dst Port Default Indicates the TCP/UDP port number on the device to which the 
packet associated with the log entry was targeted.

Protocol Default The connection type or protocol of the matching traffic. Protocols 
also have one or more port numbers.

Device Address -- Indicates the address of the server.

Comment Default Enables you to add a comment that relates to the generated log 
entry. To enter a comment, simply click in the cell and begin 
typing.

Category Default Indicates what type of log you are viewing. Can be expressed 
either as a category or a sub-category. A category is either an 
alarm, config, misc, or traffic. A sub-category is an attack type.

Sub Category Default Indicates the subcategory of the log you are viewing. 

Packet Data -- Indicates the traffic type designated as part of the log entry. This 
indication is used to identify a packet entry created in the 
rulebase.

Severity Default Indicates the level of severity associated with the attack detected. 
Every attack has a default severity level although you can 
configure a different one.

Log ID -- Indicates the unique identifier ID for the log entry. The log ID 
comprises both a date and an incrementing integer.

Action -- Indicates whether an action occurred in response to the event 
that generated the log.

Alert -- Indicates whether an alert flag was generated in response to the 
event that generated the log.

App -- Indicates the application associated with the current log.

Bytes In -- Indicates the number of bytes that comprised the log data 
entering the Log Viewer.
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Bytes Out -- Indicates the number of bytes that comprised the log data being 
transmitted from the Log Viewer.

Bytes Total -- The sum of the number of bytes transmitted and received by the 
Log Viewer.

Device -- Indicates the IP address of the device that generated the current 
log.

Device Domain -- Indicates the name of the domain in which the device resides.

Domain Ver -- Indicates the version number of the device.

Elapsed Secs -- The number of seconds that have elapsed since the beginning of 
the current session.

From External -- Specifies if the packet that generated this log came from an 
untrusted network.

Has Log Action -- Indicates the action the device performed on the packet or 
connection that generated the log, generally either a permit or 
denial of the packet into the device.

Has Packet Data -- Specifies if this log has associated packet data.

In Eth -- The name of the Ethernet interface that receives packets 
transmitted from an external device.

Misc -- A miscellaneous string associated with the current log.

NAT Dst Port -- A destination port associated with the packet that has generated 
the log that has also undergone a network address translation.

NAT Src Port -- A source port associated with the packet that has generated the 
log that has also undergone a network address translation.

NAT Dst Addr -- A destination address associated with the packet that generated 
the log that also undergone a network address translation.

NAT Src Addr -- The source address associated with the packet that generated 
the log that has also undergone a network address translation.

Out Eth -- The name of the Ethernet interface that transmits packets to an 
external device.

Packets In -- Specifies the number of received packets for a given session on 
the current port.

Packets Out -- Specifies the number of transmitted packets for a given session 
on the current port.

Packets Total -- Specifies the aggregate number of both received and transmitted 
packets for a given session on the current port.

Policy -- The name of the policy that generated the log.

Rule # -- The rule in the rulebase in the policy in the specific version of a 
domain that generated this log.

Rule Domain -- The domain that contained the rule that generated this log.

Rulebase -- The rulebase inside the policy in a specific version of a domain 
that generated this log.
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After importing a device configuration, log entries from that device begin to appear in the 
Log Viewer. However, until you update the device from NetScreen-Security Manager, the 
following log fields display 0 (or unknown):

• For 5.x devices: domain, domain version, rulebase, policy, rule number.
• For 4.0.x devices: domain, domain version, rulebase, policy, rule number, from 

zone, to zone, action.

After you update the imported device configuration using NetScreen-Security Manager, 
the appropriate values are displayed for log entries from the device.
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The Log Viewer contains additional panes that provide summary and detail information 
for log entry events. To see detailed information about a log entry, select the entry and 
view the detail panes at the bottom of the Log Viewer. The detail pane contains three tabs 
of information about the selected log record:

• The summary tab (default tab) details the event associated with the selected 
log entry. Within the summary tab, you can view the event description (right 
side) and the variable data (left side). Not all log entries contain variable data—
only log entries generated by an attack provide variable data.

• The all fields tab provides a condensed view of data for the selected log entry (so 
you don’t need to scroll from horizontally)

• The Whois tab enables you to perform a Whois lookup on an IP address to see 
what organization has registered a particular address.
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The status bar of the Log Viewer summarizes the filters applied to log entries in the log 
entry list. In the status bar, the filter type description appears; to view filter details, 
mouseover the filter type. 

Time Generated -- The time the current log was generated.

URI -- Indicates the Universal Resource Indicator (URI) associated with 
the current log.

User Flag -- The GUI assignable flag associated with the current log.

Vsys -- The name of the virtual system that generated the current log.

Var Data -- Indicates the kind of variable data if any associated with the 
current log.

Log ID -- A value that represents the sequential record ID of the log for the 
specified day. In the format the nth log received.
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For example, the status bar below displays the filter types Category and Severity:
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Using the side scroll bar, you can navigate through hundreds of log entries quickly and 
precisely:

Log entries higher in the list are older than log entries at the bottom of the list. To 
navigate through log entries based on a specific time, use the Log Timeline (for details, 
see “Log Timeline” on page 548).

Jump to top of log entry list (oldest logs)

Jump to bottom of log entry list (most recent logs)

Page up within log entry list (older logs)

Page down within log entry list (more recent logs)

Scroll down within log entry list (more recent logs)

Scroll up within log entry list (older logs)

Use the slider to move up or down within log entry 
list. The further you drag the slider from the center, 
the faster you scroll through the log entry list.
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The Log Viewer can receive thousands or even millions of log entries each day. To quickly 
locate a specific log entry or logs, use the following log searching tools:

The following sections detail each search tool.
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The log timeline is a powerful tool that enables you quickly jump to a group of log entries 
generated during a specific time period. 

The timeline consists of 4 components: the time slider, time entry, time blocks, and 
Tailing Logs. The following sections detail each component.

Tool Description Benefit

Log 
Timeline

A 14-day timeline that enables 
you to zoom to log entries for a 
specific day and time. 

• Specify an exact date and time, or use the 
timeline selection slider to move immediately 
to a specific day’s log entries.

• Can also use the Tailing Logs feature to 
jump directly to incoming log entries.

• Timeline covers any 14-day period, in 
increments of days, hours, or minutes.

Flags A symbol used to tag a specific 
log entry that you want to return to 
at a later point. The flagged entry 
stands out from other entries, 
making it easier to locate quickly.

• Gain greater control over identifying events.

• Flags are colorful and iconic, making them 
more visible than text-based results of filters.

• You can filter on a flag setting.

Find 
Utility

A string search that searches for a 
log entry based on a character 
string in the reported event.

• Locate a specific event quickly with minimal 
detail; for example, search using the 
timestamp or IP address field.

• Move quickly from one relevant event to 
another, avoiding scrolling.

Log ID 
Number

A value search that searches for a 
log entry based on the log ID 
number.

Locate a specific log entry immediately. 
Typically, you use a log ID search when you 
have previously viewed the log entry and need 
to find it again quickly.
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The time slider marks the midpoint of the time interval selected for the timeline (for 
details on setting a time interval, see “Using Time Blocks” on page 549). You can move the 
time slider to the desired time using your mouse cursor: Click the slider, then drag it to 
the area on the timeline that represents the time around which you want to view log 
entries, as shown below:
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You can also enter a date and time into the log timeline directly. Select the time display, 
then enter the desired time and click Go.
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To change the log timeline intervals, select a specific time block or use the Out and In 
buttons. From left to right, the time blocks are:

• 14 days
• 7 days
• 3 days
• 1 day
• 12 hours
• 6 hours

Set the time slider 
(the vertical red line) 
to the date and time 
for which you want to 
view log entries. 

The log entry list 
automatically 
jumps to the 
selected date and 
time (shown by the 
horizontal red line)

1

2
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• 3 hours
• 1 hour
• 30 minutes
• 1 minute

Clicking the Out button selects the time block to the left of the currently selected time 
block; clicking the In button selects the time block to the right of the currently selected 
time block. Alternatively, you can use the mouse wheel on your mouse to adjust the time 
interval.
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To view arriving log entries, select Tailing Logs. The log entry list automatically jumps to 
the bottom of the list, where new log entries display when they are received by the 
management system. As older log entries are moved up by arriving log entries, the view 
remains fixed at the bottom of the list.

Tailing Logs also works with filters, predefined view, and custom views.
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To see configuration log entries as they arrive from a specific device:

1. Select the 7-Config view from the Log Viewer navigation tree. This view uses a 
predefined filter to display log entries with the category “configuration” only.

2. Set a custom filter to set log entries from a specific device (for details, see 
“Filtering Log Entries by Event & Time” on page 551). The view changes to 
display configuration log entries from that device.

3. Select Tailing Logs. The view jumps to the bottom of the log entry list, and 
remains there; as new configuration log entries for the device arrive, they 
appear at the bottom of the list. 
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Use a flag to mark a specific event with a severity or workflow marker. Applying a flag to 
a log entries helps the event stand out from other log entries. The following table displays 
a list of log filter symbols.

Filter Symbol Severity Level Filter Type

Low Severity

Medium Severity

High Severity
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Within the Log Viewer, you can set a filter on one or more flags. Additionally, within 
Report Manager, you can generate a report that displays the count of all log entries that 
contain a specific flag.
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Use the Find utility to search for the next iteration (down) of a value in the Log Viewer. 
To use Find on a column or cell, right-click the column header or cell and select Find, then 
configure the search criteria. Select Negate to search for all log entries that do not contain 
the specified value.
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When you know the Log ID number for the log entry, you can jump directly to the log 
entry. To locate a log entry by Log ID number, from the file menu, select Edit > Go To Log 
ID. In the Go To Log ID dialog box, enter the log ID number click OK. The Log Viewer 
jumps to the specified Log ID and highlights the log entry in the main display area.
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An event- or time-based filter is a criteria search for matching log entries. When you apply 
a filter to log entries, the Log Viewer filters out log entries that do not match the filter 
criteria. You can set multiple filters on any Log Viewer column (except Log ID and 
Details) or cell value.

When filtering by cell, the filter affects only the content in that cell’s column. To set a cell 
filter, right-click a cell and select Filter to display the filter menu options:

• Edit. Use this option to set multiple filters for cell content at the same time. 
Select to display the Filter dialog box for that column, then select the columns 
you want to filter on. 

– To display only the selected content, click OK.

Assigned Information

False Positive Information

Closed Information

Follow-Up Information

Pending Information
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– To display everything except the selected content, click the checkbox next 
to Negate, then click OK. 

– To clear filters for the selected content, click Clear.
• Only This Value. Displays only the content in the selected cell.
• Not This Value. Displays everything except the content in the selected cell.
• Clear Filter. Removes a current filter on the selected cell content. If no filter 

exists, this option is unavailable.
• Clear All Filters. Removes all filters on the current view. 

When filtering by column, the filter affects all log entries. You can set an event-based 
filter using any log entry column that contains event data, and a time-based filter for the 
Time Generated and Time Received columns. Additionally, for all filters (cell or column), 
you can enable the Negate option to match all log entries that do not contain the specified 
filter criteria.

The following sections detail some common event- and time-based filters used to manage 
log entries. 
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Apply a category filter to view log entries within a specific category or subcategory. 

• To create a category filter, right-click the Category column header and select 
Filter > Set Filter. Select the categories you want to use as the filter criteria, 
then click OK. NetScreen-Security Manager applies the filter to all log entries 
and displays only the log entries that match the specified category.

• To create a subcategory filter, right-click the Subcategory column header and 
select Filter > Set Filter. Select the category first, then select the subcategories 
you want to use as the filter criteria, then click OK. NetScreen-Security 
Manager applies the filter to all log entries and displays only the log entries that 
match the specified subcategory.
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Apply an alert filter to view log entries that have an enabled or a disabled alert state. To 
create an alert filter, right-click the Alert column header and select Filter > Set Filter, 
then configure the alert filter settings:

• To display log entries that contain an enabled alert, select On and click Ok.
• To display log entries that contain a disabled alert, select Off and click Ok.

NetScreen-Security Manager applies the filter to all log entries and displays only the log 
entries that match the specified alert state.

Note: You cannot apply a filter to the Log ID or Details column.
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Apply a flag filter to view log entries that have a specified flag type. To create a flag filter, 
right-click the Flag column header and select Filter > Set Filter. Select the flag types that 
you want to use as the filter criteria, then click OK. NetScreen-Security Manager applies 
the filter to all log entries and displays only the log entries that match the specified flag 
type.
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Apply an address filter to view log entries that record events for a specific source or 
destination address, or source or destination NAT address. To create an address filter, 
right-click the Src Addr, Dst Addr, NAT Src Addr, or NAT Dst Addr column header and 
select Filter > Set Filter. Select “Click here to add address” and enter a valid IP address 
and click Ok. For NAT addresses, enter the IP address that is translated and click Ok.

NetScreen-Security Manager applies the filter to all log entries and displays only the log 
entries that match the specified IP address.

����
������������ ��
 ���
Apply a protocol filter to view log entries for events that use a specific protocol type. To 
create a protocol filter, right-click the Protocol column header and select Filter > Set 
Filter. Select the protocol types that you want to use as the filter criteria, then click OK. 
NetScreen-Security Manager applies the filter to all log entries and displays only the log 
entries that match the specified protocol types.
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Apply a domain filter to view log entries for managed devices in a specific domain. To 
create a domain filter, right-click the Domain column and select Filter > Set Filter. Select 
the domains for which you want to view log entries, then click OK. NetScreen-Security 
Manager applies the filter to all log entries and displays only the log entries that are 
generated from managed devices in the specified domains.
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Apply a time-based filter to view log entries generated or received within a specific time 
period. To create a time-based filter, right-click the Time Generated or Time Received 
column and select Filter > Set Filter:

Note: The Unflagged option in the flag filter can be helpful when trying to locate 
log entries that do not have assigned flags. When setting the flag criteria, select 
Unflagged as the flag type; NetScreen-Security Manager then displays all log 
entries without flags.
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• To filter on a specific start time, select From and configure the start date and 
time. When applied, this filter displays log entries for events that were 
generated or received after or at the specified start time.

• To filter on a specific end time, select To and configure the end date and time. 
When applied, this filter displays log entries for events that were generated or 
received before or at the specified end time.

• To filter on a time period, select From and To, then enter the start and end date 
and time. When applied, this filter displays log entries for events that were 
generated or received within the specified time period.

�'�#!$���%����3�$���%
In this example, you want to view all critical and major severity log entries that have a 
Follow-Up flag assigned to them. Additionally, you want to limit the search to log entries 
generated by the Engineering NSRP cluster on your network.

1. In the Log Viewer, right click the severity column header and select Filter > Set 
Filter. Configure the filter dialog box as shown below:

Click OK to save and apply the filter to your log entries.
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2. Right click the User Flag column header and select Filter > Set Filter. Configure 
the filter dialog box as shown below:

Click OK to save and apply the filter to your log entries.

3. Right click the Device column header and select Filter > Set Filter. Configure 
the filter dialog box as shown below:

Click OK to save and apply the filter to your log entries.
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A range filter is a criteria search for matching log entries within a value range. You can 
set a range filter for the following columns:

• Bytes In/Bytes Out
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• Bytes Total
• Packets In/Packets Out
• Packets Total
• Src Port/Dst Port
• NAT Src Port/NAT Dst Port
• Elapsed Seconds

The following sections detail some common range filters used to manage log entries.
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To view log entries based on the number of bytes received or transmitted during the 
event, set a range filter on the Bytes In or Bytes Out column:

1. Right-click the Bytes In or Bytes Out column header and select Filter > Set 
Filter. The Bytes In/Bytes Out filter dialog box appears.

2. Set the range for bytes received (Bytes In) or transmitted (Bytes Out):
– To filter on a minimum number of bytes only, select From and enter a 

value. When applied, this filter displays log entries for events that 
received or transmitted more than or equal to the specified minimum 
number of bytes.

– To filter on a maximum number of bytes only, select To and enter a value. 
When applied, this filter displays log entries for events that received or 
transmitted fewer than or equal to the specified maximum number of 
bytes.

– To filter on a range of bytes, select From and To, then enter the minimum 
and maximum values for the range. When applied, this filter displays log 
entries for events that received or transmitted a number of bytes within 
the specified range.

3. Click OK to apply the filter.
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To view log entries based on a range of port numbers used in the event, set a range filter 
on the Dst or Src Port column:

1. Right-click the Src Port or Dst Port column header and select Filter > Set Filter. 
The Dst/Src Port filter appears. 

2. Set the range for the port numbers:

Note: By default, the Log Viewer does not display the Bytes In or Bytes 
Out column. To set a byte filter, you must first configure the Log Viewer to 
display these columns. For details on configuring column settings, see 
“Customizing Columns” on page 557.



Using the Log Viewer

NetScreen-Security Manager 2004 FP2 557

– To filter on a minimum port number only, select From and enter a value. 
When applied, this filter displays log entries for events that used a port 
greater than or equal to the specified minimum port number.

– To filter on a maximum port number only, select To and enter a value. 
When applied, this filter displays log entries for events that used a port 
less than or equal to the specified maximum port number.

– To filter on a range of port numbers, select From and To, then enter the 
minimum and maximum values for the range. When applied, this filter 
displays log entries for events that used ports within the specified range.

3. Click OK to apply the filter.
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You can configure the Log Viewer to display specific columns.
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The Log Viewer includes 40 columns of log entry information; however, each predefined 
view includes only a small subset (16) of available columns. To view information in the 
other available columns, or to change the column display order, you can adjust the column 
settings for the view.

The more columns you configure to appear in the Log Viewer, the more information you 
can see at one time—and the more you must scroll from side to side to view all columns; 
setting fewer columns means less viewable information, but also less scrolling. Typically, 
you use fewer columns when you already have enough detail about the event and/or you 
are only interested in specific event data.

Use column selection in combination with filters to create a customized view of your log 
entries.
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You hide, unhide, or move columns to display specific information using one of the 
following methods:

• When managing columns using the Column Settings dialog box:
– To display hidden columns, select the columns and click Show. 
– To hide columns, select the columns and click Hide.
– To reorder the column display sequence, select a column and click Move 

Up and Move Down.
• When managing columns in the main display area:

– To hide a column, right-click the column header and select Hide Column. 
To unhide a hidden column, you must use the Column Settings dialog box.

– To reorder the column display sequence, select a column and drag it the 
new location.
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– To change column width, select the left or right edge of the column header 
and drag the edge to the desired width.
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In this example, you want to view the following information in the Log Viewer: 

• The attacks that attempt to enter your network.
• The source IP and port of the attacking computers.
• The destination IP and port on the target computers.
• The date and time of the attacks.
• The devices that detected the attack.
• The policies that matched the attack.

First, you configure the Log Viewer to display only the columns that contain the 
information you are interested in viewing, then you set can filters on those columns to 
narrow your search.

To configure the column settings: 

1. In the navigation tree, select the Log Viewer module. 
2. From the file menu, select View > Choose Columns. NetScreen-Security 

Manager displays the Column Settings dialog box, which lists all 40 available 
columns. 

3. Select the following columns:
– Time Received
– Src Addr
– Dst Addr
– Dst Port
– Category
– Subcategory
– Device
– Policy
– Src Port

Ensure all other columns are not selected, then click OK to apply your changes 
to the Log Viewer.

4. In the main display area, select the Src Port column header, then drag and drop 
the column to the right of the Src Addr column.

To configure the column filters:

1. In the main display area, right-click the Category column header and select 
Filter > Set Filter. The Category filter dialog box appears.

2. Select the following categories:
– Anomaly
– Custom
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– Screen
– Signature

Click OK to apply your changes. The Log Viewer applies the filter to the log 
entries. 
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The Log Viewer includes several predefined views for critical severity attacks, 
configuration log entries, scans, etc. Using filters, you can create your own unique, 
customized log entry view, then save the custom view (with all its filters) for future use.
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A custom view enables you to organize log entries in a format that is most helpful to you. 
Because the custom view is based on filters, incoming log entries that match the filter 
criteria are automatically displayed in the view (you do not need to re-apply the view to 
new logs). 

You might want to create views to help manage the following situations:

• Workflow. To help a team of security administrators work together to 
investigate and resolve incidents, create a view that filters on the flag column of 
the Log Viewer to indicate the status of each log entry and assignment.

• Attackers. To track the activities of a known attacker, create a view that filters 
on a specific source IP. The source IP address of an attack displays in the source 
address column, and the destination IP address of an attack displays in the 
destination address column.

• Alarms. To quickly access log entries generated by a policy rule that contains an 
alarm, create a view that filters on the alarm column. This method is useful 
when you are fine-tuning policies to distinguish between genuine attacks and 
false positives.

• Devices. To manage devices in multiple locations that use different 
investigation processes, create a separate view for each device at a specific 
location.

You can create and save custom views using one of the following methods: 

• Create New View First. In the navigation tree, select the Log Viewer module. 
From the file menu, select File > New View. In the new view dialog box, enter a 
name for the custom view and click OK; the new view appears in the navigation 
tree, at the bottom of the predefined view list. In the main display area, set the 
desired filters for the log entries.

• Set Filters First. In the Log Viewer main display area, set the desired filters 
for the view. From the file menu, select File > Save As. In the new view dialog 
box, enter a name for the custom view and click OK; the new view appear in the 
navigation tree, at the bottom of the predefined view list.
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To save a predefined or custom view to a specific format, you can export the view to an 
Adobe PDF file or a standard PostScript file. For step-by-step instructions on exporting a 
view, see the Online Help topic “Exporting from the Log Viewer”.
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The Log Viewer module is integrated with Security Policies and Device Manager modules. 
This integration enables you to jump from a log entry in the Log Viewer directly to the 
responsible Security Policy (Jump to Rule) or managed device (Jump to Device 
Configuration).
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To quickly edit a Security Policy rule from the Log Viewer, right-click a log entry and 
select Jump to Policy. NetScreen-Security Manager opens a new UI window and displays 
the policy with the rule that generated the log entry

• If the responsible rule exists within a rule group, the group is automatically 
expanded to reveal the rule.

• If the responsible rule exists within a VPN created by VPN Manager, the 
autogenerated rules appear.

Depending the domain version of the Security Policy, the rule might display as read/write 
or read-only. 

Domain version refers to a specific modeled configuration; each time you install a modeled 
configuration (this includes Security Policies) on a managed device using NetScreen-
Security Manager, the management system creates a new domain version using the 
install date and time. NetScreen-Security Manager uses domain versions to detect 
differences between the running configuration (installed on the physical device) and 
modeled configuration. Domain versioning also enables you to perform a domain rollback. 
For details on domain versions, see “Domain Versioning” on page 35.

When using the Jump to Policy option in the Log Viewer, NetScreen-Security Manager 
compares the domain version of the managed device to the current domain version. If the 
responsible rule exists in a Security Policy that has the same domain version as the 
Security Policy installed on the managed device, you can edit the rule. 

However, if the responsible rule exists in a Security Policy that has a different domain 
version from the Security Policy installed on the managed device, you cannot edit the rule. 
This typically occurs when you install a Security Policy on a managed device, then edit 
that policy in the NetScreen-Security Manager UI but do not update the device with the 
new policy changes. Because the responsible rule exists in a policy that belongs to a 
previous domain version, you cannot make changes to it.
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To quickly configure a parameter on an individual device from the Log Viewer, double-
click a device in the Device column. NetScreen-Security Manager displays the device 
configuration for the device, enabling you to make changes to the device.
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Your log entries are a valuable tool in helping you identify irrelevant attacks. Irrelevant 
attacks are events that do not affect your network or that you do not consider important. 
Typically, you want to identify irrelevant attacks to:

• Reduce the number of log entries and increase system performance.
• Isolate log entries for harmless attacks.
• Focus on log entries for attacks to which you are actually vulnerable. 

Select a log entry generated by a protocol anomaly or signature attack object, then view 
the Summary panel to see the attack description. An example is shown below:

Look carefully at the information about affected systems, and compare it with what you 
know about your network. Use the following information to help you determine if the 
attack is relevant:

If the attack is irrelevant, you can remove the matching Attack Object group from the rule 
that triggered the log entry, or monitor the Attack Object group using custom severity 
setting.

Irrelevant Attacks Relevant Attacks

Attack target hardware you do not use.
Example: Attacks that exploit Cisco routers do 
not affect Lucent routers. 

Attack attempts to exploit vulnerabilities in the 
hardware you use in your network.

Attack target software you do not use.
Example: Attacks that exploit Microsoft IIS 
Web servers do not affect Apache Web 
servers.

Attack attempts to exploit vulnerabilities in the 
software running on your network.

Attack target software versions you do not use. Attack attempts to exploit vulnerabilities in the 
software versions running on your network.

Attack Type 
(buffer overflow, 
password exploit, 
DOS, etc.)

Affected System 
(hardware, software, 
OS, or service)

Attack Pattern (what 
to match against and 
where to look)

Attack Description (how it works 
and the consequences)
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The Log Investigator module enables you to investigate patterns and trends on your 
network using data gathered from your log entries. Log entries are generated by a 
NetScreen FW/VPN device when traffic matches a Security Policy rule, or when an event 
occurs that matches a predefined set of conditions. The Log Investigator uses the event 
data recorded in the log entry to identify the destination IP addresses and ports that are 
attacked most frequently, the services that are used to attack most frequently, and the 
source IP addresses that most frequently generate attacks.

When using NetScreen-Security Manager to manage large networks with multiple 
managed devices, you can potentially receive several hundred log entries in a single day 
(depending on how you have configured your devices for logging). The Log Investigator is 
a helpful tool for manipulating and correlating a large volume of log entry data so you can 
identify and analyze important activity that might threaten your network. By analyzing 
your data and then using that knowledge to proactively fine-tune your Security Policies, 
you can decrease risk while increasing security.

This section provides details on the following Log Investigator functionality:

• About the Log Investigator UI. The Log Investigator main display area includes 
a filter summary, a log entry matrix, and two detail panes that display detail 
information in table and chart format.

• Configuring Log Investigator Options. Configure the criteria the Log 
Investigator uses to create the matrix, including the time period, Left and Top 
Axes settings, the data point count (the number of data points the Log 
Investigator must collect before displaying data), and the maximum number of 
log entries you want the Log Investigator to use when collecting data.

• Setting Log Investigator Filters. As in the Log Viewer, you can set filters on log 
entry data so the Log Investigator displays only the information you want to see. 
Apply multiple filters to data for all log entry columns found in the Log Viewer.

• Investigating Log Entry Data. After you have configured the Log Investigator 
filters, time period, and data options, you are ready to begin investigating your 
log entry information. Within any cell the Log Investigator table, you can right-
click and select an option to view specific details, including Destination Ports, 
Subcategories, and Time Period.
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The main display of the Log Investigator is shown below:

The Log Investigator contains the following UI components:

• Filter Summary. Displays the column/category filters currently applied to the 
Log Entry Matrix.

• Selected Log Entries. Displays the number of log entries currently selected in 
the Log Entry Matrix.

• Left Axis. The controlling axis for log entry data (the independent axis). The 
Log Investigator collects log entry data for the Left Axis setting, which 
determines data set that is used for Top Axis setting.

Zoom Table Zoom Chart

Filter Summary Selected Log Entries Top AxisLeft Axis

Log Entry Matrix
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• Top Axis. The controlled axis for log entry data (the dependent axis). The Log 
Investigator collects log entry data for the Left Axis setting; for the Top Axis 
setting, the Log investigator collects data that matches both the Left Axis and 
Top Axis setting.

• Zoom Table. Displays a table of log entry details. You can view Source, 
Destination, Destination Port, Attack Subcategories, or Time Period details for 
any cell, row, or column.

• Zoom Chart. Displays a chart of log entry details. You can view Source, 
Destination, Destination Port, Attack Subcategories, or Time Period details for 
any cell, row, or column.
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The first step in using the Log Investigator is to configure the basic criteria used to create 
the Log Investigator matrix. Initially, the default options are used; to edit these options, 
from the file menu, select View > Set Log Investigator Options. Using the Log 
Investigator Options dialog box, configure the desired settings (detailed below) and click 
OK to apply your changes. 

The following sections detail each Log Investigator option.
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The time period setting narrows the log entries included in your investigation based on a 
specified time interval or start time. Each log entry contains a timestamp that indicates 
the date and time the managed device generated the log entry (Time Generated). The Log 
Investigator compares the timestamp of a log entry to the specified time period setting, 
and eliminates those log entries that do not meet the time criteria.

First, you must specific a time duration. To specify a time interval for which you want to 
see log entries, set the number of weeks, days, hours, minutes, or seconds. Setting a 
longer interval time can you identify broad trends in your network activity. Typically, you 
want to use a longer interface time to initially locate problems. After you have identified 
the issues you want to investigate, set a shorter time interval to eliminate irrelevant log 
entry data.

After you have determined the time interval, you must set the end or start time for the 
duration:

• To set the end time of the duration, select Most Recent (this is the default 
setting). The Log Investigator uses the current date and time as the end point 
for the time duration. For example, for a time interval of 5 hours, the Log 
Investigator collects data from log entries that have timestamps within the 
previous 5 hours.

• To set the start time of the duration, select Start Time and configure the start 
date and time. The Log Investigator uses the specified date and time as the start 
point for the time duration. For example, for a time interval of 5 hours and a 
start date of 5/12/04 8:00:00AM, the Log Investigator collects data from log 
entries that have timestamps from the start date to the start date + 5 hours.
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Typically, use Most Recent to investigate recurring activity or to monitor expected 
network changes. Use a start time when investigating past known events, such as a virus 
attack.
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On Friday afternoon, you want to investigate attacks received by your network in the last 
eight hours. Configure the time period as show below:

On Monday morning, you want to investigate attacks received by your network during the 
last work week. If Monday’s data is 5/17/04, you configure the time period as show below:
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The Left Axis is the independent axis because it is the first data collected. The Top Axis is 
dependent axis because it uses the Left Axis data as the data set.

The dependency works like this: The Log Investigator collects data that matches the Left 
Axis setting first; this data represents the data set for the entire log entry matrix. By 
default, the Left Axis is set to the data type Top Sources. After the Left Axis data set has 
been determined, the Log Investigator searches that data set for data that matches the 
Top Axis setting. By default, the Top Axis is set to the data type Top destinations.

Because the Left Axis setting controls the initial data set, it is the most important axis 
setting. Typically, you should set the Left Axis to the data type you most want to 
investigate.

���������/���������!�
You can change the data type for each axis. The data type defines the type of information 
that the Log Investigator attempts to locate in your log entries. For either axis, you can 
set the following data types:

• Top Sources. The IP address that generated the event.
• Top Destinations. The IP address that received the event.
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• Top Subcategories. The attack subcategory detected in the event.
• Top Destination Ports. The port numbers on the Destination device that 

received the event. The port number can help you identify the service used in the 
event.

By default, the Left Axis uses the data type Top Sources and the Top Axis uses the data 
type Top Destinations. To change these settings, simply select the desired data type in the 
data point source menu.
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A data point is a single data type field that matches the axis setting. By default, each axis 
collects 10 data points for each evaluation. These default settings create a Log Entry 
Matrix of 100 cells (the top 10 source IP addresses are correlated against the top 10 
destination IP addresses, creating a 100-cell matrix). For example, a data point count of 6 
for each axis would create a 36-cell matrix).

You can set the data point higher (maximum 40) or lower (minimum 5), depending on 
your investigation requirements. To change these settings, simply select the desired data 
type in the data point count field. The higher the data count, the larger the log entry 
matrix—and the more processing power required by the Log Investigator UI. Using large 
data counts can slow performance.
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In this example, you configure swap the setting for the Left and Top Axes of the Log 
Investigator to see how each axis controls data.

Set the filter to Attacks, then configure the Left and Top Axes:

• To identify which of the most popular source addresses are generating attacks 
against the most popular destinations:

– Select as the Left Axis (the independent axis) as Top Sources.
– Select the Top Axis (the dependant axis) as Top Destinations.

The Left Axis displays all attacks for the Top Source IP addresses, while the Top 
Axis displays the number of attacks for each of the Top Destinations attacked by 
the Top Sources.

• To identify which of the most popular destination addresses are receiving 
attacks from the most popular sources:

– Select as the Left Axis (the independent axis) as Top Destinations.
– Select the Top Axis (the dependant axis) as Top Sources.

The Left Axis displays all attacks against the Top Destination IP addresses, 
while the Top Axis displays the number of attacks for each Top Source IP 
address that attacked a Top Destination.
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You can limit the number of log entries used in Log Investigator calculations. The 
NetScreen-Security Manager Device Server stores log entries from managed devices and 
the management system; when the GUI Server accesses a log entry to display its 
information in the UI, that log entry is placed in a log buffer. As the Log Investigator 
searches your log database for log entries that match the filter, time period, and data type 
criteria, it places all matching log entries in the log buffer.

To control the size of this buffer (the number of matching log entries), you can configure 
the Max Log Count for your investigations. The limit defines the number of matching log 
entries the Log Investigator accepts for its calculations.

You can set the following log entry limits:

• 100,000 log entries
• 200,000 log entries
• 400,000 log entries
• 600,000 log entries
• 800,000 log entries
• 1,000,000 log entries

Be aware that setting a large buffer limit can cause the Log Investigator performance to 
degrade. The maximum buffer size of one million log entries uses all memory on the GUI 
Server and is not recommended.
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Log Investigator filters operate very similar to Log Viewer filters: You set criteria for log 
entries and the Log Investigator filters out log entries that do not match the filter criteria. 
Using the Filter Summary dialog box, you can select and apply multiple filters to the Log 
Investigator matrix.

To set filters, from the file menu, select View > Set Filter. The following table details filter 
types:

Filter Type Sample Filters Description

Time Filters Time Received
Time Generated

Identifies packets by the time when a packet 
is sent from a device and when a packet is 
received on a device.

Address Filter Source Address
Destination Address
Device Address

Identifies packets based on information 
about an address of a device from which the 
packet was sent or an address of a device to 
which the packet was sent.

Direction Filters Inbound If
Outbound If

Identifies packets based on the direction 
they are heading to or from a specified 
device.

Device Filters Device VIN
Virt Dev

Identifies device ID number and virtual 
device value.
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After you have set a filter, the Filter Summary displays a list of all filters applied to the 
log entry data and the Log Investigator matrix displays values for matching log entries.
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In this example, the Left Axis is set to Top Sources and the Top Axis is set to Top 
Destination (these are the default settings). To set a filter that displays all attack category 
log entries generated by the Top Sources and received by the Top Destinations:

1. From the file menu, select View > Set Filter to display the Filter Summary 
dialog box.

2. In the filter list on the left, select Category, then select the following categories 
in the right: Anomaly, Custom, Screen, and Signature.

Transmission Type Filters Packets
Bytes
Attack

Identifies transmissions based on whether 
they are seen as packets, bytes, or attacks.

Port Filters Src Port
Dst Port

Identifies packets based on the port on a 
device from where they were transmitted or 
on the port on a device to where they were 
transmitted.

Policy Filters Policy ID
Policy Version
Rule Number

Identifies packets based on whether they 
meet the conditions of a policy or a rule.

Alarm Filters Flag
Alarm
Severity

Identifies the severity level of a generated 
alarm.

Miscellaneous Filters Protocol
Category
Email
SNMP
Syslog
Action

Various

Note: For a complete list of log entry columns available for filtering, see “Log Viewer 
Columns” on page 543.
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3. Click OK to save and apply your changes. An example filter is shown below:

To view the number of attacks between a specific source-destination pair, locate the 
Source Address 63.172.115.190 and Destination Address 63.172.115.6, then find the cell 
where the two addresses intersect. The Log Investigator displays 140 log entries for this 
Source-Destination pair, as shown below:
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This high value (140) reflects the number of attack log entries that have occurred between 
these two IP addresses.
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After you have configured the Log Investigator options and set filters as desired, you are 
ready to begin investigating your log entry data.
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Each row or column in the Log Entry matrix represents events for a single data type. 
When selecting a row/column, you are evaluating how the data type (source, destination, 
subcategory, or destination port) for that axis relates to the other axis during a specific 
time period. Typically, reviewing a row/column in the matrix helps you analyze all events 
for a single data type. 

For example, to investigate a sudden drop in performance on a specific destination, set the 
Left Axis to Top Sources and the Top Axis to Top Destinations, then select the column for 
the destination IP address. For each cell that displays a high number of events received by 
that destination, locate the corresponding source IP address. You might determine that 
destination 1 is receiving a large number of events from source A, B, and C. This activity 
could be a harmless event, such as multiple users attempting to contact a single 
application server at the same time. You could eliminate the bottleneck by adding another 
application server to the network or restricting access to the existing server.
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Each cell in the Log Entry matrix represents events that occur at the intersection of two 
data types. When selecting a cell, you are evaluating the events that occurred between 
those two specific data types (source, destination, subcategory, or destination port) during 
a specific time period. Typically, reviewing a cell in the matrix helps you analyze all 
events that occur between a data type pair.

For example, to investigate a sudden drop in network performance, set the Left Axis to 
Top Sources and the Top Axis to Top Destinations, then review the log entry matrix to 
locate a large number for a location pair. You might identify that source A is sending an 
unusually large number of transmissions to destination 1. This activity could be a 
harmless event, such as an employee archiving multiple large files before leaving work; 
however, this activity might be the result of a denial-of-service attack triggered by an 
internal trojan. You probably need to get more details, such as destination ports used and 
attack subcategories for the events before you can resolve the issue.
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The following table details the benefits of each type of Log Investigator analysis.
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You can zoom in on specific details about activity between two data types. You can select a 
third data type for comparison, or display details about the event over time. To get details, 
right-click a cell, row, or column and select Zoom In to see the list of available data types. 
Because the Zoom In menu is dynamic, it contains all data types not currently used for 
the Left or Top Axis of the Log Investigator matrix. Alternatively, you can select time as 
the third data type.

Details appear in the Zoom area, which contains two panes:

• The Zoom table (left pane)
• The Zoom chart (right pane)

The table and chart use the same information to generate values.
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In this example, the Left Axis is set to Top Sources and the Top Axis is set to Top 
Destination (these are the default settings); the filter is set to attacks (for details on 
setting the filter, see “Setting Filters” on page 568).

To view the service ports on the destination device used by the attacks, right-click a cell 
that contains a non-zero value and select Zoom In > Dst Port. In the Zoom area:

Data Type A

(Left Axis)

Data Type B

(Top Axis)

Benefit

Multiple Rows Multiple Columns • View all network activity for specific data types. No cells or 
columns are selected (default view).

• Useful for analyzing events for multiple data types, such 
as multiple destinations and multiple sources. To focus on 
a specific data type pair, select the intersection cell.

Multiple Row One Column • View network activity for a single data type. A single 
column is selected.

• Useful for analyzing network performance issues, such as 
multiple sources generating traffic to a single destination.

One Row Multiple Column • View network activity for a single data type. A single row is 
selected.

• Useful for analyzing attack traffic, such as one source 
generating traffic to multiple destinations.

One Row One Column • View specific activity between two specific data types. A 
single cell is selected.

• Useful for analyzing event traffic between two network 
components.



Chapter 11 Logging

572 Administrator’s Guide

• The left pane displays a table of service ports listed in descending order (the port 
accessed by the most attacks is listed first). The left column lists the Destination 
Port Number and the right column lists the number of attacks received by that 
port number. Because services are mapped to specific port numbers, you can use 
the port number to identify the service used in the attack.

• The right pane displays a chart using the same information.
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In this example, the Left Axis is set to Top Sources and the Top Axis is set to Top 
Destination (these are the default settings); the filter is set to attacks (for details on 
setting the filter, see “Setting Filters” on page 568).

To view the individual attacks (the attack subcategories) against the destination device, 
right-click a cell that contains a non-zero value and select Zoom In > Subcategory. In the 
Zoom area, the left pane displays a table of attack subcategories listed in descending order 
(the attack found in the most number of log entries is listed first); the right pane displays 
a chart using the same information.
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In this example, the Left Axis is set to Top Sources and the Top Axis is set to Top 
Destination (these are the default settings); the filter is set to attacks (for details on 
setting the filter, see “Setting Filters” on page 568).

To view the time period over which the attacks occurred, right-click a cell that has a non-
zero value and select Zoom In > Time. In the Zoom area, the left pane displays a table of 
attacks listed in order (the oldest attack is listed first); the right pane displays a chart 
using the same information.
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The Log Investigator uses log entry data for calculations, and does not display the actual 
log entries. However, you can use the Log Viewer to see the log entries used in Log 
Investigator calculations.

To see corresponding log entries, right-click a cell, row, or column from the Log 
Investigator matrix or the Zoom table and select View in Log Viewer. NetScreen-Security 
Manager creates a new UI window that displays the log entries in the Log Viewer.
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You can manually configure the Log Investigator to exclude data for a cell, row, or column 
in the Log Investigator matrix. You might want to exclude:

• Irrelevant values (i.e. values from sources or destinations no longer in 
production)

• Abnormally high or low values (to establish a baseline)
• Specific data type (source, destination, destination port, subcategory)
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• High values (when investigating events that generate lower values)

To exclude a specific attack from the Log Investigator calculations, right-click the attack 
cell and select Exclude. To help you keep track of excluded values, the Filter Summary 
area displays a list of values you have manually excluded.
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The Audit Log Viewer monitors administrative events that occur when a NetScreen-
Security Manager administrator makes changes to a domain. Use the Audit Log Viewer to 
track changes to your managed device configurations. You can view audit log entries for 
all managed devices in the all domains you have access to, or simply view entries for the 
devices in a single domain.

The Audit Log Viewer appears as the last component in the NetScreen-Security Manager 
UI. Select the Audit Log Viewer to display the audit log entry table, device view, and 
target view, as shown below:
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The audit log table contains the following columns of information:

Column Description

Time Received The time the object was changed. The Audit Log Viewer 
displays log entries in order of time generated by 
Greenwich Mean Time (GMT).

Audit Log Table

Target View Device View
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For changes to devices or device configuration, you can use the Target View and/or Device 
View to get more details about those changes.
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The Audit Log Viewer also contains two detail views:

• Target View. For a change made to the device configuration, such as changing 
an IP address or renaming the device, select the audit log entry for that change 
in the audit log table, then view the Target View to see details about that 
change.

• Device View. For a change made to the device itself, such as adding the device, 
autodetecting a device, or rebooting a device, select the audit log entry for that 
change in the audit log table, then view the Device View to see details about that 
change.

To see additional details for an target or device audit log entry, double-click the entry in 
the Target or Device View. For Target, NetScreen-Security Manager displays the 
configuration screen that the change was made in and marks the changed field with a 
solid green triangle. For Devices, NetScreen-Security Manager displays the Job Manager 
information window for the job task.
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Be default, the Audit Log Viewer displays audit log entries in order of time generated by 
Greenwich Mean Time (GMT). To configure the Audit Log Viewer to display log entries for 
events that occurred after a specific time, configure the Log By Time option.

Admin Name/Domain The name of the NetScreen-Security Manager 
administrator who changed the object and the name of 
the domain (Global or Subdomain) that contains the 
changed object. 

Action The type of change applied to the object. For a 
complete list of the actions that Audit Log Viewer tracks, 
see “Audit Log Entry Actions” on page 576.

Target Object Type/Name/Domain

Device Name/Type/Domain

• For changes made to a device configuration or 
object, the Audit Log Viewer display the object type, 
the object name, and the object domain.

• For changes made to the device, the Audit Log 
Viewer displays the device name, the object type, 
and the device domain.

• For changes made to the management system, such 
as administrator login/logout, the Audit Log Viewer 
does not display target or device data.

Log ID The assigned log ID number.
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From the menu bar, select View > Go To Log By Time to display the Log By Time dialog 
box. Select a date and time, then click OK to save and apply the time change to the Audit 
Log Viewer. The audit log table now displays only the audit log entries that were 
generated on or after the date and time you specified.
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The Audit Log records the following administrative actions:

• Add device
• Autodetect device
• Get configuration summary
• Get delta configuration summary
• Update device
• Reboot device
• Import configuration
• Import configuration offline
• Get running configuration summary
• Delete certificate
• Refresh certificate list
• Flash synchronization
• Set root admin
• Failover status
• Failover revert
• Rule validation summary
• Upload fulfilled certificate
• Generate certificate
• Install software key
• DNS refresh
• NTP update
• Generate preshared key
• Modify BGP peer session
• DI attack update
• DI attack check
• Scan manager pattern update
• Get rule validation summary
• Get policy list
• Import vsys device
• Import cluster member
• Delete vsys device
• Get license key info
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• Auto detect vsys
• Policy merge
• Update firmware
• Configuration verification
• Update configuration
• Delete device
• Download running configuration
• User login
• User login denied
• User logout
• Access control denied
• Insert object
• Update object
• Delete object
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Security administrators have different requirements for how many log entries they need 
to keep. Some administrators must keep all log entries as directed by their corporate 
Security Policy, resulting in large numbers of log entries that the administrator might not 
have time to review, but needs to store.

To manage log volume, you can:

• Configuring Active Logs
• Archiving Logs
• Purging Logs
• Exporting Logs
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The Log Viewer can display up to 120 million log entries at one time. When this threshold 
is reached, the Log Viewer automatically removes the oldest day’s log entries from the 
main display area. These removed log entries, known as inactive log entries, are not 
deleted from the logging database on the Device Server; they simply do not appear in the 
Log Viewer. However, inactive log entries can appear in other logging modules, such as 
the Log Investigator or Reports. 

You can configure which day’s log entries are active or inactive in the Log Viewer. From 
the menu bar, click View > Select Active Logs to display the Active Log Days dialog box, 
then select the days you want to be active (or clear the days you want to be inactive). The 
number of log entries for a day appears next to each day’s log; the total number of all 
selected logs appears in the Active Log Count field. If the total log entry count for all days 
is less than 120 million, all days are automatically selected; if the total log entry count is 
more than 120 million, the oldest days are not selected. 

The active log day dialog box is also a good place to quickly see all log entries for a specific 
day or set of days. For large numbers of log entries, instead of setting a filter on the 
timestamp column, use the active log day dialog box to select only the day’s logs you want 
to view. Filtering by day instead of timestamp improves performance and takes less time.

You can configure active logs for any view (predefined or custom).

Note: Excessive logging creates additional traffic on your network. Juniper 
Networks recommends balancing your logging needs with the performance needs of 
your management system.

Note: The keyboard command shortcut for the Active Log dialog box is Ctrl-L
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A security event occurred on your network on the 27th of the month. You want to review 
all log entries that were generated on 3 days that preceded the event. 

1. In the navigation tree, select the Log Viewer module. 
2. From the menu bar, select View > Select Active Logs. The Active Log Days 

dialog box appears.
3. Clear (uncheck) all log days except the 24th, 25th, 26th, and the 27th. Your 

selections look similar to the example below:

4. Click OK to apply the filter. The Log Viewer now displays log entries from the 
selected days only. Additionally, the following message appears in the status bar 
to indicate the you are currently filtering on log days:
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You can archive and retrieve log entries to and from a storage device using standard Unix 
commands. 

Logs reside on the Device Server in the following directory:

/usr/netscreen/DevSvr/var

Juniper Networks recommends using the following commands to archive your logs:

• the tar command
• the scp (Secure Copy) command
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• the ftp (File Transfer Protocol) command

For full descriptions and options for each command, see the man pages.
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The Device Server checks the available disk space every 3 seconds and purges log record 
based on specified thresholds:

• When the available disk space on the Device Server is less than 200 MB, NSM 
generates a warning. To change the minimum amount of free space, edit the 
Storage Manager.MnalFreespace value.

• When the available disk space on the Device Server is less than 100 MB, the 
Device Server begins deleting the oldest traffic log records until 200 MB (or the 
user-specific threshold) of disk space is available. To change this threshold, edit 
the storageManager.threshold value.

• To change the default 3-second interval for checking available disk space, edit 
the statusMonitor.updateInterval.

To change a threshold, edit the threshold value in the NetScreen-Security Manager 
configuration file, located in the Device Server directory: 
\usr\netscreen\devsvr\var. Open the file in a text editor, and adjust the values 
to meet your needs. 
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You can also export log entries for use in other applications. For details on configuring the 
GUI Server to automatically export log entries, see “Configuring the GUI Server for 
Logging” on page 539. 

Note: You do not need to stop the processes on the Device Server before archiving
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• About Reporting

• Report Types

• Setting Report Options

• Log Viewer Integration

• Using Reports

• Using Statistical Reports

Use the Report Manager module in Juniper Networks NetScreen-Security Manager to 
generate and view reports summarizing log and alarms generated by the managed 
Juniper Networks NetScreen FW/VPN devices in your network. You can use these reports 
to track and analyze log incidents, network traffic and potential attacks.
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The Report Manager module in NetScreen-Security Manager is a powerful and easy-to-
use tool that enables you to generate reports summarizing key log and alarm data 
originating from the managed devices in your network. The reports in Report Manager 
provide a useful complement to the monitoring and logging capabilities in NetScreen-
Security Manager enabling you to track and analyze network traffic, activities, and 
potential attacks.

Report Manager contains the following benefits for generating reports:

• Report Type Groupings
• Graphical Data Representation
• Integration with Logs
• Central Access to Management Information
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The reports in Report Manager are grouped together according to the type of data they 
provide. There are four groups of reports:

• FW/VPN. Series of six reports summarizing log and alarm data generated by 
the managed NetScreen FW/VPN devices in your network.

• DI. Includes eight reports that provide data on deep inspection attacks.
• Screen. Includes five reports that provide data on Screen attacks detected by 

the firmware on the managed NetScreen FW/VPN devices in your network.
• Administrative. Includes two reports specifically designed to help system 

administrators track and manage log incidents and security rules.

Administrators and operations staff interested in tracking and analyzing specific types of 
information need to work only within the group of reports that they need. 

For details on each of the specific reports per group, see “Report Types” on page 585.

For details on each report type grouping, refer to the online help.
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Report Manager presents the data in each report in both tabular and graphical form. The 
various depictions of the data make it easier to identify trends. Depending on your 
preference, you can view the data in either a horizontal bar graph or a pie chart.
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Report Manager integrates with the Log Viewer and Log Investigator modules. By simply 
clicking on a data point depicted in a report, you can quickly drill down to access and view 
the specific log entries presented in the report data. Refer to “Log Viewer Integration” on 
page 588 for more information on how you can use reports and log entries together to 
further analyze network events and attacks.
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For network administrators and security analysts interested in tracking and identifying 
potential network trends and attacks, Report Manager provides a single, graphical view 
into the network.
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There are 21 pre-defined reports in the Report Manager module. Each report provides a 
summary of key log events and alarms generated by the FW/VPN devices managed in 
your network. 

For your convenience, Report Manager group reports into the following four categories:

• FW/VPN Reports
• DI Reports
• Screen Reports
• Administrative Reports
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The following table lists and describes reports in NetScreen-Security Manager that 
provide information related to your network’s firewalls and VPNs.
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The following table lists and describes reports in NetScreen-Security Manager that 
provide deep inspection information.

Report Displays...

Top Alarms the total number of alarms generated by the managed FW/VPN 
devices in your network, excluding traffic alarms.

Top Traffic Alarms the total number of traffic alarms generated by the managed FW/VPN 
devices in your network.

Top Traffic Log the total number of traffic log entries generated by the managed FW/
VPN devices in your network, within filter constraints.

Top Configuration Logs the total number of configuration log entries generated by the managed 
FW/VPN devices in your network, within filter constraints.

Top Information Logs the total number of information log entries generated by the managed 
FW/VPN devices in your network, within filter constraints.

Top Self Logs the total number of Self log entries generated by the managed FW/
VPN devices in your network, within filter constraints.

Report Displays...

Top Attacks which attacks are most frequent.

Attacks by Severity the number of attacks by severity level (set in attack objects).

Attacks over Time a summary of when deep inspection attacks occur on your network.

Top Attackers where attacks originate from most frequently.



Chapter 12 Reporting

586 Administrator’s Guide

�������,�"����
When the firmware on your device identifies an attack, it generates a log event.These 
events are totalled and summarized for your review in the following reports.
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The following table lists and describes reports in NetScreen-Security Manager that 
provide information specifically for administrators:

For more specific information describing each report, refer to the online help.

Top Attackers (Action: Drop/
Close)

information about which connections an DI device dropped or 
closed most frequently. 

Top Targets which hosts on your network are the most frequent targets of 
attackers.

Top Targets (Action: Drop/
Close)

the hosts on your network for which a ScreenOS/DI device 
executes the drop or close action for most frequently (these actions 
are set in ScreenOS/DI policy rulebases).

Top Targets (Action: None) which hosts on your network are the most frequent targets of 
hacker attacks but for which the action none-set in a DI policy 
rulebase-was taken.

Report Displays...

Top Attacks the most common attacks detected by the firmware on your FW/VPN 
device.

Attacks by Severity the number of attacks detected by the firmware on your FW/VPN device 
according to severity level.

Attacks over Time a summary of when attacks are detected by the firmware on your FW/VPN 
device.

Top Attackers where attacks originate from most frequently.

Top Targets which hosts on your network are the most frequent targets of attackers for 
firewall attacks.

Report Displays...

Logs by User-set Flag the total number of log entries that were flagged by an administrator in 
the Log Viewer according to the predefined flag type set. You can flag log 
events as either High, Medium, Low, Closed, False Positive, Assigned, 
Investigate, Follow-Up, or Pending. You can use the “Logs by User-set 
Flag” report to quickly identify log events of specific interest.

Top Rules the total number of log entries generated by specific rules in your 
ScreenOS/DI policies. You can use the “Top Rules” report to identify 
those rules that are generating the most log events. This enables you to 
better optimize your rulebases by identifying those rules that are most 
and least effective. You can then modify or remove those rules from your 
Security Policies.



Setting Report Options

NetScreen-Security Manager 2004 FP2 587

����
	������������
�	�
Each report in NetScreen-Security Manager provides information based on data available 
from the current day in a horizontal bar chart by default. You can configure the duration, 
number of data points, and graphical appearance of each report depending upon your 
preference by using the Set Report Options selection in the View menu.

For more specific information describing how to configure reports options, refer to the 
online help.
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You can configure a report to display all available data from either a specific date and 
time or during a specific time interval.

For example, if you had reason to suspect that your network was attacked on September 
11 at 6:00pm, you could set the Starting At field in the Time Period Duration report 
options on a “Top Screen Attacks” report to that time, and generate the report.

If you were not sure of the exact date or time of the attack, but knew it occurred during 
the past 2 days, you could set the Duration field in the Time Period Duration report 
options on a “Top Screen Attacks” report to 2 days, and generate the report.
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Typically, the top fifty occurrences of each data type are displayed in each report. You can 
configure a report to display more or less data points depending upon the level of detail 
you need. For example, if you want to obtain a more precise view of the top occurrences of 
events, you would configure a lower Data Point Count (i.e., 25).
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Each report depicts information in a horizontal bar chart by default. You can also 
configure the report to depict information using a pie chart.

Note: You can also access the Set Report Options dialog by right-clicking on the 
chart on each report.

Note: The data that you can display in each report is limited by the amount of log 
information available.

Note: The minimum data point count that you can configure in all reports is 5; the 
maximum data point count is 200.
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Report Manager uses log data as the basis of all the information presented in each report. 
Because of this, it is recommended that you consider requirements for reporting as you 
decide how many log entries you want to maintain and store.

One key benefit of Report Manager’s tight integration with log entries is the ability to 
quickly access the source log data presented in each report. To view the source log entries 
in the Log Viewer for more detailed information about the report data, simply right-click 
on a data point in any report and select Log Viewer from the View menu. The source log 
entries will appear in the Log Viewer.
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The following examples describe typical use cases for the reports in NetScreen-Security 
Manager.

�'�#!$���%�����&#���%�����(����!���%��������-�����&���%
In this example, firewall administrators are using the Log Viewer to monitor and 
investigate log events. They are specifically interested in configuration changes that are 
causing outages sporadically throughout the network. When they encounter a 
configuration log that seems out of the ordinary, they are flagging the log using the pre-
defined flag type “Investigate”.

After completing their investigation, they change the flag to either “Closed” or “Assigned” 
for further investigation. During normal operations, firewall administrators are 
investigating over 200 log entries per day.

You are a network manager interested in the progress of the investigation. To help track 
the progress, you generate a “Logs by User-set Flag” report.

By setting the duration of the report to 1 week, you can determine the total number of log 
entries flagged for investigation, total closed, and total assigned for further analysis.
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In this example, you are a security administrator responsible for implementing new rules 
to your firewall rulebase. After you have updated the new Security Policy on the managed 
FW/VPN devices in your network, you are interested in knowing the effect of the new 
rules on network traffic.

You configure a “Top Rules” report to start at the same date and time that the new 
rulebase settings were updated in the network. You also set the report data point count to 
100. In this way, you can get an indication for the top 100 rules that are generating log 
events.
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By identifying the new rules that you implemented in the network, you can track how 
effective the new rules are. If you find that a specific rule that is permitting too much 
traffic, you may want to redefine it to be more strict. If you find that a specific rule is not 
generating any log events, you may want to check it again to verify that you configured it 
correctly; perhaps you configured an IP address incorrectly.

Regular review of the “Top Rules” report can help you to update and optimize the 
rulebases implemented in your Security Policies.

�'�#!$���%����34*0 ����!�����������-�)��+����������)/����%
In this example, you are a firewall administrator responsible for configuring all the 
managed FW/VPN devices in your network. You routinely update your network 
configurations after hours. To verify that your changes are taking effect, you routinely 
generate a “Top Configuration Logs” report each night at 1:00am.

During the day, you can generate a similar report to track any unauthorized configuration 
changes to your FW/VPN devices.
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In this example, you are a security administrator in the network operations center 
responsible for tracking potential network attacks. You routinely generate and track an 
“Attacks By Severity” report daily.

Over time, you notice that the number of critical attacks has increased 20%. To verify 
this, you can also generate a “Attacks over Time” report for the past 30 days.

The report indicates a recent increase in attacks as detected by your firewall. You can 
generate “Top Attacks”, “Top Attackers”, and “Top Targets” reports to further investigate 
the nature and assess the risk of these attacks.

For details on generating and configuring these reports, refer to the online help.

�'�#!$���%���������!���%������������!!$�������������-%
In this example, you are a security analyst responsible for tracking potential deep 
inspection attacks. You routinely generate an “Attacks By Severity” report daily to track 
and identify potential attacks.

One day, you notice a significant increase in the number of critical attacks as detected by 
the deep inspection rules you have implemented in your Security Policy. You then 
generate a “Top Attackers” report for the last day.
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The report indicates an IP Address as the top attacker for all the deep inspection attacks 
that you have been tracking. You recognize the IP address as an external server that is 
running a service using a non-standard protocol. Although the traffic is not malicious, it 
happens to match a malicious signature anomaly that you have configured in your deep 
inspection policy. You can then revise your policy rules to reclassify this traffic.

For details on generating and configuring these reports, refer to the online help.
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If you previously used the Historical Report Server to generate statistical reports in 
NetScreen-Global PRO, it is highly recommended that you install the NetScreen-
Statistical Report Server with NetScreen-Security Manager. Refer to the NetScreen-
Statistical Report Server Installer’s Guide and NetScreen-Statistical Report Server 
Administrator’ Guide for more information describing how to install and use the 
NetScreen-Statistical Report Server.

If you do not wish to install NetScreen-Statistical Report Server, you can continue to use 
your existing Historical Report Server as part of your NetScreen-Security Manager 
implementation.

Refer to the NetScreen-Security Manager 2004 FP2 Migration Guide for more information 
on maintaining your previous implementation of Historical Report Server with 
NetScreen-Security Manager. You can also refer to the NetScreen-Global PRO Report 
Manager User’s Guide for more information on how to use historical reports.
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Action (Deep Inspection). A DI action is performed by a NetScreen FW/VPN device when the 
permitted traffic matches the attack object specified in the rule. Deep Inspection actions include 
drop connection, drop packet, close client, etc.

Action (firewall). An firewall action is performed by a NetScreen FW/VPN device when the 
device receives traffic that matches the direction, source, destination, and service. Firewall 
actions include permit or deny.

Activate Device wizard. The Activate Device wizard guides you through activating a modeled 
device in the NetScreen-Security Manager User Interface.

Add Device wizard. The Add Device wizard guides you through importing or modeling a new 
device to the NetScreen-Security Manager User Interface.

Address Object. An address object represents a component of your network, such as a 
workstation, router, switch, subnetwork, or any other object that is connected to your network. 
Use address book objects to specify the network components you want to protect.

Address Spoofing. Address Spoofing is a technique for creating packets with a source IP 
address that is not the actual interface address. Attackers may use spoofed IP address to perform 
DDoS attacks while disguising their true address, or to take advantage of a trusted relationship 
between two hosts. To guard against spoofing attacks, configure a NetScreen FW/VPN device to 
check its own route table. If the IP address is not in the route table, the NetScreen FW/VPN 
device denies the traffic.

Advanced Encryption Standard (AES). AES is a 128-bit encryption key standard. Use AES 
in your VPNs when you need greater interoperability with other network security devices.

APN. Access Point Name. An APN is an IE included in the header of a GTP packet that provides 
information on how to reach a network. It is composed of two elements: a network ID and an 
operator ID.

Atomic Configuration. Atomic configuration is a fail-safe feature in ScreenOS 5.x. For devices 
running ScreenOS 5.x, if the configuration deployment fails for any reason, the device 
automatically uses the last installed stable configuration. Additionally, if the configuration 
deployment succeeds, but the device loses connectivity to the management system, the device 
rolls back to the last installed configuration. This minimizes downtime and ensures that 
NetScreen-Security Manager always maintains a stable connection to the managed device.

Attack Objects. An attack object contains attack patterns for known attacks that attackers can 
use to compromise your network. Use attack objects in your firewall rules to enable your 
NetScreen FW/VPN devices to detect known attacks and prevent malicious traffic from entering 
your network.

Attack Protection. Attack Protection is defined by the attack objects, protection options, attack 
severity, and alerts. 
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Audit Log Target. An Audit Log Target is a directive that was sent to a NetScreen FW/VPN 
device. 

Audit Log Viewer. The Audit Log Viewer is a module of the NetScreen-Security Manager User 
Interface. The Audit Log Viewer records administrative actions. Each audit log includes the date 
and time the administrative action occurred, the NetScreen-Security Manager admin who 
performed the action, and the domain (global or a subdomain) in which the action occurred.

Authentication Header (AH). See ESP/AH.

Authentication Server Objects. An authentication server provides authentication for 
NetScreen-Security Manager administrators and RAS users on your network. Use 
authentication servers objects to set a default authentication server for the global domain and 
each subdomain, or access an external RADIUS or SecurID system to provide authentication. 

Authentication. Authentication ensures that digital data transmissions are delivered to the 
intended receiver. Authentication also assures the receiver of the integrity of the message and its 
source (where or whom it came from). The simplest form of authentication requires a user name 
and password to gain access to a particular account. Authentication protocols can also be based 
on secret-key encryption, such as DES, or on public-key systems using digital signatures.

Bastion Host. A bastion host is a hardened system that is configured with the minimal software 
to support a single network service.

BGP Neighbor. (also known as a BGP Peer). BGP is a the Border Gateway Patrol dynamic 
routing protocol. A BGP neighbor is another device on the network that is running BGP. 

Circuit-level Proxy. Proxy or Proxy Server is a technique used to cache information on a Web 
server and acts as an intermediary between a Web client and that Web server. This proxy holds 
the most commonly and recently used content from the World Wide Web to provide quicker 
access to content for users and to increase server security.

CLI. The CLI is the command line interface.

Configlet. A configlet is a small, static configuration file that contains information on how a 
NetScreen FW/VPN device can connect to NetScreen-Security Manager 2004.

CRC Errors. CRC errors indicate the number of packets generating a cyclic redundancy code 
error processed through the NetScreen FW/VPN device over the selected interface.

Data Encryption Standard (DES). DES is a 40- and 56-bit encryption algorithm developed by 
the National Institute of Standards and Technology (NIST). DES is a block encryption method 
originally developed by IBM. It has since been certified by the U.S. government for transmission 
of any data that is not classified top secret. DES uses an algorithm for private-key encryption.

Data Encryption Standard-Cipher Block Chaining (DES-CBC). DES-CBC is used to 
encrypt single DES keys.

DCF. See device capability file.

Delta. A delta is a difference, or discrepancy. Example: the differences between the configuration 
running on the physical device and the difference between the configuration in NetScreen-
Security Manager are known as deltas.
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De-Militarized Zone (DMZ). A DMZ is an area between two networks that are controlled by 
different companies. A DMZ ethernet can be external or internal; external DMZ ethernets link 
regional networks with routers.

Demo Mode. Demo mode is a demo version of the NetScreen-Security Manager User Interface 
that does not connect to a NetScreen-Security Manager management system. Although demo 
mode uses dummy data, it contains similar functionality as the production version of NetScreen-
Security Manager UI.

Denial of Service (DoS) Attack. A DoS attack is designed to disrupt a network service. 
Typically, an attacker sends a flood of information to overwhelm a service’s system resources, 
causing the server to ignore valid network requests. Other DoS attacks can cause the service 
process to crash.

Device Administrator. A device administrator is the person who uses WebUI or CLI to manage 
a single NetScreen FW/VPN device.

Device Monitor. The Device Monitor displays information about individual devices, their 
configuration and connection status, and memory usage.

Device Server. The Device Server is the component of the NetScreen-Security Manager 
management system that handles communication between the GUI Server and the device, 
collects data from the managed devices on your network, formats configuration information sent 
to your managed device, and consolidates log and event data.

DHCP (Dynamic Host Configuration Protocol). DHCP is used to dynamically assign IP 
addresses to networked computers. 

Directive. A directive is a command send by NetScreen-Security Manager to your managed 
devices. Directives include importing, updating, rebooting, etc. When you send a command to a 
device or group of devices, NetScreen-Security Manager creates a job for that command and 
displays information about that job in the Job Manager.

Distributed Denial of Service (DDoS) Attack. A DoS attack (typically a flood) from multiple 
source points. DDoS attacks This is more effective than a DoS attack, as it is no longer one 
computer against one server in an effort to overwhelm the server.

DM (Data Model). A Data Model is an XML file that contains configuration data for an 
individual device. The DM is stored in the Device Server; when you create, update, or import a 
device, the GUI Server edits the Abstract Data Model (ADM) to reflect the changes, then 
translates that information to the DM.

DNS. The Domain Name System maps domain names to IP addresses.

Domain Menu. The Domain Menu is the pull-down menu above the navigation tree where 
domains and subdomains are selected.

Domains. A domain is a logical grouping of devices, their policies, and their access privileges. A 
domain can contain devices, templates, objects, policies, VPNs, administrators, activities, 
authentication servers, groups—a representation of the all or a subset of the physical devices and 
functionality on your network. The domain above a domain is the parent domain, and the domain 
below a domain is the child domain. Domains at the same level are considered peer domains.
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Encryption. Encryption is the process of changing data into a form that can be read only by the 
intended receiver. To decipher the message, the receiver of the encrypted data must have the 
proper decryption key. In traditional encryption schemes, the sender and the receiver use the 
same key to encrypt and decrypt data. Public-key encryption schemes use two keys: a public key, 
which anyone may use, and a corresponding private key, which is possessed only by the person 
who created it. With this method, anyone may send a message encrypted with the owner’s public 
key, but only the owner has the private key necessary to decrypt it. PGP (Pretty Good Privacy) 
and DES (Data Encryption Standard) are two of the most popular public-key encryption 
schemes.

ESP/AH. AH and ESP are IP level security headers that were originally proposed by the 
Network Working Group focused on IP security mechanisms known as IPSec. The term IPSec 
refers to packets, keys, and routes associated with ESP and AH headers. The IP Authentication 
Header (AH) provides authentication. The IP Encapsulating Security Header (ESP) provides 
confidentiality to IP datagrams.

Ethernet. Ethernet is a local area network (LAN) technology invented at the Xerox Corporation, 
Palo Alto Research Center. Ethernet is a best-effort delivery system that uses CSMA/CD 
technology. Ethernet can be run over a variety of cable schemes, including thick coaxial, thin 
coaxial, twisted pair, and fiber optic cable. Ethernet is a standard for connecting computers into a 
local area network (LAN). The most common form of Ethernet is called 10BaseT, which denotes a 
peak transmission speed of 10 Mbps using copper twisted-pair cable.

Extranet. An extranet connects two or more intranets. If an intranet as a company’s internal 
Web site enables users inside the company to communicate and exchange information, an 
extranet connects that virtual space with another company’s intranet, thus enabling these two 
(or more) companies to share resources and communicate over the Internet in their own virtual 
space. This technology greatly enhances business to business communications.

Filters. A filter organizes log entries based on admin specifications.

Firewall. A firewall device that protects and controls incoming and outgoing traffic on network 
connections. Firewalls protect internal servers from damage (intentional or otherwise) and 
enable authorized external access. 

GGSN. Gateway GPRS Support Node.

Gi interface. The interface between a GSN and an external network or the Internet.

Global Domain. A domain is a logical grouping of devices, their policies, and their access 
privileges. The global domain is the top level, or root domain, that contains all subdomains.

GMT (Greenwich Mean Time). GMT is the Greenwich, England mean solar time. GMT is also 
known as Universal Time and is used for calculating time worldwide.

Gn interface. The interface between two GSNs within the same PLMN.

Gp interface. The interface between two GSNs located in different PLMNs.

G-PDU. A G-PDU is a user data message. It consists of a T-PDU plus a GTP header.

GPRS. General Packet Radio Service. A packet-based technology that enables high-speed 
wireless Internet and other data communications. GPRS provides more than three to four times 
greater speed than conventional GSM systems. Using a packet data service, subscribers are 
always connected and always online so services are easy and quick to access.
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Group Expression Objects. A Group Expression Object represents a statement that sets 
conditions for authentication requirements, enabling you to combine multiple external user 
objects. You can create group expressions using the operator OR, AND, or NOT to combine user 
objects, user group objects, or other group expressions.

Groups. A group organizes previously-created devices into user-defined groups that make it 
easier for you to configure and manage devices in your domain. Groups enable you to execute 
certain NetScreen-Security Manager operations on multiple FW/VPN devices at the same time.

GRX. GPRS Roaming Exchange.

GSM. Global System for Mobile Communications.

GTP Tunnel. A GTP tunnel in the GTP-U plane is defined for each PDP Context in the GSNs. A 
GTP tunnel in the GTP-C plane is defined for all PDP Contexts with the same PDP address and 
APN (for Tunnel Management messages) or for each MS (for messages not related to Tunnel 
Management). A GTP tunnel is identified in each node with a TEID, an IP address and a UDP 
port number. A GTP tunnel is necessary to forward packets between an external network and an 
MS user.

GTP. GPRS Tunneling Protocol.

GTP-C Message. GTP-Control Message. Control plane messages are exchanged between GSN 
pairs in a path. The control plane messages are used to transfer GSN capability information 
between GSN pairs, to create, update and delete GTP tunnels and for path management.

GTP-PDU. A GTP Protocol Data Unit is either a GTP-C message or a GTP-U message.

GTP-U Message. GTP-User Data message. User plane messages are exchanged between GSN 
pairs or GSN/RNC pairs in a path. The user plane messages are used to carry user data packets, 
and signalling messages for path management and error indication.

GUI Server. The GUI Server manages the system resources and data that drives NetScreen-
Security Manager functionality. The GUI Server contains the NetScreen-Security Manager 
databases, and centralizes information for devices, their configurations, attack and server 
objects, and policies.

Hardened System. A hardened system is a secure server with all appropriate security patches 
and bug fixes; these systems are designed to resist penetration.

Hello packet. A Hello packet is a message sent out to the current network to announce the 
presence of the current routing instance to the network. Hello packets aid in the discovery of 
neighbors and in a router being able to connect to other devices on the network.When an OSPF 
interface is created, the interface sends Hello packets to the network to announce itself.

Histogram. A histogram is a vertical graph that represents different amounts by thin, color-
coded bands or bars. These bars represent a frequency distribution; heights of the bars represent 
observed frequencies.

HLR. Home Location Register.

ICMP Flood. An ICMP flood contains ICMP pings so numerous that they overload a system 
with echo requests, causing the system to expend all its resources responding until it can no 
longer process valid network traffic. If you set a threshold to invoke ICMP flood attack protection 
when exceeded, ICMP flood attacks are recorded as statistics.
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IE. Information Element.

IKE Proposal Objects. An IKE proposal is a set of encryption keys and authentication 
algorithms that is used to negotiate a VPN connection. An IKE Proposal Object is a 
representation of an IKE proposal in the NetScreen-Security Manager UI.

IMSI. International Mobile Station Identity.

Internet Control Message Protocol (ICMP). ICMP is a network-layer protocol that does not 
carry user data, but does encapsulate its messages in IP datagrams. ICMP provides a query and 
response system (with error-reporting) used to determine if another system on the network can 
receive and send data. An ICMP echo request is also known as a ping.

Internet Key Exchange (IKE). IKE is a method for exchanging keys for encryption and 
authentication over an unsecured medium, such as the Internet.

Internet Protocol (IP). IP is an Internet standard protocol that defines a basic unit of data 
called a datagram. A datagram is used in a connectionless, best-effort, delivery system. The 
Internet protocol defines how information gets passed between systems across the Internet.

IP Address. Each node on a TCP/IP network usually has an IP address. The IP address has a 
network number portion and a host number portion: Class A, >32,768 nodes, address format: 
nnn.hhh.hhh.hhh); Class B, 256-32,768 nodes, address format: nnn.nnn.hhh.hhh); Class C, <256 
nodes, address format: nnn.nnn.nnn.hhh).This address format is called decimal dot format. The 
\"n\" represents a digit of a network number and \"h\" represents a digit of a host number; for 
example, 128.11.2.30. If you are sending data outside of your network, such as to the Internet, 
you need to obtain the network number from a central authority, currently the Network 
Information Center. See also Subnet Mask.

IP Gateway. Also called a router, an IP gateway is a program or a special-purpose device that 
transfers IP datagrams from one network to another until the final destination is reached.

IP Pool Objects. An IP Pool object represents a range of IP addresses. Use IP Pool object to 
configure a DHCP server for your managed devices.

IP Security (IPSec). IPSec is a security standard maintained by the Internet Engineering Task 
Force (IETF). The IPSec protocol suite provides everything you need for secure 
communications—authentication, integrity, and confidentiality—and makes key exchange 
practical even in larger networks. See also DES-CBC, ESP/AH.

IP Sweep. An IP sweep is similar to a port scan attack. Attackers perform IP sweeps by sending 
ICMP echo requests (or pings) to different destination addresses and wait for replies that 
indicate the IP address of a target. If a remote host pings 10 addresses in 0.3 seconds, the 
NetScreen FW/VPN device flags the event as an IP sweep attack and drops the connection to 
prevent replies.

ISAKMP. The Internet Security Association and Key Management Protocol (ISAKMP) provides 
a framework for Internet key management and provides the specific protocol support for 
negotiation of security attributes. By itself, it does not establish session keys, however it can be 
used with various session key establishment protocols to provide a complete solution to Internet 
key management.

Job Manager. The Job Manager is a module of the NetScreen-Security Manager User Interface. 
Job Manager tracks the progress of the command as it travels to the device and back to the 
management server.
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Land Attack. During a Land Attack, attackers may send spoofed SYN packets that contain the 
IP address of the target as both the destination and source IP address to create an empty 
connection. These connections flood the target system, overwhelming it and causing a denial-of-
service. You can configure NetScreen FW/VPN devices to block Land Attack and record Land 
Attack attempts.

Link State Advertisement (LSA). Link State Advertisements (LSAs) are the conveyance that 
enables OSPF routers to make device, network, and routing information available for the link 
state database. Each router retrieves information from the LSAs sent by other routers on the 
network to construct a picture of the entire internetwork from which they distill path 
information to use in the routing table.

Load Balancing. Load balancing distributes workload to processors to improve the throughput 
of a concurrent connections.

Lockout. Lockout is an object state during which the object cannot be edited.

Log Category. A log category defines the log type (alarm, config, traffic, etc.). 

Log ID. A log ID is a unique ID for the log entry, derived from the combination of the date and 
log number.

Log Investigator. The Log Investigator is a module of the NetScreen-Security Manager User 
Interface. The Log Investigator contains tools for analyzing your log entries in depth. Use the Log 
Investigator to manipulate and change constraints on log information, correlate log entries 
visually and rapidly, and filter log entries while maintaining the broader picture.

Log Viewer. The Log Viewer is a module of the NetScreen-Security Manager User Interface. 
The Log Viewer displays log entries that your NetScreen firewalls generate based on criteria that 
you defined in your Security Policies, on the Device Server, and in the device configuration. Logs 
appear in table format; each row contains a single log, and each column defines specific 
information for a log. 

Log. A Log is a grouping of log entries.

Main Display Area. The main display area displays the content for the currently selected 
module or module contents. 

Management System. The management system includes the GUI Server and Device Server. 
You can deploy the GUI Server and Device Server on separate servers; however, the combination 
of the two servers is known as the management system.

Management System. The Management System is the Windows or Solaris server that a GUI 
Server and Device Server is installed on.

MCC. Mobile Country Code.

MD5. Message Digest (version) 5 is an algorithm that produces a 128-bit message digest (or 
hash) from a message of arbitrary length. The resulting hash is used to verify authenticity.

Menu bar. The menu bar is the upper section of the NetScreen-Security Manager UI. The menu 
bar contains accessible commands.

MNC. Mobile Network Code.

Modeling. Modeling is the process of creating a non-deployed device configuration in the 
NetScreen-Security Manager UI.
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Modules. A module is a first-level element in the NetScreen-Security Manager navigation tree.

MS. Mobile Station.

MSIN. Mobile Subscriber Identification Number.

NAT Object. A NAT Object is a global object that contains references to device-specific NAT 
configurations, enabling multiple devices to share a single object. Use the Device Manager to 
configure NAT for each device, then create a global NAT object that includes the device-specific 
NAT configuration. Use global NAT objects in Security Policies and VPNs; when you update a 
device, that device automatically replaces the global NAT object with its device-specific NAT 
configuration.

Navigation Tree. The navigation tree displays the 11 NetScreen-Security Manager modules in 
the left pane of the NetScreen-Security Manager window. 

NetScreen FW/VPN Device. A NetScreen FW/VPN is a NetScreen-produced device that you 
use to enable access to your network components and to protect your network against malicious 
traffic. NetScreen-Security Manager can manage NetScreen FW/VPN devices running ScreenOS 
5.x and ScreenOs 4.0.x (except 4.0.2). All devices from NetScreen-5XT to the NetScreen-5400 are 
supported, except the NetScreen-5, NetScreen-10, and NetScreen-1000. NetScreen-Security 
Manager also supports the NetScreen-5GT running ScreenOS 4.0-DIAL2. NetScreen-Security 
Manager can also manage vsys configurations, NSRP clusters, and extranet devices.

NetScreen Redundancy Protocol (NSRP). NRSP is a proprietary protocol that provides 
configuration and run time object (RTO) redundancy and a device failover mechanism for 
NetScreen FW/VPN devices in a high availability (HA) cluster.

NetScreen-Security Manager admin(istrator). The NetScreen-Security Manager admin is 
the person who uses NetScreen-Security Manager User Interface to manage their FW/VPN 
devices.

Network Address Translation (NAT). NAT is a standard for translating secure IP addresses 
to temporary, external, registered IP address from the address pool. NAT enables trusted 
networks with privately assigned IP addresses to access the Internet, eliminating the need to use 
a registered IP address for every machine in your network.

NSAPI. Network Service Access Point Identifier.

NSGP. NetScreen Gatekeeper Protocol.

Object Manager. The Object Manager is a module of the NetScreen-Security Manager User 
Interface. The Object Manager contains the Objects used in your NetScreen-Security Manager 
system. An object is a re-usable, basic NetScreen-Security Manager building block that contains 
specific information; you use objects to create device configurations, policies, and VPNs. All 
objects are shared, meaning that they can be shared by all devices and policies in the domain.

Object. Objects represent reusable information, such as network addresses, individual users and 
user groups, and commonly used configuration data. In NetScreen-Security Manager, objects are 
shared objects, meaning they are shared between the global domain and all subdomains. Objects 
are the building blocks of the NetScreen-Security Manager management system.

On-Site Admin. The on-site admin is the person who installs a configlet using Rapid 
Deployment. 
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Packet Filtering. Packet filtering is a router/firewall process that uses access control lists 
(ACL) to restrict flow of information based on protocol characteristics such as source/destination 
IP address, protocol, or port used. Generally, packet-filtering routers do not track sessions except 
when doing NAT (which tracks the session for NAT purposes).

PDP Context. A user session on a GPRS network.

PDP. Packet Data Protocol. 

PDU. Protocol Data Unit.

Ping of Death. The ping of death is an intentionally oversized or irregular ICMP packet that 
can trigger a Denial of Service condition, freezing, or other adverse system reactions. You can 
configure a NetScreen FW/VPN device to detect and reject oversized or irregular packet sizes.

PLMN. Public Land Mobile Network. A public network dedicated to the operation of mobile radio 
communications.

Security Policies. Security Policies is a module of the NetScreen-Security Manager User 
Interface. You can use Security Policies to configure firewall and VPN policies for your managed 
devices.

Policy. A Security Policy is the combination of both firewall rulebases and all rules into a 
comprehensive plan that defines how the NetScreen FW/VPN device works on your network.

Port Scan. A port scan attack occurs when packets are sent out to different port numbers, for 
the purpose of scanning the available services in hopes that one port will respond. If a remote 
host scans 10 ports in 0.3 seconds, the NetScreen FW/VPN device flags this as a port scan attack 
and drops the connection.

Process Status. The process status displays information about processes on a NetScreen FW/
VPN device.

Protocol. Protocols are predefined services (HTTP, SNMP, Telnet, etc.) that are enabled for the 
NetScreen FW/VPN device.

PT. Protocol Type.

RADIUS. Remote Authentication Dial-In User Service is a service for authenticating and 
authorizing remote access service (RAS) users.

RAS (remote access services). RAS is the acronym for remote access services, which enable 
users to access services protected by your NetScreen FW/VPN devices. Typically, you use a VPN 
to enable RAS, then add RAS users to the VPN.

Realtime Monitor. The Realtime Monitor is a module of NetScreen-Security Manager User 
Interface. It contains the Device Monitor, the VPN Monitor, and the NSRP Monitor.

Receive Collisions. The number of collisions on the line detected by the Carrier Sense Multiple 
Access Collision Detection (CSMA/CD) protocol.

Remote Setting Objects. A Remote Settings object defines the DNS and WINS servers that are 
assigned to L2TP RAS users after they have connected to the L2TP tunnel.
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Report Manager. Report Manager is a module of the NetScreen-Security Manager User 
Interface. Use Report Manager to generate and view reports summarizing log and alarm 
originating from the managed FW/VPN devices in your network. You can use these reports to 
track and analyze log incidents, network traffic and potential attacks.

Role-Based Administration (RBA). Role-based administration enables you to define strategic 
roles for your administrators and create domains to organize your network devices. Use role-
based administration to create a security environment that reflects your current offline 
administrator roles and responsibilities.

Route Redistribution. Router redistribution is the exporting of route rules from one virtual 
router to another.

Rule. A rule is a statement that defines a specific type of network traffic. When traffic passes 
through the FW/VPN device, the device attempts to match that traffic against its list of rules. If a 
rule is matched, the device performs the action defined in the rule against the matching traffic.

Rulebase. A rulebase contains rules. a rulebase provides a method of detecting and acting upon 
suspicious traffic. In NetScreen-Security Manager, there are two Security Policy rulebases: zone-
specific and global.

Schedule Object. A schedule object defines a time interval that a firewall rule is in effect. You 
use a schedule object in your firewall rule to determine when a device enforces that rule.

Secure Server Protocol (SSP). For communication between the UI, the GUI Server, and the 
Device Server, NetScreen-Security Manager uses SSP, a modified version of TCP that is more 
reliable than ordinary TCP, requires less CPU and memory resources from servers, and reduces 
the number of acknowledgement packets on the network. SSP uses AES encryption and SH1 
authentication for all connections.

Security Association. The security association combines the Security Parameters Index and a 
destination address. Required for both Authentication Header and Encapsulating Security 
Payload protocols. See also Security Parameters Index.

Security Parameters Index (SPI). The SPI is a hexadecimal value which uniquely identifies 
each tunnel. It also tells the NetScreen FW/VPN device which key to use to decrypt packets.

Security Policies. A Security Policy defines access to your network, including permitted 
services, users, and time periods. Use Security Policies to control the shape of your network 
traffic as it passes through the firewall, or log specific network events.

Security Zone. A security zone is a collection of one or more network segments requiring the 
regulation of inbound and outbound traffic via access policies.

Server Manager. The Server Manager is a module of the NetScreen-Security Manager User 
Interface. Server Manager contains server objects that represent your management system 
components. Use Server Manager to manage and monitor the individual server processes that 
comprise your NetScreen-Security Manager system.

Service Object. Service objects represent the IP traffic types for existing protocol standards. 
NetScreen FW/VPN devices monitor and manage network traffic using these protocols. 
NetScreen-Security Manager includes predefined service objects for most standard services. You 
can also create custom service objects to represent services that are not included in the list of 
predefined service objects, or to represent a custom service running on your network.
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SGSN. Serving GPRS Support Node.

SHA-1. Secure Hash Algorithm-1, an algorithm that produces a 160-bit hash from a message of 
arbitrary length. SHA-1 is generally regarded as more secure than MD5 because of the larger 
hashes it produces.

Shared Objects. A shared object is an object that can be shared across domains.

Short Frame. A short frame contains less than 64 bytes of data.

Signalling Message. Any GTP-PDU except the G-PDU. GTP signalling messages are 
exchanged between GSN pairs in a path. The signalling messages are used to transfer GSN 
capability information between GSN pairs and to create, update and delete GTP tunnels.

Source Route. The source route is a option in the IP header. An attacker can use the source 
route option to enter a network with a false IP address and have data sent back to the attacker’s 
real address.

Stateful Inspection. A firewall process that checks the TCP header for information on the 
session’s state. The process checks whether it is initializing (SYN), ongoing (SYN/ACK), or 
terminating (FIN). A stateful inspection firewall tracks each session flowing through it, dropping 
packets from unknown sessions that appear to be part of an ongoing or illegal sessions. All 
NetScreen network security devices are stateful inspectors.

Status Bar. The status bar is the lower section of the NetScreen-Security Manager UI. The 
status bar displays supplemental information.

Subdomain. A subdomain is a domains under the global domain.

Subinterface. A subinterface is a logical division of a physical interface that borrows the 
bandwidth it needs from the physical interface from which it stems. A subinterface is an 
abstraction that functions identically to an interface for a physically present port and is 
distinguished by 802.1Q VLAN tagging.

Subnet Mask. A subnet mask enables you to define subnetworks. For example, if you have a 
class B network, a subnet mask of 255.255.255.0 specifies that the first two portions of the 
decimal dot format are the network number, while the third portion is a subnet number. The 
fourth portion is the host number. If you do not want to have a subnet on a class B network, you 
would use a subnet mask of 255.255.0.0. A network can be subnetted into one or more physical 
networks which form a subset of the main network. The Subnet Mask is the part of the IP 
address which is used to represent a subnetwork within a network. Using Subnet Masks enables 
you to use network address space which is normally unavailable and ensures that network traffic 
does not get sent to the whole network unless intended. See also IP address.

Super Admin(istrator). The super administrator is the default administrator for all domains. 
The superadmin has immutable powers. You cannot change or delete permissions for the super 
administrator; you can, however, change the password for the super admin. 

SYN Attack. A SYN attack occurs when SYN packets overwhelm a network by initiating so 
many connection attempts or information requests that the network can no longer process 
legitimate connection requests, resulting in a Denial of Service.

Tear Drop Attack. A Tear Drop Attack occurs when the first and second parts of a fragmented 
packet overlap, the server attempting to reassemble the packet can crash. If the NetScreen FW/
VPN device sees this discrepancy in a fragmented packet, it drops the packet.
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TEID. Tunnel Endpoint Identifier. The TEID uniquely identifies a tunnel endpoint in the 
receiving GTP-U or GTP-C protocol entity. The receiving end side of a GTP tunnel locally assigns 
the TEID value the transmitting side has to use. The TEID values are exchanged between tunnel 
endpoints using GTP-C messages.

Templates. A template is a device configuration that you can define once and then use for 
multiple devices. You can specify most device configuration values in a template. In a template, 
you can define only those configuration parameters that you want to set; you do not need to 
specify a complete device configuration.

TID.Tunnel Identifier. 

Toolbar. The toolbar is the upper section of the NetScreen-Security Manager UI. The toolbar 
contains icons that relate to accessible commands.

T-PDU. A T-PDU is the payload that is tunnelled in the GTP tunnel.

Transmission Control Protocol/Internet Protocol (TCP/IP). A set of communications 
protocols that support peer-to-peer connectivity functions for both local and wide area networks. 
A communications protocol which enables computers with different operating systems to 
communicate with each other. Controls how data is transferred between computers on the 
Internet.

Triple DES (3DES). 3DES is a more powerful version of DES in which the original DES 
algorithm is applied in three rounds, using a 168-bit key. DES provides a significant performance 
savings but is considered unacceptable for many classified or sensitive material transfers.

Trojan. A trojan is a program with hidden functionality. Trojans often install a remote 
administration program (known as a backdoor) that enables attackers to access the target 
system.

Trunk Port. A trunk port enables a switch to bundle traffic from several VLANs through a 
single physical port, sorting the various packets by the VLAN identifier (VID) in their frame 
headers.

Tunnel Interface. A tunnel interface is the opening, or doorway, through which traffic to or 
from a VPN tunnel passes. A tunnel interface can be numbered (that is, assigned an IP address) 
or unnumbered. A numbered tunnel interface can be in either a tunnel zone or security zone. An 
unnumbered tunnel interface can only be in a security zone that contains at least one security 
zone interface. The unnumbered tunnel interface borrows the IP address from the security zone 
interface.

Tunnel Zone. A tunnel zone is a logical segment that hosts one or more tunnel interfaces. A 
tunnel zone is associated with a security zone that acts as its carrier.

UDP Flood. A UDP flood is an attack using multiple UDP packets. An attacker can send UDP 
packets to slow the target system to the point that it can no longer handle valid connections. You 
can configure the NetScreen FW/VPN device with a threshold to invoke UDP flood attack 
protection; when UDP packet flow exceeds this threshold, the device records the UDP flood 
attack as a statistics.
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Universal Resource Locator (URL). A URL is a standard method of specifying the location of 
an available electronic resource. Also known as a location or address, a URL specifies the location 
of files on servers. A general URL has the syntax protocol://address. For example, http://
www.srl.rmit.edu.au/pd/index.html specifies that the protocol is http and the address is 
www.srl.rmit.edu.au/pd/index.html.

User Datagram Protocol (UDP). UDP is a protocol in the TCP/IP protocol suite that enables 
an application program to send datagrams to other application programs on a remote machine. 
UDP provides an unreliable and connectionless datagram service and does not guarantee 
delivery or duplicate detection; it does not use acknowledgments, or control the order of arrival.

User Interface (UI). The NetScreen-Security Manager graphical User Interface (UI) is used to 
control the NetScreen-Security Manager system. Using the UI, you can configure NetScreen-
Security Manager administrators, add devices, edit policies, view reports, etc.

User Object. User objects represent the users of your managed devices. You can include user 
objects or groups in Security Policies or VPNs to permit or deny access to individuals or groups.

User. A user is a person using the network your NetScreen FW/VPN devices are protecting. 
NetScreen-Security Manager support two types of users: local users and external users.

View. A view is an admin-defined subset of column settings and filters in the Log Viewer.

Virtual IP Address. A VIP address maps traffic received at one IP address to another address 
based on the destination port number in the packet header.

Virtual Local Area Network (VLAN). A VLAN is a logical rather than physical grouping of 
devices that constitute a single broadcast domain. VLAN members are not identified by their 
location on a physical subnetwork but through the use of tags in the frame headers of their 
transmitted data. VLANs are described in the IEEE 802.1Q standard.

Virtual Private Network (VPN). A VPN is an easy, cost-effective and secure way for 
corporations to provide telecommuters and mobile professionals local dial-up access to their 
corporate network or to another Internet Service Provider (ISP). Secure private connections over 
the Internet are more cost-effective than dedicated private lines. VPNs are possible because of 
technologies and standards such as tunneling, screening, encryption, and IPSec.

Virtual Router (VR). A virtual router is the component of ScreenOS that performs routing 
functions. By default, a NetScreen FW/VPN device supports two virtual routers: Untrust-VR and 
Trust-VR.

Virtual Security Device (VSD). A VSD is a single logical device composed by a set of physical 
NetScreen FW/VPN devices.

Virtual Security Interface (VSI). A VSI is a logical entity at layer 3 that is linked to multiple 
layer 2 physical interfaces in a VSD group. The VSI binds to the physical interface of the device 
acting as master of the VSD group. The VSI shifts to the physical interface of another device in 
the VSD group if there is a failover and it becomes the new master.

Virtual System (vsys). A virtual system is a subdivision of the main system that appears to the 
user to be a stand-alone entity. Virtual Systems reside separately from each other. Each one can 
be managed by its own Virtual System Administrator.
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VPN Manager. VPN Manager is a module of the NetScreen-Security Manager User Interface. 
Use VPN Manager to design a system level VPN and automatically set up all connections, 
tunnels, and rules for all devices in the VPN.

Windows Internet Naming Service (WINS). WINS is a service for mapping IP addresses to 
NetBIOS computer names on Windows NT server-based networks. A WINS server maps a 
NetBIOS name used in a Windows network environment to an IP address used on an IP-based 
network.

WinNuke Attack. A WinNuke attack can crash any computer on the Internet running Windows 
by introducing a NetBIOS anomaly that forces Windows to restart. You can configure the 
NetScreen FW/VPN device to scan any incoming Microsoft NetBIOS Session Service packets, 
modify them, and record the event as a WinNuke attack.

Worm. A worm is a self-replicating attack program. Worms differ from typical viruses in that 
they are completely automatic—no attacker interaction is required. When the worm locates a 
vulnerable target, it immediately and automatically infects the new host with its malicious code. 
The newly infected host repeats the process and attempts to infect more hosts.

Zone. A zone can be a segment of network space to which security measures are applied (a 
security zone), a logical segment to which a VPN tunnel interface is bound (a tunnel zone), or 
either a physical or logical entity that performs a specific function (a function zone).
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Juniper-Networks NetScreen-Security Manager is designed for system-level 
management, enabling multiple administrators to manage their devices from one central 
location using the majority of CLI commands available in ScreenOS. However, a small 
number of device commands are unmanaged from the Juniper Networks NetScreen-
Security Manager UI.

Most unmanaged commands are useful only when performing device administration on a 
specific device, and do not affect management capabilities (although future versions of 
NetScreen-Security Manager may support these commands). To use an unmanaged 
device command, you must connect locally to the Juniper Networks NetScreen FW/VPN 
device.

The table below details each unmanaged command:

Command Description

common-criteria This command disable all internal commands. Only the root 
admin can set this command. If someone other than the root 
admin tries to set this command, the NetScreen FW/VPN 
device displays an error message.

envar These commands define environment variables. NetScreen 
FW/VPN devices use environment variables to make special 
configurations at startup.

gate This command checks the number of gates on a NetScreen 
FW/VPN device, how many are in use, and how many are 
still available. Gates are logical access points in the firewall 
for FTP and similar applications. NetScreen FW/VPN devices 
create the gates, then convert a gate for each new session 
when data traffic occurs.

ike These commands define the Phase 1 and Phase 2 proposals 
and the gateway for an AutoKey IKE (Internet Key Exchange) 
VPN tunnel, and specify other IKE parameters.

intervlan-traffic These commands configure inter-VLAN traffic through a 
NetScreen FW/VPN device. It is possible to configure a 
virtual system (vsys) with two trusted interfaces, such that 
traffic can enter the vsys through one interface and exit 
through the other without undergoing any security services 
such as authentication or encryption. This is known as inter-
VLAN traffic.

set log audit-loss-
mitigation

This command configures logging to mitigate message loss 
due to memory limitations on a NetScreen FW/VPN device. 
Used for common criteria only.

set mac This command configures a static Media Access Control 
(MAC) address for a NetScreen FW/VPN device interface.
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timer These commands display timer settings, or configure a 
NetScreen FW/VPN device to automatically execute 
management or diagnosis at a specified time. All timer 
settings remain in the configuration script after the specified 
time has expired.

user These commands create, remove, or display entries in the 
internal user authentication database.

Command Description
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This appendix lists the log entry subcategories for the following log entry categories:

• Screen Alarm Log Entries
• Alarm Log Entries
• Deep Inspection Alarm Log Entries
• Configuration Log Entries
• Information Log Entries
• Self Log Entries
• Traffic Log Entries

Additionally, you can also view the information provided for Basic and Extended GTP Log 
Entries.
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The Screen category contains the following subcategories:

Attack ScreenOS Message ID

Address Sweep Attack Attacks > Alert > 00017

Block ActiveX component Attacks > Critical > 00434

Block EXE component Attacks > Critical > 00433

Block IP fragment traffic Attacks > Critical > 00429

Block JAVA component Attacks > Critical > 00432

Block ZIP component Attacks > Critical > 00431

Destination IP session limit Attacks > Critical > 00430

ICMP Flood Attack Attacks > Alert > 00011

IDS ICMP Fragment Attacks > Critical > 00422

IDS ICMP too large Attacks > Critical > 00436

IDS IP Bad Options Attacks > Critical > 00415

IDS IP unknown port Attacks > Critical > 00414

IDS SYN Fragment Attacks > Critical > 00412

IDS TCP FIN No ACK Attacks > Critical > 00438

IDS TCP SYN FIN Attacks > Critical > 00437

IDS TCP No Flag Attacks > Critical > 00413

IP Source Route Attack Attacks > Alert > 00009

IP Spoof Attack Attacks > Alert > 00008

Land Attack Attacks > Alert > 00010

Malicious URL Protection Attacks > Critical > 00032

Multiple Authentications Failed Auth > Alert > 00003

Ping of Death Attack Attacks > Emergency > 00007

Policy Denied Policies > Alert > 00018

Port Scan Attack Attacks > Alert > 00016

SYN Attack
SYN Flood
SYN ACK
SYN MAC

Attacks > Emergency > 00005

SYN-ACK-ACK proxy DoS Attacks > Critical > 00439

Source IP session limit Attacks > Critical > 00033

Tear Drop Attack Attacks > Emergency > 00006
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UDP Flood Attack Attacks > Alert > 00012

VPN Replay Detected IKE > Critical > 00042

Winnuke Attack Attack > Alert > 00004
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The Alarm category contains the following subcategories:

Alarm Log Entry Subcategories ScreenOS Message ID

Admin Admin > Alert > 00027

Anti Virus - CSP AntiVirus Scanning (External) > Error > 52

BGP Alarm BGP > Alert > 00206

CPU Usage High Logging > Critical > 00030

DHCP DHCP > Alert > 00029
DHCP > Critical > 00029

DNS Host DNS > Critical > 00021

Interface Failover Interface > Critical > 00090

Hardware Device > Critical > 00022

IP Conflict ARP > Critical > 00031

Log Overflow Logging > Critical > 00024

Memory Low Device > Critical > 00020
Logging > Critical > 00020

NSRP Inconsistent Config High Availability > 00015

NSRP IP DUP Master High Availability > 00015

NSRP RTO DOWN High Availability > 00015

NSRP RTO Duplicate High Availability > 00015

NSRP RTO UP High Availability > 00015

NSRP Status High Availability > Critical > 00015

NSRP TRACKIP Failed High Availability > 00062

NSRP TRACKIP Failover High Availability > 00062

NSRP VSD 2nd Path Reply High Availability > Critical > 00077

NSRP VSD 2nd Path REQ High Availability > Critical > 00076

NSRP VSD Backup High Availability > Critical > 00073

NSRP VSD Ineligible High Availability > Critical > 00074

NSRP VSD Init High Availability > Critical > 00070

NSRP VSD Inoperable High Availability > Critical > 00075

NSRP VSD Master High Availability > Critical > 00071

NSRP VSD Pbackup High Availability > Critical > 00072

OSPF Packet Flood OSPF > Critical > 00206

RIP Packet Flood RIP > Critical > 207
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Route add/delete Error OSPF > Critical > 200

Route RIP Updated Flood RIP > Critical > 00207

Exceeded Route Entry (Sys) Route > Critical > 00200 

Secure Shell SSH > Critical > 00034

URL Blk URL Filtering > Alert > 00014

VIP Svr Down VIP > Critical > 00023

VPN IKE > Alert > 00026

VPN Down VPN > Critical > 00041

VPN Up VPN > Critical > 00040

Alarm Log Entry Subcategories ScreenOS Message ID
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The Deep Inspection Alarm category contains the following subcategories:

Deep Inspection Alarm Subcategory Description

DNS:EXPLOIT:EMPTY-UDP-MSG This protocol anomaly is an empty DNS UDP 
message. This may indicate an exploit attempt.

DNS:EXPLOIT:EXPLOIT-BIND9-RT This protocol anomaly is an rdataset parameter to 
the dns_message_findtype() function in message.c 
that is not NULL. In BIND 9 (up to 9.2.0), attackers 
may cause a shutdown on an assertion failure. 
Note: Common queries in routine operations (such 
as SMTP queries) may trigger this anomaly.

DNS:EXPLOIT:POINTER-LOOP This protocol anomaly is a DNS message with a set 
of DNS pointers that form a loop. This may indicate 
a denial-of-service (DoS) attempt.

DNS:EXPLOIT:TYPE-AXFR This protocol anomaly is a zone transfer attempt. 
This may indicate an attempt to obtain information 
about an entire domain.

DNS:HEADERERROR:INVALID-OPCODE This protocol anomaly is a DNS request/reply with 
an invalid value in the header OPCODE field. This 
may indicate an exploit attempt.

DNS:OVERFLOW:BIN This signature detects attempts to create buffer 
overflows. Attackers may send maliciously crafted 
packets to DNS servers to overflow the buffer and 
gain root access.

DNS:OVERFLOW:INVALID-LABEL-LEN This protocol anomaly is a DNS request/reply with a 
label that exceeds the maximum length (63) 
specified in the RFC. This may indicate a buffer 
overflow attempt.

DNS:OVERFLOW:INVALID-POINTER This protocol anomaly is a DNS request/reply with a 
pointer that points beyond the end of the data. This 
may indicate a buffer overflow or denial-of-service 
(DoS) attempt.

DNS:OVERFLOW:NAME-TOO-LONG This protocol anomaly is a DNS name that exceeds 
255 characters. This may cause problems for some 
DNS servers.

DOS:NETDEV:CISCO-HTTPD-DOS This signature detects attempts to exploit a 
vulnerability in Cisco IOS. Versions prior to 11.0, 
11.2.8SA1, 12.1(1a)T1, and 12.1(1.3)T are 
susceptible. Attackers may remotely request URLs 
containing the %% string from the IP HTTP server, 
causing the router to crash/reboot/power cycle.
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DOS:NETDEV:NETWORK-3COM-DOS This signature detects attempts to exploit a firmware 
vulnerability in the 3COM OfficeConnect 812 and 
840 DSL/ADSL routers. OCR812 versions 1.1.9 and 
earlier are susceptible. Attackers may remotely 
request long strings from the HTTP daemon, 
making the router reboot/power cycle and creating a 
denial-of-service (DoS).

FTP:COMMAND:PLATFTP-CD-DOS This signature detects attempts to exploit a 
vulnerability in PlatinumFTP. Attackers may submit 
a maliciously crafted pathname in a CD request to 
crash the FTP daemon. PlatinumFTP 1.0.6 and 
earlier versions are vulnerable.

FTP:COMMAND:SITE-EXEC This signature detects attempts to exploit a 
configuration vulnerability in wuFTPd. Version 2.4.1 
is susceptible. pathnames.h sets 
_PATH_EXECPATH to /bin, which is relative to ~ftp 
for anonymous users, but relative to / for users with 
accounts (specifying the actual /bin rather than ~ftp/
bin). Attackers may establish an FTP account on the 
system and run the site exec command to gain 
access to the /bin directory.

FTP:EXPLOIT:BOUNCE-ATTACK This protocol anomaly is an FTP bounce attack. 
There are two possibilities: a PORT command 
specified an IP address different from the client 
address, or a PASV command resulted in a 227 
message with an IP address different than the 
server.

FTP:EXPLOIT:ILLEGAL-PORT This protocol anomaly is an FTP PORT command/
response to a PASV command (&quot;227...&quot;) 
that specifies a reserved port number. This may 
indicate an attempt to make IDP or firewall open 
reserved ports.

FTP:EXPLOIT:SYNTAX-ERROR This protocol anomaly is a syntax error in an FTP 
command/response, such as a malformed PORT 
command or 227 response. This may indicate an 
exploit attempt.

FTP:MS-FTP:ASTERISK This signature detects denial-of-service (DoS) 
attempts against Microsoft FTP Service in Microsoft 
IIS 4.0 and 5.0. Attackers who have previously 
established an FTP session may send glob 
characters within a maliciously crafted NLST 
request to crash the server.

FTP:MS-FTP:STAT-GLOB This signature detects denial-of-service (DoS) 
attempts against Microsoft FTP Service in Microsoft 
IIS 4.0 and 5.0. Attackers who have previously 
established an FTP session may send glob 
characters within a maliciously crafted status 
request to crash the server.

Deep Inspection Alarm Subcategory Description
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FTP:OVERFLOW:BSD-FTPD-MKD-OF This signature detects buffer overflow attempts 
against the FTPD that ships with early versions of 
FreeBSD 4.x and OpenBSD 2.8. FTPD 6.00LS and 
6.5/OpenBSD versions are vulnerable. Attackers 
may gain local host access and root permissions.

FTP:OVERFLOW:FREEBSD-FTPD-GLOB This signature detects an attempt by a malicious 
user to exploit a buffer overflow condition in the 
FreeBSD FTP daemon by submitting a malicious 
STAT request containing file globbing characters. 
Successful exploitation of this vulnerability may 
permit an attacker to execute arbitrary code on the 
victim host with administrator privileges. This 
signature detects an exploit against FreeBSD-4.2.

FTP:OVERFLOW:LINE_TOO_LONG This protocol anomaly is an incoming FTP line that 
is too long. This may indicate an attempt to overflow 
the server. You can set the length threshold for FTP 
lines in the Sensor Settings Rulebase-Protocol 
Thresholds-FTP.

FTP:OVERFLOW:OPENBSD-X86 This signature detects buffer overflow attempts 
against ftpd in OpenBSD. OpenBSD versions 2.7 
and 2.8, FTP code revisions 1.49 to 1.79 are 
vulnerable. Attackers with write access may exploit 
the replydirname() function in BSD-based ftpd 
daemons to gain root access.

FTP:OVERFLOW:PASS_TOO_LONG This protocol anomaly is an FTP client password 
that exceeds the length threshold. This may indicate 
a malicious FTP client attempting to overflow the 
server. You can set the length threshold for 
passwords in the Sensor Settings Rulebase-
Protocol Thresholds-FTP.

FTP:OVERFLOW:PATH-LINUX-X86-1 This signature detects attempts to exploit a realpath 
vulnerability in ProFTPD and wuFTPd running on 
LINUX. Versions ProFTPD 1.2pre1 and earlier and 
wuFTPd 2.4.2 (beta 18) VR9 and earlier are 
susceptible. Attackers may gain write access, 
remotely create long pathnames, and overflow the 
buffer to gain root access.

FTP:OVERFLOW:PATH-LINUX-X86-2 This signature detects attempts to exploit a realpath 
vulnerability in ProFTPD and wuFTPd running on 
LINUX. Versions ProFTPD 1.2pre1 and earlier and 
wuFTPd 2.4.2 (beta 18) VR9 and earlier are 
susceptible. Attackers may gain write access, 
remotely create long pathnames, and overflow the 
buffer to gain root access.

Deep Inspection Alarm Subcategory Description
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FTP:OVERFLOW:PATH-LINUX-X86-3 This signature detects attempts to exploit a realpath 
vulnerability in ProFTPD and wuFTPd running on 
LINUX. Versions ProFTPD 1.2pre1 and earlier and 
wuFTPd 2.4.2 (beta 18) VR9 and earlier are 
susceptible. Attackers may gain write access, 
remotely create long pathnames, and overflow the 
buffer to gain root access.

FTP:OVERFLOW:PATH-TOO-LONG This protocol anomaly is a pathname in an FTP 
command (RETR, STOR, APPE, SMNT, RNFR, 
RNTO, DELE, RMD, MKD, STAT, CWD, LIST, 
NLST) that exceeds the length threshold. This may 
be an attempt to overflow the server. You can set 
the length threshold for pathnames in the Sensor 
Settings Rulebase-Protocol Thresholds-FTP.

FTP:OVERFLOW:SITESTRING-2-LONG This protocol anomaly is an argument in the FTP 
SITE command that exceeds the length threshold. 
This may be an attempt to overflow the server. You 
can set the length threshold in the Sensor Settings 
Rulebase-Protocol Thresholds-FTP.

FTP:OVERFLOW:USERNAME-2-LONG This protocol anomaly is a username in an FTP 
connection that exceeds the length threshold. This 
may be an attempt to overflow the server. You can 
set the length threshold in the Sensor Settings 
Rulebase-Protocol Thresholds-FTP.

FTP:OVERFLOW:WFTPD-MKD-
OVERFLOW

This signature detects buffer overflow attempts 
against the MKD command in Wftpd server 2.34. 
Attackers may use MKD and CWD commands to 
create nested directories and execute arbitrary 
commands with system privileges.

FTP:OVERFLOW:WUBSD-SE-RACE This signature detects buffer overflow attempts 
against the PASS command in Wu-ftpd 2.6.0 and 
BSDi-ftpd. Attackers may send a maliciously crafted 
PASS request to an FTP server to execute arbitrary 
commands as root.

FTP:PABLO-FTP:FORMAT-STRING This signature detects denial-of-service attempts 
against the Pablo FTP Server. Versions 1.2, 1.3, 
and 1.5 running on Windows 2000 are vulnerable. 
Because the FTP server improperly parses format 
string characters, attackers may supply a 
maliciously crafted username to execute arbitrary 
code and crash the server.

FTP:PASSWORD:H0TB0X This signature detects attempts to use the default 
rootkit password ’h0tb0x’ to access a FreeBSD 
rootkit account. Attackers may gain root access.

FTP:PASSWORD:LRKR0X This signature detects attempts to install the Rootkit 
hacker utility on a LINUX system. The default 
password is lrkr0x.

Deep Inspection Alarm Subcategory Description



Appendix B Log Entries

C-620 Administrator’s Guide

FTP:PASSWORD:SATORI This signature detects attempts to install the Rootkit 
lrk4 hacker utility on a system. The default 
password is satori.

FTP:PASSWORD:WH00T This signature detects attempts to install the Rootkit 
hacker utility on a LINUX system. The default 
password is wh00t.

FTP:PROFTP:LOGXFR-OF1 This signature detects buffer overflow attempts 
against the log_xfer() function in ProFTPD. This 
vulnerability affects ProFTPD versions 1.2.0pre1, 
pre2, and pre3.

FTP:PROFTP:MKD-OVERFLOW This signature detects buffer overflow attempts 
against ProFTPD. Versions 1.2pre3 and earlier are 
vulnerable. Attackers may send a pathname to the 
’MKD’ command to gain remote root access.

FTP:PROFTP:PPC-FS1 This signature detects attempts to exploit a format 
string vulnerability in ProFTPD. Versions 1.2pre6 
and earlier are vulnerable. Attackers may overflow 
the PWD command.

FTP:PROFTP:PPC-FS2 This signature detects attempts to exploit a format 
string vulnerability in ProFTPD. Versions 1.2pre6 
and earlier are vulnerable.

FTP:PROFTP:PROFTPD-GEN-GLOB-DOS This signature detects denial-of-service (DoS) 
attempts against ProFTPD. Because ProFTPD uses 
inadequate globbing algorithms, attackers may 
send wildcards in the argument of a maliciously 
crafted command to DoS the server.

FTP:PROFTP:SIZE-DOS2 This signature detects attempts to exploit a 
vulnerability in ProFTPD. Version 1.2.0pre* is 
vulnerable. Attackers may send multiple SIZE 
requests with a static pathname to create a denial-
of-service (DoS).

FTP:PROFTP:USER-DOS This signature detects attempts to exploit a 
vulnerability in ProFTPD. Versions 1.2.0rc* and 
1.2.0pre* are vulnerable. Attackers may send a 
maliciously crafted USER command to create a 
denial-of-service (DoS).

FTP:REQERR:GNULS-WIDTH-DOS This signature detects denial-of-service (DoS) 
attempts against GNU ls. If the FTP daemon uses a 
vulnerable version of GNU ls, attackers may send 
an oversized width parameter to GNU ls to cause 
the server CPU utilization to temporarily reach 
100% and exhaust system memory. This condition 
can persist for several minutes depending on the 
width specified.
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FTP:REQERR:REQ-MISSING-ARGS This protocol anomaly is an FTP command with an 
incomplete argument list, such as a USER 
command with no user name, a RETR command 
with no file name, etc. This may indicate command 
line access to the FTP server or an exploit attempt.

FTP:USER:4DGIFTS This signature detects attempts to access the user 
account ’4dgifts’, a default SGI IRIX account that 
has no password. Attackers may gain unauthorized 
access.

FTP:USER:ROOT This signature detects attempts to login to an FTP 
server using the "root" account. This may indicate 
an attacker trying to gain root-level access, or it may 
indicate poor security practices. FTP typically uses 
plain-text passwords, and using the root account to 
FTP could expose sensitive data over the network.

FTP:WS-FTP:CPWD This signature detects buffer overflow attempts 
against WS FTP Server. The code that handles 
arguments to the SITE CPWD command, which 
permits users to change their password, contains an 
unchecked string copy. Attackers may send a 
maliciously crafted argument in the SITE CPWD 
command to overflow the buffer and overwrite the 
return address.

FTP:WU-FTP:DELE-OF This signature detects buffer overflow attempts 
against the DELE command in a WU-ftpd server. 
Wu-ftpd versions 2.4 and prior (Academ beta12-18 
included) are vulnerable. This may be a variation on 
the ADM exploit; attackers may log in anonymously 
using a hardcoded email address as the password.

FTP:WU-FTP:FTPD-BSD-X86 This signature detects attempts to exploit an input 
validation vulnerability in wuFTPd running on 
FreeBSD. FreeBSD versions 4.3 and 4.4 are 
vulnerable. Because user input goes directly into a 
format string for a *printf function, attackers may 
overwrite data on a stack (i.e. a return address), 
access the shellcode pointed to by the overwritten 
eip, and execute arbitrary commands.

FTP:WU-FTP:GLOBARG This signature detects attempts to exploit a 
vulnerability in Wu-ftpd, a software package that 
provides File Transfer Protocol (FTP) services for 
UNIX and Linux systems. Wu-ftpd versions 2.6.1 to 
2.6.18 are vulnerable. Attackers may send a 
maliciously crafted pathname in a CWD or LIST 
command to the FTP server to execute arbitrary 
commands as root.
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FTP:WU-FTP:IREPLY-FS This signature detects attempts to exploit a format 
string vulnerability in Wu-ftpd 2.4 running on Solaris 
2.8. Attackers may inject malicious code into the 
Wu-ftp daemon memory space; later in the same 
session, the attacker may exploit a format string 
vulnerability in the Ireply() function to access that 
code and execute arbitrary commands as root.

FTP:WU-FTP:LINUX-OF This signature detects attempts to exploit an input 
validation vulnerability in wuFTPd running on 
LINUX. All versions are susceptible. Because user 
input goes directly into a format string for a *printf 
function, attackers may overwrite data on a stack, 
i.e. a return address, access the shellcode pointed 
to by the overwritten eip, and execute arbitrary 
commands. This same attack may be successful 
seen against ProFTPD servers.

FTP:WU-FTP:REALPATH-OF This signature detects buffer overflow attempts 
against the realpath() function in Wu-ftpd, a 
software package that provides File Transfer 
Protocol (FTP) services for UNIX and Linux 
systems. Wu-ftpd version 2.5.0 and earlier are 
vulnerable. Attackers may send a maliciously 
crafted FTP pathname to overflow a buffer in 
realpath() and execute arbitrary commands with 
administrator privileges.

FTP:WU-FTP:REALPATH-OF2 This signature detects buffer overflow attempts 
against the realpath() function in Wu-ftpd, a 
software package that provides File Transfer 
Protocol (FTP) services for UNIX and Linux 
systems. Wu-ftpd version 2.5.0 and earlier are 
vulnerable. Attackers may send a maliciously 
crafted FTP pathname to overflow a buffer in 
realpath() and execute arbitrary commands with 
administrator privileges.

HTTP:APACHE:MOD-NTLM-BOF1 This signature detects buffer overflow attempts 
against Apache Web server. An Apache Web server 
uses mod_ntlm (an Apache 1.x and 2.x module) to 
authenticate users against a Microsoft Windows 
Domain Controller. Attackers may send long or 
malformed strings to mod_ntlm using the 
Authorization HTTP header, overflow the buffer, 
then execute arbitrary code on the Web server.
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HTTP:APACHE:NOSEJOB This signature detects attempts to exploit a 
vulnerability in Apache Web servers. Apache 
improperly calculates required buffer sizes for 
chunked encoded requests due to a signed 
interpretation of an unsigned integer value. 
Attackers may send chunked encoded requests with 
the unique Host header value "Apache-nosejob.c." 
in the GET request to create a buffer overflow and 
execute arbitrary code.

HTTP:APACHE:PHP-INVALID-HDR This signature detects denial-of-service attempts 
against the Apache HTTP daemon. PHP versions 
4.2.0 and 4.2.1 running on Apache 1.3.26 are 
vulnerable. Attackers may use invalid headers in an 
HTTP request to crash the Apache HTTP daemon; 
the daemon may require a manual restart.

HTTP:APACHE:SCALP This signature detects attempts to exploit a 
vulnerability in Apache Web servers. Apache 
improperly calculates required buffer sizes for 
chunked encoded requests due to a signed 
interpretation of an unsigned integer value. 
Attackers may send chunked encoded requests with 
the unique Host header value "apache-scalp.c." in 
the GET request to create a buffer overflow and 
execute arbitrary code.

HTTP:BIGBROTHER:DIR-TRAVERSAL This signature detects attempts to view files on the 
Web server using the BigBrother bb-hist.sh history 
browser script. Attackers may view any files on the 
Web server that are accessible to the user the 
history browser script is running under.

HTTP:CGI:ALTAVISTA-TRAVERSAL This signature detects attempts to exploit a 
vulnerability in the AltaVista Search engine. The 
search engine sets up a Web server at port 9000 
that listens for search queries. The search function 
accepts a single ’../’ string in the query, providing 
access to the parent, or ’http’ directory. This 
directory typically contains administrative 
documents that may include the password for the 
remote administration utility, which is base-64 
encoded. Attackers may send multiple ’../’ strings in 
hex code (ie.’%2e%2e%2f’) in a query to access the 
remote administration utility password and gain full 
remote administration abilities. 

HTTP:CGI:APPLE-QT-FILEDISC1 This signature detects attempts to exploit a 
vulnerability in Apple QuickTimer Streaming Server. 
QuickTime Streaming Server v4.1.1 and earlier 
versions are vulnerable. Attackers may send a 
maliciously crafted URL to parse_xml.cgi to view 
files that are not usually accessible through HTTP.
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HTTP:CGI:BNB-SURVEY-REMOTE-EXEC This signature detects attempts to access the 
BNBSurvey survey.cgi program. Attackers may 
remotely execute commands via shell 
metacharacters.

HTTP:CGI:BUGZILLA-SEMICOLON This signature detects shell access attempts to 
exploit the process_bug.cgi script vulnerability in 
Bugzilla. Attackers may send a semi-colon as an 
argument to the script, followed by arbitrary shell 
commands.

HTTP:CGI:DCFORUM-AZ-EXEC This signature detects shell attempts to exploit the 
dcforum.cgi script in DCScripts DC Forum (all 
versions), which is used to manage web-based 
discussion boards. Attackers may use maliciously 
crafted URL requests with the pipe and newline 
characters to execute arbitrary scripts on the Web 
server.

HTTP:CGI:FORMMAIL-ENV-VAR This signature detects access to the FormMail CGI 
program. Attackers may use this program to 
remotely execute commands.

HTTP:CGI:HASSAN-DIR-TRAVERSAL This signature detects attempts to exploit a 
vulnerability in the Hassan shopping cart script 
shop.cgi. Attackers may access arbitrary system 
files.

HTTP:CGI:HTDIG-INCLUSION This signature detects attempts to exploit a 
vulnerability in ht://dig, a Web content search 
engine for UNIX. Because ht://dig improperly 
validates form input, attackers may pass a 
maliciously crafted variable to the htsearch CGI 
script to read files accessible to the program user.

HTTP:CGI:HYPERSEEK-DIR-TRAVERSL This signature detects attempts to exploit a 
vulnerability in hsx.cgi, which ships as part of iWeb 
Hyperseek 2000. Attackers may view arbitrary files 
and directories.

HTTP:CGI:INFO2WWW-EXEC This signature detects attempts to exploit a 
vulnerability in the info2www CGI script. Attackers 
may execute arbitrary binaries on the Web server.

HTTP:CGI:INFOSRCH-REMOTE-EXEC This signature detects attempts to exploit a 
vulnerability in the infosrch.cgi script. Attackers may 
execute commands on the Web server.

HTTP:CGI:MOREOVER-CACHE-FEED This signature detects attempts to exploit a 
vulnerability in the cached_feed.cgi script provided 
by moreover.com. Attackers may view arbitrary 
system files that are readable by the HTTPd 
process.
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HTTP:CGI:TECHNOTE-MAIN-DCLSR This signature detects directory traversal attempts 
that exploit the main.cgi script in TECH-NOTE 2000. 
Because the script validates input incorrectly, 
attackers may remotely access arbitrary files from 
the server.

HTTP:CGI:TECHNOTE-PRINT-DSCLSR This signature detects directory traversal attempts 
that exploit the print.cgi script in TECH-NOTE 2000. 
Because the script validates input incorrectly, 
attackers may remotely access arbitrary files from 
the server.

HTTP:CGI:W3-MSQL-CGI This signature detects attempts to exploit a 
vulnerability in W3-msql, a CGI program that acts as 
a Web interface for Mini SQL (mSQL). W3-msql 
version 2.0.11 is vulnerable. Attackers may 
remotely send a maliciously crafted scanf call to 
overflow the content-length field and execute 
arbitrary code with Web server privileges.

HTTP:CGI:WEBPALS-EXEC This signature detects attempts to exploit a 
vulnerability in the WebPALS CGI script. Attackers 
may remotely execute arbitrary code with root 
permissions.

HTTP:CGI:WEBSPEED-WSMADMIN This signature detects attempts to gain 
administrative access to the WebSpeed server 
without normal authentication.

HTTP:CGI:WEBSPIRS-FILE-DISCLSR This signature detects attempts to exploit a 
vulnerability in the SilverPlatter WebSPIRS 
webspirs.cgi file. Attackers may access arbitrary 
system files

HTTP:CGI:YABB-DIR-TRAVERSAL This signature detects attempts to exploit a 
vulnerability in the YaBB.pl CGI script. Attackers 
may view arbitrary files.

HTTP:CHKP:FW1-FORMAT-STR This signature detects attempts to exploit a 
vulnerability in the CheckPoint AI/Smart Defense 
HTTP proxy engine. Attackers may send a scheme 
that includes format strings to crash the proxy 
engine, creating a denial-of-service (DoS) or 
enabling the attackers to take control of the firewall 
as root.

HTTP:CHKP:FW1-PROXY This signature detects attempts to exploit the web 
proxy functions of CheckPoint FireWall-1. When the 
HTTP CONNECT method, used to build generic 
Transit Layer Security over HTTP, is used by 
default, the firewall web proxies may be used as 
open TCP proxies. Attackers may use an HTTP 
proxy to connect to a server, then use the 
CONNECT method to access other servers and 
launch further attacks.
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HTTP:CISCO:IOS-ADMIN-ACCESS This signature detects attempts to exploit a 
vulnerability in Cisco IOS. Attackers may remotely 
gain full administrative access to the router.

HTTP:CISCO:VOIP:PORT-INFO-DOS This signature detects attempts to exploit a 
vulnerability in Cisco VoIP phones. Versions CP-
7910 and later are vulnerable. Attackers may send 
an arbitrarily long (120000+) StreamID to the 
PortInformation script to cause an error message 
that displays a memory dump. Attackers may use 
this information to reconstruct the calling patterns of 
a particular phone.

HTTP:CISCO:VOIP:STREAM-ID-DOS This signature detects denial-of-service (DoS) 
attempts against Cisco VoIP phones. Versions CP-
7910 and later are vulnerable. Attackers may send 
an arbitrarily long (120000+) StreamID to the 
StreamingStatistics script to cause the phone to 
reset, creating a DoS for 30 seconds (or until the 
phone reboots).

HTTP:COLDFUSION:EXPRCALC-OPNFIL This signature detects attempts to exploit a 
vulnerability in the ColdFusion ExprCalc.cfm script. 
Attackers may delete files from a Web server.

HTTP:DIR:TRAVERSE-DIRECTORY This protocol anomaly is an HTTP directory 
traversal attempt, i.e. /../ or /./. This may indicate an 
attempt to evade an IDS (IDP is not vulnerable). 
Note that some websites refer to directories in a 
way that looks like a traversal.

HTTP:EXPLOIT:AMBIG-CONTENT-LEN This protocol anomaly is an HTTP request that has 
a Content-Length and Transfer-Encoding header. 
RFC-2616#4.4 specifies that only one of these two 
headers should be used in an HTTP request.

HTTP:EXPLOIT:BLAZIX-JSPVIEW This signature detects attempts to exploit a 
vulnerability in the Blazix, a Java-based Web 
server. Blazix 1.2 and earlier versions are 
vulnerable. Because Blazix does not strip bad 
characters (such as ’+’ and ’’) from URL requests, 
attackers may send a malicious URL to the Web 
server to view the jsp server side scripts.

HTTP:FRONTPAGE:ADMIN.PWD-REQ This signature detects attempts to access the 
Microsoft FrontPage Extensions for UNIX .pwd file 
that contains sensitive account information.

HTTP:FRONTPAGE:FOURDOTS This signature detects attempts to exploit the ’/..../’ 
directory traversal vulnerability in Microsoft 
FrontPage PWS.

HTTP:FRONTPAGE:SERVICE.PWD-REQ This signature detects attempts to access the 
Microsoft FrontPage extensions for UNIX .pwd file 
which contains sensitive account information.
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HTTP:HOSTCTRL:BROWSE-ASP This signature detects attempts to exploit a 
vulnerability in the browse.asp script supplied with 
Hosting Controller, a tool that permits Microsoft 
Windows network administrators to centralize 
administrative tasks into one interface. Attackers 
may send a maliciously crafted URL request for 
browse.asp to view arbitrary directories and files on 
hard drives.

HTTP:IIS:AD-SERVER-CONFIG This signature detects attempts to download the 
site.csc configuration file for Microsoft Ad Server. 
Attackers may access sensitive information.

HTTP:IIS:ASP-CODEBROWSER-EXAIR This signature detects attempts to exploit the 
Showcode ASP vulnerability in Microsoft IIS.

HTTP:IIS:BAT-& This signature detects attempts to execute a 
command by specifying a .bat or .cmd extension to 
a Microsoft Windows Web server.

HTTP:IIS:COMMAND-EXEC This signature detects attempts to exploit Microsoft 
Windows Web servers. Attackers may send a 
maliciously crafted url containing the string 
"cmd.exe" to execute commands on the Web 
server.

HTTP:IIS:COMMAND-EXEC-2 This signature detects attempts to exploit a 
vulnerability in Microsoft IIS. Attackers may execute 
arbitrary commands on the Web server.

HTTP:IIS:DATA-DISCLOSURE This signature detects attempts to obtain the 
sourcecode of Active Server Pages served by 
Microsoft’s Internet Information Server. In IIS, 
remote attackers can obtain source code for ASP 
files by appending "::$DATA" to the URL.

HTTP:IIS:FACTO-CMS-SQL-INJ This signature detects attempts to exploit a 
vulnerability in the FactoSystem Content 
Management System (CMS). Attackers may 
introduce instructions into a SQL query to create a 
non-authorized CMS account.

HTTP:IIS:HEADER-HOST-DOS This signature detects denial-of-service (DoS) 
attempts against Microsoft IIS. Attackers may pass 
maliciously malformed header values to the host to 
crash the IIS service.

HTTP:IIS:ISAPI-IDQ-OVERFLOW This signature detects buffer overflow attempts 
against Microsoft ISAPI Indexing Service for IIS. 
Index Server 2.0 and Indexing Service 2000 in IIS 
6.0 beta and earlier are vulnerable. Attackers may 
send a long argument to Internet Data 
Administration (.ida) and Internet Data Query (.idq) 
files to overflow the buffer in the ISAPI extension 
(idq.dll) and execute arbitrary commands.
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HTTP:IIS:ISAPI-PRINTER-OVERFLOW This signature detects attempts to execute a buffer 
overflow in the Microsoft IIS 5.0 .printer ISAPI 
extension.

HTTP:IIS:MDAC-RDS This signature detects attempts to exploit the 
Microsoft Data Access Components (MDAC) 
Remote Data Services (RDS) component. Attackers 
may access files and other services.

HTTP:IIS:MDAC-RDS-2 This signature detects attempts to exploit the 
Remote Data Services (RDS) component included 
in Microsoft Data Access Components (MDAC) 
using ActiveDataFactory. Microsoft IIS 3.x and 4.x 
are vulnerable. Attackers may remotely access 
exposed unsafe methods to execute arbitrary 
commands.

HTTP:IIS:NEWDSN-FILE-CREATION This signature detects attempts to create a file on 
the Web server by exploiting the newdsn.exe 
vulnerability in Microsoft IIS 3.0.

HTTP:IIS:OUTLOOK-WEB-DOS This signature detects denial-of-service (DoS) 
attempts against Microsoft Outlook Web. Attacker 
may send a long string of ’%’ characters as the user 
name and/or password.

HTTP:IIS:SENSEPOST.EXE This signature detects attempts to locate 
sensepost.exe on a Microsoft ISS Web Server. 
Attackers may use a proof-of-concept hacking tool 
to break into a vulnerable Web server, then copy 
cmd.exe to the Web server script directory and 
rename it sensepost.exe to avoid detection by log 
viewers. To identify this event, check your Web 
server logs for details--if the server returned a ’200’ 
to the request, your Web server may be 
compromised. 

HTTP:IIS:WEBDAV:MALFORMED-REQ1 This signature detects denial-of-service (DoS) 
attempts against Microsoft IIS 5.0 servers with 
WebDAV extensions enabled. Attackers may send 
a maliciously crafted WebDAV SEARCH request in 
an HTTP request to DoS the Web server.

HTTP:IIS:WEBDAV:MALFORMED-REQ2 This signature detects denial-of-service (DoS) 
attempts against Microsoft IIS 5.0 servers with 
WebDAV extensions enabled. Attackers may send 
a maliciously crafted WebDAV SEARCH request in 
an HTTP request to DoS the Web server.

HTTP:INFO-LEAK:VIGNETTE-LEAK "This signature detects attempts to exploit a 
vulnerability in Vignette Story Server. Vignette Story 
Server versions 4.1 and 6 are vulnerable. Attackers 
may expose information about user sessions, server 
side code, and other sensitive information.
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HTTP:INFO-LEAK:WEB-INF-DOT This signature detects attempts to exploit a 
vulnerability in Windows Web servers with J2EE. 
Attackers may append a ’.’ character to a request for 
the WEB-INF directory (where J2EE class files are 
typically stored) to bypass directory security and 
gain access to normally protected files.

HTTP:IRIX:CGI-BIN-WRAP This signature detects attempts to exploit the wrap 
CGI script in SGI IRIX. Attackers may list the 
contents of Web server directories.

HTTP:MISC:HP-PROCURVE-RESET This signature detects denial-of-service (DoS) 
attempts against the HP Procurve 4000M switch. 
Configuration changes for the switch are made via 
an HTTP-based interface; however, the script that 
resets the switch after a configuration change does 
not properly authenticate the IP address that calls 
the script. Attackers may call the script repeatedly to 
perform a DoS.

HTTP:MISC:HTACCESS-ATTEMPT This signature detects probes for the .htaccess file, 
used by the Apache Web server for configuration 
directives. Attackers may be attempting to gain 
access to the Web server.

HTTP:NOVELL:NETWARE-
CONVERT.BAS

This signature detects directory traversal attempts 
on Novell NetWare Web Server 2.x. The 
convert.bas CGI script permits file retrieval outside 
of normal Web server context. Attackers may 
submit the filename and path as a parameter to the 
script using relative paths (../../) to traverse 
directories.

HTTP:OREILLY:WIN-C-SMPLE-OVFLOW This signature detects buffer overflow attempts that 
exploit the win-c-sample.exe sample script 
vulnerability in O’Reilly Website Pro 2.0 Web server. 
The script is placed in the /cgi-shl directory off of the 
Web root by default.

HTTP:OVERFLOW:CHUNK-LEN-OFLOW This protocol anomaly is an HTTP message that 
has a chunk length in a Transfer-Encoding: chunk 
request that is greater than 0x7fffffff. Apache 
servers 1.3 to 1.3.24 and 2.0 to 2.0.36 are 
vulnerable. Attackers may cause a denial-of-service 
(DoS) or execute arbitrary code on the server.

HTTP:OVERFLOW:HEADER This protocol anomaly is an HTTP header field that 
is too long, and may indicate a buffer overflow 
attempt.

HTTP:OVERFLOW:INV-CHUNK-LEN This protocol anomaly is an invalid chunk length 
specification in a chunked transfer encoded HTTP 
request. RFC-2616#3.6.1 specifies that the size of a 
chunk should be represented using hexadecimal 
notation.

Deep Inspection Alarm Subcategory Description



Appendix B Log Entries

C-630 Administrator’s Guide

HTTP:OVERFLOW:PI3WEB-SLASH-OF This signature detects denial-of-service (DoS) 
attempts against Pi3Web Server. Attackers may 
send a URL with more than 354 Slashes (/) to crash 
the server.

HTTP:PHP:ACHIEVO-EXEC This signature detects attempts to exploit a 
vulnerability in Achievo, a Web-based project 
management suite. Achievo 0.8.1, 0.9.1, and earlier 
versions are vulnerable. Attackers may send a 
maliciously crafted URL to the Web Server to cause 
it to download code from a remote server, permitting 
the attacker to execute arbitrary code with 
permissions of the user that is running the HTTP 
server daemon.

HTTP:PHP:DFORUM-PHP-INC This signature detects attempts to exploit a 
vulnerability in D-Forum. D-Forum versions 1.0 
through 1.11 are vulnerable. Attackers may exploit 
header.php3 and footer.php3 to include PHP code 
from a remote host and execute arbitrary 
commands.

HTTP:PHP:DOTPROJECT-USERCOOKIE This signature detects attempts to exploit a 
vulnerability in DotProject 0.2.1.5, an online project 
management tool. Attackers may append a false 
user_cookie parameter to a query to bypass 
authentication procedures and access files as the 
application administrator.

HTTP:PHP:FI-DIR-TRAVERSAL This signature detects attempts to exploit a design 
vulnerability in PHP/FI. Attackers may remotely 
access files and directories that are readable by the 
Web server UID to gather information on the local 
host and retrieve encrypted user passwords on the 
system.

HTTP:PHP:GALLERY-MAL-INCLUDE This signature detects attempts to exploit a 
vulnerability in Gallery online photo gallery software. 
Attackers may inject malicious PHP code into the 
software to execute operations on the Web server.

HTTP:PHP:MANTIS-ARB-EXEC1 This signature detects attempts to exploit a 
vulnerability in Mantis, an open source Web-based 
bug tracking system. Mantis 0.17.3 and earlier 
versions are vulnerable. Attackers may send a 
maliciously crafted URL to cause the Web server to 
download PHP code from a remote server, 
permitting the attacker to execute arbitrary code 
with the permissions of the user that is running the 
Web server daemon.
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HTTP:PHP:MANTIS-ARB-EXEC2 This signature detects attempts to exploit a 
vulnerability in Mantis, an open source Web-based 
bug tracking system. Mantis 0.17.3 and earlier 
versions are vulnerable. Attackers may send a 
maliciously crafted URL to cause the Web server to 
download PHP code from a remote server, 
permitting the attacker to execute arbitrary code 
with the permissions of the user that is running the 
Web server daemon.

HTTP:PHP:MLOG-SCREEN This signature detects attempts to exploit the 
vulnerable mlog.phtml script. Attackers may 
remotely access arbitrary files on the Web server.

HTTP:PHP:PHORUM:ADMIN-PW-CHG This signature detects attempts to exploit the 
vulnerable admin.php3 script in Phorum. Attackers 
may remotely send a maliciously crafted string to 
the script, change the administrative password of 
the board without user verification, and access 
restricted files on the local system.

HTTP:PHP:PHORUM:READ-ACCESS This signature detects access to the vulnerable 
read.php3 script installed with Phorum. Because the 
script does not validate input, attackers may 
execute arbitrary SQL statements to modify the 
database contents, insert new entries, create and 
drop tables, etc.

HTTP:PHP:PHORUM:REMOTE-EXEC This signature detects attempts to exploit a 
vulnerability in the PHP Phorum bulletin board 
system. Attackers may remotely execute arbitrary 
commands with the privileges of the HTTP server.

HTTP:PHP:PHPBB:SEARCH-INJECT This signature detects attempts to exploit a 
vulnerability in phpBB, an open-source bulletin 
board package. The search_id parameter in phpBB 
is vulnerable to SQL injection. Attackers may query 
private data (such as hashed passwords) then 
embed the password in a cookie to gain 
administrative access to the Web site. 

HTTP:PHP:PHPLIB-REMOTE-EXEC This signature detects attempts to exploit a 
vulnerability in PHPLILB, a code library that 
provides support for managing sessions in Web 
applications. Attackers may remotely submit 
maliciously crafted Web requests to cause the 
application to fetch and execute scripts from 
another host, permitting local access to the Web 
server.
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HTTP:PHP:PHPNUKE:MODULES-DOS This signature detects attempts to exploit a SQL 
injection vulnerability in the modules.php script that 
ships with PHPNuke. PHPNuke 6.0 and earlier are 
vulnerable. Attackers may produce a process that 
increases system load on the server, making it 
unusable until the process is killed.

HTTP:PHP:PHPWEB-REMOTE-FILE This signature detects attempts to exploit a 
vulnerability in phpWebsite. Version 0.8.2 and 
earlier are vulnerable. Attackers may specify a 
remote file location for file inclusion to cause 
phpWebsite to execute arbitrary PHP code; 
attackers may execute commands with HTTP 
daemon user permissions.

HTTP:PHP:PMACHINE-INCLUDE This signature detects attempts to exploit a 
vulnerability in pMachine, an online publishing 
application. pMachine version 2.2.1 and other 
versions are vulnerable. Attackers may send a 
malicious HTTP request to force the pMachine Web 
server to execute PHP code from a remote server; 
commands are executed with web server privileges.

HTTP:PHP:POPPER-OPEN-ADMIN This signature detects attempts to exploit a 
vulnerability in popper_mod 1.2.1, a Web-based 
PHP POP3 email client based on Qpopper. 
Popper_mod relies on htaccess authentication to 
authenticate administrators; if htaccess is not used 
to protect admin access, popper_mod does not 
authenticate administrators. Attackers may browse 
to the /mail/admin directory to access the 
administration PHP script and view a complete list 
of user accounts and passwords, delete accounts, 
modify accounts, and edit settings.

HTTP:PHP:POSTNUKE-SQL-EXEC This signature detects directory traversal attempts 
against the modules.php script included with 
PostNuke. PostNuke versions 0.723 and earlier are 
vulnerable. Attackers may send a maliciously 
crafted request to the modules.php to traverse the 
directory structure and execute SQL queries to the 
PostNuke database.

HTTP:PHP:REDHAT-PIRANHA-PASSWD This signature detects attempts to exploit the 
vulnerable passwd.php3 cgi-bin script in the Piranha 
virtual server package (Red Hat Linux 6.2). 
Because the script does not validate input properly, 
attackers may authenticate to the Piranha package 
with the effective ID of the Web server and execute 
arbitrary commands.
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HTTP:PHP:VBULL-CAL-EXEC This signature detects attempts to exploit a 
vulnerability in the calender.php script that is 
included with the VBulletin package. Attackers may 
run the vbull.c exploit to execute arbitrary 
commands with Web Server user permissions.

HTTP:PHP:WOLTAB-SQL-INJ Any user on the bulletin board can compromise any 
other user’s account by exploiting a vulnerability in 
board.php. Board.php does not perform proper input 
validation, and therefore is subject to executing 
user-supplied SQL statements. This is known to 
affect Woltlab Burning Board 2.0 RC 1 and earlier 
versions.

HTTP:PHP:YABBSE-PKG-EXEC This signature detects attempts to exploit a 
vulnerability in Packages.php in YabbSE. YabbSE 
1.5.0 and earlier are vulnerable. Attackers may 
include remote malicious code in Packages.php to 
include remote malicious code to execute arbitrary 
commands with Web server privileges.

HTTP:PHP:YABBSE-SSI-INCLUDE This signature detects attempts to exploit a 
vulnerability in YabbSE, a PHP/MySQL port of the 
forum software YaBB (yet another bulletin board). 
YabbSE versions 1.5.2 and earlier are vulnerable. 
Attackers may include PHP code in a maliciously 
crafted URL request; when YabbSE receives the 
request it runs the PHP code, enabling the attacker 
to execute arbitrary commands on the server.

HTTP:PHP:ZENTRACK-CMD-EXEC This signature detects attacks against the PHP-
based zenTrack CRM system. A vulnerability exists 
in the header.php that holds zenTrack configuration 
settings. It permits remote command execution as 
the webserver process privilege. This applies to 
zenTrack 2.4.1 and below.

HTTP:PKG:ALLAIRE-JRUN-DOS This signature detects an attempt to launch a 
denial-of-service (DoS) in Allaire JRun 3.0/3.1. 
Attackers may send a long string of ’.’ characters 
after the /servlet/ prefix in the URL to cause the 
server to interpret the URL as a very large tree of 
non-existent directories and to consume system 
resources.

HTTP:PKG:EWAVE-SERVLET-DOS This signature detects denial-of-service (DoS) 
attempts against the eWave Servlet JSP. Attackers 
may remotely send URL requests to cause the 
Servlet engine to terminate abruptly.

HTTP:PKG:MOUNTAIN-ORDR-DSCLSR This signature detects attempts to exploit a 
vulnerability in Mountain Network Systems Webcart 
software. Attackers may remotely execute arbitrary 
commands on the server.
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HTTP:PKG:WEBGAIS-REMOTE-EXEC This signature detects attempt to exploit the 
websendmail script in WebGais. Attackers may 
execute arbitrary commands on the Web server.

HTTP:REQERR:HEADER-INJECT This signature detects attempts to exploit an input 
validation vulnerability in HTTP. Attackers may use 
encoded CR/LF (carriage return/line feed) 
characters in an HTTP response header to split 
HTTP responses into multiple parts, enabling them 
to misrepresent web content to the recipient.

HTTP:REQERR:REQ-INVALID-FORMAT This protocol anomaly is an invalid HTTP request 
format, such as a request that begins before a 
previous one ends.

HTTP:REQERR:REQ-LONG-UTF8CODE This protocol anomaly is an HTTP request with an 
exceedingly long UTF8 codes. This may be an 
attempt to overflow a portion of the Web server, or 
that a script is being made available to the Web 
server.

HTTP:REQERR:REQ-MALFORMED-URL This protocol anomaly is a malformed URL, such as 
a Unicode encoded field with non-hex digits or an 
encoded NULL byte.

HTTP:TOMCAT:SERVLET-DEVICE-DOS This signature detects denial-of-service (DoS) 
attempts against Apache Group Tomcat Server. 
Attackers may request a device name from the /
examples/servlet directory to render the server 
inaccessible. This signature also detects attempts to 
run neuter.c and similar exploits.

HTTP:WASD:CONF-ACCESS This signature detects attempts to exploit a 
vulnerability in the WASD HTTP Server for 
OpenVMS. Default installations of 1.0 and earlier 
are vulnerable. Attackers may download the 
configuration file for the server and obtain 
information on the ACL and internal directory 
structure.

HTTP:WASD:DIR-TRAV This signature detects directory traversal attempts 
against WASD HTTP Server for OpenVMS. WASD 
version 1.0 and earlier are vulnerable. Attackers 
may navigate to any directory on the server.

HTTP:WEBLOGIC:URL-REVEAL-SRC This signature detects attempts to exploit a 
vulnerability in Bea Weblogic. Version V6.1 Service 
Pack 2 on Windows 2000 Server is vulnerable. 
Attackers may append the string "%00x" to a URL 
request to read the contents of a .jsp file.

Deep Inspection Alarm Subcategory Description



NetScreen-Security Manager 2004 FP2 C-635

HTTP:WEBLOGIC:WEBROOT This signature detects attempts to exploit a 
vulnerability in Bea Weblogic. Version V6.1 Service 
Pack 2 on Windows 2000 Server is vulnerable. 
Attackers may append the string "%00.jsp" to a 
normal .html request, causing a compiler error that 
prints the path to the physical web root.

HTTP:WEBPLUS:DIR-TRAVERSAL This signature detects attempts to exploit the input 
validation vulnerability in the main CGI in TalentSoft 
Web+, an e-commerce storefront provider. 
Attackers may pass a script variable that specifies a 
filepath to the webpsvr daemon, and gain access to 
any file on the system that the UID of the Web 
server has access to.

HTTP:WIN-CMD:WIN-CMD-EXE This signature detects the Windows command 
’cmd.exe’ within a URL. This command does not 
normally appear in a URL, and may indicate an 
attempt to compromise the system.

HTTP:WIN-CMD:WIN-RGUEST This signature detects the Windows command 
’rguest.exe’ within a URL. This command does not 
normally appear in a URL, and may indicate an 
attempt to compromise the system.

HTTP:WIN-CMD:WIN-WGUEST This signature detects the Windows command 
’wguest.exe’ within a URL. This command does not 
normally appear in a URL, and may indicate an 
attempt to compromise the system.

HTTP:XSS:HTML-SCRIPT-IN-URL-PRM This signature detects attempts at cross site 
scripting attacks. Attackers may create a malicious 
Web site that includes HTML embedded in the 
hyperlinks, which might violate site security settings. 
Attackers may then view the Web cookies from your 
computer; Web cookies typically contain sensitive 
information such as usernames, passwords, credit 
card numbers, social security numbers, bank 
accounts, etc.

IMAP:OVERFLOW:COMMAND This protocol anomaly is an IMAP command that is 
too long. This may indicate a buffer overflow 
attempt.

IMAP:OVERFLOW:FLAG This protocol anomaly is an IMAP flag that is too 
long. This may indicate a buffer overflow attempt.

IMAP:OVERFLOW:IMAP4-LSUB-OF This signature detects buffer overflow attempts 
against the IMAP package included with several 
Linux distributions. Attackers may send a long string 
to the IMAP package to execute code with daemon-
level permissions.
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IMAP:OVERFLOW:LINE This protocol anomaly is an IMAP line (from the 
client to the server) that is too long. This may 
indicate a buffer overflow attempt. NOTE: Long 
lines are parsed, which may generate other IMAP 
overflow errors.

IMAP:OVERFLOW:MAILBOX This protocol anomaly is an IMAP mailbox name 
that is too long. This may indicate a buffer overflow 
attempt.

IMAP:OVERFLOW:PASS This protocol anomaly is an IMAP user password 
that is too long. This may indicate a buffer overflow 
attempt.

IMAP:OVERFLOW:REFERENCE This protocol anomaly is an IMAP reference field 
that is too long. This may indicate a buffer overflow 
attempt.

IMAP:OVERFLOW:TAG This protocol anomaly is an IMAP tag field that is 
too long. This may indicate a buffer overflow 
attempt.

IMAP:OVERFLOW:USER This protocol anomaly is an IMAP user name that is 
too long. This may indicate a buffer overflow 
attempt.

IMAP:REQERR:REQ-INVALID-TAG This protocol anomaly is an invalid IMAP tag, i.e., a 
tag that begins with a white space or contains non-
alphanumeric characters. This may indicate a non-
standard IMAP client or command line access to an 
IMAP server.

IMAP:REQERR:REQ-UNEXPECTED-ARG This protocol anomaly is an IMAP command with 
too many arguments. This may indicate a non-
standard IMAP client or command line access to an 
IMAP server.

POP3:DOS:MDAEMON-POP-DOS This signature detects denial-of-service attempts 
against the Mdaemon POP3 Server. Mdaemon 
v.6.0.7 and earlier versions are vulnerable. 
Attackers may send a maliciously crafted DELE or 
UIDL request to the POP3 daemon to crash the 
POP3, SMTP, and IMAP services.

POP3:OVERFLOW:APOP This protocol anomaly is a POP3 APOP command 
argument that is too long. This may indicate a buffer 
overflow attempt.

POP3:OVERFLOW:COMMAND This protocol anomaly is a POP3 command that 
exceeds 4 bytes, the standard length for a POP3 
command. This may indicate a non-standard POP3 
client/server or an attacker has gained command-
line access to the server.
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POP3:OVERFLOW:LINE This protocol anomaly is a text-line from a POP3 
client to the server that is too long. This may 
indicate a buffer overflow attempt.

POP3:OVERFLOW:PASS This protocol anomaly is a POP3 PASS command 
argument that is too long. This may indicate a buffer 
overflow attempt.

POP3:OVERFLOW:QPOP-OF1 This signature detects a buffer overflow attempt to 
exploit a vulnerability in Qpopper. Version 
3.0beta20 and many earlier versions are vulnerable.

POP3:OVERFLOW:QPOP-OF2 This signature detects a buffer overflow attempt to 
exploit a vulnerability in Qpopper. Version 
3.0beta30 and many earlier versions are vulnerable.

POP3:OVERFLOW:QPOP-OF3 This signature detects buffer overflow attempts to 
exploit a vulnerability in the Qpopper daemon. 
Some 3.0 beta versions are vulnerable.

POP3:OVERFLOW:QPOP-OF4 This signature detects a buffer overflow attempt to 
exploit a vulnerability in Qpopper using custom 
shellcode. Version 3.0beta20 and many earlier 
versions are vulnerable.

POP3:OVERFLOW:USER This protocol anomaly is a POP3 USER command 
argument that is too long. This may indicate a buffer 
overflow attempt.

POP3:REQERR:REQ-MESSAGE-
NUMBER

This protocol anomaly is a POP3 message number 
that is unreasonably high. This may indicate a huge 
mailbox or an exploit attempt.

POP3:REQERR:REQ-SYNTAX-ERROR This protocol anomaly is an unparsed POP 
command line or header line. This may indicate a 
non-standard email client or server or a backdoor/
exploit attempt.

SHELLCODE:AIX:NOOP-PKT This signature scans PACKETS for at least four in a 
raw AIX NOOP instructions, which are very 
common in buffer overflow exploits. You may want 
to apply this signature to all non-TCP traffic to your 
AIX servers.

SHELLCODE:BSDX86:GEN-1-PKT This signature scans PACKETS for an x86 BSD (all 
flavors) instruction sequence, common in buffer 
overflow exploits. You may want to apply this 
signature to all non-TCP traffic to your BSD servers.

SHELLCODE:BSDX86:GEN-2-PKT This signature scans PACKETS for an x86 BSD (all 
flavors) instruction sequence, common in buffer 
overflow exploits. You may want to apply this 
signature to all non-TCP traffic to your BSD servers.
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SHELLCODE:DIGITAL:NOOP-PKT This signature scans PACKETS for at least four in a 
row DEC ALPHA NOOP instructions, which are very 
common in buffer overflow exploits. You may want 
to apply this signature to all non-TCP traffic to your 
DEC ALPHA servers.

SHELLCODE:HP-UX:HP-NOOP-1-PKT This signature scans PACKETS for a HP-UX PA-
RISC instruction sequence, common in buffer 
overflow exploits. You may want to apply this 
signature to all non-TCP traffic to your HP-UX 
servers.

SHELLCODE:HP-UX:HP-NOOP-2-PKT This signature scans PACKETS for a HP-UX PA-
RISC instruction sequence, common in buffer 
overflow exploits. You may want to apply this 
signature to all non-TCP traffic to your HP-UX 
servers.

SMTP:COMMAND:EXPN This protocol anomaly is an attempt to use the 
EXPN command. This command is not used by 
most standard clients and servers and may reveal 
information about email accounts.

SMTP:COMMAND:VRFY This protocol anomaly is an attempt to use the 
SMTP VRFY command. This command is not used 
by most standard clients and servers and may 
reveal sensitive information about email accounts.

SMTP:EMAIL:HEADER-FROM-PIPE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the pipe passthrough vulnerability. 
Attackers may use the invalid "from |" as the return 
email address to cause Sendmail to reroute data to 
another program.

SMTP:EMAIL:HEADER-TO-PIPE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the pipe passthrough vulnerability. 
Attackers may use the invalid ’to |’ as the return 
email address to cause Sendmail to reroute data to 
another program.

SMTP:EMAIL:MAIL-FROM-PIPE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the pipe passthrough vulnerability. 
Attackers may use the invalid "mail from |" as the 
return email address to cause Sendmail to reroute 
data to another program.
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SMTP:EMAIL:RCPT-TO-DECODE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the "decode" email alias vulnerability. 
Attackers may use the invalid ’rcpt to decode’ as the 
"rcpt to" email address to cause Sendmail to reroute 
data to the program uudecode. Attackers may then 
send uuencoded data to overwrite files or place an 
arbitrary .rhosts files onto the system.

SMTP:EMAIL:RCPT-TO-PIPE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the pipe passthrough vulnerability. 
Attackers may use the invalid ’rcpt to |’ as the "rcpt 
to" email address to cause Sendmail to reroute data 
to another program.

SMTP:EMAIL:REPLY-TO-PIPE This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the pipe passthrough vulnerability. 
Attackers may use the invalid ’reply to |’ as the 
"reply to" email address to cause Sendmail to 
reroute data to another program.

SMTP:EXCHANGE:DOS This signature detects denial-of-service (DoS) 
attempts that exploit a MIME header vulnerability in 
Microsoft Exchange Server 5.5. Attackers may send 
an email message with an empty charset value ("") 
in the MIME header to cause a denial-of-service 
(DoS).

SMTP:IIS:IIS-ENCAPS-RELAY This signature detects attempts to exploit a 
vulnerability in the Microsoft SMTP Service in 
Microsoft IIS. Versions 4.0 and 5.0 are vulnerable. A 
maliciously crafted ’rcpt to:’ command can 
circumvent email relaying rules. Attackers may 
impersonate trusted emails or send spam 
anonymously.

SMTP:MAJORDOMO:COMMAND-EXEC This signature detects attempts to send shell 
commands via an SMTP email message by 
exploiting the back-tick (‘ ) vulnerability in Great 
Circle Associates Majordomo, a perl-based Internet 
email list server. When processing a list command, 
Majordomo compares the "reply to" email address 
again the advertise/noadvertise lists (if configured). 
During this comparison, Majordomo may be tricked 
into executing commands when it expands the 
back-tick operator (used by UNIX to enclose 
executable commands in a shell command line). 
Attackers may use the back-tick operator in the 
"reply to" email header to execute arbitrary 
commands on the server.
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SMTP:MSSQL-WORM-EMAIL This signature detects attempts to send an email to 
ixltd@postone.com. This may indicate the presence 
of SQLsnake, a MSSQL worm. SQLsnake infects 
Microsoft SQL Servers that have SA 
(administrative) accounts without passwords. The 
worm sends a password list and other system 
information via email to ixltd@postone.com, then 
begins scanning for vulnerable hosts listening on 
TCP/1433.

SMTP:OVERFLOW:COMMAND-LINE This protocol anomaly is a text line (in the command 
section, before the DATA command) in an SMTP 
connection that is too long. This may indicate a 
buffer overflow attempt.

SMTP:OVERFLOW:EMAIL-ADDRESS This protocol anomaly is an email address that is 
too long. This may indicate a buffer overflow 
attempt.

SMTP:OVERFLOW:EMAIL-DOMAIN This protocol anomaly is a domain name within an 
email address (for example, localhost.localdomain 
in root@localhost.localdomain) that is too long. This 
may indicate a buffer overflow attempt.

SMTP:OVERFLOW:EMAIL-USERNAME This protocol anomaly is a user name within an 
email address (for example, root in 
root@localhost.localdomain) that is too long. This 
may indicate a buffer overflow attempt.

SMTP:OVERFLOW:OUTLOOK-CERT-OF This signature detects buffer overflow attempts 
against Microsoft Outlook Express, which ships with 
Internet Explorer 5.5. Attackers may send a 
maliciously crafted email to a host; if the host opens 
the email in Outlook Express, attackers may 
execute arbitrary code on the host.

SMTP:OVERFLOW:REPLY-LINE This protocol anomaly is a server reply line in an 
SMTP connection that is too long. This may indicate 
a buffer overflow attempt by a compromised or 
malicious SMTP server.

SMTP:OVERFLOW:SENDMAIL-CMT-OF1 This signature detects attempts to exploit a 
vulnerability in Sendmail. Sendmail versions 5.79 to 
8.12.7 are vulnerable. Attackers may include 
multiple empty address containers in an SMTP 
header field to overflow the SMTP header buffer 
and force Sendmail to execute arbitrary code on the 
host; attackers may obtain root access.
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SMTP:OVERFLOW:SENDMAIL-CMT-OF2 This signature detects attempts to exploit a 
vulnerability in Sendmail. Sendmail versions 5.79 to 
8.12.7 are vulnerable. Attackers may include 
multiple empty address containers in an SMTP 
header field to overflow the SMTP header buffer 
and force Sendmail to execute arbitrary code on the 
host.

SMTP:OVERFLOW:TOO-MANY-RCPT This protocol anomaly is too many ’RCPT TO:’ 
recipients in an SMTP connection. This may 
indicate a very popular email message or a DoS/
buffer overflow attempt.

SMTP:SENDMAIL:ADDR-PRESCAN-ATK This signature detects attempts to exploit a 
vulnerability in Sendmail SMTP server versions 
prior to 8.12.9. Because the prescan() procedure 
that processes email addresses in SMTP headers 
does not perform some char and int conversions 
correctly, attackers may send a maliciously crafted 
request to corrupt the Address Prescan Memory on 
a Sendmail SMTP server and execute arbitrary 
code.

SMTP:SENDMAIL:SENDMAIL-FF-OF This signature detects attempts to exploit a 
vulnerability in Sendmail versions 8.12.8 and earlier. 
Under certain conditions, the Sendmail address 
parser does not perform sufficient bounds checking 
when converting char to int. Attackers may use this 
exploit to gain control of the server.

TROJAN:QAZ:TCP25-CALLING-HOME This signature detects the string ’nongmin_cn’ within 
an SMTP header-from field sent from a remote 
system to local server port 25. This may indicate an 
attacker is attempting to access the Trojan/Worm 
QAZ. The QAZ Trojan/Worm, famous for infecting 
the Microsoft network October 2000, permits 
attackers to access data and gain control over some 
functions on remote Microsoft Windows systems.

WORM:CODERED-2:CMD-BACKDOOR This signature detects attempts to access a 
backdoor web script installed by the Code Red II 
worm. The Code Red II worm, like the original Code 
Red worm, permits attackers to remotely access the 
server.

WORM:CODERED-2:INFECT-ATTEMPT This signature detects attempts by the CodeRedII 
worm to infect a host. The CodeRedII worm, also 
known as CodeRed.F, exploits the same 
vulnerability as the original CodeRed worm.

WORM:CODERED-2:ROOT-BACKDOOR This signature detects attempts to access a 
backdoor web script installed by the Code Red II 
worm. The Code Red II worm, like the original Code 
Red worm, permits attackers to remotely access the 
server.
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WORM:EMAIL:BAGLE-INFECTION This signature detects the Bagle worm activity on a 
host. After infecting a host, the Bagle worm attempts 
to contact a Web server listening post. The Bagle 
worm, which affects Microsoft Windows, copies 
itself to the system directory, and edits the system 
registry. The worm uses an email attachment to 
propagate itself to other hosts, and has a hard-
coded expiration date (January 28). This signature 
could be prone to false positives.

WORM:NIMDA:BIN-255-CMD This signature detects attempts to infect a Microsoft 
IIS Web server with the Nimda worm. Nimda may 
infect other Web servers by obtaining email 
addresses and sending a copy of itself in infected 
messages using its own SMTP or POP3 server; 
adding files to a system configured to permit 
Windows file shares; or posting an infected HTML 
email to the Web server where it can be accessed 
via HTTP.

WORM:NIMDA:MSADC-ROOT This signature detects attempts to infect a Microsoft 
IIS Web server with the Nimda worm. Nimda may 
infect other Web servers by obtaining email 
addresses and sending a copy of itself in infected 
messages using its own SMTP or POP3 server; 
adding files to a system configured to permit 
Windows file shares; or posting an infected HTML 
email to the Web server where it can be accessed 
via HTTP.

WORM:NIMDA:SCRIPTS-C11C-CMD This signature detects attempts to infect a Microsoft 
IIS Web server with the Nimda worm. Nimda may 
infect other Web servers by obtaining email 
addresses and sending a copy of itself in infected 
messages using its own SMTP or POP3 server; 
adding files to a system configured to permit 
Windows file shares; or posting an infected HTML 
email to the Web server where it can be accessed 
via HTTP.

WORM:NIMDA:SCRIPTS-CMD This signature detects attempts to infect a Microsoft 
IIS Web server with the Nimda worm. Nimda may 
infect other Web servers by obtaining email 
addresses and sending a copy of itself in infected 
messages using its own SMTP or POP3 server; 
adding files to a system configured to permit 
Windows file shares; or posting an infected HTML 
email to the Web server where it can be accessed 
via HTTP.
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WORM:NIMDA:SCRIPTS-ROOT This signature detects attempts to infect a Microsoft 
IIS Web server with the Nimda worm. Nimda may 
infect other Web servers by obtaining email 
addresses and sending a copy of itself in infected 
messages using its own SMTP or POP3 server; 
adding files to a system configured to permit 
Windows file shares; or posting an infected HTML 
email to the Web server where it can be accessed 
via HTTP.
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The Configuration category contains the following subcategories:

Configuration Log Entry Subcategories ScreenOS Message ID

Address Addresses > Notification > 00001

Admin Admin > Notification > 00002

Auth Auth > Notification > 00015

Clock System > Notification > 00014

CLS Notification > 00043

CMS Device > Notification > 00022

Console Admin > Notification > 00003

DHCP CLI DHCP > Notification > 00027

DHCP IP DHCP > Notification > 00009

DHCP Opt DHCP > Notification > 00024

DIP DIP > Notification > 00021

DNS DNS > Notification > 00004

DNS REP DNS > Notification > 00029

Erase System > Notification > 00023

Hostname System > Notification > 00006

Interface Interface > Notification > 00009

MIP MIP > Notification > 00021

NSRP High Availability > Notification > 00007

OSPF OSPF > Notification > 00038

PKI PKI > Notification > 00002

Policy Policies > Notification > 00018

PPP HDLC > Notification > 00042

PPPoE PPPoE > Notification > 00034

RIP RIP > Notification > 00045

Route Route > Notification > 00011

Route Map Route > Notification > 00048

Schedule Schedule > Notification > 00020

Service Service > Notification > 00012

Set ARP ARP > Notification > 00051

Shaper Traffic Shaping > Notification > 00002

SIP ALG Flow > Notification > 00047
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SME NSM > Notification > 00033

SNMP SNMP > Notification > 00031

S/W Key Entitlement > Notification > 00036

SSH SSHv2 > Notification > 00026

SSL SSL > Notification > 00035

Syslog Syslog and WebTrends > Notification > 00019

Track IP High Availability > Notification > 00050

URL URL Filtering > Notification > 00013

User User > Notification > 00014

VPN VPN > Notification > 00017

Vrouter Virtual Router > Notification > 00049

Vsys Vsys > Notification > 00032

Zone Zone > Notification > 00037

Set ARP Always On Dest ARP > Notification > 0005

Unset ARP Always On Dest ARP > Notification > 00054

Configuration Log Entry Subcategories ScreenOS Message ID



Appendix B Log Entries

C-646 Administrator’s Guide


	(��$��
�	������	��
��
The Information category contains the following subcategories

Information Log Entry Subcategories ScreenOS Message ID

Auth Challenge Auth > Information > 00546

Auth Failed Auth > Warning > 00518

Auth Status Change Auth > Information > 00525

Auth Passed Auth > Warning > 00519

Auth Timeout Auth > Warning > 00520

Anti Virus AntiVirus Scanning (External) > Information > 00547

BGP BGP > Information > 00542

Clock NTP > Notification > 00531

Configuration Size System > Notification > 00553

DHCP CLI DHCP > Information > 00530

DHCP DNS DNS > Information > 00004

Generic System > Information > 00767

VIP Svr Up VIP > Notification > 00533

Link Status Interface > Notification > 00513

Log Cleared Logging > Information > 00534

NSRD NSRD > Information > 00551

NTP failure NTP > Notification > 00531

NTP timeout NTP > Notification > 00531

OSPF OSPF > Information > 00541

Password Change Admin > Information > 00002

PKI PKI > Information > 00535

PPP PPP > Notification > 00539

PPPoE PPPoE > Notification > 00034

RIP RIP > Information > 00544

SME NSM > Information > 00538

SNMP SNMP > Information > 00524

SSH SSHv1 > Information > 00528
SSHv2 > Information> 00026

SSL SSL > Information > 00284

URL Blk URL Filtering > Notification > 00523

Username Change Admin > Information > 00002
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VPN VPN > Information > 00536
L2TP > Information > 00536
IKE > Information > 00536

VIP Server Status VIP > Notification > 00533

DHCP Server Status DHCP > Information > 00527

Information Log Entry Subcategories ScreenOS Message ID



Appendix B Log Entries

C-648 Administrator’s Guide

���(������	��
��
Self log entries appear in the Log Viewer under the category Self, which contains a single 
subcategory: Self Log.
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Traffic log entries appear in the Log Viewer under the category Traffic, which contains a 
single subcategory: Traffic Log.
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When you enable logging in a GTP object, you can configure a NetScreen FW/VPN device 
to create log entries with Basic or Extended information. Additionally, when counting is 
also enabled the GTP object, the device also generates log entries for deleted GTP tunnels.

For log entries generated by GTP objects with Basic logging enabled, you can view the 
following information:

For log entries generated by GTP objects with Extended logging enabled, you can view the 
following information:

For log entries generated by deleted GTP tunnels, you can view the following information:

Basic GTP Log Entry

Timestamp

Source IP address

Destination IP address

TID (Tunnel Identifier) or TEID (Tunnel Endpoint Identifier)

Message type

Packet status: forwarded, prohibited, state-invalid, rate-limited, or tunnel-limited

Interface, vsys, or vrouter name (if applicable)

PLMN or zone name

Extended GTP Log Entry

IMSI

MSISDN

APN

Selection Mode

SGSN address for signaling

SGSN address for user data

GGSN address for signaling

GGSN address for user data

Deleted GTP Tunnel Log Entry

Timestamp

Interface name (if applicable)

SGSN IP address

GGSN IP address

TID
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Tunnel duration time in seconds

Number of messages sent to the SGSN

Number of messages sent to the GGSN

Deleted GTP Tunnel Log Entry
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*
Abstract Data Model 292

active sessions

information available 514

session display filter, configuring 515

session filter, using 514

viewing 513–515

active statistics

device-specific view, described 495

viewing 512

active VPN details 518

activities 32

address objects 302, 395

defined 595

administrative reports 582, 586, 589

administrators 30

timeout 324

ADSL

configuring interface 179

connecting the cable 179

advanced device options 233

aggregate interface 166

alarms 362

alerts 361

antivirus

See AV

application relocation 363

ARP cache, configuring on device 209

ASN1-DN 410

asset recovery 217

attack object database

checking version on device 286

configuring on device 232

updating on device 286

attack objects

contexts 309

custom 308

defined 595

in firewall rules 365

overview 306

protocol anomaly 307

signature 306

updating 307

attack protection

deep inspection alert 366

options 365

severities 366

attack statistics 495, 507–510

attack trends, using reports to identify 592

Attacks By Severity (DI) report 592

Attacks by Severity (DI) report 585

Attacks by Severity (Screen) report 586

Attacks over Time (DI) report 585

Attacks over Time (Screen) report 586, 592

Audit Log Viewer 264, 269

defined 596

authentication

NSRP 257

authentication method, device administrators 214

authentication server objects

configuring 323

defined 596

authentication servers

address 323

backup servers 323

object properties 323

RADIUS 324–327

RADIUS user support 325

RADIUS, defining 326

timeout 323

types 324

authentication users

run-time (external user group) 330

timeout 323

AV

activating subscription on device 285
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configuring external scanner 229

configuring internal scanner 230

configuring on device 229

configuring webmail scanning 230

objects 310

updating pattern file on device 287

-
backup interface, fail over 289

banners, configuring on device 224

BGP

configuring on device 133

peer connection troubleshooting 290

Border Gateway Protocol

See BGP

�
CA certificates, configuring on device 252

certificate authorities 340

Certificate Revocation List

See CRL

certificate revocation lists 343

certificates

CA 252

CA certificates 252

certificate request 250

configuring on device 249

CRL configuration 253

CRLs 253

generating request 250

imported 253

installing 250

local 249

local certificates 249

PKI defaults 254

revocation settings 254

SCEP 251, 252, 255

using imported 253

X509 certificates 254

X509 settings 254

changes that affect device connection 94

chart type, configuring 587

CLI banners, configuring on device 220

CLI commands, displaying 291

CLI management 216

cluster

See NSRP cluster

configuration logs report 585

configuration states 267

Configuration Summary

running 270, 274

configuring

devices 93–262, 523–576

multicast rules 367–369

objects 299–349

role-based administration 23–46

security policies 351–380

session display filter 515

session filter for active sessions 514–515

VPNs 381–484

connection attempts, max 217

connection states 267

connections, BGP peer 290

console-only restrictions 218

CRL, configuring on device 253

/
Data Model

defined 293

importing 295

schema 293

updating 293

data point count 566

data point count, configuring 587

data types 565

Deep Inspection 231

activating subscription on device 285

checking attack object database 286

configuring on device 231

see DI

updating attack object database 286

default values in templates 97

Delta Configuration Summary 271, 274

running 274

device administration 211

CLI management 216

CLI management, asset recovery 217

CLI management, configuring SSH 218

CLI management, console-only restrictions 218

CLI management, file format 216
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CLI management, max connection attempts 217

CLI management, reset hardware (device) 218

CLI management, restricting password length 217

CLI management, SSH and Telnet ports 217

date/time 222

device admins, authentication method 214

device admins, passwords 214

device admins, privilege levels 213

device admins, public key authentication (PKA) 214

example, permitted IPs 215

permitted IPs 215

device administration, CLI management, CLI banners 220

device administration, configuring HTTP 221

device administration, configuring SSL 221

device administration, disabling SSL on device 222

device administration, Web management 220

device advanced options 233

host and domain name 235

packet flow 235

predefined service timeout 233

SIP 233

TFTP/FTP server 235

traffic shaping 234

device capabilities

file 293

viewing 109

device certificate options 249

CA certificates 252

certificate request 250

CRLs 253

imported certificates 253

local certificates 249

PKI defaults 254

SCEP 251, 252, 255

X509 certificates 254

device clock, updating 288

device configuration

link from Log Viewer 561

overview 93

unsupported in UI 94

updating 274

device connection to Security Manager 94

device groups

planning for 45

using 107

device information, configuring 108
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